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To configure   the selection timeout: 328
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To add a foreground   color to a specific object with no gradient fill: 333

© 2024 General Electric Company. All rights reserved. xxxvii
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To select a color   set: 334
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To assign a color   to a property: 335
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Multiple Command Script Wizard 344

To use the Multiple   Command Script Wizard: 345

Experts Summary 345

Animation Experts 345

Command Experts 346

Data Entry Expert 346

Database Experts 347

Picture Experts 347

Report Experts 347

Create Objects 347

Animation Experts 347

Color Expert 348

Data Source 348

Color Properties Tab 348

Color By 348

New Alarm 349

Color Threshold 349

Historical Properties Tab 350

Start Date 350

Start Time 350

Time Zone 350

Historical Mode 351

Duration 351

Update Rate 352

Get Data From New Selection 352

Fill Expert 352

Data Source 352

Fill Properties 352

Direction 352

Direction Settings 353
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Input Ranges 353

Fill Percentages 353

Historical Properties Tab 353

Start Date 354

Start Time 354

Time Zone 354

Historical Mode 354

Duration 355

Update Rate 355

Get Data From New Selection 356

Position Expert 356

Data Source 356

Position Properties Tab 356

Position 356

Position Type 356

Input Values 356

Horizontal Position Output Values 357

Historical Properties Tab 358

Start Date 358

Start Time 358

Time Zone 358

Historical Mode 359

Duration 359

Update Rate 359

Get Data from New Selection 360

Rotate Expert 360

Data Source 360

Rotate Properties Tab 360

Input 360

Output 360

Historical Properties Tab 361
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Start Date 361

Start Time 361

Time Zone 362

Historical Mode 362

Duration 362

Update Rate 363

Get Data from New Selection 363

Scale Expert 363

Data Source 363

Scale Properties Tab 363

Scale Parameters 363

Input 364

Output 364

Historical Properties Tab 364

Start Date 364

Start Time 365

Time Zone 365

Historical Mode 365

Duration 366

Update Rate 366

Get Data from New Selection 366

Visibility Expert 366

Data Source 367

Visibility Properties Tab 367

Condition for Visibility 367

Condition 367

Condition Value 367

Tolerance 367

Condition Expression 367

View Visibility Condition 367

Visibility Condition 367
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Historical Properties Tab 367

Start Date 368

Start Time 368

Time Zone 368

Historical Mode 368

Duration 369

Update Rate 369

Display Layers Expert 369

Layer Numbers 370

Select All Layers 370

Deselect All Layers 370

Set Layer Expert 370

Layer Numbers 370

Allow Multiple Layers 370

Select All 370

Deselect All 370

Command Experts 370

Acknowledge Alarm Expert 371

Data Source 371

Use Database Tags 371

Acknowledge All Alarms Expert 371

Picture Name 372

Browse Button (...) 372

Acknowledge All Alarms in Picture 372

Alarm Horn Expert 372

Silence Horn 372

Enable Horn 372

Disable Horn 372

Toggle Horn Enable 372

Prompt for Horn Status in Run Mode 372

Close Digital Tag Expert 372
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Data Source 372

Use Database Tags 373

Close Picture Expert 373

Picture Name 373

Browse (...) 373

Use Alias 373

Picture Alias 373

Close This Picture 373

Disable Alarm Expert 373

Data Source 373

Use Database Tags 373

Enable Alarm Expert 373

Data Source 374

Use Database Tags 374

Locate Object Expert 374

Object Name 374

Search Active Document 374

Search All Documents 374

Open Digital Tag Expert 374

Data Source 374

Use Database Tags 374

Open Picture Expert 374

Picture Name 375

Picture Browse (...) 375

Picture Alias 375

Select Picture to Open in Run Mode 375

Allow Multiple Instances of this Picture 375

Top 375

Left 375

Enable Tag Group Substitution 375

Tag Group File 375
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Select Tag Group file in Run Mode 375

Tag Group file Browse (…) 375

Tag Group Editor Button 375

Ramp a Value Expert 375

Data Source 376

Ramp by Percentage 376

Ramp by Value 376

Ramp Value 376

Use Database Tags 376

Replace Picture Expert 376

Picture to Replace 376

Picture Browse (...) 376

Picture Alias 376

Replace Current Picture in Run Mode 376

New Picture File Name 377

New Picture Browse (...) 377

Enable Tag Group Substitution 377

Tag Group File 377

Select Tag Group file in Run Mode 377

Tag Group file Browse (…) 377

Tag Group Editor Button 377

Set Tag to Auto Expert 377

Data Source 377

Use Database Tags 377

Set Tag to Manual Expert 377

Data Source 378

Use Database Tags 378

Set Symbol Values Expert 378

Example 378

Tip 379

Symbol 379
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Value 379

Set Symbol from Model Browse Expert 379

SCADA Name 380

Symbol to Update 380

Update Symbol With 380

Model Browse at Run Time 380

Shelve Expert 381

FIX Database Tag 381

Use Database Tag(s) for Item(s) Selected In the Run Environment 382

Shelve Duration 382

Toggle Digital Tag Expert 382

Data Source 382

Use Database Tags 382

Toggle Scan Expert 382

Data Source 382

Use Database Tags 382

Toggle Tag Between Auto and Manual Expert 383

Data Source 383

Use Database Tags 383

Turn Tag Off Scan Expert 383

Data Source 383

Use Database Tags 383

Turn Tag On Scan Expert 383

Data Source 383

Use Database Tags 384

Unshelve Expert 384

FIX Database Tag 384

Use Database Tag(s) for Item(s) Selected In the Run Environment 384

Write a Value Expert 384

Data Source 384

Value 384
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Use Database Tags 384

Alpha-Numeric 385

Numeric 385

Data Entry Expert 385

Data Source 385

Choose Data Entry Method 385

Database Experts 387

Add Database Block Expert 387

Data Source 387

Add 387

Database Reload 387

Database Save 388

Modify Database Block Expert 388

Data Source 388

Modify 388

Read a Value Expert 388

Data Source 388

Use Database Tags 388

Picture Experts 388

Button Caption Converter Expert 389

Convert Button Caption 389

Find Next 389

Convert all 389

Close 389

Push buttons found on picture 389

Export Key Macros Expert 389

Object 389

Recursive (Include Children) 389

File Name 389

Browse (...) 389

Append to File 390
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Export 390

Generate Picture Expert 390

Window Location 390

Window Styles 390

Background Color 390

Picture Name 391

Refresh Rate Expert 391

Selected Objects 391

Entire Picture 391

Tolerance 391

Deadband 391

Refresh Rate 391

Resolve Files Expert 391

File Types 391

Directories 392

Resolve Files 392

Select All 392

Deselect All 392

Save Files with Thumbnail Preferences Expert 392

File Types 392

Directories 392

Save Thumbnails 393

Save Files With 393

Select All 393

Deselect All 393

Upgrade File to Enhanced Coordinates Expert 393

File Type 393

Picture and Dynamo Set Folder Path 393

Browse (....) 393

Refresh File List 393

Upgrade Files 393
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Restore Files from Backup 394

Select Files 394

Buttons 394

Reports Experts 394

Cross Reference Tool 394

Print Crystal Report Expert 394

Select Report 394

Preview Report 395

Report Name 395

Print Crystal Report Expert (PrintReport Subroutine) 395

Select Report 395

Report Name 395

Print All 395

Print Selected Pages 395

From Page 395

To Page 395

Prompt User 395

Collate 395

Number of Copies 395

Create Objects 395

Variable Object 396

Variable Name 396

Variable Type 396

Assign Variable 396

Data Source 396

Local Variable 396

Global Variable 396

Timer Object 396

Timer Name 397

Timer Description 397

Start Time 397
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Interval 397

Edit Script 397

Event Object 397

Event Source 397

Event Properties Tab 397

Historical Properties Tab 398

Start Date 398

Start Time 398

Time Zone 398

Historical Mode 399

Duration 399

Update Rate 400

Edit Script 400

Using Dynamos 400

Using Global Subroutines 400

Performing Functions with Toolbars 400

Controlling Object Properties 402

How Properties Work 402

Defining and Modifying Properties 402

Entering Property Values Manually 402

Entering Property Values with the Properties Window 403

Entering Property Values with the Advanced Animations Dialog Box 403

Animating Objects to Modify Properties 405

Writing Scripts to Modify Properties 405

Animating Object Properties 405

How Animations Work 405

Understanding Data Sources 406

Accessing the Animations Dialog Box and Using Common Animations 406

Animating a Size Property 408

Understanding Animation Objects 408

Animating an Object's Properties 408
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To animate the   properties of any object in a picture: 409

Using Experts to Animate Objects 409

Defining Data Sources 409

Entering Data Source Syntax 410

Selecting Data Sources from a List 411

Filtering Data Sources 412

Specifying Data Conversions 412

Sample Table Data Conversion 414

Classifying Animations Errors 414

Specifying OPC Errors 415

Animating Properties Using Color 416

Color by Analog Value 416

Color by Digital Value 417

Color by Current Alarm 418

Color by Latched Alarm 418

Using Blinking Thresholds 418

Blinking on a New Alarm 418

Blinking Rate 419

Using Shared Thresholds 419

Animating Object Properties with Visual Basic 419

To connect the data source to the object you want to animate: 419

Animating a Grouped Object 419

Modifying Animations 420

Deleting Animations 421

Building Expressions 422

Using the Expression Builder Dialog Box 422

Customizing the Expression Builder 423

Specifying Tolerance, Deadband, and Refresh Rate 423

The Importance of Syntax 424

Syntax: Required Format for Expressions 424

Operators: Applying the Glue to Your Expressions 424
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Mathematical Operators 425

Syntax: Mathematical Operators 426

Example: Mathematical Operators 426

Relational Operators 426

Syntax: Relational Operators 426

Example: Relational Operators 427

Boolean Operators 427

Syntax: Boolean Operators 427

Example: AND Operator 427

Example: OR Operator 428

Example: NOT Operator 428

Changing the Order of Precedence 428

Example: Changing the Order of Precedence 428

Bit Operators for Expressions 428

Modifying Expressions 429

Browsing the Model in the Expression Builder 429

Accessing the Animation Dialog Boxes 430

Selecting a Data Source from a List 430

To select a data   source from a list: 430

Creating an Animation Using the Basic Animation Dialog Box 430

To create an   animation using the Basic Animation dialog box: 430

Modifying an Animation in the Basic Animation Dialog Box 431

To modify an   animation using the Basic Animation dialog box: 431

Animating Grouped Objects 431

To animate a   grouped object: 431

Deleting an Animation in the Basic Animation Dialog Box 431

To delete an   animation using the Basic Animation dialog box: 431

Modifying an Animation in the Advanced Animations Dialog Box 432

To modify an   animation using the Advanced Animations dialog box: 432

Deleting Animations in the Advanced Animations Dialog Box 432

To delete an   animation using the Advanced Animations dialog box: 432
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Entering a Property Value in the Advanced Animations Dialog Box 432

To enter a property   value in the Advanced Animations dialog box: 432

Changing Properties Using the Property Window 433

To change a property   using the Properties window: 433

Entering Highlight Timeout Intervals 433

To enter a Highlight   Timeout Interval: 433

Filtering Data Sources 433

To filter data   sources: 433

Creating Expressions 434

To create an   expression: 434

Modifying Expressions 434

To modify an   expression: 434

Deleting Expressions 434

To delete an   expression: 434

Data Conversions, Error Defaults, and Threshold Tables 435

Completing a Range Data Conversion 435

To complete a   range data conversion: 435

Completing Table Data Conversion 435

To complete a   table data conversion: 436

Completing a Format Data Conversion 436

To complete a   format data conversion: 436

Modifying Animations Error Defaults 437

To modify animations   error defaults: 437

Assigning Blinking Thresholds 437

To assign a blinking   threshold: 437

Setting the Blink Speed 437

To set the blink   speed: 438

Running Your Pictures 439

Working with Objects in the Run-time Environment 439

Interacting with Alarm Summaries at Run Time 440

Interacting with Charts in Run Time 440
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Locating Objects 440

Using the Global Time Control 440

Configuring the Global Time Control 441

Displaying the Global Time Control 441

Using the Global Time Control 441

Example 443

Limitations 443

Using Experts to Expedite Pictures at Run Time 443

Multiple Picture Instances and Run Mode 444

Important Information About Run Mode 445

To edit a VBA   script of a picture with multiple instances open in run mode: 445

Using Tag Status and Quick Trend Pictures 446

Accessing Tag Status, Quick Trend, and Tag Control   Panel Pictures 447

The Tag Status Picture 447

Quick Trend Charts in Tag Status Pictures 448

The Quick Trend Picture 449

The Tag Control Panel Picture 450

Adding and Deleting Tags 451

Saving and Loading Tag Lists 451

Translating Picture Text 452

Global Picture Language Settings 453

Individual Picture Language Settings 454

Language File Exporter Dialog Box 454

Export location 455

Select Pictures 455

Show Tag Status Pictures Check Box 455

Always overwrite existing export files Check Box 455

Select Language 455

Select All 455

Deselect All 455

Export 455
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Exit 455

Exporting and Importing Language Files 455

Exporting a Single Language File 457

Exporting Multiple Language Files 457

Importing a Language File 457

Language Letter Acronyms 458

Examples of How to Switch Between Languages 458

Example 1: Configure Global Language for all Pictures   to Open in Run Mode 459

Example 2: Open a Single Picture in a Desired   Language in Run Mode 461

Example 3: Switch the Language of Single Picture   to a Desired Language in Run Mode 462

How Do I... 464

Configuring the Default Language Settings for All Pictures 464

To configure   default language for all pictures when opened in run mode: 464

Configuring Language Settings for an Individual Picture 465

To configure   the language for a single picture when opened in run mode: 465

Exporting a Single Language File 466

To export a single   language file: 466

Exporting Multiple Language Files 467

To export multiple   language files: 467

Editing a Language File 467

To edit a language   file: 467

Importing a Language File in Configuration Mode 468

To import a language   file in configuration mode: 468

Using Tag Groups in Pictures 469

Example: Using Tag Groups in Pictures 469

Using the Tag Group Editor 469

Getting Ready to Use the Tag Group Editor 469

Starting the Tag Group Editor 470

The Tag Group Editor Window 470

Creating and Opening Tag Group Files 471

Column Definitions for the Tag Group Editor 471
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Using the Tag Group Editor Toolbar 471

Using the Tag Group Editor Spreadsheet 472

Retrieving Fully Qualified Names for Substitutions in a Spreadsheet 472

Using the Data Entry Dialog Box to Define Substitutions 473

Sorting Data in the Spreadsheet 473

Searching and Replacing Substitutions 473

Retrieving Symbols from a Picture 473

Using Tag Group Symbols in Pictures 473

Implementing a Tag Group Strategy 474

Entering a Symbol in a Picture 474

Example 474

Using Partial Substitutions 475

Partial Substitution Errors in Data Sources 475

Syntax Guidelines for Symbols in Pictures 475

Using Symbols for the Current Value of a Variable Object 476

Using Symbols for Complex Expressions 476

Assigning a Tag Group File to a Picture Event 476

Optimizing Picture Loading in the Run-time Environment 477

Error Log Creation 477

OPC Server Address Substitution 477

To use an OPC   address substitution with Symbols in the Tag Group Editor: 477

Importing and Exporting Tag Group Files 477

Understanding the CSV File Format 478

CSV File Formatting Rules 478

Example: A Sample CSV File 478

Exporting a Tag Group File as a CSV File 479

Converting 6.x Tag Group Files 479

Tag Group Editor Dialog Boxes 479

Convert 6.x CSV Files Dialog Box 479

6.x .CSV File Directory 479

CSV File List 479
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Update .CSV File List 479

Select All 479

Deselect All 480

Data Entry Dialog Box 480

Symbol 480

Substitution 480

Browse 480

Modify Database Block 480

Get Full Name 480

Description 480

Tag Group Editor Main Window 480

Symbol 481

Substitution 481

Get Full Name 481

Description 481

How Do I... 481

Performing Basic Functions 481

Creating a New Tag Group File 482

To create a new   tag group file: 482

Opening an Existing Tag Group File 482

To open an existing   tag group file: 482

Changing the Font 483

To change the   font: 483

Saving a Tag Group File 483

To save a tag   group file: 483

Closing a Tag Group File 483

To close a tag   group file: 483

Exiting the iFIX Tag Group Editor 484

To exit the iFIX   Tag Group Editor: 484

Entering Data into the Spreadsheet 484

Entering Symbols Directly Into the Spreadsheet 484
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To enter symbols   directly into the spreadsheet: 484

Entering Substitutions Directly Into the Spreadsheet 484

To enter substitutions   directly into the spreadsheet: 484

Entering Descriptions Directly Into the Spreadsheet 485

To enter descriptions   directly into the spreadsheet: 485

Entering Data If You Don't Know the Substitution Name 485

To enter data   if you don't know the substitution name: 485

Editing a Tag Group File 485

Editing a Cell 486

To edit a cell: 486

Deleting the Contents of a Cell 486

To delete the   contents of a cell: 486

Inserting a Row 486

To insert a row: 486

Adding a Row 486

To add a row: 486

Deleting a Row 486

To delete a row: 487

Sorting Data Alphabetically in a Column 487

To sort data   alphabetically in a column: 487

Searching and Replacing Substitutions 487

To search and   replace substitutions: 487

Using OPC Server Address Substitution in the Tag Group Editor 487

To use an OPC   address substitution with Symbols in the Tag Group Editor: 487

Resolving Tags With a Picture 487

To resolve tags   with a picture: 488

Assigning a Tag Group File to a Picture Event 488

Assigning a Tag Group Substitution to Occur When a Picture Opens 488

To assign a tag   group substitution to occur when a picture opens: 488
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Creating Pictures

The Creating Pictures manual is intended for process control engineers, integrators, and developers 
responsible for designing and creating operator displays, and configuring the development and run-time 
environments. The manual assumes familiarity with the process database and the iFIX® WorkSpace.

Reference Documents
For related information on iFIX®, refer to the following manuals:

 l Building a SCADA System

 l Understanding iFIX

 l Writing Scripts

 l Implementing Alarms and Messages

 l Trending Historical Data

  

See Also

Introduction

Getting Started

Introduction

iFIX®   allows developers and process engineers to create dynamic pictures with   minimal effort. By 
providing an open-environment, ActiveX format, iFIX   lets you incorporate internet controls (OCXs),   
reuse elements from other sources (such as bitmaps),   or embed other OLE   automation applications into 
your pictures. 

While creating pictures in the iFIX WorkSpace, you can utilize   features that give you the control you 
need to customize your drawings.   You can view your pictures by merely switching to the run-time envir-
onment   with the click of a mouse.

Picture Coordinate Systems 
Before creating or editing pictures or dynamo sets, it is important   to be aware of the coordinate system 
you are using. iFIX 5.8 supports   the following two coordinate systems:

 l Logical

 l Enhanced 

The Logical Coordinate System is the legacy system that supports graphics   created with iFIX 5.5 or 
earlier. The Logical Coordinate System uses logical   units for measurement, and provides graphic scal-
ing that is dependent   on the screen resolution (or aspect ratio) of the terminal used to create   the graphic; 
thus, graphics may not accurately scale to different screen   sizes.
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The Enhanced Coordinate System is a feature of iFIX 5.8, which uses   postscript points for units of 
measurement instead of logical units. The   Enhanced Coordinate System is a screen independent 
coordinate system,   which accurately scales across different screens sizes. When the screen   resolution 
(or aspect ratio) changes, the picture automatically adjusts   to the new resolution (or aspect ratio). 

iFIX 5.8 also provides a means to easily upgrade Logical Coordinate   System graphics to the Enhanced 
Coordinate System. For more information   on this feature, refer to the Picture   Coordinate System sec-
tion.

Creating Pictures with Purpose

Whether you are a new or an expert user, iFIX gives you the power and flexibility to create pictures that 
provide solutions to your process needs. Let's take two scenarios to illustrate this concept:

 l Joe. Joe is a system developer for a small shop. He is slightly intimidated by Visual Basic and 
would prefer not to learn scripting to create and control his pictures. However, he wants to take 
advantage of VBA's capabilities by customizing a few objects in his picture.

Joe's Solution. Using iFIX Experts, Joe attaches scripts to the objects in his picture without 
leaving his development screen or entering the VBA environment. Experts give him a simple 
means to perform the processes he wants.   

 l Janet. Janet is a Process Manager for a large processing plant. She is well-versed in VBA, and is 
more than eager to unleash the power of iFIX using her knowledge of Visual Basic. Specifically, 
Janet wants the ability to override the default property settings of a series of existing objects and 
create her own properties, including complex animations from several different data sources and 
algorithms. She also wants to add custom controls and toolbars to simplify the process for her 
developers. 

Janet's Solution. iFIX provides the tools that Janet needs to fully customize her environment 
and fine-tune the control she has over her application. Using the Animations dialog box, she anim-
ates certain properties of her objects by specifying a data source and conversion method. Then, 
by writing VBA scripts, she overrides existing defaults, inserts custom controls, and creates a 
development toolbar that saves her developers time.    

Having all the power you need doesn't mean it should be difficult to use. Developing complex pictures 
using process automation software was once a tedious and intimidating venture, as it required you to 
use proprietary command languages and graphics formats that, in the end, gave you limited flexibility. 
iFIX offers an alternate solution – an easy-to-implement and use, object and task-oriented development 
tool that lets you create pictures with purpose.

This manual details all of the concepts introduced in the above example. The following table helps you 
locate specific concepts throughout the various chapters.     

To learn about... Refer to the section... In the chapter...
Experts Using Wizards and Experts Using Process Assistants to 

Expedite Pictures
Pictures as ActiveX 
Documents

What Makes up Your Picture Implementing Pictures in Your 
Process

The run-time envir- Working with Objects in the Run- Running Your Pictures

iFIX Picture Concepts 

2 © 2024 General Electric Company. All rights reserved.



onment time Environment
Using animations Connecting to a Data Source Animating Object Properties

Getting Started

This chapter shows you how to start creating and drawing pictures right   away. Some of the basic con-
cepts of iFIX pictures are also described.

 l Creating   and Opening Pictures

 l The   Object-oriented Nature of Pictures

 l Using   Basic Drawing Tools

 l Using   Basic Functions in Pictures

 l Performing   Advanced Functions in Pictures

Before You Begin
Before you start creating pictures, make sure you have started the iFIX   WorkSpace. It is also helpful to 
know which data sources you want to connect   to ahead of time.

Creating and Opening Pictures 

When you start the iFIX WorkSpace, you are ready to develop   your picture. You can start by creating a 
new picture or opening an existing   one. 

Before you begin, it is important to know which coordinate system the   picture uses. Typically, legacy 
pictures (iFIX 5.5 or earlier) use the   Logical Coordinate System and new pictures (iFIX 5.8 or greater) 
use the   Enhanced Coordinate System. For more information on coordinate systems,   refer to the Picture 
Coordinate   System section.

For Classic view, to create a new picture, click the New Picture button   on the Standard toolbar as 
shown:

For Ribbon view, click the WorkSpace button, select New, and then click   Picture. Or, click Picture in 
the New group, on the Home tab.

By default, the Create Picture Wizard appears and guides you through   the picture creation process.

If a single untitled picture appears when you click the New Picture   button, the Create Picture wizard has 
been disabled. Enable it by selecting   the following check box on the Picture Preferences tab of the User 
Preferences   dialog box: Show Picture Wizard from New Picture Menu.

For more information on the Create Picture wizard, refer to the Using   the Create Picture Wizard section 
in the Implementing Pictures in   Your Process chapter.
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Opening Existing Pictures

To open an existing picture, double-click the picture from the Pictures   folder in the system tree. By 
default, the system tree is docked on the   left side of the screen, and the picture appears to the right of it. 
To   create more room for your picture, you can do any of the following:

 l Dock the system tree   on the other side of the screen by dragging it 

 l Set the system tree   to float on top of your picture by dragging it away from the sides of   the 
screen. 

 l Hide the system tree   completely so that the picture appears to fit the full screen. 

For more information on using the system tree of the WorkSpace, refer   to the Using  the iFIX WorkSpace 
chapter of the Understanding iFIX manual.

If the picture you opened has links to an external data source, such   as a Proficy Historian server, which 
is not configured in the WorkSpace,   you will receive an error message indicating that the data source is 
not   configured in WorkSpace.

Saving Pictures

In Classic view, to save your drawing, click the Save button on the   Standard toolbar. In Ribbon view, to 
save your drawing, click the Application   button, and then click Save. You can save your picture as either 
a .GRF   file or .SVG file. Both file types are stored, by default, in the PIC   folder in the path where iFIX is 
installed, but only .GRF files are displayed   in the system tree. You can save .SVG files in any location 
but you cannot   open them in iFIX Workspace, as these files are used for exporting to   third-party applic-
ations.   

When saving picture files, as either file type, you must follow the   guidelines of VBA naming constraints. 
For example, do not use:

 l Anything but a letter   as the first character. 

 l Any of the following   characters in a name: space, period, exclamation mark, @, &, $, #.   

 l A name that exceeds   31 characters. 

 l A name used by any   object in your iFIX application. For example, you cannot have both a picture   
and a rectangle named test.   

Also, we recommend that you do not use any names that are common to   other objects, functions, state-
ments, or methods in Visual Basic, as you   may cancel one of the keywords in the code. For more inform-
ation on VBA   Naming Conventions, refer to the VBA  Naming Conventions section in the Writing Scripts 
manual.

Picture Coordinate Systems

The picture coordinate systems uniquely determine the position of a   point or other geometric element in 
a picture. All coordinates used by   a picture, Dynamo Set, or animation are measured in the document's 
coordinate   system, which can be either:

 l Logical 

 l Enhanced
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Logical Coordinate System

The Logical Coordinate System is a legacy system that was used for pictures   created with iFIX 5.5 or 
earlier. With the Logical Coordinate System,   the screen resolution is measured in logical units. The 
logical unit value   is derived from the screen resolution of the terminal on which the picture   was originally 
created. When viewing this picture on a terminal with a   different screen resolution, the picture may not 
automatically scale to   the new screen resolution.

The Logical Coordinate System uses the following properties to identify   the logical units used for the 
height and width of the document as displayed   in the Property window.

Property Description
DocumentHeight Specifies the height of the document in logical units.
DocumentWidth Specifies the width of the document in logical units.

With the Logical Coordinate System, the Auto Scale option allows you   to move pictures between 
screens with the same resolution. However, when   viewed on a screen with a different resolution, the pic-
ture many not scale   as desired. When moving pictures to a screen with a different resolution,   it is recom-
mended to use the Enhanced Coordinate System.

Enhanced Coordinate System

The Enhanced Coordinate System is provided for iFIX 5.8 and greater.   With the Enhanced Coordinate 
System, you can create a picture that provides   independence from restricted screen resolution. For the 
Enhanced Coordinate   System, the dimension and position of a picture are measured in postscript   
points. The Enhanced Coordinate System features automatic scaling of a   picture when viewed on a 
screen with a resolution that is different from   the screen on which the picture was originally created. 
Once a picture   is created with the Enhanced Coordinate System, the picture retains its   original aspects 
even when viewed on screens with different resolutions.

The Enhanced Coordinate System uses the following properties to reflect   the height, width, and coordin-
ate system of the graphic. Refer to the   iFIX Automation Reference e-book   for more information on these 
properties.

Property Description
DocumentHeightEx Specifies the document height in postscript points.
DocumentWidthEx Specifies the document width in postscript points.
EnhancedCoordinates Identifies the picture coordinate system as either   -  True   (Enhanced 

Coordinate System) or False (Logical Coordinate System).

You can upgrade a picture created with the Logical Coordinate System   to the Enhanced Coordinate Sys-
tem. The Enhanced Coordinate System expert   converts the picture from logical units to postscript 
points. During the   upgrade process, the picture in the Logical Coordinate System is saved   to a Backup 
folder before the picture is upgraded. This allows you to   revert back to the original picture in logical units 
if you want to. Also,   when a picture is upgraded, the icon changes to indicate the upgraded   picture.  

By default, the Enhanced Coordinate System is enabled for new pictures.   Existing legacy pictures 
remain in the Logical Coordinate System until   you upgrade them to the Enhanced Coordinate System.
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Zoom to Fit 

The Enhanced Coordinate System provides a Zoom to Fit viewing preference   that is enabled for run 
mode. Zoom To Fit suppresses scroll bars while   allowing you to view the entire picture on your screen. 
The objects within   the picture do not change their position and dimensions even when the   picture is 
brought to a new screen resolution, which is different from   the resolution on which the picture was 
developed. Zoom to Fit does not   change the location of the objects/shapes within your picture, but 
scales   the picture for viewing only. For more information on using Zoom to Fit,   refer to the Selecting 
Zoom to   Fit section.

By default, Zoom to Fit is enabled for run mode. You may wish to disable   this preference for a special 
purpose.  To   disable Zoom to Fit in run mode, for all pictures de-select the Zoom to   Fit in Run mode 
check box on the General tab of the User Preference dialog   Box. To disable this preference for a specific 
picture, put a script under   the picture initialization code to call "ME.ZoomToFit False."    For more   inform-
ation on this script, refer to the ZoomToFit  Method Example in the iFIX Automation  Reference e-book.

NOTE: Zoom to   Fit does not apply to a document that uses the Logical Coordinate System.

IMPORTANT: iFIX   screens depend on the Dots Per Inch (DPI)   setting of the physical display monitor and 
should always be at the recommended   setting. Failure to do so may cause the picture to display improperly.

Button Caption Converter

The Button Caption Converter allows you to scale command button captions   (text) when used in a pic-
ture with a screen resolution that is different   from the resolutions in which the picture and command but-
ton caption were   created. When text does not scale properly for a command button, the Button   Caption 
Converter expert converts the caption text to scale across zoom   factors and screen resolutions and 
places an overlay on the original command   button caption. Using the Button Caption Converter expert, 
you can scale   one, some, or all of the command button captions in a picture. This is   useful when viewing 
pictures and text with Zoom to Fit. The Button Caption   Converter expert supports the Enhanced Coordin-
ate System only. The Button   Caption Converter does not apply to a document that uses the Logical 
Coordinate   System. For more information on using the Button Caption Converter, refer   to the Converting 
Button   Captions section. 

Coordinate System Summary

The following table summarizes the characteristics of each coordinate   system.

Characteristic Logical Coordinate 
System

Enhanced Coordinate 
System

iFIX support Version 5.5 or earlier

NOTE:  Pictures   using 
the Logical Coordinate 
System can be viewed 
and edited with iFIX    5.8.

Version 5.8 and greater

Measurement used for  screen    dimen-
sions

logical units postscript points 

Default picture size (height and width) 100 x 75 logical units postscript points, cal-
culation based on the 
screen   resolution
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Picture height property

Picture width property

DocumentHeight

DocumentWidth

DocumentHeightEx

DocumentWidthEx

EnhancedCoordinates property False True

Views picture in entire screen option Auto Scale Zoom to Fit 

Legacy picture backup and restore No Yes

 

The Object-oriented Nature of Pictures 

Many graphics programs work by giving you tools to manipulate pixels,   a series of tiny dots that make 
up your computer monitor. When you add   shapes to your drawing, the program translates these shapes 
into a matrix   of dots, and changes the color of the screen pixels to match the dot matrixes.   These dot 
matrixes are called bitmaps.

Although bitmaps are a common graphic format, they are limited in that   once you create the image, there 
is very little you can do to change it.   You can erase or partially erase a bitmap, or paint a new bitmap on 
top   of the old one. But changing bitmaps takes almost as much time as creating   them.

iFIX pictures, on the other hand, work with objects   instead of individual pixels. An object-oriented 
graphic consists of an   image and image attributes, such as size, color, and position, that define   the prop-
erties of the object. By providing this object-oriented foundation,   iFIX precludes your having to work with 
individual pixels. Rather, you   interact with tools, menus, and dialog boxes to add and change object   prop-
erties, while iFIX automatically adjusts the object and its property   data for you. This gives you an enorm-
ous amount of control and flexibility   when drawing and modifying your pictures. 

For example, many other graphics packages allow you to save object-oriented   graphics as a Windows 
Metafile. iFIX allows you to import the metafile   (in .WMF format) into a picture. The advantage of using a 
.WMF format   is that the imported image consists of individual objects, giving you   greater control of your 
picture. 

The following figures illustrate some additional examples of the control   and flexibility you have with iFIX 
pictures. 

The Control You Have With Your   Pictures
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In an iFIX picture, you can modify spe-
cific objects   of a group without sep-
arating the objects from the group, and 
without   losing scripts or animations 
applied to the group. 

This concept is referred to as drilling   
down.

The Flexibility You Have With   Your Pictures
Given the popularity of bitmap formats, 
you may have   an existing bitmap that 
you want to add to your picture. 

iFIX makes this easy by letting you 
import the image   into a picture as an 
object. Now you can control the image's 
properties   like any other iFIX object. 

For more information on adding a bitmap 
to a picture,   refer to the Implementing   Pic-
tures in Your Process chapter.

How Objects Behave in Pictures 

An object   is anything that you create or import into an iFIX picture that has properties,   methods, and 
events. In the next section we talk more about how objects   work. After you have created an object in the 
iFIX WorkSpace's   configuration environment, you can control its attributes and view its   behavior in the 
run-time environment.
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An object can be any of the following:

 l Shapes   – Shapes   are integral to adding precise detail to your pictures. Shapes include   rect-
angles, rounded rectangles, ovals, lines, polylines, polygons, arcs,   chords, pies, and pipes. 

 l Text   – Text   added to an iFIX picture becomes an object, containing properties that   allow you to 
format or control the text. 

 l Bitmaps   – Bitmaps   are images constructed of dot matrixes. They can be imported into an iFIX   
picture and controlled like any other object. 

 l Charts   – Charts   are compound objects made of lines, text, and rectangles that display   real-time 
and historical trend data. 

 l Data   links –   Data links display text and values from process databases. 

 l Alarm   Summaries –   An Alarm Summary object displays real-time alarm status information 
based   on your alarming and SCADA configuration. An Alarm Summary object is an    iFIX OCX. 

 l Push   Buttons –   A push button is a tool that lets you execute an action easily with the   click of a 
mouse. A push button is an OCX supplied Microsoft.   

 l Timers   –   Timers perform an action based on a specified time duration. 

 l Events– Events   allow you to perform an operation based on a specific action. 

 l Variables   – Variables   allow you to specify different values that let you store and display process   
data in various ways. 

 l ActiveX   Controls –   compiled software components based on the component object model 
(COM).   Any imported ActiveX control (OCX) becomes an iFIX object in the WorkSpace.   

 l Applications   – Any   OLE-compatible application, such as a Microsoft Excel spreadsheet, can   be 
imported as a document object within the iFIX WorkSpace. 

 l Animations   – When   you animate an object's properties, iFIX adds animation objects to the   
object containing those properties. 

An iFIX picture can contain many types of objects. The following figure   illustrates the concept of objects 
inside an iFIX picture.
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Example of Objects in an   iFIX Picture

Objects consist of the following image attributes:

 l Properties 

 l Methods 

 l Events 

These attributes are described in the sections that follow.
Properties 

All objects have properties.   Properties are object attributes you can control, such as the foreground   fill 
color or the object's size or position. These properties can be modified   by animating the object or by writ-
ing a script.
Methods and Events

Objects also contain methods   and events.   

A method   is a task that affects one or more objects. For example, a rectangle can   be moved, rotated, 
and scaled, and these are all methods of the rectangle.   

An event   is a signal that an object generates that we respond to. For example,   if you click the left mouse 
button or press a key on the keyboard, the   object generates an event which you would respond to, typ-
ically by executing   a script. Note that the action which triggers an event does not have to   be a user 
action, it can be another script, an application, or the operating   system.
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Typically, when drawing pictures you work with properties more than   methods and events. However, 
you may want to access an object's methods   and events in order to write scripts for the objects you cre-
ate. For more   information on properties, refer to the Controlling   Object Properties chapter. 

Using Basic Drawing Tools 

The iFIX configuration environment contains several tools that help   you access, modify, and apply an 
object's characteristics into your picture   design. These tools are described in the following sections.

 l Using   Drawing Cursors

 l Using   Toolbars

 l Using   the Toolbox

 l Using   the Object Pop-up Menu

 l Using   the Properties Window

 l Using   the Color Box

 l Using   the Find Mouse Coordinates Tool

 l Using   the Animations Dialog Box

 

Using Drawing Cursors 

When you draw pictures, you have many different cursors to use depending   on what you are trying to do. 
Many of these cursors appear when you have   selected an object and place the cursor over the object's 
handles.   The handles of an object provide points that control the movement of the   object. Object handles 
appear in three types, depending on the operation   you are trying to perform:

 l Resize   Handles –   Allow you to resize an object. These automatically appear when you initially   
add most objects. 

 l Reshape   Handles –   Allow you to reshape an object. These automatically appear when you ini-
tially   add lines, arcs, chords, and pies. 

 l Rotate   Handles –   Allow you to rotate an object. These handles appear only when you rotate   a 
particular object (excluding ovals, rounded rectangles, charts, and   bitmaps). 

The following example illustrates a rectangle with resize handles. There   are four diagonal handles, two 
left and right handles, and two top and   bottom handles, as shown. When you initially add an object, 
object handles   appear. If you select outside the object, its handles disappear. Place   the cursor on the 
object and click (select) the object to display the   handles again.
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Object Handles

For examples of reshape and rotate handles, refer to the Reshaping   Objects and Rotating Objects   sec-
tions, respectively. When you display the object's handles, you can   control that object on the screen. 
Notice that when you display the handles,   that object's name is highlighted in the system tree. The fol-
lowing table   shows each cursor that is available, where it can be accessed in the iFIX   WorkSpace, and 
what the cursor allows you to do. 

The 
Cursor...

Positioned... Does this...

In the iFIX WorkSpace 
document outside of an 
object;   or anywhere in the 
system tree.

Selects an object or folder in the system tree, begins   clicking 
and dragging objects (left-click), or displays a picture pop-up   
window (right-click).

Anywhere on your 
screen.

Alerts you that the system is working and no input   can cur-
rently be processed.

On an object or group of 
objects.

Selects an object (single-click), displays the pop-up   menu 
(right-click), moves an object by clicking and dragging, or dis-
plays   the Animations dialog box (double-click).

On the up/down object 
handle, or at the top or 
bottom   edge of the pic-
ture.

Resizes an object or picture up or down.

On the left/right object 
handle, or at the left or   
right edge of the picture.

Resizes an object or picture left or right.

On the diagonal object 
handle, or at corner edges   
of the picture.

Resizes an object or picture diagonally.

Right edge of the system 
tree.

Expands the system tree.

Using   Drawing Cursors 
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In system tree, dragging 
into picture.

Drags and drops objects or Dynamos to a picture. The   
second cursor indicates that the location you are dropping to 
is not valid.

In the Edit Color palette 
when customizing colors.

Selects a color range.

On objects with points. Adds or deletes a point to an object. The white cursors   on the 
left indicate that a point cannot be added or deleted. The 
black   cursors on the right indicate a point can be added or 
deleted.

On pipe and polyline 
objects.

Splits pipes or polylines. The yellow cursor on the   left indic-
ates that a pipe can be split at that point. Note that the yellow   
cursor can actually be any contrasting color, depending on 
the color of   the pipe object. 

The black cursor on the right indicates that a polyline   can be 
split at that point. The white cursors indicate that pipes and   
polylines cannot be split at those points.

Anywhere when adding or 
reshaping shapes or 
charts.

Also appears on an 
object's center of rotation 
circle.

Provides a starting point to add or reshape a shape   or chart by 
clicking and dragging to a location.

As a rotation cursor, selects the center of rotation   so that you 
can relocate it by clicking and dragging the circle.

Anywhere when adding 
data links, current date, 
or   current time.

Adds a data link, current date, or current time.

Using Toolbars 

iFIX provides both WorkSpace and Picture toolbars to help you perform   various functions. Although both 
WorkSpace and Picture toolbars help you   perform actions in your picture, the Picture toolbars contain 
specific   tools to help you create and modify objects and their properties. The   following table describes 
the Picture toolbars available to you for drawing   pictures. 

NOTE: Although   hidden by default, you can access and use toolbars in Ribbon view. To   access a toolbar in 
Ribbon view, on the Home tab, in the WorkSpace group,   click Settings, and then click Toolbars. You can also 
open a toolbar from   the WorkSpace tree, by opening the Project Toolbar Files folder and double-clicking   the 
toolbar you want to open.

The tool-
bar...

Which can be accessed 
in Ribbon view...

Lets you...

Shapes From the Insert tab, in the 
Shapes group, in the 
Shapes   list.

Add shapes to your pictures. Refer to the Adding   
Objects to Pictures section for a list of the shapes 
you create.

Using Toolbars to Create and   Modify Pictures  
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Edit From the Home tab, in the 
Clipboard and Editing 
groups.

Perform basic functions with objects, including 
cutting,   copying, pasting, and undoing an action. 
Refer to the Performing   Basic Functions with 
Objects section for more information on these   
functions.

ChartGroup 
Toolbar

From the Tools tab, in the 
Chart group

Performs functions on objects in pictures such as 
applying the chart group wizard to a chart. For 
additional information, refer to the  Trending His-
torical Data ebook.

Translation 
Toolbar

From the Home tab, in the 
WorkSpace group, in the 
Settings tab, in the Tool-
bars group, on the Pictures 
toolbar selection window

Changes the language of the text in a picture that 
is open in run rode. For more information, refer to 
the Translating Picture Text section.

CAD Toolbar From the Home tab, in the 
WorkSpace group, in the 
Settings group, in the Pic-
ture Toolbar, or 

From the Format tab, inthe 
Picture group, in the draw-
ing Tools list.

Perform functions with line objects in the picture, 
such as extending and trimming lines, converting 
lines to polylines, converting lines to pipes, or 
adding/deleting connection points. Refer to the 
Performing Advanced Functions with Objects sec-
tion for more information on these functions

VisionX Tool-
bar

From the Insert tab, in the 
VisiconX Controls group

Select the function to insert into the picture.For 
more information, refer to the Using VisiconX 
ebook.

Tools From the Format tab, in the 
Arrange group.

Perform functions with objects in your pictures 
such   as aligning or grouping them. Refer to the 
Performing   Advanced Functions with Objects sec-
tion for a description of the functions   you can per-
form.

Toolbox From the Format tab, all 
groups and from the Tools   
tab, in the Tasks/Experts 
group.

Select the most commonly used toolbar buttons 
from   a resizable box. Refer to the Using   the Tool-
box section for more information.

Experts From the Tools tab, in the 
Tasks/Experts group, from   
the Tasks/Experts list.

Perform advanced functions with objects in the 
picture   or the picture itself, such as rotate, scale, 
or position. Refer to the   Using Wizards and 
Experts   section for more information on using 
experts.

Web HMI From the Tools tab, in the 
Web HMI group

Provides a Web HMI Toolbox to create high per-
formance GE Web HMI graphics for export to GE 
Web HMI, or to create high performance 
iFIX pictures that use the High Performance color 
set and High Performance settings for shape and 
picture creation. For more information, refer to the 
Creating High Performance Pictures e-book.
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To show or hide a Picture toolbar, select Toolbars from the WorkSpace   menu, select Picture in the 
Owner area, and then select or deselect the   appropriate toolbars. You must have a picture open in order 
to select   Picture from the Owner area. For more information on toolbars, refer to   the Understanding Tool-
bars   section of the Understanding iFIX manual.

You can also create your own toolbars, or write scripts for custom buttons   in toolbars. For more inform-
ation on creating and customizing toolbars,   refer to the Understanding  Toolbars chapter of the Under-
standing iFIX manual. For information   on writing scripts to customize toolbars, refer to the Writing 
Scripts   manual.

Using the Toolbox 

By default, many of the toolbar buttons appear in a Toolbox, allowing   you to quickly select the buttons 
you want from one place. The Toolbox   is also a convenient way to save space in your picture by not hav-
ing several   individual toolbars open. You can click and drag the Toolbox to position   it anywhere in the pic-
ture, or click and drag one of its edges to resize   it. 

If you would rather select buttons from specific toolbars, simply deselect   the Toolbox in the Toolbars dia-
log box.

The following table lists the names of the toolbar buttons found in the Toolbox. The layout of the cells in 
the table mimics the layout of the corresponding buttons in the Toolbox. The following layout is the 
default layout of the Toolbox.

Pointer Selec-
tion

Cut Copy Paste Time Date

Rectangle Rounded Rect-
angle

Oval Chord Polygon Pie

Pipe Arc Line Polyline Text Pushbutton
OLE Object Set Color Datalink 

Stamper
Historical 
Datalink

Alarm Sum-
mary

Variable Object

Chart Event Bitmap Set Font Line Multiline 
Chart

X Bar Chart

R Bar Chart S Bar Chart Histogram 
Chart

XY Chart Standard Cart Toggle Grid

Space Evenly 
Vertical

Space Evenly 
Horizontal

Align Top Align Left Align Bottom Align Right

Align Hori-
zontal Center

Align Vertical 
Center

Group Ungroup Bring to Front Send to Back

Set Layer Display Layers Foreground 
Color Expert

Position 
Expert

Position Expert Position Expert

Scale Expert Visibility 
Expert

Create Picture 
Wizard

Open Picture 
Expert

Close Picture 
Expert

Replace Picture 
Expert

Refresh Rate 
Expert

Data Entry 
Expert

VisiconX Data 
Control

VisiconX 
Grid Control

VisiconX List 
Box Control

VisiconX Combo 
Box Control

Undo      
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Using the Object Pop-up Menu 

As you create a picture, you can display a pop-up menu for the picture   or an object in the picture. To dis-
play an object's pop-up menu, right-click   the object. This menu provides quick access to the object's 
properties   and animations, as well as common operations you can perform with the   object, such as copy-
ing and pasting. 

You can also access this menu by right-clicking the object in the Pictures   directory of the system tree. 
This is an effective way to view or adjust   properties for invisible objects (which only appear in the sys-
tem tree)   added during animation.

NOTE: The pop-up menu   for objects differs somewhat from the picture pop-up menu. Refer to the   Using the 
Picture Pop-up   Menu section for more information on the picture pop-up menu.

The following table shows the functions that are available from the   object pop-up menu. Depending on 
the object you have selected, additional   operations may be available. 

Use the oper-
ation...

To...

Animations Display the Animations dialog box, which allows you   to animate the properties of an 
object or several objects.

Resize Display handles around the object so you can resize   it.
Reshape Display handles around the object so you can reshape   it.
Rotate Display rotate handles around the object so you can   move the object around its cen-

ter of rotation. 
Add Connection 
Point

Display a square green cursor with a smaller square   inside it and a crosshair when 
you are close to or moving over the object.   This menu item displays as Add Point 
when you right-click a polyline or   pipe object.

Dynamo Displays a Dynamo
Delete Con-
nection Point

Display a square, solid red cursor with a cross hair   when you are close to a con-
nection point that can be deleted. When not   close, the cursor becomes a red square 
with a minus sign and a crosshair.   This menu item displays as Delete Point when 
you right-click a polyline   or pipe object.

Split Polyline Display a splitting cursor that changes to black when   you are close to the polyline. A 
black cursor indicates that you can split   the polyline at that point. 

Convert to Pipe Convert the line or polyline to a pipe object.
Split Pipe Display a splitting cursor that changes to a contrasting   color when you are inside the 

edge of the pipe. A colored cursor indicates   that you can split the pipe at that point.
Make Horizontal Make the line horizontal.
Make Vertical Make the line vertical.
Undo Cancel the previous operation. If a particular task   cannot be undone, the Undo com-

mand is unavailable after you complete the   action.
Cut Remove the object from the picture and places it into   the clipboard.
Copy Create a duplicate copy of the object and place it   into the clipboard.
Delete Remove the object from the picture.
Duplicate Create a duplicate copy of the object and place it   slightly offset from the original.
Group Combine one or more objects into one grouped object.
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Bring to Front Move the selected object to the front or top of the   picture.

NOTE: This   function may not work as expected with Enhanced Charts. 
Send to Back Move the selected object to the back or bottom of   the picture.

NOTE: This   function may not work as expected with Enhanced Charts. 
Color Define fade, foreground, background, and edge colors   using a color palette.
Fill Style Specify a fill style of one of the following:

 l Solid 

 l Hollow

 l Horizontal

 l Vertical

 l Downward Diagonal

 l Upward Diagonal

 l Cross Hatch

 l Diagonal Cross   Hatch

 l Gradient

Refer to the Coloring   and Styling Objects section for further information on fill styles.
Edge Style Specify an edge style of one of the following:

 l Solid – Applies a   solid line style

 l Dash – Applies a   dashed pen line style

 l Dot –   Applies a dotted pen line style

 l Dash Dot – Applies a   dash-dot combination line style

 l Dash Dot Dot   – Applies   a dash-dot-dot combination line style

 l No Edge – Specifies   that the object contains no edge style

 l Inside Frame   – Applies   a solid line style inside the frame of the object

NOTE: If   you set the edge width to greater than 1, it displays as Solid regardless   of 
the selected edge style in the pop-up menu or the Shape Preferences   tab on the User 
Preferences dialog box.

Background 
Style

Specify a background style of either opaque or transparent.

Fade Type Specify a fade type of one of the following:

 l Linear – Applies a   vertically linear fade type inside the frame of the object.

 l Reflected – Applies a   horizontally reflected fade type inside the frame of the 
object.

 l Radial – Applies a   radial fade type inside the frame of the object.

 l Concentric – Applies a   concentric fade type inside the frame of the object.

Refer to the Coloring   and Styling Objects section for further information on fade 
types.

© 2024 General Electric Company. All rights reserved. 17



Edit Script Open the Visual Basic Editor, which allows you to   edit Visual Basic scripts.
KeyMacros Open the Key Macro Editor, which allows you to add   and edit key macros.
Property Win-
dow

Display the Properties Window, which allows you to   view and change property val-
ues.

Elbow Style Specify an elbow style for a pipe object. These styles   include:

 l Round – Applies rounded   edges to the bends in a pipe object.

 l Square – Applies squared   edges to the bends in a pipe object.
Start Cap Style Specify a start cap style for a pipe object. These   styles include:

 l Round – Applies a   rounded cap at the starting point of the pipe object.

 l Square – Applies a   square cap at the starting point of the pipe object.

 l Horizontal Diagonal   – Applies   a horizontally diagonal cap at the starting point 
of the pipe object.

 l Vertical Diagonal   – Applies   a vertically diagonal cap at the starting point of the 
pipe object.

End Cap Style Specify an end cap style for a pipe object. These   styles include:

 l Round – Applies a   rounded cap at the ending point of the pipe object.

 l Square – Applies a   squared cap at the ending point of the pipe object.

 l Horizontal Diagonal   – Applies   a horizontally diagonal cap at the ending point 
of the pipe object.

 l Vertical Diagonal   – Applies   a vertically diagonal cap at the ending point of the 
pipe object.

Modify Pipe 
Characteristics

Open the Modify Pipe Characteristics dialog box, which   allows you to edit the styles 
of pipe objects.

Edit Com-
mandButton 
Object

Place a text cursor in the push button object to allow   you to enter text.

Depending on the object you add, the pop-up menu may vary to include   operations specific to that 
object. For example, if you add a chart, you   can access the Chart Customization dialog box from the 
object pop-up menu.

Tag Status Pop-up Menu

When you associate database tags with an object, you can switch to the   iFIX WorkSpace run-time envir-
onment to view and test the object's   configuration. The run-time object provides a menu you can display 
by   right-clicking the object. The options on the menu depend on the number   of tags you associate with 
the object.

If you have associated tags with your objects, the following functions   are available from the object pop-
up menu in the run-time environment.

Use the oper-
ation...

To...
Run-time Object Pop-up Menu Commands
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Tag Status Open the Tag Status picture of the tag associated with the selected   object.

If multiple tags are associated with the selected object, open the Tag          Status picture of 
the first associated tag, or open the Tag Control Panel          picture, which lists the Tag 
Status pictures of all tags associated with          the selected object.

Quick Trend Open the Quick Trend picture of the tag(s) associated with the selected   object(s). The 
Quick Trend picture displays up to eight pens when multiple   tags are associated with 
the selected object(s).

 

Using the Properties Window 

You can display the properties of an object with the Properties window.   This window displays a two-
column list of the selected object's properties   that accept data. The Properties window is modeless,   
meaning that you can jump to different positions in the picture and the   window will stay on your screen. 
This is a convenient way to quickly read   properties of several objects in your picture or a picture itself. If   
no object is selected, the current picture's properties are shown in the   window. See the following 
examples.
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You can also display a different set of properties by selecting the   object or picture from the drop-down 
list at the top of the window.

To display the Properties window of an object, right-click the object   and select Property Window from 
the pop-up menu. You can also access this   menu by right-clicking the object in the Pictures directory in 
the system   tree, or by selecting Property Window from the View menu.

For more information on selecting properties, refer to the Controlling   Object Properties chapter.

Using the Color Box 

The iFIX color box contains all the tools you need to assign colors   to your objects and create customized 
color schemes. The color box offers   over 16 million color possibilities for use in your pictures, and can   be 
accessed from anywhere in the iFIX WorkSpace.

There are two color boxes you can choose from depending on how you want   to apply colors. The first 
option is a Select Color box that lets you   select fade, foreground, background, or edge colors for a spe-
cific object.   This dialog

The iFIX color box contains all the tools you need to assign colors   to your objects and create customized 
color schemes. The color box offers   over 16 million color possibilities for use in your pictures, and can   be 
accessed from anywhere in the iFIX WorkSpace.

There are two color boxes you can choose from depending on how you want   to apply colors. The first 
option is a Select Color box that lets you   select fade, foreground, background, or edge colors for a spe-
cific object.   This dialog box, shown in the following figure, is accessed by right-clicking   the object, point-
ing to Color then choosing Fade, Foreground, Background,   or Edge from the menu.
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NOTE: Refer to   the Setting Gradient   Fill Properties section, for more information about accessing the   Select 
FadeColor and Select ForegroundColor dialog boxes.

The second option is the Color Selection box. This box is modeless,   allowing you to select different 
shapes in your picture while the dialog   box remains on your screen. You can color as many objects as 
you like   using this box, and you can choose which property of the selected object   or objects you want to 
modify. Additionally, you can use a color palette   to customize a color set. The Color Selection dialog 
box, shown in the   following figure, is accessed by clicking the Color button on the Tools   toolbar (Classic 
view) or on the Format tab in the Styles group (Ribbon   view) or the Toolbox, if enabled.
   

NOTE: Any time you   open the Select Color or Color Selection dialog box, the undo stack is   removed.

For more information on applying color to your pictures, refer to the   Working with Color section.

Using the Find Mouse Coordinates Tool 
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The Find Mouse Coordinates Tool is available to track the x,y coordinates   of the mouse cursor in the 
iFIX WorkSpace. This is helpful if you want   to open a picture in a specific location in the WorkSpace, but 
do not   want to spend a lot of time guessing the coordinates of the location.   This is especially useful if 
you are spanning an iFIX display across multiple   monitors.

In Classic view, to access the Find Mouse Coordinates Tool, click the   following icon in the iFIX 
WorkSpace, on the Utilities toolbar:

In Ribbon view, you may access the Find Mouse Coordinates Tool from   the Tools tab, in the Tasks/Ex-
perts group, in the Pictures list or from   the Applications tab, in the Utilities group, in the Utilities list.

The Find Mouse Coordinates Tool appears in the WorkSpace, as shown in   the following figure.

To stop tracking the cursor, click anywhere in   the WorkSpace. To start tracking again, click the Resume 
tracking button.   To copy the cursor coordinates to the clipboard, click the Copy coordinates   button. After 
you copy the coordinates to the clipboard, you can paste   them into your OpenPicture   command, for 
example, as the coordinates for the top left corner of your   picture.

Using the Animations Dialog Box 

iFIX provides a Basic Animation dialog box, shown in the following figure,   allowing you to access many 
commonly used Animation Experts in one location.   These Animation Experts include Color, Movement, 
Fill, Click Command,   and Visibility Animation Experts as well as providing a link to the Advanced   Anim-
ations dialog box. The Advanced Animations dialog box allows you to   access all of the available object 
animations and change properties by   entering values into one of the tabbed pages. 
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Basic Animation Dialog   Box

To access the Basic Animation dialog box, double-click on an object   or select Animations from the 
object's right-click menu. 

You can also access the Advanced Animations dialog box by clicking the   Configure button in the Basic 
Animation dialog box. The Advanced Animations   dialog box, shown in the following figure, allows you to 
access all of   the property animations available to the selected object and also provides   a more detailed 
interface for adding or modifying property animations.   
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Advanced Animations Dialog   Box

To always open the Advanced Animations dialog box by default, clear   the Always Show Basic Anim-
ation dialog check box in the Picture Preferences   tab of the User Preferences dialog box. 

NOTE: Any time you   open the Animations dialog box, the undo stack is removed. This is because   certain 
property changes take effect even if the dialog box is closed   using the Cancel button.

Refer to the Animating   Object Properties chapter for more information on animating objects.

Using Basic Functions in Pictures 
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There are several functions you can perform in your picture, regardless   of the objects it contains. These 
functions are described in the following   sections.

 l Showing   a Picture

 l Refreshing   a Picture

 l Refreshing   a Thumbnail

 l Closing   a Picture

 l Using   the Picture Pop-up Menu

 l Using   the Picture Properties Window

 l Defining   the Picture Height and Width

 l Setting   the Picture Background and Fade Color

 l Setting   Gradient Fill Properties

 l Viewing   Your Picture in the Run-time Environment

 l Upgrading   the Picture to the Enhanced Coordinate System

 l Upgrading   Hardcoded Values in Animations

 l Converting   Button Captions

 l Restoring   a Picture to the Logical Coordinate System

 l Selecting   Zoom to Fit

 

Showing a Picture 

If you have more than one picture open in the WorkSpace, you can easily   view a picture that is behind 
another one by doing one of the following:

 l Double-clicking the   picture name in the system tree. 

 l Right-clicking the   picture name in the system tree and selecting Show from the pop-up menu.   

 l Select the picture   name from the Window menu. 

Another effective strategy for showing multiple pictures is using the   tiling and cascading functions, 
described in the Tiling   and Cascading Pictures section.

Refreshing a Picture 

You can refresh a picture by right-clicking the picture name in the   system tree and selecting Refresh 
from the pop-up menu. You can also select   Refresh from the View menu (Classic view) or from the View 
tab, in the   Picture group, in the View list (Ribbon view). When you refresh a picture,   iFIX repaints the cur-
rent picture on the screen.

Refreshing a Thumbnail 
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You can refresh a thumbnail by right-clicking the picture name in the   system tree and selecting Refresh 
Thumbnail from the pop-up menu. When   you refresh a thumbnail, iFIX saves the picture with a thumbnail 
(if it   did not already exist), and repaints the current thumbnail on the System   Tree. 

Closing a Picture 

You can close a picture by right-clicking the picture name in the system tree and selecting Close from 
the pop-up menu. 

Using the Picture Pop-up Menu 

When creating pictures, you can display a pop-up menu for that picture   by right-clicking the picture name 
in the system tree, or by right-clicking   any area in the picture outside of an object. The pop-up menu 
provides   quick access to the picture's specific properties and animations, as well   as common oper-
ations you can perform within the picture, such as selecting   all objects.

The following table shows the functions that are available from the   picture pop-up menu. 

NOTE: Functions   apply to both the Logical and Enhanced Coordinate Systems unless stated   otherwise. 

Use the 
Operation...

To...

Animations Display the Animations dialog box that lets you animate   properties of the pic-
ture.

Undo Cancel the previous operation. If a particular task   cannot be undone, the Undo 
command is unavailable after you complete the   action.

Paste Place the most recently copied object into your picture.   
Select All Select all objects in the picture window. 
Bring to 
Front

Move the selected picture to the front of the stack.

Send to 
Back

Move the selected picture to the back of the stack.

Space 
Evenly

Tile the open pictures in one of the following ways:

 l Horizontal

 l Vertical
Zoom Change the width and height of the viewport   by 50%, 150%, or 200% of the 

window size, or return the viewport   size to 100% of the window size. The view-
port   is described in the Implementing   Pictures in Your Process chapter.

Default 
View

Restore the original view of the picture before the   window's size was changed.

NOTE: This function   applies only to Logical Coordinate System pictures. This func-
tion does   not apply to Enhanced Coordinate System pictures.

Full View Expand the window to occupy the entire client-area.

NOTE: This function   applies only to Logical Coordinate System pictures. This func-
tion does   not apply to Enhanced Coordinate System pictures.

Picture Pop-Up Menu Functions    
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Fit Picture to 
Window

Resize the picture to fit inside the picture window,   if necessary.

NOTE: This function   applies only to Logical Coordinate System pictures. This func-
tion does   not apply to Enhanced Coordinate System pictures.

Fit Window 
to Picture

Resize the window to fit the size of the picture,   if necessary.

NOTE: This function   applies only to Logical Coordinate System pictures. This func-
tion does   not apply to Enhanced Coordinate System pictures.

Update Win-
dow Loca-
tion

Preserve the current view of the picture so that,   after being saved, it will look 
exactly the same way it did on the screen   as when you closed it.

Refresh Repaint the current picture in the picture window.
KeyMacros Open the Key Macro Editor, which allows you to view   and edit key macros.
Property 
Window

Display the Properties window for the current picture.   

Picture Display the Edit Picture dialog box, which allows   you to change window prop-
erties.

Edit Script Open the Visual Basic Editor, which allows you to   edit Visual Basic scripts.
Enable 
Scripts

Reference all selected objects into Visual Basic scripts.

NOTE: The pop-up menu   for pictures differs somewhat from the object pop-up menu. Refer to the   Using the 
Object Pop-up   Menu  section for more information on the object pop-up menu.

Using the Picture Properties Window 

To display the Properties window of a picture, right-click the picture name in the system tree and select 
Property Window from the pop-up menu. For more information on Properties, refer to the Controlling 
Object Properties chapter.

Defining the Picture Height and Width 

You can define the height and width of the window in your picture using   the Edit Picture dialog box.

The window dimensions are specified as percentages.  For   more information on implementing pictures, 
see the Implementing   Pictures in Your Process section.

 To define the picture height and   width:

 1. Right click the picture   name in the system tree.

 2. Select Picture from   the pop-up menu.   

-Or-

In Classic view, select Picture from the   Edit menu.

-Or-

In Ribbon view, on the Home tab, in the   Editing group, in the Properties list, click Picture.
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 3. In   the Properties section, type in the new Window Width or Window Height   as percentages.

 4. Click   on the Apply button.

 5. View   the picture.  Make   any additional changes as you wish.

 6. When   you do not want to make any more changes, click the OK button to save   the picture.

The Picture Preferences dialog box contains the default picture preferences   that apply to newly created 
pictures.

Setting the Picture Background and Fade Colors

You can set the background and fade colors of your picture using an   unlimited selection of colors. This is 
useful for customizing your screens   to complement multi-colored objects in your picture and to give your 
pictures   a three-dimensional look. The default background and fade colors are displayed   in the Picture 
Preferences dialog box when you create a new picture. You   can change the default colors by clicking the 
Background Color or Fade   Color buttons and choosing a color from the Select Color dialog box.

For more information on using color in your pictures, refer to the Working with Color section.

 

Setting Gradient Fill Properties

The gradient fill features allow you to illustrate your real-world objects,   like tanks and pipes, with a three-
dimensional look. A gradient fill can   also be used for the picture itself. The gradient fill is composed of   
fade color, fade type, blend percentage of fade color, and gradient angle   of fade color. For more inform-
ation about applying fade color, see Setting the Picture   Background and Fade Colors and Working   with 
Color.

Like the behavior of other fill styles, you can animate the gradient   effect with the shape; for example, 
rotate, scale, fill, and translate   with the shape; however, you cannot animate gradient effects in your pic-
ture.

You can right-click an object and apply the individual gradient fill   properties after you have set the fill 
style to Gradient. You can also   apply the properties all at once using the gradient preview dialog box.   
The gradient preview dialog box   for shapes contains the tools you need to preview and apply gradient fill   
properties. 

The type of object you select determines the properties available for   your use. For example, pipe objects 
have a different gradient   preview dialog box where the properties specific to pipe objects are   available, 
as well as gradient fill properties. For other shapes, only   gradient fill properties are available.

Clicking the Foreground or Fade color buttons opens the Select Color   box where you can choose the col-
ors you want to apply to your shape or   pipe. For more information about choosing colors for your shapes, 
refer   to Using the Color Box.

When you choose Fade from the Color pop-up menu on a shape object, the   Gradient preview tab of the 
Select FadeColor dialog box appears. The fields   on this dialog box allow you to apply gradient fill prop-
erties to the   object. These fields are available only when you select a single shape   object. If you select 
multiple objects, you can only choose a color from   the Select Color dialog box.
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Shape   Gradient Preview Dialog Box

When you choose Fade from the Color pop-up menu on a pipe object, the   Gradient preview tab of the 
Select FadeColor dialog box appears. The fields   on this dialog box allow you to apply pipe and gradient 
fill properties   to the pipe object. 

Pipe   Gradient Preview Dialog Box
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These dialog boxes offer a central place to apply gradient fill properties   rather than making individual 
changes using the right-click pop-up menu.   However, you cannot make gradient fill changes to multiple 
shape objects.   

For more information about making changes to multiple pipe objects,   refer to Modifying Pipe   Char-
acteristics.

The following sections describe the different gradient fill features   that you can apply to your shape 
objects.

Fade Type 

Fade type blends the fade color with the foreground and background colors   to produce the three-dimen-
sional appearance in the shape. You can apply   the following fade types to your objects and pictures:

Fade Type Description

Linear The foreground color fades to the fade color from   one end of the shape 
to the other.

Reflected The foreground color converges to the fade color in   the center of the 
shape in a linear fashion.

NOTE: This   fade type may not display in long, narrow rectangular 
shapes.

Radial The foreground color is darkest around the edges and   recedes radially 
towards the center.

Concentric The foreground color is darkest along the edges and   center with a con-
centric band of fade color in between.

 

             

Linear     Reflected

 

30 © 2024 General Electric Company. All rights reserved.



                            

Radial Concentric

 

Blend Percentage of Fade Color

When you use gradient fill, you can change the way colors are mixed   to achieve different effects. The 
blend percentage is the amount of fade   color that is applied to the fade type. The higher the percentage, 
the   more fade color is visible. The following diagrams show different blend   percentages.

                               

20% Blend 50% Blend 75% Blend

 

Gradient Angle of Fade Color

Gradient angle is the angle, in degrees, of the gradient brush. The   default gradient angle is 0° and is 
always on the right side of the shape.   You can apply as precise an angle as you need using the Gradient 
Angle   slider.
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0° Angle 90° Angle 135° Angle

 

                                              

180° Angle 270° Angle

 

Viewing Your Picture in the Run-time Environment 

To view a picture, you do not have to leave the application you are   in or shut anything down. You can 
switch environments directly from the   WorkSpace with the click of the mouse. To view your picture, use 
one of   the following methods:

 l Click the Switch   to Run button on the Standard toolbar (Classic view).

 l Click Switch to Run   in the WorkSpace group on the Home tab (Ribbon view).

 l Press CTRL+W   on your keyboard.

You can also control other preferences at run-time using the User Preferences   dialog box. Refer to the 
Using  the iFIX WorkSpace chapter of the Understanding iFIX manual   for more information on iFIX 
WorkSpace preferences and on switching environments.
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Upgrading Pictures to Enhanced Coordinates

The Enhanced Coordinate System allows you to upgrade   one or more pictures (or Dynamo Sets) cre-
ated with the Logical Coordinate   System. 

IMPORTANT:
It is recommended to upgrade   your pictures in groups, verifying the upgrade along the way to ensure   that pic-
tures are upgrading in accordance with your expectations.    Also,   because the upgrade process is resource 
intensive, it is recommended to   refrain from other CPU intensive tasks during the time of upgrade.
When using constant numeric   values in scripting for object dimension and position, you may need to   edit the 
script to implement the Enhanced Coordinate System. For more   information, refer to the Upgrading   Hard-
coded Values in Animations section.
If your iFIX project is   configured in a path other than the LOCAL directory in the SCU or if you   have multiple 
SCUs in different locations (for example, Terminal Services   or iPower setup), you must upgrade the iFIX 
default files. When   you upgrade from iFIX 5.5 or earlier with this scenario, the listed new   Utility toolbar options 
related to the Enhanced Coordinate System will   not appear on your screen or work properly. To fix this situ-
ation, first   upgrade to iFIX 5.8 and then follow the directions to upgrade the iFIX   default files. 

NOTE: This procedure   must be performed for every project.

 1. Start the SCU.

 2. On the Configure menu,   click Paths to open the Path Configuration dialog box to make your changes.

 3. Click Change Project.    A message   box appears asking if you want to generate the default iFIX files to 
the   project.

 4. Click Yes and then OK.

Before You Upgrade the Picture 

Prior to upgrading the picture (or Dynamo Set) to the Enhanced Coordinate   System, open the picture in 
the screen resolution in which the picture   was created or displayed (with the Logical Coordinate Sys-
tem). Make sure   that the picture opens without errors and displays as desired before   you start the 
upgrade process. The picture you view on the screen resolution   with the Logical Coordinate System is 
exactly what will be upgraded to   the Enhanced Coordinate System; that is, if the picture contains a scal-
ing   issue, that issue is converted to the Enhanced Coordinate System. Fix   any errors that display when 
opening the picture or Dynamo Set, such as   those for missing references, as this will prevent the picture 
or Dynamo   Set from upgrading successfully. When you are satisfied with the picture,   continue with the 
upgrade process.

 To upgrade a   picture:

 1. Close all pictures   and Dynamo Sets. A warning message appears when a picture or Dynamo Set   
is open.

 2. In Classic view,   on the Utilities toolbar, click the Upgrade File to Enhanced Coordinates icon.

-Or-

In Ribbon view, on the Applications tab,   in the Utilities menu, click Upgrade Files to Enhanced 
Coordinates.

The Upgrade Pictures to Screen Independent   Enhanced Coordinates dialog box appears with the 
Upgrade Files option   selected.

A list of eligible files from the default   folder displays in the Select Files window depending on the 
File Type   selected. 
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 3. Select the File Type   you wish to display in the Select Files window. 

 4. To display files   from a different directory,in the Pictures and Dynamos Set Folder Path   window 
specify the new directory. Then, select the Refresh File List button.   You can also browse and 
select an available folder by using the Browse   button followed by the Refresh Files List button.

 5. Select the appropriate   file(s) you   wish to upgrade from the Select Files window. The Upgrade but-
ton becomes   enabled.

 6. Press the Upgrade   button. This operation backs up the files selected for upgrading, and   then 
upgrades the files. The upgraded files are removed from the Select   Files list when the upgrade is 
completed. 

 7. Confirm that the   picture was upgraded by using the Properties Window to examine the 
EnhancedCoordinates   property for that picture (where "True" indicates the file was   upgraded suc-
cessfully), or by checking the picture or Dynamo icon in the   system tree.

To cancel the upgrade while it is in progress, click the Cancel button.   Files that were upgraded remain 
upgraded. Files that were to be upgraded   are not upgraded.

For information on restoring upgraded files, refer to the Restoring   a Picture to the Logical Coordinate Sys-
tem section.

 After You Upgrade the Picture

Make sure all the objects within the picture are located at the right   positions and that the picture is a valid 
size.  In   some cases, upgraded pictures may contain objects that reside outside   of the document 
extents. After upgrading these pictures, the objects may   not display correctly when viewing the picture 
in Zoom to Fit in the Enhanced   Coordinate System. If this occurs, modify the document extents by edit-
ing   the picture properties DocumentHeightEx   and DocumentWidthEx.   

The Upgrade File to Enhanced Coordinate expert checks the position of   each object in the picture as it is 
upgraded. When an object resides outside   of the document extents, a message is written to the log file, 
UpgradeCoordinatesLog_<date   time>, which recommends new settings for these properties. The log   
file resides in the current project’s configured Alarm (ALM)   folder. A new log file is created each time an 
upgrade is run. 

A sample log file for an upgrade that requires modifications is as follows:

2013_8_29 23_14_49 iFIX Enhanced Coordinates Upgrade Expert 5.8.10367.0Copyright(c) 2013, General Electric Company. All Rights Reserved.
2013_8_29 23_14_49 Upgrade started Thursday, August 29, 2013 2:14:49 PM.
2013_8_29 23_14_49 Upgrade Picture Path: C:\PROGRAM FILES (X86)\PROFICY\PROFICY IFIX\PIC\
2013_8_29 23_14_49 Some upgraded objects in file TestPicture3 are outside of the new document extents and may not be visible. To fix this:
2013_8_29 23_14_49           Set the value of DocumentHeightEx in the property window to be greater than or equal to 452.700000.
2013_8_29 23_14_49           Set the value of DocumentWidthEx in the property window to be greater than or equal to 616.500000.
2013_8_29 23_14_52 Upgrade completed Thursday, August 29, 2013 2:14:52 PM. Closing the log file.
 

A sample log file for an upgrade that does not require changes is as   follows:

2013_8_29 23_20_54 iFIX Enhanced Coordinates Upgrade Expert 5.8.10367.0
Copyright(c) 2013, General Electric Company. All Rights Reserved.
2013_8_29 23_20_54 Upgrade started Thursday, August 29, 2013 2:20:54 PM.
2013_8_29 23_20_54 Upgrade Picture Path: C:\PROGRAM FILES (X86)\PROFICY\PROFICY IFIX\PIC\
2013_8_29 23_20_58 Upgrade completed Thursday, August 29, 2013 2:20:58 PM. Closing the log file.
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 To verify the   picture upgraded correctly:

 1. Check the log files   to determine if changes need to be made to the picture(s)   properties in the 
Properties window. The log file (UpgradeCoordinatesLog_201x_x_xx   xx_xx_xx) resides   in the 
current project's configured ALM   folder. This log file name contains the current date and time 
when the   Upgrade File to Enhanced Coordinate expert was run.  

 2. Examine the log files   to determine if the picture(s)   needs to be changed. 

 3. If necessary, modify   the document extents (DocumentHeightEx   and DocumentWidthEx)   so that 
window sizes are calculated correctly.

 4. Verify that the picture   displays correctly.
 

Upgrading Hardcoded Values in Animations

Position (horizontal/vertical) and dimension (height/width)   properties for an animation within a picture 
that was upgraded to the   Enhanced Coordinate System may not work as expected when you have hard-
coded   values that are either:

 l Used in the Expression   Builder for the position and dimensions animation of objects.

 l Assigned via scripts   for the position and dimensions of objects.

To upgrade the animation to work correctly, you must modify the animation   with valid values for the 
Enhanced Coordinate System.

 To modify the   animation, perform one of the following:

 l Change the hardcoded   value in the Expression Editor to reflect the Enhanced Coordinates value   
in postscript points.

Place a sample script into the same picture   that needs the hardcoded values updated. For 
example, the following sample   script contains a value of 10 for the horizontal position:
Private Sub Rectl_Edit()
MsgBox Me.ConvertToEnhanced Coordinates (10, True)
EndSub

Then, replace the value in the Expression   Editor for your animation with the value that displays in 
the message   box.

NOTE:   The script to derive the Enhanced Coordinate value must be placed under   the same picture 
that requires the edits for the animation.

 l Place Me.ConvertToEnhancedCoordinates(   ) around the hardcoded value in a script.

For more information, see  the   example in the ConvertToEnhancedCoordinates  Method Example 
section in the iFIX Automation Reference e-book. 

Converting Button Captions 

The Button Caption Converter allows you to scale one or more button   captions (text) in an active picture. 
When converted, the caption text   automatically scales to the resolution of the target screen and sits dir-
ectly   on top of the command button as an overlay.  
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NOTE: If you   have a button with long caption strings and a button caption appears in   multiple lines with the 
WordWrap property enabled,  edit   the button caption by entering a new line (Shift-Enter) where you want   the 
string  to   wrap. Then, convert the Button Caption.  The   Button Caption Converter should make the button and 
text for multiple   lines appear as you desire.

Before you Convert a Button Caption

After you upgrade a picture to use Enhanced Coordinates and before you   convert a button caption, make 
sure all the objects within the picture   are located at the right positions and that the picture is a valid size.   
In some cases, upgraded pictures may contain objects that reside outside   of the document extents. 
After upgrading these pictures to use Enhanced   Coordinates, the objects may not display correctly 
when viewing the picture   with Zoom to Fit. If this occurs, modify the document extents by editing   the pic-
ture properties DocumentHeightEx   and DocumentWidthEx.   For a description of the DocumentHeightEx 
and DocumentWidthEx properties,   refer to the DocumentHeightEx   and DocumentWidthEx   sections in 
the iFIX Automation Reference   e-book.

The upgrade expert checks the position of each object in the picture   as it is upgraded. When an object 
resides outside of the document extents,   a message is written to the log file, UpgradeCoordinatesLog_
<date   time>, which recommends new settings for these properties. The log   file resides in the current pro-
ject's configured Alarms path folder. A   new log file is created each time an upgrade is run. For log file 
examples,   see the information in the Upgrading   a Picture to Enhanced Coordinates section. 

IMPORTANT:    If you   choose to relocate the command button caption within the picture, you   must move both 
the original command button and the newly created overlay   together. Otherwise, the exact   placement the 
overlay on top of  the   command button is lost. If you choose to modify any button property or   caption, you must 
first edit the button object and then convert the button   object again.

 To convert a   selected button caption:

 1. Open the picture   that contains the button caption you wish to convert. 

 2. Select a button object   to convert.

 3. In Classic view,   click on the Convert a Selected Button's Caption icon  in   the Utilities toolbar.

-Or-

In Ribbon View, on the Applications tab   select the Utilities button.  From   the Utilities drop-down 
menu, select Convert a Selected Button's Caption.

The Button   Caption is converted and scales to Zoom to Fit view.

 4. Verify that the button   caption was converted by viewing the graphic with the converted text.

 

 To convert multiple   button captions:

 1. Open the picture   that contains the button captions you wish to convert.

 2. In Classic view,   click on the Multiple Button Caption Converter Expert icon  in the Utilities tool-
bar.

-Or-

In Ribbon View, on the Applications tab   select the Utilities button. From the Utilities drop-down 
menu, select   Multiple Button Caption Converter Expert.

The Button Caption Converter dialog box   appears. A listing of button captions eligible for con-
version display   in the "Push button found in picture' dialog box.
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 3. From the list of   eligible objects, select the button object you wish to convert. You can   confirm that 
the button is selected by looking in the picture, or clicking   on "Find Next" to confirm the con-
version of each button object   individually.

 4. Click   the Convert Button Caption button. The selected button object is converted.

 5. Repeat steps 3 and   4, or click 'Convert All' to convert all the button objects.

 6. Verify that the button   captions were converted by viewing the graphic with the converted text.

NOTES:

 l When you need to modify   the button caption, color, animations, move or delete groups,  first   edit the 
button object and then convert the button object.

 l The number of buttons   selected during the conversion process may  impact   the picture loading time. 
For efficient picture loading, it is recommended   to minimize the number of button conversions.

 l If you want to change   the button Foreground  and   Background color  properties   from the default, select 
the color from the system default color selection   in the Property Window, or from the Advanced Anim-
ation dialog box.

 l WordWrap properties are   not applied.  Instead,   you must insert a CR (Shirt-Enter) to make a caption to 
be multiple lines   in the button before the conversion.

 

Restoring a Picture to the Logical Coordinate System

You can restore an upgraded Enhanced Coordinate System picture to a   Logical Coordinate System pic-
ture.  Prior   to upgrading to the Enhanced Coordinate System, pictures are backed-up   to a Backup dir-
ectory for this purpose.

NOTE:  Make   sure the picture file is closed both locally and remotely before you attempt   to restore a picture.  
Picture   files that are open in a local or a remote session are not eligible for   restoration, and will not display in 
the Select Files window until the   picture is closed.

 To restore a   picture to the Logical Coordinate System:

 1. Close all pictures   and Dynamo Sets. A warning message appears when there are files open and   
need to be closed before you can proceed.

 2. In Classic view,   on the Utilities toolbar, click the Upgrade File to Enhanced Coordinates icon.

-Or-

In Ribbon view, on the Applications tab,   in the Utilities drop-down menu, click Upgrade File to 
Enhanced Coordinates.

The Upgrade Pictures to Screen Independent   Enhanced Coordinates dialog box appears with the 
Upgrade Files option   selected. A list of eligible files from the default folder display in   the Select 
Files window (depending on the File Type selected).

 3. Select the Restore   Files from Backup option. A list of eligible files from the Backup directory   dis-
play.

 4. To display files   in a different directory, specify the new directory in the Pictures and   Dynamos 
Set Folder Path window. Then, select the Refresh File List button.   You can also browse and 
select an alternate folder by using the Browse   button followed by the Refresh Files List button.
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 5. Select the appropriate   file(s) from   the Select Files window. The Restore Files button becomes 
enabled.

 6. Click the Restore   Files button. This restores the file(s)   to the Logical Coordinate System. The 
restored files are removed from   the Select Files list when the operation completes.  

 7. Confirm that the   picture was restored by using the Property Window to examine the 
EnhancedCoordinates   property for the picture. (False - indicates the file was restored to   the 
Logical Coordinate System successfully.)

Selecting Zoom to Fit

Zoom to Fit is an Enhanced Coordinate System option that automatically   resizes the picture area to fit 
the entire window and also suppresses   scroll bars. The Zoom to Fit option is only for viewing pictures 
and does   not allow you to edit the picture.

NOTES:

 l When using Zoom to Fit   in Configuration mode, edits to the file are disabled and grids are also   dis-
abled.

 l When using Zoom to Fit   on a picture with a lower resolution that was converted to the Enhanced   
Coordinate System, be sure to verify that all the objects are visible.   Check the height and width of the 
picture in run mode. If all the objects   are not visible, change the height and width of the picture  to   see 
all the objects. Then, Save the picture.  By   default Zoom to Fit is enabled in run mode.  To   disable 
Zoom to Fit, press Ctrl+M.    All objects   should appear in the picture.

 To select   Zoom to Fit to view a picture:

 1. Open the   picture you want to use for Zoom to Fit.

 2. In Classic   view, select the Windows menu and then Zoom to Fit —   or press Ctrl+M.

-Or-

In Ribbon view, on the View tab and in the   Zoom group, click Zoom to Fit —   or press Ctrl+M.

The Workspace displays a message box to   inform you that:

 l Zoom   to Fit is view only and edits are disabled.  

 l Turn   Zoom to Fit off (Ctrl+M)   to enable editing.

 3. Click OK   to continue.

The picture automatically scales to fit   the entire window and suppresses the scroll bars.   

A small toolbar appears, which you can select   to close Zoom to Fit, or you can enter Ctrl+M   to 
toggle Zoom to Fit.

 

Performing Advanced Functions in Pictures 

iFIX gives you complete control of your pictures by allowing you to   easily perform advanced procedures. 
The sections that follow introduce   some of the functions that are available, many of which are access-
ible   from the picture pop-up menu. The Implementing   Pictures in Your Process chapter expands on 
these concepts and details   additional features for controlling how your pictures look.
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 l Sharing   Picture Files

 l Replacing   a Picture

 l Changing   the Picture View

 l Tiling   and Cascading Pictures

 l Creating   Pictures without Title bars

Sharing Picture Files 

iFIX lets you share picture files so that other users can access pictures on a different system. You can 
do this by placing the files on a file server and sharing a path. For more information on sharing files, refer 
to the Sharing Files  section in the Understanding iFIX manual.

Replacing a Picture 

To replace a picture with another picture, use the Replace Picture Expert,   located on the Experts toolbar 
(Classic view) or on the Tools tab, in   the Tasks/Experts area, click Tasks/Experts (Ribbon view). This 
Expert   allows you to close a picture and replace it with another picture in both   the configuration and run-
time environments. If desired, you can specify   an alias to the picture that is automatically assigned as 
the new picture   name. For more information on Experts, refer to the Using   Process Assistants to Exped-
ite Pictures chapter.

Changing the Picture View 

By giving you control of the window, iFIX makes it easy to change a   picture's magnification. There are 
several different views you can create   using the picture pop-up menu. These include:

 l Zoom 

 l Default View 

 l Full View 

 l Fit Picture to Window   

 l Fit Window to Picture   

 l Zoom to Fit 

Refer to the Controlling   a Picture's Magnification section for more information on specifying   viewing 
options.

Tiling and Cascading Pictures 

As you create and modify pictures, you may want to have several pictures   open at once. Depending on 
the size and position of the pictures opened,   this can result in one or more pictures hidden behind the top 
picture.   Although you can use the Show function to switch from one to another,   or manually move or res-
ize a picture, you may want to view more than one   at a time. A fast, easy way to arrange multiple 
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pictures is to tile or   cascade them using the Window menu. (Both Tile and Cascade are found on   the 
View tab in ribbon view.)

When you tile two or more pictures, iFIX arranges each picture so that   they do not overlap and resizes 
each window so that all the pictures fit   in the available client area. You can tile pictures horizontally or 
vertically.   To do this select Tile Horizontal or Tile Vertical from the Window menu.   Both methods of tiling 
are shown in the following figures. 

Tiling Horizontally
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Tiling Vertically

You can open as many pictures as you want, limited only by the amount   of memory in your computer. 

When you cascade two or more pictures, the pictures are staggered and   resized equally so that you can 
select each picture by its title bar.   This is illustrated in the following figure. To cascade pictures, select   
Cascade from the Window menu.

Cascading Pictures
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Creating Pictures without Title bars 

You can also create pictures with no title bars. This is a particularly   helpful feature when you want to 
view your pictures as   is in your operator display. The following figure illustrates a   picture without a title 
bar.

Picture without a Title   bar

You cannot tile or cascade a picture without a title bar.

If you want to create a full screen picture without a title bar make   sure that you deselect the Title bar 
check box. 

 To create a full screen picture without   a title bar: 

 1. In Classic view,   on the WorkSpace menu, click User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences.

 2. Click the Picture   Preferences tab. 

 3. Deselect the Titlebar   check box. 

 4. Click OK. 

NOTE: If you intend   to autoscale pictures created without titlebars, the picture must be started   titleless.

There are many additional style options for the picture window. For   more information on these window 
properties, refer to the Planning   Your Pictures section.

Overview Checklist

The list below describes the tasks to create a picture.

 To create a picture: 

 1. In Classic view,   on the Standard toolbar, click the New Picture button. 
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-Or-

In Ribbon view, click the WorkSpace button,   select New, and then click Picture.

 2. Using the Shapes   toolbar, add objects to the picture. In Ribbon view you may also add objects   
form the Insert tab from the Shapes group. If you want to use a pre-configured   object, add a 
Dynamo. If you want to attach a script to the object, run   an Expert. 

 3. Using the Animations   dialog box, modify or animate the object's properties. 

 4. If desired, write   an event-based script for your pictures and objects. 

 5. In Classic view,   on the WorkSpace menu, click Switch to Run to view your picture in the   run-time 
environment. 

-Or-

In Ribbon view, from the Home tab, in the   WorkSpace group, click Switch to Run.

 6. In Classic view,   on the WorkSpace menu, click Switch to Configure to switch back to the   con-
figuration environment. 

-Or-

In Ribbon view, from the Home tab, in the   WorkSpace group, click Switch to Configure.

How Do I...

In the iFIX WorkSpace, you can perform the following steps with   pictures:

 l Changing   Your Window Size 

 l Setting   the Fade Type of a Picture

 l Setting   the Gradient Angle of a Picture's Fade Type

 l Zooming   In and Out of Pictures

 l Updating   the Window Location

 l View   All Thumbnails

 l Enabling   or Disabling Window Properties

 l Resolving   Pictures

 l Saving   Thumbnails for Previously Created Pictures or Dynamo Sets

 l Importing   Windows Metafiles

 l Assigning   Pictures to a Security Area

 l Defining   the Attributes of a Custom Picture

 l Using   Specified Dimensions

 l Modifying   Picture Properties

 l Using   the Dimensions of an Existing Picture

 l Setting   the Options on the WorkSpace Appearance Page

 l Tracking   Cursor Coordinates

 l Using   the Grid
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 l Upgrade   Pictures to the Enhanced Coordinate System

 l Convert   Button Captions

 l Restore   Pictures to the Logical Coordinate System

 

Changing Your Window Size 

The window size is always defined as a percentage of the screen. By   sizing a window by the percentage 
of the screen, iFIX scales your picture   while maintaining its coordinate system and displays the picture 
with   its original aspects regardless of the monitor's resolution on which it   is viewed. Both the Window 
Width and Window Height must be within 0-100   percent.

 To change your window size:

 1. In Classic view,   in the iFIX WorkSpace, on the Edit menu, click Picture. 

-Or-

In Ribbon view, on the Home tab, in the   Editing group, click Properties, and then click Picture. 

 2. In the Window Width   field, enter a picture width as a percentage.

NOTE: Be careful   when entering a percentage as its meaning is different for each coordinate   system. For 
more information on percentages for both coordinate systems,   refer to the Controlling   a Picture's Mag-
nification section.

 3. In the Window Height   field, enter a picture height as a percentage. 

 4. Click the Apply button   to view the change.

 5. Continue to adjust   the percentages and apply the changes until you have the picture as you   want 
it to be.

 6. Click the OK button   to save the window settings.

 

Setting the Fade Type of a Picture

 To set the fade   type of a picture:

 1. In Classic view,   in the iFIX WorkSpace, on the Edit menu, click Picture. 

-Or-

In Ribbon view, on the Home tab, in the   Editing group, click Properties, and then click Picture. 

 2. Select the Gradient   enabled check box and then select the fade type you want to apply to the   
gradient.

NOTE:   The Gradient enabled check box is automatically selected in this dialog   box if it has been 
selected in the Picture Preferences tab of the User   Preferences dialog box.

 

Setting the Gradient Angle of a Picture's Fade Type
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 To set the gradient   angle of a picture's fade type:

 1. In Classic view,   in the iFIX WorkSpace, on the Edit menu, click Picture. 

-Or-

In Ribbon view, on the Home tab, in the   Editing group, click Properties, and then click Picture. 

 2. Select the Gradient   enabled check box and then select the fade type you want to apply to the   
gradient.

 3. Move the Gradient   Angle slider to the angle you want applied to the fade type. 

Zooming In and Out of Pictures

 To zoom in and   out of a picture:

 1. In the iFIX WorkSpace,   right-click any area in the picture outside of an object, point to Zoom   and 
choose the desired magnification.

 2. To zoom out, repeat   step 1.

 

Updating the Window Location

 To update the   window location:

 1. In the iFIX WorkSpace,   adjust the picture window size and location.

 2. Right-click any area   in the picture outside of an object and choose Update Window Location.

 3. Save the picture.   When you open the picture later, or switch back to the configuration envir-
onment   after viewing it at run-time, the picture will appear with the same size   and location you set 
in step 1.

 

Viewing all Picture and Dynamo Set Thumbnails at Once

 To view all picture   and Dynamo set thumbnails at once:

 1. In Classic view,   in the iFIX WorkSpace, on the Standard toolbar, click the Open Picture   Folder 
button. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group click Open Picture Folder. 

 2. Select the folder   that contains your iFIX pictures.

NOTE:   The PIC folder   is the default folder location.

 3. Click OK.   A window opens that displays thumbnails, if they exist, for all pictures   and dynamo 
sets.

 

Enabling or Disabling Window Properties
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 To enable or   disable a window property:

 1. In Classic view,   in the iFIX WorkSpace, on the Edit menu, click Picture. 

-Or-

In Ribbon view, on the Home tab, in the   Editing group, click Properties, and then click Picture. 

 2. Select or clear one   or more check boxes corresponding to the window properties you want to   
enable or disable.

 

Resolving Pictures

 To resolve a   picture:

 1. In Classic view,   in the iFIX WorkSpace, on the Utilities toolbar, click the Resolve Files   button. 

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Utilities, and then click 
Resolve Files.   

 2. In the File Types   area, select the Pictures check box.

 3. In the Directories   area, verify that your picture directory is correct. If not, enter the   correct path in 
the Pictures field.

 4. In the Resolve Files   area, select the picture file you want to resolve. To select every file   in the 
list, click Select All.

 5. Click the Update   Picture Files button.

 

Saving Thumbnails with Previously Created Pictures or Dynamo Sets

 To save thumbnails   with a picture or Dynamo set:

 1. In Classic view,   the iFIX WorkSpace, on the Utilities toolbar, click the Save Files With   Thumb-
nail Preference button. 

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Utilities, and then click Save 
Files With   Thumbnail Preference. 

 2. In the File Types   area, select the Pictures and/or Dynamo Sets check box.

 3. In the Directories   area, verify that your directory is correct. If not, enter the correct   path in the dir-
ectory field.

 4. In the Save Files   With area, select the picture or dynamo file you want to save. To select   every 
file in the list, click Select All.

 5. Click OK.

Importing Windows Metafiles
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 To import a Windows   Metafile:

 1. In Classic view,   in the iFIX WorkSpace, from the Insert menu, select Bitmap. 

-Or-

In Ribbon View, on the Insert tab, in the   Objects/Links group, click Objects Links, and then click 
Bitmap.

 2. In the Files of type   field, select Win Metafile (*.wmf) and select the folder where the file   resides.

 3. Click Open.

TIP: If you want   to insert a Windows Metafile (WMF) as a grouped object and not as a flat   Bitmap, do not 
import it directly. Instead, insert the WMF picture into   Microsoft Excel using the Insert menu. Right-click the pic-
ture and select   Edit Picture. A message box appears requesting that you convert the picture   to a Microsoft 
drawing object. Click Yes, and then copy the converted   object from Excel. In the iFIX WorkSpace, and select 
Paste > Paste   Special. From the Paste Special dialog box, select Enhanced Metafile and   click OK. The 
grouped object should now appear in your picture.

 

Assigning Pictures to a Security Area

 To assign a picture   to a security area:

 1. In the iFIX WorkSpace,   open the picture you want to modify.

 2. In Classic view,   from the View menu, select Property Window. 

-Or-

In Ribbon view, on the View tab, in the   Window group, click Properties. 

 3. In the Security Area   field, enter the security area you want to use.

 

Using the Grid

In the iFIX WorkSpace, you can perform the following steps with   the grid feature:

 l Displaying   the Grid

 l Disabling   the Grid

 l Snapping   an Object to a Grid Point

 l Changing   the Grid Spacing

 l Enabling   Grids for All Future Pictures

 

Displaying the Grid

 To display the   grid:

 1. In Classic view,   in the iFIX WorkSpace, on the Format menu, select Grid Settings. 
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-Or-

In Ribbon View, on the Format tab, in the   Arrange group, click Grid, and then click Grid Settings. 

 2. Select the Show the   Grid check box and click OK.
 

Disabling the Grid

 To disable the   grid:

 1. In Classic view,   in the iFIX WorkSpace, on the Format menu, select Grid Settings. 

-Or-

In Ribbon View, on the Format tab, in the   Arrange group, click Grid, and then click Grid Settings. 

 2. Clear the Show the   Grid check box and click OK.

 

Snapping an Object to a Grid Point

 To snap an object   to a grid point:

 1. In the iFIX WorkSpace,   select the object(s) you want to snap to a grid point.

 2. In Classic view,   on the Format menu, select Snap Objects to Grid. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Grid, and then click Snap Objects 
to Grid.

 

Changing the Grid Spacing

 To change the   spacing of the grid:

 1. In Classic view,   in the iFIX WorkSpace, on the Format menu, select Grid Settings. 

-Or-

In Ribbon View, on the Format tab, in the   Arrange group, click Grid, and then click Grid Settings. 

 2. In the Grid Interval   field, enter the desired spacing for the grid, in pixels.

 

Enabling Grids for All Future Pictures

 To enable grids   for all future pictures:

 1. In Classic view,   on the WorkSpace menu, select User Preferences and click the Picture Prefer-
ences   tab. 

-Or-
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In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences.

 2. In the Window Properties   area, select the Grid Enabled check box.

 3. In the Properties   area, enter a value in the Grid Interval field. The value must be entered   in pixels.

NOTES:

 l When zooming in and out   of pictures, grids may not appear in the picture properly.

 l When using Zoom to Fit   in Configuration mode, grids are disabled. 
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Implementing Pictures in Your Process

This chapter presents several picture development strategies using iFIX.   Included in the chapter are 
ways to plan, develop, and use pictures to   satisfy process requirements, and design tips to help you 
take full advantage   of iFIX. The chapter begins with a comprehensive discussion of how pictures   are 
constructed.

 l What   Makes Up Your Picture

 l Planning   Your Pictures

 l Designing   Your Pictures

 l Using   the Create Picture Wizard

 l Working   with Other Applications

 l Optimizing   Picture Performance

 l Using   Picture Caching

 l Making   Changes to Pictures at Runtime

To expedite the process of creating pictures and groups of pictures,   you can use the Create Picture wiz-
ard. This wizard allows you to configure   the size, location, and properties of your pictures. You can also 
use   and create predefined configurations of pictures. For more information   on the Create Picture wizard, 
refer to the Using   the Create Picture Wizard section. 

What Makes Up Your Picture 

A picture consists of the following components:

 l Document

 l Viewport

 l Window

The Document 

A picture is a document object. When you open a new picture in iFIX,   you create a document. The doc-
ument is the ActiveX container for your   iFIX picture. Look at the document as the entire landscape of 
your picture.   The document is created using either the Logical or Enhanced Coordinate   Systems. Only 
pictures created in releases earlier than iFIX 5.8 use the   Logical Coordinate system. Pictures created in 
iFIX 5.8 or later, or pictures   from earlier releases that have been upgraded will use Enhanced Coordin-
ates.

Logical Coordinate System   

To understand what this means, let's go back to the discussion of object-oriented   graphics in the Getting 
Started   section. This section discussed how iFIX uses object-oriented, rather   than pixel-based, graph-
ics. The iFIX picture sizing methodology works   in a similar way. A Logical Coordinate System picture 
size means that   your document size is based on logical units, not pixels. The number of   this unit of 
measurement is arbitrary; that is, you can use any number   of logical units you want. iFIX makes this 
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possible by calculating a one-to-one   relationship between the pixel size of your monitor and the logical 
units   of your document, while maintaining the dpi   (dots per inch) ratio of your monitor.

For example, a standard VGA   monitor consists of 640x480 pixels. In iFIX, the default size of your   pic-
ture, viewed with this monitor, is not 640x480. Rather, it is 100x75   (logical units), as illustrated in the fol-
lowing calculation.

      
      
      

 Autoscaling

An iFIX document that uses the Logical Coordinate System establishes   the logical-units-to-pixels ratio 
when you create a new picture, and automatically   adjusts the ratio when you change the resolution of 
your screen. This   way, your picture appears to scale no matter what monitor you view it   on. When you 
make any changes to the document, viewport,   or window size, iFIX maintains the 4:3 ratio so that your 
objects maintain   a consistent size on your screen.

Enhanced Coordinate System

With the Enhanced Coordinate System, your document size is based on   postscript points, not logical 
units. The number of this unit of measurement   is arbitrary; that is, you can use any number of postscript 
points you   want. 

Since the document size is based on the resolution of the screen on   which the picture is created, you are 
recommended to develop a document   using the screen resolution of the monitor on which the picture is 
to   be viewed when implemented. (For example, to create a document for a screen   with 1920x1080 res-
olution, you must create your pictures using a computer   with a screen resolution of 1920x1080.)  

Once created, the document size and shape remains constant when used   on a screen with a different 
resolution.

In addition, iFIX allows you to upgrade documents created with the Logical   Coordinate System to the 
Enhanced Coordinate System while maintaining   a backup copy of the original document. 

Zoom to Fit 

Zoom to Fit is an Enhanced Coordinate System viewing option. The Zoom   to Fit feature automatically 
scales the document view to fit the current   window while suppressing scroll bars. 

The Viewport   

The viewport   is the mapping system for the Logical Coordinate System document. Like   the document, it 
reads the picture's logical coordinates to determine   its size, and then maps the logical coordinates onto 
the window. 

NOTE: The Viewport    mapping   does not apply to pictures that use the Enhanced Coordinate System.

CAUTION: If you resize a picture, then modify   the viewport   width or height (ViewPortHeight   and 
ViewPortWidth   properties), the picture's Logical Coordinate System is remapped.   When this happens, objects 
in your pictures may appear skewed when resizing   or autoscaling.   If you are using custom scripts to manip-
ulate these properties, these   scripts become obsolete after an upgrade to the Enhanced Coordinates System.   
To avoid this problem, it is recommended that you either:
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 l Do not modify the   viewport height   or width once you have resized a picture using the Logical Coordin-
ate   System.

 l Upgrade the picture   to the Enhanced Coordinate System.

Logical Coordinate System Example

For example, when using a picture with a width of 100 logical units   (or postscript points) and a height of 
75 logical units (or postscript   points) maintains a logical ratio with coordinates 0, 0 at the top left   corner 
of the picture. This is illustrated in the following diagram.

The Logical Coordinate   System

Look at the viewport   as the lens of a camera. For example, if you have a picture containing   a circle and a 
rectangle, and you define the viewport   to begin as shown in the following picture:
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Then the picture will be displayed as shown in the following figure:
   

 

The Window 

The window is the available screen area of the document; it sets the   boundaries for what you can display 
in your picture. The window preserves   a portion of the screen for various window decorations, such as 
title   bars and sizing borders, for displaying your picture. If the document   is the landscape, and the view-
port is the camera lens, than the window   is the viewfinder; it is what you actually see on the screen. For 
more   information on window decorations, refer to the Selecting   Window Properties section.

The following figure shows the relationship between the window and screen   in an iFIX picture.
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The Window and Screen in   an iFIX Document

Planning Your Pictures

To prepare your development strategy, you must first plan the size of   your window, the area of your 
screen that contains your picture. The sections   that follow describe how to custom-design your window 
so that your pictures   look the way you want them to.

 l Determining   a Window Size

 l Tips:   Sizing and Locating a Picture

 l Controlling   a Picture's Magnification

 l Selecting   Window Properties

 l Selecting   Additional Picture Properties

Determining a Window Size 

When adjusting your picture size, you work with the window property,   and you define the size as a per-
centage of screen:
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 l Full Screen

 l 1/2 Screen Height

 l 1/2 Screen Width

 l 1/4 Screen

By sizing a window by the percentage of the screen, iFIX scales your   picture, maintaining its coordinate 
system and displaying the picture   at its original aspects regardless of the monitor resolution it is viewed   
on.

The default window and document properties are displayed in the Picture   Preferences tab of the User 
Preferences dialog box. These properties are   applied when you create a new picture. The new picture's 
viewport   is automatically set to display the maximum viewable amount of your picture   at a 100% zoom 
ratio. For more information on zooming, refer to the Controlling a Picture's   Magnification section.

To change the size of your window for all new pictures to be created,   select a window size in the Win-
dow Size field. 

Logical Coordinate System

For the Logical Coordinate System, when you want to modify the default   document width or height (100 
x 75), make sure that the ratio between   the width and height remains at 4:3. You can select any units 
you want;   however, if you choose not to maintain the 4:3 ratio, objects with an   identical width and height 
do not appear as such in the window. For more   information on the logical-units-to-pixels ratio, refer to the 
section,   The Document.

Enhanced Coordinate System

For the Enhanced Coordinate System, the document width and height is   calculated in postscript points. 
When determining a window size, it is   important to use the resolution on the computer where the pic-
tures are   intended to be viewed.  For   example, you might create a picture for viewing on a high-definition 
computer   with a resolution of 1920 x 1080, which assumes a wide screen aspect ratio   of 16:9.  

Once you create a picture, you can change its size by changing the percentage   of the Window Height 
and Window Width properties in the Edit Picture dialog   box. In the Edit Picture dialog box, you can spe-
cify the desired percentage   to represent the size your picture. iFIX automatically preserves the size   of 
the objects on the screen.

You can have a window that is full screen, half the height of your screen,   half the width of the screen, or 
one quarter of the screen's size. These   sizes are illustrated in the following figures.
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Full Screen Window Size
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Half Screen Height Window   Size
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Half Screen Width Window   Size
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Quarter Screen Window Size
Manually Changing the Picture Size of a Logical Coordinate System Picture

By manually adjusting the size of the window, you can quickly change   the view of your picture, when 
you use the Logical coordinate System.

Before you attempt to adjust the size, make sure you know what document   components you are chan-
ging in the picture. The following table shows   what key sequences or mouse actions that change your 
picture size, and   what part of the document you actually modify. 

NOTE: The key   sequences apply only to pictures that use the Logical Coordinate System.    They do   not apply 
to pictures that use the Enhanced Coordinate System.

Pressing the key 
sequence...

While... Does the fol-
lowing...

And changes...

Shift Clicking and dragging the mouse on an 
edge of the   window

Adjusts the size of 
the picture

The window and 
the viewport.

Ctrl+Shift Clicking and dragging the mouse on an 
edge of the   window

Adjusts the size of 
the picture

The window.

None Clicking an arrow on the scroll bar Scrolls the picture The viewport.

Key Sequences That Change the Picture Size of   a Logical Coordinate System Picture

Tips: Sizing and Locating a Picture
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The way that a picture appears in Run mode can be very different from   the way it appears in Configure 
mode, especially if the WorkSpace will   not be full screen in Run mode. Before you create a picture, use 
the following   tips in Configure mode to coordinate the appearances of the picture in   configure mode and 
in run mode: 

 l If you will be using   the WorkSpace full screen in Run mode, maximize the WorkSpace in Con-
figure   mode in Classic view by selecting Full Screen from the WorkSpace menu.   To maximize 
the WorkSpace in Configure mode in Ribbon view, on the Home   tab, in the WorkSpace group, 
click Full Screen.

 l Float or hide toolbars.   To modify settings for toolbars, in Classic view, select the Toolbars   option 
from the WorkSpace menu. In Ribbon view, on the Home tab, in the   WorkSpace group, click Set-
tings and then click Toolbars.

 l Float or hide the   system tree. To toggle the display of the system tree, in Classic view,   select 
System Tree from the WorkSpace menu. In Ribbon view, on the Home   tab, in the WorkSpace 
group, click Show/Hide and then click System Tree.

 l Set the Windows taskbar   to appear the same as when iFIX is in the run-time environment. To 
toggle   the display of the Windows taskbar, click the right mouse button in the   taskbar and select 
Properties. 

TIP:   For Ribbon view, to ensure access to the taskbar, after you set the toggle   property, minimize and 
then maximize the WorkSpace.

 l Set the Status bar   to the same appearance as when iFIX is in the run-time environment. To   toggle 
the display of the status bar, in Classic view, select Status Bar   from the WorkSpace menu. In 
Ribbon view, on the Home tab, in the WorkSpace   group, click Show/Hide and then click Status 
Bar.

 l Use Zoom to Fit to   suppress scroll bars and view the entire graphic of pictures created with   or 
upgraded to the Enhanced Coordinate System.

 l When creating new   pictures with the Enhanced Coordinate System, consider the following 
recommendations:   

- Develop pictures on the screen resolutions where   they are to be viewed.

- When there are multiple display resolutions on   the target devices, it is recommended to develop 
those pictures using   the minimum resolution at which they will be displayed.

- Mobile devices require you to develop separate   pictures designed specifically for the mobile dis-
plays.

If you set Run-time Environment Protection to disable the title bar   or the menu bar, you will not be able to 
set up Configuration mode to   appear exactly as it would in run mode. To set run-time protection, access   
the Environment Protection Preferences tab in the User Preferences dialog   box.

When you open an existing picture in run mode, the picture will adjust   to the WorkSpace run-time Envir-
onment Protection preferences and settings   that are currently enabled.

Controlling a Picture's Magnification 

iFIX gives you many ways to change the appearance of your picture on   screen or, conversely, keep it 
looking exactly the same so you don't lose   the perfect view. For example, you may want to magnify your 
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picture so   that objects change size, perhaps allowing you to study them in more detail.   The following 
sections show you how to work with different window views.   

Most of the functions described can be accessed using the View menu   or tab, or using the picture pop-
up menu. You can also change certain   picture properties using VBA.   Refer to the Writing Scripts manual   
for more information.
Zooming In and Out of Pictures  

The viewing area of a picture is like an adjustable camera lens; it   allows you to magnify or reduce the 
image on the screen. Magnifying an   image (zooming in)   lets you work on detailed areas of your picture. 
Reducing an image (zooming   out)   lets you work on the overall structure of the picture.

You can choose four different percentages of magnification when zooming   in and out of pictures –   50%, 
100%, 150%, or 200%. By default, the viewport   is set at 100% view magnification, giving you the max-
imum viewable amount   of your picture. When you change the magnification of the picture using   the 
zoom function, you change the width and height of the picture's viewport,   but not the size of the objects 
in the picture. Objects appear   to get bigger or smaller, allowing you to view more or less detail, but   they 
are actually the same size.

NOTE: When zooming   in and out of pictures, grids may not appear in the picture properly.

You can use Zoom with both Logical and Enhanced Coordinate Systems;   however, Zoom acts dif-
ferently with each coordinate system. That is, with   the legacy Logical Coordinate System, you had to 
decrease the Zoom Factor   to increase the Zoom Percentage. With the Enhanced Coordinate System,   
you must increase the Zoom Factor to increase the Zoom Percentage.

 l With the Logical   Coordinate System -  Zooming   In  (greater   than 100%) is applied by reducing or 
decreasing the viewport;    thus, the   zoom factor is less than 1.  ZoomOut   increases the viewport,    
thus, the    Zoom Factor   is greater than 1.

 l With the Enhanced   Coordinate System - Zooming In to a picture increases the Zoom Factor,   and 
Zooming Out reduces or decreases the Zoom Factor.

The following table lists examples of zoom percentage and corresponding   zoom factor  for   each coordin-
ate system. For example, a zoom percentage of 200% is represented   as a Zoom Factor of 0.5 for the 
Logical Coordinate and 2.0 with the Enhanced   Coordinates System. 

Zoom Percentage  Zoom Factor - Logical 
Coordinate 

Zoom Factor - Enhanced Coordin-
ate 

50% 1.5 0.5

100% 1.0 1.0

150% 0.75 1.5

200% 0.5 2.0

IMPORTANT:   Scripts written in for Logical Coordinate System must be changed for the   Enhanced Coordinate 
System. In particular, when using the Zoom Property   with scripts in pictures that have been upgraded to use 
the Enhanced Coordinate   System, you must change the script to reflect the new behavior. For more   inform-
ation on Zoom Property and changing scripts, refer to the iFIX  Automation Reference e-book.
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NOTE:  For   Logical Coordinate System pictures only, y/SHIFT   while clicking and dragging a corner of the win-
dow. This makes the object   appear to change shape without cCTRL ou can accomplish the same   function of 
a zoom by simply pressinghanging the viewport,   just like a zoom.  For   pictures that use the Logical Coordin-
ate System, refer to the Key Sequences   that Change the Picture Size table in the Determining   a Window 
Sizesection. This key   sequence does not apply to pictures that use the Enhanced Coordinate System.
Default View and Full View  

NOTE: This option   does not apply to pictures that use the Enhanced Coordinate System.

If your picture uses the Logical Coordinate System and you make changes   to your window, you may 
decide that you prefer the original view. To restore   the original view, use one of the following methods:

 l Right-click the picture   and select Default View from the pop-up menu.

 l Select Default View   from the View menu (Classic view).

 l Click View and then   Default View from the Picture group on the View tab (Ribbon view).

Your picture will appear as you originally created   it before making any changes. 

If you make the size of your window smaller, you can return the window   to full view by selecting Full 
View. The Full View function expands the   size of the window and changes the viewport.   You can also 
perform a full view by pressing <Shift> and dragging   the window to fill the screen of the window.
Fitting the Picture to Window or Window to Picture 

NOTE: This option   does not apply to pictures that use the Enhanced Coordinate System.

If your picture uses the Logical Coordinate System and you adjust the   window size of your picture, you 
may want the objects in the picture to   be accurately represented within the new window size. To fit the 
picture   to the new window, use one of the following methods:

 l Right-click the picture   name in the system tree and select Fit Picture to Window from the pop-up   
menu.

 l Select Fit Picture   to Window from the View menu (Classic view).

 l Click Window and   then Fit Picture to Window from the Picture group on the View tab (Ribbon   
View).

The picture is adjusted to the new window size, so   that the objects in the picture are the same size rel-
ative to the new   window. 

To adjust the size of the window to fit as much of your picture as possible:   

 l right-click the picture   name in the system tree and select Fit Window to Picture from the pop-up   
menu, 

 l select Fit Window   to Picture from the View menu (Classic view), or

 l click Window and   then Fit Window to Picture from the group Picture on the View tab (Ribbon   
View)

If the viewport   stretches beyond the boundary of the picture, scroll bars are added to   the picture. 

NOTE: Scroll   bars may be added when a picture is created using the Picture wizard in   Classic view and then 
opened in Ribbon view. If this occurs in a picture   using legacy Logical Coordinates, select Fit Picture To Win-
dow from the   right mouse menu and save the picture to eliminate the scroll bars. Use   Zoom To Fit for 
Enhanced Coordinate pictures.
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Updating Window Location 

The Update Window Location function allows you to retain a specific   picture configuration, maintaining 
the document, window, and viewport   sizes that you create. When you open the picture later, or switch 
back   to the configuration environment after viewing it at run-time, the picture   appears exactly as it did on 
the screen when you originally created it.   

In this way, Update Window Location is not   the same as saving your picture. Saving alone does not 
retain window properties,   and does not guarantee that your picture will look exactly the same when   you 
re-open it again at a later date. So be sure to save your picture   after   you have updated the window loc-
ation to your exact specifications.

Update Window Location is an effective way to create pop-up windows   for your application that appear 
exactly the same, regardless of what   resolution they are viewed on. To use this function, employ one of 
the   following methods:

 l Right-click the picture   in the system tree and select Update Window Location from the pop-up 
menu.

 l Select Update Window   Location from the View menu (Classic view).

 l Click Window and   then Update Window Location from the Picture group on the View tab (Ribbon   
View).

Next, save your picture.
Zoom to Fit 

When pictures are created or upgraded with the Enhanced Coordinate System,   the Zoom to Fit option 
automatically scales the entire picture to fit   within the current screen while suppressing scroll 
bars. Objects   are not distorted and retain their original shape. Zoom to Fit is only   available for viewing 
pictures, edits are not permitted. Zoom to Fit can   be used in both Configuration and Runtime modes.

Changing the Screen Resolutions

If you change the screen resolution for a picture in Zoom to Fit, the   picture looks differently even though 
the aspect ratio remains unchanged.   The objects within the picture appear to have changed size 
because the   Zoom to Fit option makes the best use of the available screen space.  If   you change the res-
olution from:

 l a lower resolution   to a higher resolution, the objects in your picture appear larger 

 l a higher resolution   to a lower resolution, the objects in your picture appear smaller

If you choose to disable Zoom to Fit (Ctrl+M)   for the picture in the new resolution, the scroll bar becomes 
enabled   and the objects within the pictures appear differently as the software   accommodates the adjus-
ted screen space. 

For example:  

 l As shown in sequence   A, changing the screen resolution from 800 x600 to the new 1920 x 1080   
resolution, makes the objects appear larger.   When   you disable Zoom to Fit, scroll bars are 
enabled and the images appear   smaller.

 l As shown in sequence   B, changing the screen resolution from 1920 x 1080 to the new 800 x 600   
resolution, makes the objects appear smaller.  When   you disable Zoom to Fit, scroll bars are 
enabled and the images appear   larger or may not appear on the screen.
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 Viewing Overlaid Objects 

When overlaying objects in a graphic (in configuration mode), make sure   the alignment of each object is 
as you expect it. When overlaid objects   are not aligned properly, viewing these objects in Zoom to Fit (in 
run   mode) may not display as you expect.  For   example, if text is overlaid on a rectangle object and the 
text object   is not aligned during configuration mode, when you view the objects with   Zoom to Fit (in run 
mode), the text size may increase and hide one of   the rectangle's edges. If this occurs, return to con-
figuration mode and   adjust the overlays to align properly.

How to Control How the Font in Text and Datalink Objects is Zoomed

You can control whether font in Text or Datalinks is zoomed with a setting in the FixUserPreferences.ini 
file. When this setting is enabled, zoom is enabled on these objects. By default, this setting is enabled. 
The FixUserPreferences.ini file is found in the LOCAL folder in the iFIX base path. By default, this path 
is: C:\Program Files (x86)\Proficy\iFIX\LOCAL. 

To disable or enable this behavior, modify the RecalcTextRectOnZoom parameter in the [ShapePrefer-
ences] section of the FixUsersPreferences.ini file. For example, 1 is enabled and 0 is disabled. For 
example:

[ShapePreferences]
ForegroundColor=8816262
BackgroundColor=16777215
...
RecalcTextRectOnZoom=1
To disable the new behavior, set RecalcTextRectOnZoom to 0. For example:
RecalcTextRectOnZoom=1

The WorkSpace must be restarted for any changes to the RecalcTextRectOnZoom parameter to take 
effect.
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Other Picture Settings Available through the FixUserPreferences.ini file

There are other settings that you can configure in the FixUserPreferences.ini file located in the iFIX base 
path (by default: C:\Program Files (x86)\Proficy\iFIX\LOCAL). These include: ZoomToFitFromCenter, 
ThickEdgeLinesWithZoom, and SmoothShapes. After changing any of these settings in the FixUser-
Preferences.ini, the WorkSpace must be restarted for these changes to take affect.

ZoomToFitFromCenter

ZoomToFitFromCenter can be added to the [AppDesignPreferences] section of the FixUser-
Preferences.ini.  The default value of ZoomToFitFromCenter will always be “1” when ZoomToFit is 
enabled for a picture.  When ZoomToFit is applied on a picture, objects in a picture cover the maximum 
view area in terms of width or height. This means that space at the right or at the bottom around objects 
in the picture will have less empty spaces. This is because the starting position of objects in a picture 
have been shifted either to right or to bottom. When setting ZoomToFitFromCenter to "0", the Fit From 
Center feature is disabled for all the opened documents or pictures. In this case, objects in a picture will 
have larger gaps (empty spaces) at the right or at bottom.    

NOTE: You can also set/unset ZoomToFitFromCenter setting on individual picture through a script. For 
example: Me.BestFitWithCenter = False or Me.BestFitWithCenter = True. Me.BestFitWithCenter script always 
takes precedence over ZoomToFitFromCenter settings provided in .ini file. ZoomToFitFromCenter setting is a 
global setting which gets applied on the opened documents in the WorkSpace. To override this setting for an 
individual picture, use the help of script, like Me.BestFitWithCenter.

NOTE: Be aware that if you enable this property on pictures with lots of graphics, it may have an impact on the 
performance of the iFIX WorkSpace.

ThickEdgeLinesWithZoom

ThickEdgeLinesWithZoom can be added to the [ShapePreferences]  section of the FixUser-
Preferences.ini. When this variable is set to 0 the edge lines while zooming in will NOT become thicker 
while shapes are drawn on a picture. By default, this value is 1, which means edges will become thicker 
for shapes on zooming.

SmoothShapes

SmoothShapes can be added to the [PicturePreferences] section of the FixUserPreferences.ini. This 
property is used mainly for older pictures which were upgraded prior to version 6.5 and above to help 
improve the draw quality of shapes (a polygon, circle, arc, and so on). If you want old pictures (created in 
version 5.5 and earlier) which have been converted to Enhanced Coordinates, to have the Smooth 
Shapes property enabled globally (for all the pictures opened), set SmoothShapes to “1” in the Pic-
turePreferences section of FixUserPreferences.ini. 

NOTE: Be aware that if you enable this property on pictures with lots of graphics, it may have an impact on the 
performance of the iFIX WorkSpace. 
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In current version of iFIX, there is also a SmoothShapes property on the picture. On new pictures this 
value is set to True.
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NOTE: If a non-Enhanced Coordinate picture is converted to Enhanced Coordinates on upgrade, the 
SmoothShapes Picture property value is set to False.  

Be aware that the setting in the Picture Properties does not take precedence over the setting in the 
FixUserPreferences.ini file. As long as one of the settings is 1 (True), SmoothShapes logic will be 
applied to the picture in run mode. The following table explains how combinations of these settings get 
applied.

FixUserPreferences SmoothShapes 
setting

Picture Properties Set-
ting

SmoothShape logic 
applied?

0 0 No
0 1 Yes

© 2024 General Electric Company. All rights reserved. 67



1 1 Yes
1 0 Yes

Example of FixUserPreferences.ini with these Settings

[PicturePreferences]
...
SmoothShapes=0
...
[AppDesignPreferences]
...
ZoomToFit=1
ZoomToFitFromCenter=1
Multimonitorsupport=0
...
[ShapePreferences]
...
ThickEdgeLinesWithZoom=1
...

Oval Shapes with SmoothShapes Enabled

When the SmoothShapes parameter is enabled, Oval shapes (Fix2DOval object) may change in size. If 
you do not want Oval shapes to change,  enable the ConsistentOvalSizeInSmoothShape parameter. To 
enable this parameter, in the FixUserpreferences.ini file, under the [ShapePreferences] section, add the 
following:

ConsistentOvalSizeInSmoothShape=1

After changing any of this settings in the FixUserPreferences.ini, the WorkSpace must be restarted for 
these changes to take affect. With both SmoothShapes and the ConsistentOvalSizeInSmoothShape 
parameters enabled, the Oval shape size will not change in size or increase.

By default, the ConsistentOvalSizeInSmoothShape parameter is not included in the .ini file; it is con-
sidered as False (or 0), by default.

 

Selecting Window Properties 

As discussed in the previous sections, the area of the window that you   can resize is called the client 
area. Essentially, the screen is the window   less decorative properties, or decorations. To give your pic-
tures a custom   design and look, you can select or modify the following window decorations:

 l Title   bars –   Adds a title bar to your picture. 

 l System   menus –   Adds system menus to your picture. 

 l Sizing   borders –   Adds sizing borders so that you can resize (or scroll) your window. 

To show or hide the decorations listed above, select or deselect   the appropriate check boxes in the Edit 
Picture dialog box. The window   decorations enabled by default appear on the Picture Preferences 
tabbed   page when you open a new picture.

Additionally, you can add the following window properties to your picture:
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 l Always   on Top –   Configures the window so that it is always on top when you open it. You   can 
select this feature in the Edit Picture dialog box, from the picture   preferences tab in the User 
Preferences dialog box and the Property Window.   

 l Click   and Stick Enabled –   Allows you to view which objects can be selected, can perform 
actions,   or can have actions performed on them. You can select this feature from   the picture pref-
erences tab in the User Preferences dialog box. You cannot   select this feature from the Property 
Window. 

 l Grid   Enabled –   Displays a grid on the window. You can select this feature in the Edit   Picture dia-
log box, from the picture preferences tab in the User Preferences   dialog box and the Property Win-
dow. 

 l Snap   to Grid –   Allows objects to snap to a grid point in a grid. You can select this   feature from 
the picture preferences tab in the User Preferences dialog   box and the Property Window. 

 l Runtime   Visible –   Allows you to run a picture in memory without a visible display in the   run-time 
environment. You can select this feature in the Edit Picture   dialog box and the Property Window. 

 l Disable caching for this picture – allows you   to disable picture caching for an individual pic-
ture. You can select this   feature in the Edit Picture dialog box. See the Using   Picture Caching 
section for more information about picture caching.

Each of the available properties can be turned on or off, allowing you   to create the exact look and feel 
you want. For example, you can:

 l Simulate dialog boxes   by creating a window with the title bar and system menu enabled. 

 l Create a tool palette   for operators using a window with the sizing borders and system menu dis-
abled.   

 l Create an opening   title screen by creating a window with the full screen enabled, and the   other 
window properties disabled. 

 l Simulate an alarm   condition where an object makes a sound when the cursor passes over an   
object. Do this by creating a window with Click and Stick Enabled selected.   

Creating Picture Types Using Window Properties 

Use the following table as a guideline to help you define your picture   properties. 

To create a... Select these properties...
Dialog box Titlebar

System Menu

Resizeable
Toolbar Titlebar

System Menu

Resizeable

Always on Top
Palette or control panel Titlebar

Always on Top

Creating Picture Types Using   Window Properties  
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Non-movable banner Always on Top
Detail window Titlebar

System Menu

Resizeable
Pop-up alarm messages Titlebar

System Menu

Resizeable

Always on Top
Resizeable picture with hidden objects, not displayed   at run-time Resizeable

For more information on the window and screen in an iFIX document, refer   to the section, The Window.

Selecting Additional Picture Properties 

The User Preferences dialog box contains several additional properties   you can apply to your pictures. 
To access them click the Picture Preferences   tab. The following properties are available in the right 
column of the   Properties area:

 l Highlight   Timeout Interval –   When Click and Stick is enabled, this time period defines how 
long before   the highlight around an object disappears when it is not selected. 

 l Grid   Interval –   When the grid is enabled, this interval (entered in pixels) determines   the distance 
between the dots in the grid. 

 l Using Click and Stick –   Click and Stick allows you to view which objects can be selected, high-
lighted,   or modified at run-time. As the mouse moves over an object, a single highlighted   box 
clicks   around the object if it is selectable. If the object is highlighted, use   the mouse to select or 
stick   the object and it becomes the current object. To enable or disable Click   and Stick, select or 
deselect the Click and Stick Enabled check box. 

Designing Your Pictures 

Developing a strategy for your pictures is a lot more than defining   a picture type and window size. You 
can apply many strategies to help   you achieve the maximum performance from your pictures. Employ-
ing these   strategies can make your development easier and less costly.

Some of the more effective strategies you can implement include:

 l Speeding development   time. 

 l Improving performance   by using the tools that iFIX gives you. 

 l Making the design   flexible so that you can easily maintain pictures. 

 l Securing pictures   so they are accessible to specific users. 

The sections that follow describe some of the strategies that you can   use.
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 l Design   Tips

 l Finding   and Replacing Data in Pictures

 l Using   Process Assistants

 l Working   with Color

 l Securing   Your Pictures

Design Tips 

We recommend that you keep the following tips in mind when designing   your pictures.

General Tips

The following tips are for developing pictures with either the Logical   or Enhanced Coordinate Systems.

 l Use   the tools that iFIX provides you to accomplish the job. Using the   tools available to you 
helps you quickly implement your process development   strategy. Examples: using Dynamo 
objects for common object groups; using   screen regions to determine color schemes; using Find 
and Replace to locate   and change data; using Experts to add scripts to objects. 

 l Get   data once. Because iFIX allows you to obtain your data from a variety   of sources and use 
that data throughout the open environment of the    iFIX WorkSpace, you only need to hook   to that 
data source once. So, for example, if you want to attach a data   source to many objects in your 
picture, you can do so by distributing   the data from one object throughout your picture. There is no 
need to   fetch data again or retransform    that data to assign or animate properties throughout your 
picture. 

 l Use   color only when it enhances the picture and makes it easier to use.   Overusing colors, 
or using an ineffective color strategy, can do more   harm than good to your picture design. For help 
in designing a coloring   strategy, refer to the Working with   Color section. 

 l Instead   of creating pictures to monitor points, use the Scheduler. Using   pictures to monitor 
the value of a point can be ineffective, as scripts   may run continuously and never run to com-
pletion. Rather than run a looping   script, the Scheduler waits for an event to occur before it trig-
gers a   point. For more information on the Scheduler, refer to the Mastering  iFIX manual. 

 l Use   the extensive resources available to you for help. The Help and   Information folder in the 
system tree contains comprehensive information   to help you learn about a concept or perform a 
procedure. This information   includes Automation Interfaces and Database Manager help, as well 
as a   complete electronic book with context-sensitive help. 

 l Use the SmoothShapes property for more polished looking images, with anti-aliasing 
enabled. The SmoothShapes Property is set to TRUE for all new pictures.   Old pictures will 
default with this setting to FALSE. Set this property at the picture-level, from the Properties win-
dow in the iFIX WorkSpace.

Enhanced Coordinate System Tips 

The following tips are for developing pictures with the Enhanced Coordinate   System: 

 l Design   Enhanced Coordinate pictures for the terminal on which they will be viewed.    
When designing   the picture for a specific resolution, you should use a terminal with   that same res-
olution for your development.
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 l Use the   minimum resolution when designing for a wide range of resolution for target   
devices. When creating pictures that   will be used on multiple resolutions, it is recommended to 
develop those   pictures using the minimum resolution at which the picture will be displayed.

 l When   upgrading pictures to Enhanced Coordinates, be sure the existing picture   dis-
plays as you want it to view on the screen. When upgrading pictures   from the Logical Coordin-
ate System to the Enhanced Coordinate system,   make sure the existing picture views as you 
wish before you upgrade the   picture. Since the upgrade process uses the dimensions of the exist-
ing   picture, any issues with the existing picture are transferred  to   the upgraded picture.

 l Develop   separate pictures for mobile devices. When developing an Enhanced   Coordinate 
system picture for a mobile device, create a separate picture;   that is, do not use the same picture 
that you use for a wide screen or   other full size target devices.

 

 

Finding and Replacing Data in Pictures 

Many process environments are expansive, and their size may require   that pictures have multiple links 
to many data sources. Should managers   need to reroute certain data to another node, or globally change 
a data   source throughout a plant, they need to do so quickly, without disrupting   operation or utilizing valu-
able resources. The Find and Replace feature   in iFIX makes this possible.

To search and replace data in your pictures, select Find and Replace   from the Edit menu (Classic view) 
or on the Home tab, in the Editing group,   click Find and Replace, and complete the appropriate fields on 
the Find   and Replace dialog box. For detailed information on Finding and Replacing   data, refer to the 
Finding  and Replacing Data section in the Understanding iFIX manual.

Using Process Assistants

Process assistants can simplify picture development. These assistants include the following:

 l Wizards

 l Experts

 l Dynamos

 l Global   Subroutines

 l Toolbars

For more information on how Process assistants can help you develop your pictures more easily, refer to 
the Using Process Assistants to Expedite Pictures chapter.

Working with Color 

Using color is an effective way to enhance your pictures. iFIX allows   you to select from millions of col-
ors (including 24-bit), and lets you   customize your colors to give you more flexibility. With iFIX colors 
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there   are no   limitations; you have all the colors you want available to all objects,   all the time. Using these 
colors, you can:

 l View   colors by name. By clicking a tab, you can view all of the available   colors by name, giving 
you an easy way to select across a color spectrum   without choosing from a palette. 

 l Customize   your colors. You can assign unique colors and create a custom palette.   If you are 
using named colors, you can give the color a specific name.   

 l Color   as you go. Using the Color Selection dialog box, you can edit as   many objects as you like 
while the dialog box remains on your screen.   

 l Select   which property you want to modify. You can select the property   you want to modify 
(foreground, background, or edge color). 

 l Animate   your colors using a Color Expert. Using one of the Color Experts   on the Experts 
toolbar, you can animate a foreground, background, or edge   color with ease. 

Modal versus Modeless Color Selection

You can incorporate color to your objects in two ways:

 l Selecting a fade,   foreground, background, or edge color for a specific object using the   modal   
Select Color dialog box. The modal   color box is used to apply a color only to the object selected. 
Once you   select a color, you click OK and the dialog box closes. 

 l Selecting a color   to one or more objects, or designing a custom color set, using the modeless   
Color Selection dialog box. The modeless   color box is used to color as many objects as you like, 
as it stays on   your screen as you jump from object to object in your picture. 

The following sections detail how to incorporate colors into your pictures   using both methods.
Adding Colors to a Selected Object 

You can specify fade, foreground, background, and edge colors using   the modal Select Color box, 
shown in the following figure.
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This dialog box is accessed by right-clicking an object, pointing to   Color and selecting Foreground, Back-
ground, or Edge from the pop-up menu.   It is also accessed when you click either the Foreground or Fade 
button   on the Select Color dialog box shown below. This dialog box contains two   tabs that let you 
choose your color from a palette or from a list of names.   You select a color by either clicking the color in 
the palette or by clicking   the name in the list.

You can specify all of the gradient fill settings at one time using   the Select FadeColor dialog box, as 
shown in the following diagram.

The Select FadeColor dialog box is accessed by right-clicking an object,   pointing to Color, and selecting 
Fade from the pop-up menu. This dialog   box also appears if you select Foreground from the pop-up menu 
when the   object's fill style is Gradient. When you click either the Foreground   or Fade color button the 
Select Color dialog box appears, as shown in   the first diagram above.

Default color selections appear in the Shape Preferences tabbed page   of the User Preferences dialog 
box.

NOTE: You can also   specify a background color for your picture using the Edit Picture dialog   box or Shape 
Preferences tabbed page. For more information, refer to the   Setting the Picture   Background and Fade Colors 
section. 
Adding Colors to Multiple Objects 

You can specify foreground, background, and edge colors to as many objects   as you like using the 
modeless Color Selection box, shown in the following   figure.
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Because the Color Selection box remains on your screen as you add or   modify objects in your picture, 
you can make changes to your objects without   having to exit and re-enter the dialog box. To access the 
Color Selection   dialog box, click the Color button on the Tools toolbar (Classic view)   or on the Format 
tab, in the Styles group (Ribbon view) or the Toolbox,   if enabled.

The Color Selection dialog box contains two tabs that allow you to display   the default system colors in 
either a color palette or a list. To select   a color, click a color in the palette or click a name in the list. 

The ColorSet field displays the current default color set being used,   and it also contains any custom sets 
you may have created. You can create   a new custom set from the list provided, or create your own cus-
tom set   using a customized palette. All palettes are automatically saved when   the iFIX WorkSpace 
shuts down. 

In the Property field, you can choose the foreground, background, or   edge property to assign to the selec-
ted color. That property changes when   you change a color in the dialog box.
Using Custom Colors in Duplicated Objects

If you tie a custom color to the foreground of an object and duplicate   the object, the custom color link will 
not be retained in the duplicates   of the object. The duplicates will only take the color of the custom color   
at the time they were duplicated, future changes to the custom color will   only update the original object.
Using Named Colors 

Each color in the color box is named based on its location in the color   spectrum. Changing a color in a 
palette changes the name of that color   in the name list. When creating custom color sets, you can 
assign custom   names to colors. Each color name appears in a list, allowing you to select   across mul-
tiple palettes quickly and easily. If an object uses a named   color and the color is deleted or renamed, the 
object reverts to the 24-bit   color value.

The list of named colors is saved when the iFIX WorkSpace shuts   down.
Using the Edit Color Palette 

The Edit Color palette is a grid of colors ranging from red to violet   that let you select a custom color of 
your choice. You can select any   color from the palette by clicking the mouse. A four-mark cursor 
appears.

The slider to the right of the matrix is called a mixer bar. To specify   the shade of the color spectrum you 
selected in the matrix, adjust the   mixer bar. A black arrow appears next to the area you have selected. 
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You   can also change the shade of the color by adjusting the mixer bar up and   down, as the following fig-
ure shows.
   

Using the Color Experts 

Color Experts are convenient process assistants that help you easily   animate colors of your objects. By 
entering a data source and specifying   certain options, you can make foreground, background, or edge 
colors behave   in a way that benefits your process application. For information on the   dialog fields on the 
Expert, click Help on the dialog box. For more details   on the Experts that iFIX provides, refer to the 
Using   Process Assistants to Expedite Pictures chapter.
Applying Background Colors 

When specifying background colors for your objects, be aware that certain   colors or fill patterns may not 
work effectively, as they may be hidden   or offset by the foreground. You can also set a background color 
for your   pictures. For more information, refer to the Setting   the Picture Background and Fade Color sec-
tion.

Securing Your Pictures 

iFIX's picture protection prevents unauthorized users from accessing or modifying pictures, or per-
forming unauthorized actions on the pictures. To configure security for your picture, enter a security area 
in the Properties window. For more information on configuring security for your specific environment, 
refer to the Configuring Security Features manual.     

Secure Containment

iFIX offers a unique security feature called secure containment, which protects your pictures in the iFIX 
WorkSpace in the event that a third-party control fails.

For example, if you add an OCX to your picture in the iFIX WorkSpace, and the OCX crashes, an excep-
tion is created. The iFIX WorkSpace detects this exception and isolates it so that your system keeps 
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running. By securing your application as part of the iFIX WorkSpace, iFIX ensures that your pictures are 
saved even during an unlikely, yet potentially troublesome, event.

Using the Create Picture Wizard

iFIX provides the Create Picture wizard to allow you to more easily   step through some of the details 
inherent in creating pictures. Although   the underlying picture properties are the same whether you create 
pictures   manually or use the wizard, you can use the Create Picture wizard to easily   generate pictures of 
a particular size, location, or configuration. You   can access the Create Picture wizard by clicking the 
Create Picture button   on the Toolbox. 

The sections that follow describe the aspects of the Create Picture   Wizard.

 l Accessing   the Create Picture Wizard

 l Types   of Pictures in the Create Picture Wizard

 l Overview   of the Create Picture Wizard Process

Special Considerations

It is recommended that you ensure the following characteristics are   the same for both the machine on 
which you create the pictures and the   machine on which you deploy the pictures:

 l Monitor resolution   

 l Desktop Theme (especially   for users who have a mixed Windows environment) 

 l Font 

 l WorkSpace Full Screen   in Run Mode 

 l UI configuration   (Title bar height, window border size, status bar) 

 l Environment Protection   settings (title bar, menu bar) 

After you have created a picture with the Create Picture Wizard, you   will need to understand the con-
cepts found in the following sections to   resize, relocate, or change the attributes of the picture:

 l What   Makes Up Your Picture

 l Planning   Your Pictures

 l Designing   Your Pictures

Accessing the Create Picture Wizard

You can access the Create Picture wizard from the File menu (Classic   View only), from the Ribbon (Rib-
bon view only), from the Task Wizard,   and on several toolbars. The following table lists the most com-
mon ways   to access the Create Picture wizard: 

From 
the...

Do this...

Menu Bar Select New from the File menu, then select Picture   from the New list.
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(Classic 
view only)
Ribbon
(Ribbon 
view only)

Click the WorkSpace button, select New, and then click   Picture.

System 
Tree

Click the right mouse button on the Pictures folder   in the System tree.

Task Wiz-
ard 

Click the Task Wizard button from the Standard toolbar.   Select Picture from the 
Task Categories list box. Select Create Picture   Wizard from the Tasks list.

Experts 
Toolbar

Click the Create Picture Wizard button from the Experts   toolbar.

Standard 
Toolbar

Click the Create Picture Wizard button from the Standard   toolbar.

Toolbox Click the Create Picture Wizard button from the Toolbox.

NOTE: To access the   Create Picture wizard from the Menu Bar, the Ribbon, the System Tree,   or the Standard 
toolbar, you must have the Show Picture Wizard from New   Picture Menu check box enabled. You can enable 
this option in the Picture   Preferences tab of the User Preferences dialog box.
Common Elements of the Create Picture Wizard

As you can see in the Introduction   Page of the Create Picture Wizard, there are several elements of the   
Create Picture wizard that you will see on every page, including the following:

Preview Pane   – Shows   a picture configuration based on the currently selected options.

Help Button   – Launches   the Help topics for the Create Picture wizard.

Cancel Button   – Exits   the Create Picture wizard without creating any new pictures, or changing   
WorkSpace appearance.

Previous Button   – Returns   you to the previous page in the wizard.

Next   Button –   Sends you to the next page in the wizard.

Finish   Button –   Creates the new pictures that you have specified, and sets the WorkSpace   appear-
ance as you have specified. This button is only enabled when the   wizard has enough information to 
successfully create new pictures.

Types of Pictures in the Create Picture Wizard

There are three types of pictures that you can create using the Create   Picture wizard: 

 l Pictures from a Predefined   Configuration 

 l Custom Picture 

 l Default Untitled   Picture 

Pictures from a Predefined Configuration

Many implementations of iFIX require a configuration of pictures that   need to occupy certain areas of the 
screen. These pictures have different   uses; some of the pictures within the configuration may be stand-
ard across   the installation, and some of the pictures may differ depending on the   node or the day. The 
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Create Picture wizard provides you with a number   of predefined configurations, which you can modify to 
suit your needs.   Each configuration consists of some combination of the following default   pictures: 

Main   – Occupies   the entire client screen space, excluding any application title bars,   menu bars, head-
ers, footers, and left navigation pictures. You can use   the sizes tab to change the height, width, and 
position of this picture.   

Header   – Runs   across the top of the configuration. You can change the height of this   picture.

Footer   – Runs   across the bottom of the configuration. You can change the height of this   picture.

Left   – Runs   along the left side of the configuration. You can change the width of   this picture.

Faceplate   – Typically   used as a pop-up or informational window. You can select the screen location   of 
this picture, but the size is controlled by the configuration. This   picture is created separately from the 
other default pictures.

Additionally, the Create Picture wizard now provides two predefined   configurations for the most com-
mon handheld device screen resolutions:   240x320 and 320x240. These forms are specifically designed 
for handhelds   that have Terminal Services capabilities. For more information on using   them with Ter-
minal Server, refer to Optimizing  New iFIX Pictures for Use with Terminal Service Capable Devices. 

Once you have created pictures of the correct size and shape, you can   use them as templates. You can 
open them, edit them, and save them as   different pictures to suit your needs.
Custom Picture

When you choose to create a custom picture, you can set all the properties   for that picture as you step 
through the wizard. The end result is a single   picture of the size, location, and name that you define in 
the Create   Picture wizard.
Default Untitled Picture

Select this option to create the same picture that would ordinarily   be created in the WorkSpace if you did 
not have the Create Picture wizard   enabled. This picture will take on the size and properties that are cur-
rently   set in the WorkSpace, and named Untitled.

Overview of the Create Picture Wizard Process

The Create Picture wizard allows you to select the type of picture that you want to create, configure the 
WorkSpace settings for the way you want it to appear in run mode, and then specify the attributes, size, 
and location of each picture. The pictures are created in configure mode and added to the system tree. 
This section provides an overview of the process.

When you invoke the Create Picture wizard, the Introduction page appears, as shown in the following fig-
ure. On this page, you select the type of picture that you want to create. You also can elect to exit the 
wizard and disable its access from the menu bar, the system tree, and the Standard toolbar. For a 
description of each type of picture, see the Types of Pictures in the Create Picture Wizard section.
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Introduction Page of the Create Picture Wizard

After you complete the Introduction page and click Next, the WorkSpace Appearance page appears, as 
shown in the following figure. This page allows you to set the visibility of the Title Bar, the Menu Bar, and 
the Status Bar in run mode, and whether the WorkSpace will be full screen in run mode. 

NOTE: This page only appears if you selected the Show WorkSpace Appearance Page check box on the 
Introduction page.
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WorkSpace Appearance Page of the Create Picture Wizard

If you change the settings on this page, the WorkSpace preferences are automatically updated in your 
system when you exit the wizard. You should only need to complete the WorkSpace Appearance page 
once. The next time you use the Create Picture wizard, you can clear the check box on the Introduction 
page for Show WorkSpace Appearance Page. For more information on setting WorkSpace preferences, 
refer to the Setting User Preferences  section in the Understanding iFIX manual.

The wizard then steps you through other pages, depending on whether you are creating a custom picture 
or pictures from a predefined configuration. These pages allow you to specify the size, location, attrib-
utes, and filename of each picture you create.  

Once you have completed the picture specification pages, the Summary page appears, as shown in the 
following figure. This page presents a layout preview of the pictures you are creating, and lists the file-
name of each picture. From this page you can return to the picture specification pages, or click Finish to 
generate the pictures and add them to the system tree.
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Summary Page of the Create Picture Wizard

For information about modifying the attributes of pictures once you have created them, refer to the Using 
Basic Functions in Pictures section. 

How Do I...

In the iFIX WorkSpace, you can perform the following steps with   the Create Picture Wizard:

 l Accessing   the Create Picture Wizard

 l Creating   Pictures with the Create Picture Wizard

 l Creating   Pictures from a Predefined Configuration

 l Modifying   a Predefined Configuration

 l Creating   Pictures with a Custom Configuration

 l Changing   the Attributes of Predefined Pictures

 l Changing   the Dimensions of Predefined Pictures

 

Accessing the Create Picture Wizard
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 To access the   Create Picture Wizard:

Use any of the following methods in the   iFIX WorkSpace to access the Create Picture Wizard:

 l Menu   Bar – On the File menu, point to New and then click Picture (Classic   View only).

 l Ribbon   – Click the WorkSpace button, select New, and then click Picture (Ribbon   View 
only).

 l System   Tree – Right-click the Pictures folder in the System tree and select   New from the 
pop-up menu.

 l Task   Wizard – Click the Task Wizard button on the Standard toolbar,   select Picture from 
the Task Categories list box, then select Create Picture   Wizard from the Tasks list.

 l Experts   Toolbar – Click the Create Picture Wizard button on the Experts   toolbar.

 l Standard   Toolbar – Click the New Picture button on the Standard toolbar.

 l Toolbox   – Click the Create Picture Wizard button on the Toolbox.

NOTE:   To access the Create Picture Wizard from the Menu Bar, the Ribbon, the   System Tree, or the 
Standard toolbar, you must have the Show Picture Wizard   from New Picture Menu check box enabled 
on the Picture Preferences tab   of the User Preferences dialog box.

 

Creating Pictures with the Create Picture Wizard

 To create pictures   with the Create Picture Wizard:

 1. Maximize the    iFIX WorkSpace. 

 2. In Classic view,   click the New Picture button on the Standard toolbar. 

-Or-

In Ribbon view, click the WorkSpace button,   select New, and then click Picture. 

The Create Picture Wizard appears.

If the Create Picture Wizard does not appear,   you may need to enable the Create Picture Wizard:

 a. In Classic view,   select User Preferences from the WorkSpace menu. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click 
User Preferences. 

 b. Select the Picture   Preferences tab from the User Preferences dialog box. 

 c. Select the Show   Picture Wizard from New Picture Menu check box.

 3. Select the type of   picture configuration you want to create. The Create Picture Wizard allows   you 
to create the following types of pictures:

 l Create Picture(s)   from a Predefined Configuration

 l Create a Custom   Picture

 l Create a Default   'Untitled' Picture (When you select this option and then the Finish button,   
the wizard exits and creates a picture the current size of your WorkSpace.)
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 4. Select or clear the   Show WorkSpace Appearance Page check box and then click Next. If you 
selected   this check box, the WorkSpace Appearance page appears. If you cleared   the check 
box, go to step 6.

 5. Set the options on   the WorkSpace Appearance page.

This page configures general properties   for new pictures. It only needs to be accessed once per 
WorkSpace session.

 6. The next pages in   the Wizard depend on the type of picture you chose to create. Follow the   pro-
cedures associated with Step 3.

 7. Click Next. If you   are creating pictures from a predefined configuration, select which of   the pic-
tures in the configuration you want to create, and specify the   filename for each picture on the 
Select Filenames page.

 l To disable a   picture, clear the check box next to the generic name. Disabled pictures   will 
not be created.

 l Enter a filename   in the field next to each enabled picture.

 l If you are creating   a custom picture, enter a filename in the Custom field.

 8. Click Next. The Summary   page lists the configuration name, the generic pictures that will be cre-
ated   when you click Finish, and the filename of each picture. 

 9. Optionally, select   the Do Not Show Wizard check box to prevent the wizard from running the   next 
time you select New Picture from the File menu.

 10. Click Previous to   change your pictures, or Finish to exit and add the new picture files   to your sys-
tem tree.

 

Creating Pictures from a Predefined Configuration

 To create pictures   from a predefined configuration:

 1. In Classic view,   in the iFIX WorkSpace, click the New Picture button. 

-Or-

In Ribbon view, click the WorkSpace button,   select New, and then click Picture. 

 2. On the Introduction   page, select Create Picture(s) from a Predefined Configuration. Click   Next. 
The Choose Configuration page  appears.   

NOTE:   If you selected the Show WorkSpace Appearance Page check box on the Introduction   page, 
the WorkSpace Appearance page appears before the Choose Configuration   page.

 3. Select a picture   configuration from the list. 

 4. Click the Modify   Configuration button to customize the predefined configuration, if needed.   The 
Modify Configuration dialog box appears. Make the modifications and   return to the Choose Con-
figuration page.

 5. Click Next. The Select   Filenames page  appears.

 6. Select which of the   pictures in the configuration you want to create and specify filenames   for 
those pictures.
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 l To disable a   picture, clear the check box next to the generic name. Disabled pictures   will 
not be created.

 l Enter a filename   in the field next to each enabled picture.

 7. Click Next. The Summary   page lists the name of the predefined configuration, the generic pic-
tures   that will be created when you click Finish, and the filename of each picture.

 8. Optionally, select   the Do Not Show Wizard check box to prevent the wizard from running the   next 
time you select New Picture from the File menu.

 9. Click Previous to   change your configuration, or Finish to exit and add the new pictures   to your 
system tree.

 

Modifying a Predefined Configuration

 To modify a predefined   configuration:

 1. In the Create Picture   Wizard, from the Choose Configuration page, click the Modify Configuration   
button. The Modify Configuration dialog box appears.

NOTE:   The Create Picture Wizard's Choose Configuration page is only available   if you select Create 
Picture(s) from a Predefined Configuration in the   Introduction page.

 2. On the Attributes   tab, select the attributes for each picture within the configuration.

 3. On the Sizes tab,   change the size or position of each picture. 

 4. To save your modified   configuration, select one of the following options:

 l Save   – Saves   the changes for this picture only.

 l Save   As –   Saves the current options as a new configuration. When you select this   option, 
the Enter New Configuration Name dialog box appears. Enter the   name for the new con-
figuration (up to 80 characters) in the Name field,   then click OK to return to the Modify Con-
figuration dialog box.

 5. Click Return to Wizard.   If you have unsaved changes, choose whether you want to save them or 
not.   Click Yes to save the changes for this picture only, or click No to cancel   the changes you 
made to the configuration and reset the attributes and   sizes to their previous settings

 6. The Choose Configuration   page of the Create Picture Wizard reappears. Notice that the name 
you   entered (if you saved the configuration under a new name) is displayed   in the list on the 
Choose Configuration page.

TIP:   If you mistakenly save a predefined configuration, select the unwanted   configuration from the list 
on the Choose Configuration page and click   Delete Configuration.

Creating Custom Pictures

 To create a custom   picture:

 1. In Classic view,   click the New Picture button on the Standard toolbar. 

-Or-

In Ribbon view, click the WorkSpace button,   select New, and then click Picture. 

 2. On the Introduction   page, select Create a Custom Picture.
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NOTE:   If you selected the Show WorkSpace Appearance Page check box on the Introduction   page, 
the WorkSpace Appearance page appears before the Choose Configuration   page.

 3. Select either of   the following options:

 l Use Specified   Dimensions

 l Use Dimensions   of Existing Picture

 4. Click Next. 

 5. Select the attributes   that you would like for the picture.

 6. Click Next. 

 7. Specify a filename   for the picture, then click Next. The Summary page lists the filename   of the 
picture that will be created when you click Finish. 

 8. Optionally, select   the Do Not Show Wizard check box to prevent the wizard from running the   next 
time you select New Picture from the File menu.

 9. Click Previous to   change your picture, or Finish to exit and add the new picture to your   system 
tree.

 

Working with Other Applications

The open architecture of iFIX lets you easily incorporate features of   external applications. The following 
sections detail how to add other   applications into iFIX pictures.

 l Working   with ActiveX Controls

 l Working   with Bitmaps

 l Working   with Windows Metafiles

 l Creating   Alarms Using Pictures

Working with ActiveX Controls 

iFIX graphics are created and saved as ActiveX documents, which allows you to view your pictures in 
any application that supports ActiveX controls, such as the iFIX WorkSpace or Internet Explorer. In fact, 
you can think of the iFIX WorkSpace simply as a container for ActiveX controls.  

Working with Bitmaps

You can import bitmaps from another drawing application directly into   a picture. Once a bitmap is pasted 
into your picture, you can work with   the image as you would any iFIX object. In fact, you have additional 
options   for a bitmap. When you right-click a bitmapped object, you can select   the operations listed in the 
following table. 

Use this Oper-
ation...

To...
Bitmap Operations Available Through the Pop-Up   Menu  
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Animations Animate a bitmap using the Animations dialog box.
Undo Cancel the previous operation.
Cut Remove the bitmap from the picture and places it into   the clipboard.
Copy Copy the bitmap to the clipboard.
Delete Remove the bitmap from the picture.
Duplicate Create a duplicate copy of the bitmap and place it   slightly offset from the original.
Group Combine one or more bitmaps into one grouped object.
Bring to Front Move the selected bitmap to the front or top of the   picture.
Send to Back Move the selected bitmap to the back or bottom of   the picture.
Load Image Load a primary or secondary bitmap, either from a   file or from the clipboard, that can be 

displayed in your picture.
Enable/Disable 
Transparency

Enables or disables the Transparency property in the   bitmap.

Transparent 
Color

Assign a color to the Transparency of the bitmap.

If you have your display configured for true colors,   transparent bitmaps may not dis-
play properly. This may be related to the   type of video card in your PC. To avert this 
problem, change your Windows   display settings to 65536.

Button Styles Assign a button style (No Button, PushButton, or MultiState)   to the bitmap.
Edge Style Assign an edge style (None, Sunken, Raised, Etched,   Bump) to the bitmap.
Edit Script Open the Visual Basic Editor, which allows you to   edit Visual Basic scripts.
Property Win-
dow

Display the Properties Window, which allows you to   view and change property values.

Let's say you want to import a bitmap, and then be able to easily view   a different image related to the 
first. You can do this using the Load   Image operation from the bitmap's pop-up menu as follows:

 To use the Load   Image operation: 

 1. In Classic view,   on the Shapes toolbar, click the Bitmap button, if enabled. 

-Or-

In Ribbon view, on the Format tab, in the   Insert group, click Objects/Links and then click Bitmap.

-Or-

If the Toolbox is enabled, click the Bitmap   button on the Toolbox.

 2. Select the desired   directory and bitmap and click Open. The image is added to the picture   with 
object handles. 

 3. With the image selected,   right-click the mouse and select Load Image - Secondary from the 
object's   pop-up menu. 

 4. Select the file from   the Open File dialog box, and click Open. 

 5. To switch from one   image to another, right-click the bitmap and select Display Primary or   Display 
Secondary from the pop-up menu. 

Bitmaps can also be resized.  To   resize an imported bitmap, select it and then drag one of the sizing 
handles   in any direction.  Bitmaps   can be resized with little or no loss in picture quality.
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NOTES:

 l You can copy another   object as a bitmap and paste it into another graphics application such   as 
Microsoft Paint, or copy and paste an existing object as a bitmap.   You can also change the properties 
of a bitmap by selecting the bitmap,   and then selecting a property from the Object menu.

 l Bitmaps up to 24-bit   graphics resolution are supported. If a picture contains a large 24-bit   bitmap, 
there may be a short delay when opening the picture in iFIX.

Working with Windows Metafiles 

Another powerful feature of iFIX is that it lets you directly import   Windows metafiles (files with the exten-
sion .WMF) into your picture. When   importing metafiles, you can improve your performance by copying 
the object   as a bitmap and then pasting it into the picture. Refer to the Working   with Bitmaps section for 
more information on how to do this. The bitmap   will use much less system memory than the metafile.

Creating Alarms Using Pictures 

You can create pictures to monitor and display alarm conditions. For example, using animations and a 
color by alarm strategy, you can set up thresholds to visually alert an operator that a data source is in a 
particular alarm state.  

For more information, refer to the Animating Object Properties chapter. Refer to the Implementing 
Alarms and Messages manual for detailed information on how to employ an alarming strategy.

Optimizing Picture Performance 

iFIX provides you with a performance-oriented picture development tool   that is open and easy to use. 
Because it is an event-driven   system, iFIX does not allocate memory or use processor speed when it is   
not necessary. When an event occurs, only then does the system access   the CPU. This makes the 
drawing environment of iFIX more efficient. You   can draw a shape and link it to a live I/O source in a mat-
ter of seconds.   And, using the design considerations outlined in the previous section,   you can save even 
more time in your development and implementation.

Still, external to iFIX software, there are some guidelines that you   should abide by to make iFIX perform 
more effectively for your specific   needs.

The two easiest ways to optimize the performance of your pictures are   to make your pictures open faster 
and update faster. Common to both attributes   are:

Processor   Speed –   The faster the machine's processor, the faster your applications perform.

RAM   –   To avoid disk swapping, your computer must have enough memory to contain   all applications, 
databases, and cached pictures. If the computer does   not have enough memory, Windows swaps 
the applications to disk.

To optimize the speed at which iFIX initially displays pictures, iFIX   includes a Resolve feature, 
described in the Resolving   Pictures section that follows. To further optimize the speed at which   your pic-
tures are dynamically updated based on changes in process conditions,   try doing one or more of the fol-
lowing:
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 l Use computers that   have a local bus video. 

 l Update to a faster   graphics card, if necessary. 

 l Avoid blinking alarms.   For more information, refer to the Blinking   Alarms section.

 l Use exception-based   processing in your database. 

 l Change the refresh   rate. For more information, refer to the Increasing  the Refresh Rate section in 
the Setting up the Environment manual.   

Resolving Pictures 

Database information for each data source in a picture is saved as part   of the picture file on disk. When a 
picture is displayed in the run-time   environment, and the database information is not up-to-date, iFIX 
queries   the database and resolves   the tag definitions. This can be a time-consuming process which   
slows the opening of the picture. 

Resolving pictures removes the need for iFIX to query the database.   Therefore, resolved pictures open 
faster in the run-time environment.   The Resolve feature is available for both pictures and schedules, and   
can be accessed using the Utilities toolbar or the Picture category of   the Task Wizard (Classic view), or 
on the Applications tab, in the Utilities   group, in the Utilities list (Ribbon view).

When you resolve a picture that requires autoscaling, the iFIX Resolve   Task Wizard now opens the pic-
ture while resolving. 

NOTE: If you delete   tags from the process database after you resolve a picture, you need to   run Resolve 
again.

Blinking Alarms 

Instead of using blinking alarms, use a color-by alarm or color-by value strategy to indicate alarm status. 
Blinking is a very time-intensive operation because the blinking object and the surrounding objects need 
to be redrawn each time the picture is refreshed at the specified picture refresh rate, even though the 
information in the object has not changed. For more information on employing a color-by alarm strategy, 
refer to the Implementing Alarms and Messages manual.

Using Picture Caching

iFIX provides a picture caching capability that optimizes the performance   of the WorkSpace when open-
ing pictures by eliminating the need for picture   files to be read from the disk drive. Instead, pictures that 
have been   previously opened and closed are held in memory and, when reopened, are   read from 
memory. 

With picture caching, you can:

 l Preload pictures   that will always remain in the cache. 

 l Set the number of   pictures to be reopened from the cache. 
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There are two types of pictures you can cache: run-time pictures and   preload pictures. Run-time pictures 
are loaded into the cache when they   are closed. When the number of cached pictures exceeds the 
cache size   setting, the oldest picture is dropped from the cache and is replaced   with the most recently 
closed picture. Preload pictures are loaded when   the WorkSpace is started and have a property of 
AlwaysLoaded. They are   never dropped from the cache while you are in run mode.

In a new installation of iFIX, picture caching is enabled by default   with a picture count of five. In 
upgrades to iFIX 2.5 and later, picture   caching is not enabled by default. 

 l System   Requirements

 l Enabling   Picture Caching

 l Preloading   Pictures

 l Run-time   Pictures

System Requirements

System requirements for picture caching depend on the number of pictures   you choose to cache. 

The current version of iFIX requires 128 megabytes of physical memory   to run. However, as your cache 
size increases, your memory requirements   will increase. Use the following as a guide for memory 
requirements when   caching pictures. Memory should increase:

 l 2 to 3 times the   file size for each picture that does not include bitmaps and controls.   

 l 3 to 4 times the   file size for each picture that includes bitmaps and controls. 

For example, a 2 megabyte file that does not include bitmaps and controls   requires a 4 to 6 megabyte 
increase in memory. A 2 megabyte file that   includes bitmaps and controls requires an increase in the 
memory of 6   to 8 megabytes.

 

Enabling Picture Caching 

You must enable picture caching in order to preload pictures into the   cache or to cache pictures at run 
time. You enable picture caching in   the User Preferences Dialog box, shown in the figure below. 

If you disable picture caching, the most recently used cache is disabled,   no pictures will be preloaded, 
and all pictures will be fully closed when   the file is closed.

NOTE: Picture caching,   by default, is disabled when you upgrade from a previous version of iFIX   to the cur-
rent version.  If   you are installing iFIX 2.6 or later for the first time, picture caching,   by default, is enabled, with 
a default cache size of five.

Most users will not notice any difference in the way the system behaves   with cache enabled. However, 
if you have done extensive VBA scripting   in your application, there will be a few minor differences in the 
system   behavior. If you are upgrading from a previous version of iFIX, you should   review and understand 
these changes before enabling picture caching. See   the Making Changes   to Pictures at Run Time sec-
tion of this document for more information.   
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Preloading Pictures

You can preload frequently used pictures directly into the picture cache   when the WorkSpace starts in 
run mode. In order to do this, you need to   modify the FixUserPreferences.ini file, located in the C:\Pro-
gram Files (x86)\Proficy\iFIX\LOCAL   directory. Use a text editor to modify this file. The following two 
configuration   parameters are located in the [AppPreloadPicturePreferences] section of   the FixUser-
Preferences.ini file. These parameters are required to preload   pictures.

TotalPreloadPicturePath=<nn>
PicturePath#0=Firstpicture.grf

TotalPreloadPicturePath indicates the number of pictures you want to   preload in the cache. Pic-
turePath#N indicates the file name of each picture   you want to preload. For   example, to preload two pic-
tures into the cache, enter the following lines   to the FixUserPreferences.ini file:

[AppPreloadPicturePreferences]
TotalPreloadPicturePath=2
PicturePath#0=Firstpicturename.grf

© 2024 General Electric Company. All rights reserved. 91



PicturePath#1=Secondpicturename.grf
 

NOTE: The WorkSpace   will only preload pictures when picture caching is enabled and the Start   WorkSpace 
in Run mode check box is enabled. WorkSpace does not preload   pictures when switching from configure 
mode to run mode.

Ensure that the number of pictures you enter to preload in the FixUserPreferences.ini   file does not exceed the 
Cache Size you have set in the WorkSpace User   Preferences dialog box.

Save and close the FixUserPreferences.ini file after making your changes.   Restart the WorkSpace to 
load the new preferences settings.

Preloaded pictures are designated as always loaded by definition. They   will not be dropped from the 
cache while you are in run mode. Displays   are preloaded only when the WorkSpace is initially started in 
run mode.
 

Run-time Pictures 

At run time, you can also cache pictures that you open and then close.   

When picture caching is enabled, the WorkSpace maintains a list of the   most recently closed files. 
When you close a file, that document is placed   on the list of most recently closed files. If this list of 
closed files   exceeds the cache size, the first file closed is unloaded from memory   and completely 
closed. However, preloaded pictures are not dropped from   the cache. You can view a list of cached pic-
tures by pressing Ctrl + Shift   + C. The following figure shows the picture caching process.
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How Picture Caching Works

NOTE: You cannot delete   a picture that is closed into the cache. You must wait until that picture   is dropped or 
flushed from the cache before deleting.

Picture Caching only functions when the WorkSpace is in run mode. If   you switch to configure mode, 
the most recently closed cache is flushed   and any files in the cache are fully closed. All preloaded pic-
tures in   the loaded state are then closed. If you switch back to run mode, pictures   in the preload list are 
not loaded into memory. 

If you disable picture caching, the most recently used cache is disabled,   no pictures are preloaded, and 
all pictures are then fully closed when   the file is closed.
 

Making Changes to Pictures at Run Time

During run time, VBA allows you to write a script to change the properties   of any object contained in a 
picture. These changes are not written to   the stored file, but are temporary changes made to the 
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displayed picture   in memory. If picture caching is disabled,   those changes are gone when you close the 
picture.

When you enable picture caching, some of your run-time changes are preserved   while your picture 
remains cached. If you change any object properties   (such as foreground color) through VBA or make 
changes to a chart through   a chart dialog in run mode, you will still see those changes when you   close 
the picture and reopen it from cache. However, your changes are   not written to the stored file, and once 
the picture drops from the cache,   your changes are lost. If you use scripts to make those changes, you 
should   retest your displays with caching enabled.

All other behavior involving tag groups, or changing alarm summary sort   or filter configurations, are not 
preserved regardless of whether picture   caching is enabled or disabled. 

Disabling Picture Caching for Individual Pictures

iFIX also allows you to disable picture caching for individual pictures so that changes made during run 
time will not persist when the picture is reopened.  

 To disable picture caching for a picture: 

 1. Right-click the picture name in the system tree, or right-click any area in the picture outside of an 
object to display the pop-up menu.    

 2. Select Picture... to display the Edit Picture dialog.   

 3. Check the Disable caching for this picture check box from the Edit Picture dialog box.   

Resizing Pictures 

You can resize a picture in configure mode, so that every time you go   into run mode the picture appears 
in the location you want it to. 

NOTE: The type   of coordinate system (Logical or Enhanced) is not relevant.

In addition, you can resize a picture through VBA.   For instance, you can create a push button with code 
behind it that, when   clicked in run-mode, resizes the picture. The steps below provide more   details.

 To resize a picture in configure   mode:

 1. In Classic view,   in configure mode, on the WorkSpace menu, click User Preferences. 

-Or-

In Ribbon View, on the Home tab, in the   WorkSpace group, in the Settings list, click User Prefer-
ences.

 2. Click the Picture   Preferences tab.

 3. In the Window Properties   area, make sure that the Title and Resizable   check boxes are selected.

NOTE:   After you resize the picture, you can enable these options again, if required.

 4. In Classic view,   on the WorkSpace menu, click Full Screen. 

-Or-
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In Ribbon view, in the WorkSpace group,   click Full Screen.

 5. Click and drag a   corner or side of the picture to resize it.

 6. When the picture   is in the desired location, right-click it and select Update Window Location.

 7. Click Close Full   Screen.

 8. Save the picture.

TIP:    For Logical   Coordinate System pictures only, if you want to restore the default picture   height and 
width values, in configure mode, right-click the picture and   select Full View. You can now repeat steps 
4-8 to resize the picture again.   (Full View is not available for Enhanced Coordinate System pictures.)

 9. In Classic view,   on the WorkSpace menu, select Run. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Switch to Run.

 10. Confirm that your   picture appears in the desired location.
 To use VBA   to resize the current picture in run mode:

 1. In the WorkSpace   configure mode, add a push button to your picture.

 2. Right-click the push   button, and select Edit Script. The Microsoft Visual Basic Editor appears.

 3. Cut and paste the   following code:
Private Sub Command1_Click()
Dim objFIXPic As Object
Dim dTopPct As Double
Dim dLeftPct As Double
Dim dHeightPct As Double
Dim dWidthPct As Double
Set objFIXPic = CreateObject("Workspace.Application")
dTopPct = 20
dLeftPct = 20
dHeightPct = 50
dWidthPct = 50
objFIXPic.ActiveDocument.Page.SetWindowLocation TopPct, dLeftPct, dHeightPct, dWidthPct, True
Set objFIXPic = Nothing
End Sub

NOTE:   You can modify the dTopPct,   dLeftPct, dHeightPct,   and dWidthPct   resize percentage values to 
the values specific to the picture you want   to resize.

 4. Close the Microsoft   Visual Basic Editor.

 5. Save your picture.

 6. In Classic view,   on the WorkSpace menu, select Run. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Switch to Run. 

 7. Click the button   to resize your picture.

 

Maximizing the WorkSpace on Open 
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If you want to be sure that the iFIX WorkSpace always opens   maximized, you can add this setting to the 
WorkSpace.ini file's [Misc]   section:

AlwaysShowMaximized=1

If you later change the value from a 1 to a 0, or remove the line altogether,   the iFIX WorkSpace starts in 
the mode it was last open in. For instance,   if the window was minimized and you shut it down, when you 
restart the   WorkSpace it will re-appear minimized. It does not matter if the WorkSpace   was last in con-
figure mode or run mode. 
 To configure the iFIX WorkSpace to   always open maximized:

 1. Shut down the WorkSpace.

 2. In Notepad or another   text editor, open the WorkSpace.ini file in the iFIX LOCAL folder. If   you 
installed iFIX to the default location, you can find this file in   the C:\Program Files (x86)\Profi-
cy\iFIX\LOCAL location.

 3. In the [Misc] section,   add this line:
AlwaysShowMaximized=1

 4. Save the file.

 5. Restart the WorkSpace.

 

Changing Picture Settings in the FixUserPreferences.ini   File

iFIX provides you with the FixUserPreferences.ini file that allows you   to make changes to user pref-
erences that are not available on the User   Preferences dialog box, from the iFIX WorkSpace. You can 
also make changes   to preferences that are available on the dialog box. The FixUserPreferences.ini   file 
is installed with iFIX and is located in the LOCAL folder of the   iFIX install directory. When you install 
iFIX to the default location   the path is: C:\Program Files (x86)\Proficy\iFIX\LOCAL.

You can also add user preferences to this file to control certain behavior.

Use caution when making changes to the FixUserPreferences.ini file,   and ensure that you are changing 
the correct settings. You must shut down   iFIX before making your changes to this file, and then restart it 
for   the new settings to take effect.

Configuring Whether a Prompt Appears on Close   for Changes in Run Mode

If you make a change to a picture in run mode, when you attempt to close   the picture, a prompt appears 
warning you that your changes will not be   saved. You can disable this warning prompt with the 
RuntimePictureChangeSaveWarning=0   setting in the [AppRunPreferences]   section of the FIXUser-
Preferences.ini   file. 

Run mode changes can be made on-the-fly (via scripting) such as with   the BuildObject.   By default, a 
warning message about any changes appears when you close   the picture in run mode. You may want to 
close this picture without user   interaction, and not display this message. 

To allow suppress this warning message, change the RuntimePictureChangeSaveWarning=1   setting 
(the default) to RuntimePictureChangeSaveWarning=0 in the FixUserPreferences.ini   file. By default, 
this message is enabled (set to 1).
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 To disable the   Save prompt that displays when you close a picture with changes in run   
mode:

 1. Shut down iFIX if   you haven't already done so.

 2. Open the FixUserPreferences.ini   file in a text editor, such as Notepad.

 3. Find the RuntimePictureChangeSaveWarning=1   setting under the [AppRunPreferences]   section.

 4. Change the setting   to 0. 

 5. Save the FixUserPreferences.ini   file and restart iFIX.

Changing the Nudge Settings

The nudge settings determine the number of pixels or degrees your object   will move, scale, or rotate. 
Each action has both slow and fast settings.   The setting is determined by whether you are using the 
SHIFT   or CTRL   keys, a combination of both, or neither, depending on the action.   The following table indic-
ates which keys or key combinations to use for   these actions:

To perform the action... Use the following keys...

SlowNudgeMoveOffset The arrow keys.

FastNudgeMoveOffset SHIFT +   arrow keys

SlowNudgeScaleOffset CTRL   + arrow keys

FastNudgeScaleOffset CTRL   + SHIFT + arrow   keys

SlowNudgeRotateOffset + = Counter Clockwise
- = Clockwise

FastNudgeRotateOffset SHIFT +   rotate (+ or - )

NOTE: To perform   either of the rotate actions, right-click the object and choose Rotate,   then press either the 
SHIFT or   CTRL   key and use the rotate handles that appear.

 To change the   nudge settings:

 1. Shut down iFIX if   you haven't already done so.

 2. Open the FixUserPreferences.ini   file in a text editor, such as Notepad.

 3. Find the [ShapePreferences2]   section.

 4. Change the nudge   settings, as required. 

 5. Save the FixUserPreferences.ini   file and restart iFIX.

Allowing a group click event 

iFIX provides you with the ability to group objects in a picture and   treat that group as if it is a single 
object. You can animate the group   just like you can animate individual objects. By default, however, iFIX   
prevents certain objects in a group from performing events that are defined   in the Visual Basic Editor, 
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such as a message script. To allow all objects   in a group to perform the desired events, change the 
PassControlClickEvent   setting to 1 in the [AppRunPreferences]   section of the FixUserPreferences.ini 
file.

 To allow a group   click event:

 1. Shut down iFIX if   you haven't already done so.

 2. Open the FixUserPreferences.ini   file in a text editor, such as Notepad.

 3. Find the PassControlClickEvent=0   setting under the [AppRunPreferences]   section.

 4. Change the setting   to 1. 

 5. Save the FixUserPreferences.ini   file and restart iFIX.

Disabling the Right-Click Menu

iFIX provides you with the ability to disable the right-click menu in   the WorkSpace run mode. To disable 
the right-click menu in run mode, change   the DisableRuntimeRightClickMenu   setting to 1 in the 
[AppRunPreferences]   section of the FixUserPreferences.ini file. By default, the right-click   menu is 
enabled. 

 To disable the   right-click menu in the WorkSpace:

 1. Shut down iFIX if   you haven't already done so.

 2. Open the FixUserPreferences.ini   file in a text editor, such as Notepad.

 3. Find the DisableRuntimeRightClickMenu=0   setting under the [AppRunPreferences]   section.

 4. Change the setting   to 1. 

 5. Save the FixUserPreferences.ini   file and restart iFIX.

Other Picture Settings Available through the FixUserPreferences.ini file

There are other settings that you can configure in the FixUserPreferences.ini file located in the iFIX base 
path (by default: C:\Program Files (x86)\Proficy\iFIX\LOCAL). These include: ZoomToFitFromCenter, 
ThickEdgeLinesWithZoom, and SmoothShapes. After changing any of these settings in the FixUser-
Preferences.ini, the WorkSpace must be restarted for these changes to take affect.

In an earlier version of iFIX, code was added to limit the evaluation of animations to Workspace Run 
mode only. However, there are valid scenarios in which animations need to be evaluated in Workspace 
Configuration mode.

The user preference AllowEvalInConfigMode enables and disables the evaluation of animations in Work-
space Configuration mode.

To enable evaluation of animations in Workspace Configuration mode, add the AllowEvalInConfigMode 
parameter to the [AppDesignPreferences] section of the FixUsersPreferences.ini file (located in the 
LOCAL folder) and set it to 1. To disable this feature, set the parameter to 0. By default, this parameter is 
disabled.

For example, to enable this feature:

[AppDesignPreferences]
AutoSave=0
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FullScreen=0
...
AllowEvalInConfigMode=1

The Workspace must be restarted for any changes to the AllowEvalInConfigMode parameter to take 
effect.

Developing Objects in Pictures

iFIX gives you all the tools you need to create simple or complex pictures   for your process environment. 
This chapter gives you an overview of all   the functionality available to you, and gives specific instruc-
tions on   how to perform various operations that help you expedite picture development.

 l Adding   Objects to Pictures

 l Performing   Basic Functions with Objects

 l Performing   Advanced Functions with Objects

 l Creating   Complex Objects

Adding Objects to Pictures 

Using the Shapes toolbar, you can add an array of different objects   to your picture. The following table 
shows you which objects are available   and how to add them using the toolbar buttons: 

Click 
this but-
ton...

Which can also be accessed in 
Ribbon view...

To add... Double-click 
for multiple   
creation 
mode?

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Rectangle.

Rectangles. Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Straight Line.

Straight lines. Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Oval.

Ovals. Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Arc.

Arcs (curved line seg-
ments).

Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Rounded Rectangle.

Rounded rectangles. Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Polygon.

Polygons. Yes

Shapes Toolbar  
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From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Polylines.

Polylines (two or more con-
nected line segments).

Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Chord.

Chords (a curved line con-
necting a line segment).   

Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Pie.

Pie shapes (wedges of a 
circle). 

Yes

From the Insert tab, in the Shapes 
group, click Shapes,   and then click 
Pipe.

Pipes. Yes

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Text.

Text. Yes

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Bitmap.

Bitmaps. Yes

From the Insert tab, in the Object-
s/Links group, in   the Objects/Links 
list, click DataLink Stamper.

Data links. No

From the Insert tab, in the Object-
s/Links group, in   the Objects/Links 
list, click Historical DataLink.

Historical Data links. No

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Alarm Summary.

Alarm Summaries. No

From the Insert tab, in the Charts 
group, click Line Multiline Chart.

Line Multiline Chart. Yes

From the Insert tab, in the Charts 
group, click X Bar Chart.

X Bar Chart. Yes

From the Insert tab, in the Charts 
group, click R Bar Chart.

R Bar Chart. Yes

From the Insert tab, in the Charts 
group, click S Bar Chart.

S Bar Chart. Yes

From the Insert tab, in the Charts 
group, click Histogram Chart.

Histogram Chart. Yes

From the Insert tab, in the Charts 
group, click XY Chart.

XY Chart. Yes

From the Insert tab, in the Charts 
group, click Standard Chart.

Standard Charts (com-
pound objects made of 
lines, text, and   rect-
angles). 

Yes

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Push Button.

Push Buttons. No
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From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Variable

Variable objects. No

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click OLE object.

OLE objects. No

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Timer.

Timer Objects. No

From the Insert tab, in the Object-
s/Links group,  click   Objects/Links, 
and then click Event.

Event Objects. No

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Current Time.

Current Time (a text 
object).

Yes

From the Insert tab, in the Object-
s/Links group, click   Objects/Links, 
and then click Current Date.

Current Date (a text 
object).

Yes

From the Insert tab, in the Object-
s/Links group, in   the Objects/Links 
list, click DataLink.

Data links. No

By default, all of the buttons in the above table appear in the Toolbox   when you create or open a picture. 
If you have the Toolbox enabled, you   can add objects to your pictures by clicking the appropriate button 
on   the Toolbox.

TIP: To add multiple   objects of the same type, double-click the appropriate button on the Toolbox.   When you 
are done adding the objects, press ESC, click another button,   or click the pointer selection tool in the Toolbox. 
For information on   which buttons allow multiple creation, refer to the previous table.

A powerful feature of iFIX is the capability to add ActiveX controls   (OCXs) to your pictures. ActiveX con-
trols provide functionality to your   pictures without your having to write complex code. Because of its 
open   architecture, iFIX allows you to drag and drop any third-party object   (OCX) into your displays.

NOTE: Because third-party   objects are self-contained applications in themselves, you should be aware   that 
problems that occur from these components are beyond the control of GE.   However, iFIX does provide 
Secure Containment, which seals off a crashed   ActiveX control and allows iFIX to run normally.

 

Drawing Shapes

Once you select a shape (that is, a rectangle, rounded rectangle, oval,   line, polyline, polygon, arc, chord, 
pie, or pipe), it is easy to add   it to a picture.

Some shapes are drawn by defining a series of points using the mouse.   

 To draw an arc:   

 1. In Classic view,   click the Arc button on the Shapes toolbar. 

-Or-
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In Ribbon view, on the Insert tab, in the   Shapes group, in the Shapes gallery, click Arc. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The cursor changes to a plus sign. 

 2. Position the cursor   where you want the first point of the arc to appear and click. 

 3. Move the cursor to   define the width of the arc and click the mouse. An arc appears on the   screen. 

 4. Move the cursor until   the height of the arc is the correct size and click. 

See the following illustration.
   

Similarly, you draw a chord as illustrated in the following figure:
   

And you draw a pie as illustrated in the following figure:
   

 

Adding a Chart 

You can choose to add either a Standard Chart or an Enhanced Chart to   your picture. To add a chart to 
your picture, click the desired chart   button on the Shapes toolbar (Classic view) or on the Insert tab, in 
the   Charts group, select the desired Chart (Ribbon view). If you have the   Toolbox enabled, click the but-
ton on the Toolbox. The cursor becomes a   plus sign. Click and drag the mouse in an area of the picture 
where you   want to place the chart. A chart appears on the screen, and also in the   system tree.
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By double-clicking the chart, you can define properties for the chart   using the Chart Properties dialog 
box. The properties available depend   on the data source selected. Chart Properties are detailed fully in 
the   Trending Historical Data manual.
Trending Real-time Data in Your Picture 

If you choose a real-time data source, certain properties are enabled   or disabled, as shown in the fol-
lowing table. Real-time data sources can   also include T_DATA2 from Trend blocks. 

Property Property State
Fixed Date Disabled 
Fixed Time Disabled
Days Before Now Disabled
Duration Before Now Disabled
Duration Enabled
Interval Disabled

Real-Time Data Source Chart   
Properties  

To plot real-time data, you must define a real-time data source. To   do this, for Standard Charts, click the 
Chart tab, for Enhanced Charts,   click the Data Sources tab, on the Chart Customization dialog box and,   
at the top of the tabbed page, enter a real-time data source in the Data   Source field. Use Data Serv-
er.node.tag.field   format. You can also use a local node alias by selecting THISNODE   from the list. 
Alternately, you can click the Browse button to display   the Expression Builder, which allows you to 
search global data sources   through a data source browser. To learn how to use the Expression Builder   
and define data sources, refer to the Animating   Object Properties chapter.

Once you have defined a real-time data source, you can define how the   data is presented. For Standard 
Charts, using the data area of the Chart   tabbed page, you can configure pen properties, pen styles, X 
and Y axis   properties, time ranges, grid styles. You can also define general chart   properties such as a 
name and description, scroll direction, attributes,   and appearance. For Enhanced Charts, you can use 
the multiple tabs available   to configure every attribute of the chart's appearance and data representation.

For Standard Charts only, default settings for charts are set in the   Standard Chart Preferences tabbed 
page of the User Preferences dialog   box. For more information on using charts and applying chart prop-
erties,   refer to the Trending Historical Data   manual.

How F_CV Real-time Values Are Trended

The duration and number of samples determine how F_CV real-time values   are trended in a chart.  For   
example, if you set the number of samples to 600 and the duration to one   minute, then the chart displays 
a value for every second. In this example,   the trend array holds a maximum of 600 seconds of data, or 
10 minutes.   You can change the duration to any value under or equal to 10 minutes,   and the trend line 
continues to be plotted. However, if you change the   duration to a value greater then 10 minutes the trend 
is cleared, and   the data is plotted based upon the new duration and number of samples.   The following 
table illustrates this example, and provides a few more.

NOTE: Be aware   that if you want to change the duration from a small value, such as 10   minutes, to larger 
value, such as an hour, and back, then it is highly   recommended that you use either ETR (Extended Trend 
Blocks) or Historical   data.

Duration Number of Then the Trend Array Contains...
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Samples
1 minute 600 samples 10 minutes of data, 1 value for every second
5 minutes 600 samples 10 minutes of data, 1 value for every second
10 minutes 600 samples 10 minutes of data,1 value for every second
1 hour 600 samples 1 hours of data, 1 value for every 6 seconds
6 hours 600 samples 1 hours of data, 1 value for every 36 seconds
12 hours 600 samples 1 hours of data, 1 value for every 72 seconds
24 hours 600 samples 1 hours of data, 1 value for every 144 seconds

 

Adding Text 

A text object is a collection of characters within an invisible rectangle.   To add text to your picture, click 
the Text button on the Shapes toolbar   (Classic view) or on the Insert tab, in the Objects/Links group, on 
the   Objects/Links list click Text (Ribbon view). If the Toolbox is enabled,   click the button on the Tool-
box.

The default font properties for text are defined on the Shape Preferences   tabbed page of the User Prefer-
ences dialog box. To change a font option   for new objects, make the appropriate selections in the Font 
area. For   example, to change the size of the font, enter a point size in the Font   Size field. 

If you use text with an italic font style in your pictures, the text   may not always appear as expected. If 
the text appears clipped in your   picture, use the handles to resize the text block. Selecting a different   
font may also correct this problem. 

Text within a text object can be edited by:

 l Double-clicking the   text object and placing the cursor where you want to make your edits.

 l Right-clicking the   text object and selecting Edit Text from the pop-up menu that appears.   

 l Editing the Caption   property. For instance, you can do this by right-clicking the text object   and 
selecting Property Window. In the Caption field, enter your changes   and press Enter.

For more information on Shape Preferences, such as how to change the   text color, style, and size, refer 
to the  Coloring and Styling   Objects section.

Adding a Bitmap Image 

With iFIX, it's easy to work with bitmaps that were created using other   applications. By simply clicking 
the Bitmap button, you can place a bitmap   of your choice wherever you want in your picture, and then 
work with the   image like you would any other object. For more information on working   with bitmaps, refer 
to the Working   with Bitmaps section. 

Adding Data Links 
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Data links give operators a flexible tool for displaying text and values   from process databases. To add a 
data link to your picture, click the   Datalink Stamper button on the Shapes toolbar. In Ribbon view, from 
the   Insert tab, in the Objects/Links group, in the Objects/Links list, click   Datalink. If the Toolbox is 
enabled, click the button on the Toolbox.   In the Datalink dialog box, specify your choices for the fol-
lowing settings:

 l Access to any data   source. 

 l Data entry. 

 l Flexible display   formatting. 

 l Definable output   error messages. 

After completing the Datalink dialog box, click the mouse in the location   where you want to place the 
data link. Once you add a data link, you can   access the Datalink dialog box by selecting DataLink Cus-
tom Page from   the data link's pop-up menu.

The initial size of the data link is determined both by the formatting   settings you choose in the Datalink 
dialog box and by the font settings   in the User Preferences dialog box. To change the size of the font, 
access   the User Preferences dialog box through the WorkSpace menu (Classic view)   or from the Home 
tab, in the WorkSpace group, in the Settings list, click   User Preferences (Ribbon view), and set the font 
properties on the Shape   Preferences tab. Once you have created a data link, you can resize it   by click-
ing on it and dragging the handles, and reformat it using the   Datalink dialog box.

NOTE: If you add a   data link by selecting Datalink from the Insert menu (Classic view) or   from the Insert tab, in 
the Objects/Links group, in the Objects/Links   list and clicking Datalink (Ribbon view), you first sketch the loc-
ation   and size of the data link, then complete the Datalink dialog box. In this   case the size of the data link is 
determined by your initial sketch.
Entering a Data Source 

You can display data from any valid data source using your data link.   In the Source field, enter the data 
source you want. You can also select   from the Expression Builder by clicking the Browse button.
Enabling Data Entry 

To allow operators to enter data into the data link, select In-Place   from the Type field's drop-down menu. 
This lets you enter data in-place,   meaning you can display data as you enter it in the Type field. In the   
run-time environment, data entered is written to the appropriate database   tag during the next scan cycle. 
When you enable data entry, you can require   that operators confirm that they want this data to be written 
to the database   before it is sent. To require confirmation, select the Confirm check box.

To help you configure data, use the Data Entry Expert. This Expert lets   you determine which data 
source the data link receives its data from,   and how that data appears.

If you use the Data Entry Expert on a data link, you must set the Data   Entry Type value in the Datalink 
dialog box to None. If you set this value   to In-Place, unexpected results may occur.

Use the Data Entry Expert to create the following types of data entry:

 l Numeric/Alphanumeric   

 l Slider 

 l Pushbutton 

 l Ramp 
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NOTE: Do not name your   picture after one of Data Entry Expert types. Picture names can conflict   with the 
script variable names used with the Data Entry Expert. For instance,   if you name your picture Pushbutton.grf 
and also use the Pushbutton data   entry method, when you enter run mode, an error message appears. If you   
rename the picture, Pushbutton1.grf, the error message does not appear,   since the picture name is now dif-
ferent than the data entry method. 

You can access the Data Entry Expert from the Task Wizard. For more   information on the fields of the 
Expert, click the Help button. For more   information on using the Task Wizard, refer to the Using  Experts 
and the Task Wizard section in the Understanding iFIX manual.

You can also create custom types of entry in VBA. For more information   on VBA, refer to the Writing 
Scripts   manual.
Formatting Data 

iFIX lets you format the data you want to display in the data link.   First, you must choose one of the fol-
lowing types of data to display:

 l Raw 

 l Numeric 

 l Alphanumeric 

To display data in its raw (or native, C code) format, select the Raw   Format check box. You can then 
edit the format by entering a C format   string in the Format field. You can also enter a string of any kind 
preceding   the raw format string (to introduce what the data string represents, for   example).

To format numeric data, first select Numeric from the Type field's drop-down   menu. Next, enter an 
integer from 0 to 7 to represent the:

 l Whole   digits –   the number of digits displayed before the decimal point. 

 l Decimal   digits –   the number of digits displayed after the decimal point. This value is   rounded off 
to fit into the number of digits specified for the Data link.   

The following table shows some examples of how formatted numbers affect   the way the data link dis-
plays in the run-time environment. 

Whole Digits Decimal Digits Display at Run-time
2 4 12.1234
1 6 1.123456
6 1 123456.1
0 7 .1234567
7 0 1234567

NOTE: To format a data   link to display scientific notation, first select a F_CV, E_CV or A_CV   field, enable the 
Raw Format check box, and specify %e in format field.   F_CV and E_CV datalinks using %e raw format, by 
default, display 6 places   after the decimal point. To display more places after the decimal point,   for example 
15, change %e to %1.15e. A_CV datalinks using %e raw format   will always display 15 places after decimal 
point. To display a leading   zero in the link, use the F_CV field and the raw format similar to %02.2f.

To format alphanumeric (or text) data, first select Alpha-Numeric from   the Type field's drop-down menu. 
Next, enter in the appropriate fields   the number of lines and the number of characters per line you want to   
display in the Data link. You can also justify the data to the left, right,   or center, by making the appro-
priate selection from the Justify field.   
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Be aware that float point precision can differ between a datalink and   what is shown in the Database Man-
ager. In order to synchronize the two,   use the following .INI file setting in the FixUserPreferences.ini file   
in the iFIX Local folder:

[AppRunPerferences] 
AllowPrecisionAdjustment=0

A value of 0 indicates that there is no special precision adjustment   for a datalink, and it will be the same 
precision as the Database Manager   displays. The default behavior is to allow datalink precision adjust-
ment.
Using Tag Groups in Data Links

When using tag groups in data links and using raw format strings, you   must be sure to match data types 
between the values and the format string.   

For example, if the tag used is going to be replaced by the value of   Fix32.Thisnode.AI1.F_CV,   the 
format string must be %f, or some derivative (i.e. %7.2f). The default   when entering a tag group is %s, or 
string. If you do not adjust this   and the types do not match, no formatting will occur and you will only   get 
the value.
Configuring the Output Error Mode 

The Error Configuration area of the Datalink dialog box lets you determine   how error conditions are dis-
played by the data link should they appear.   You can configure the output to derive its value from:

 l An error table, or   

 l The current value.   

For more information on output values and definitions, refer to the   Classifying Animations   Errors section.

You can also display system information using the data link. To do this,   add a data link to your picture as 
described in this section. When selecting   a data source, use the format FIX32.node:system:system   
field. This data link can display a number of different system   parameters of a particular node. Refer to 
the iFIX  Database Reference help for a list of system parameters.
Using the DataChange Event in a Data Link 

If you are attempting to use the DataChange Event in a data link, you   cannot create the VBA object 
(such as Private Sub Format1_DataChange)   by selecting Edit Script from the right-click menu. 

To use the DataChange event with a data link, you must use the DataChange   event with the Format 
child object. 
 To use the DataChange event with   a data link: 

 1. Create a data link.   

 2. Open the VBA Editor.   

 3. Type the following   code and press ENTER: 
Private Sub Format1_DataChange(ByVal DataValue As Variant, ByVal TimeStamp as Date, ByVal Transition As Long, ByVal Reserved As Variant) 

The VBA object gets created.

 4. Enter any desired   code. 

 5. Enter End Sub at   the end of the subroutine. 

NOTE: These steps assume   that the Format object name is Format1.

 

Adding Historical Datalinks to Pictures
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Historical datalinks give operators a flexible tool for displaying historical   values from process databases. 
In addition to displaying the text and   values from a process database, the Historical Datalink displays a 
time   stamp. The time stamp, in most cases, indicates the end time of the interval   for the data collected. 
The only time this is not true is when the historical   datalink is configured to collect the high, low or cur-
rent value for the   interval. In those cases, the time the value occurred is displayed, rather   than the end 
time of the interval. The value in the Historical Datalink   is updated at the update rate specified during 
configuration.

To add a historical data link to your picture, in Ribbon view, from   the Insert tab, in the Objects/Links 
group, in the Objects/Links list,   click Historical Datalink. In Classic view, click the Datalink Stamper   but-
ton on the Shapes toolbar. If the Toolbox is enabled, click the button   on the Toolbox. In the Historical 
Datalink dialog box, specify your choices   for the following settings:

 l Access to any data   source (that contains Numeric data)

 l Start date and time

 l Historical mode

 l Duration 

 l Update rate

After completing the Historical Datalink dialog box, click the mouse   in the location where you want to 
place the historical data link. After   you add a historical data link, you can access the Historical Datalink   
dialog box by selecting DataLink Custom Page from the historical data   link's pop-up menu.

After you have created a data link, you can resize it by clicking on   it and dragging the handles.

IMPORTANT:   Be aware that Historical Datalinks or Historical  Animations that use Sample or Interpolated 
data from Proficy Historian   may display a Lookup or Format error status of “Unknown”, when the local   com-
puter's time is ahead of the Proficy Historian Server's time.  (The   “Unknown” Lookup or Format data symbols 
are defined in the User Preferences,   on the Animations Data Error Defaults tab.) 

Entering a Data Source 

You can display data from any valid data source using your historical   data link. In the Source field, enter 
the data source you want. You can   also select from the Expression Builder by clicking the Browse but-
ton.

IMPORTANT:
 l Be   aware that while Proficy Historian can store both String and Numeric data,   the iFIX data system can 

only retrieve Numeric data for historical datalinks.
 l Text   block values, which the Proficy Historian data system does NOT support   retrieving, are also not 

supported as a the data source for historical   datalinks in iFIX. 

Configuring the Data to Display

Depending on the historical mode that you choose from the Historical   Mode list, you can configure the 
start date and time as well as the duration.   If you choose the Current Value historical mode, you can only 
configure   the update rate for the historical data link. For all other historical   modes, to determine the start 
date for the historical data link, you can   choose either a fixed, specific date, or a certain number of days 
before   the current date. Similarly, for the start time, you can choose either   a fixed, specific time, or a cer-
tain number of hours before the current   time.
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If you want to specify the time zone you can do so in the Time Zone   area. To set the duration, or the time 
range for the display, select the   number of days, hours, minutes and seconds in the Duration area. To 
set   the rate at which the data is updated, set the update rate in the Update   Rate area.

Configuring the Appearance of the Data

By default, the historical datalink displays with a timestamp. The timestamp   is in the regional date and 
time format configured for your system. If   you do not want to display the timestamp with the data in any 
of your   historical datalinks, in the User Preferences dialog box, on the Shape   Preferences tab, in the His-
torical Datalink area, clear the Show Timestamp   With Data check box. Changes made on the User 
Preferences dialog box only   apply to new Historical Datalinks and do not effect existing historical   
datalinks. If you only want to hide the timestamp for the particular historical   datalink you are configuring, 
clear the Show Timestamp With Data check   box on the Historical Datalink dialog box for that historical 
datalink.   Or, from the Property Window, for the Show Timestamp property, select   False. This change 
applies only to the selected historical datalink and   is not subject to changes on the User Preferences dia-
log box.

The historical datalink can be animated. To animate the historical datalink,   from the right-mouse menu, 
select Animations. Complete your animation   configuration selections on the Basic Animations dialog 
box.

Adding an Alarm Summary Object 

Using Alarm Summary objects in your pictures gives you an effective   way to monitor, acknowledge, 
sort, and filter alarms using an OCX. You   can color-code alarms by alarm status and priority in order to 
provide   operators with visual cues. You can also view how many alarm occurrences   have taken place 
between alarm acknowledgements (using the A_ALMOCCUR   block field).

To add an Alarm Summary object to your picture, click the Alarm Summary   button on the Shapes toolbar 
(Classic view) or on the Insert tab, in the   Objects/Links group, in the Objects/Links list, click Alarm Sum-
mary (Ribbon   View). If the Toolbox is enabled, click the button on the Toolbox.

The Alarm Summary object appears as a spreadsheet that you can modify   in both the configuration and 
run-time environments. For example, you   can resize the object using the object's handles, resize the 
columns in   the spreadsheet, or select rows in the spreadsheet in both environments.   Additionally, you 
can perform many functions using the object's pop-up   menu. 

Before you add an Alarm Summary object to a picture, verify that specific   alarming services and net-
working options are enabled. Refer to the Understanding  the Alarm Summary Object section in the 
Implementing Alarms and Messages   manual for more information on using the Alarm Summary object.

NOTE: Inserting an   alarm summary into a VBA form may cause unpredictable results when opening   the pic-
ture or switching environments from run-time to configuration or   vice versa.

Adding Push Buttons 

Push buttons are a visually effective way to invoke an action in your   picture. They can help you:

 l Toggle tags between   Automatic and Manual mode. 

 l Open and close pictures.   

 l Toggle digital tags   between OPEN and CLOSE. 
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 l Manipulate files.   

 l Run other applications.   
 To add a Push Button to your picture:

 l In Classic view,   click the Push Button button on the Shapes toolbar. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Push Button.

-Or-

 l If you have the Toolbox   enabled, click the button on the Toolbox.

Adding Variable Objects 

By clicking the Variable object button, you can assign a variable object   to your picture or globally to the 
entire system. The variable can represent   different values at different times. The variables you assign 
include   the following:

 l Boolean 

 l Byte 

 l Short 

 l Long 

 l Float 

 l Double 

 l String 

In Classic view, to create a Variable object, click the Variable object   button on the Shapes toolbar. In 
Ribbon view, from the Insert tab, in   the Objects/Links group, in the Objects/Links list, click Variable. If   
the Toolbox is enabled, click the button on the Toolbox. Next, complete   the fields on the Create a Vari-
able Object dialog box. To name a variable   object, enter the name in the Variable Name field. The name 
must be consistent   with VBA conventions. For more information on the various fields, click   the Help but-
ton.

Adding OLE Objects 

iFIX lets you insert a variety of OLE objects into your pictures. In   Classic iew, to insert an OLE object, 
click the OLE Object button on the   Shapes toolbar. In Ribbon view, you may also add an OLE object 
from the   Insert tab, in the Objects/Links group, in the Objects/Links list, by   clicking OLE Object. If you 
have the Toolbox enabled, click the button   on the Toolbox.

You have three choices on the Insert dialog box for inserting an OLE   object: Create New, Create from 
File, and Create Control.

Creating New OLE Objects 

The Create New option button allows you to select from a list of objects   registered on the local node. To 
add a specific object, double-click it   from the Object Type list box. For more information on adding 
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controls,   refer to the Create a Control for an OLE Object section that follows.
Creating an OLE Object from a File 

The Create from File option button lets you insert the contents of a   file into a new object in your picture. 
You can either select a file from   the File field or click the Browse button to select a file from any available   
directory.
Creating a Control for an OLE Object 

The Create Control option button allows you to add an ActiveX Control   (OCX) to a new object in your pic-
ture. Click Add Control to display a   browse dialog where you can select an OCX installed on the local 
node.   When you select the file, a new object is inserted into your picture with   the specified control. 
When you switch to the run-time environment, you   activate the object with the control you selected. 

If the "Application Data Control" appears in the list of OLE   objects you can insert into a picture, be aware 
that you cannot use this   control in a picture. This control is actually a control panel applet   and is not 
insertable. Do not use this control.
Adding a Third-Party Control 

When adding third-party controls to a iFIX picture, some controls may   display a message similar to the 
following:

<OCX name>: License file for custom control not found...

The reason you get this message is because you are adding a control   that you do not have the license 
for. We recommend that you delete the   control from your picture or install the license for this control and   
re-insert the control.
Animating the String Property of an OLE Control

To animate the String property of an OLE Control, you must ensure that   the data source is of a string 
type by doing one of the following:

 l Connecting directly   to an A_field. 

 l Using a Format object   to convert a F_field to a string format. 

List Box Example

To add a Microsoft list box to an iFIX picture in configure mode, use   the OLE Object named Microsoft 
Forms 2.0 ListBox. The steps below describe   how to do this.
 To add a list box object to your   iFIX picture: 

 1. In Classic view,   from the iFIX WorkSpace, on the Insert menu, click OLE Object. 

-Or-

In Ribbon View, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
OLE Object. 

 2. In the Object Type   list, select the Microsoft Forms 2.0 ListBox.

 3. Click OK.

Combo Box Example

To add a Microsoft combo box to an iFIX picture in configure mode, use   the OLE Object named 
Microsoft Forms 2.0 ComboBox. The steps below describe   how to do this.
 To add a combo box object to your   iFIX picture: 

 1. In Classic view,   from the iFIX WorkSpace, on the Insert menu, click OLE Object. 
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-Or-

In Ribbon View, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
OLE Object. 

 2. In the Object Type   list, select the Microsoft Forms 2.0 ComboBox.

 3. Click OK.

 

Adding a Plant Applications Dynamo

You can add a Plant Applications Dynamo to your pictures. The   Dynamos simplify the process of estab-
lishing a connection between the   Plant Application Server and the Client as well creating a display   of the 
desired information, which is determined by the Dynamo selected.

To insert a Plant Applications Dynamo into a picture, first, locate   the Dynamo Sets folder, which is in the 
iFIX WorkSpace, under the System   Tree. Expand the Dynamo Sets folder to display the Dynamo sets. 
The Plant   Applications Dynamos are in the Dynamos folder. Double-click on the PlantApplications    
Dynamo set. The PlantApplications.fds file displays. From the file, drag   and drop the desired Dynamo 
into your picture. Then, complete the Dynamo   configuration as prompted.

For More Information

Refer to the following table to determine where you can find more information   about the Plant Applic-
ations Dynamos.

Plant Applications Dynamo For more information, in the Plant Applications 
ebook,   refer to the chapter:

DynamoPAALC Autolog Display
DynamoPAALM Alarm View Display
DynamoPADTN Downtime Displays
DynamoPADTP Downtime Displays
DynamoPAGVW Genealogy View Display
DynamoPANPT NonProductive Time View
DynamoPAOVW Production Overview Display
DynamoPASOE Sequence of Events Display
DynamoPASVW Schedule View Display
DynamoPAWASTE Waste Displays
DynamoPAWP Waste Displays

 

Adding Timer Objects 

By adding timer objects to your picture, you can perform an action based   on a time interval that you spe-
cify.
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Adding Event Objects 

Event objects allow you to perform an operation based on an action that   you specify. After you add an 
event object, you must enter Visual Basic   code to actually trigger the event.

Performing Basic Functions with Objects 

The iFIX configuration environment provides many basic functions that   you should be familiar with as 
you develop objects. Once you learn how   to perform a basic function on one object, you can perform that 
function   for all objects. These functions include:

 l Using   shortcut keys

 l Selecting   objects

 l Moving   objects

 l Editing   objects

 l Renaming   objects

 l Changing   Object Names in Scripts

 

Using Shortcut Keys 

By pressing a sequence of keys (referred to as shortcut keys), you can perform specific drawing oper-
ations that help you quickly accomplish a task. The following table shows you what shortcut keys are 
available and their function.     

Press these keys 
together...

To do the following...

<Alt> and <arrow 
key>

Move from one object handle to another around an object.

<Ctrl> and <arrow 
key>

Reshape an object by moving a point at an object handle.

+ or - from numeric 
pad

Rotate an object.

<Ctrl> and mouse 
click

Copy an object.

<Shift> and any of 
the above

Accelerate the operation. For example: <Shift> plus <Ctrl> and an arrow 
key quickly reshapes an object.

Shortcut Keys for Pictures    

Specific uses of shortcut keys are included throughout this chapter.

Selecting Objects 
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You can select an object by clicking it with the mouse. Objects can   be selected in the picture itself or in 
the system tree. The selected   object remains selected until you click another object. When you select   
an object, the object's handles appear, permitting you to change the object's   size. For more information 
on object handles, refer to the Using   Basic Drawing Tools section.
Selecting Multiple Objects 

You can select multiple objects by enclosing two or more objects in   a rectangle selector, or by selecting 
the first object and then control-clicking   additional objects. The following figure shows both methods.
   

Moving Objects 

You can move any object in a picture by clicking and dragging it to   its new location. To move an object 
quickly, hold down the Shift key and   click and drag the object. 
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Nudging 

Sometimes you need to move an object more precisely to better control   its placement in the picture. iFIX 
lets you move an object in small increments   using the arrow keys. This concept is called nudging.   

To nudge an object, select it and press an arrow key. The object moves   one pixel in the direction indic-
ated by the arrow key. By repeatedly pressing   the arrow keys, you can slowly move the object to any 
desired location.   To accelerate the movements, press Shift and an arrow key simultaneously.

Editing Objects 

Naturally, you will occasionally make errors when you draw your pictures.   Or, conversely, you may cre-
ate something that you want to apply everywhere   in your picture In either case, iFIX's editing func-
tionality lets you   quickly update how objects look in your picture.

A simple way to edit objects is to use the Edit Toolbar: 

Click this but-
ton...

Which can also be accessed in Ribbon 
view...

To...

From the Home tab, in the Clipboard group, 
click Cut.

Cut an object.

From the Home tab, in the Clipboard group, 
click Copy.

Copy an object.

From the Home tab, in the Clipboard group, 
click Paste.

Paste an object.

From the Home tab, in the Editing group, click 
Undo.

Undo an actions performed on an 
object.

By default, the buttons in the above table appear in the Toolbox when   you create or open a picture. If you 
have the Toolbox enabled, simply   click the button on the Toolbox that corresponds to the editing function   
you want. These functions, as well as the other available editing functions,   are detailed in the following 
sections.

Cutting Objects 

When you cut an object, you remove the object from the picture and place   it into the Clipboard. Once an 
object is in the Clipboard, it can be retrieved   by pasting it back into the picture.

To cut an object, in Classic view, click the Cut button on the Edit   toolbar. In Ribbon view, on the Home 
tab, in the Clipboard group, click   Cut. If the Toolbox is enabled, click the button on the Toolbox.

Deleting Objects 

Unlike cutting an object, deleting an object permanently removes it   from the picture, unless you undo the 
operation. To delete an object,   select the object and press Delete. Or, select Delete from the object's   
pop-up menu. 

Copying and Pasting Objects 

iFIX lets you copy objects in two ways: by placing a duplicate copy   of the object into the clipboard for 
pasting into your picture, or by   duplicating the object. To copy   an object, use one of the following meth-
ods:
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 l Select Copy from   the object's pop-up menu.

 l Select the object   and click the Copy button on the Edit toolbar (Classic view).

 l Select Copy from   the Clipboard group on the Home tab (Ribbon view). 

To paste the object use one of the following methods:

 l Select Paste from   the picture pop-up menu.

 l Click the button   on the Toolbox, if the Toolbox is enabled.

 l Click Paste on the   Edit toolbar (Classic view).

 l Click Paste from   the Clipboard group on the Home tab (Ribbon view).

Duplicating an object is the easier method of copying and pasting, as   it combines the copy-and-paste 
action into one step by avoiding copying   the object to the clipboard. To duplicate an object, select the 
object   you want to copy and select:

 l Duplicate from the   object's pop-up menu, or 

 l Duplicate from the   Editing group on the Home tab (Ribbon view).

A second object with identical properties of the original appears slightly   offset from the original. In the fol-
lowing figure, the oval to the lower   right is a duplicate   of the original.

Duplicating an Object

You can copy any iFIX object using the copy or duplicate methods, including   bitmaps and OCXs.
Undoing Actions 

iFIX has a number of actions that cannot be undone. If a particular   task cannot be undone, the Undo 
command in the Edit menu is unavailable   after you complete the action. For example, if you try to undo 
moving   a chart, the command is unavailable. Typically, actions involving Standard   Charts and Historical 
Data Links cannot be undone.

Undoing Repeated Positioning and Sizing Operations with a Single Undo Command

This feature allows you to revert back repeated positioning and sizing operations in single Undo com-
mand. It works only for repeated left/right/up/down arrow keys that do the same operation.

When enabled, only one undo operation is registered for repeated arrow key operations. Since this beha-
vior is not required by all users, it is disabled by default to allow users to choose when they want to activ-
ate it. 
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To activate this feature, in the FixUserPreferences.ini file, in the [PicturePreferences] section, set the 
"SingleUndoOperationForRepeatedArrowKey" parameter to 1. The FixUserPreferences.ini file is found 
in the iFIX\Local folder. If this parameter is not already listed, you can add it to the bottom of the [Pic-
turePreferences] section of this file. 

For example, here is the setting enabled:

[PicturePreferences]
Width=100.000000
Height=75.000000
BackgroundColor=16777215
...
SingleUndoOperationForRepeatedArrowKey=1

To disable this behavior, set "SingleUndoOperationForRepeatedArrowKey" to 0. For example:

SingleUndoOperationForRepeatedArrowKey=0

IMPORTANT: The iFIX WorkSpace must be restarted for any changes to the "SingleUn-
doOperationForRepeatedArrowKey" parameter to take effect.

 

Renaming Objects 

When you add an object to your picture, iFIX automatically names the   object in the system tree and num-
bers it in the order it was created.   For example, the second rectangle added to your picture would be 
titled   Rect2 in the Pictures directory. To more easily recognize your objects,   or to assign a specific 
name that represents a common property in your   process, you can give it an alternate name.

To rename an object, right-click the object name in the system tree   and select Property Window from the 
pop-up menu. Place the cursor in the   second column of the Name row and enter a name. You can also 
select Animations   from the pop-up menu and rename the object from the Animations dialog   box.

IMPORTANT: When you   rename an object, avoid the use of underscores in the name. Underscores   my cause 
problems with scripts associated with the object. For more information,   refer to the VBA Naming  Conventions   
section of the Writing Scripts   manual.

Changing Object Names in Scripts 

If you change the name of an object in a script, and then change the   name back to its original, you may 
also change the edit event that is   called from that script. iFIX attempts not to use an older name that is   
already used in a code or global module, but may not always be able to   determine which names are 
valid.

Renaming Objects with Associated Script

By default, if you change the name of an object that has script associated   with it, iFIX automatically 
renames the event name and the references   to the object within the script for that object. Therefore, you 
do not   have to explicitly do anything in your scripts to make these objects work.

However, if you are indirectly referencing any object names in a script   from another object (for example, 
setting Rect1.HorizontalPositional from   the click event on Oval1), this reference is not renamed.
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 To rename these references: 

 1. In the WorkSpace,   perform a Find and Replace to rename all objects. We do not recommend   that 
you use the Include Scripts option in the Find and Replace feature   from the Workspace to per-
form this function. Doing so will replace objects   that we are automatically renaming. 

 2. In the Visual Basic   Editor, perform a Find and Replace to change any specific object references.   

NOTE: Renaming objects   in the Property Window can greatly affect how your scripts run using VBA.   For more 
information, refer to the  Writing Scripts manual.

Performing Advanced Functions with Objects 

Creating and manipulating objects in iFIX may often require more than   cutting and pasting or moving 
static objects around the screen. Although   these are necessary functions, there are many advanced 
functions that   you can perform when developing or modifying your pictures or working   with specific 
objects. These functions include:

 l Manipulating   objects using toolbars

 l Resizing   objects

 l Rotating   objects

 l Manipulating   objects with points

 l Reshaping   objects

 l Coloring   and styling objects

 l Aligning   objects

 l Flipping   objects

 l Splitting   Polylines and Pipes

 l Extending   Lines to Intersect

 l Trimming   Line at the Intersection

 l Converting   Lines to Polyline

 l Making   Lines Horizontal or Vertical

 l Converting   Lines and Polylines to Pipe

 l Modifying   Pipe Characteristics

 l Adding   and Deleting Connection Points

 l Using   the Connector Tools

Manipulating Objects Using Toolbars 

Using the Tools Toolbar

Many of the advanced functions described in this section can be performed   using the Tools toolbar. The 
following table shows you which functions   are available and how they are used.
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NOTE: Although   hidden by default, you can access and use toolbars in Ribbon view. To   access the Tools tool-
bar in Ribbon view, on the Home tab, in the WorkSpace   group, click Settings, and then click Toolbars. You 
can also open a toolbar   from the WorkSpace tree, by opening the Project Toolbar Files folder and   double-
clicking the toolbar you want to open.

Click this 
button...

Which can also be accessed in the Ribbon view... To...

From the Format tab, in the Arrange group, click Align,   
and then click Align Left.

Align objects to the left 
edge.

From the Format tab, in the Arrange group, click Align,   
and then click Align Horizontal Center.

Align objects to each 
other's horizontal cen-
ter.

From the Format tab, in the Arrange group, click Align,   
and then click Align Right.

Align objects to the right 
edge.

From the Format tab, in the Arrange group, click Align,   
and then click Align Top.

Align objects to the top 
edge.

From the Format tab, in the Arrange group, click Align,   
and then click Align Vertical Center.

Align objects to each 
other's vertical center.

From the Format tab, in the Arrange group, click Align,   
and then click Align Bottom.

Align objects to the bot-
tom edge.

From the Format tab in the Arrange group, click Group   
Objects.

Group objects.

From the Format tab in the Arrange group, click 
Ungroup   Objects.

Ungroup objects.

From the Format tab in the Arrange group, click Bring   
to Front.

Bring an object in front 
of another.

From the Format tab in the Arrange group, click Send   
to Back.

Send an object to the 
back of another.

From the Format tab, in the Arrange group, click Space   
Evenly, and then click Space Evenly Vertical.

Vertically space objects 
evenly.

From the Format tab, in the Arrange group, click Space   
Evenly, and then click Space Evenly Horizontal.

Horizontally space 
objects evenly.

From the Format tab, in the Styles group, click Color. Apply color to an object 
or objects.

From the Format tab, in the Font group, click Font. Apply a font to a text 
object or objects.

From the Format tab, in the Arrange group, click Grid,   
and then click Toggle Grid.

Turn picture grid on and 
off.

From the Format tab, in the Picture group, click Layers,   
and then click Set Layer.

Select layers for 
objects.

From the Format tab, in the Picture group, click Layers,   
and then click Display Layer.

Display layers for selec-
ted objects.

From the Tools tab, in the Tasks/Experts group, click 
Picture,   and then click Refresh Rate Expert.

Display the Refresh 
Rate Expert.

Manipulating Objects in Pictures   Using the Tools Toolbar  
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By default, all of the buttons in the above table appear in the Toolbox.   If you have the Toolbox enabled, 
click the button on the Toolbox.

Using the CAD Toolbar

The iFIX configuration environment provides a CAD (computer assisted   drawing) toolbar with functions 
for manipulating line and polyline objects.   The following table shows you which functions are available 
and how they   are used.

Table Caption Outside Table: Manipulating Objects in Pictures Using the CAD   
Toolbar  

Click this but-
ton...

Which can also be accessed in 
the Ribbon view...

To...

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Extend Lines.

Extend a selected line to intersect 
with another selected   line. Refer to 
Extending   Lines for more inform-
ation.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Trim Lines.

Trim the selected lines to the inter-
section point.   Refer to Trimming   
Lines for more information.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Convert Lines to Polyline.

Convert the selected lines to a poly-
line object. Refer   to Converting 
Lines to   Polyline for more inform-
ation.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Make Lines Horizontal.

Change the selected line(s) to hori-
zontal. Refer to   Making Lines Hori-
zontal   or Vertical for more 
information.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Make Lines Vertical.

Change the selected line(s) to ver-
tical. Refer to   Making Lines Hori-
zontal   or Vertical for more 
information.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Convert Line/Polyline to 
Pipe.

Convert the selected line(s) or poly-
line(s) to a pipe   object. Refer to 
Converting   Lines and Polylines to 
Pipe for more information.

From the Format tab, in the Styles 
group, click Pipe   Styles, and then 
click Modify Pipe Characteristics.

Open the Modify Pipe Char-
acteristics dialog box for   the selec-
ted pipes. Refer to Modifying   Pipe 
Characteristics for more inform-
ation.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 
then click Add Connection Point.

Add a connection point to anchor 
the selected connector   to a shape. 
Refer to Adding   and Deleting Con-
nection Points for more inform-
ation.

From the Format tab, in the Picture 
group, click Drawing   Tools, and 

Delete a connection point anchor 
from the selected   connector. Refer 

120 © 2024 General Electric Company. All rights reserved.



then click Delete Connection Point. to Adding   and Deleting Connection 
Points for more information.

From the Format tab, in the Insert 
group, click Connectors,   and then 
click Line Connector.

Draw a connecting line between 
two shapes. Refer to   Using the 
Connector Tools   for more inform-
ation.

From the Format tab, in the Insert 
group, click Connectors,   and then 
click Right Angle Line Connector.

Draw a right angle connecting line 
between two shapes.   Refer to 
Using the Connector   Tools for 
more information.

From the Format tab, in the Insert 
group, click Connectors,   and then 
click Pipe Connector.

Draw a connecting pipe between 
two shapes. Refer to   Using the 
Connector Tools   for more inform-
ation.

Using the Translation Toolbar

The iFIX configuration environment provides a translation toolbar with   functions for exporting and import-
ing language files. The following table   shows you which functions are available and how they are used.

Table Caption Outside Table: Exporting and Importing Language Files using the   
Translation Toolbar  

Click this button... To...
Export the language file for the active picture. 

Export separate language files for one or more pictures.

Import the translated language file for the active   picture.

NOTE: Translation   functions are not available from the Ribbon in Ribbon view. To access   these functions, 
you must display the Translation Toolbar. To access this   toolbar in Ribbon view, on the Home tab, in the 
WorkSpace group, click   Settings, and then click Toolbars. You can also open a toolbar from the   WorkSpace 
tree, by opening the Project Toolbar Files folder and double-clicking   the toolbar you want to open.

 
 

Resizing Objects 

Objects other than lines, arcs, chords, and pies are automatically added   with resize handles, and the 
default operation available through their   pop-up menu is Resize. Any object can be resized, including 
those with   points. However, for lines, arcs, chords, and pies, you must select Resize   from the pop-up 
menu; it is not selected automatically.  When   you resize an object, the object changes shape uniformly, 
without changing   its shape.

NOTE: Ovals,   rounded rectangles, charts, and bitmaps do not have the Resize option   in the pop-up menu, but 
do have resize handles, allowing you to resize   these objects.

To resize an object, simply select the object and click and drag one   of its handles.

Rotating Objects 
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Objects naturally rotate around a center of rotation, designated by   a dot enclosed with a circle. When 
you select Rotate from an object's   pop-up menu, the object displays its center of rotation, and rotation   
handles showing the direction you can rotate the object. See the following   figure. 

Rotation Handles

To rotate an object around its center of rotation, click and drag one   of the object's rotation handles. You 
can also rotate an object using   the Rotate Expert, which allows you to specify minimum and maximum 
angles   of rotation. To use the Expert, click the Rotate Expert from the Expert   toolbar (Classic view) or 
on the Tools tab, in the Animations group, click   Rotate (Ribbon view) or the Toolbox, if enabled. For help 
on the fields   of the Expert, click the Help button.

iFIX also lets you rotate objects based on a selected center of rotation.   To change the center of rotation, 
click and drag the default center of   rotation to the desired location in the picture. When you place the 
cursor   over the center of rotation, the cursor becomes a crosshair. Now when   you click and drag one of 
the object's handles, the object rotates around   the new center of rotation. This is illustrated in the fol-
lowing figure.

Rotating an Object Around   a New Center of Rotation
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To relocate the object's default center of rotation, click the current   center of rotation. The cursor 
becomes a crosshair, and another crosshair   appears at the object's center. Move the center of rotation 
over the crosshair   inside the object. 

You can rotate any object except ovals, rounded rectangles, and charts.

NOTE: You can resize   or rotate an object by animating it. For more information on animating   an object, refer 
to the Animating   Object Properties chapter.

Manipulating Objects with Points 

Some objects work a little differently than shapes such as rectangles and ovals, because they consist of 
a series of connected points. Objects with points include polygons, polylines, lines, arcs, chords, and 
pie shapes. The following figure illustrates the various types of objects with points. 

Objects with Points

Reshaping Objects 

When you create an object that consists of points, the object is added   to your picture with   reshape 
handles, and the default operation available through the   pop-up menu is Reshape. The following figure 
illustrates an object with   reshape handles. For polygons and polylines, objects are added with resize   
handles, because you do not need reshape handles in order to reshape these   objects. You can move the 
points in the object to reshape the object at   15-degree increments.
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Reshape Cursors

For lines, arcs, chords, and pies, you can reshape the object by clicking   and dragging a reshape cursor 
on the object. 
Adding and Deleting Points in Polygons and Polylines 

To reshape polygons and polylines, you add points to or delete points   from the shape. When you add a 
point, the cursor changes to a circle with   a plus sign inside. If the cursor is black, you can add a point to 
the   polygon or polyline. If the cursor is white, you cannot, because the cursor   is not close enough to the 
object's edge. Move the cursor closer until   it turns black or becomes partially black, as the following fig-
ure shows.

Adding and deleting points can be performed using a circular cursor.   A plus sign inside the circle indic-
ates that you are adding a point; a   minus sign in the circle indicates that you are deleting a point.

Adding a Point

After you add a point, all the points in the object are displayed as   small plus signs. You can click any of 
these plus signs and drag the mouse   to adjust the size or position of the point it represents. This, in turn,   
changes the overall shape of the object.

Deleting a point is similar to adding a point, except the cursor changes   to a circle with a minus sign 
inside. A black cursor means you can delete   a point; a white cursor means you cannot. When the cursor 
is white, move   it over the point you want to delete until it turns black. You can then   delete that point. See 
the following figure.
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Deleting a Point

Coloring and Styling Objects 

Depending on the object you are working with, you can apply one or more   of the following color and style 
properties to that object:

 l Fade color

 l Foreground color   

 l Background color   

 l Background style   

 l Edge color 

 l Edge style 

 l Edge width 

 l Fill style 

The relationship of these properties is depicted in the following figure.
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Object Color and Style   Properties

The following table shows the color and style properties that can be changed for each object that you 
can add to a picture.   

Object Foreground 
Color

Background 
Color

Background 
Style

Edge 
Color

Edge 
Style

Edge 
Width

Fill 
Style

Fade 
Type

Current 
Time

* * * * * * * *

Current 
Date

* * * * * * * *

Rectangle * * * * * * * *
Rounded 
Rectangle

* * * * * * * *

Oval * * * * * * * *
Chord * * * * * * * *
Polygon * * * * * * * *
Pie * * * * * * * *
Pipe * * * * * * *  

Color and Style Properties    
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Arc    * * *   
Line    * * *   
Polyline    * * *   
Text * * * * * * *  
Push But-
ton

        

OLE Object * * * * * * *  
Data Link * * * * * * * *
Alarm Sum-
mary

        

Variable 
Object

        

Timer 
Object

        

Event 
Object

        

Charts * *  * *   *
Bitmaps    * *    

NOTE: If you apply   an edge style other than solid, and then change the edge width to a value   greater than 1, 
the edge style will not appear as defined in the Properties   Window. This is because Microsoft Windows does 
not permit edge styles   to be applied to edge widths greater than 1. Therefore, make sure your   edge widths 
are no greater than 1 for lines that are not solid.
Selecting Object Color and Style Properties 

To select or change object properties for a shape, select the shape   and do one of the following:

 l Select a property   from the object's pop-up menu. 

 l Select the object   and then select the property from the Object menu. 

 l Select a property   from the Shape Preferences dialog box. 

 l Change a property   value in the Properties Window. 

 l Animate the object.   

To set a property using the object pop-up menu, right-click the object   in the picture (or by clicking the 
name in the system tree) and select   the property from the pop-up menu. For more information on the pop-
up   menu and the options you have for each property, refer to the Using   the Object Pop-up Menu section.

Depending on the object you are working with, specific property options   are also available under the 
Object menu. To access these properties,   select the object, and then select the appropriate property 
from the Object   menu. When you do not have an object selected, the Object menu is disabled.

The following table lists the properties that are available from the   Shape Preferences tabbed page on the 
User Preferences dialog box. This   dialog box displays the default property value for new objects, unless   
that value is changed by any of the means outlined in this section. 

Preference Function Options
Color Applies color properties to objects.  l Fade Color

Shape Preferences  
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 l Foreground

 l Background

 l Edge

For more information on 
selecting colors, refer to   
the Working with Color sec-
tion.

Font Applies a font to text.  l Name

 l Size

 l Style

For more information on 
selecting colors, refer to   
the Adding Text section.

Edge Style Applies an edge style to lines in objects.  l Solid 

 l Dash 

 l DashDot 

 l DashDotDot

 l Dot 

 l Null

 l Inside Frame
Edge Width Applies an edge width to lines in objects. Any width, entered in 

pixels. 

NOTE: Edge widths   do not 
autoscale.

Fill Style Applies a fill style to shapes.  l CrossHatch

 l Diagonal 
CrossHatch

 l Downward Diag-
onal

 l Gradient

 l Hollow

 l Horizontal

 l Solid

 l Upward Diagonal

 l Vertical
Hit Test 
Size

With Click and Stick enabled, determines the min-
imum   distance the cursor can be from a shape 
before the shape can be selected   (known as a hit   
test).

Any logical units.
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Background 
Style

Applies a background style to objects.  l Opaque

 l Transparent
Blend Per-
cent

Applies a percentage of blending between the fore-
ground   color and the fade color.

Any number from 0 through 
100.

Fade Type Applies a fade type to shapes.  l Concentric

 l Linear

 l Reflected

 l Radial
Thickness Applies a thickness to pipe objects. Any thickness from 10 

through 300 pixels.
Elbow Style Applies an elbow style to pipe objects.  l Round

 l Square
Start Cap Applies a cap style to the beginning of pipe 

objects.
 l Round

 l Square

 l Horizontal Diagonal

 l Vertical Diagonal
End Cap Applies a cap style to the end of pipe objects.  l Round

 l Square

 l Horizontal Diagonal

 l Vertical Diagonal
Remove 
Leading and 
Trailing 
Spaces

Removes extra spaces when Data links are dis-
played   in the run-time environment.

 l Selected (default)

 l Cleared

For more information on selecting properties using the Properties Window,   refer to the Controlling   Object 
Properties chapter. You can also dynamically change the color,   fill, and edge styles of an object by anim-
ating it. For more information   on animations, refer to the Animating   Object Properties chapter.

Aligning Objects 

To help create and maintain attractive pictures, you can align objects   to a grid or in relation to each other. 
The following sections show you   how to align objects in your pictures.

Aligning Objects to the Grid 

Each picture maintains an invisible grid that you can use to align objects   precisely as you create them. 
By enabling the Snap to Grid function, you   can align objects with minimal effort, as objects stick (or 
snap) to the   nearest grid point. When this function is disabled, you can align objects   visually by dis-
playing the grid and moving objects with the mouse, or   by selecting the object you want to snap to a grid 
point and in Classic   View, selecting Snap Objects to Grid from the Format menu. In Ribbon view,   select 
the object, and on the Format tab in the Arrange group, in the   Grid List, click Snap Objects to Grid.
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When you display the grid, an evenly-spaced array of dots appear in   the background of the picture. 
These dots represent the intersection of   the grid lines, measured in pixels.

The Grid Settings dialog box lets you quickly set your options for using   a grid. You can elect to show the 
grid, enable the Snap to Grid function,   and define the grid's spacing using this dialog box. In Classic 
view,   you can also select Snap to Grid from the Format menu, without using the   Grid Settings dialog 
box. In Ribbon view, you can enable the Snap to Grid   function from the Format tab, in the Arrange group, 
on the Grid list,   by clicking Snap to Grid. If enabled, the Snap to Grid function works   whether or not you 
display the grid. To disable Snap to Grid, deselect   the Snap to Grid check box on the Grid Settings dialog 
box. 

If enabled, the Snap to Grid function works whether or not you display   the grid. To disable Snap to Grid, 
deselect the Snap to Grid check box   on the Grid Settings dialog box.

Default settings for Grid Enable and Snap to Grid can be entered in   the Picture Preferences tabbed page 
of the User Preferences dialog box.

NOTE: Snap to Grid   does not work by nudging objects. You must use the mouse.

The following illustration shows an object moved with the grid displayed   and Snap to Grid enabled. The 
box to the lower left shows the outline   of the object as it is being moved to that position. Notice that the 
object   sticks to the grid points.

Aligning Objects to the   Grid
Aligning Objects to Each Other 

IMPORTANT: You can   also align two or more objects in relation to each other using the Align   buttons on the 
Tools toolbar or the Toolbox, if enabled. When using these   buttons, you can vertically align the top, bottom, or 
center of the objects   and horizontally align the left, right, or center of the objects, as the   following figure 
shows. In Ribbon view, you can also align objects using   options from the Align list, in the Arrange group in the 
Format tab.
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Original 
Picture

Hori-
zontal 
Align-
ment

Vertical 
Align-
ment

Aligning Objects in Relation   to Each Other
Spacing Objects in a Vertical or Horizontal Line 

Another way you can align objects is to space them. In Classic view,   you can space two or more objects 
vertically or horizontally with the   Space Evenly Vertical and Space Evenly Horizontal buttons on the 
Tools   toolbar. In Ribbon view, you may access these options on the Format tab,   in the Arrange group, in 
the Space list. Both methods create an equal   amount of spacing between each object; the difference is 
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that vertical   spacing creates rows, and horizontal spacing creates columns. Both types   of alignment are 
illustrated in the following figure.

Vertical Spacing

Horizontal Spacing
Positioning and Scaling Objects 

Another way to align objects in your picture is to position   them. Positioning places the object where you 
want it, based on either   relative or absolute alignment and the horizontal or vertical axis. In   Classic view, 
you can position your objects using the Position Expert   located on the Experts toolbar,  or   in Ribbon 
view from the Tools tab, in the Animations group, click Animations.   If the Toolbox is enabled, click the 
button on the Toolbox. For help on   the Expert fields, click the Help button on the Expert.

Alternately, you can scale   an object. Scaling actually changes the dimensions of the object's height   or 
width, as you specify. To scale an object, use the Scale Expert located   on the Experts toolbar or the 
Toolbox, if enabled, or in Ribbon view from   the Tools tab, in the Animations group, click Animations. For 
help on   the Expert fields, click the Help button on the Expert.

Flipping Objects 
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One simple way to change the way your objects appear in relation to   each other is to flip them. When 
you flip an object, the object reflects   along its vertical or horizontal axis and reappears as a mirror image   
of the original. 

There are two ways to flip an object. You can flip an object simply   by dragging a handle of an object from 
one side to its opposite side.   The drawback to this approach is that it also stretches the object. The   fol-
lowing figure shows a manually-flipped object that was accidentally   reshaped. 

Flipping Objects Manually

A more effective way to flip an object is to use the Flip Horizontal   and Flip Vertical method. This method 
flips the object while maintaining   its original size and shape. The following figure illustrates this effect.

Flipping Objects Effectively

Splitting Polylines and Pipes

After you have created a polyline or pipe, you may decide that it is   not exactly the shape you want. Or, 
you may want to insert another shape   so that the polyline (or pipe) flows into and out of the new shape; 
for   example, a pipe flowing in one end of a tank and out the other end.
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You can split a polyline or pipe into two or more objects. The following   sections show you how it's done.

Split Polyline

Figure 1 shows the selected polyline with reshape handles. In Figure   2, the arrow points to the  split-
ting cursor, which turns   black when it is close to the polyline. 

Figure 3 shows that the polylines still appear joined, however the reshape   handles now surround only the 
polyline on the left. Figure 4 shows the   polylines separated. You can now move the individual polylines 
around   the picture or choose to delete one of them.
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Split Pipe

Figure 1 shows the selected pipe with reshape handles. In Figure 2 the   arrow points to the  splitting 
cursor, which changes to   a contrasting color when the cursor is inside the pipe. 

In Figure 3, the arrow points to the split you created in the original   pipe object. Note that the reshape 
handles now surround only the pipe   on the left. Figure 4 shows the pipes separated. You can now move 
the   individual pipes around the picture or choose to delete one of them.

NOTE: When you   split a polyline or pipe, you create a new object. Therefore, if you undo   a polyline or pipe 
split, the new object is deleted first and you must   perform a second undo action to revert to the original object. 

 

Extending Lines to Intersect

Joining two or more lines can be tedious and time-consuming if it is   done manually and if there are 
many lines in your picture that need to   be joined. Using the Extend Lines button on the CAD Toolbar 
(Classic view)   or Extend Lines, in the Drawing Tools list, in the Picture group, on the   Format tab 
(Ribbon view), you can easily extend single or multiple lines   to an intersection point. 

NOTE: You can   intersect lines in configuration mode only.
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There are two types of intersection points:

          

 on-line                               off-line

Intersecting Lines to a Single Intersection Point

Each intersection of lines can involve only two lines whether the intersection   point is on-line or off-line. If 
you select more than two lines, then   more than one intersection point is involved and a separate oper-
ation   for each intersection is required. For more information about intersecting   multiple lines to multiple 
intersection points, see Intersecting   Lines to Multiple Intersection Points.

Example 1: On-line intersection point

The following diagrams show an example of extending and intersecting   a single line (line 1) with the inter-
section point located on another   line (line 2). This is an example of an on-line intersection point.

Example 2: Off-line intersection points

The following diagrams show examples of extending and intersecting two   lines (lines 1 and 2) with an 
intersection point that is not located on   either source line (off-line). When the intersection point of two 
lines   is found at a point off the two source lines, both lines are extended   to the intersection point.
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IMPORTANT:   Lines may appear to be perfectly vertical or horizontal, but if they are   even slightly off, they will 
extend well beyond the boundaries of your   computer screen. In the following diagram, the "horizontal"   lines 
were extended to the intersection points on the vertical line, but   also extend to the right, past the edge of the 
viewing area on the computer   screen.

For this reason, it is best to use the Make lines   horizontal and/or Make lines vertical buttons on the CAD Tool-
bar (Classic   View) or from the Format tab, in the Picture group, in the Drawing Tools   list (Ribbon view) before 
extending lines to the intersection points.   For more information, see Making   Lines Horizontal or Vertical.

Intersecting Lines to Multiple Intersection Points

In cases where there is more than one potential   intersection point, the closest intersection point is 
always used. However,   an on-line intersection point always takes precedence over an off-line   inter-
section point, regardless of it's proximity to the intersecting lines,   and the number of lines and inter-
section points. The following diagrams   show examples of these rules.

Example 1: No on-line intersection point

In the first example, the blue circle indicates   the closest of the two intersection points, and because 
there is no on-line   intersection point, only lines 2 and 3 are extended to the closest intersection   point. 
Line 1 does not intersect with line 3.
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Example 2: On-line and off-line intersection points

In this example, the blue circle indicates the on-line intersection   point, and because on-line intersection 
points take precedence over off-line   intersection points, line 3 is extended to the on-line point on line 1.   
Line 2 does not intersect with line 3.

Example 3: On-line and off-line intersection points

The following diagrams provide examples of   extending multiple lines.

In the following example, lines 1 and 5 connect   with the off-line intersection point (in the upper left 
corner), because   there is no on-line point to take precedence. Line 4 goes through the   off-line inter-
section points to connect with the on-line point on line   1 and lines 2 and 3 go through the off-line points to 
connect with the   on-line intersection points on line 5.
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In the next example, lines 1 and 6 connect   with the off-line intersection point (in the upper left corner), 
because   there is no on-line point to take precedence. Lines 2, 4, and 5 go through   the off-line points to 
the on-line points on lines 6 and 1. Line 3 connects   only with the first on-line intersection point on line 5.

The final example below, shows line 5 going   through the off-line intersection points (red circles) to the 
on-line   intersection point in the top left corner on line 1. Lines 3 and 4 intersect   at the off-line point on the 
right because there is no on-line intersection   point to take precedence. If you click the Extend Lines but-
ton again,   lines 2 and 3 are extended to line 5 where on-line intersection points   exist.

 

Trimming Lines at the Intersection

After you have intersected lines in your picture, you can trim the intersected   lines to remove unne-
cessary portions. Trimming lines can be tedious and   time-consuming if it is done manually and if 
there are many lines in your   picture that need to be trimmed. Using the Trim Lines button on the 
CAD   Toolbar (Classic view) or Trim Lines in the Drawing Tools list, in the   Picture list, in the Picture 
group, on the Format tab (Ribbon view), you   can easily trim single or multiple lines. The following 
diagrams show   examples of trimmed intersected lines.
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NOTE: Regardless   of the trim option set in the User Preferences dialog box, the shortest   portion of the line 
from the intersection point will always be trimmed   first.

Converting Lines to Polyline

Joining multiple lines to create a polyline can be tedious and time-consuming   if it is done manually. 
Using the Convert Lines to Polyline button on   the CAD Toolbar, (Classic view) or Convert Lines to 
Polyline, in the Drawing   Tools list, in the Picture list, in the Picture group, on the Format tab   (Ribbon 
view), you can easily draw the individual lines required and convert   them to a polyline. You can cre-
ate single or multiple polylines.

Converting lines to a single polyline

The following diagrams show an example of creating a single polyline   from individual lines.
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The lines are drawn, as in Figure 1, and then all are selected. When   you click the Convert Lines to 
Polyline button, it extends the lines (as   shown in Figure 2), and then it trims the lines (as shown in Figure 
3).   For more information, refer to Extending   Lines to Intersect and Trimming   Lines at the Intersection.

Figure 4 shows the points of the polyline. The points of a polyline   are determined when two lines are con-
nected and have the same intersection   point at the start or end point. 

Converting lines to multiple polylines

The following diagrams show an example of creating multiple polylines   from individual lines.

As with converting lines to a single polyline, the selected lines are   first extended to the intersection 
points and then trimmed. In this example,   two polylines have been created. 

Figure 4 shows the points of each polyline; that is, points 1-1 through   1-6 are the points of Polyline 1 and 
points 2-1 through 2-3 are the points   of Polyline 2. The points of a polyline are determined when two lines   
are connected and have the same intersection point at the start or end   point. 
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Making Lines Horizontal or Vertical

 
Drawing straight horizontal or vertical lines can be tedious and time-consuming   if done manually. 
Using the Make Lines Horizontal or Make Lines Vertical   buttons on the CAD Toolbar, (Classic 
view) or Make Lines Horizontal or   Make Lines Vertical, in the Drawing Tools list, in the Picture 
group,   on the Format tab (Ribbon view), you can easily change the position of   your lines. The fol-
lowing diagrams show examples of making lines horizontal   and vertical.

Make Line Horizontal

Make Line Vertical

 

Converting Lines and Polylines to Pipe

Creating pipe objects from lines and polylines is simplified using the   Convert Lines and Polylines to 
Pipe button on the CAD toolbar (Classic   View) or Convert Lines and Polylines to Pipe, in the Draw-
ing Tools list,   in the Picture group, on the Format tab (Ribbon view). Create the required   lines and 
polylines, or select existing lines and polylines, then convert   them to pipes.
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The new pipe object inherits the property values, animation settings,   and VBA scripts from the original 
line/polyline object. The pipe-specific   properties have the default values configured in the User Prefer-
ences   dialog box. You can change the pipe-specific properties using the Modify   Pipe Characteristics dia-
log box.

The following diagrams show examples of converting lines and polylines   to pipes.

                 Single Line                                                       Line Converted   to Pipe

Polyline                                                       Polyline Converted   to Pipe

 

Modifying Pipe Characteristics

You can modify the characteristics of pipe objects by using either the   Modify Pipe Characteristics 
dialog box, or the Select Color dialog box   when you choose Fade from the Color pop-up menu. The 
same pipe properties   are available on both dialog boxes.

To access the Modify Pipe Characteristics dialog box, use one of the   following methods: 
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 l Right-click a pipe   object and choose Modify Pipe Characteristics.

 l Select one or more   pipe objects and click the Modify Pipe button on the CAD Toolbar, if it   is 
enabled (Classic view).

 l Select one or more   pipe objects and on the Format tab, in the Styles group, from the Pipe   Styles 
list, click Modify Pipe Characteristics (Ribbon view).

To access the Select Color dialog box, right-click a pipe object, point   to Color and choose Fade. 
Whichever dialog box you choose to access, you   can define the same characteristics for your pipe 
objects.

NOTE: If you   select multiple pipe objects, you cannot access these dialog boxes with   the right-click pop-up 
menu. You can, however, use the Modify Pipe button   on the CAD Toolbar (Classic view) or Modify Pipe Char-
acteristics in the   Pipe Styles list, in the Styles group on the Format tab (Ribbon view)   to change characteristics 
of multiple pipe objects, as shown in the following   illustration.

In these dialog boxes you can change the appearance of the selected   pipes, including the foreground 
and fade colors, blend percentage, edge   and fill styles, thickness and edge width, the appearance of the 
start   and end caps, and elbow style. If you select more than one pipe, the changes   are applied to all 
pipes. Note that if you select Gradient as the fill   style, the only fade type available for pipe objects is 
reflected.

The following diagrams show different combinations of cap and elbow   styles. 

NOTE: Elbow styles   must be either all round or all square; you cannot mix elbow styles on   a single pipe 
object.
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Round start caps, end caps, and elbows

Square start caps, end caps, and elbows

Horizontal diagonal start cap, Vertical diagonal end cap,   and round elbows

Adding and Deleting Connection Points

 Connection points are used to anchor connectors to shapes in your pictures.

If the Always Show Connection Nodes check box on the User Preferences   dialog box is selected, the 
default connection points and points that   you add to shapes are always visible. If this check box is 
cleared, the   connection points are not visible, but can be displayed using one of the   following methods:

 l Select a connector   and move it towards the shape to anchor it to a certain connection point   on the 
shape.
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- Or -

 l Select the shape   and click either the Add Connection Point button or Delete Connection   Point but-
ton on the CAD Toolbar.

 Adding Connection Points

You can add new connection points to a shape or use the default   connection points to anchor a con-
nector. For more information about   anchoring, refer to Using   the Connector Tools.

The following diagrams show you how to add connection points.

In Figure 1, the red arrow points to the  Add Connection   Point cursor that appears when you are adding 
a connection point. The   black arrow in Figure 2 points to the new connection point. 

NOTE: The shape   you are adding a connection point to must be selected. Reshape handles   appear around 
the shape when it is selected.

Default Connection Points

Most shapes are provided with default connection points and allow you   to add custom connection 
points. The following table lists the different   shapes, the number of default connection points and the 
number of custom   connection points that can be added.

Object Default
Connection
Points

Custom
Connection
Points

Pipes, Lines, Polylines 0 0
Arcs 3 0
Pies, Chords 3 13
Text, Datalink 8 8
Rectangles, Round Rectangles, 
Ovals, Polygons

8 8

Line Connector, Right Angle Line Con-
nector, Pipe Connector

2 0
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NOTE: Pipes,   lines, and polylines display connection nodes only at their end points   and only when a con-
nector object attempts to connect or is connected to   the object. At no other time are connection nodes visible 
for these objects,   regardless of whether the Always Show Connection Nodes check box is selected.

 Deleting Connection Points

You can delete connection points that you add to a shape but you cannot   delete default connection 
points. The following diagrams show you how   to delete a connection point.

In Figure 1, the black arrow points to the custom connection point you   added. The red arrow in Figure 2 
points to the  Delete Connection   Point cursor that appears when you move the cursor over a custom 
connection   point. The gold arrow in Figure 3 points to the  cursor   that appears when you move the 
cursor over a default connection point,   to indicate that the connection point cannot be deleted. 

NOTE: The shape   you are deleting a connection point from must be selected. Reshape handles   appear 
around the shape when it is selected.

 

Using the Connector Tools

 

 

Connectors are used to connect two shape objects together. This is helpful   when you want to move 
your shapes around the picture but keep them connected.   If only one of the connector's ends is 
anchored to a shape object, whenever   that shape is moved, the connector object follows it. If both 
ends of   the connector are anchored to two shapes, it will stretch or shrink itself   when one of the 
shapes is moved or resized.

 Line Connector

The Line Connector tool allows you to draw a straight line to connect   two shapes, as illustrated in the fol-
lowing figure.
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 Right Angle Line Connector

The Right Angle Line Connector tool allows you to draw a right angle   line to connect two shapes, as illus-
trated in the following figure.

 Pipe Connector

The Pipe Connector tool allows you to draw   a pipe connector between two shapes, as illustrated in the 
following figure.   
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Moving Connectors

You can move your connector to any position simply by selecting it and   dragging it to a spot anywhere in 
the picture. However, there will be   times when you want to be more precise about positioning the con-
nector.   There are a number of ways you can do this:

 l Click   and drag a connector handle

 l Hold   down the CTRL key and click   and drag a connector handle

 l Use   the arrow keys

 l Hold   down the SHIFT key and   use the arrow keys

 l Hold   down the CTRL key and use   the arrow keys

 l Hold   down the SHIFT + CTRL key and use the arrow keys

 l Use   the + or - keys to rotate

 l Use   the SHIFT and + or - key   to rotate

Using the SHIFT or CTRL keys, or a combination of   both, while moving, scaling, or rotating your con-
nectors provides you   with an extra level of precision when performing these actions. You can   change 
that level of precision by changing the settings for these actions   by increasing or decreasing the number 
of pixels or degrees your connector   moves, scales, or rotates. For more information about changing 
these settings,   see the Changing the Nudge Settings section in Changing   Picture Settings in the 
FixUserPreferences.ini file.

Click and Drag a Connector Handle

When you click and drag a connector handle, only the selected end of   the connector moves as you drag 
it, and the connector itself is stretched   or shrunk, depending on how you move the connector. When you 
release the   mouse button, the connector handle is placed at that position. However,   if you place the con-
nector handle near a connection point on an object,   the connector handle snaps to that connection point. 
This is very useful   when anchoring a connector. For more information about anchoring, see   Anchoring 
Connectors.
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CTRL + Click and Drag a Connector Handle

When you press the CTRL   key and click and drag a connector handle the connector is moved, stretched,   
or shrunk similar to clicking and dragging; however, when you hold down   the CTRL key and drag the   con-
nector in an arc formation, the connector only moves in 15 degree increments.   That is, as you drag the 
connector handle through a 90 degree arc, there   are only six positions it can be dropped on. As you drag 
it through 180   degrees, there are 12 positions it can be dropped on, and so forth. 

If you drop the connector handle near a connection point on an object   when you are holding down the 
CTRL   key, it will not snap to the connection point; it will simply drop at   the indicated position. If you want 
the connector handle to snap to a   connection point, you must click and drag it without using the CTRL   
key.

The Arrow Keys

Use the arrow keys to move the connector horizontally and vertically   in the picture. The number of pixels 
the connector moves each time you   press an arrow key depends on the SlowNudgeMoveOffset setting 
in the FixUserPreferences.ini   file. 

SHIFT + the Arrow Keys

When you press the SHIFT key   and one of the arrow keys, the connector moves horizontally or vertically,   
depending on the arrow key used. The number of pixels the connector moves   is defined in the 
FastNudgeMoveOffset setting in the FixUserPreferences.ini   file.

CTRL + the Arrow Keys

When you press the CTRL key   and the up or down arrow keys, the connector moves or scales vertically,   
depending on the position of the connector and  the   arrow key used. If you press the left or right arrow 
key while pressing   the CTRL key, the connector   moves or scales horizontally. For example, if you draw a 
horizontal connector,   it will move vertically when you use the up or down arrow key with the   CTRL key, 
and will scale   horizontally when you use the left or right arrow key with the CTRL   key. If you draw a ver-
tical connector, it will scale vertically   when you use the up or down arrow key with the CTRL   key, and will 
move horizontally when you use the left or right   arrow key with the CTRL key.

When scaling the connector, only the end moves. For example, if you   draw a pipe connector from left to 
right, the right side of the connector   (the end) stretches or shrinks when you use the CTRL   key and left or 
right arrow key. If you rotate the connector 180   degrees, the left side becomes the end and the connector 
will be scaled   from that side. The number of pixels the connector moves or is scaled   when you use the 
CTRL key   with the arrow keys depends on the SlowNudgeMoveOffset and SlowNudgeScaleOffset   set-
tings in the FixUserPreferences.ini file. 

SHIFT + CTRL + the Arrow Keys

When you press SHIFT +   CTRL and one of the arrow   keys, the connector moves or scales horizontally or 
vertically, depending   on the position of the connector and the arrow key used. For example,   if you draw a 
horizontal connector, it will move vertically when you use   the up or down arrow key with the SHIFT   +CTRL 
keys, and   will scale horizontally when you use the left or right arrow key with   the SHIFT + CTRL keys.   If 
you draw a vertical connector, it will scale vertically when you use   the up or down arrow key with the 
SHIFT   + CTRL keys, and   will move horizontally when you use the left or right arrow key with the   SHIFT + 
CTRL   keys. The number of pixels the connector moves or scales when you   use the SHIFT + CTRL   keys 
with the arrow keys depends on the FastNudgeMoveOffset and FastNudgeScaleOffset   settings in the 
FixUserPreferences.ini file.
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The + or - keys

Use the + or - keys to rotate your connector. When you right-click the   object and choose Rotate, four 
rotate handles appear around the object.   Use the + key on the number keypad to rotate the connector in 
a counter   clockwise direction; use the - key on the number keypad to rotate the   connector in a clockwise 
direction. The number of degrees the connector   rotates each time you press the + or - key depends on 
the SlowNudgeRotateOffset   setting in the FixUserPreferences.ini file.

SHIFT and + or - key

When you press the SHIFT key   and either the + or - key, the connector rotates either counter clockwise   
or clockwise, depending on the key used. The number of degrees the connector   moves is defined in the 
FastNudgeRotateOffset setting in the FixUserPreferences.ini   file.

Anchoring Connectors

You must add connection points to shapes or   use the default connection points to anchor the connector. 
Anchoring a   connector allows you to move the shapes around the picture until you are   satisfied with their 
locations, while keeping them connected. The connector   stretches and reshapes itself as you move or 
resize the shapes.

The following diagrams show you how to anchor   a connector.

In Figure 1, the green arrow points to the   line connector and the black arrows point to connection points 
you added.   For information about adding connection points, refer to Adding   and Deleting Connection 
Points.

Figure 2 shows the anchored connector. When you select the connector   and move the cursor over the 
handles, the cursor becomes a crosshair.   Click and drag each connector handle to a connection point. 
The handles   change to red and black when the connector is anchored.

NOTE: You can anchor   a connector to default connection points.

Connected Shapes that Overlap

All shapes have a bounding box that defines the outside boundary of   the shape. The bounding box is vis-
ible when a shape is selected and dragged.   The following picture shows the bounding box of a pipe con-
nector that   is being moved. Only the bounding box moves while you're dragging the   connector. When 
you let go of the mouse button, the shape then moves and   the bounding box disappears.
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As you add shapes to your picture, the shape that was drawn last is   always placed "on top." This means 
that the bounding box of   the newest shape may overlap an existing shape. When you are adding pipe   
and line connector shapes to your picture, this overlap can prevent you   from selecting the previously 
drawn shape.

For example, you have anchored both a pipe connector and a line (or   right angle line) connector to two 
shapes, and the bounding box of the   pipe connector is on top because you drew it last. As the following 
picture   shows, the line connector is positioned within the pipe connector's bounding   box; therefore, you 
cannot select it. 

  You must either move the pipe connector so that its bounding box no longer   overlaps the line connector 
or right-click the pipe connector and choose   Send to Back. This allows you to select and move the line 
connector and   anchor it to the desired connection points.   

NOTE: To allow shapes   to be selectable at all times, regardless of the location of a shape's   bounding box, 
clear the Always Show Connection Nodes check box on the   Drawing Options tab of the User Preferences dia-
log box.

 

Creating Complex Objects 
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One of the most powerful features in iFIX is the ability to easily create   complex objects from simple 
ones. Because iFIX uses object-oriented graphics   in an open picture environment, you have the flex-
ibility to develop more   intuitive pictures with a few clicks of the mouse. The ways you can manipulate   
objects to design advanced pictures include:

 l Stacking

 l Bringing   to Front and Sending to Back

 l Layering   and Visibility

 l Grouping   and ungrouping

Stacking

Stacking allows you to place one object on top of another so that it forms a more complex, multi-dimen-
sional figure. 

It is an effective method for taking simple, existing objects and forming more intuitive ones. For 
example, by stacking two ovals and two rectangles, you can create a picture that resembles a pump, as 
depicted in the following figure. 

To form more precise connections, such as the two rectangles meeting flush with the edge of the out-
side circle in the figure above, try nudging the object exactly where you want it. For more information on 
moving objects and nudging, refer to the Moving Objects section.

You can stack as many objects as you want. The object on top does not have to cover the other object 
completely and does not alter its properties.

Bringing to Front and Sending to Back 

When you initially draw multiple objects, the object that appears on   top is always the last one drawn. 
However, you can change the order of   objects in a stack with the Send to Back and Bring to Front but-
tons. The   following figure illustrates this concept.
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You can move multiple objects in a stack so that they keep their relative   position to each other, as the fol-
lowing figure shows.
   

Making Multiple Objects the Same Size 

When you create multiple objects in a picture, you can easily resize   one or more of the objects to match 
the size of another resized object.   For example, lets say you add an oval to your picture. Next, you add a   
rectangle, and then you manually resize the rectangle. You can make the   oval the same size as the rect-
angle by selecting both objects and using   the Make Same Size function. By default, Make Same Size 
resizes the objects   in the picture according to the most recently modified object's dimensions.   If you 
want to resize objects using the dimensions of any other object,   you must select that object and resize it 
first.

Layering and Visibility 

Layering objects is a powerful way to control specific objects in a   complex picture or process. One of the 
most common uses for layering is   when you are developing large displays, and you want your operators 
to   be able to easily distinguish specific parts of the picture. By assigning   a layer or multiple layers to 
objects in the picture, you determine which   objects within the picture are visible to the operator. Further, 
layers   are an effective security feature in that you can turn off a specific   layer so that certain objects can-
not be viewed by one or a set of operators.

You can establish layering using the Set Layer and Display Layers buttons   on the Tools toolbar (Classic 
view) or from the Format tab in the Picture   group, in the Layers list (Ribbon view). Setting a layer assigns 
a layer   to a selected object. Displaying layers, on the other hand, applies to   the entire picture, and 
determines what layers are displayed in your picture.

The following illustration shows two objects, Oval1 and Rect1, added   to a picture.
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Next, layers are assigned to the objects as follows:

 1. The object Oval1   is set with a layer of 1. 

 2. The object Rect1   is set with a layer of 2. 

Then, display layers are set to 1. The following figure shows what is   displayed based on the layering that 
was assigned.
   

Next, the same objects are grouped, and layers are assigned to the objects   as follows:

 1. The object Oval1   is set with a layer of 1. 

 2. The object Rect1   is set with a layer of 2. 

 3. The grouped object   Group1 is set with a layer of 1. 

Then, display layers are set to 1. The grouped object is displayed,   including one of its member objects 
(the oval).

Layers are controlled by the LayerName property, which can be animated   using the Misc tab in the 
Advanced Animations dialog box, or by writing   VBA scripts. In addition to the examples cited above, you 
can also effectuate   the layering function in the run-time environment. After assigning layers   to a set of 
objects, the objects appear at run-time according to the layering   you have set. 

What appears on your screen, whether you are in the configuration or   run-time environments, is determ-
ined by the Visible property. However,   this is only true if the layer assigned to that object is displayed. 
For   example, if you assign the Visible property for an object to True, but   that object does not appear in 
your picture, it is probably because the   object is assigned to a layer that is not displayed (the LayerName 
property   takes precedence over the Visible property).
Using the Visibility Expert

You can also set conditions for the Visible property using the Visibility   Expert. This Expert lets you 
assign a data source to the property, or   create an expression using conditional values and relational oper-
ators.   To use the Visibility Expert, click the Visibility Expert button on the   Experts toolbar (Classic 
view), or access the Visibility Expert from the   Tools tab, in the Animations group (Ribbon View). If the 
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Toolbox is enabled,   click the button on the Toolbox. For help on the Expert fields, click   the Help button 
on the Expert.
Setting the Layer Property Through VBA

When you set the Layer property through VBA, the layers are related   to the property number by a bit 
mask. In the following equation, n   is the layer number that you want to display:

picture.displaylayer = 2n-1

For example, if you want to display layer 3, picture.displaylayer would   be equal to 23-1, which is sim-
plified to 22, which is equal to 4. So, you would use the   following VBA code:

picture.displaylayer = 4

If you want to display layer 4, picture.displaylayer would be equal   to 24-1, which is simplified to 23, which 
is equal to 8. So, you would use the   following VBA code:

picture.displaylayer = 8

Grouping and Ungrouping Objects 

You can group objects together to create a new single object. This is   called a group,   or   grouped object. A 
grouped object is like having a rubber band around   your picture that contains all the objects you grouped 
together. 

The power of grouped objects is that they let you create custom objects   which you can reuse without 
building new ones from scratch. Like other   objects, grouped objects have properties you can modify and 
control. You   can manipulate a group as an object while maintaining individual object   properties and anim-
ations. However, grouped objects do not need to be   permanent. You can always destroy a grouped 
object by ungrouping it. When   you ungroup it, the rubber band containing the objects in the group is   
deleted, but the member objects are not.

Nesting Grouped Objects 

You can nest a group inside another group. For example, you can create   a pump from a group of rect-
angles and ovals and group them. When you group   these objects, the iFIX WorkSpace adds a group 
name (Group 1)   to the system tree for the group object and lists the individual objects   that comprise the 
group one level down from the group name. The following   figure illustrates this concept. 

System Tree Grouped Objects

If you draw a valve (Polygon1), a connector (PolyLine1), and group it   with the pump (Group1), another 
object named Group 2 is created which   contains the first group (the pump) and the objects used to create 
the   valve (the Polygon1 and PolyLine1), as the following figure shows. 

System Tree Grouped Objects
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Editing Grouped Objects 

Once you create a grouped object, you can manipulate it like any other   individual object, including mov-
ing, cutting, copying, and resizing it.   Keep in mind, however, that when you ungroup an object, any 
changes you   make to it affect the member objects. For example, if you resize a group   before you 
ungroup it, you resize each individual object in the group.   

Changing a group's animations, however, does not affect the member objects   when you ungroup. To 
change the properties of individual objects, you   must drill   down into the group to select the object you 
want, without ungrouping   the object.
Drilling Down into a Group 

Drilling down allows you to meticulously control complex grouped objects.   To drill down, select Enter 
DrillDown from the object pop-up menu and   select the object in the group that you want to change. You 
can also hold   down the shift key and click the object in the group that you want to   change. Drilling down 
also lets you change the order in which the objects   are stacked within the group. 

For example, suppose you want to change the color and size of the polygon   (the valve) in the following 
figure. 

One way to do this would be to ungroup, make changes to the polygon,   and regroup the objects. 
However, this can be tedious and time-consuming,   particularly if you have many objects in the group 
that you need to change.   In addition, if the group contains animations or scripts, the animation   settings 
and the scripts are destroyed when you ungroup the object.

A more effective way to modify the polygon is to drill down into the   group and make changes without 
ungrouping. This approach saves time because   you don't have to ungroup and then regroup, and con-
sequently you preserve   any animations or scripts you have assigned to the group.

When you drill down into a group to change an object, a box of dashed   lines appear around the group. 
Any additional groups will also display   a dashed line box. To change only a specific object in a group, 
first   select the group that contains that object. Then right-click the group   and select Enter DrillDown from 
the pop-up menu. Now you can select the   object you want. You can also hold down the shift key and 
click the object   in the group that you want to select, as the following figure illustrates.
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Nested Group Objects

 

Pictures Dialog Boxes

The WorkSpace application includes the following dialog boxes for working   with pictures (listed in alpha-
betical order):

 l Add   Alarm Extension Field1 Dialog Box

 l Add   Alarm Extension Field2 Dialog Box

 l Add   Area Dialog Box

 l Add   ColorSet Dialog   Box

 l Add   Date In Dialog Box

 l Add   Date Last Dialog Box

 l Add   Description Dialog Box

 l Add   Node Dialog Box

 l Add   Priority Dialog Box

 l Add   Tag Dialog Box

 l Add   Time In Dialog Box

 l Add   Time Last Dialog Box

 l Advanced   Animations Dialog Box

 l Advanced   Lookup Options Dialog Box

 l Alarm   Summary Configuration Dialog Box

 l Basic   Animation Dialog Box

 l Button   Caption Converter Dialog Box
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 l Chart   Configuration Dialog Box

 l Color   Selection Dialog Box

 l Create   Picture Wizard Dialog Box

 l Custom   Lookup Table Dialog Box

 l Datalink   Dialog Box

 l Edit   Picture Dialog Box

 l Enhanced   Chart Customization Dialog Box

 l Grid   Settings Dialog Box

 l Historical   Datalink Dialog   Box

 l Modify   Area Dialog Box

 l Modify   Configuration Dialog Box

 l Modify   Pipe Characteristics Dialog Box

 l New   Level Dialog Box

 l Select   BackgroundColor

 l Select   Color Dialog Box

 l Select   EdgeColor

 l Select   FadeColor Dialog   Box

 l Select   ForegroundColor

 l Upgrading   Pictures to Screen Independent Enhanced Coordinates Dialog Box

 

Add Ack Dialog Box

The Add Ack dialog box displays the following items:

Acknowledged

Lists the alarms that have been acknowledged.

Unacknowledged

Lists the alarms that have not been acknowledged.

Add Alarm Extension Field1 Dialog Box

The Add Alarm Extension Field1 dialog box displays the following items:

Containing

Allows you to configure the Alarm Summary object to display only those   alarms that contain the text 
string entered in the Description field.    
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Not Containing

Allows you to configure the Alarm Summary object to display all alarms   that do not contain the text 
string entered in the Description field.    

Containing Only

Allows you to configure the Alarm Summary object to display all alarms   that contain an exact match of 
the text string entered in the Description   field.  

Alarm Extension Field1

Allows you to enter the text description for which to filter alarms.    You can   use the asterisk (*) wildcard 
character to match substrings; for example,   my* would filter the description "mynode".  You   can also 
use the question mark (?) wildcard character to match individual   characters; for example, myno?e would 
also filter the description "mynode".    

Add Alarm Extension Field2 Dialog Box

The Add Alarm Extension Field2 dialog box displays the following items:

Containing

Allows you to configure the Alarm Summary object to display only those   alarms that contain the text 
string entered in the Description field.    

Not Containing

Allows you to configure the Alarm Summary object to display all alarms   that do not contain the text 
string entered in the Description field.    

Containing Only

Allows you to configure the Alarm Summary object to display all alarms   that contain an exact match of 
the text string entered in the Description   field.  

Alarm Extension Field2

Allows you to enter the text description for which to filter alarms.    You can   use the asterisk (*) wildcard 
character to match substrings; for example,   my* would filter the description "mynode".  You   can also 
use the question mark (?) wildcard character to match individual   characters; for example, myno?e would 
also filter the description "mynode".    

Add Area Dialog Box

The Add Area dialog box displays the following items:

Available

Lists the alarm areas that are currently available.  To   filter alarms by alarm area, select the area(s) from 
this list and select   the In or Not In option button.  
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In

Allows you to filter alarms by the alarm areas that are currently selected   in the Available list.  When   this 
option is selected, the Alarm Summary object displays only those   alarms from the selected alarm areas.  

Not In

Allows you to filter alarms by the alarm areas that are currently selected   in the Available list.  When   this 
option is selected, the Alarm Summary object ignores all alarms from   the selected alarm areas.  

Add Area Not Currently in List Edit Box

Allows you to add an alarm area name to the Available list, if it does   not appear by default.  Enter   the 
alarm area name in this field and click Add to add it to the list.    

Add Button

Allows you to add an alarm area name to the Available list, if it does   not appear by default.  Enter   the 
alarm area name in the Add Area Not Currently In List field and click   this button to add it to the Available 
list.  

Add ColorSet Dialog Box

The Add ColorSet dialog box displays the following item:

Name

Allows you to enter a name for your color set.

Add Date In Dialog Box

The Add Date In dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 

only those alarms that are equal to the value of the field to   the 
right.  For   example, if the equal operator is used in conjunction 
with the Time In   field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred at 10:00:00.    

< > Allows you to configure the Alarm Summary object to   display 
only those alarms that are not equal to the value of the field   to the 
right.  For   example, if the not equal operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display all alarms 
that did not first occur at 10:00:00.    

> Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than the value of the field   to the 
right.  For   example, if the greater than operator is used in con-
junction with the   Time In field, and the value in the Time In field is 
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10:00:00, then the   Alarm Summary object will display only those 
alarms that first occurred   after 10:00:00.  

>= Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than or equal to the value   of the 
field to the right.  For   example, if the greater than or equal to oper-
ator is used in conjunction   with the Time In field, and the value in 
the Time In field is 10:00:00,   then the Alarm Summary object will 
display all alarms that first occurred   at or after 10:00:00.  

< Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than the value of the field to   the 
right.  For   example, if the less than operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred before   10:00:00.  

<= Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than or equal to the value of   the 
field to the right.  For   example, if the less than or equal to operator 
is used in conjunction   with the Time In field, and the value in the 
Time In field is 10:00:00,   then the Alarm Summary object will dis-
play all alarms that first occurred   at or before 10:00:00.  

Date In

The date when the block first generated the alarm –   used as a condition to filter alarms.

Add Date Last Dialog Box

The Add Date Last dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 

only those alarms that are equal to the value of the field to   the 
right.  For   example, if the equal operator is used in conjunction 
with the Time In   field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred at 10:00:00.    

< > Allows you to configure the Alarm Summary object to   display 
only those alarms that are not equal to the value of the field   to the 
right.  For   example, if the not equal operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display all alarms 
that did not first occur at 10:00:00.    

> Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than the value of the field   to the 
right.  For   example, if the greater than operator is used in con-
junction with the   Time In field, and the value in the Time In field is 
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10:00:00, then the   Alarm Summary object will display only those 
alarms that first occurred   after 10:00:00.  

>= Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than or equal to the value   of the 
field to the right.  For   example, if the greater than or equal to oper-
ator is used in conjunction   with the Time In field, and the value in 
the Time In field is 10:00:00,   then the Alarm Summary object will 
display all alarms that first occurred   at or after 10:00:00.  

< Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than the value of the field to   the 
right.  For   example, if the less than operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred before   10:00:00.  

<= Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than or equal to the value of   the 
field to the right.  For   example, if the less than or equal to operator 
is used in conjunction   with the Time In field, and the value in the 
Time In field is 10:00:00,   then the Alarm Summary object will dis-
play all alarms that first occurred   at or before 10:00:00.  

Date Last

The date when the block last generated the alarm –   used as a condition to filter alarms.

Add Description Dialog Box

The Add Description dialog box displays the following items:

Containing

Allows you to configure the Alarm Summary object to display only those   alarms that contain the text 
string entered in the Description field.    

Not Containing

Allows you to configure the Alarm Summary object to display all alarms   that do not contain the text 
string entered in the Description field.    

Containing Only

Allows you to configure the Alarm Summary object to display all alarms   that contain an exact match of 
the text string entered in the Description   field.  

Description

Allows you to enter the text description for which to filter alarms.    You can   use the asterisk (*) wildcard 
character to match substrings; for example,   my* would filter the description "mynode".  You   can also 
use the question mark (?) wildcard character to match individual   characters; for example, myno?e would 
also filter the description "mynode".    

Add Model Context Dialog Box
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The Add Model Context dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 

only those alarms that are generated from the model context 
entered   in the Model Context field.  

< > Allows you to configure the Alarm Summary object to   display all 
alarms that are not generated from the model context entered in   
the Model Context field.  

Model Context

Allows you to enter a model context filter value in the format: SCADAName.ObjectInstance. Tag group 
symbols may be used in the model context filter value. 

 1. Click the ellipsis button to open the Model Browse dialog box. 
 2. In the SCADA field, use the drop-down list to select an available SCADA.
 3. Select Types to see the available model types, or Instances to see the available model 

instances. Note: Selecting from a Type will fill in the filter expression field with a symbol for sub-
stitution.

 4. Select an entry from the model tree to use in your filter expression field.
 5. Click OK.

Add Node Dialog Box

The Add Node dialog box displays the following items:

Available

Lists the nodes that are currently available.  To   filter alarms by node, select the node from this list and 
select the In   or Not In option button.  

In

Allows you to filter alarms by the nodes that are currently selected   in the Available list.  When   this option 
is selected, the Alarm Summary object displays only the available   nodes.  

Not In

Allows you to filter alarms by the nodes that are currently selected   in the Available list.  When   this option 
is selected, the Alarm Summary object ignores all alarms from   the selected alarm areas.  

Add Priority Dialog Box

The Add Priority dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 
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only those alarms that are equal to the priority listed on the   right.  
< > Allows you to configure the Alarm Summary object to   display 

only those alarms that are not equal to the priority listed on   the 
right.   

> = Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than or equal to the priority   lis-
ted on the right.  

< = Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than or equal to the priority   listed 
on the right.  

Priority Drop-Down List

Allows you to select an INFO,   LOLO, LOW,   MEDIUM, HIGH,   HIHI, or CRITICAL   priority condition to 
filter the alarms.  

Add Tag Dialog Box

The Add Tag dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 

only those alarms that are generated from the tagname entered   in 
the Tagname field.  

< > Allows you to configure the Alarm Summary object to   display all 
alarms that are not generated from the tagname entered in   the 
Tagname field.  

Tagname

Allows you to enter a tagname for which you want to filter alarms.  

Add Time In Dialog Box

The Add Time In dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 

only those alarms that are equal to the value of the field to   the 
right.  For   example, if the equal operator is used in conjunction 
with the Time In   field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred at 10:00:00.    

< > Allows you to configure the Alarm Summary object to   display 
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only those alarms that are not equal to the value of the field   to the 
right.  For   example, if the not equal operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display all alarms 
that did not first occur at 10:00:00.    

> Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than the value of the field   to the 
right.  For   example, if the greater than operator is used in con-
junction with the   Time In field, and the value in the Time In field is 
10:00:00, then the   Alarm Summary object will display only those 
alarms that first occurred   after 10:00:00.  

>= Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than or equal to the value   of the 
field to the right.  For   example, if the greater than or equal to oper-
ator is used in conjunction   with the Time In field, and the value in 
the Time In field is 10:00:00,   then the Alarm Summary object will 
display all alarms that first occurred   at or after 10:00:00.  

< Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than the value of the field to   the 
right.  For   example, if the less than operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred before   10:00:00.  

<= Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than or equal to the value of   the 
field to the right.  For   example, if the less than or equal to operator 
is used in conjunction   with the Time In field, and the value in the 
Time In field is 10:00:00,   then the Alarm Summary object will dis-
play all alarms that first occurred   at or before 10:00:00.  

Time In

The time that the block first generated the alarm –   used as a condition to filter alarms.

Add Time Last Dialog Box

The Add Time Last dialog box displays the following items:

Operator

Item Description
= Allows you to configure the Alarm Summary object to   display 

only those alarms that are equal to the value of the field to   the 
right.  For   example, if the equal operator is used in conjunction 
with the Time In   field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred at 10:00:00.    

< > Allows you to configure the Alarm Summary object to   display 
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only those alarms that are not equal to the value of the field   to the 
right.  For   example, if the not equal operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display all alarms 
that did not first occur at 10:00:00.    

> Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than the value of the field   to the 
right.  For   example, if the greater than operator is used in con-
junction with the   Time In field, and the value in the Time In field is 
10:00:00, then the   Alarm Summary object will display only those 
alarms that first occurred   after 10:00:00.  

>= Allows you to configure the Alarm Summary object to   display 
only those alarms that are greater than or equal to the value   of the 
field to the right.  For   example, if the greater than or equal to oper-
ator is used in conjunction   with the Time In field, and the value in 
the Time In field is 10:00:00,   then the Alarm Summary object will 
display all alarms that first occurred   at or after 10:00:00.  

< Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than the value of the field to   the 
right.  For   example, if the less than operator is used in conjunction 
with the Time   In field, and the value in the Time In field is 
10:00:00, then the Alarm   Summary object will display only those 
alarms that first occurred before   10:00:00.  

<= Allows you to configure the Alarm Summary object to   display 
only those alarms that are less than or equal to the value of   the 
field to the right.  For   example, if the less than or equal to operator 
is used in conjunction   with the Time In field, and the value in the 
Time In field is 10:00:00,   then the Alarm Summary object will dis-
play all alarms that first occurred   at or before 10:00:00.  

Time Last

The time when the alarm condition or status last changed –   used as a condition to filter alarms.

Advanced Animations Dialog Box

The Advanced Animation dialog box can display the following tabs:

 l General   Tab

 l Visibility   Tab

 l Size   Tab

 l Miscellaneous   Tab

 l Position   Tab

 l Color   Tab

 l Style   Tab

 l Rotate   Tab
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 l Fill   Tab

 l Gradient   Tab

 l Text   Tab

 l Behavior   Tab

 l Appearance   Tab

 l Picture   Tab

 

General Tab - Advanced Animations Dialog Box

The General tab of the Advanced Animations dialog box displays the following   items:

Name

Allows you to enter a name for the selected object. The name that you   specify appears in the 
WorkSpace system tree and in the Name row of the   VBA Property window.

Description

Allows you to enter a description for the selected object. The description   that you specify appears in the 
ToolTip for the object (provided that   the Enable ToolTips option is enabled) and in the Description row of 
the   VBA Property window.

Help Context ID

Allows you to enter a help context ID for the selected object if you   are creating your own context-sens-
itive, picture-specific help files.   See the Mastering iFIX manual for more information.

Enable Tooltips

Select this check box to display an on-screen description of the object   when the pointer pauses on it.

Tooltip Option

This drop-down list is only available when the Enable Tooltip option   is selected. Select the item from the 
list that specifies where the tooltip   text comes from: 

 l The object's Description   property (TooltipDescription).

 l The Dynamo's Description   property (TooltipDynamoDescription).

 l From a run mode tag   value description supplied when you load tag status symbols for your pic-
ture   (TooltipTagStatus).

Enable Highlight

Select this check box to display a highlight around the object when   the pointer is over it.

Enable Select

Select this check box to allow operators to select the object at run-time.

Visibility Tab - Advanced Animations Dialog Box

The Visibility tab of the Advanced Animations dialog box displays the   following items:
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Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for the Visible Property area appears   directly below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.

Animation Properties Tab

The Animation Properties tab contains the following   items: 

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
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occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.

 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 
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allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 
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Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Size Tab - Advanced Animations Dialog Box

The Size tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.
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Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.  

Animation Properties

The Animation Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:  

 l Range – uses a range of values on which   to animate an 
object.

 l Table – attempts to match the incoming   value from the 
data source to an entry in a lookup table. If a match 
occurs,   the selected property is changed to match the out-
put value.

 l Format  –   provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact   value. This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Range to 
Table, Format, or   Object, the bottom half the dialog box changes 
accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:  

 l Use   Current Output– Displays   the data exactly as it 
appeared in when the error occurred.

 l Use   Error Table– Displays   an error message that 
matches the current error, based on the error definitions   in 
the Animations Data Error Defaults tab of the User Prefer-
ences dialog   box.

 l Use   Minimum Value– Displays   the lowest possible 
value that is valid for the data source when an error   
occurs.

 l Use   Maximum Value– Displays   the highest possible 
value that is valid for the data source when an error   
occurs.
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Minimum Input Allows you to specify the low limit value for incoming   data.  
Minimum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the minimum   
value, in logical units or postscript points, for the output range in   
this field.  

Maximum Input Allows you to specify the high limit value for incoming   data.  
Maximum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the 
maximum   value, in logical units or postscript points, for the out-
put range in   this field.  

Fetch Input Range on 
Open

Select this check box to automatically fetch the minimum   and 
maximum input values for the data source at run-time.  

NOTE: Fetching   data limits at runtime for an expression with more than one data source   is not supported and 
may produce unexpected results at runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.
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Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
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other fields in this area.
Secs Allows you to enter the number of seconds for the   duration for the 

data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Miscellaneous Tab - Advanced Animations Dialog Box

The Miscellaneous tab of the Advanced Animations dialog box displays   the following items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.

Animation Properties

The Animation Properties tab contains the following items:
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Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.

 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

© 2024 General Electric Company. All rights reserved. 177



existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   
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Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.
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Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Position Tab - Advanced Animations Dialog Box

The Position tab of the Advanced Animations dialog box   displays the following items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames   and historical files, 
or other OPC-compliant   data servers. A data source may also consist of iFIX objects (such as   shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.  

The Animation Properties Tab

The Animation Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:  

 l Range – uses a range of values on which   to animate an 
object.

 l Table – attempts to match the incoming   value from the 
data source to an entry in a lookup table. If a match 
occurs,   the selected property is changed to match the out-
put value.
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 l Format  –   provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact   value. This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Range to 
Table, Format, or   Object, the bottom half the dialog box changes 
accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:  

 l Use   Current Output– Displays   the data exactly as it 
appeared in when the error occurred.

 l Use   Error Table– Displays   an error message that 
matches the current error, based on the error definitions   in 
the Animations Data Error Defaults tab of the User Prefer-
ences dialog   box.

 l Use   Minimum Value– Displays   the lowest possible 
value that is valid for the data source when an error   
occurs.

 l Use   Maximum Value– Displays   the highest possible 
value that is valid for the data source when an error   
occurs.

Minimum Input Allows you to specify the low limit value for incoming   data.  
Minimum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the minimum   
value, in logical units or postscript points, for the output range in   
this field.  

Maximum Input Allows you to specify the high limit value for incoming   data.  
Maximum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the 
maximum   value, in logical units or postscript points, for the out-
put range in   this field.  

Use Offset Select this check box to perform an animation on an   object in its 
current position, not in the absolute position specified   by the 
logical unit or postscript point value in the Minimum Output field.    

Fetch Input Range on 
Open

Select this check box to automatically fetch the minimum   and 
maximum input values for the data source at run-time.  

NOTE: Fetching   data limits at runtime for an expression with more than one data source   is not supported and 
may produce unexpected results at runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.
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Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg   – The average of all valid data found during the specified interval. 
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 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp   for this mode represents 
the timestamp   from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Color Tab - Advanced Animations Dialog Box
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The Color tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.  

Animations Properties Tab

The Animations Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly. 
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Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.

 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.  

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description

© 2024 General Electric Company. All rights reserved. 185



Fixed Time Specifies whether to designate a specific time to   start. If selected, 
allows you to enter an explicit start time.

Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 
Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.
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Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Style Tab - Advanced Animations Dialog Box

The Style tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 
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Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager. 

Animations Properties Tab

The Animations Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.
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 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.  

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
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Time Zone Allows you to select the time zone to associate with   the start time. You 
can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
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other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Rotate Tab - Advanced Animations Dialog Box

The Rotate tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.  

Animations Properties Tab

The Animations Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
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version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:  

 l Range – uses a range of values on which   to animate an 
object.

 l Table – attempts to match the incoming   value from the 
data source to an entry in a lookup table. If a match 
occurs,   the selected property is changed to match the out-
put value.

 l Format  –   provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact   value. This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Range to 
Table, Format, or   Object, the bottom half the dialog box changes 
accordingly.

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:  

 l Use   Current Output– Displays   the data exactly as it 
appeared in when the error occurred.

 l Use   Error Table– Displays   an error message that 
matches the current error, based on the error definitions   in 
the Animations Data Error Defaults tab of the User Prefer-
ences dialog   box.

 l Use   Minimum Value– Displays   the lowest possible 
value that is valid for the data source when an error   
occurs.

 l Use   Maximum Value– Displays   the highest possible 
value that is valid for the data source when an error   
occurs.

Minimum Input Allows you to specify the low limit value for incoming   data.  
Minimum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the minimum   
value, in logical units or postscript points, for the output range in   
this field.  

Maximum Input Allows you to specify the high limit value for incoming   data.  
Maximum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the 
maximum   value, in logical units or postscript points, for the out-
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put range in   this field.  
Fetch Input Range on 
Open

Select this check box to automatically fetch the minimum   and 
maximum input values for the data source at run-time.  

NOTE: Fetching   data limits at runtime for an expression with more than one data source   is not supported and 
may produce unexpected results at runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   
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Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.
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Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Fill Tab - Advanced Animations Dialog Box

The Fill tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.  

Animation Properties Tab

The Animation Properties tab contains the following items: 

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:  

 l Range – uses a range of values on which   to animate an 
object.

 l Table – attempts to match the incoming   value from the 
data source to an entry in a lookup table. If a match 
occurs,   the selected property is changed to match the out-
put value.
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 l Format  –   provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact   value. This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Range to 
Table, Format, or   Object, the bottom half the dialog box changes 
accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:  

 l Use   Current Output– Displays   the data exactly as it 
appeared in when the error occurred.

 l Use   Error Table– Displays   an error message that 
matches the current error, based on the error definitions   in 
the Animations Data Error Defaults tab of the User Prefer-
ences dialog   box.

 l Use   Minimum Value– Displays   the lowest possible 
value that is valid for the data source when an error   
occurs.

 l Use   Maximum Value– Displays   the highest possible 
value that is valid for the data source when an error   
occurs.

Minimum Input Allows you to specify the low limit value for incoming   data.  
Minimum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the minimum   
value, in logical units or postscript points, for the output range in   
this field.  

Maximum Input Allows you to specify the high limit value for incoming   data.  
Maximum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the 
maximum   value, in logical units or postscript points, for the out-
put range in   this field.  

Fetch Input Range on 
Open

Select this check box to automatically fetch the minimum   and 
maximum input values for the data source at run-time.  

NOTE: Fetching   data limits at runtime for an expression with more than one data source   is not supported and 
may produce unexpected results at runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:
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NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 
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 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Gradient Tab - Advanced Animations Dialog Box

The Gradient tab of the Advanced Animations dialog box displays the   following items:
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Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.  

Animation Properties Tab

The Animation Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
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occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.

 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.  

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options. 

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 
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allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 
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Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Text Tab - Advanced Animations Dialog Box

The Text tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.
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Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.

Animation Properties Tab

The Animation Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Format to 
Range, Table, or   Object, the bottom half the dialog box changes 
accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

Type Allows you to configure whether or not operators can enter data 
into   the animation at run-time. To allow operators to enter data 
into animation   and write a new value to the database tag during 
the next scan cycle,   select In-Place from the list. To prohibit 
data entry at run-time, select   None.  

Confirm When selected, requires operators to confirm that they want to 
write   data to the database after they have entered a new value 
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into the animation   at run-time. 

This option is only available if In-Place is selected in the Data 
Entry   Type list.  

Raw Format Allows you to enter data in its raw (or native C code) format. If 
this   check box is enabled, you can edit the format by entering a 
C format string   in the Format field.  

Format Allows you to enter a C format string to display data in its raw, 
native   C code format. You can also enter a string of any kind pre-
ceding the raw   format string (for example, to introduce what the 
data string represents).    

This option is only available if Raw Format is selected.
Justify Allows you to justify the alignment (left, center, or right) of data   in 

the animation.  

This option is only available if the Raw Format check box is 
cleared.

Type Allows you to configure whether the data represented by the 
animation   should be formatted as numeric or alphanumeric data. 
To format numeric   data, select Numeric from this list and enter 
an integer from 0 to 7 in   the Whole Digits field and 0 to 5 in the 
Decimal field. To format alpha-numeric   data, select Alpha-
Numeric from this list and enter the number of lines   and the 
desired number of characters per line.  

This option is only available if the Raw Format check box is 
cleared.

Lines Allows you to enter the number of lines that you want to display 
in   an alpha-numerically formatted animation.  

This option is only available if the Raw Format check box is 
cleared.

Chars/Line Allows you to enter the number of characters per line that you 
want   to display in an alpha-numerically formatted animation.  

This option is only available if the Raw Format check box is 
cleared.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
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Days Before Now Specifies whether to enter the number of days prior   to today to fetch 
data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
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be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Behavior Tab - Advanced Animations Dialog Box

The Behavior tab of the Advanced Animations dialog box displays the   following items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.
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Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.

Animation Properties Tab

The Animation Properties tab contains the following items: 

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.
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 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.

 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.
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Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
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other fields in this area.
Mins Allows you to enter the number of minutes for the   duration for the 

data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Appearance Tab - Advanced Animations Dialog Box

The Appearance tab of the Advanced Animations dialog box displays the   following items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.
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Animation Properties Tab

The Animation Properties tab contains the following items:

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:  

 l Range – uses a range of values on which   to animate an 
object.

 l Table – attempts to match the incoming   value from the 
data source to an entry in a lookup table. If a match 
occurs,   the selected property is changed to match the out-
put value.

 l Format  –   provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact   value. This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Range to 
Table, Format, or   Object, the bottom half the dialog box changes 
accordingly. 

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:  

 l Use   Current Output– Displays   the data exactly as it 
appeared in when the error occurred.

 l Use   Error Table– Displays   an error message that 
matches the current error, based on the error definitions   in 
the Animations Data Error Defaults tab of the User Prefer-
ences dialog   box.

 l Use   Minimum Value– Displays   the lowest possible 
value that is valid for the data source when an error   
occurs.

 l Use   Maximum Value– Displays   the highest possible 
value that is valid for the data source when an error   
occurs.

Minimum Input Allows you to specify the low limit value for incoming   data.  
Minimum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the minimum   
value, in logical units or postscript points, for the output range in   
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this field.  
Maximum Input Allows you to specify the high limit value for incoming   data.  
Maximum Output Allows you to apply linear signal conditioning to   the data by map-

ping the range of input values specified in the Minimum   and Max-
imum Input fields to a range of output values. Enter the 
maximum   value, in logical units or postscript points, for the out-
put range in   this field.  

Fetch Input Range on 
Open

Select this check box to automatically fetch the minimum   and 
maximum input values for the data source at run-time.  

NOTE: Fetching   data limits at runtime for an expression with more than one data source   is not supported and 
may produce unexpected results at runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
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that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming new data points between the starting and   end-
ing values. All data points are estimated except the starting point   and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.
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Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Picture Tab - Advanced Animations Dialog Box

The Picture tab of the Advanced Animations dialog box displays the following   items:

Properties

Provides options that allow you to select the properties that you want   to animate. For a brief description 
of each property, read the property   description on the right side of the dialog box.

Animate

Select this check box to open dynamic settings for the visible property.   When selected, the Dynamic 
Setting for Property area appears directly   below the Properties area.

Dynamic Settings for Property

Data Source

Allows you to enter a data source or expression for this object. 

Data source refers to a reference   to a source of information, such as iFIX tagnames and historical files,   
or other OPC-compliant data servers. A data source may also consist of   iFIX objects (such as shapes, 
charts, and variables) or 3rd party OLE   controls.

Expression refers to constants,   data sources, or a combination of constants and data sources that are   
connected with one or more operators. Use the Browse (...) button to open   the Expression Builder dialog 
box. Use the Quick Modify button to modify   a database block directly without launching the Database 
Manager.

Animation Properties Tab

The Animation Properties tab contains the following items: 

Item Description
Data Conversion Allows you to select the type of data conversion to   apply to the 

data from the source listed in the Data Source field. A data   con-
version defines how the incoming data should be processed or 
formatted   so that your objects behave according to the prop-
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erties you have assigned   to them. You can apply any of the fol-
lowing data conversion:

 l Range   – uses a range of values on which to animate an 
object.

 l Table   – attempts to match the incoming value from the 
data source to an entry   in a lookup table. If a match 
occurs, the selected property is changed   to match the out-
put value.

 l Format   – provides several options for formatting text 
data.

 l Object   – processes the data received from the data 
source at its exact value.   This option is not supported for 
data from Proficy Historian.

NOTE: If   you change the Data Conversion option from Table to 
Range, Format, or   Object, the bottom half the dialog box 
changes accordingly.

Output Error Mode Allows you to configure how an animation behaves if   an error 
occurs. Depending on the type of data conversion, the output   
error mode can be any of the following:

 l Use   Current Output – Displays the data exactly as it 
appeared in when   the error occurred.

 l Use   Error Table – Displays an error message that 
matches the current   error, based on the error definitions in 
the Animations Data Error Defaults   tab of the User Prefer-
ences dialog box.

 l Use   Minimum Value – Displays the lowest possible 
value that is valid   for the data source when an error 
occurs.

 l Use   Maximum Value – Displays the highest possible 
value that is valid   for the data source when an error 
occurs.

Exact Match Allows you to specify that incoming data must exactly   match the 
configured input value in the lookup table in order to format   the 
data as the corresponding output value.

Range Comparison Allows you to specify that incoming data must fall   within a range 
of input values in the lookup table in order to format   the data as 
the corresponding output value.

Insert Row Inserts a new row into the data conversion table.
Modify Row Displays the New   Level Dialog Box so that you can modify an 

existing row in the data   conversion table.
Delete Row Deletes an existing row of the data conversion table.
Advanced Displays the Advanced   Lookup Options Dialog Box that allows 

you to configure several more   lookup options.
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Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 
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 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Advanced Lookup Options Dialog Box
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The Advanced Lookup Options dialog box displays the following items:

Toggle Source

Allows you to enter a data source or expression to provide an additional   animation to an object.  

Toggle Value

Allows you to specify a second output color to which you want to convert   the input value or range of val-
ues in the lookup table, based on the value   of the data source in the Toggle Source field.  

Table

Allows you to override the default lookup table completely and use a   user-defined lookup table that is 
defined in the User Global page.  

Toggle Rate

Allows you to modify the blink rate of the animations that are tied   to the selected object, if you have spe-
cified a second data source through   the Toggle Source field.  

Unmatched Level

Allows you to specify the color value for the data if the conversion   does not match a level that is defined 
in the lookup table.  

Tolerance for Exact Match Table

Allows you to specify the allowable deviation from the exact match table.   For example, if the exact 
match table has a configured level of 20, and   you enter a tolerance of .1, then the conversion will pro-
ceed even with   a value of 19.9.  

Alarm Summary Configuration Dialog Box

Click the following links for more information about the Alarm Summary   Configuration dialog box:

 l General   Tab

 l Operator   Tab

 l Filter   Tab

 l Sort   Tab

 l Color   Tab

 l Column   Tab

 l Display   Tab

General Tab - Alarm Summary Configuration Dialog Box

The General tab of the Alarm Summary Configuration dialog box contains   the following item:

Description

Allows you to enter a description for the Alarm Summary object.
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Alarm Summary Column Headers

Displays the font selected for the column headings in the Alarm Summary   object. Only the font name 
appears in this field. Click the browse (...)   button to change the font name, style, size, or script. 

After you select a new font and click Apply or OK, the font gets applied   to the Alarm Summary object –   in 
both configure and run mode. If the font is larger than the area allowed,   the height of the area is adjusted. 

Browse (...) Button 1

Click to select a font name, style, size, and script for the column   headings in the Alarm Summary object.

Status Bar

Displays the font selected for the status bar in the Alarm Summary object.   Only the font name appears 
in this field. Click the browse (...) button   to change the font name, style, size, or script.

After you select a new font and click Apply or OK, the font gets applied   to the Alarm Summary object –   in 
both configure and run mode. If the font is larger than the area allowed,   the height of the area is adjusted. 

Browse (...) Button 2

Click to select a font name, style, size, and script for the text in   the status bar of the Alarm Summary 
object.

Operator Tab - Alarm Summary Configuration Dialog Box

The Operator tab of the Alarm Summary Configuration dialog box displays   the following items:

Operator Run Time Settings

Item Description
Allow Alarm Acknow-
ledgement

When selected, allows operators to acknowledge alarms   through the 
Alarm Summary object at run-time. The operator can right-click   the 
object and acknowledge the currently selected alarm, all of the 
alarms   that match the current filter, or all of the alarms that are cur-
rently   displayed on the screen.

Allow Alarm Deletion When selected, allows operators to delete alarms through   the Alarm 
Summary object at run-time. The operator can right-click the   object 
and delete the currently selected alarm or all of the alarms that   match 
the current filter.

Allow Run Time Con-
figuration

When selected, allows operators to change the filter   and sort con-
figuration of the Alarm Summary object at run-time.

Enable Column Quick 
Sort

When selected, allows operators to click the heading   of any of the 
Alarm Summary object's columns to sort alarms by the attribute   lis-
ted in that column.

Display Right Mouse 
Menu

When selected, allows operators to right-click the   Alarm Summary 
object and select from a list of related commands.

Allow Acknowledge 
All Alarms

When selected, this feature allows operators to acknowledge   all 
alarms for the Alarm Summary object. By default this option is 
enabled.

IMPORTANT:   The iFIX Electronic Signature option does not support 
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Acknowledge All   Alarms capability. If you are operating in a reg-
ulated environment, GE   encourages you to clear the Allow Acknow-
ledge All Alarms check box.

Filter Tab - Alarm Summary Configuration Dialog Box

The Filter tab of the Alarm Summary Configuration dialog box displays   the following items:

Column List Box

Allows you to choose the column of the Alarm Summary object that you   want to add a filter condition to. 
To add the filter condition, select   the column name from this list and click the Add Filter Condition button   
or Insert Filter Condition button. Note that the Insert Filter Condition   button is available only if you have a 
previously defined filter condition.

Add Filter Condition

Allows you to add a filter condition to the Alarm Summary object's column   that is selected in the 
Columns field. Select a field and click Add Filter   Condition to open the associated dialog box:

 l Add   Ack Dialog Box

 l Add   Area Dialog Box

 l Add   Date In Dialog Box

 l Add   Date Last Dialog Box

 l Add   Description Dialog Box

 l Add   Node Dialog Box

 l Add Model Context Dialog Box

 l Add   Priority Dialog Box

 l Add   Tag Dialog Box

 l Add   Time In Dialog Box

 l Add   Time Last Dialog Box

 l Add   Alarm Extension Field1 Dialog Box

 l Add   Alarm Extension Field2 Dialog Box

When you add the  filter   condition, it appears at the end of the Display Alarms Where list. The   Alarm 
Summary object supports up to nine filter conditions. 

Insert Filter Condition

Allows you to add a filter condition to the Alarm Summary object's column   that is selected in the 
Columns field. Select a field and click Insert   Filter Condition to open the associated dialog box:

 l Add   Area Dialog Box

 l Add   Date In Dialog Box

 l Add   Date Last Dialog Box

 l Add   Description Dialog Box

220 © 2024 General Electric Company. All rights reserved.



 l Add   Node Dialog Box

 l Add   Priority Dialog Box

 l Add   Tag Dialog Box

 l Add   Time In Dialog Box

 l Add   Time Last Dialog Box

 l Add   Alarm Extension Field1 Dialog Box

 l Add   Alarm Extension Field2 Dialog Box

When it is inserted, the filter condition appears before the currently-selected   filter condition in the Dis-
play Alarms Where list. The Alarm Summary object   supports up to nine filter conditions. 

Display Alarms Where... List Box

Lists all configured filter conditions. You can modify, delete, or add   relational and comparison operations 
to these filter conditions by clicking   the buttons on the right.

Additional Buttons

The following buttons are included next to the Display Alarms list box:

Item Description
Modify Opens the Modify   Area Dialog Box. This dialog box allows you to edit 

the filter condition   that is currently selected in the Display Alarms 
Where list.

Remove Allows you to delete the filter condition that is   currently selected in the 
Display Alarms Where list.

And Use this button to logically connect two expressions   that must both be 
true.

Or Use this button to logically connect two expressions   where only one of 
the conditions in the expression can be true.

( Use this button to logically group two or more expressions.   This button 
must be used in conjunction with the ) operator.

) Use this button to logically group two or more expressions.   This button 
must be used in conjunction with the ( operator.

Not Use this button to logically negate expressions.  

Sort Tab - Alarm Summary Configuration Dialog Box

The Sort tab of the Alarm Summary Configuration dialog box displays   the following items:

Sort By

Allows you to select the attribute (column) of the Alarm Summary object   you want to sort by.

Ascending

Sorts the rows of the Alarm Summary object's spreadsheet in the ascending   order of the attribute that is 
currently displayed in the Sort By field.
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Descending

Sorts the rows of the Alarm Summary object's spreadsheet in the descending   order of the attribute that 
is currently displayed in the Sort By field.

Color Tab - Alarm Summary Configuration Dialog Box

The Color tab of the Alarm Summary Configuration dialog box displays   the following items:

Foreground Alarm Color 

Item Description
Color By Status Select this option to color the text and font of alarms using the alarm 

status.
Color By Priority Select this option to color the text and font of alarms using the alarm 

priority.
Unacknowledged 
Alarm Color

Select this check box to display all unacknowledged   alarms in the 
Alarm Summary object with the selected color. This check   box over-
rides all entries listed in the Foreground Alarm Color grid.

Foreground Alarm 
Color grid

Allows you to modify the foreground color and attributes for the alarms 
displayed in the Alarm Summary object.

Background Alarm Color

Item Description
Color By Priority Select this option to color the background of alarms   using the alarm pri-

ority.
Color By Status Select this option to color the background of alarms   using the alarm 

status. 
Blink to Color Select this check box to define a blink color for   the background. You set 

the color for the blink in the Background Color   grid, in the second 
column.

Background Color 
grid

Allows you to modify the background color for the   alarm. The first 
column is the background color, while the second column   (if Blink to 
Color is enabled) is the blink color for the background.   

Run Status Color –   Blink

Specifies whether the Alarm Summary object's run indicator blinks while   the spreadsheet is not paused.  

Pause Status Color –   Blink

Specifies whether the Alarm Summary object's pause indicator blinks   while the spreadsheet is paused.  

Paused Alarm Status Color –   Blink

Specifies whether the Alarm Summary object's pause indicator blinks   when new alarms are received 
while the spreadsheet is paused.  

Column Tab - Alarm Summary Configuration Dialog Box

The Column tab of the Alarm Summary Configuration dialog box displays   the following items:
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Columns Area

Item Description
Available Columns Lists the columns that are available to be added to   the Alarm Summary 

object.  To   add a column, select the column name and click Add. The 
name of the column   appears in the Selected Columns list, and appears 
in the Alarm Summary   object at run-time.

Add Allows you to add the currently selected column in   the Available 
Columns list to the Alarm Summary object.

Remove Allows you to remove the currently selected column   in the Selected 
Columns list from the Alarm Summary object.

Selected Columns Lists the columns that appear in the Alarm Summary   object at run-time. 
To remove a column from the list, select the column   name and click 
Remove. To change the order of the columns, select the   column name 
and use the up and down arrows to move the column to the desired   
positon.

Up Moves the selected column name up in the Selected   Columns list. This 
has the effect of moving the column to the left in   the Alarm Summary 
object at run-time.

Down Moves the selected column name down in the Selected   Columns list. 
This has the effect of moving the column to the right in   the Alarm Sum-
mary object at run-time.

User Definable Columns

Item Description
User Defined Field 
1

Allows you to assign a different ASCII (A_) block   field to the User 
Defined Field 1 column. The default field is A_CUALM.   This field is 
available only if the User Defined Field1 column has been   added to the 
Selected Columns list.

<> (first instance) Changes the ASCII (A_) block field that is represented   by the User 
Defined Field 1 entry in the Selected Columns list to the   field currently 
entered in the User Defined Field.

User Defined Field 
2

Allows you to assign a different ASCII (A_) block   field to the User 
Defined Field 2 column. The default field is A_AUTO.   This field is avail-
able only if the User Defined Field2 column has been   added to the Selec-
ted Columns list.

<> (second 
instance)

Changes the ASCII (A_) block field that is represented   by the User 
Defined Field 2 entry in the Selected Columns list to the   field currently 
entered in the User Defined Field 2 field.

User Defined Field 
Name 1

Specifies the text displayed in the header of the   Alarm Summary 
object's User Defined Field1 column.  The   text you specify cannot 
match the text of any existing column header,   including the text used in 
the User Defined Field2 column header.  The   maximum length of this 
name is 50 characters.  

User Defined Field 
Name 2

Specifies the text displayed in the header of the   Alarm Summary 
object's User Defined Field2 column.  The   text you specify cannot 
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match the text of any existing column header,   including the text used in 
the User Defined Field1 column header.  The   maximum length of this 
name is 50 characters.  

Display Tab - Alarm Summary Configuration Dialog Box

The Display tab of the Alarm Summary Configuration dialog box displays   the following items:

Display Settings 

Item Description

Show Headers Shows/Hides the column names of the Alarm Summary   object.

Show Scroll Bars Enables/Disables horizontal and vertical scroll bars   for the Alarm Sum-
mary object.

Show Row Num-
bers

Shows/Hides the row numbers for each row in the Alarm   Summary 
object.

Show Status Bar Shows/Hides the status bar of the Alarm Summary object.

Show Grid Lines Shows/Hides the spreadsheet grid of the Alarm Summary   object.

Don't Blink Alarms When selected, the Alarm Summary object does not flash new unac-
knowledged alarms in run mode.

Blink Unack 
Alarms

When selected, the Alarm Summary object flashes new   unac-
knowledged alarms at run-time. The rate at which the unacknowledged   
alarms flash is defined by the value in the Blink Rate field.

Reverse Colors On 
Unack Alarms

When selected, the Alarm Summary object reverses the colors of the 
unacknowledged alarms visible in the Alarm Summary object. When an 
alarm is acknowledged, the colors revert to their configured state.

Reverse Colors On 
Ack Alarms

When selected, the Alarm Summary object reverses the colors of the 
acknowledged alarms visible in the Alarm Summary object. While an 
alarm is unacknowledged, the colors are as configured.  When the alarm 
is acknowledged, the colors are reversed. 

Show Current 
Alarm Status

Select this option to show the current alarm status   in the Alarm Sum-
mary window. 

Show Latched 
Alarm Status

Select this option to show the latched alarm status   in the Alarm Sum-
mary window. 
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NOTE: Reversing colors has two different actions depending on whether the Blink To Color option is disabled 
or enabled. If the Blink To Color option is disabled, the text color comes from the Foreground Color table and 
the background color comes from the Background Color table.  When the colors are reversed, the text color 
comes from the Background Color table and the background color comes from the Foreground color table. If 
the Blink To Color option is enabled, the text color comes from the Foreground Color table and the back-
ground color comes from the Background Color table.  When the colors are reversed, the text color still comes 
from the Foreground Color table and the background color comes from the Blink Color table.

Refresh Settings 

Item Description
Alarm Refresh 
Interval

Allows you to configure how often the Alarm Summary   object examines 
the queue for new alarms at run-time.

Data Refresh Inter-
val

Allows you to configure how often the Alarm Summary   object updates 
the alarm values currently displayed at run-time.

Blink Rate If the Blink Unack Alarms option is selected, allows you to configure 
how often an unacknowledged alarm flashes at run-time. The Blink Rate 
ranges from 1 to 10 seconds.  By default, it is 1 second.

Selection Timeout Allows you to configure how long a row in the spreadsheet   remains 
selected at run-time.

Basic Animation Dialog Box

The Basic Animation dialog box displays the following items:

General

Item Description
Object Name Allows you to enter a name for the selected object. The name that 

you   specify appears in the WorkSpace system tree and in the 
Name row of the   VBA Property window.

Description Allows you to enter a description for the selected object. The 
description   that you specify appears in the ToolTip for the object 
(provided that   the Enable ToolTips option is enabled) and in the 
Description row of the   VBA Property window.

Enable Tooltip Select this option to display an on-screen description of the object   
when the pointer pauses on it. You can only use this in con-
junction with   the Enable Highlight option.

Tooltip Option This drop-down list is only available when the Enable   Tooltip 
option is selected. Select the item from the list that specifies   
where the tooltip text comes from: 

 l The object's   Description property (TooltipDescription).

 l The Dynamo's   Description property (Tool-
tipDynamoDescription).

 l From a run mode   tag value description supplied when you 
load tag status symbols for your   picture (Tool-
tipTagStatus).
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Enable Highlight Select this option to display a highlight around the object when the   
pointer is on it. To use the ToolTip option, you must also select 
this   option.

Enable Select Select this check box to allow operators to select the object at 
run-time.

Color

Item Description
Foreground Check Box Select this option to animate the foreground color   property of the 

selected object.  If   this check box is selected, a Foreground 
Color property animation already   exists for this object.

To modify the existing animation, click the Foreground   Color 
Expert button. To remove the Foreground Color animation, clear 
the   check box.

NOTE: Lines,   polylines, and bitmaps do not have foreground color 
properties.

Foreground Button Click this button to animate the foreground color   property of the 
selected object. If the Foreground check box is selected,   click 
this button to modify the existing foreground color animation. 

NOTE: Lines,   polylines, and bitmaps do not have foreground 
color properties.

Edge Check Box Select this option to animate the edge color property   of the selec-
ted object. If this check box is selected, an Edge Color property   
animation already exists for this object.

To modify the existing animation, click the Edge Color   Expert 
button. To remove the Edge Color animation, clear the check 
box.

Edge Button Click this button to animate the edge color property   of the selec-
ted object. If the Edge check box is selected, click this   button to 
modify the existing edge color animation.

Background Check Box Select this option to animate the background color   property of 
the selected object.  If   this check box is selected, a Background 
Color property animation already   exists for this object.

To modify the existing animation, click the Background   Color 
Expert button. To remove the Background Color animation, 
clear the   check box.

Background Button Click this button to animate the background color   property of the 
selected object. If the Background check box is selected,   click 
this button to modify the existing background color animation.

Movement

Item Description
Position Check Box Select this option to animate the Horizontal or Vertical   Position 

property of the selected object. 
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If this check box is selected, a Position property   animation 
already exists for this object. 

To modify the existing animation, click the Position   Expert but-
ton. To remove the Horizontal or Vertical Position animation,   
clear the check box.

Position Button Click this button to animate the Horizontal or Vertical   Position 
property of the selected object. 

If the Position check box is selected, click this   button to modify 
the existing Position animation.

Scale Check Box Select this option to animate the Uniform Height and   Width 
Scale property of the selected object. These animations allow 
you   to scale the object proportionally, by height, or by width. 

If the Scale check box is selected, a Scale property   animation 
already exists for this object.

To modify the existing animation, click the Scale   Expert button. 
To remove the Scale animation, clear the check box.

Scale Button Click this button to animate the Uniform Height and   Width Scale 
property of the selected object. These animations allow you   to 
scale the object proportionally, by height, or by width. 

If the Scale check box is selected, click this button   to modify the 
existing Scale animation.

Rotate Check Box Select this option to animate the RotationAngle property   of the 
selected object.  This   animation allows you to define the angle of 
rotation.  If   the Rotation check box is selected, a RotationAngle 
property animation   already exists for this object. 

To modify the existing animation, click the Rotation   Expert but-
ton. To remove the RotationAngle animation, clear the check   
box.

NOTE: Ovals,   rounded rectangles, and charts do not have rota-
tion properties.

Rotate Button Click this button to animate the RotationAngle property   of the 
selected object. This animation allows you to define the amount   
to rotate an object. If the RotationAngle check box is selected, 
click   this button to modify the existing RotationAngle animation.

NOTE: Ovals,   rounded rectangles, and charts do not have rota-
tion properties.

Fill

Item Description
Fill Percentage Check Box Select this option to animate the Fill property of   the selected 

object.  You   can animate both the Horizontal and Vertical Fill 
properties and specify   whether the Fill animates based on a per-
centage.  
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If the Fill check box is selected, a Fill property   animation already 
exists for this object.  To   modify the existing animation, click the 
Fill Expert button.  To   remove the Fill animation, clear the check 
box.  

Fill Percentage Button Click this button to animate the Fill property of   the selected 
object. You can animate both the Horizontal and Vertical   Fill 
properties and specify whether the Fill animates based on a per-
centage.   If the Fill check box is selected, click this button to 
modify the existing   Fill animation.

Visibility

Item Description
Visible Check Box Select this option to animate the Visible property   of the selected 

object.  This   animation allows you to make an object visible or 
invisible.  If   the Visibility check box is selected, a Visible prop-
erty animation already   exists for this object.  

To modify the existing animation, click the Visibility   Expert but-
ton.  To   remove the Visibility animation, clear the check box.  

Visible Button Click this button to animate the Visible property   of the selected 
object. This animation allows you to make an object visible   or 
invisible. If the Visibility check box is selected, click this button   
to modify the existing Visibility animation.

Additional Animations

Item Description
Advanced Animations 
Check Box

Select this option to open the Advanced Animations   dialog box.  
This   dialog box allows you to access all of the property anim-
ations available   to the selected object and also provides a more 
detailed interface for   adding or modifying property animations.  

If this check box is selected, one or more advanced   animations 
already exist for this object.  

To modify the existing animations, click the Configure   button.  
To   delete the existing Advanced Animations, clear this check 
box.  

Configure Click this button to open the Advanced Animations   dialog box.  
This   dialog box allows you to access all of the property anim-
ations available   to the selected object and also provides a more 
detailed interface for   adding or modifying property animations.  

If the Advanced Animations check box is selected,   one or more 
advanced animations already exist for this object.  

To modify the existing animations, click the Configure   button.  
To   delete the existing Advanced Animations, clear this check 
box.  
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Command

Item Description
Click Check Box Select this option to specify one or more click commands   for 

your object. If this check box is selected, a command script 
already   exists for this object.  

To modify the existing command script, click the Click   button to 
launch the Multiple Command Script Wizard. To delete the exist-
ing   script, clear this check box.

Click Button Click this button to specify one or more click commands   for your 
object. If the Click check box is selected, click this button   to 
modify the script in the Multiple Command Script Wizard.

Button Caption Converter Dialog Box 

The Button Caption Converter Dialog Box allows you to select one or   more button captions (text) on your 
active picture and converts the button   caption text to scale to a new screen resolution. 

Convert Button Caption

Converts the selected button(s)   in the 'Push button found on picture' dialog box.

Find Next

Allows you to confirm the conversion of each button individually.

Convert all

Converts all the selected button text.

Close

Closes the Button Caption Converter dialog box.

Push buttons found on picture 

Lists all the buttons in the active picture that are available for conversion.

NOTE: When the button includes only a bitmap, it is not listed for conversion   as there is no caption to 
convert.

Chart Customization Dialog Box

The Chart Customization dialog box is composed of the following tabs:

 l General   Tab

 l Chart   Tab

General Tab - Chart Customization Dialog Box

The General tab of the Chart Customization dialog box displays the following   items:
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Name

Allows you to enter a specific name for your chart.

Description

Allows you to add a description for your chart.

Help Context ID

Allows you to attribute a help context ID for your own help files.

Highlightable

Allows you to highlight the chart at run time.

Selectable

Allows you to select the chart at run time.

Modifiable

Allows you to modify the chart at run time.

Scroll Direction

Item Description
Scroll Right to Left Specifies that when you scroll the chart, it will   do so from right to 

left.
Scroll Left to Right Specifies that when you scroll the chart, it will   do so from left to 

right.
Reset Allows you to assign a reset value for a left-to-right   scroll. The 

data and its time shifts according to this percentage when   the 
data plot reaches the right edge of the chart.

Appearance

Item Description
Refresh Rate Allows you to specify how quickly a chart updates   the data plot 

at run time.
Historical Update Rate Allows you to specify the rate at which the historical   chart is 

updated. The default rate of zero disables the chart from being   
automatically updated. The rate format is hh:mm:ss. The rate 
limit is   one hour.

Transparent Makes the chart transparent.
Foreground Color To change the foreground color, click this button   to open the 

Select Color dialog box.
Background Color To change the background color, click this button   to open the 

Select Color Dialog box.
Show Multiple Values Allows you to display all of the chart pen's axes   at run time.
Show Multiple Times Allows you to display all of the chart pen's time   scales at run 

time.
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Show Time Cursor Allows you to display all of the chart pen's time   cursors at run 
time.

Show Time Cursor Tool 
Tips

Allows you to display the pens' time cursor ToolTips   at run time.

Zooming

Item Description
Horizontal Allows you to zoom into a chart on its horizontal   axis at run time.
Vertical Allows you to zoom into a chart on its vertical axis   at run time.
Both Allows you to zoom into a chart on both its horizontal   and ver-

tical axes at run time.

Chart Tab - Chart Customization Dialog Box

The Chart tab of the Chart Customization dialog box displays the following   items:

Data Sources

Allows you to add a pen to your chart by double-clicking a blank field   in the list. This in turn allows you to 
select a data source for the pen.

Apply to All Pens

Allows you to apply any properties that you select from this dialog   box to all pens in a chart.

Pen Tab

Item Description
High Limit Allows you to enter the high limit value defined for   the selected data 

source.
Low Limit Allows you to enter the low limit value defined for   the selected data 

source.
Number of 
Decimal Places to 
Display

Allows you to specify the number of decimal places   the pen displays for 
EGU limits. Enter a number from 0-7.

Fetch Limits Specifies whether or not to automatically retrieve   the low and high limits 
assigned to the selected data source at run time.

Show Line Specifies whether or not to display the trend line   for the selected data 
source.

Constant Line Specifies whether or not to display a constant horizontal   line at the cur-
rent value of the pen.

Show Gaps Specifies whether or not to display a blank space   to represent an area in 
a plot where there is no data.

Use Regional Set-
tings

Specifies whether or not to use the Windows Regional   Settings. Dis-
abling this feature allows you to enter user-defined decimal   place set-
tings. By default, this feature is enabled.

Maximum Display 
Points

Allows you to specify how many data points will be   displayed in the 
chart over a given span duration.
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Line Style Allows you to apply a style to the pen's plot line.   The options are:

 l Solid   – Applies a solid pen line style.

 l Dash   – Applies a dashed pen line style.

 l Dot   – Applies a dotted pen line style.

 l DashDot   – Applies a dash-dot combination line style.

 l DashDotDot   – Applies a dash-dot-dot combination line style.
Line Color Allows you to specify the color of the pen's plot   line.
Line Width Allows you to specify the width of a pen's plot line.
Marker Style Allows you to specify a style for the pen's marker   type.
Historical Mode Allows you to determine how iFIX selects data from   a historical data 

source and displays it in the chart, and determines   what each displayed 
value represents. The options are:

 l Sample   – The last valid value found is trended, up to and includ-
ing the start   of the interval.

 l Avg   – The average of all valid data found during the interval is 
trended,   starting at the beginning of the interval, 12:00:00. In this 
case, 4.5   is trended from 12:00:00 to 12:10:00.

 l High   – The highest valid data point value found during the inter-
val is trended,   starting at the beginning of the interval, 12:00:00. 
In this case, 9.0   is trended from 12:00:00 to 12:10:00.

 l Low   – The lowest valid data point value found during the interval 
is   trended, starting at the beginning of the interval, 12:00:00. In 
this   case, 0.0 is trended from 12:00:00 to 12:10:00.]

 l Interpolated   – The data is interpreted by assuming that the line 
between two values   is a straight line. All points along that line are 
estimated except the   starting point and the ending point. Avail-
able for Historian only.

Type This field is informational. You cannot edit this   field.

Time Tab

Item Description
Fixed Date Specifies whether or not to enter a specific date   on which to start the 

display, in the format MM/DD/YY (month/day/year).
Days Before Now Specifies whether or not to enter a number of days   prior to today to start 

the display. Allows you to enter the number of   days prior to today to 
start the display. For example, if you want to   define a time group to dis-
play data collected two days before the current   date, enter 2.

Fixed Time Specifies whether or not to designate a specific time   to start the dis-
play, based on a 24 hour clock.

Lock Time Locks the current Fixed Time, even if you change the   time zone in the 
Date and Time Properties dialog box in the Control Panel.   This field is 
available only when you designate a specific time to start   the display 
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using the Fixed Time field.
Duration Before 
Now

Specifies whether or not to enter the duration prior   to the current time to 
start the display. The minimum duration for a display   is 0 seconds; the 
maximum is 23 hours, 59 minutes, and 59 seconds.

Time Zone Allows you to select the time zone to associate with   the start time. You 
can select a specific time zone, or you can select   the client time (time 
zone for your computer), the server time (time zone   used by the His-
torian server), or the collector time (time zone of the   collector machine). 
The default time zone is that of the client machine.   This field is avail-
able only when Historian is being used.

Adjust for Daylight 
Saving Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   This field is 
available only when Historian is being used.

Days Allows you to enter the duration for the display,   which determines how 
much data to display on the x axis. The minimum duration   for a display 
is 1 second; the maximum is 99 days, 23 hours, 59 minutes,   and 59 
seconds.

Time Displays the time.
Display Mil-
liseconds

Displays milliseconds on the time axis and time cursor   in the chart and 
milliseconds in the (Interval) Time field when Historian   is being used. 
This field is available only when Historian is being used.

X-Axis Tab

Item Description
Show X Axis Specifies whether or not to display the x axis in   the chart.
Number of Labels Allows you to specify how many labels the x axis will   contain. You can 

enter a maximum of 21 labels.
Number of Ticks Allows you to specify how many ticks the x axis will   contain. You can 

enter a maximum of 21 ticks.
Axis Color Allows you to choose a color for the axis.
Show Date Allows you to display the current date in the x axis   of the chart.
Allow Reset of 
Axis Limits

Lets you control changes to the limits on the x (time)   axis in a chart. Ini-
tially, the limits are set to match the time specified   on the Time tab of 
the Chart Customization dialog box. However, when you   select this 
check box, you enable the time axis limits of your chart to   be reset after 
you right-click the object to zoom out. The chart resets   the time axis lim-
its to the values of the Start Time and End properties.

Show Title Specifies whether or not to display the title of the   x axis in the chart.
Title Allows you to specify a title for the x axis in the   chart. You can enter a 

title of up to 255 characters.

Y-Axis Tab

Item Description
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Show Y Axis Specifies whether or not to display the y axis in   the chart.
Number of Labels Allows you to specify how many labels the y axis will   contain. You can 

enter a maximum of 21 labels.
Number of Ticks Allows you to specify how many ticks the x axis will   contain. You can 

enter a maximum of 21 ticks.
Axis Color Allows you to choose a color for the axis.
Allow Reset of 
Axis Limits

Lets you control changes to the limit on the y (value)   axis in a chart. Ini-
tially, the limits are set to match the High and Low   limits specified on the 
Pen tab of the Chart Customization dialog box.   However, when you 
select this check box, you enable the value axis limits   of your chart to 
be reset after you right-click the object to zoom out.   The chart resets the 
value axis limits to the values of the HiLimit and   LoLimit properties.

Show Title Specifies whether or not to display the title of the   x axis in the chart.
Title Allows you to specify a title for the x axis in the   chart. You can enter a 

title of up to 255 characters.

Grid Tab

Item Description
Show Horizontal 
Grid

Specifies whether or not to display the horizontal   grid in a chart.

Number of Lines 
(Horizontal)

Allows you to specify the number of lines in the horizontal   grid. The 
maximum number of lines you can have in your grid is 21.

Grid Color (Hori-
zontal)

Allows you to specify a color for the grid.

Grid Style (Hori-
zontal)

Allows you to apply a style to the chart's horizontal   grid line. The 
options are the same as for the chart's line styles.

Scroll Grid (Hori-
zontal)

Specifies whether or not to scroll the grid.

Show Vertical Grid Specifies whether or not to display the vertical grid   in a chart.
Number of Lines 
(Vertical)

Allows you to specify the number of lines in the vertical   grid. The max-
imum number of lines you can have in your grid is 21.

Grid Color (Vertical) Allows you to specify a color for the grid.
Grid Style (Vertical) Allows you to apply a style to the chart's vertical   grid line. The options 

are the same as for the chart's line styles.

Legend Tab

Item Description
Source Specifies whether or not to display a data source   in the legend.
Description Specifies whether or not to display a description   in the legend.
Value Allows you to enter the number of characters that   represents the length 

of the value.
Units Specifies whether or not to display data units in   the legend.
Mode Specifies whether or not to display a data mode in   the legend.
High Limit Specifies whether or not to display a data high limit   value in the legend.
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Low Limit Specifies whether or not to display a data low limit   value in the legend.
Interval Specifies whether or not to display a data interval   in the legend.
High Over Range Specifies whether or not to display the high data   value of a pen in a spe-

cified time range.
Low Over Range Specifies whether or not to display the low data value   of a pen in a spe-

cified time range.
Average Over 
Range

Specifies whether or not to display the average data   value of a pen in a 
specified time range.

Order Allows you to display the items you select in any   order in the legend 
(left to right). To rearrange the order in the list,   select the item and click 
the Up or Down arrow.

Color Selection Dialog Box

The Color Selection dialog box displays the following items:

Property

Displays the color property (foreground, background, or edge) for which   you are currently defining a 
color.

Color Set

Lists all color sets that are currently configured on your system. You   can add your own color set by click-
ing the New Color Set button, naming   the color set, and customizing the individual colors within the set.

Color Tab

Allows you to attribute a color for the selected object. To change an   object's color, click the Color tab, 
select a color from the color box,   and click OK. Optionally, you can attribute a named color by clicking   
the Name tab, selecting the name of a color from the list, and clicking   OK.

Name Tab

Displays the named colors of the color set listed in the Color Set list.   To change the name of a color, 
double-click it from the list and enter   a new name in the highlighted field.

Customize Color

Allows you to create a unique color from one of the available color   sets listed in the ColorSet list.

NOTE: This button   is disabled if the System Default color set is selected.

New Color Set

Allows you to add a custom color set to the ColorSet list. This button   displays the Add ColorSet dialog 
box.

Create Picture Wizard Dialog Box

© 2024 General Electric Company. All rights reserved. 235



Common Wizard Elements

The Create Picture Wizard guides you when creating pictures in Configure   mode that will appear the 
way you intend in Run mode. Each page in the   Wizard includes the following elements:

 l Preview   Pane – Shows a picture configuration based on the currently selected   options.

 l Help   Button – Launches the Help topics for the Create Picture Wizard.

 l Cancel   Button – Exits the Create Picture Wizard without creating any new   pictures, and without 
changing WorkSpace appearance.

 l Previous   Button – Returns you to the previous page in the Wizard.

 l Next   Button – Sends you to the following page in the Wizard.

 l Finish   Button – Creates the new pictures that you have specified, and   sets the WorkSpace 
appearance that you have specified. This button is   only enabled when the Wizard has collected 
enough information to successfully   create new pictures.

Create Picture Paths

The Create Picture Wizard dialog box displays three paths to create   new pictures. For more information 
on the screens that appear when you   select a path, refer the following sections:

 l Create   Picture(s) from a Predefined Configuration

 l Create   a Custom Picture

 l Create   a Default Untitled Picture

Show WorkSpace Appearance Page

Indicates whether you want to view the WorkSpace Appearance page in   the wizard. This page only 
needs to be accessed once per WorkSpace session.

Do not show this Wizard from the new picture   menu and Exit now

Prevents the wizard from running the next time you select New Picture   from the File menu. The Finish 
Button changes to an OK button, and allows   you to close the wizard.

Create Picture(s) from a Predefined Configuration 

When you select the Create Picture(s) from a Predefined Configuration   option in the first screen of the 
Create Picture Wizard, the wizard then   displays the following screens:

WorkSpace Appearance Screen

This screen provides you with iFIX WorkSpace settings.

Item Description
WorkSpace Full Screen in 
Run Mode

When you select this option, the WorkSpace hides its   title bar, 
menu bar, and status bar in the run environment. If you clear   this 
option, you can select any of the other options on the page.

Show WorkSpace Title Bar Displays the title bar across the top of the screen   in run mode.
Show WorkSpace Menu 
Bar

This is available only if Show WorkSpace Title Bar   is enabled. 
Select this option to display the menu bar across the screen   
under the title bar in run mode.
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Show Status Bar Displays the status bar across the bottom of the screen   in run 
mode.

Choose Configuration Screen

This screen provides you with predefined picture configurations. You   can select a configuration as is, or 
modify it through the Modify Configuration   button. When you highlight a configuration name in the list 
box, the preview   pane displays the configuration.

There are five generic names for predefined pictures: Main, Header,   Footer, Left Navigation, and Face-
plate. If you create a custom picture,   the generic name is Custom. The background color of the generic 
name corresponds   to the color of the picture in the preview pane.

Item Description
Modify Configuration Opens the Modify   Configuration Dialog Box that allows you to 

specify attributes and   sizes for your picture. 
Delete Configuration Deletes the selected configuration from the Choose   Con-

figuration list.

Select Filename(s) Screen

The Select Filename(s) page allows you to assign a filename to each   picture in the configuration. Valid 
filenames must:

 l be alphanumeric

 l begin with an alphabetic   character

 l contain no more than   31 characters

 l contain none of the   following characters: spaces, @, &, $, #, !, or %

 l have a .grf extension

Summary Screen

This page summarizes the settings that will be used to create the picture.

Do not show this Wizard from the new picture menu   Check Box

Prevents the wizard from running the next time you select New Picture   from the File menu (Classic 
view) or from the WorkSpace button (Ribbon   View). The Finish Button changes to an OK button, and 
allows you to close   the wizard.

Create a Custom Picture

When you select the Create a Custom Picture option in the first screen   of the Create Picture Wizard, the 
wizard then displays the following screens:

WorkSpace Appearance Screen

This screen provides you with iFIX WorkSpace settings.

Item Description
WorkSpace Full Screen in 
Run Mode

When you select this option, the WorkSpace hides its   title bar, 
menu bar, and status bar in the run environment. If you clear   this 
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option, you can select any of the other options on the page.
Show WorkSpace Title Bar Displays the title bar across the top of the screen   in run mode.
Show WorkSpace Menu 
Bar

This is available only if Show WorkSpace Title Bar   is enabled. 
Select this option to display the menu bar across the screen   
under the title bar in run mode.

Show Status Bar Displays the status bar across the bottom of the screen   in run 
mode.

Define Custom Picture Screen

Allows you to define a picture by either specifying dimensions or using   the dimensions of an existing pic-
ture. The dimensions that you enter are   checked for range. The preview pane updates to show the pic-
ture that you   are defining. Valid ranges for dimensions:

 l For Width and Height,   dimensions must be greater than zero.

 l For Top and Left,   dimensions can be zero or any positive or negative number.

Settings that you can configure in this area include:

Item Description
Use Specified Dimensions Selecting this check box allows you to specify the   dimensions 

used to create the picture.
Left Distance from the left of the screen to the left edge   of the pic-

ture.
Top Distance from the top of the screen to the top edge   of the pic-

ture.
Width Distance from the left edge of the picture to the   right edge of the 

picture.
Height Distance from the top edge of the picture to the bottom   edge of 

the picture.
Percentage Units Indicates the size and location of the picture is   based on per-

centage of the screen.
Pixel Units Indicates the size and location of the picture is   based on the 

number of pixels.
Use Dimensions of Exist-
ing Picture

Allows you to use an existing picture as the template   for a new 
picture.

Edit Box Enter the picture name that you want to use the dimension   of, or 
click the browse (...) button to select it.

Define Custom Picture Attributes Screen

Item Description
Show Title Bar Adds a title bar to your picture.
Show System Menu Adds system menus to your picture.
Resizable Adds sizing borders to the picture.
Always on Top Configures the window so that it is always on top   when you 

open it.
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Allow this Picture to be 
Cached

Configures the window so that when it is opened and   closed it is 
held in memory and, when reopened, is read from memory.

Background Color Click the Background Color button to set the actual   background 
color of the picture. This color will not appear in the preview   
pane, since the colors in the preview pane are used only in the 
Create   Picture Wizard.

Select Filename(s) Screen

Allows you to specify the filename for the custom picture.

Summary Screen

This page summarizes the settings that will be used to create the picture.

Do not show this Wizard from the new picture menu   Check Box

Prevents the wizard from running the next time you select New Picture   from the File menu (Classic 
view), or from the Application Button (Ribbon   View). The Finish Button changes to an OK button, and 
allows you to close   the wizard.

Create a Default Untitled Picture

When you select the Create a Default Untitled Picture option in the   first screen of the Create Picture 
Wizard, no additional screens appear.   Click Finish to create your picture.

Custom Lookup Table Dialog Box

The Custom Lookup Table dialog box displays the following items:

Source Property Type

Allows you to specify the input data type for which you want to configure   a custom lookup table. You can 
create a custom lookup table for the following   data types: Boolean, integer, float, and string values.

Object Property Type

Allows you to specify the output data type that corresponds to the input   data type specified in the Source 
Property Type field. You can specify   the following data types as output values: Boolean, integer, float, 
string,   and color.

Exact Match

Allows you to specify that incoming data must exactly match the configured   input value in the lookup 
table in order to format the data as the corresponding   output value.

Range Comparison

Allows you to specify that incoming data must fall within a range of   input values in the lookup table in 
order to format the data as the corresponding   output value.
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Grid

Allows you to configure the lookup table for this property. Double-click   any cell in the table to configure 
the input data, output data, and toggle   (blink to) data.

Insert Row

Inserts a new row into the data conversion table.

Modify Row

Displays the New Level Dialog Box   so that you can modify an existing row in the data conversion table.

Delete Row

Deletes an existing row of the data conversion table.

Advanced

Displays the Advanced   Lookup Options Dialog Box that allows you to configure several more   lookup 
options.

Datalink Dialog Box

The Datalink dialog box displays the following items:

Source

Item Description
Edit Box Allows you to enter a data source or expression for   this Data link.

Data source refers to a reference to a source of information,   such 
as iFIX tagnames and historical files, or other OPC-compliant 
data   servers. A data source may also consist of iFIX objects 
(such as shapes,   charts, and variables) or 3rd party OLE con-
trols. Single lettered tags named A through P are not allowed.

Expression refers to constants, data sources, or a   combination 
of constants and data sources that are connected with one   or 
more operators.

Browse Button Use the Browse (...) button to open the Expression   Builder dialog 
box.

Quick Modify Button Use the Quick Modify button to modify a database block   directly 
without launching the Database Manager.

Data Entry

Item Description
Type Allows you to configure whether or not operators can   enter data 

into the Data link at run-time. To allow operators to enter   data 
into the link and write a new value to the database tag during the   
next scan cycle, select In-Place from the list. To prohibit data 
entry   at run-time, select None.
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Confirm When enabled, requires operators to confirm that they   want to 
write data to the database after they have entered a new value   in 
a Data link at run-time. Note that this option is only available if   In-
Place is selected in the Data Entry Type list.

Output Error Mode

Allows you to specify how errors are processed for this Data link. To   accept an input value and return a 
corresponding output value, select   Use Current Output.  To   use values from a lookup table, select Use 
Error Table. If an incoming   input value matches an entry in the table, that output value is returned.

For more information on different error configurations, see the Creating   Pictures electronic book.

Formatting

Item Description
Raw Format Allows you to enter data in its raw (or native C code)   format. If 

this check box is enabled, you can edit the format by entering   a 
C format string in the Format field.  Only the use of %f, %g, %e, 
%s formats is supported. Any other format is forced to %7.2f.

Format Allows you to enter a C format string (%f, %g, %e, %s) to dis-
play data in its raw, native C code format. Only the use of %f, 
%g, %e, %s formats is supported. Any other format is forced 
to %7.2f.

Displays when the Raw Format check box is selected.
Type Allows you to configure whether the data represented   by the 

Data link should be formatted as numeric or alphanumeric data.   
To format numeric data, select Numeric from this list and enter 
an integer   from 0 to 7 in the Whole Digits and Decimal fields. To 
format alpha-numeric   data, select Alpha-Numeric from this list 
and enter the number of lines   and the number of characters per 
line that you want to display in the   Data link.

Displays when the Raw Format check box is cleared.
Justify Allows you to justify the alignment of the Data link's   text. Text 

can be aligned to the left, center, or right of the Data link.

Displays when the Raw Format check box is cleared.
Lines Allows you to enter the number of lines that you want   to display 

in an alpha-numerically formatted Data link.

Displays when the Raw Format check box is cleared.
Char/Lines Allows you to enter the number of characters per line   that you 

want to display in an alpha-numerically formatted Data link.

Displays when the Raw Format check box is cleared.

Edit Picture Dialog Box

The Edit Picture dialog box displays the following items:
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Window Width

Specifies the width of the iFIX picture that is currently open. Window   Width is measured as a per-
centage.

Window Height

Specifies the height of the iFIX picture that is currently open. Window   Height is measured in a per-
centage.

Window Styles

Item Description
Title Bar Select this check box to display the title bar of   the currently 

opened picture.
System Menu Select this check box to display the system menu controls   in the 

title bar of the currently opened picture. These controls allow   you 
to perform such window-related actions as Restore, Move, Size, 
Minimize,   Maximize, Close, and Next.

Resizable Select this check box to indicate that the picture   can be resized.
Always on Top Select this check box to indicate that the current   picture is dis-

played on top of all other windows.
Runtime Visible Select this check box to indicate that the current   picture can be 

viewed in the run-time environment.

Gradient

Item Description
Gradient Enabled Select this check box to apply a gradient to the background   color 

of the current picture.
Linear Select this option to apply a linear gradient fade   type to the back-

ground of the current picture. This option is available   only when 
the Gradient enabled check box is selected.  

Reflected Select this option to apply a reflected gradient fade   type to the 
background of the current picture. This option is available   only 
when the Gradient enabled check box is selected.

Radial Select this option to apply a radial gradient fade   type to the back-
ground of the current picture. This option is available   only when 
the Gradient enabled check box is selected.

Concentric Select this option to apply a concentric gradient   fade type to the 
background of the current picture. This option is available   only 
when the Gradient enabled check box is selected.

Background Color Use this button to open the Select BackgroundColor   dialog box 
to configure the background color of the picture that is currently   
open.

Blend Slider Use this slider to set the percentage of fade color   to blend with 
the current picture's background color. The higher the per-
centage,   the more fade color is visible. This slider is available 
only when the   Gradient enabled check box is selected.
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Fade Color Use this button to open the Select FadeColor   dialog box to con-
figure the fade color of the picture that is currently   open.

Gradient Angle Slider Use this slider to set the angle of the gradient for   the current pic-
ture's background color. This slider is available only   when the 
Gradient enabled check box is selected.

Message Reflection

Some messages are normally sent to the parent control. Under normal   conditions, these messages are 
actually reflected back to the sending   control, so that the control can handle its own message. This mes-
sage   reflection can be handled by the container, which will reflect the messages   back as events. 
However, some controls cannot handle message reflection.   

If your picture contains OLE   controls, and those controls are behaving poorly, try disabling the Message   
Reflection check box.

Disable Caching for this Picture

Select this check box to indicate that when you close the current picture,   it will NOT be loaded into the 
cache. With this check box selected, the   picture file will always be opened directly from the disk drive. 

If you clear this check box, picture caching is enabled for the current   picture, if you also enabled it in the 
User Preferences dialog box on   the Picture tab. With picture caching enabled, iFIX reads and opens the   
previously opened picture from memory. 

Enhanced Chart Customization Dialog Box

The Enhanced Chart Customization dialog box is composed   of the following tabs:

 l General   Tab

 l Data   Sources Tab

 l Chart   Style Tab

 l Subsets   Tab

 l Axis   Tab

 l Font   Tab

 l Color   Tab

 l Plotting   Style Tab

 l Exporting   Enhanced Chart Dialog Box

General Tab - Enhanced Chart Customization Dialog Box

The General tab of the Enhanced Chart Customization   dialog box displays the following items:

Main Title

Allows you to enter a main title for your chart.

Subtitle

Allows you to enter a subtitle for your chart.
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Object Name

Allows you to enter an object name for your chart. This name appears   in the system tree. It must be 
unique and is limited to the standard object   naming conventions.

Description

Allows you to add a description for your chart, which is the standard   object description shared by all 
object types.

Highlightable

Allows you to highlight the chart at run time so it can be modified.

Selectable

Allows you to select the chart at run time. By default, this option   is selected.

Modifiable

Allows you to modify the chart at run time.

Expandable

Allows you to display an Expand or Contract button in the upper right   corner of the chart at run time when 
the cursor hovers over that area.   The Expand button displays the chart in full screen; the Contract button   
resets the chart to its original size and position. The hot keys 'E' and   'C' (upper and lower case) can also 
be used to Expand or Contract the   chart if it has focus.

An Enhanced Chart in thumbnail mode can be expanded and contracted.    Thumbnail   mode can be 
enabled on the Chart Style tab. When expanded, the displayed   chart will not be in thumbnail optimized 
mode, but with user configured   legend settings. When contracted, it will revert back to the thumbnail   set-
tings.

Zooming

Item Description
Horizontal Allows you to zoom into a chart along its horizontal   axis at run 

time.
Vertical Allows you to zoom into a chart along its vertical   axis at run 

time.
Both Allows you to zoom into a chart along both its horizontal   and ver-

tical axes at run time.

Appearance

Item Description
Chart Update Rate Allows you to specify how quickly a chart updates   the data plot 

at run time. When used for real-time data, the fastest update   rate 
is 0.1 seconds and the slowest is 1800 seconds. When used for 
historical   data, the fastest update rate is 5 seconds and the slow-
est is 1800 seconds.

This value is not used for Histogram and SPC charts.   They 
update at the rate of their data sources.
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For XY charts, this rate specified applies to both   real-time and 
historical data sources.

NOTE: If   you choose to use a real-time data source for your XY 
or line/multiline   chart, be aware that when you view it in run 
mode, the first data points   will not be plotted until the time spe-
cified in the Chart Update Rate   field has elapsed. Therefore, 
there will be a lag time between when you   open the chart in run 
mode and when the data is plotted; the first data   point does not 
immediately display. This applies to tag group substitution,   as 
well.

Historical Update Rate Allows you to specify the rate at which the historical   chart is 
updated. The default rate of zero disables the chart from being   
automatically updated. The format is hh:mm:ss. The fastest 
update rate   is five seconds, the slowest, 1800 seconds, or thirty 
minutes.

NOTE: This   field is not available for XY charts.
Number of Points Allows you to specify the number of points in the   chart. Limits 

the chart's data display for each data source to no more   than the 
number specified. 

NOTES:

 l You cannot specify the   number of points for SPC or His-
togram charts.

 l Do not select 2 for the   number of points setting if your chart 
is a Line/Multiline chart and your   chart includes both the 
graph and the table. Doing so will cause the graph   to dis-
appear.

 l If you set the Number   of Points too high, the Hourglass will 
continuously flicker. In most cases,   the default value of 500 
is high enough to accommodate the data points   required 
and low enough to avoid this situation. 

 l For XY charts, using   historical data sources, the value in the 
Number of Points field adjusts   automatically to the value 
closest to the value you entered that will   produce evenly 
spaced data, based on the duration configured and the auto-
matically calculated interval.

Show Time Cursor Allows you to configure whether the time cursor will   display at 
run time as tool tips or as a table.

Charts in upgraded pictures which display the time   cursor will be 
configured as a table. The default for new charts in new   pictures 
is as tool tips.

In run mode, if the time cursor is configured as tool   tips, clicking 
in the plot area freezes the time cursor where clicked;   clicking 
again frees the cursor.

IMPORTANT:   You must also have the Selectable check box 
enabled for the Show Time   Cursor option to work. 
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Show Hover Tool Tip Displays a tool tip for the data point that the mouse   is placed 
over.

IMPORTANT:   You must also have the Selectable check box 
enabled for the Show Hover   Tool Tip option to work. 

Display Milliseconds Displays milliseconds on the time axis and time cursor   in the 
chart and milliseconds in the (Interval) Time field.

NOTE: This   field is not available for XY charts.
Enable Advanced Graph-
ics

Allows you to improve the visual quality of the chart   by per-
mitting the use of bitmap/gradient styles, drop-shadow, 3D 
effects,   a variety of plotting style lines and improved font appear-
ance. Disabling   this option removes smoothing from fonts and 
graphics (Anti-Aliasing),   as well as disabling transparencies 
(Alpha Blending) and removing Bitmap   and Gradient func-
tionality.

IMPORTANT:   Enabling Advanced Graphics may affect chart 
plotting performance.

Enable Quick Configure Allows you to change chart properties while in run   mode without 
having to display the configuration dialog or the right-click   menu. 
The Quick Configure chart properties that can be modified in run   
mode are:

 l Y Axes Style – Hovering   over the upper left hand corner 
of the chart displays Multiple, Stack,   or Single buttons 
that can be used to display the Y Axes of the chart   in the 
specified format.

 l Y Axes Always Visible   – Clicking   the far right column in 
the Data Source Legend area allows you to toggle   
between Yes and No to set the Y Axis Always Visible 
property for each   data source.

 l Plot Visible – Clicking   the next-to-last column in the Data 
Source Legend area allows you to toggle   between Yes 
and No to set the Plot Visible property for each data 
source.

NOTE:   This property applies only to the Line and XY Charts.

Duration

IMPORTANT: These fields   do not apply to XY charts plotting real-time data.

NOTE: Be aware that the x-axis labels on the MultiLine Enhanced Chart are auto calculated for you based on 
the chart dimensions, the maximum labels specified, the chart font size and style, and time format (whether 
milliseconds display).  Because of this auto-calculation, the first label on the x-axis may not indicate the start 
time of the chart data. Similarly, the last label may not indicate the end of chart data (especially when you 
zoom). Even though the start and end labels may not be correct, the duration is for the time you specify.

Item Description
Days Allows you to enter the number of days for the duration   of the dis-

play. This field can be used in conjunction with the following   field.
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The duration for the display determines how much data   to display 
on the x axis. The minimum duration for a display is 1 second;   the 
maximum is 365 days, 23 hours, 59 minutes, and 59 seconds. 
The durations   apply to all chart data sources.

Time Allows you to enter the number of hours, minutes and   seconds for 
the duration for the display. This field can be used in conjunction   
with the preceding field.

Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Data Sources - Enhanced Chart Customization Dialog Box

The Data Sources tab of the Enhanced Chart Customization   dialog box displays the following items:

Data Sources List

Item Description
Data Source 
Selection List

Allows you to add a data source to your chart by double-clicking   a blank 
field in the list. You can apply different legend, data limits,   time con-
straints, and general axis information for each data source that   you add.

Acceptable data sources:

 l X Bar, R Bar,   and S Bar –   SD block (Statistical Data)

 l Histogram – HS block   (Histogram)

 l Line/Multiline   – Any   block

 l XY –   Any block, except SD, HS, ETR, SQT, SQD, or PA

Any changes made to the Data Sources List are applied   immediately; 
clicking Cancel does not undo any changes. 

Allowable number of data sources, by chart type:

 l X Bar, R Bar,   S Bar, and Histogram –   one

 l XY –   two (one for the X axis and one for the Y axis)

 l Line/Multiline   – multiple

NOTES:

 l In the configuration   mode for XY charts, it is possible to enter a real-
time data source with   partial tag group substitutions (for example, 
fix32.@server1@.@tag@.f_cv)   and a historical data source. 
However, in run mode, the quality column   in the legend displays a 
Type Mismatch error code because the data types   do not match.

 l If you change the data   source type for an existing data source, any 
user-modified entries in   the Data, Time, Legend, and Y Axis tabs will 
not re-default. To reset   default values for a data source, the existing 
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data source should be deleted,   and a new data source should be 
added.

 l Proficy Historian Data   Sources using expressions (for example, 
Hist1.INFO10.Simulation00001 +   30) are not supported for 
Enhanced Charts.

Add Allows you to add a data source to the chart.

Delete Allows you to remove a data source from the chart.

Move Up Allows you to move the selected data source up in   position in the list.

Move Down Allows you to move the selected data source down in   position in the list.

X Axis

Allows you to select the data source to use for the X axis.

NOTES:

 l By default, the data   source at the top of the Data Sources List is used for the X axis.

 l This field is only available   for XY charts.

 l Any changes made   to the X axis selection are applied immediately; clicking Cancel does   not undo 
any changes.

Apply to All Data Sources

For XY Charts and XY Chart Dynamos, the Apply to all Data Sources check   box is disabled when you 
select the Time tab. The Time tab is enabled   when the data source selected is the one being used for the 
X-Axis. The   time for Historical data sources is kept in sync so any change to time   is propagated to the 
other historical data sources.

For the Line Chart Dynamo, the Apply to all Data Sources check box is   disabled when you select the 
Time tab. The Time tab is enabled if the   data source is historical or Tag Group. Any change made on a 
Time tab   is synchronized to all other Historical and Tag Group data sources.

For the Line Chart, the Apply to all Data Sources check box is enabled   and available to be checked 
when the Time tab is selected. Unless this   check box is checked and the Apply or OK button is pressed, 
the changes   made to the Time tab apply only to the data source currently selected.

Data Tab

Item Description
High Limit Specify the high limit value for the selected data   source.
Low Limit Specify the low limit value for the selected data   source.
Fetch Limits Select this check box to specify that at run-time,   the low and high limits 

of the selected data source are retrieved. Clear   the check box to activate 
the High and Low Limit fields.

Show Gaps Determines whether a blank space or a line is displayed   to represent an 
area in a plot where there is no data.
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NOTE: This   field is not available for XY charts.
Interpolate Data Causes the lines between plotted data to display as   slopes, rather than 

flat lines. In the following illustration, the line   on the left uses interpolated 
data. The line on the right does not.

NOTE: This   field is not available for XY charts.
Maximum Display 
Points

Specify the number of data points to display for a   data source over a 
given duration; the duration is indicated on the General   Tab. This number 
cannot exceed the number specified on the General Tab   in the Number 
of Points field.

NOTE: This   field is not available for XY charts.
Historical Mode Allows you to determine how iFIX selects data from   a historical data 

source and displays it in the chart, and determines   what each displayed 
value represents. The options are:

 l Sample   – The last valid value found is trended, up to and includ-
ing the start   of the interval.

 l Avg   – The average of all valid data found during the interval is 
trended,   starting at the beginning of the interval, 12:00:00. 

 l High   – The highest valid data point value found during the interval 
is trended,   starting at the beginning of the interval, 12:00:00. 

 l Low   – The lowest valid data point value found during the interval 
is   trended, starting at the beginning of the interval, 12:00:00. 

 l Interpolated   – The data is interpreted by assuming that the line 
between two values   is a straight line. All points along that line are 
estimated except the   starting point and the ending point. 

 l Trend   – The raw data for the minimum and maximum values for 
each interval is   returned.

NOTE: This   field is not available for XY charts.

Time Tab

NOTES:

 l The following fields   are only available if the data source is historical.

 l For XY charts, configuration   choices made for the X axis data source are also applied to the Y axis   
data source.
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 l For Line, X-Bar, R-Bar,   S-Bar, and Histogram Charts, if the Apply To All Data Sources check box   is 
checked, the selections you make on the Time tab are applied to all   data sources.

Item Description
Fixed Date Specifies whether to enter a specific date on which   to start the display.
Days Before Now Specifies whether to enter the number of days prior   to today to start the 

display. Allows you to enter the number of days   prior to today to start 
the display. For example, if you want to define   a time group to display 
data collected two days before the current date,   enter 2.

Fixed Time Specifies whether to designate a specific time to   start the display, 
based on a 24 hour clock.

Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 
Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   the display using the 
Fixed Time field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start 
the display. The minimum duration for a display   is 0 seconds; the max-
imum is 23 hours, 59 minutes, and 59 seconds.

Time Zone Allows you to select the time zone to associate with   the start time. You 
can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   This field is 
available only when Historian is being used.

Duration The Duration fields on this tab are display-only.    The information   dis-
playing in these fields come from the Duration specified on the General   
Tab. The fields specify the amount of data your chart displays along the   
time (X) axes. On the General Tab, you can enter any value from 0 to 
365   days in the Days field.  In   the Time field, enter the time in hours, 
minutes, and seconds.  You   can enter any time up to 23 hours, 59 
minutes, and 59 seconds.

Interval
The Interval fields are display-only.  If   you are using a historical data 
source, the Interval value is automatically   calculated to a time that res-
ults in evenly spaced data, based on the   Duration and Number of Points 
specified on the General tab. 

Legend Tab

NOTE: If the   Apply To All Data Sources check box is checked, the selections you make   on the Legend tab are 
applied to all data sources.

Item Description
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Source Specifies if the chart's data source appears in the   legend.
Description Specifies that a description of the data source appears   in the legend.
Quality Specifies that a description of the quality of the   data source appears in 

the legend. This option is not available for histogram   charts.
Value Specifies that the value of the chart's data source   appear in the legend. 

This option is not available for histogram charts.
Low Limit Specifies that the low limit specified on the Data   Source Data tab 

appears in the legend.
High Limit Specifies that the high limit specified on the Data   Source Data tab 

appears in the legend.
Eng Units Specifies the engineering units for the data source   connected to the 

legend item for the specified pen. This check box is   selected for new 
charts and not selected for old charts.

Y Axis Tab

NOTES:

 l This tab is available   only for Multi-Line and XY charts.

 l Although the Y Axis tab   has fields enabled for an X Axis Data Source, and the various check boxes,   
bullets, and fields can be changed and saved, these selections are ignored   if the data source is 
defined as the X Axis. However, if the X Axis data   source is changed to a Y Axis Data Source, these 
selections are then applied.

This tab allows you to configure multiple Y axes in the XY Chart and   Line Multiline Charts. You can now 
enter up to 16 data sources and individually   configure the Y Axis. Multiple axes can be shown in the 
same graph, or   in graphs stacked one on top of the other. Different plotting methods   are supported for 
each data source.

Select a data source in the Data Sources List and then configure the   following properties for the Y-Axis:

Item Description
Title The Title displayed along the Y Axis for the associated   data source. 
Y Axis Always Vis-
ible

Indicates whether the Y Axis for this data source   is always visible.

NOTE: This applies   only to the Multiple Y Axes Style.
Use Default Y Axis 
Settings

Indicates whether default Y Axis settings are displayed   in the chart for 
the associated data source. The default Y Axis settings   are those con-
figured in the Axis tab. The Title is the only exception.   If it is not empty 
then it will be used rather than the Y Axis Title configured   in Axis tab.

NOTE: Selecting   this option disables all other controls in this group.
Use Data Source 
Limits

If selected, the Y Axis for each data source is set   according to the limits 
of the individual data source.

NOTES:

 l This option   is available only if Use Default Y Axis Settings is 
not selected.

 l Selecting this   option disables all other Data Source Limits con-
trols in this group.
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Linear/Log Indicates whether the Y Axis legend for the associated   data source is 
displayed in a linear or logarithmic style.

NOTE: This   option is available only if Use Default Y Axis Settings is 
not selected.

Min Specifies the minimum value of the Y Axis legend for   the selected data 
source.

NOTE: This   option is not available if Use Default Y Axis Settings or 
Use Data Source   Limits is selected.

Max Specifies the maximum value of the Y Axis legend for   the selected data 
source.

NOTE: This   option is not available if Use Default Y Axis Settings or 
Use Data Source   Limits is selected.

Padding Specifies the spacing between values and the top and   bottom of plot 
area. This can be used to prevent points from being plotted   at the very 
top or bottom of the plot. Valid values are 0-100 and represent   a percent 
of the range (Max – Min). Max and/or Min may be calculated at   run time 
based on selection of the Auto, Max or Min radio buttons.

NOTE: This   option is not available if Min/Max is selected.
Auto, Min, Max, 
Min/Max

Auto allows iFIX to automatically calculate the Max   and Min in run 
mode so that all data points are within the visible area   of the chart for 
the selected data source.

Min allows you to specify the minimum value and automatically   cal-
culate the Max for the selected data source.

Max allows you to specify the maximum value and automatically   cal-
culate the Min for the selected data source.

Min/Max allows you to specify both the minimum and   maximum values 
for the selected data source.

NOTE: This   option is not available if Use Default Y Axis Settings or 
Use Data Source   Limits is selected.

Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Chart Style Tab - Enhanced Chart Customization Dialog Box

The Chart Style tab of the Enhanced Chart Customization   dialog box displays the following items:

Border Style

Item Description
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Shadow Specifies whether the chart has a drop-shadow.
No Border Specifies whether the chart has a border.
Line Specifies whether the chart has a line border.
3D Inset Specifies whether the chart is inset.

Numeric Precision

NOTE: Even though   you set the numeric precision, the number of decimal points specified   does not appear 
on the chart unless it is necessary. For example, if you   specified the use of two decimal places, but all of the 
data values in   your chart are whole numbers, decimal points would not be used because   they are not neces-
sary. This setting does not apply to the axes graduations   and ticks.

Item Description
0 Specifies the use of no decimals.
1 Specifies the use of one decimal.
2 Specifies the use of two decimals.
3 Specifies the use of three decimals.
4 Specifies the use of four decimals.
5 Specifies the use of five decimals.
6 Specifies the use of six decimals.
7 Specifies the use of seven decimals.

Miscellaneous

Item Description
Mark Data Points Specifies whether each individual data point is plotted on the chart.   
Show Plotting 
Style Legend

Specifies whether the legend appears on the chart. The plotting style   
legend shows the line type or point type, color, and data source.

Show Data Source 
Legend

Specifies whether the data source legend appears on the chart. The 
data   source legend appears at the bottom of the chart and includes the 
tag   name and other items specified on the Legend tab of the Data 
Sources tab.

Thumbnail Specifies that only the Title, Sub Title, and Value field of the Data   
Source Legend and the graph portion of the chart is displayed, so that   it 
can be displayed as a thumbnail and still be legible. The Title and   Sub 
Title will only be displayed if the Title or Sub Title is defined,   and the 
Value field of the Data Source Legend will only be displayed if   Show 
Data Source Legend is true.

An Enhanced Chart in thumbnail mode can be expanded and contracted 
using   the Expandable   option on the General tab. When expanded, the 
displayed chart will not   be in thumbnail optimized mode, but with user 
configured legend settings.   When contracted, it will revert back to the 
thumbnail settings.

Truncate Titles Specifies that longer titles on the chart can be truncated   for better legib-
ility.

Include Data 
Labels

Specifies whether data labels are placed next to data   points. The labels 
have the number of decimal places specified in the   Numeric Precision 
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field.

NOTES:

 l This option is available   only for XY charts.

 l Data Labels should be   used only for a small number of points. 
Using Data Labels for a large   number of points can cause charts to 
run slowly in run mode, and potentially   cause the Workspace to 
freeze.

Grid Lines

Item Description
Grid in Front of 
Data

Specifies that the grid appears in front of the data.

Extend Y Axis 
Ticks

Specifies whether Y Axis minor ticks are extended across the chart.

NOTE: You   can choose only one line display option from the following four choices.
None Specifies that no grid lines display on the chart.
X Specifies that only grid lines for the X-axis display on the chart.
Y Specifies that only grid lines for the Y-axis display on the chart.
Both Specifies that grid lines for both the X and Y-axes display on the chart.
NOTE: You   can only choose one line style from the following five options.
Thin Specifies that grid lines are thin. 
Thick Specifies that grid lines are thick.
Dotted Specifies that grid lines are dotted.
Dashed Specifies that grid lines are dashed.
One Pixel Specifies that grid lines are one pixel thick. This setting is primarily   for 

printing, because it only affects the look of a printed chart.

Legend Column Widths

NOTE: The following   settings apply to all data sources legends and not to any individual data   source.

Item Description
Source Specifies the column width of the data source name in the legend.
Description Specifies the column width of the data description in the legend.
Quality Specifies the column width of the data quality in the legend.
Value Specifies the column width of the data value in the legend.
Low Limit Specifies the column width of the low limit in the legend.
High Limit Specifies the column width of the high limit in the legend.
Eng Units Specifies the column width of the Engineering Units in the legend.
Order Allows you to display the items you select in any order in the legend   

(left to right). To rearrange the order in the list, select the item and   click 
the Up or Down arrow.
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X-Axis Label Orientation

Item Description
Auto Specifies that the orientation of the X-axis label is determined by   iFIX.

NOTE: This   option is not available for XY charts.
Vertical Specifies that the X-axis label is vertical.
Horizontal Specifies that the X-axis label is horizontal.
Slanted Specifies that the X-axis label is slanted.

NOTE: This   option is not available for XY charts.

Y Axes Style

NOTE: The Y Axes   Style fields are available only for Multi-Line and XY charts.

Item Description
Multiple Axes Specifies that the graph portion of the chart can be displayed with   mul-

tiple Y axes.
Stack Axes Specifies that the graph portion of the chart is displayed with stacked   Y 

axes..
Single Axis Specifies that the graph portion of the chart is displayed with a single   Y 

axis that accommodates the data range of all the data sources.

Display

NOTE: The Display   fields are not available for the XY chart.

Item Description
Graph Specifies that the graph portion of the chart is displayed.
Table Specifies that the table portion of the chart is displayed in a table.
Both Specifies that both the graph and table portions of the chart are dis-

played.

Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Subsets Tab - Enhanced Chart Customization Dialog Box 

NOTE: The Subsets   tab in the Enhanced Chart Customization dialog box is disabled by default.   To enable 
Subsets for an Enhanced Chart, you must have your Y-Axis Style   set to Single Axis. The Y-Axis Style setting is 
located under the Chart   Style tab of the Enhanced Chart.

The Subsets tab of the Enhanced Chart Customization dialog box, which   appears only when configuring 
a Line Chart, displays the following items:
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Baseline Subsets to Graph

Item Description
Subset Selection 
List

Allows you to select which   subsets will always show in the graph. 
Those data sources not selected   become part of the scrolling subsets. 

Select All Allows you select all data sources to use as subsets.
Clear All Allows you clear all selected data sources from the   subsets to graph.

Scrolling Subsets

Specifies the number of subsets to view in one group. If zero is selected,   no scroll bar appears.

IMPORTANT: Pre-defined   Scrolling Subset Groups should not be used in conjunction with the Quick   Con-
figure buttons. Using the Quick Configure buttons in run mode to   change the Y Axis Style or to change a Data 
Source's Plot Visible option   will overwrite any pre-defined Scrolling Subset Groups.

Example

Assuming there are four data sources, then the following results occur:

Data Sets 
Selected...

Subsets Spe-
cified...

Results...

4 1 Each data source appears   separately in four vertically 
arranged groups in a scrolling chart window.

2 0 Only the two selected data sources appear on a chart.
2 1 Three data sources appear on two charts, which are   arranged 

vertically in a scrolling chart window. 

Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Axis Tab - Enhanced Chart Customization Dialog Box

The Axis tab of the Enhanced Chart Customization dialog   box displays the following items:

Titles and Labels

Item Description
X-Axis Title Allows you to specify the X Axis Title.
Y-Axis Title Allows you to specify the Y Axis Title.
Show X-Axis Allows you to specify how the X-axis grid, labels, and title are displayed   

on the chart.
Show Y-Axis Allows you to specify how the Y-axis grid, labels, and title are displayed   

on the chart.
Max X-Axis Labels Allows you to specify the maximum number (up to 20) of X-Axis labels.    

The chart logic calculates the number of labels to display on the X   Axis 
based on settings such as chart size, duration, and number of points.   
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When a maximum number is specified, the user can have partial control   
over this logic to display not more than the specified number of labels   
regardless of the chart configuration. 

A value of “Unspecified” means the label spacing is automatically con-
trolled   by the chart. 

For pictures created before iFIX 5.5 that are upgraded,   the default value 
is 0. For all other pictures, the default value is 10.   

NOTE: The   Max X-Axis Labels field is only available for the Line Chart.

Y Axis

Item Description
Linear Specifies whether the Y-axis uses linear values.
Log Specifies whether the Y-axis uses log values.
Auto Allows iFIX to automatically scale the Y-axis so that   all data points are 

within the visible area of the chart. 
Min Select to activate the Min field.
Max Select to activate the Max field.
Min/Max Select to activate both the Min and Max fields.
Use Data 
Source Limits

Select to allow iFIX to automatically determine the   minimum and maximum 
axis limits using the limits of all selected data   sources.

Min Allows you to specify the minimum value for the Y-axis.

NOTE: When   you select this option the maximum axis value will be auto-
matically scaled   based on the data points in the chart and padding field.

Max Allows you to specify the maximum value for the Y-axis.

NOTE: when   you select this option the minimum axis value will be auto-
matically scaled   based on the data points in the chart and padding field.

Padding Allows you to set the percentage of the total range   of the Y-axis allocated to 
providing space above and below the highest   and lowest data points when 
the axis values are automatically scaled.   Padding prevents the data points 
from intersecting with the top or the   bottom of the chart. Acceptable values: 
0-100. 

Your selection for Auto, Min, Max, or Min/Max determines   if and where pad-
ding is applied. The selections have the following results:

 l Auto   – padding   is applied to both the bottom and the top of the 
range.

 l Min   – padding   is applied to the top of the range. 

 l Max   – padding   is applied to the bottom of the range. 

 l Min/Max   – padding   is not applied.

X Axis

NOTE: The X Axis   fields are only available for the XY chart.
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Item Description
Linear Specifies whether the X-axis uses linear values.
Log Specifies whether the X-axis uses log values.
Use Data 
Source Limits

Select to allow iFIX to automatically determine the   minimum and maximum 
axis limits using the limits of all selected data   sources.

Clear the checkbox to allow iFIX to automatically   scale the X-axis so that all 
data points are within the visible area of   the chart. In effect, this enables 
auto-scaling. 

Padding Allows you to set the percentage of the total range   of the X-axis allocated to 
providing space above and below the highest   and lowest data points. Pad-
ding prevents the data points from intersecting   with the top or the bottom of 
the chart. Acceptable values: 0-100. 

NOTE: For   XY charts, for the X axis, Use Data Source Limits must not be 
selected   for padding to apply.

Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Font Tab - Enhanced Chart Customization Dialog Box

The Font tab of the Enhanced Chart Customization dialog   box displays the following items:

Chart Font Size

Item Description
Large Specifies that the size of all chart fonts is large.
Medium Specifies that the size of all chart fonts is medium-sized.
Small Specifies that the size of all chart fonts is small.

Font Styles

Item Description
Main Title Specifies the font style for the chart's main title. You can also specify   if 

the title is bold, italic, underlined, or any combination.
Sub-Title Specifies the font style for the chart's sub-title. You can also specify   if 

the title is bold, italic, underlined, or any combination.
Subset / Point / 
Axis Labels

Specifies the font style for the chart's subset, point, and axis labels.   
You can also specify if the title is bold, italic, underlined, or any   com-
bination.

Table Data Specifies the font style for the chart's table data.
Sample Displays a sample of the selected font and typeface options.
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Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Color Tab - Enhanced Chart Customization Dialog Box

The Color tab of the Enhanced Chart Customization dialog   box displays the following items:

Viewing Style

Item Description
Color Specifies that the chart displays in color.
Monochrome Specifies that the chart displays in black, gray and   white.

NOTE: The   axes, legends and time cursor appear in color, even if this 
option is   selected.

Monochrome and 
Symbols

Specifies that the chart displays in black, gray and   white and includes 
symbols in the legend.

NOTE: The   axes, legends and time cursor appear in color, even if this 
option is   selected.

Graph Attributes

Item Description
Desk Foreground Select to allow specification of the color of the   title, sub-titles, and 

legends. 
Desk Background Select to allow specification of the color of the   area behind the graph, 

table, title, sub-titles, and legends.
Shadow Color Select to allow specification of the color of the   drop shadow, if present.
Graph Foreground Select to allow specification of the color of the   graph grid.
Graph Background Select to allow specification of the graph's background   color.
Table Foreground Select to allow specification of the color of the   table's data.
Table Background Select to allow specification of the color of the   table's interior.
Color buttons Click to choose the desired color for selected graph   attributes. Double-

click a color button to define a custom color.

Pre-set Styles

Item Description
Bitmap / Gradient 
Styles

Select to choose a bitmap or gradient style for the   chart.
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Light Inset
(Bitmap / Gradient 
selected)

Medium Inset
(Bitmap / Gradient 
selected)

Dark Inset
(Bitmap / Gradient 
selected)

Light Shadow
(Bitmap / Gradient 
selected)

Medium Shadow
(Bitmap / Gradient 
selected)

Dark Shadow
(Bitmap / Gradient 
selected)
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Light Line
(Bitmap / Gradient 
selected)

Medium Line
(Bitmap / Gradient 
selected)

Dark Line
(Bitmap / Gradient 
selected)

Light No Border
(Bitmap / Gradient 
selected)

Medium No 
Border
(Bitmap / Gradient 
selected)

Dark No Border
(Bitmap / Gradient 
selected)

© 2024 General Electric Company. All rights reserved. 261



Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Plotting Style Tab - Enhanced Chart Customization Dialog Box

The Plotting Style tab of the Enhanced Chart Customization   dialog box displays the following items:

Line Style

Item Description
Subset Selection 
List

Allows you to select the data source that your Color,   Point Type, Plot-
ting Style, and Line Type selections will apply to. 

Colors Click to choose the desired color for the selected   data source. Double-
click a color button to define a custom color.

Point Type Specifies the point type for the selected data source.

NOTE: Point   types appear in the chart only if the Chart Plotting Style 
includes points,   such as Point + Line, for example. 

Line Type Specifies the line type for the selected data source.

Chart Plotting Style

NOTE: The following   styles are available only for Line/Multiline and XY Charts. 

Item Description
Area Specifies that the area under the plot line is filled   with the color selected 

in the Line Style area.

Bar Specifies that data is presented using bars.

Histogram Specifies that data is presented in a histogram.
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NOTE: This   style is not available for XY charts. The Histogram style is 
only valid   for one data source.

Line Specifies that data is presented using lines.

NOTE:  When   two gapped sections surround a single valid data point, 
that isolated   data point is plotted with a point even though the plotting 
style is currently   a line.

Points Specifies that data is presented using points.

Point + Best Fit 
Curve

Specifies that data is presented showing all data   points and plots a best 
fit curve for all points in the chart.

Point + Best Fit 
Curve II

Specifies that data is presented showing all data   points and plots a best 
fit curve for only the currently visible points   in the chart.
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NOTE: This   style is not available for XY charts.
Point + Best Fit 
Line

Specifies that data is presented showing all data   points and plots a best 
fit line for all points in the chart.

Point + Best Fit 
Line II

Specifies that data is presented showing all data   points and plots a best 
fit line for only the currently visible points   in the chart.

NOTE: This   style is not available for XY charts.
Point + Line Specifies that data is presented using points and   lines.

Point + Spline Specifies that data is presented using points and   splines.

Spline Specifies that data is presented using splines.
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Data Shadows

Item Description
Off Specifies that there are no shadows for the chart   data.
Shadow Specifies that there are shadows for the chart data.

NOTE: Shadows   can be applied only to Line/Multiline charts that use 
Area or Bar for   their Plotting Style and to Histograms.

3D Specifies that the chart's data is 3D. 

NOTE: 3D   can be applied only to Histogram charts. It does not work 
with SPC Bar   charts or Line/Multiline charts.

Export

Click to access the Exporting dialog box.

Snapshot

Click to get a maximized static snapshot of the chart, presented at   full-screen size.

Exporting Enhanced Chart Dialog Box 

The Exporting Enhanced Chart dialog box displays the   following items:

Export

Item Description
EMF Specifies EMF file format for chart export.
WMF Specifies WMF file format for chart export.
BMP Specifies BMP file format for chart export.
JPG Specifies JPG file format for chart export.
PNG Specifies PNG file format for chart export.
Text/Data Specifies text/data file format for chart export.

Export Destination

Item Description
Clipboard Specifies that data is exported to the clipboard.
File Specifies that data is exported to a file.
Browse Click to choose a destination file and folder for   export.
Printer Specifies that data is sent to a printer.
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Export Size

Item Description
Full Page 
(available only if 
Printer is selected 
in Export Destin-
ation)

Prints the exported chart on a full page.

No Specific Size
(only available if 
WMF is selected in 
Export) 

Specifies that no specific size is used for the exported   chart.

Pixel
(available only if 
BMP, JPG, or PNG 
is selected in 
Export)

Specifies the unit of measure for the exported chart.   This option is 
auto-selected for BMP, JPG and PNG file format and cannot   be 
deselected.

Millimeters Specifies that the size for the exported chart is   measured in mil-
limeters.

Inches Specifies that the size for the exported chart is   measured in inches.
Points Specifies that the size for the exported chart is   measured in points.
Width Specifies the dimensions for the printed exported   chart.

NOTE: The width/height   aspect ratio must be between .1 and 10.0 to 
avoid generating the error   "This will produce an image that is hard to read. 
Please adjust output   dimensions." For example, a width/height of 30/300 
does not produce   an error, but 30/301 does. Likewise, a width/height of 
300/30 does not   produce an error, but 301/30 does.

The following fields are available only   if Clipboard or File is selected in Export 
Destination.

DPI Specifies the dots per inch. The higher the number   the better the qual-
ity.

Large Font Specifies a large size font is used in exported chart.

Export

Click to export data to selected destination.

Export Enhanced Chart Dialog Box 

The Export Enhanced Chart dialog box displays the   following items:

Export What

Item Description

Data Exports the chart's data.

Data and Labels Exports the chart's data along with the data labels.
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Export Style

Item Description

List Specifies that data is exported in list format.

Tab 
(only available if 
List is selected)

Specifies that data is delimited using a tab.

Comma 
(only available if 
List is selected)

Specifies that data is delimited using a comma.

Table Specifies that data is exported in table format.

Subsets/Points
 (only available if 
Table is selected)

Specifies that data is exported with one row for the point data and 
one additional row for each subset.

Points/Subsets 
(only available if 
Table is selected)

Specifies that data is exported with one row for each point and an 
additional column for each subset.

Numeric Precision

Item Description

Current Pre-
cision

Exports the data using the level of numeric precision specified on the 
Chart Style tab.

Maximum Pre-
cision

Exports the data using the highest level of numeric precision available 
on the Chart Style tab, which is seven decimal places.

Export

Click to export the data.

Global Time Control Configuration Dialog Box

The Global Time Control Configuration dialog box displays the following   items:

Time Definition

Item Description
Click to set the time to now. The value displayed   in this field is applied 
after clicking OK.

Start Time –   Date Enter the date of the start time. The format for the   day comes from your 
local regional settings.
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Start Time –   Time Enter the time of the start time. The format for the   time comes from your 
local regional settings.  

NOTE: The   Start Time Date and Time settings apply to all objects that 
contain historical   animations.

End Time –   Date Enter the date of the end time. The format for the   day comes from your 
local regional settings. This field is only available   if you did not select 
Define Duration.

End Time –   Time Enter the time of the end time. The format for the   time comes from your 
local regional settings. This field is only available   if you did not select 
Define Duration.  

NOTE: The   End Time Date and Time settings apply to all objects that 
contain historical   animations.

Define Duration Select to define the duration of the data, in days,   hours, minutes, and 
seconds. Clear this check box to define the duration   using the Start 
Time and End Time fields.

Days Enter the number of days for the duration. This field   is only available if 
you selected Define Duration.

Hours Enter the number of hours for the duration. This field   is only available if 
you selected Define Duration.

Mins Enter the number of minutes for the duration. This   field is only available 
if you selected Define Duration.

Secs Enter the number of seconds for the duration. This   field is only available 
if you selected Define Duration.

Historical Update Rate

Item Description
Hours Select the number of hours for the historical update   rate.
Mins Select the number of minutes for the historical update   rate.
Secs Select the number of seconds for the historical update   rate.

Scroll Rates

Item Description
Scroll as % of Dur-
ation

Select to set the scroll rate as a percentage of duration.   Clear this check 
box to enter an exact value for the scroll rate. For   example, 1.25 hours, 
or 75 minutes.

Slow Enter the slow scroll value in this field, or use   the arrows to increase or 
decrease the value. The Slow Scroll Value applies   to both the Forward 
and Backward Slow Scroll buttons. By default, this   value is set to 25 per-
cent.  

If the Scroll as % of Duration check box is selected,   this value is a per-
centage. For example, if you enter 10, it means 10   percent of the total 
duration is used for the scroll. 
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If the Scroll as % of Duration check box is cleared,   the number you 
enter is an exact value. For example, if you enter 1.2   and then select the 
Minutes option, the scroll will be a value of 1.2   minutes.  

NOTE: This   value cannot be greater than the value you enter in the Fast 
field.

Slow –   Days Select to set the unit of measure as days. This field   is only available if 
you did not select Scroll as % of Duration.

Slow –   Hours Select to set the unit of measure as hours. This field   is only available if 
you did not select Scroll as % of Duration.

Slow –   Mins Select to set the unit of measure as minutes. This   field is only available 
if you did not select Scroll as % of Duration.

Slow –   Secs Select to set the unit of measure as seconds. This   field is only available 
if you did not select Scroll as % of Duration.

Fast Enter the fast scroll value in this field, or use   the arrows to increase or 
decrease the value. The Fast Scroll Value applies   to both the Forward 
and Backward Fast Scroll buttons. By default, this   value is set to 50 per-
cent.  

If the Scroll as % of Duration check box is selected,   this value is a per-
centage. For example, if you enter 10, it means 10   percent of the total 
duration is used for the scroll. 

If the Scroll as % of Duration check box is cleared,   the number you 
enter is an exact value. For example, if you enter 1.2   and then select the 
Minutes option, the scroll will be a value of 1.2   minutes.  

NOTE: This   value cannot be greater than the value you enter in the 
Slow field.

Fast –   Days Select to set the unit of measure as days. This field   is only available if 
you did not select Scroll as % of Duration.

Fast –   Hours Select to set the unit of measure as hours. This field   is only available if 
you did not select Scroll as % of Duration.

Fast –   Mins Select to set the unit of measure as minutes. This   field is only available 
if you did not select Scroll as % of Duration.

Fast –   Secs Select to set the unit of measure as seconds. This   field is only available 
if you did not select Scroll as % of Duration.

Playback

Item Description
Enable Playback Select this check box to enable playback of Historian data. The His-

torical Update Rate and Scroll Rate functions are unavailable for Play-
back.

By Speed Select this option to playback data by a specified speed factor for a sys-
tem generated frame size for historical data when playback is enabled.

Speed List drop-
down

The speed at which the data is stepped through for the specified time 
period: 1x, 10x, 20x, 40x, 50x, 100x, 200x (with the largest being 200x).  
The higher the speed, the larger the frame size.
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By Frame Select this option to playback data by a specified frame size.  The max-
imum time for playback is 24 hours.

Hours The length in hours of the frame size for playback. Valid values are 0-
23. After you click out of this field, the informational section below is 
updated with the new Playback Time, Total Time, and Speed.

Mins The length of minutes of the frame size for playback. Valid values are 0-
59. After you click out of this field, the informational section below is 
updated with the new Playback Time, Total Time, and Speed.

Secs The length in seconds of the frame size for playback.  Valid values are 0-
59. After you click out of this field, the informational section below is 
updated with the new Playback Time, Total Time, and Speed.

Grid Settings Dialog Box

The Grid Settings dialog box displays the following items:

Show the Grid

Select this check box to shows a grid of evenly spaced dots to help   you guide the placement of objects 
for precise vertical or horizontal   alignment.

Snap to Grid

Select this check box to force the top left corner of every object you   create or move to stick to the 
closest grid point.

Grid Interval

Specifies the amount of space, in pixels, between each evenly spaced   dot in the grid.

Historical Datalink Dialog Box

The Historical Datalink dialog box displays the following items:

Source

Item Description
Edit Box Allows you to enter a data source or expression for   this historical 

data link.

A data source is a reference to a source of information,   such as 
historical files. 

An expression includes constants, data sources, or   a com-
bination of constants and data sources that are connected with 
one   or more operators.

IMPORTANT:   Be aware that while Proficy Historian can store 
both String and Numeric   data, the iFIX data system can only 
retrieve Numeric data for Historical   Datalinks.

Browse Button Use the Browse (...) button to open the Expression   Builder dialog 
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box.
Quick Modify Button Not available.

Show Time Stamp with Data

Select this check box to specify that the Historical Datalink include   the time stamp with the data. The 
time stamp appears only at run-time.   By default, this check box is selected. 

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone associated with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode

Allows you to determine how iFIX selects and   fetches data from a historical data source and, determ-
ines what each displayed   value represents. The options are:
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 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The   current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest is 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
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update. This field can be used in conjunction with the other   fields 
in this area.

Modify Area Dialog Box

The Modify Area dialog box displays the following items:

Available

Lists the alarm areas that are currently available.  To   filter alarms by alarm area, select the area(s) from 
this list and select   the In or Not In option button.  

In

Allows you to filter alarms by the alarm areas that are currently selected   in the Available list.  When   this 
option is selected, the Alarm Summary object displays only those   alarms from the selected alarm areas.  

Not In

Allows you to filter alarms by the alarm areas that are currently selected   in the Available list.  When   this 
option is selected, the Alarm Summary object ignores all alarms from   the selected alarm areas.  

Add Area Not Currently in List Edit Box

Allows you to add an alarm area name to the Available list, if it does   not appear by default.  Enter   the 
alarm area name in this field and click Add to add it to the list.    

Add Button

Allows you to add an alarm area name to the Available list, if it does   not appear by default.  Enter   the 
alarm area name in the Add Area Not Currently In List field and click   this button to add it to the Available 
list.  

Modify Configuration Dialog Box

You access the Modify Configuration dialog box from the Create Picture   Wizard. The Modify Con-
figuration dialog box displays the following items:

Attributes Tab

Item Description
Show Title Bar Adds a title bar to your picture.
Show System Menu Adds system menus to your picture.
Resizable Adds sizing borders to the picture.
Always on Top Configures the window so that it is always on top   when you 

open it.
Allow this Picture to be 
Cached

Configures the window so that when it is opened and   closed it is 
held in memory and, when reopened, is read from memory.

Background Color Click the Background Color button to set the actual   background 
color of the picture. This color will not appear in the preview   
pane, since the colors in the preview pane are used only in the 
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Create   Picture Wizard.

Sizes Tab

Item Description
Left Distance from the left of the screen to the left edge   of the pic-

ture.
Top Distance from the top of the screen to the top edge   of the pic-

ture.
Width Distance from the left edge of the picture to the   right edge of the 

picture.
Height Distance from the top edge of the picture to the bottom   edge of 

the picture.
Percentage Units Indicates the size and location of the picture is   based on per-

centage of the screen.
Pixel Units Indicates the size and location of the picture is   based on the 

number of pixels.

Help

Displays the Help for the current topic.

Save

Saves the changes for this picture only.

Save As

Saves the current options as a new configuration. When you select this   option, the Enter New Con-
figuration Name dialog box appears. Enter the   name for the new configuration (up to 80 characters) in the 
Name field,   then click OK to return to the Modify Configuration dialog box.

Return to Wizard

Closes the Modify Configuration dialog box and returns to the Create   Picture Wizard.

Modify Pipe Characteristics Dialog Box

The Modify Pipe Characteristics dialog box display the following items:

Preview

Displays a preview of the object with the properties you select.

Start Cap

Specifies the start cap you want to apply to the selected pipe. Start   caps can be round, square, hori-
zontal-diagonal, or vertical-diagonal.   Start caps are determined by the point where you start the pipe 
drawing.
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End Cap

Specifies the end cap you want to apply to the selected pipe. End caps   can be round, square, horizontal-
diagonal, or vertical-diagonal. End caps   are determined by the point where you end the pipe drawing.

Elbow

Specifies the elbow style you want to apply to the selected pipe. Elbow   styles can be either round or 
square.

Foreground

Click this button to open the Select Color dialog box where you can   choose the foreground color for the 
selected object.

Blend Slider

Move this slider to apply the desired amount of fade color to the selected   foreground type.

Fade

Click this button to open the Select Color dialog box where you can   choose the fade color for the selec-
ted object.

Edge Style

Specifies the edge style you want to apply to the selected pipe. Edge   styles for pipes can be either solid 
or none.

Fill Style

Specifies the fill style you want to apply to the selected pipe. Fill   styles for pipes can be either solid or 
gradient. If you select Gradient,   the fade type of the pipe defaults to reflected, and cannot be changed.

Thickness

Specifies the thickness you want to apply to the selected pipe. Pipe   thickness can range from 10 to 300 
pixels.

Edge Width

Specifies the edge width, in pixels, you want to apply to the selected   pipe. Edge widths can range from 1 
to 200 pixels.

New Level Dialog Box

The New Level dialog box displays the following items:

Low

If configuring an exact match data conversion table, this field allows   you to specify the exact value that 
incoming data must match in order   to format the data as the corresponding output value. If configuring a   
range comparison data conversion table, this field allows you to specify   the low value of the range that 
incoming data must match in order to format   the data as the corresponding output value.  
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High

Allows you to specify the high value of the range that incoming data   must match in order to format the 
data as the corresponding output value.    

Primary

Allows you to specify the output value to which you want to convert   the input value or range of values in 
the lookup table.  

Toggle

Allows you to specify a second output value to which you want to convert   the input value or range of val-
ues in the lookup table, essentially providing   a second animation for the object.  

Select BackgroundColor Dialog Box

The Select BackgroundColor dialog box displays the following items:

Property

Displays the color property (foreground, background, or edge) for which   you are currently defining a 
color.

Color Set

Lists all color sets that are currently configured on your system. You   can add your own customized color 
set by clicking the Color button on   the Toolbar to bring up the Color Selection dialog box, then clicking   
the New Color Set button. 

Color Tab

Allows you to attribute a color for the selected object. To change an   object's color, click the Color tab, 
select a color from the color box,   and click OK. Optionally, you can attribute a named color by clicking   
the Name tab, selecting the name of a color from the list, and clicking   OK.

Name Tab

Displays the named colors of the color set listed in the Color Set list.   To change the name of a color, 
double-click it from the list and enter   a new name in the highlighted field.

Select Color Dialog Box

The Select a Color dialog box displays the following items:

Property

Displays the color property (foreground, background, or edge) for which   you are currently defining a 
color.

Color Set

Lists all color sets that are currently configured on your system. You   can add your own color set by click-
ing the New Color Set button, naming   the color set, and customizing the individual colors within the set.
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Color Tab

Allows you to attribute a color for the selected object. To change an   object's color, click the Color tab, 
select a color from the color box,   and click OK. Optionally, you can attribute a named color by clicking   
the Name tab, selecting the name of a color from the list, and clicking   OK.

Name Tab

Displays the named colors of the color set listed in the Color Set list.   To change the name of a color, 
double-click it from the list and enter   a new name in the highlighted field.

Select EdgeColor Dialog Box

The Select EdgeColor dialog box displays the following items:

Property

Displays the color property (foreground, background, or edge) for which   you are currently defining a 
color.

Color Set

Lists all color sets that are currently configured on your system. You   can add your own customized color 
set by clicking the Color button on   the Toolbar (Classic view) or on the Format tab, in the Styles group,   
by clicking Color Selections (Ribbon view) to bring up the Color Selection   dialog box, then clicking the 
New Color Set button. 

Color Tab

Allows you to attribute a color for the selected object. To change an   object's color, click the Color tab, 
select a color from the color box,   and click OK. Optionally, you can attribute a named color by clicking   
the Name tab, selecting the name of a color from the list, and clicking   OK.

Name Tab

Displays the named colors of the color set listed in the Color Set list.   To change the name of a color, 
double-click it from the list and enter   a new name in the highlighted field.

Select FadeColor Dialog Box

The Select FadeColor dialog box displays the following items:

Preview

Displays a preview of the object with the properties you select.

Linear

Select this option to apply a linear fade effect to the selected fade   color.

Reflected

Select this option to apply a reflected fade effect to the selected   fade color.

© 2024 General Electric Company. All rights reserved. 277



Radial

Select this option to apply a radial fade effect to the selected fade   color.

Concentric

Select this option to apply a concentric fade effect to the selected   fade color.

Foreground

Click this button to open the Select Color dialog box where you can   choose the foreground color for the 
selected object.

Blend Slider

Move this slider to apply the desired amount of fade color to the selected   fade type.

Fade

Click this button to open the Select Color dialog box where you can   choose the fade color for the selec-
ted object.

Gradient Angle Slider

Move this slider to apply the desired angle of fade color to the selected   fade type.

Select ForegroundColor Dialog Box

The Select ForegroundColor dialog box displays different items, depending   on whether the object that 
has been selected has a gradient color fill   or not.  Consult   the following tables for descriptions in each 
case:

Gradient Color Fill

Item Description

Preview Displays a preview of the object with the properties   you select.

Linear Select this option to apply a linear fade effect to   the selected fade color.

Reflected Select this option to apply a reflected fade effect   to the selected fade color.

Radial Select this option to apply a radial fade effect to   the selected fade color.

Concentric Select this option to apply a concentric fade effect   to the selected fade color.

Foreground Click this button to open the Select Color dialog   box where you can choose the 
foreground color for the selected object.

Blend Slider Move this slider to apply the desired amount of fade   color to the selected fade 
type.
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Fade Click this button to open the Select Color dialog   box where you can choose the 
fade color for the selected object.

Gradient 
Angle Slider

Move this slider to apply the desired angle of fade   color to the selected fade type.

Non-Gradient Color Fill

Item Description

Property Displays the color property (foreground, background,   or edge) for which you are cur-
rently defining a color.

Color 
Set

Lists all color sets that are currently configured   on your system. You can add your own 
customized color set by clicking   the Color button on the Toolbar to bring up the Color 
Selection dialog   box, then clicking the New Color Set button. 

Color 
Tab

Allows you to attribute a color for the selected object.   To change an object's color, click 
the Color tab, select a color from   the color box, and click OK. Optionally, you can attrib-
ute a named color   by clicking the Name tab, selecting the name of a color from the list,   
and clicking OK.

Name 
Tab

Displays the named colors of the color set listed   in the Color Set list. To change the 
name of a color, double-click it   from the list and enter a new name in the highlighted 
field.

Shelve Alarm Dialog Box

The Shelve Alarm dialog box contains the following items:

Preset Duration

If you select this option, you can choose from up to five preselected durations.

Maximum Duration

Select this option to shelve the alarm for the maximum amount of time defined by the associated policy.

Custom Duration

Select this option to enter a specific amount of time to shelve the alarm.

Shelve

Select this button to shelve all alarms that appear in the Alarm List.

Shelve Multiple Alarms Dialog Box

The Shelve Multiple Alarms dialog box contains the following items: 
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Preset Duration

If you select this option, you can choose from up to five preselected durations to shelve the selected 
alarms.

Maximum Duration

Select this option to shelve the selected alarms for the maximum amount of time defined by the asso-
ciated policy.

Custom Duration

Select this option to enter a specific amount of time to shelve the selected alarms.

Alarm List

The alarms selected in the Alarm Summary list that you want to shelve.

Shelve

Select this button to shelve all alarms that appear in the Alarm List.

Upgrade Pictures to Screen Independent Enhanced Coordinate Dialog Box

The Upgrading Pictures to Screen Independent Enhanced Coordinates Dialog   Box allows you to 
upgrade one (or more) picture or Dynamo Set from the   legacy Logical Coordinate System to the 
Enhanced Coordinate System. This   dialog box displays the following items:

File Type 

Allows you to select the file type to display in the Select Files window.   You can select Pictures or 
Dynamo Sets or both. 

Picture and Dynamo Set Folder Path

Lists the path to the folder that contains the pictures and/or Dynamo   Sets you want to upgrade to 
Enhanced Coordinates, or to restore to Logical   Coordinate System.

Browse (....)

Allows you to select a different folder that contains the files you   want to upgrade or restore.  

Refresh File List

Updates the files in the Select Files window to reflect eligible files   in the folder you selected.

Upgrade Files

Upgrades the selected files to the screen independent Enhanced Coordinates   System.  By   default, this 
button is enabled when the dialog box opens.

Restore Files from Backup

Restores selected files from the Backup folder.  When   you select this option, files that are eligible for res-
toration are listed   in the Select Files window.
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Select Files 

Lists files that are eligible for upgrading or restoration. Files eligible   for upgrading include files that are not 
using the Enhanced Coordinates   System and that are not open in the iFIX WorkSpace.  By   default, the 
picture files in your default directory display. Files that   are eligible for restoration are those files that have 
been upgraded and   for which a backup file exists in the Backup folder.

Buttons

Button Description
Select All Selects all the files listed in the Select Files window.
Deselect   All Clears all the files selected in the Select Files   window.
Upgrade Files Upgrades pictures and/or Dynamo Sets using the Logical   Coordinate 

System to the Enhanced Coordinate System.
Restore Files Restores the upgraded picture and/or Dynamo Set to   the previously 

saved file in the Backup folder when the file exists. All   changes made to 
the file since the upgrade will be lost. After the restoration   operation is 
completed, the restored files are removed from the list in   the Select 
Files window and are returned to the list of files eligible   for upgrading.

 

How Do I...

The following sections explain how to work with pictures in the    iFIX WorkSpace:

 l Working   with Objects

 l Working   with Charts

 l Working   with Enhanced Charts

 l Working   with the Alarm Summary Object

 l Working   with Groups

 l Using   Color

Click a section above for steps on how to use or configure this part   of a picture.

Working with Objects 

In the iFIX WorkSpace, you can perform the following steps with   objects:

 l Adding,   Drawing, and Creating Objects

 l Manipulating   Objects

 

Adding Charts to Pictures
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 To add a chart   to your picture:

 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the desired chart   button. 

-Or-

In Ribbon view, on the Insert tab, in the   Charts group, click the desired chart type. 

-Or-

If the Toolbox is enabled, click the Chart   button on the Toolbox.

The cursor changes to a plus sign.

 2. Click and drag the   mouse to define an area of the picture where you want to place the chart,   and 
release the mouse.

TIP:   To add multiple charts, double-click the desired chart button on the Toolbox.   When you are done 
adding charts, press ESC, click another button, or click   the pointer selection tool in the Toolbox.

 

Adding, Drawing, and Creating Objects 

In the iFIX WorkSpace, you can perform the following steps to   add, draw, or create objects:

 l Adding   Charts to Pictures

 l Adding   Text to Pictures

 l Adding   Bitmaps to Pictures

 l Adding   Data Links to Pictures

 l Adding   Data Links Using the Data Entry Expert

 l Adding   Historical Data Links to Pictures

 l Adding   the Current Time to Pictures

 l Adding   the Current Date to Pictures

 l Drawing   Rectangles, Rounded Rectangles, Ovals, Pipes, and Lines

 l Drawing   Polylines and Polygons

 l Drawing   Arcs, Chords, and Pies

 l Creating   Variable Objects

 l Creating   New Objects from Files

 l Creating   New OLE Objects

 l Creating   a Control for a New OLE Object

 l Creating   Timer Objects

 l Creating   Event Objects

 l Create   a Custom Lookup Table

 l Selecting   Commands Using the Multiple Command Script Wizard

 

Adding Text to Pictures
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 To add text to   your picture:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Text button. 

-Or-

In Ribbon view, on the Insert tab, in the   Object/Links group, click Object/Links, and then click 
Text. 

-Or-

If the Toolbox is enabled, click the Text   button on the Toolbox.

The cursor changes to an I-beam.

 2. Position the cursor   where you want the text to appear.

 3. Enter the text you   want. Use <Backspace> to delete the text and <Enter> to start   a new line.

TIPS:

 l To add multiple   text objects, double-click the Text button on the Toolbox. Place the cursor   
where you want to add the first text object and enter your text. Click   outside the text object or 
press ESC, and then place the cursor where   you want to add the second object. Repeat these 
steps for each text object   you want to add.

When you   are done adding text objects click the Text button again, the pointer   selection tool, or 
another button in the Toolbox.

 l To edit   the text within a text object, you can double-click the text object, or   right-click the text 
object and select Edit Text from the pop-up menu   that appears.

 

Adding Bitmaps to Pictures

 To add a bitmap   image to your picture:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Bitmap button.   

-Or-

In Ribbon view, on the Insert tab, in the   Object/Links group, click Object/Links, and then click Bit-
map. 

-Or-

If the Toolbox is enabled, click the Bitmap   button on the Toolbox.

The cursor changes to a plus sign.

 2. Select a file from   the Open dialog box and click Open. 

TIP:   To add multiple bitmaps, double-click the Bitmap button on the Toolbox.   When you are done 
adding bitmaps, press ESC, click another button, or   click the pointer selection tool in the toolbox.

 

Adding Data Links to Pictures
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 To add a data   link to your picture:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Datalink Stamper   but-

ton. 

-Or-

In Ribbon view, from the Insert tab in Objects/Links   group, click Objects/Links, and then click 
Datalink. 

-Or-

If the Toolbox is enabled, click the Datalink   button on the Toolbox.

 2. In the Source field,   enter a data source for the data link. To use the Expression Builder,   click the 
Browse button.

 3. To enable data entry   on the data link, select In-Place from the Type field's drop-down menu.   If 
you want confirmation from the operator when the value is changed,   select the Confirm check 
box.

 4. In the Formatting   area, select the type of data you want to display from the Type field's   drop-
down menu. 

For numeric data, enter an integer between   0 and 7 to represent the number of whole digits (those 
before the decimal   point) and decimal digits (those after the decimal point) in the Whole   Digits 
and Decimal fields, respectively. If needed, justify the data by   making the appropriate selection 
from the Justify drop-down menu.

Although you can enter an integer between   0 and 40 in the Whole Digits field, when you view the 
data link in Run   mode the number of digits is truncated to at most 7. 

For alphanumeric data, enter the number   of lines and the number of characters per lines in the 
Lines and Chars/Lines   fields, respectively. If desired, justify the data by making the appropriate   
selection from the Justify drop-down menu.

For raw data, select the Raw Format check   box and enter the format in the Format field.

NOTE:  To format a data link to display scientific   notation, first select a F_CV, E_CV or A_CV field, 
enable the Raw Format   check box, and specify %e in format field. F_CV and E_CV datalinks using   %e 
raw format, by default, display 6 places after the decimal point. To   display more places after the 
decimal point, for example 15, change %e   to %1.15e. A_CV datalinks using %e raw format will always 
display 15 places   after decimal point. To display a leading zero in the link, use the F_CV   field and the 
raw format similar to %02.2f.

 5. In the Error Configuration   area, select how you want output errors to be defined in the Output 
Error   Mode field. To define errors through an error table, select Use Error   Table. To define errors 
using the current output value, select Use Current   Output.

 6. Click OK. The cursor   changes to a stamper. 

 7. Position the cursor   where you want to place the data link, and click the mouse. The data link   
appears in the picture. The size of the data link is determined both by   the settings you chose in 
the Datalink dialog box and by the font size   you set in the User Preferences dialog box. 

TIP:   In Classic view, access the User Preferences dialog box from the WorkSpace   menu. In Ribbon 
view, access User Preferences from the Home tab, in the   WorkSpace group, in the Settings list. Set the 
font size on the Shape   Preferences tab. 

NOTE:   If you create a data link by selecting Datalink from the Insert menu (Classic   View), or by select-
ing it from the Insert tab, in the Objects/Links group,   in the Objects/Links list (Ribbon view), you will first 
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sketch the size   of the data link, then configure the content of the data link as described   in steps 2 
through 5.

 

Adding Data Links Using the Data Entry Expert

 To add a data   link using the Data Entry Expert:
 1. In the iFIX WorkSpace,   double-click a Data link. 

 2. In the Data Entry   Type field of the Datalink dialog box, select None and click OK.

NOTE:   If you set the Data Entry Type field to In-Place, unexpected results may   occur.

 3. In Classic view,   on the Standard toolbar, click the Task Wizard button. 

-Or-

In Ribbon view, on the Tools tab, in the   Tasks/Experts group, click the Tasks/Experts dialog box 
launcher. 

 4. From the Task Categories   list, select Data Entry Expert and click Perform Task. 

 5. In the Data Source   field, enter a data source for the data link. To use the Expression Builder,   click 
the Browse button.

 6. In the Choose Data   Entry Method area, select the appropriate data entry option.

 7. Set the values of   the fields corresponding to the data entry method you chose.

 8. Click OK.

 

Adding Historical Datalinks to Pictures

 To add a historical   datalink to your picture:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Historical   Datalink 

Stamper button. 

-Or-

In Ribbon view, from the Insert tab in Objects/Links   group, click Objects/Links, and then click 
Historical Datalink. 

-Or-

If the Toolbox is enabled, click the Historical   Datalink button on the Toolbox.

 2. In the Source field,   enter a data source for the historical data link. To use the Expression   Builder, 
click the Browse button.

IMPORTANT:   Be aware that while Proficy Historian can store both String and Numeric   data, the iFIX 
data system can only retrieve Numeric data for Historical   Datalinks.

TIP:   To display a one-hour average in your historical data link, in Historian,   create a calculation tag to 
calculate the one-hour average. Then, select   the tag that you created when choosing the data source 
for your historical   data link.

 3. To display a time   stamp with the historical datalink, select the Show Time stamp With Data   
check box. To hide the time stamp, clear the Show Time stamp With Data   check box.

© 2024 General Electric Company. All rights reserved. 285



 4. From the Historical   Mode list, select the data type to display. If you selected Current Value,   go to 
step 9. Otherwise, proceed to step 5.

 5. In the Start Date   area, choose select either Fixed Date or Days Before Now to set when the   date 
for the display to begin and enter the desired time or value.

 6. In the Start Time   area, choose either Fixed Time or Duration Before Now to set the start   time for 
the data display and enter the desired time or value. 

 7. Optionally, to configure   the historical datalink to open at the Fixed Time and to ignore changes   to 
the time zone in the Date and Time Properties dialog box in the Control   Panel, select Lock Time.

 8. Optionally, to adjust   for daylight saving time, if it is not already selected, click Adjust   for Daylight 
Savings Time and select a time zone from the Time Zone list.

 9. In Duration area,   select or enter the time range for the data.

 10. In the Update Rate   area, select or enter the update rate for the data.

 11. Click OK. The cursor   changes to a stamper. 

 12. Position the cursor   where you want to place the historical data link, and click the mouse.   The his-
torical data link appears in the picture. 

Adding the Current Time to Pictures

 To add the current   time to your picture:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Time button. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Current Time.   

-Or-

If the Toolbox is enabled, click the Time   button on the Toolbox.

The cursor changes to a stamper.

 2. Position the cursor   where you want the time to appear and click again.

TIP:   To add multiple instances of the current time, double-click the Time button   on the Toolbox. When 
you are done adding instances, press ESC, click another   button, or click the pointer selection tool in 
the Toolbox.

 

Adding the Current Date to Pictures

 To add the current   date to your picture:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Date button. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Current Date.   

-Or-
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If the Toolbox is enabled, click the Date   button on the Toolbox.

The cursor changes to a stamper.

 2. Position the cursor   where you want the date to appear and click again.

TIP:   To add multiple instances of the current date, double-click the Date button   on the Toolbox. When 
you are done adding instances, press ESC, click another   button, or click the pointer selection tool in 
the Toolbox.

 

Drawing Rectangles, Rounded Rectangles, Ovals, Pipes, and Lines

 To draw a rectangle,   rounded rectangle, oval, pipe, or line:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the appropriate button.   

-Or-

In Ribbon view, on the Insert tab, in the   Shapes group, click Shapes, and then click the desired 
shape. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The cursor changes to a plus sign.

 2. Place the cursor   where you want to draw the shape.

 3. Click and drag in   the picture until the shape is the desired size.

TIP:   To add multiple rectangles, rounded rectangles, ovals, pipes, or lines,   double-click the appro-
priate button on the Toolbox. When you are done   adding the objects, press ESC, click another button, 
or click the pointer   selection tool in the Toolbox.

 

Drawing Polylines and Polygons

 To draw a polyline   or polygon:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Polyline or Polygon   but-

ton. 

-Or-

In Ribbon view, on the Insert tab, in the   Shapes group, click Shapes, and then click Polyline or 
Polygon. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The cursor changes to a plus sign.

 2. Place the cursor   where you want to start your polyline or polygon.

 3. Click once for each   point you want in the polyline or polygon. Double-click to end the shape.
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TIP:   To add multiple polylines or polygons, double-click the appropriate button   on the Toolbox. When 
you are done adding the objects, press ESC, click   another button, or click the pointer selection tool in 
the Toolbox.

 

Drawing Arcs, Chords, and Pies

 To draw an arc,   chord, or pie:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Arc, Chord, or   Pie but-

ton. 

-Or-

In Ribbon view, on the Insert tab, in the   Shapes group, click Shapes, and then click the Arc, 
Chord, or Pie. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The cursor changes to a plus sign.

 2. Position the cursor   where you want the first point of the shape to appear and click the mouse.

 3. Drag the cursor where   you want the second point of the shape to appear and click the mouse.

 4. Move the cursor to   define the height and width of the shape and click again.

TIP:   To add multiple arcs, chords, or pies, double-click the appropriate button   on the Toolbox. When 
you are done adding the objects, press ESC, click   another button, or click the pointer selection tool in 
the Toolbox.

 

Creating Variable Objects

 To create a variable   object:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Variable Object   button. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Variable.

-Or-

If the Toolbox is enabled, click the Variable   Object button on the Toolbox.

 2. Complete the fields   on the Create a Variable Object dialog box. For more information on these   
fields, click Help.

 

Creating New Objects from Files
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 To create a new   object from a file:
 1. In Classic view,   in the iFIX WorkSpace, on the Insert menu, click the OLE Object. 

-Or-

In Ribbon View, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
OLE Object. 

 2. Select the Create   from File option.

 3. In the File field,   enter a directory path and file name, or click Browse to search available   drives for 
a file.

 

Creating New OLE Objects

 To create a new   OLE object:
 1. In Classic view,   in the iFIX WorkSpace, on the Insert menu, click the OLE Object. 

-Or-

In Ribbon View, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
OLE Object. 

 2. Select the Create   New option.

 3. In the Object Type   list box, double-click the object you want to create.

 

Creating a Control for a New OLE Object

 To create a control   for a new OLE object:
 1. In Classic view,   in the iFIX WorkSpace, on the Insert menu, click the OLE Object. 

-Or-

In Ribbon View, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
OLE Object. 

 2. Select the Create   Control option.

 3. Click OK to create   the control.

 

Creating Timer Objects

 To create a timer   object:
 1. In Classic view,   in the iFIX WorkSpace, on the Shapes toolbar, click the Timer Object button.   

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Timer.
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-Or-

If the Toolbox is enabled, click the Timer   button on the Toolbox.

 2. Complete the fields   on the Create a Timer Object dialog box.
 

Creating Event Objects

 To create an   event object:
 1. In Classic view,   on the Shapes toolbar, click the Event Object button. 

-Or-

In Ribbon view, from the Insert tab, in   the Objects/Links group, click Objects/Links, and then 
click Event. 

-Or-

If the Toolbox is enabled, click the Event   Object button on the Toolbox.

 2. Complete the fields   on the Event Object dialog box.

 

Selecting Commands Using the Multiple Command Script Wizard

 To select one or more commands using   the Multiple Command Script Wizard:
 1. In the Basic Animation   dialog box, click the Click button or select the Command check box. The   

Multiple Command Script Wizard appears.

 2. Choose a command   from the Select Action to Append list. The Expert associated with the   com-
mand you chose appears.

 3. Complete the Expert   with your desired settings and information.

 4. Click OK. The Expert   closes and appears in the Configured Actions list box of the Multiple   Com-
mand Script Wizard.

 5. Optionally, repeat   steps 2-4 if you want to add additional commands to your scripted command   
sequence.

 6. When you have finished   choosing your command sequence, click OK to return to the Basic Anim-
ation   dialog box.

 

Manipulating Objects 

In the iFIX WorkSpace, you can perform the following steps to   manipulate objects:

 l Copying   and Pasting Objects as Bitmaps

 l Moving   Objects

 l Copying   and Pasting Objects

 l Renaming   Objects
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 l Rotating   Objects

 l Changing   an Object's Center of Rotation

 l Reshaping   Objects

 l Setting   the Fade Type of an Object

 l Setting   the Gradient Angle of an Object's Fade Type

 l Extending   Lines to Intersect

 l Trimming   Intersected Lines

 l Making   Lines Horizontal or Vertical

 l Converting   Lines to a Polyline

 l Converting   Lines and Polylines to Pipe

 l Modifying   Pipes Overview

 l Modifying   Pipe Characteristics

 l Adding   and Deleting Connection Points

 l Adding   and Anchoring Connectors to Shapes

 l Adding   Points to Polygons and Polylines

 l Deleting   Points from Polygons and Polylines

 l Splitting   Polylines and Pipes

 l Selecting   an Object's Color or Style Property

 l Selecting   Multiple Objects

 l Aligning   Two or More Objects to Each Other

 l Spacing   Three or More Objects

 l Flipping   Objects

 l Sending   Objects in Back of Other Objects

 l Bringing   Objects to the Front of Other Objects

 l Making   Multiple Objects the Same Size

 l Viewing   Tag Status Pictures

 l Viewing   Quick Trend Pictures

 l Viewing   Tag Control Panel Pictures

 l Adding   and Deleting Tags in a Tag Control Panel Picture

 l Saving   Tag Lists in a Tag Control Panel Picture

 l Loading   Tag Lists in a Tag Control Panel Picture

 l Configuring   the Global Time Control

 l Hiding   the Historical Datalink Timestamp

 

Copying and Pasting Objects as Bitmaps
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 To copy and paste   an object as a bitmap image:
 1. In the iFIX WorkSpace,   select the object you want to copy.

 2. In Classic view,   on the Edit menu, choose Copy as Bitmap. 

-Or-

In Ribbon view, on the Home tab, in the   Clipboard group, click Copy as Bitmap.

 3. In Classic view,   on the Edit menu, choose Paste. 

-Or-

In Ribbon view, on the Home tab, in the   Clipboard group, click Paste, and then click Paste.

 

Moving Objects

 To move an object:
 1. In the iFIX WorkSpace,   select the object you want to move.

 2. Click and drag the   object to the desired location.

 

Copying and Pasting Objects

 To copy and paste   an object:
 1. In the iFIX WorkSpace,   right-click the object you want to copy, and click Copy.

 2. Click anywhere in   the picture to de-select the object.

 3. Right-click the picture   and select Paste.

 4. Move the object to   where you want it in the picture.

TIPS:
 l If you   want to copy and paste a Windows Metafile (WMF) from another application   and retain its group 

properties in the iFIX WorkSpace, do not use the   right-click Cut and Paste options. If you do, the pas-
ted object will not   be a grouped object, and instead will be a flat Bitmap. 

 l To insert   a WMF as grouped object, you can use Microsoft Excel . In Excel, use the   Insert menu to 
insert the WMF picture into a new spreadsheet. Right-click   the picture and select Edit Picture. A mes-
sage box appears requesting   that you convert the picture to a Microsoft drawing object. Click Yes,   and 
then copy the converted object from Excel. In the iFIX WorkSpace,   and select Paste > Paste Special. 
From the Paste Special dialog box,   select Enhanced Metafile and click OK. The grouped object should 
now appear   in your picture.

 

Renaming Objects

 To rename objects:
 1. In the iFIX WorkSpace   system tree, right-click the object and choose Property Window. The 

Properties   dialog box appears.
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 2. Place the cursor   in the second column of the Name row and enter a name.

 

Rotating Objects

 To rotate an   object:
 1. In the iFIX WorkSpace,   right-click the object you want to rotate and choose Rotate from the pop-

up   menu that appears.

 2. Click and drag one   of the rotation handles in the direction that you want to rotate the object.

 

Changing an Object's Center of Rotation

 To change an   object's center of rotation:
 1. In the iFIX WorkSpace,   right-click the object you want to rotate and choose Rotate from the pop-

up   menu that appears. 

 2. Click and drag the   object's center of rotation and move it to the desired location in your   picture. 
The cursor becomes a crosshair.

 3. To relocate the object's   original center of rotation, click the current center of rotation and   move it 
to the crosshair that appears inside the object.

 

Reshaping Objects

 To reshape an   object:
 1. In the iFIX WorkSpace,   select the object. Reshape handles appear around the object.

 2. Click and drag a   reshape cursor. As you drag, the object changes shape.

 

Setting the Fade Type of an Object

 To set the fade   type of an object:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Fade. 

 2. In the Fade Type   area, select the fade type you want to apply to the object.

- Or -

If the object already has a gradient style   applied to it, right-click the object, point to Fade Type 
and choose the   fade type you want to apply.

NOTE:   Selecting a fade type in the Select FadeColor dialog box automatically   sets the object's fill style 
to Gradient, regardless of the setting in   the User Preferences dialog box.
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Setting the Gradient Angle of an Object's Fade Type

 To set the gradient   angle of an object's fade type:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Fade. The Select 

FadeColor   dialog box appears.

 2. Move the Gradient   Angle slider to change the angle of the gradient. The gradient angle moves   
around the shape in a counter-clockwise direction, starting from the right   side of the shape, as 
you increase the angle.

NOTE:   Changing the gradient angle has no effect on a radial or concentric fade   type. Gradient angle 
applies only to the linear and reflected fade types.

 3. Click OK.

Extending Lines to Intersect

 To extend a line   to intersect with another line:
 1. In the iFIX WorkSpace,   control-click the lines you want to intersect with each other.

 2. In Classic view,   on the CAD Toolbar, click the Extend Lines button. 

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Drawing Tools, and then click 
Extend Lines.

 

Trimming Intersected Lines

 To trim lines   at the intersection point:
 1. In the iFIX WorkSpace,   control-click the intersected lines you want to trim.

 2. In Classic view,   on the CAD Toolbar, click the Trim Lines button. 

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Drawing Tools, and then click Trim 
Lines.

 

Making Lines Horizontal or Vertical

 To make lines   horizontal:
 1. In the iFIX WorkSpace,   control-click the lines you want to make horizontal.

 2. In Classic view,   on the CAD Toolbar, click the Make Lines Horizontal button. 

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Drawing Tools, and then click Make 
Lines Horizontal.
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 To make lines   vertical:
 1. In the iFIX WorkSpace,   control-click the lines you want to make vertical.

 2. In Classic view,   on the CAD Toolbar, click the Make Lines Vertical button. 

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Drawing Tools, and then click Make 
Lines Vertical.

 

Converting Lines to Polylines

 To convert lines   to a polyline:
 1. In the iFIX WorkSpace,   control-click the lines you want to convert to a polyline.

 2. In Classic view,   on the CAD Toolbar, click the Convert Lines to Polyline button. 

-Or-

In Ribbon View, on the Format tab, in the   Picture group, click Drawing Tools, and then click Con-
vert Lines to Polyline.   

 

Converting Lines and Polylines to Pipe

 To convert multiple   lines and polylines to pipes:
 1. In the iFIX WorkSpace,   control-click the lines or polylines you want to convert to pipes.

 2. In Classic view,   on the CAD Toolbar, click the Convert Lines and Polylines to Pipe button.   

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Drawing Tools, and then click Con-
vert Lines and Polylines   to Pipe. 

 To convert a   single line or polyline to a pipe:
In the iFIX WorkSpace, right-click the line   or polyline you want to convert to a pipe and choose 
Convert to Pipe.

 

Modifying Pipe Characteristics

 To modify pipe   characteristics:
 1. In the iFIX WorkSpace,   select the pipe object(s) you want to modify.

 2. In Classic view,   on the CAD Toolbar, click the Modify Pipe button. 

- Or -

In Ribbon view, from the Format tab, in   the Styles group, in the Pipe list, click Modify Pipe Char-
acteristics.   
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- Or -

Right-click a single pipe, and choose Modify   Pipe Characteristics. 

- Or -

Right-click the single pipe, point to Color,   and choose Fade. 

- Or -

Control-click multiple pipes and in Classic   View, click the Modify Pipe button on the CAD toolbar. 
In Ribbon view,   from the Format tab, in the Styles group, in the Pipe list, click Modify   Pipe Char-
acteristics. 

NOTE:   The changes you make are applied to all of the selected pipe objects.

 3. Change the pipe characteristics,   as required.
 

Adding and Deleting Connection Points

 To add a connection   point:
 1. In the iFIX WorkSpace,   select the shape object you want to add connection points to.

 2. In Classic view,   on the CAD Toolbar, click the Add Connection Point button. 

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Drawing Tools, and then click Add 
Connection Point.   

 3. Add the required   connection points to the shape object.

NOTE:   If the Always Show Connection Nodes check box on the User Preferences   dialog box is selec-
ted, the default connection points and points that   you add to shapes are always visible. If this check 
box is cleared, the   connection points are not visible, but can be displayed either when you   select a 
connector and move it towards the shape to anchor it to a certain   connection point on the shape, or, in 
Classic view, by selecting the shape   and clicking either the Add Connection Point button or Delete 
Connection   Point button on the CAD Toolbar. In Ribbon view, select the shape and   on the Format tab, 
in the Picture group, in the Drawing Tools list, click   either Add Connection Point or Delete Connection 
Point.

 To delete a connection   point:
 1. In the iFIX WorkSpace,   select the shape object you want to delete connection points from.

 2. In Classic view,   on the CAD Toolbar, click the Delete Connection Point button. 

-Or-

In Ribbon View, on the Format tab, in the   Picture group, click Drawing Tools, and then click 
Delete Connection Point.

 3. Delete the connection   points, as required.

 

Adding and Anchoring Connectors to Shapes
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 To add and anchor   a connector to shapes:
 1. In Classic view,   in the iFIX WorkSpace, on the CAD Toolbar, click the line connector button   you 

want to use to connect your shapes. 

-Or-

In Ribbon view, on the Insert tab, in the   Connectors group, click Connectors, and then click the 
desired line connector.   

You can choose from the Line Connector Tool,   the Right Angle Line Connector, or the Pipe Con-
nector.

 2. Draw a connector   between two shapes.

 3. Select the connector.   The ends of the connector change to green squares.

 4. Drag the end of the   connector to the connection point. The connector end changes to a red   square 
when it is anchored to the connection point. If it is not anchored   to the connection point, it stays 
green.

NOTE:   When you are anchoring a connector object, it is automatically sent to   the back of the object 
you are anchoring it to. The connector handles,   however, are still visible and can be selected and 
moved. When the anchoring   process is completed, you can right-click the connector object and 
choose   Bring to Front.

 5. Repeat steps 3 and   4 to anchor the connector to the second shape. The shapes can be moved   
around the picture but remain connected. The connector stretches and reshapes   as the shapes 
are moved.

 

Adding Points to Polygons and Polylines

 To add a point   to a polygon or polyline:
 1. In the iFIX WorkSpace,   right-click the polygon or polyline and choose Add Point.

 2. Position the cursor   between two of the object's points. Make sure the cursor is black or partially   
black.

 3. Click the mouse to   add the new point.

 

Deleting Points from Polygons and Polylines

 To delete a point   from a polygon or polyline:
 1. In the iFIX WorkSpace,   right-click the polygon or polyline and choose Delete Point.

 2. Position the cursor   over the point you want to delete. Make sure the cursor is black.

 3. Click the mouse to   delete the point.

 

Splitting Polylines and Pipes
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 To split a polyline:
 1. In the iFIX WorkSpace,   right-click the polyline you want to split and choose Split Polyline.   The 

cursor becomes a splitting cursor. When you are close to the polyline,   the splitting cursor 
changes to black.

 2. Click the spot on   the polyline where you want to split it. New reshape handles appear on   one 
piece of the split polyline. You can use these handles to reshape   the polyline or move it to a new 
location in the picture.

NOTE:   When you split a polyline or pipe, you create a new object. Therefore,   if you undo a polyline or 
pipe split, the new object is deleted first   and you must perform a second undo action to revert to the ori-
ginal object.

 To split a pipe:
 1. In the iFIX WorkSpace,   right-click the pipe you want to split and choose Split Pipe. The cursor   

becomes a splitting cursor. When you are inside the edges of the pipe,   the splitting cursor 
changes color.

 2. Click the spot on   the pipe where you want to split it. New reshape handles appear on one   piece of 
the split pipe. You can use these handles to reshape the pipe   or move it to a new location in the 
picture.

NOTE:   When you split a polyline or pipe, you create a new object. Therefore,   if you undo a polyline or 
pipe split, the new object is deleted first   and you must perform a second undo action to revert to the ori-
ginal object.

 

Selecting an Object's Color or Style Property

 To select   an object's color or style property:
In the iFIX WorkSpace, right-click the object   and do one of the following:

 l Select the desired   property from the pop-up menu.

 l Select Property   Window from the pop-up menu and enter a property value in the second 
column   of the Properties Window.

 

Selecting Multiple Objects

 To select multiple   objects:
 1. In the iFIX WorkSpace,   select an object.

 2. Control-click the   remaining objects. Each selected object displays with handles.

 

Aligning Two or More Objects to Each Other
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 To align two   or more objects to each other:
 1. In the iFIX WorkSpace,   control-click the objects you want to align.

 2. In Classic view,   on the Tools toolbar, click the appropriate Align button. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Align, and then click the desired 
alignment type.   

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The objects align according to your selection.

 

Spacing Three or More Objects

 To space three   or more objects:
 1. In the iFIX WorkSpace,   control-click the objects.

 2. In Classic view,   on the Tools toolbar, click the Space Evenly Vertical or Space Evenly   Horizontal 
button. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Space Evenly, and then click 
Space Evenly Vertical   or Space Evenly Horizontal. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The objects are spaced according to your   selection.

 

Sending Objects in Back of Other Objects

 To send an object   in back of another object:
 1. In the iFIX WorkSpace,   select the object.

 2. In Classic view,   on the Tools toolbar, click the Send to Back button. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Send to Back. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The selected object is positioned behind   other objects.

 

Bringing Objects to the Front of Other Objects
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 To bring an object   in front of another object:
 1. In the iFIX WorkSpace,   select the object.

 2. In Classic view,   on the Tools toolbar, click the Bring to Front button. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Bring to Front. 

-Or-

If the Toolbox is enabled, click the Bring   to Front button on the Toolbox.

The selected object is positioned in front   of other objects.

 

Making Multiple Objects the Same Size

 To make multiple   objects the same size:
 1. In the iFIX WorkSpace,   select any objects you want to resize.

 2. Select the object   you want to use to specify the size. All previously selected objects will   be res-
ized to match this object's size.

 3. In Classic view,   on the Format menu, select Make Same Size and then Select Height, Width,   or 
Both, depending on which dimensions you want to change in the objects.   

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Make Same Size, and then click 
desired option.

 

Viewing Tag Status Pictures

 To view a single   Tag Status picture:
 1. In the iFIX WorkSpace   run-time environment, select the object you want to view the Tag Status   

picture for.

 2. Right-click the object   and choose Tag Status. The Tag Status picture appears.

 To view a Tag   Status picture from the Tag Control Panel picture:
 1. In the iFIX WorkSpace   run-time environment, select the object(s) you want to view Tag Status   

pictures for.

 2. Right-click the objects   and choose Tag Status. Another menu appears listing the first tag found   
and the Tag Control Panel item.

NOTE:   When you select multiple objects, the first associated tag of the first   object selected is dis-
played in the right-click menu.

 3. Choose Tag Control   Panel. The Tag Control Panel picture appears.

 4. Click the Tag Status   button for the Tag Status picture you want to view.
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 To view a Quick   Trend chart from a Tag Status picture:
 1. In the iFIX WorkSpace   run-time environment, select the object you want to view Tag Status pic-

ture   for.

 2. Right-click the object   and choose Tag Status. The Tag Status picture appears.

 3. Click the Quick Trend   chart to select it, then right-click and choose Quick Trend. The Quick   
Trend picture for the tag appears.

NOTE:   Only tags that have an F_CV field associated with it will display a Quick   Trend chart in the Tag 
Status picture.

 

Viewing Quick Trend Pictures

 To view a Quick   Trend picture:
 1. In the iFIX WorkSpace   run-time environment, select the object you want to view the Quick Trend   

picture for.

 2. Right-click the object   and choose Quick Trend. The Quick Trend picture appears, displaying up   to 
eight pens for the associated database tags.

NOTE:   You can also select multiple objects and view a single Quick Trend picture   for up to eight tags.

 To view a Quick   Trend picture from the Tag Control Panel picture:
 1. In the iFIX WorkSpace   run-time environment, select the object(s) you want to view Quick Trend   

pictures for.

 2. Right-click the objects   and choose Tag Status. Another menu appears listing the first tag found   
and the Tag Control Panel item.

NOTE:   When you select multiple objects, the first associated tag of the first   object selected is dis-
played in the right-click menu.

 3. Choose Tag Control   Panel. The Tag Control Panel picture appears.

 4. Click the Quick Trend   button for the Quick Trend picture you want to view.

 

Viewing Tag Control Panel Pictures

 To view a Tag   Control Panel picture:
 1. In the iFIX WorkSpace   run-time environment, select the object(s) you want to view a Tag Control   

Panel picture for.

 2. Right-click the objects   and choose Tag Status. Another menu appears listing the first tag found   
and the Tag Control Panel item.

NOTE:   When you select multiple objects, the first associated tag of the first   object selected is dis-
played in the right-click menu.
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 3. Choose Tag Control   Panel. The Tag Control Panel picture appears.

 4. You can view Tag   Status and Quick Trend pictures for the tags associated with the object(s)   you 
selected, as well as other tag information.

 

 To add a tag   to a Tag Control Panel picture:

 1. In the Tag Control   Panel picture, click the Add Row button. The Expression Builder appears   with 
only the FIX Database tab available.

 2. Use the Expression   Builder to create a tag whose information you want to view.

 3. Click OK on the Expression   Builder. The tag is added to the list on the Tag Control Panel picture.

 To delete a tag   from a Tag Control Panel picture:

In the Tag Control Panel picture, select   the tag you want to delete and click the Delete Selected 
Row(s) button.

NOTE:   A tag that is associated with an object is removed only from the Tag Control   Panel picture; it is 
not removed from the object.

 

Saving Tag Lists in a Tag Control Panel Picture

 To save a tag   list in the Tag Control Panel picture:
 1. In the Tag Control   Panel picture in WorkSpace's runtime environment, select the tags you   want 

to save to a tag list, by holding down the Control key and clicking   each row you want to include in 
the list.

 2. Click the Save Tag   List button. The Save As dialog box appears.

 3. Save the tag list   to the location you want.

 

Loading Tag Lists in a Tag Control Panel Picture

 To load a tag   list in the Tag Control Panel picture:
 1. In the Tag Control   Panel picture in WorkSpace's runtime environment, click the Load Tag List   but-

ton. The Open dialog box appears.

 2. Locate the tag list   you want to load and click Open. The tag list you selected is displayed   in the 
Tag Control Panel picture, overwriting the current list.

 

Configuring the Global Time Control
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 To configure   the Global Time Control:
 1. In Ribbon view, in   run mode, click the Historical tab, and then click Configuration. The   Global 

Time Control dialog box appears.

 2. In the Time Definition   area, enter the Start Time.

 3. Either choose an   End Time or define the Duration of the display:

 l To set the End   Time, in the End Time area, enter a date.

 l To set the Duration:

 a. Select the   Define Duration check box.

 b. In the Days   list, select the number of days. 

 c. Select the   number of hours, minutes and seconds in their respective lists.

 4. In the Historical   Update Rate area, select the number of hours, minutes, and seconds from   their 
respective list, for the update rate. This function does not apply for Playback.

 5. In the Scroll Rates   area, either set the scroll rate as a percentage of the duration or as   a fixed 
amount. This function does not apply for Playback.

 l To set the scroll   rate as a percentage of the duration:

 a. Select Scroll   as % of Duration check box.

 b. In the Slow   list, enter a value for the slow scroll speed.

 c. In the Fast   list, enter a value for the fast scroll speed.

 l To set the scroll   rate as a fixed amount:

 a. If necessary,   clear the Scroll as % of Duration check box.

 b. In the Slow   area, select the unit of measurement: days, hours, minutes, or 
seconds.

 c. Enter the   value for the unit selected.

 d. In the Fast   area, select the unit of measurement: days, hours, minutes, or 
seconds.

 e. Enter the   value for the unit selected.

 6. To allow for playback (does not apply to Historian Update or Scroll Rate), select the Enable Play-
back option. In the Playback area, select either By Speed or By Frame Size and the setting.

 7. Click OK to apply   changes to all open pictures.

Hiding the Historical Datalink Timestamp

 To hide the historical   datalink time stamp for all historical datalinks:
NOTE:   The following procedure applies only to historical datalinks created after   you perform this pro-
cedure. Existing historical datalinks will not be   affected.

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 
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 2. Click the Shape Preferences   tab.

 3. In the Historical   Datalink area, clear the Show Timestamp With Data check box.

 To hide the historical   datalink time stamp for a single historical datalink:
Method 1

 1. Double-click the   historical datalink. The Historical Datalink dialog box appears.

 2. Clear the Show Timestamp   With Data check box.

 3. Click OK.

 

Method 2

 1. From the right-mouse   menu of the historical datalink, select Property Window. The Property   Win-
dow appears.

 2. For the ShowTimeStamp   property, select False.

Working with Standard Charts 

In the iFIX WorkSpace, you can perform the following steps with   charts:

 l Applying   Properties to all Pens in a Chart

 l Adding   a Pen to a Chart

 l Selecting   a Historical Mode for a Pen

 l Naming   a Chart

 l Entering   a Chart Description

 l Attributing   a Help Context ID

 l Changing   the Refresh Rate

 l Changing   the Order of the Information in the Legend

 

Applying Properties to all Pens in a Chart

 To apply properties   to all pens in a chart:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the Chart tab,   then click the tab containing the properties you want to select.

 3. Select the appropriate   properties on the tabbed page.

 4. Select the Apply   to All Pens check box and then click OK.

Adding a Pen to a Chart
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 To add a pen   to your chart:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click on the Chart   tab.

 3. In the Pen List area,   click the Add Pen button, or click a blank area in the Pen List, and do   one of 
the following:

 l Enter a data   source using the Data Server.NODE.TAG.FIELD   format.

 l Select a data   source from the drop-down list.

 l Click the Browse   button and select a data source from the Expression Builder.

 

Selecting a Historical Mode for a Pen

 To select a historical   mode for a pen:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the Chart tab,   and then click the Pen tab.

 3. In the Pen List,   select a historical data source.

 4. In the Style area,   select a historical mode from the Historical Mode field.

Naming a Chart

 To name a chart:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the General   tab and, in the Name field, enter a name for the chart.

 3. Click OK.

Entering a Chart Description

 To enter a chart   description:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the General   tab and, in the Description field, enter a chart description.

 3. Click OK.

Attributing a Help Context ID

 To attribute   a help context ID:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the General   tab and, in the Help Context Id field, enter a context-sensitive help   ID.

 3. Click OK.

Changing the Refresh Rate
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 To change the   refresh rate:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the General   tab and, in the Refresh Rate field, choose a refresh rate in seconds.

 3. Click OK.

Changing the Order of the Information in the Legend

 To change the   order of the information in the legend of a chart:

 1. In the iFIX WorkSpace,   double-click the chart. 

 2. Click the Chart tab,   then click the Legend tab.

 3. In the Order area,   select the information you want and click the up or down button to change   its 
order in the legend (left to right). For example, if you want to display   the data source value first, 
select Value and click the up arrow button   until Value is listed first.

 4. Click OK.

Working with Enhanced Charts

In the iFIX WorkSpace, you can customize your enhanced charts   using the following procedures:

 l Adding   a Chart Description to Enhanced Charts

 l Adding   a Data Source Legend to an Enhanced Chart

 l Adding   a Plotting Style Legend to an Enhanced Chart

 l Adding   a Title to an Enhanced Chart

 l Changing   the Plotting Color and Style of an Enhanced Chart

 l Changing   the Chart Refresh Rate for an Enhanced Chart

 l Choosing   a Border Style for an Enhanced Chart

 l Choosing   Subsets for Enhanced Line Charts

 l Configuring   Data Sources for Enhanced Charts

 l Configuring   the X and Y Axis of an Enhanced Chart

 l Customizing   Enhanced Chart Grid Lines

 l Customizing   the Color and Look of Enhanced Charts

 l Customizing   the Data Source Legend for an Enhanced Chart

 l Defining   Run-time Attributes for Enhanced Charts

 l Displaying   Milliseconds on an Enhanced Chart

 l Exporting   Enhanced Chart Data

 l Extending   the Y Axis Ticks on an Enhanced Chart

 l Naming   an Enhanced Chart

 l Removing   the Plotting Style Legend from an Enhanced Chart
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 l Removing   the Data Source Legend from an Enhanced Chart

 l Selecting   the Font Size and Type for an Enhanced Chart

 l Setting   Numeric Precision for Enhanced Charts

 l Setting   the Data Display Format for Enhanced Charts

 l Showing   Data Points on an Enhanced Chart

 l Showing   the Time Cursor in Enhanced Charts

Adding a Chart Description to Enhanced Charts

 To add a chart   description to an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and in the Description field, enter a chart description.

 3. Click OK.

Adding a Data Source Legend to an Enhanced Chart

 To add a data   source legend to an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, select Show Data Source Legend.

 3. Click OK.

Adding a Plotting Style Legend to an Enhanced Chart

 To add a plotting   style legend to an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, select Show Plotting Style Legend.

 3. Click OK.

 

Adding a Title to an Enhanced Chart

 To add a title   to an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab, and in the Main Title field, enter a title for the chart.

 3. Optionally, in the   Subtitle field, enter a subtitle for the chart.

 4. Click OK.

Changing the Plotting Color and Style of an Enhanced Chart
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 To change the   plotting color and style of an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Plotting   Style tab and in the Line Style area, click the desired color. To create   a custom 
color, double-click a color. 

NOTE:   The selected color is applied to the X and Y axis markers, Data Sources   table items, and graph 
lines and points. 

 3. Line Charts Only:   In the Chart Plotting Style area, select the desired style.

 4. Line Charts Only:   Select a Point Type.

NOTE:   Point types appear only if the Chart Plotting Style includes points, such   as Point + Line, for 
example. 

 5. Select a Line Type.

 6. In the Data Shadows   area, click Off, Shadow, or 3D.

NOTE:   3D can be applied only to Histograms; Shadow can be applied to only Histograms   and 
Line/Multiline charts that use Area or Bar for their Plotting Style.

 7. Click OK.

Changing the Chart Update Rate for an Enhanced Chart

 To change the   chart update rate of an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and, in the Chart Update Rate field, enter a refresh rate in seconds.

 3. Click OK.

 

Changing the Y Axis Style in Run Mode

NOTES:

 l Two or more data sources   must be configured in order to display multiple charts or a stacked chart.

 l The Enable Quick Configure   check box must be selected in the General tab of the Chart Cus-
tomization   dialog box.

 To change the   Y axis style:

 1. In run mode, hover   over the upper left corner of the chart. Buttons labeled Multiple, Stack,   and 
Single appear.

 2. Click the button   corresponding to the Y axis style you want to display.

 

Changing the Y Axis Visibility in Run Mode

NOTE:   The Enable Quick Configure check box and the Selectable check box must   both be selected in the 
General tab of the Chart Customization dialog   box.
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 To change the   Y axis visibility:

 1. In run mode, hover   over the column at the far right of the Data Source Legend area under   the 
chart. The Y Axis Always Visible label box appears just above the   cursor.

 2. Click the value (Yes   or No) displayed for the row to toggle it to the opposite value.

 

Changing the Plot Visibility in Run Mode

NOTE: The Enable   Quick Configure check box and the Selectable check box must both be selected   in the 
General tab of the Chart Customization dialog box.

 To change the   plot visibility:

 1. In run mode, hover   over the second column from the far right of the Data Source Legend area   
under the chart. The Plot Visible label box appears just above the cursor.

 2. Click the value (Yes   or No) displayed for the row to toggle it to the opposite value.

 

Choosing a Border Style for an Enhanced Chart

 To choose a border   style for an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Border Style area, click the desired border style.

 3. Click OK.

Choosing Subsets for Enhanced Line Charts

 To choose the   subsets for an enhanced line chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Subsets   tab and in the Scrolling Subsets area, choose the number of subsets to   view in 
one group.

 3. To add a subset to   a graph select it from the Baseline Subsets to Graph list.

 4. Click OK.

Configuring Data Sources for Enhanced Charts

 To configure   data sources for an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Data Sources   tab and in the Data Sources List do one of the following:
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 l Enter a data   source using the Data Server.NODE.TAG.FIELD   format.

 l Select a data   source from the drop-down list.

 l Click the Browse   button and select a data source from the Expression Builder.

NOTE:   Proficy Historian Data Sources using expressions (for example, Hist1.INFO10.Sim-
ulation00001   + 30) are not supported for Enhanced Charts.

 3. To use the data range   of the data source, on the Data tab, if it is not already selected, click   Fetch 
Limits. 

 4. To set the data range   yourself, clear the Fetch limits check box and enter the upper limit of   the 
range in the High Limit field and enter the lower limit of the range   in the Low Limit field.

 5. For Line/Multiline   charts only: Enter the maximum number of display points in the Maximum   Dis-
play Points field.

 6. To cause gaps to   appear on the chart if they are present in the data, select Show Gaps.

 7. To use interpolated   data, select Interpolated Data.

 8. Historical Data Charts   only: Choose a mode from the Historical Mode list.

 9. Configure the time   parameters for historical data sources on the Time tab. 

NOTE:   The Time tab is available only for historical data sources.

 a. In the Start   Date section, select either Fixed Date or Days Before Now and enter the   
desired date or value.

 b. In the Start   Time section, select either Fixed Time or Duration Before Now and enter   the 
desired time or value.

 c. Optionally, to   configure the chart to open at the Fixed Time and to ignore changes to   the 
time zone in the Date and Time Properties dialog box in the Control   Panel, select Lock 
Time.

 d. Optionally, to   adjust for daylight saving time, if it is not already selected, click   Adjust for 
Daylight Savings Time and select a time zone from the Time   Zone list.

 e. To apply all   of the preceding settings to all historical data sources, select Apply   To All 
Data Sources, and then click Apply.

 10. Click OK.
 

Configuring the X and Y Axis of an Enhanced Chart

 To configure   the X and Y axis of an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Axis tab   and in the X Axis Title field, enter a title for the X axis.

 3. In the Y Axis Title   field, enter a title for the Y axis.

 4. In the Show X-Axis   field, select the Grid, Labels, and Title to be displayed for the X axis.

 5. In the Show Y-Axis   field, select the Grid, Labels, and Title to be displayed for the Y axis.
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 6. In the Max X-Axis   Labels field, select the maximum number of labels (up to 20) to be displayed   
for the X axis.

 7. Line/Multiline Charts   only: Select Linear or Log format for the Y axis units.

 8. To use automatically   generated limits for the Y axis, select Use Data Source Limits.

 9. To specify which   values you want to set for the Y axis, clear the Use Data Source Limits   check 
box  and   select Min, Max, or Min/Max.

 10. Enter the desired   value in the Min and/or Max fields.

 11. Select Auto if you   want the chart to dynamically resize to the values plotted.

NOTE:   Auto is available only if Use Data Source Limits is selected.

 12. In the Padding field,   enter a value.

 13. On the Chart Style   tab, in the X Axis Label Orientation area, click the orientation of the   X axis. 

 14. Click OK.
 

Configuring Multiple Y Axes for Enhanced Charts

 To configure   multiple Y axes for Enhanced Charts:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab. In the Y Axes Style area, select either Multiple Axes or Stack Axes.

 3. Click the Data Sources   tab and click the Y Axis sub-tab.

 4. From the Data Sources   List area, select the data source to configure a Y axis for.

 5. In the Title field   in the Y Axis tab, enter a title for the Y axis of the selected data source.

 6. If you want the Y   axis for this data source to always be visible, select the Y Axis Always   Visible 
check box.

 7. If you want to use   the default Y axis settings configured in the Axis tab, select the Use   Default Y 
Axis Settings check box.

NOTE:   Selecting this option disables all other controls in this group.

 8. If you want the Y   axis for this data source to be set according to the limits of the individual   data 
source, select the Use Data Source Limits check box.

NOTES:

 l This option   is available only if Use Default Y Axis Settings is not selected.

 l Selecting   this option disables all other Data Source Limits controls in this group.

 9. Select Linear or   Log format to specify whether the Y Axis legend for the associated data   source is 
displayed in a linear or logarithmic style

NOTE:   This option is available only if Use Default Y Axis Settings is not selected.

 10. To specify minimum   and/or maximum values for the Y axis in run mode either manually or auto-
matically,   select either Auto, Min, Max, or Min/Max in the radio button group.
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 l Auto allows iFIX   to automatically calculate the minimum and maximum values so that all   
data points are within the visible area of the chart for the selected   data source.

 l Min allows you   to specify the minimum value and automatically calculate the maximum 
value   for the selected data source.

 l Max allows you   to specify the maximum value and automatically calculate the minimum 
value   for the selected data source.

 l Min/Max allows   you to specify both the minimum and maximum values for the selected 
data   source.

NOTE: These   options are not available if Use Default Y Axis Settings or Use Data Source   Limits is 
selected.

 11. To manually specify   the minimum and/or maximum values for the Y axis, enter the values in   the 
Min and/or Max fields.

NOTES:

 l The Min   and Max fields are not available if Use Default Y Axis Settings or Use   Data Source 
Limits is selected.

 l The Min   field is available only if the Min or Min/Max radio button is selected.

 l The Max   field is available only if the Max or Min/Max radio button is selected.

 12. To specify the spacing   between values and the top and bottom of plot area, enter the desired   
value in the Padding field.

NOTES:

 l This option   is not available if the Min/Max radio button is selected.

 l This option   is not available if Use Default Y Axis Settings or Use Data Source Limits   is selec-
ted.

 13. To configure the   Y axis for another data source in the Data Sources List area, repeat the   pre-
ceding steps.

 
 

Customizing Enhanced Chart Grid Lines

 To customize   enhanced chart grid lines:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Grid Lines area, click Grid in Front of Data to make the   grid 
lines appear in front of the data.

 3. Click which, if any,   grid lines you want to display on the chart.

 4. Click the desired   style for the grid lines.

 5. Click OK.

Customizing the Color and Look of Enhanced Charts
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 To customize   the color and look of an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Color tab   and in the Viewing Style area, select Color, Monochrome, or Monochrome   + 
Symbols.

 3. To design your own   custom color graph:

 a. In the Graph   Attributes area, click the attribute you want to change the color for.

 b. Click the desired   color for the selected attribute. To create a custom color, double-click   a 
color.

 c. Repeat steps   a and b until you have modified all desired attributes. 

 4. To use a pre-set   style:

 a. Select Bitmap/Gradient   Styles.

 b. Click the desired   Bitmap/Gradient style.

 5. Click OK.

Customizing the Data Source Legend for an Enhanced Chart

 To customize   the data source legend for an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Data Sources   tab and then the Legend tab.

 3. In the Items area,   select the items that you want to appear in the data sources Legend.

 4. To apply your selections   to all data sources, select Apply To All Data Sources.

 5. To change the order   in which the selected items appear, on the Chart Style tab, in the Legend   
Column Width area, in the Order list, select the item you want to move.   Use the Up arrow to 
move the item's location to the right or the Down   arrow to move the item's location to the left.

 6. To change the width   of a data source legend column, in the Legend Column Width area, enter   the 
desired column width in the corresponding column field. For example,   to change the width of the 
Source column of the data source legend, enter   the desired width in the Source field.

 7. In the Miscellaneous   area, select Show Data Source Legend.

 8. Click OK.

Defining Run-time Attributes for Enhanced Charts

 To define run   time attributes for enhanced charts:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab.

 3. Select the attributes   (Highlightable, Selectable, Modifiable, Expandable), if any, you want   to per-
mit at run time.
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 4. In the Zooming area,   select the desired zoom function.

 5. In the Appearance   area, select Enable Quick Configure to quickly and easily change various   
Enhanced Chart properties while in run mode without having to display   the configuration dialog or 
the right-click menu.

 6. Click OK.

Displaying Milliseconds on an Enhanced Chart

 To display milliseconds   on an enhanced charts:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and in the Appearance area, select Display Milliseconds.

 3. Click OK.

Enabling Advanced Graphics

 

 To enable advanced   graphics for an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and in the Appearance area, select Enable Advanced Graphics.

 3. Click OK.

Enabling Quick Configure

Enable Quick Configure provides a way to quickly and easily change chart   properties while in run mode 
without needing to open the configuration   dialog box or use the right-click menu. The Quick Configure 
options that   are enabled are:

 l Y Axes Style buttons   (Multiple, Stack, Single) that appear when you hover over the upper left-
hand   corner of the chart

 l Y Axis Always Visible   toggle when you hover over the column at the far right of the Data Source   
Legend area under the chart

 l Plot Visible toggle   when you hover over the second column from the far right of the Data Source   
Legend area under the chart

NOTE:   The Selectable check box on the General tab must also be selected to toggle   the Y Axis 
Always Visible and Plot Visible properties between Yes and   No.

 To enable quick   configure for an Enhanced Chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and in the Appearance area, select Enable Quick Configure.

 3. Click OK.

Enabling the Thumbnail View

314 © 2024 General Electric Company. All rights reserved.



The Thumbnail check box allows the chart to be reduced to thumbnail   size while still being legible 
enough to provide useful information. When   coupled with the Expandable property, the chart can be 
enlarged to full   size in run mode, or can be reduced to thumbnail size.

 To enable thumbnail   view:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, select Thumbnail.

 3. Click OK.

Exporting Enhanced Chart Data

 To export enhanced   chart data:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click Export.

 3. In the Export area,   select the desired file format type.

 4. In the Export Destination   area, select the desired export location. If you chose File, click Browse   
to set the destination.

 5. For Export options   EMF, WMF, BMP, JPG, and PNG only, configure the export size. To do so:   

 a. If applicable,   select the unit of measure.

 b. Enter the export   size in the Width fields.

NOTE:   The width/height aspect ratio must be between .1 and 10.0 to avoid generating   the 
error "This will produce an image that is hard to read. Please   adjust output dimensions." For 
example, a width/height of 30/300   does not produce an error, but 30/301 does. Likewise, a 
width/height of   300/30 does not produce an error, but 301/30 does.

 c. Select the DPI.

 d. If desired, click   Large Font.

 2. Click Export. If   you selected the EMF, WMF, BMP, JPG, or PNG formats for export, your data   is 
exported. Otherwise, the Exporting Enhanced Chart dialog box appears.

 3. On the Exporting   Enhanced Chart dialog box, in the Export What area, select whether you   want 
to export only the data or the data with its labels.

 4. In the Export Style   area, choose to export the data in either list or table format. If you   chose List, 
in the Delimited area, select either Tab or Comma. If you   chose Table, in the Row vs Column 
area, select either Subsets/Points or   Points/Subsets.

 5. In the Numeric Precision   area, choose your level of precision.

 6. Click Export.

Extending the Y Axis Ticks on an Enhanced Chart
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 To show the Y   Axis ticks on an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Grid Lines area, select Extend Y Axis Ticks.

 3. Click OK.

 

Naming an Enhanced Chart

 To name an enhanced   chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and, in the Object Name field, enter a name for the chart.

 3. Click OK.

Removing the Plotting Style Legend from an Enhanced Chart

 To remove the   plotting style legend from an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, clear the Show Plotting Style Legend   
check box.

 3. Click OK.

 

Removing the Data Source Legend from an Enhanced Chart

 To remove the   data source legend from an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, clear the Show Data Source Legend 
check   box.

 3. Click OK.

 

Selecting the Font Size and Type for an Enhanced Chart

 To select the   font size and type for an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Font tab   and in the Chart Font Size area, select a size for the chart's fonts.
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 3. In the Font Styles   area, select a font type for the Main Title, Sub-Title, Subset / Point   / Axis 
Labels, and Table Data.

 4. Optionally, select   a font face for the Main Title, Sub-Title, Subset / Point / Axis Labels,   and Table 
Data.

NOTE:   To help you visualize how your choices look, an example is displayed in   the Sample field.

 5. Click OK.

Setting Numeric Precision for Enhanced Charts

 To set the numeric   precision for an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Numeric Precision area, select the desired level of precision.

 3. Click OK.

Setting the Data Display Format for Enhanced Charts

 To set the data display format for   an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Display field, select the desired data display format.

 3. Click OK.

Showing Data Points on an Enhanced Chart

 To show data   points on an enhanced chart (method 1):

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Plotting   Style tab and in the Chart Plotting Style area, select a plotting style   that 
includes "Points" in the name.

 3. Select a Point Type   for each data source.

 4. Choose a color for   each data source.

 5. Click OK.

 To show data   points on an enhanced chart (method 2):

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, select Mark Data Points.

 3. Click OK.

 

Showing the Data Points Labels in an XY Chart 
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 To show data points labels on an   XY chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the Chart Style   tab and in the Miscellaneous area, select Include Data Labels.

 3. Click OK.

 

Showing the Expand/Contract Button in Enhanced Charts

 To show the expand/contract   button in an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and select Expandable.

 3. Click OK.

NOTES:

 l In run mode, moving the   cursor to the upper right corner of the chart displays the Expand or Contract   
button. This button toggles the size of the chart between a smaller view   and a larger view.

 l The expand/contract feature   can be used in conjunction with the Thumbnail feature if you want the   
smaller view to be thumbnail size with legible information available.

Showing the Time Cursor in Enhanced Charts

 To show the time   cursor in an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and in the Appearance area, select Show Time Cursor, and select As   Table 
or As Tool Tips for displaying the time cursor at run time.

 3. Select the Selectable   check box. 

 4. Click OK.

NOTE: In run   mode, clicking in the plot area freezes the time cursor where clicked;   clicking again frees the 
cursor.

Showing the Hover Tool Tips in Enhanced Charts

 To show the hover   tool tip in an enhanced chart:

 1. In the iFIX WorkSpace   picture, double-click the chart. The Enhanced Chart Customization dialog   
box appears.

 2. Click the General   tab and in the Appearance area, select Show Hover Tool Tip.

 3. Select the Selectable   check box. 

 4. Click OK.

Working with the Alarm Summary Object 
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In the iFIX WorkSpace, you can perform the following steps with   Alarm Summary objects:

 l Setting   a SCADA Server's Alarm Priority

 l Adding   Alarm Summary Objects to a Picture

 l Displaying   the Object's Properties Window

 l Changing   the General Appearance

 l Configuring   Colors, Fonts, and Styles

 l Filtering   or Sorting Alarms

 l Acknowledging   Alarms

 l Changing   Default Settings

 l Working   with Run-Time Settings and Properties
 

Setting a SCADA Server's Alarm Priority

 To set a SCADA   server's alarm priority:

 1. In the iFIX WorkSpace   configuration environment, open or create a picture.

 2. In Classic view,   from the Shapes toolbar, click the Data link button. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Datalink. 

-Or-

If the Toolbox is enabled, click the Datalink   button on the Toolbox.

The cursor changes to a plus sign.

 3. Click and drag the   mouse to define the size of the Data link. The Datalink dialog box appears.

 4. In the Source field,   enter the data source Fix32.node.System.A_SACPR.

 5. From the Type drop   down menu in the Data Entry area, select In-Place.

 6. Complete the remainder   of the Datalink dialog box.

 7. Switch to the run-time   environment and enter the SCADA server's alarm priority.

 

Adding Alarm Summary Objects to a Picture

 To add an Alarm   Summary object to a picture:

In Classic view, in the iFIX WorkSpace,   from the Shapes toolbar, select the Alarm Summary but-
ton. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Alarm Summary.
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-Or-

If the Toolbox is enabled, click the Alarm   Summary button on the Toolbox.

 

Displaying the Object's Properties Window

 To display the   object's Properties window:

 1. In the iFIX WorkSpace,   right-click the object.

 2. Select Property Window.   The Properties window appears.

 

Displaying The Number of Occurrences of an Alarm Since Last Acknowledgement

 To display the   number of occurrences of an alarm since last acknowledgement in an Alarm   Summary object:

 1. In the iFIX   WorkSpace, double-click the Alarm Summary object. The Alarm Summary Con-
figuration   dialog box appears.

 2. Select the   Column tab.

 3. From the   Available Columns list, double-click the user-defined field you want to   add to the spread-
sheet.

 4. In the user-defined   field, assign the A_ALMOCCUR block field. In the user-defined field name,   
type a name for the column header.

 

 

Changing the General Appearance

In the iFIX WorkSpace, you can perform the following steps to   change the general appearance of your 
working area:

 l Blinking   Unacknowledged Alarms

 l Stop Blinking of Unacknowledged Alarms

 l Changing   the Alarm Summary Object's Columns

 l Changing   the Column Order

 l Configuring   User-Defined Fields

 l Showing   or Hiding Alarm Summary Object Controls

 

Blinking Unacknowledged Alarms
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 To blink unacknowledged   alarms:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Select Blink Unack   Alarms.
 

Changing the Alarm Summary Object's Columns

 To change the   columns displayed by the Alarm Summary object:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Column   tab.

 3. Double-click the   columns in the Available Columns box to add them to the object.

 4. Double-click the   columns in the Selected Columns box to remove them from the object.

 

Changing the Column Order

 To change the   column order:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Column   tab.

 3. Select the column   you want to move from the Selected Columns box.

 4. Click the up arrow   button to move the column left in the spreadsheet.

 5. Click the down arrow   button to move the column right in the spreadsheet.

 

Configuring User-Defined Fields

 To configure   a user-defined field:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Column   tab.

 3. From the Available   Columns list, double-click the user-defined field you want to add to the   spread-
sheet.

 4. Enter a block field   name you want to assign to the user-defined field in the User Definable   
Columns area and click the <> button. The maximum length of the   field name is 50 characters.

 

Showing or Hiding Alarm Summary Object Controls

© 2024 General Electric Company. All rights reserved. 321



 To show or hide   column headings, scroll bars, row numbers, grid lines, or the 
status bar:

 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-
figuration   dialog box appears.

 2. Select the Display   tab.

 3. Select the check   boxes of the items you want to display.

 4. Clear the check boxes   of the items you want to hide.
 

Configuring Fonts, Colors, and Styles

In the iFIX WorkSpace, you can perform the following steps with   fonts, colors, and styles:

 l Configuring   Fonts for the Column Headings and Status Bar

 l Configuring   Unacknowledged Alarm Colors

 l Display Alarm Colors by Status or Priority

 l Set the Backgound Color of Alarms to Blink

 l Selecting   an Alarm's Font and Style

 l Selecting   the Alarm Foreground Color

 l Selecting   the Alarm Background Color

 

Configuring Fonts for the Column Headings and Status Bar

 To configure   fonts for the Alarm Summary column headings and status bar:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. On the General tab,   in the Fonts area, click the browse (...) button next to either the Alarm   
Column Headings or Status bar field. The font dialog box appears.

 3. Select the font name,   style, size, and/or script that you want to use.

 4. Optionally, repeat   steps 2 and 3 for the other configurable field.

 5. Click OK to accept   your changes and close the Font dialog box.

 6. In the Alarm Summary   Configuration dialog box, click Apply.

 

Configuring Unacknowledged Alarm Colors

 To configure   the color for unacknowledged alarms:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Color   tab.
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 3. Select the Unacknowledged   Alarm Color check box to enable it.

 4. Click the option's   color button. The Select Color dialog box appears.

 5. Select a color for   unacknowledged alarms, then click OK.
 

Selecting an Alarm's Font and Style

 To select an   alarm's font and style:

 1. In the iFIX WorkSpace, double-click the Alarm Summary object. The Alarm Summary Con-
figuration dialog box appears.

 2. Select the Color tab.

 3. In the Foreground Alarm Color area, next to the alarm priority or status, select the Font button.

 4. Select the font and style from the dialog box that appears.

 

Setting the Alarm Foreground Color

 To select the   alarm foreground color:
 1. In the iFIX WorkSpace, double-click the Alarm Summary object. The Alarm Summary Con-

figuration dialog box appears.

 2. Select the Color tab. 

 3. Next to each alarm priority or status, double-click the   color. The Select Color dialog box appears.

 4. Select a new color for the alarm status or priority and then click OK.

 5. Repeat the previous two steps for each row in the Foreground Alarm Color area.

 6. If the Unacknowledged Alarm Color option is enabled, double-click the color next the field  to 
define the unacknowledged alarm color. 

 7. Click Apply.

 

 

Selecting the Alarm Background Color

 To select the   alarm background color:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Color   tab.

 3. Next to each alarm priority or status, double-click the   color. The Select Color dialog box appears.

 4. Select a new color   for the alarm and then click OK.
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 5. Repeat steps the previous two steps  for each row in the Background Alarm Color area.

 6. If the Blink to Color   option is enabled, in the second column for each alarm priority or status,   
select a blinking color. Double-click the color in the second row   to define the blink color. 

 7. Repeat the previous step for   each row that you want to define a color for the blink feature.

 8. Click Apply.

 
 

Filtering or Sorting Alarms

In the iFIX WorkSpace, you can perform the following steps with   alarms:

 l Appending   Filter Conditions

 l Changing   Boolean Operators

 l Configuring   Alarm Summary to Sort Alarms

 l Creating   Filter Conditions

 l Deleting   Filter Conditions

 l Inserting   Filter Conditions

 l Modifying   Filter Conditions

 

Appending Filter Conditions

 To append a filter   condition:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Filter   tab.

 3. Select the column   you want to add to your filter condition.

 4. Click Add Filter   Condition and complete the dialog box that appears.

NOTE:   The Alarm Summary object supports up to ten filter conditions. 

 

Changing Boolean Operators

 To change the   Boolean operator:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Filter   tab.
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 3. Select the portion   of the filter condition you want to modify.

 4. Click OR,   AND, or NOT   to change the Boolean operator. 
 

Configuring Alarm Summary to Sort Alarms

 To configure   the Alarm Summary object to sort alarms:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Sort tab.

 3. Select the attribute   you want to sort by.

 4. Select whether you   want to sort alarms in ascending or descending order.

 

Creating Filter Conditions

 To create a filter   condition:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Filter   tab.

 3. Double-click each   column you want to filter on and complete the dialog box that appears.

NOTE:   The Alarm Summary object supports up to ten filter conditions. 

 

Deleting Filter Conditions

 To delete a filter   condition:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Filter   tab.

 3. From the Display   Alarms Where box, select the portion of the filter condition you want   to delete 
and click Remove.

Inserting Filter Conditions

 To insert a filter   condition:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Filter   tab.
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 3. From the Display   Alarms Where box, highlight the portion of the filter condition where   you want to 
insert a new condition.

 4. From the Fields box,   select the column you want to add to the filter condition.

 5. Click Insert Filter   Condition and complete the dialog box that appears.

NOTE:   The Alarm Summary object supports up to ten filter conditions. 
 

Modifying Filter Conditions

 To modify a filter   condition:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Filter   tab.

 3. From the Display   Alarms Where box, select the portion of the filter condition you want   to modify.

 4. Click Modify. The   Modify Area dialog box appears.

 5. In the Modify Area   dialog box, enter the required changes and click OK.

 

Acknowledging Alarms

In the iFIX WorkSpace, you can perform the following steps with   alarm acknowledgments:

 l Acknowledging   Alarms with the Alarm Summary Object

 l Creating   a Data Link That Displays Alarms

 

Acknowledging Alarms with the Alarm Summary Object

 To acknowledge   alarms with the Alarm Summary object:
 l For a single   alarm, right-click the object in the iFIX WorkSpace and select Acknowledge   from the 

pop-up menu.

 l For all alarms,   right-click the object in the iFIX WorkSpace and select Acknowledge All   from the 
pop-up menu.

 l For all alarms   currently displayed on the screen, right-click the object in the iFIX   WorkSpace and 
select Acknowledge Page from the pop-up menu.

 

Creating a Data Link That Displays Alarms
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 To create a Data   link that displays alarms:
 1. Open or create a   picture in the iFIX WorkSpace.

 2. In Classic view,   from the Shapes toolbar, click the Data link button. 

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Datalink. 

-Or-

If the Toolbox is enabled, click the Datalink   button on the Toolbox.

The cursor changes to a plus sign.

 3. Click and drag the   mouse to define the size of the Data link. 

 4. In the Source field,   enter the data source you want to use. Use the A_CUALM field name when   
entering a data source to show the current alarm.

 5. Complete the remainder   of the Datalink dialog box.
 

Changing Default Settings

In the iFIX WorkSpace, you can perform the following steps with   the default settings:

 l Restoring   the Alarm Summary Object's Default Settings

 l Saving   the Alarm Summary Object's Current Settings

 

Restoring the Alarm Summary Object's Default Settings

 To restore the   Alarm Summary object's default settings:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Click Reset. The   default settings get applied to the selected Alarm Summary object. 

TIP:   Only the settings in the selected   Alarm Summary object get restored. If you want other Alarm Sum-
mary objects   that you create after this one to also use the same default settings,   click Save. This saves 
your Alarm Summary settings to the AlarmSummary.ini   file in the LOCAL folder (by default: C:\Program 
Files (x86)\Proficy\iFIX\LOCAL), so that subsequent Alarm Summary objects will apply these   default 
settings when you first drop the object into your picture. 

 

Saving the Alarm Summary Object's Current Settings

 To save the Alarm   Summary object's current settings:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.
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 2. Click Save. This   saves the currently selected Alarm Summary object's settings into the   
AlarmSummary.ini file in the LOCAL folder (by default: C:\Program Files (x86)\Profi-
cy\iFIX\LOCAL), so that subsequent Alarm Summary objects that   you add to your pictures will 
use these settings by default. 

IMPORTANT:   Be aware that the filtering string added in run mode will not get reloaded when nav-
igating away from the picture and then returning back to the picture with the Alarm Summary object.  
The AlarmSummary.ini file is read only by the new AlarmSummary.OCX when it is added in con-
figuration mode.
 

Working with Run-Time Settings and Properties

In the iFIX WorkSpace, you can perform the following steps with   the run-time settings and properties:

 l Configuring   the Selection Timeout

 l Enabling   and Disabling Alarm Summary Operator Properties

 l Setting   the Alarm Refresh Rate

 l Setting   the Blink Rate

 l Setting   the Data Refresh Rate

 l Showing   the Latched or Current Alarm Status

 l Reversing the Text and Background Colors of Alarms Based on Acknowledgment State

 

Configuring the Selection Timeout

 To configure   the selection timeout:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Enter the number   of seconds the Alarm Summary object should wait before deselecting an   alarm.

 

Enabling and Disabling Alarm Summary Operator Properties

 To enable and   disable the Alarm Summary operator properties:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Operator   tab.

 3. Select the check   box of each property you want to enable.

 4. Clear the check box   of any property you want to disable.

 

Setting the Alarm Refresh Rate
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 To set the alarm   refresh rate:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Enter the number   of seconds the Alarm Summary object should wait before reading its queue   for 
new alarms.

 

Setting the Blink Rate

 To set the blink   rate:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Enter the rate, in   seconds, that the Alarm Summary object should flash unacknowledged alarms.

 

Setting the Data Refresh Rate

 To set the data   refresh rate:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Enter the number   of seconds the Alarm Summary object should wait before updating the alarm   
values displayed on the screen. 

 

Showing the Latched or Current Alarm Status

 To show the latched   or current alarm status in the Alarm Summary window:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Select the Show Current   Alarm Status or Show Latched Alarm Status option.

 4. Click Apply.

 

 

Reversing the Text and Background Colors of Alarms Based on Acknowledgment State
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 To reverse the text and background colors of unacknowledged alarms:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Select the Reverse   Colors On Unack Alarms option. 

 4. Click Apply. 

 To reverse the text and background colors of acknowledged alarms:
 1. In the iFIX WorkSpace,   double-click the Alarm Summary object. The Alarm Summary Con-

figuration   dialog box appears.

 2. Select the Display   tab.

 3. Select the Reverse Colors On Ack Alarms option.

 4. Click Apply. 
 

Working with Groups 

In the iFIX WorkSpace, you can perform the following steps with   grouping objects and layers:

 l Grouping   Two or More Objects

 l Ungrouping   Objects

 l Animating   Grouped Objects

 l Drilling   Down into a Group

 l Setting   Object Layers

 l Displaying   Layers in Pictures

 

Grouping Two or More Objects

 To group two   or more objects:

 1. In the iFIX WorkSpace,   control-click the objects.

 2. In Classic view,   from the Tools toolbar, click the Group button. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Group. 

-Or-

If the Toolbox is enabled, click the button   on the Toolbox.

The objects are grouped together and a group   object appears in the WorkSpace system tree.

 

Ungrouping Objects

330 © 2024 General Electric Company. All rights reserved.



 To ungroup an   object:

 1. In the iFIX WorkSpace,   select the grouped object.

 2. In Classic view,   from the Tools toolbar, click the Ungroup button. 

-Or-

In Ribbon view, on the Format tab, in the   Arrange group, click Ungroup. 

-Or-

If the Toolbox is enabled, click the Ungroup   button on the Toolbox.

The group object is removed from the system   tree but the member objects remain.

 

Animating Grouped Objects

 To animate a   grouped object:

 1. In the iFIX WorkSpace,   right-click the group you want to animate, and select Animations. The   
Basic Animation dialog box appears.

 2. Click the appropriate   Expert button.

 3. Enter the configuration   information for the Animation Expert.

 

Drilling Down into a Group

 To drill down   into a group:

 1. In the iFIX WorkSpace,   select the group containing the object you want to modify. 

 2. Right-click the group   and choose Enter DrillDown. A box appears around the group.

 3. Select the object   in the group you want to change.

 4. Make the changes   you require. When finished, deselect the object and the group. The box   dis-
appears.

 

Setting Object Layers

 To set a layer   for an object:

 1. In the iFIX WorkSpace,   select the object you want to set a layer for.

 2. In Classic view,   on the Tools toolbar, click the Set Layer button. 

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Layers, and then click Set Layer. 

-Or-

If the Toolbox is enabled, click the Set   Layer button on the Toolbox.

© 2024 General Electric Company. All rights reserved. 331



 3. Click the button   that represents the number of the layer you want to assign. To assign   multiple 
layers, select the Allow for Multiple Layers check box and then   click the numbered buttons, or 
click Select All. If you make a mistake,   click Deselect All and repeat this step.

 4. Click OK.

 

Displaying Layers in Pictures

 To display layers   in a picture:

 1. In Classic view,   in the iFIX WorkSpace Tools toolbar, click the Display Layers button.   

-Or-

In Ribbon view, on the Format tab, in the   Picture group, click Layers, and then click Display 
Layer. 

-Or-

If the Toolbox is enabled, click the Display   Layers button on the Toolbox.

 2. Click the button   that represents the layer you want to display. To select all possible   layers to be 
displayed, click Select All Layers. If you make a mistake,   click Deselect All Layers and repeat 
this step.

 3. Click OK.

 

Using Color

In the iFIX WorkSpace, you can perform the following steps with   colors:

 l Color   Selection Overview – Modal

 l Color   Selection Overview – Modeless

 l Adding   Fade, Foreground, Background, or Edge Colors to Objects

 l Setting   the Background Color of a Picture

 l Setting   the Fade Color of a Picture

 l Setting   the Blend Percentage of a Picture's Fade Color

 l Setting   the Blend Percentage of an Object's Fade Color

 l Selecting   Color Sets

 l Assigning   Colors to Properties

 l Creating   Custom Color Sets

 l Assigning   a Custom Name to a Color

 l Coloring   Objects by Analog Values

 l Coloring   Objects by Digital Values
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Adding Fade, Foreground, Background, or Edge Colors to Objects

 To add a fade   color to a specific object:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Fade. The Select 

FadeColor   dialog box appears.

 2. Click the Fade button.   The Select Color dialog box appears.

 3. Select a color and   click OK. To select a name, click the Name tab and select a color name   from 
the list.

 To add a foreground   color to a specific object with no gradient fill:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Foreground. The Select   

ForegroundColor dialog box appears.

 2. Select a color and   click OK. To select a name, click the Name tab and select a color name   from 
the list.

 To add a foreground   color to a specific object with a gradient fill:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Foreground. The Select   

ForegroundColor dialog box appears.

 2. Click the Foreground   button. The Select Color dialog box appears.

 3. Select a color and   click OK. To select a name, click the Name tab and select a color name   from 
the list.

 To add a background   color to a specific object:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Background. The Select   

BackgroundColor dialog box appears.

 2. Select a color and   click OK. To select a name, click the Name tab and select a color name   from 
the list.

 To add an edge   color to a specific object:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Edge. The Select 

EdgeColor   dialog box appears.

 2. Select a color and   click OK. To select a name, click the Name tab and select a color name   from 
the list.

 

Setting the Background Color of a Picture

 To set the background   color of a picture:
 1. In the iFIX WorkSpace,   right-click any area in the picture outside of an object and choose Picture.   

The Edit Picture dialog box appears.

 2. Click the Background   Color button. The Select BackgroundColor dialog box appears.

 3. Select the color   you want and click OK.
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Setting the Fade Color of a Picture

 To set the fade   color of a picture:
 1. In the iFIX WorkSpace,   right-click any area in the picture outside of an object and choose Picture.   

 2. Click the Fade Color   button. 

 3. Select the color   you want and click OK.

 

Setting the Blend Percentage of a Picture's Fade Color

 To set the blend   percentage of a picture's fade color:
 1. In the iFIX WorkSpace,   right-click any area in the picture outside of an object and choose Picture.   

The Edit Picture dialog box appears.

 2. Select the Gradient   enabled check box and then select the fade type you want to apply to the   
gradient.

 3. Move the Blend slider   to increase or decrease the amount of fade color you want applied to the   
fade type. The higher the percentage, the more fade color is visible.

 

Setting the Blend Percentage of an Object's Fade Color

 To set the blend   percentage of an object's fade color:
 1. In the iFIX WorkSpace,   right-click the object, point to Color, and choose Fade. The Select 

FadeColor   dialog box appears.

 2. Move the Blend slider   to increase or decrease the amount of fade color you want applied to the   
fade type. The higher the percentage, the more fade color is visible.

 

Selecting Color Sets

 To select a color   set:
 1. In the iFIX WorkSpace,   right-click an object, point to Color, and choose Fade, Foreground, Back-

ground,   or Edge. The applicable Select Color dialog box appears.

- Or -

Select an object and click the Color button   in the Toolbox. The Select Color dialog box appears.

 2. In the Color Set   field, select a color set from the list box.

 

Assigning Colors to Properties
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 To assign a color   to a property:
 1. In Classic view,   in the iFIX WorkSpace, on the Tools toolbar, click the Color button. 

-Or-

In Ribbon view, on the Format tab, in the   Styles group, click Color Selection. 

-Or-

If the Toolbox is enabled, click the Color   button on the Toolbox.

 2. In the Property field,   select the property you want. Use the drop-down menu if necessary.

 3. Select a color from   the Color Selection dialog box.
 

Selecting Color Sets

 To select a color   set:
 1. In the iFIX WorkSpace,   right-click an object, point to Color, and choose Fade, Foreground, Back-

ground,   or Edge. The applicable Select Color dialog box appears.

- Or -

Select an object and click the Color button   in the Toolbox. The Select Color dialog box appears.

 2. In the Color Set   field, select a color set from the list box.

 

Creating Custom Color Sets

 To create a custom   color set:
 1. In Classic view,   in the iFIX WorkSpace, on the Tools toolbar, click the Color button. 

-Or-

In Ribbon view, on the Format tab, in the   Styles group, click Color Selection. 

-Or-

If the Toolbox is enabled, click the Color   button on the Toolbox.

 2. Click either the   Color tab to display the color palette, or the Name tab to display a list   of colors.

 3. Click New Color Set.   

 4. Enter a palette name   in the Name field and click OK. The palette name is added to the Color   Set 
list box.

 

Assigning a Custom Name to a Color

 To assign a custom   name to a color:
 1. In Classic view,   in the iFIX WorkSpace, on the Tools toolbar, click the Color button. 
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-Or-

Ribbon view, on the Format tab, in the Styles   group, click Color Selection.

-Or-

If the Toolbox is enabled, click the Color   button on the Toolbox.

 2. From the Color Set   field, select a color set. 

 3. Click the Customize   Color button.

NOTE:   The Customize Color button is not available if you selected System Default   as the color set.

 4. Click a location   in the palette that most closely represents the color you want. 

 5. Specify the shade   of the color spectrum by clicking the mixer bar to the right of the palette   and 
click OK. For a more precise selection, adjust the slider by clicking   and dragging it.

 6. Enter a specific   name to identify your color.
 

Coloring Objects by Analog Values

 To color an object   by analog value:
 1. In the iFIX WorkSpace,   select an object.

 2. Click the appropriate   Color Expert on the Experts toolbar.

-Or-

In Classic view, click the Task Wizard button   on the WorkSpace toolbar. 

-Or-

In Ribbon view, from the Tools tab, in the   Animations group, click Animations. Select the appro-
priate Color Expert   from the Task Wizard dialog box and click the Perform Task button.

 3. In the Data Source   field, enter a data source.

 4. Select the Range   option above the lookup table.

 5. Select a Minimum   and Maximum cell in the lookup table row that corresponds to the color   you 
want to assign to those values.

 6. Enter the appropriate   low and high limit values for the color selection in the row.

 

Coloring Objects by Digital Values

 To color an object   by digital value:
 1. In the iFIX WorkSpace,   select an object.

 2. Click the appropriate   Color Expert on the Experts toolbar.

-Or-

In Classic view, click the Task Wizard button on   the WorkSpace toolbar. 

-Or-

336 © 2024 General Electric Company. All rights reserved.



In Ribbon view, from the Tools tab, in the   Animations group, click Animations. Select the appro-
priate Color Expert   from the Task Wizard dialog box and click the Perform Task button.

 3. In the Data Source   field, enter a data source.

 4. Select the Exact   Match option above the lookup table.

 5. If desired, enter   a tolerance value in the Exact Match Tolerance field.

 6. Double-click a Value   cell in a lookup table row that corresponds to the color you want to assign   to 
that value.

 7. Enter the appropriate   digital value for the color selection in the row.
 

Using Process Assistants to Expedite Pictures

By studying the trends in today's users, and focusing specifically on   iFIX users, GE has developed a set 
of performance support tools   that let you tap the power of iFIX with minimal effort. These tools include:

 l Wizards

 l Experts

 l Dynamos

 l Global   Subroutines

 l Toolbars

Each of these tools are described in this chapter.

Using Wizards and Experts 

GE developed Wizards and Experts with one goal in mind – allow users   to unleash the power of iFIX 
quickly and easily. Wizards and Experts are   essentially simplified user interfaces that help you accom-
plish a task.   

The fundamental difference between Wizards and Experts is:

 l Wizards consist of a series   of dialog boxes that guide you through a process and engage you in 
dialog   that helps you understand that process. 

 l Experts consist of one dialog   box that requires minimum input to quickly perform a task. They 
provide   an easier way to animate objects or execute scripts, tasks that you can   also accomplish 
using the Basic Animations dialog box. 

iFIX Wizards and Experts were created to help both advanced and novice   users. Advanced users can 
carry the process to additional steps, perhaps   by using a powerful feature of VBA, re-entering an Expert 
after performing   another function, or learning a new feature by implementing it.

Novice users can run a Wizard or Expert in an effort to complete a more   complicated task without adapt-
ing to new concepts or technology. Although   the underlying foundation of Wizards and Experts is Visual 
Basic, you   never need to be exposed to or versed in VBA to use these tools.
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Ultimately, employing Wizards and Experts in your picture development   means you can complete 
desired tasks and enjoy the results.

Running Wizards 

iFIX provides the following Wizards:

 l Task   – Access   from a button on the Standard toolbar. 

 l Generate   – Access   through the Generate option on the Blocks menu of the Database Manager.   

 l Backup   and Restore –   Access through the iFIX menu on the Programs menu of the Start menu. 

 l Create   Picture –   Access through the Task wizard, using one of the following methods:

 l by right-clicking   on the Pictures folder in the system tree, 

 l by selecting   New from the File menu in the WorkSpace (Classic view), 

 l by clicking Picture   in the New group, on the Home tab  (Ribbon   view), 

 l by clicking the   WorkSpace button, selecting new and clicking Picture (Ribbon view),   or 

 l from one of the   following toolbars: Experts, Standard, or Toolbox. 

NOTE: To access   the Create Picture wizard from the Menu Bar, the Ribbon, the System Tree,   or the 
Standard toolbar, you must have the Show Picture Wizard from New   Picture Menu check box enabled 
on the Picture Preferences tab of the User   Preferences dialog box.

 l Multiple   Command Script –   Access from the Command category of the Task Wizard, the Click 
Event button   in the Basic Animation dialog box, or the Run Wizard button in the Key   Macro Editor 
or Scheduler.

The following table shows how these Wizards can be used in iFIX. 

While doing 
the fol-
lowing...

You can 
use the...

To...

Resolving a 
picture

Task Wiz-
ard

Run the Resolve utility. For more information, refer   to the Resolving Pic-
tures section.   To learn how to use the Task Wizard, refer to the Using  
Experts and the Task Wizard  section of the Understanding iFIX manual.

Building a 
database

Generate 
Wizard

Add blocks to your database. For more information,   refer to the Working  
with the Process Database chapter in the Building a SCADA System 
manual.

Managing 
your files

Backup 
and 
Restore 
Wizard

Archive all of your iFIX configuration files. For   more information, refer to the 
Backing  up and Restoring Files section of the Understanding iFIX manual.

Creating a pic-
ture or set of 
pictures

Create Pic-
ture Wiz-
ard

Set the sizes, locations, and properties of an individual   picture or a group of 
pictures. For more information, refer to the Using the Create Picture   Wiz-
ard section in this manual.

Assigning mul-
tiple com-

Multiple 
Command 

Create a sequence of commands that are executed in response to a trigger   
event such as a mouse click, Scheduler entry, or key macro. For more 

Wizards   in iFIX 
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mands to an 
event

Script Wiz-
ard

information,   refer to the Multiple Command Script   Wizard section.

 

Running Experts 

You can easily access iFIX Experts in the WorkSpace while you are drawing   your pictures. In our online 
help, Experts are included in procedures   to help you expedite your task. For more information on how to 
complete   the dialog fields in the Expert, use the Help provided with the Expert   (in some instances, you 
must click the Help button and access a procedures   window). The following table shows some 
examples of Experts used in iFIX.   

While doing 
the fol-
lowing...

You can 
use the...

To...

Coloring 
objects

Foreground 
Color 
Expert

Assign a foreground color to objects. For more information   on 
defining a color strategy, refer to the Working   with Color section.

Creating sched-
ules

Script 
Authoring 
Expert

Write a script to schedule events (example: Toggle   Digital 
Point). For more information, refer to the Writing  Scripts manual.

Developing pic-
tures

Rotate 
Expert

Rotate a selected object. For more information on   rotating 
objects, refer to the Rotating   Objects section.

Using Experts in iFIX    

To run an Expert, click the appropriate button on the Experts toolbar,   complete the dialog fields and click 
OK.

Using the Task Wizard to Run Experts 

iFIX gives you a convenient organizer to access, customize, and run   Experts –   the Task Wizard. The 
Task Wizard allows you to choose a category relating   to what action you want to perform, and then 
select a task specific to   that category. All Experts can be accessed from the Task Wizard, but some   are 
not available from the Experts toolbar. These Experts can be accessed   on the Buttons tabbed page of 
the Customize Toolbars dialog box and added   to a toolbar. In Ribbon view, all Experts can be accessed 
via the Tasks/Experts   launch button on the Tools tab in the Tasks/Experts group.

For more information on adding buttons to a toolbar, refer to the Customizing Toolbars   section of the 
Understanding iFIX manual. 

The following table shows you which Experts are available on the Task   Wizard and the Experts toolbar, 
and what functions they perform: 

Click this 
Expert from   
the Experts 
toolbar...

Which can be accessed in the 
Ribbon view...

To...

Fill From the Tools tab, in the Anim-
ations group, click   Fill.

Dynamically fill an object.

iFIX Experts  
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Rotate From the Tools tab, in the Anim-
ations group, click   Rotate.

Rotate an object.

Position From the Tools tab, in the Anim-
ations group, click   Position.

Move an object horizontally or vertically across 
the   screen.

Scale From the Tools tab, in the Anim-
ations group, click   Scale.

Scale an object.

Visibility From the Tools tab, in the Anim-
ations group, click   Visibility.

Make an object visible or invisible.

Edge Color From the Tools tab, in the Anim-
ations group, click   Edge Color.

Change the edge color of an object.

Foreground 
Color

From the Tools tab, in the Anim-
ations group, click   Foreground 
Color.

Change the foreground color of an object.

Background 
Color

From the Tools tab, in the Anim-
ations group, click   Background 
Color.

Change the background color of an object.

Data Entry From the Tools tab, in the 
Tasks/Experts group, click   Data 
Entry Expert. 

Modify a tag.

Create Picture 
Wizard

From the Tools tab, in the 
Tasks/Experts group, click   Picture 
and then click Create Picture Wiz-
ard.

Create, size, and locate a group of pictures.

Open Picture From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Open Pic-
ture.

Open a new picture on an object's click event.

Close Picture From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Close Pic-
ture.

Close a picture on an object's click event.

Replace Picture From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Replace Pic-
ture.

Close an open picture and replace with a new pic-
ture   on an object's click event.

Open Digital 
Tag

From the Tools tab, in the 
Tasks/Experts group, click   Com-

Open a digital point on an object's click event.
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mands and then click Open Digital 
Tag.

Close Digital 
Tag

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Close Digital 
Tag.

Close a digital point on an object's click event.

Toggle Digital 
Tag

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Toggle 
Digital Tag.

Toggle a digital point on an object's click event.   

NOTE: In this   expert, use the F_CV   field as the 
data link. Using the A_CV   field may cause unpre-
dictable results.

Acknowledge 
Alarm

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Acknow-
ledge Alarm.

Acknowledge an alarm on an object's click event.

Alarm Horn From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Alarm Horn.

Enable, disable, or silence the alarm horn. Also 
prompt   for alarm horn status in run mode and 
toggle the horn status between enable   and dis-
able.

The following table shows you the additional Experts available from   the Task Wizard (but not from the 
Experts toolbar) and what functions   they perform: 

From this 
Task Cat-
egory...

Click this 
Expert...

Which can be accessed in the 
Ribbon View...

To...

Command

Ramp Tag 
Value

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Ramp Tag Value.

Ramp a specified database 
tag by a percentage or actual   
value that you define.

Write Value to 
Tag

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Write Value to 
Tag.

Write a value you select to 
the specified database   tag.

Turn Tag On 
Scan

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Turn Tag On 
Scan.

Turn a specified database 
tag on scan. 

Turn Tag Off 
Scan

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Turn Tag Off 
Scan.

Turn a specified database 
tag off scan. 

Toggle Scan
From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Toggle Scan.

Toggle a specified database 
tag on and off scan.

Set Tag Auto
From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Set Tag Auto.

Set a specified database tag 
to automatic.

Additional Experts in the Task    Wizard  
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Set Tag Manual
From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Set Tag Manual.

Set a specified database tag 
to manual.

Set Symbol Val-
ues

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Set Symbol Val-
ues.

Replace multiple symbols in 
the picture with specific val-
ues at run time.

Set Symbol 
From Model 
Browse

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Set Symbol From 
Model Browse.

Set a symbol’s value by 
browsing and selecting a 
model object instance at run 
time.

Toggle Tag 
Auto/Manual

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Toggle Tag 
Auto/Manual.

Toggle a specified database 
tag between auto and 
manual.

Acknowledge 
All Alarms

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Acknowledge All 
Alarms.

Acknowledge all new alarms 
in the specified picture.

Disable Alarm
From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Disable Alarms.

Disable all new alarms in the 
specified picture.

Enable Alarm
From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Enable Alarms.

Enable all new alarms in the 
specified picture.

Locate Object
From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Locate Object.

Find a specified object.

Print Crystal 
Report

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then Print Crystal 
Report.

Prints a specified Crystal 
Report.

Database

Add Database 
Block

From the Applications tab, in the 
Process Database   group, click 
Blocks and then click Add Data-
base Block.

Add a new database block 
without opening Database   
Manager.

Modify Data-
base Block

From the Applications tab, in the 
Process Database   group, click 
Blocks and then click Modify Data-
base Block.

Modify a database block 
without opening Database 
Manager.

Database Save
From the Applications tab, in the 
Process Database   group, click 
Save Database.

Save the database.

Database 
Reload

From the Applications tab, in the 
Process Database   group, click 
Reload Database. 

Reload the database.

Data Entry Data Entry From the Tools tab, in the 
Tasks/Experts group, click   
Tasks/Experts. Select Data Entry 

Enter the data source that 
the data entry gets written   to.
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from the Task Categories menu 
and Data   Entry from the Task list. 
Click Perform Task. 

Picture

Resolve Files From the Tools tab, in the 
Tasks/Experts group, click   
Tasks/Experts. Select Picture 
from the Task Categories menu 
and Resolve   Files from the Task 
list. Click Perform Task.

Resolve files before you 
enter into the run-time envir-
onment.

Generate New 
Picture

From the Tools tab, in the 
Tasks/Experts group, click   Pic-
ture and then click Generate Pic-
ture Expert.

Generate a new picture.

Refresh Rate

From the Tools tab, in the 
Tasks/Experts group, click   Pic-
ture and then click Refresh Rate 
Expert.

Change the refresh rate for a 
selected object or an   entire 
picture.

Export Key Mac-
ros

From the Tools tab, in the 
Tasks/Experts group, click   Pic-
ture and then click Export Key 
Macros.

Export all of the key macros 
in the selected object,   pic-
ture, or user global page to a 
.CSV file. 

Save Files with 
Thumbnail 
Preference

From the Tools tab, in the 
Tasks/Experts group, click   
Tasks/Experts. Select Picture 
from the Task Categories menu 
and Save Files   with Thumbnail 
Preference from the Task list. 
Click Perform Task.

Save thumbnails of existing 
pictures and Dynamo Sets.

Convert a Selec-
ted  Button's   
Caption 

From the Application tab, in the 
Utilities group,   on the drop down 
menu, click Convert a Selected 
Button's Caption.

Converts one button caption 
text to scale to a new   screen 
resolution in pictures using 
the Enhanced Coordinate 
System.

Multiple Button 
Caption Con-
verter Expert

From the Application tab, in the 
Utilities group,   on the drop down 
menu, click Multiple Button Cap-
tion Converter Expert.

Converts more than one or all 
the button caption text   to 
scale a new screen res-
olution in  pictures   using the 
Enhanced Coordinate Sys-
tem.

Upgrade to 
Enhanced 
Coordinates 

From the Applications tab, in the 
Utilities group,   click Upgrade to 
Enhanced Coordinates.

Upgrade one or more pic-
tures/Dynamo Sets to the 
Enhanced   Coordinate Sys-
tem -Or- Restore one or more 
pictures/dynamo Sets to the   
Logical Coordinate System. 

Report Print Crystal 
Report

From the Tools tab, in the 
Tasks/Experts group, click   Com-
mands and then click Print Crystal 
Report.

Prints a specified Crystal 
Report.
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You can also create your own Experts to help you automate processes   that you do often. This can be 
done through VBA   scripts. For more information on creating your own Experts, refer to the   Writing 
Scripts manual. To learn   how to use the Task Wizard, refer to the Using  Experts and the Task Wizard 
section of the  Understanding iFIX manual.

IMPORTANT: If you are   working in a secure environment and using the Electronic Signature option,   you must 
be aware of the impact of unsigned writes to the process database.   Unsigned writes can originate from scripts 
Refer to the Implications  of Database Writes With Electronic Signature section of the Using   Electronic Sig-
natures manual for detailed information. When you use certain   Experts, such as Toggle Digital, you are 
prompted to sign if the associated   tag is configured for electronic signature. For complete information on   a 
secure environment and electronic signatures, refer to the Using  Electronic Signatures   manual.
Re-entering Experts 

All of the Experts in the Animation category of the Task Wizard have   re-entrance   functionality, allowing 
you to exit the Expert, make any changes   you want within your picture, and then go back into the Expert 
to resume   inputting data to complete the task. These Experts include the following:

 l Fill 

 l Foreground Color   

 l Edge Color 

 l Background Color   

 l Rotate 

 l Scale 

 l Visibility 

 l Position 

You can also re-enter the Data Entry Expert, located in the Data Entry   category of the Task Wizard.

NOTE: The Data Entry   Expert writes a script to a selected object; therefore, it will not retain   its re-entrance 
functionality if you change the code. Instead, it will   act as though there are no data entry parameters, and will 
therefore write   over the existing script.
Notes About VBA   Code Generated by Experts

Some of the iFIX Experts generate VBA   code. Occasionally, a conflict can occur between the VBA   code 
generated by the Expert and the VBA   code for a picture, variable, or globals   page because of naming 
conflicts. When a conflict like this occurs, the   solution is to change the name of your picture, variable, of 
globals   subroutine.

For example, do not name a picture after one of Data Entry Expert types.   Picture names can conflict 
with the script variable names used with the   Data Entry Expert. For instance, if you name your picture 
Pushbutton.grf   and also use the Pushbutton   data entry method, when you enter run mode, an error mes-
sage appears.   If you rename the picture, Pushbutton1.grf, the error message does not   appear, since the 
picture name is now different than the data entry method.   
 

Multiple Command Script Wizard
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The Multiple Command Script Wizard enables you to create a sequence   of commands, using one or 
more Command Experts, that is triggered by one   of these types of events: a mouse click on an object in 
a picture, a time-based   or event-based Scheduler entry, or a key macro.

When you open the wizard and select a command, the Expert associated   with the command will appear.  
The   selections you make in the Expert automatically create a VBA script that   is run when the trigger 
event occurs.  Each   time you add a command in the wizard, its corresponding Expert will appear,   
enabling you to append the Expert's VBA script to the scripts created   by the previous commands in the 
sequence.

You can use the wizard to delete or re-order commands in the sequence.    When you   do this, the VBA 
script associated with the affected commands will be   automatically deleted or re-ordered to reflect the 
new sequence displayed   in the wizard.

 To use the Multiple   Command Script Wizard:

 1. In the Key Macro   Editor, Scheduler, or the Basic Animation dialog box, access the Multiple   Com-
mand Script Wizard.

 2. Add one or more commands   by either selecting one from the Select Action to Append list, or click-
ing   the Append Action button to add the currently selected command.

 3. Optionally, move   a command to a different position in the sequence by selecting it and   clicking 
the Up or Down arrow button.

 4. Optionally, delete   a command from the sequence by selecting it and then clicking the Delete   
Action button, or delete all commands by clicking the Delete All Actions   button.

 5. Optionally, modify   a command by clicking the Modify a Selected Action button. When the Expert   
for the associated command appears, make your changes to the Expert's   settings and click OK.

NOTES:

 l Although the Multiple   Command Script Wizard's purpose is to fully automate the VBA command script-
ing   process, you can manually edit scripts generated by the wizard with the   VB Editor. You may add or 
edit VBA scripts anywhere before the Scripts   Authoring Tool header line (***** Scripts Authoring Tool 
*****), or directly   between a "WizardEnd" and a “Wizard[x]=” statement. Do not edit   any of the com-
mented areas in the wizard-generated script. If the Multiple   Command Script Wizard detects an 
improperly customized VBA script, you   may encounter an error.

 l The Multiple Command   Script Wizard does not check the command sequence to make sure com-
mands   occur in a logical order. 

Experts Summary

The following experts are available for use in iFIX.

Animation Experts

 l Color   Experts

 l Fill   Expert

 l Position   Expert

 l Rotate   Expert

 l Scale   Expert

© 2024 General Electric Company. All rights reserved. 345



 l Visibility   Expert

 l Display   Layers Expert

 l Set   Layer Expert

Command Experts

 l Selecting   a Command

 l Acknowledge   Alarm

 l Acknowledge   All Alarms

 l Alarm   Horn

 l Close   Digital Tag

 l Close   Picture

 l Disable   Alarm

 l Enable   Alarm

 l Locate   Object

 l Open   Digital Tag

 l Open   Picture

 l Print   Crystal Report

 l Ramp   Tag Value

 l Replace   Picture

 l Set   Tag Auto

 l Set   Tag Manual

 l "Set Symbol Values Expert" on page 378

 l "Set Symbol from Model Browse Expert" on page 379

 l Shelve Expert

 l Toggle   Digital Tag

 l Toggle   Tag Auto/Manual

 l Toggle   Scan

 l Turn   Tag Off Scan

 l Turn   Tag On Scan

 l Unshelve Expert

 l Write   Value to Tag

Data Entry Expert

 l Data   Entry Expert
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Database Experts

 l Add   Database Block

 l Database   Reload

 l Database   Save

 l Modify   Database Block Expert

 l Read   a Value Expert

Picture Experts

 l Button   Caption Converter

 l Export   Key Macros

 l Generate   Picture Expert

 l Refresh   Rate Expert

 l Resolve   Files Expert

 l Save   Files with Thumbnail Preferences

 l Upgrade   File to Enhanced Coordinates

Report Experts

 l Cross   Reference Tool

 l Print   Crystal Report

 l Print   Crystal Report (PrintReport Subroutine)

Create Objects

 l Variable   Object

 l Timer   Object

 l Event   Object

 

Animation Experts 

The following list summarizes the Animation Experts available in iFIX:

 l Color   Experts

 l Fill   Expert

 l Position   Expert

 l Rotate   Expert

 l Scale   Expert

 l Visibility   Expert

 l Display   Layers Expert

 l Set   Layer Expert
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IMPORTANT:   Be aware that Historical Animations that use Sample or Interpolated data   from Proficy Historian 
may display a Lookup or Format error status of   “Unknown”, when the local computer's time is ahead of the 
Proficy Historian   Server's time.  (The   “Unknown” Lookup or Format data symbols are defined in the User 
Preferences,   on the Animations Data Error Defaults tab.) 

 

Color Expert

Lets you set the way the selected object(s) color is animated in the   runtime environment. There are three 
color experts: 

 l Background Color   Expert

 l Foreground Color   Expert

 l Edge Color Expert

Data Source

Allows you to enter the data source that animates the selected object(s)   color property. Click the browse 
button (...) to view all of data sources   available in your system. Click the down button to view the last 
data   sources you used. Click the modify database block button to modify the   selected data source. You 
can add a database block by entering a new database   block tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Color Properties Tab

The Color Properties tab contains the following items:

Color By 

Item Description

Current 
Value

Allows you to enter a value or range of values and   assign each a unique color in 
the Color Threshold table to the right.   When the current value of the data source 
falls within or on that color   definition, the selected object(s) change to that 
color.

Current 
Alarm

Allows you to set up color thresholds to visually   alert operators that a data 
source is in a particular alarm state. This   differs from the Latched Alarm option 
in how it handles multiple alarm   states. Selecting current alarm always dis-
plays the color assigned to   the current alarm.

Latched 
Alarm

Allows you to set up color thresholds to visually   alert operators that a data 
source is in a particular alarm state. This   differs from the Current Alarm option 
in how it handles multiple alarm   states. When a data source is in more than one 
alarm state that has defined   thresholds, the latched alarm strategy displays the 
color assigned to   the unacknowledged alarm of the highest priority. If there are 
no unacknowledged   alarms, it displays the color of the current alarm.
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New Alarm

Item Description

Blink 
on 
New 
Alarm

Sets the selected object(s) to blink every time the   data source registers a new 
alarm. The object stops blinking when the   alarm is acknowledged. This setting 
overrides the blinking settings defined   for individual thresholds. The object blinks 
between the color of the   threshold table and the blink on a new alarm color.

Blink 
on 
New 
Alarm 
Color

Sets the color for the blink on new alarm if the Blink   on New Alarm check box is 
selected.

Color Threshold

Item Description

Range If the value of the data source falls within a specified   threshold range in the 
table below, the selected object(s) change to the   associated color.

Exact 
Match

If the value of the data source exactly matches a   threshold value in the table 
below, the selected object(s) change to the   associated color.

Exact 
Match Tol-
erance

Lets you enter an allowable deviation from the current   value of a data source. 
For example: If the current value is 10, and the   tolerance is 5, the range that 
the color will display is from 5 to 15.

Color List 
Box

Allows you to animate an object's color based on a   specified value. To assign 
values, click a cell within the Maximum, Minimum,   and Value columns and 
enter a value. To assign colors, double-click a   cell within the Color and Blink 
To columns and select a color from the   color box.

No Blink Removes a blink color assigned to the selected row   in the color table 
threshold.

Insert 
Row

Inserts a new row into the color threshold table.   

Delete 
Row

Deletes the selected row of the color threshold table.

Reset to 
Defaults

Resets the Color Threshold table to the default values.

Use Allows you to use a color table that is defined in   globals or any color table that 
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Shared 
Threshold 
Table

is defined in a picture, which will be   open in conjunction with the current pic-
ture.

Shared 
Table 

Allows you to enter the data source for the shared   color table. The shared 
table data source must be a color threshold table   found in the global user 
page or in another picture.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch data 

from Proficy Historian. For example, if you want   to display data collected 
for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel. This   field is available 
only when you designate a specific time to start using   the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.
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Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode
Allows you to determine how iFIX   selects and fetches data from a historical data source and, determ-
ines   what each displayed value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The   current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents 
the timestamp from the Historian server, not the client.  

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.
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Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Get Data From New Selection

Allows you to select a different object in the Workspace while the Color   Expert is still displayed. Click 
this button and that object's color animation   parameters appear in the Color Expert. You can then apply 
the parameters   to a new selection.

Fill Expert

Lets you set the way the horizontal or vertical fill for the selected   object(s) is animated in the runtime 
environment.

Data Source

Allows you to enter the data source that animates the selected object's   fill property. Click the browse 
button (...) to view all of data sources   available in your system. Click the down button to view the last 
data   sources you used. Click the modify database block button to modify the   selected data source. You 
can add a database block by entering a new database   block tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Fill Properties

Direction

Fills the selected object(s) vertically. You can select the Vertical   and Horizontal check boxes to fill the 
selected object(s) both horizontally   and vertically.

Item Description

Vertical Fills the selected object(s) vertically. You can select   the Vertical and Hori-
zontal check boxes to fill the selected object(s)   both horizontally and ver-
tically.

Horizontal Fills the selected object(s) horizontally. 
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Direction Settings

Item Description

Vertical Fill Dir-
ection

Sets the vertical fill direction: Bottom to Top, Top   to Bottom, Top and 
Bottom from Center.

Horizontal Fill Dir-
ection

Sets the horizontal fill direction: Left to Right,   Right to Left, Left and 
Right from Center.

Input Ranges

Item Description

Lowest Input 
Value

Sets the minimum input value from the data source.   The valid range is 
dependent on the valid range of the data source. The   default value is 0.

Highest Input 
Value

Sets the maximum input value from the data source.   The valid range is 
dependent on the valid range of the data source. The   default value is 
100.

Fetch Limits at 
Runtime

Fetches the low and high EGU limits from the data   source auto-
matically at runtime.

NOTE: Fetching   data limits at runtime for an expression with more 
than one data source   is not supported and may produce unexpected 
results at runtime. This is   because there could be different tag names 
in the expression and it may   not be clear which tag to fetch the limits 
for.

Fill Percentages

Item Description

Minimum Per-
centage

Allows you to calculate the amount you want the object   filled when the 
data source equals the lowest input value.

Maximum 
Percentage

Allows you to calculate the amount you want the object   filled when the 
data source equals the highest input value.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE:   The following fields, with the exception of the Update Rate fields, are   only available if you select a His-
torical Mode other than Current Value.
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Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode
Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 
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 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.
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Get Data From New Selection

Allows you to select a different object in the Workspace while the Fill   Expert is still displayed. Click this 
button and that object's fill animation   parameters appear in the Fill Expert. You can then apply the para-
meters   to a new selection.

Position Expert

Lets you set the way the selected object(s) vertical or horizontal position   is animated in the runtime envir-
onment.

Data Source

Allows you to enter the data source that animates the selected object's   position property. Click the 
browse button (...) to view all of data sources   available in your system. Click the down button to view the 
last data   sources you used. Click the modify database block button to modify the   selected data source. 
You can add a database block by entering a new database   block tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Position Properties Tab

Position

Item Description

Vertical Moves the selected object(s) vertically. You can select   the Vertical and Hori-
zontal check boxes to move the selected object(s)   both horizontally and ver-
tically.

Horizontal Moves the selected object(s) horizontally. You can   select the Vertical and 
Horizontal check boxes to move the selected object(s)   both horizontally and 
vertically.

Position Type

Item Description

Relative Allows you to set the selected object(s) start and   end positions relative to its 
current position in the runtime environment.

Absolute Allows you to make the selected object(s) movement   always start and end in 
the same position.

Input Values

Item Description

Lowest 
Input 

Sets the minimum input value from the data source.   The valid range is depend-
ent on the valid range of the data source. The   default value is 0.
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Value

Highest 
Input 
Value

Sets the maximum input value from the data source.   The valid range is depend-
ent on the valid range of the data source. The   default value is 100.

Fetch 
Limits at 
Runtime

Fetches the Low and High EGU limits from the data   source automatically at 
runtime.

NOTE: Fetching   data limits at runtime for an expression with more than one 
data source   is not supported and may produce unexpected results at runtime. 
This is   because there could be different tag names in the expression and it 
may   not be clear which tag to fetch the limits for.

Horizontal Position Output Values

Item Description

Minimum 
Offset

Allows you to modify the distance that you want the   object to move from its 
origin when the data source value equals the lowest   input value. Available 
when you select the Relative Position.

This item is only available when the Relative option   is selected.

Maximum 
Offset

Allows you to specify the distance you want the object   to move from its ori-
gin when the data source value equals the highest   input value.

This item is only available when the Relative option   is selected.

Start Allows you to specify the position in the iFIX Workspace   that you want the 
object to move to when the data source value equals   the lowest input value. 
Available when you select Absolute as the position   type.

This item is only available when the Absolute option   is selected.

End Allows you to specify the position in the iFIX Workspace   that you want the 
object to move to when the data source value equals   the highest input 
value. Available when you select Absolute as the position   type.

This item is only available when the Absolute option   is selected.

Get Value 
Button 
(Minimum 
Offset)

Allows you to select the object(s) in the iFIX Workspace   and move the 
object(s) to the start or minimum offset position that you   want. The position 
is entered in the field to the left.

Get Value 
Button 
(Maximum 

Allows you to select the object(s) in the iFIX Workspace   and move the 
object(s) to the end or maximum offset position that you   want. The position 
is entered in the field to the left.
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Offset)

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE:   The following fields, with the exception of the Update Rate fields, are   only available if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   
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Historical Mode
Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 
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update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Get Data from New Selection

Allows you to select a different object in the Workspace while the Position   Expert is still displayed. Click 
this button and that object's position   animation parameters appear in the Position Expert. You can then 
apply   the parameters to a new selection.

Rotate Expert

Lets you set the way the selected object(s) rotate in the runtime environment.

Data Source

Allows you to enter the data source that animates the selected object's   rotate property. Click the browse 
button (...) to view all of data sources   available in your system. Click the down button to view the last 
data   sources you used. Click the modify database block button to modify the   selected data source. You 
can add a database block by entering a new database   block tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Rotate Properties Tab

Input

Item Description

Lowest Input 
Value

Sets the minimum input value from the data source.   The valid range is 
dependent on the valid range of the data source. The   default value is 0.

Highest 
Input Value

Sets the maximum input value from the data source.   The valid range is 
dependent on the valid range of the data source. The   default value is 100.

Fetch Limits 
at Runtime

Fetches the Low and High EGU limits from the data   source at runtime.

NOTE: Fetching   data limits at runtime for an expression with more than 
one data source   is not supported and may produce unexpected results at 
runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Output

Item Description
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Minimum 
Angle of 
Rotation 
in 
Degrees

Allows you to enter the value, in degrees, of the   angle that you want the 
object to rotate to when the data source equals   the lowest input value. The 
default value is 0.

Maximum 
Angle of 
Rotation 
in 
Degrees

Allows you to enter the value, in degrees, of the   angle that you want the 
object to rotate to when the data source equals   the highest input value. The 
default value is 360.

NOTE: When   the Minimum Angle is set to 0 and the Maximum Angle is set 
to 360, the   selected object(s) rotate counter clockwise. When the Minimum 
Angle is   set to 360 and the Maximum Angle is set to 0, the selected object(s) 
rotate   clockwise.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The   following fields, with the exception of the Update Rate fields, are only   available if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.
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Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode
Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.
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Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Get Data from New Selection

Allows you to select a different object in the Workspace while the Rotate   Expert is still displayed. Click 
this button and that object's rotate   animation parameters appear in the Rotate Expert. You can then 
apply the   parameters to a new selection.

Scale Expert

Lets you set the way the selected object(s) scale is animated in the   runtime environment.

Data Source

Allows you to enter the data source that animates the selected object's   scale property. Click the browse 
button (...) to view all of data sources   available in your system. Click the down button to view the last 
data   sources you used. Click the modify database block button to modify the   selected data source. You 
can add a database block by entering a new database   block tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Scale Properties Tab

Scale Parameters

Item Description

Dimension 
to Scale

Lets you select the dimension of the object to scale.

Valid Entries:   Uniform Height and Width, Height, Width
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Scale Dir-
ection 

Lets you select the direction to scale the object.   The options are dependent 
on which dimension you choose to scale.

Input

Item Description

Lowest Input 
Value

Sets the minimum input value from the data source.   The valid range is 
dependent on the valid range of the data source. The   default value is 0.

Highest Input 
Value

Sets the maximum input value from the data source.   The valid range is 
dependent on the valid range of the data source. The   default value is 100.

Fetch Limits 
at Runtime

Fetches the Low and High EGU limits from the data   source at runtime.

NOTE: Fetching   data limits at runtime for an expression with more than 
one data source   is not supported and may produce unexpected results at 
runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Output

Item Description

Minimum 
Percentage

Allows you to enter the value, in degrees, of the   amount that you want the 
object to scale to when the data source equals   the lowest input value.

Maximum 
Percentage

Allows you to enter the value, in degrees, of the   amount that you want the 
object to scale to when the data source equals   the highest input value.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The   following fields, with the exception of the Update Rate fields, are only   available if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.
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Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel.   This field is available 
only when you designate a specific time to start   using the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode
Allows you to determine how iFIX selects and fetches   data from a historical data source and, determ-
ines what each displayed   value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents   
the timestamp from the Historian server, not the client. 
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 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Get Data from New Selection

Allows you to select a different object in the Workspace while the Scale   Expert is still displayed. Click 
this button and that object's scale animation   parameters appear in the Scale Expert. You can then apply 
the parameters   to a new selection.

Visibility Expert

Lets you set the visibility conditions for the selected object(s) in   the runtime environment.
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Data Source

Allows you to enter the data source that animates the selected object's   visibility property. Click the 
browse button (...) to view all of data   sources available in your system. Click the down button to view the 
last   data sources you used. Click the modify database block button to modify   the selected data source. 
You can add a database block by entering a new   database block tag name and tabbing off this field. The 
Quick Add dialog   box appears and allows you to enter the appropriate values for the added   block.

Visibility Properties Tab

Condition for Visibility
Condition

Lets you select the desired logical comparison. The selected object   is visible when:

< Data source value is less than the entry in the Value   field.
> Data source value is greater than the entry in the   Value field.
= Data source value equals the entry in the Value field.   This comparison lets you enter a 

Tolerance amount.
<= Data source value is less than or equal to the entry   in the Value field.
>= Data source value is greater than or equal to the   entry in the Value field.
<> Data source value is not equal to the entry in the   Value field.

Condition Value

Enter the number you want to compare with the data source value.

NOTE: Scientific   notation cannot be used to specify the Condition Value.

Tolerance

Allows you to enter the allowable deviation from the entry in the Value   field.

Condition Expression
View Visibility Condition

Click this button to view the condition you set in the Visibility Condition   field.

Visibility Condition

When you click the View Visibility Condition button, this field displays   the visibility condition you have 
set.

The Historical Properties tab contains the following items:

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The   following fields, with the exception of the Update Rate fields, are only   available if you select a His-
torical Mode other than Current Value.
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Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel. This   field is available 
only when you designate a specific time to start using   the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
used.

Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode
Allows you to determine how iFIX   selects and fetches data from a historical data source and, determ-
ines   what each displayed value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 
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 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The   current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents 
the timestamp from the Historian server, not the client.  

 l Standard Deviation   – The standard deviation of all valid data found during the specified   interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Display Layers Expert
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Lets you view only the layers that you want.

Layer Numbers

Allows you to select the layer numbers to display. The button for the   selected layer appears depressed.

Select All Layers

Allows all of the layers to be displayed.

Deselect All Layers

Allows none of the layers to be displayed. 

Set Layer Expert

Lets you set which layers the selected object(s) display in. For example,   if you have a series of objects 
that make up the foreground of a picture   and another series of objects that make up the background, you 
can set   the layer for the foreground objects to Level 1 and set the layer for   the background objects to 
Level 2. Then you can display just the foreground   objects, just the background objects, or both at the 
same time. See the   Display Layer Expert for information on displaying layers.

Layer Numbers

Allows you to select the layer number for the selected object. The object   is displayed when that display 
layer is set. The button for the selected   layer appears depressed.

Allow Multiple Layers

Lets you select additional layers for the object to appear.

Select All

Allows you to specify that the object will display in every layer. This   button is enabled only if you selec-
ted the Allow for Multiple Layers check   box.

Deselect All

Allows the user to specify that the object will not display in any layer.   This button is enabled only if you 
select the Allow for Multiple Layers   check box.

Command Experts

The following list summarizes the Command Experts available in iFIX.   You can select a single com-
mand Expert from the Experts toolbar, or you   can use the Multiple Command Script Wizard to build an 
object's command   script with more than one Command Expert.

 l Acknowledge   Alarm

 l Acknowledge   All Alarms

 l Alarm   Horn

 l Close   Digital Tag

 l Close   Picture

 l Disable   Alarm
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 l Enable   Alarm

 l Locate   Object

 l Open   Digital Tag

 l Open   Picture

 l Print   Crystal Report

 l Ramp   Tag Value

 l Replace   Picture

 l Set   Tag Auto

 l Set   Tag Manual

 l "Set Symbol from Model Browse Expert" on page 379

 l Set Symbol Values Expert

 l Shelve Expert

 l Toggle   Digital Tag

 l Toggle   Tag Auto/Manual

 l Toggle   Scan

 l Turn   Tag Off Scan

 l Turn   Tag On Scan

 l Unshelve Expert

 l Write   Value to Tag

 

Acknowledge Alarm Expert

Acknowledges a new alarm for the specified database tag. This expert   uses the AcknowledgeAlarm sub-
routine. 

Data Source

Allows you to enter the data source whose alarm you want to acknowledge.   Click the browse button (...) 
to view all of data sources available in   your system. Click the down button to view the last data sources 
you used.   Click the Modify Database Block button to modify the selected data source.   You can add a 
database block by entering a new database block tag name   and tabbing off this field. The Quick Add dia-
log box appears and allows   you to enter the appropriate values for the added block.

Use Database Tags 

Allows you to acknowledge the alarms only on the selected object's database   tags. To make an object 
selectable, open the object's property page and   set the property 'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Acknowledge All Alarms Expert
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Acknowledges all new alarms in the specified picture. This expert uses   the AcknowledgeAllAlarms sub-
routine. 

Picture Name

Allows you to specify the name of the picture whose alarms you want   to acknowledge. Click the browse 
button (...) to view all of the pictures   available in your iFIX picture path.

Browse Button (...)

Allows you to view all of the saved pictures in your iFIX picture path.

Acknowledge All Alarms in Picture 

Allows you to acknowledge all of the alarms in the current picture.   When this check box is enabled, the 
Picture Name field is disabled.

Alarm Horn Expert

Lets you configure an object to enable, disable, or silence the alarm   horn. You can also toggle the alarm 
horn between enable and disable, and   prompt for horn status in run mode. This expert uses the following 
subroutines:

 l AlarmHornEnabled

 l AlarmHornEnabledToggle

 l AlarmHornSilence

Silence Horn

Silences the alarm horn for the current set of alarms.

Enable Horn

Enables the alarm horn.

Disable Horn

Disables the alarm horn.

Toggle Horn Enable

Toggles the alarm horn between enabled and disabled.

Prompt for Horn Status in Run Mode

Displays a dialog box in run mode that shows the current status of the   Alarm Horn. You can also silence 
the alarm horn from this dialog box.

Close Digital Tag Expert

Closes the specified digital tag. This expert uses the CloseDigitalPoint   subroutine. 

Data Source

Allows you to enter the digital tag you want to close (for example,   set to 1). Click the browse button (...) 
to view all of data sources available   in your system. Click the down button to view the last data sources 
you   used. Click the Modify Database Block button to modify the selected data   source. You can add a 
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database block by entering a new database block   tag name and tabbing off this field. The Quick Add dia-
log box appears   and allows you to enter the appropriate values for the added block.

Use Database Tags

Allows you to close only the selected object's digital blocks. To make   an object selectable, open the 
object's property page and set the property   'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Close Picture Expert

Closes the specified picture. If there are multiple instances of a picture   open, all instances of that picture 
are closed. This expert uses the ClosePicture   subroutine. 

Picture Name

Allows you to specify the name of the picture you want to close. Click   the browse button (...) to view all 
of the pictures available in your   iFIX picture path.

Browse (...)

Allows you to view all of the saved pictures in your iFIX picture path.

Use Alias

Allows you to use the picture's alias name instead of its filename.

Picture Alias

Allows you to enter an optional alias for your picture instead of the   name from the Picture Name field.

Close This Picture

Allows you to close the current picture in the runtime environment.   When this check box is enabled, the 
Picture Name field is disabled.

Disable Alarm Expert

Disables the alarm for the specified database tag. This expert uses   the DisableAlarm subroutine. 

Data Source

Allows you to enter the data source whose alarm you want to disable.   Click the browse button (...) to 
view all of data sources available in   your system. Click the down button to view the last data sources 
you used.   Click the Modify Database Block button to modify the selected data source.   You can add a 
database block by entering a new database block tag name   and tabbing off this field. The Quick Add dia-
log box appears and allows   you to enter the appropriate values for the added block.

Use Database Tags

Allows you to disable the alarms only on the selected object's database   tags. To make an object select-
able, open the object's property page and   set the property 'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Enable Alarm Expert

© 2024 General Electric Company. All rights reserved. 373



Enables the alarm for the specified database tag. This expert uses the   EnableAlarm subroutine. 

Data Source

Allows you to enter the data source whose alarm you want to enable.   Click the browse button (...) to 
view all of data sources available in   your system. Click the down button to view the last data sources 
you used.   Click the Modify Database Block button to modify the selected data source.   You can add a 
database block by entering a new database block tag name   and tabbing off this field. The Quick Add dia-
log box appears and allows   you to enter the appropriate values for the added block.

Use Database Tags

Allows you to enable the alarms only on the selected object's database   tags. To make an object select-
able, open the object's property page and   set the property 'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Locate Object Expert

Finds the object you specify. You can set it to find the object in one   picture or in all open pictures. This 
expert uses the LocateObject subroutine.   

Object Name

Allows you to specify the name of the object that you want to locate.

Search Active Document

Allows you to search for the object in the currently active document.

Search All Documents

Allows you to search for the object in all open documents.

Open Digital Tag Expert

Opens the selected digital tag. This expert uses the OpenDigitalPoint   subroutine. 

Data Source

Allows you to enter the digital tag you want to open (for example, set   to 0). Click the browse button (...) 
to view all of data sources available   in your system. Click the down button to view the last data sources 
you   used. Click the modify database block button to modify the selected data   source. You can add a 
database block by entering a new database block   tag name and tabbing off this field. The Quick Add dia-
log box appears   and allows you to enter the appropriate values for the added block.

Use Database Tags

Allows you to open only the selected object's digital blocks. To make   an object selectable, open the 
object's property page and set the property   'IsSelectable' to True.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Open Picture Expert
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Opens the specified picture. This expert uses the OpenPicture subroutine.   

Picture Name

Allows you to specify the name of the picture you want to open. Click   the browse button (...) to view all 
of the pictures available in your   iFIX picture path.

Picture Browse (...)

Allows you to view all of the saved pictures in your iFIX picture path.

Picture Alias

Allows you to enter an optional alias for your picture instead of the   name from the Picture Name field.

Select Picture to Open in Run Mode 

Allows you to be able to choose the picture to open in the runtime environment.   When this check box is 
enabled, the Picture Name field is disabled. 

NOTE: This option   is not available in the Scheduler.

Allow Multiple Instances of this Picture

Allows you to open a new instance of a picture, if the picture is already   open in the WorkSpace when you 
run the OpenPicture subroutine.

Top 

Allows you to specify the topmost position that you want to open the   picture. The default is 0.

Left 

Allows you to specify the leftmost position that you want to open the   picture. The default is 0.

Enable Tag Group Substitution

Allows you to be able to use tag group substitution invoked on the picture   being opened. 

Tag Group File

Allows you to specify the file to be used for the tag group substitution.   

Select Tag Group file in Run Mode 

Using this option will prompt the user for the tag group file to be   used for the substitution after the picture 
is opened. If both this and   the select picture in run mode check box are selected, two prompts will   
appear. First the picture and second the Tag Group File.

NOTE: This option   is not available in the Scheduler.

Tag Group file Browse (…)

Allows you to specify the name of the Tag Group file you want to use   for Tag Group Substitution. Click 
the browse button (...) to view all   of the Tag Group Files available in your iFIX picture path.

Tag Group Editor Button

This is the button directly to the right of the Tag Group Browse button   (…). Allows you to launch the Tag 
Group Editor. If a Tag Group File is   specified, this file will be opened when the Tag Group Editor is 
launched.

Ramp a Value Expert

© 2024 General Electric Company. All rights reserved. 375



Ramps the specified database tag by a percentage or actual value that   you define. This expert uses the 
RampValue subroutine. 

Data Source

Allows you to enter the data source whose value you want to ramp. Click   the browse button (...) to view 
all of data sources available in your   system. Click the down button to view the last data sources you 
used.   Click the Modify Database Block button to modify the selected data source.   You can add a data-
base block by entering a new database block tag name   and tabbing off this field. The Quick Add dialog 
box appears and allows   you to enter the appropriate values for the added block.

Ramp by Percentage

Allows you to ramp the value by a percentage.

Ramp by Value

Allows you to ramp the value by a set value.

Ramp Value

The value to ramp the database tag value by.

Use Database Tags

Allows you to ramp only the selected object's database tag value. To   make an object selectable, open 
the object's property page and set the   property 'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Replace Picture Expert

Replaces the specified picture with another picture that you select. If the picture you select is already 
open in the WorkSpace, another instance of that picture opens. This expert uses the ReplacePicture 
subroutine.

Picture to Replace

Allows you to specify the name of a currently open picture you want   to replace. Click the browse button 
(...) to view all of the pictures   available in your iFIX picture path.

Picture Browse (...)

Allows you to view all of the saved pictures in your iFIX picture path.

Picture Alias

Allows you to use the picture's alias name instead of its filename.

Replace Current Picture in Run Mode

Allows you to replace the current picture in the runtime environment.   When this check box is enabled, 
the Picture to Replace field is disabled.

NOTE: This option   is not available in the Scheduler.
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New Picture File Name

The name of the new picture file to open. Click the browse button (...)   to view all of the pictures available 
in your iFIX picture path.

New Picture Browse (...)

Allows you to view all of the saved pictures in your iFIX picture path.

Enable Tag Group Substitution

Allows you to be able to use tag group substitution invoked on the picture   being opened. 

Tag Group File

Allows you to specify the file to be used for the tag group substitution.   

Select Tag Group file in Run Mode 

Using this option will prompt the user for the tag group file to be   used for the substitution after the picture 
is opened. If both this and   the select picture in run mode check box are selected, two prompts will   
appear. First the picture and second the Tag Group File.

NOTE: This option   is not available in the Scheduler.

Tag Group file Browse (…)

Allows you to specify the name of the Tag Group file you want to use   for Tag Group Substitution. Click 
the browse button (...) to view all   of the Tag Group Files available in your iFIX picture path.

Tag Group Editor Button

This is the button directly to the right of the Tag Group Browse button   (…). Allows you to launch the Tag 
Group Editor. If a Tag Group File is   specified, this file will be opened when the Tag Group Editor is 
launched.

Set Tag to Auto Expert

Sets the specified database tag to automatic. This expert uses the SetAuto   subroutine. 

Data Source

Allows you to enter the data source whose current mode you want to set   to auto. Click the browse but-
ton (...) to view all of data sources available   in your system. Click the down button to view the last data 
sources you   used. Click the Modify Database Block button to modify the selected data   source. You can 
add a database block by entering a new database block   tag name and tabbing off this field. The Quick 
Add dialog box appears   and allows you to enter the appropriate values for the added block.

Use Database Tags

Allows you to change the current mode to auto only on the selected object's   database tags. To make an 
object selectable, open the object's property   page and set the property 'IsSelectable' to True.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Set Tag to Manual Expert

Sets the specified database tag to manual. This expert   uses the SetManual subroutine. 
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Data Source

Allows you to enter the data source whose current mode you want to set   to manual. Click the browse 
button (...) to view all of data sources available   in your system. Click the down button to view the last 
data sources you   used. Click the Modify Database Block button to modify the selected data   source. You 
can add a database block by entering a new database block   tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Use Database Tags

Allows you to change the current mode to manual only on the selected   object's database tags. To make 
an object selectable, open the object's   property page and set the property 'IsSelectable' to True.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Set Symbol Values Expert

At run time, the Set Symbol Values expert replaces a name with a corresponding value, against that 
name in the active picture document. Up to five symbols name value pairs can be specified in this 
expert. 

A function named “SetValuesToSymbol” executes at run time to set the symbol value pair with an API 
call to SetSymbolValues. The API call replaces the symbol name with a corresponding value in the Act-
ive Picture Object or Document.

For example, say that you had tag text that was being used across several devices, and you had a sim-
ilar set of motors being manufactured. You needed to make the manufacturer's name the same across 
all the motors. You can use the Set Symbol Values expert to make this update.

The SetSymbolValues expert only works on an active picture document. If the active document is not a 
picture (for instance, if it is a scheduler), then  the following message appears to the operator: “Command 
SetSymbolValues tried to use a relative reference outside the WorkSpace “.

NOTE: Be aware that if you mix different symbols from tag group files and use SetValuesToSymbol VBA 
scripts in a picture, errors can appear if you try to load the TGD (tag group) file before the script-defined sym-
bols have been set. As a workaround, either use VBA to set the symbols before the TGD is loaded, or include 
all symbols from the picture in the TGD file (so that they can later be changed by scripts).

Example 

The following values in the Set Symbol Values expert would be used to create this script: 
SetValuesToSymbol "Hum", "1", "Mod", "Analog", "Temp", "Degrees", "Pressure", "Pascal", "Force", "Newton".
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Tip

While the Set Symbol Values expert can only replace up to five symbol names with new values, you can 
extend it to more than five by copying and pasting the same script generated through the Expert Wizard 
and providing different name/value pairs in the script. For example:

SetValuesToSymbol "Hum", "1", "Temp", "4", "Pressure", "20", "Vol ", "40", " Force", "60"
SetValuesToSymbol "Size", "7", "Width", "40", "Height", "6", "Freq", "100", " Modulation", "Analog"

Symbol

Must be a string. Maximum value of 31 characters. 

Value

Must be a string. Maximum value of 288 characters. 

At least one symbol name and value pair should be entered by the user. Otherwise, the following mes-
sage appears: "At least one pair of symbol name and its value should be entered from user side."

If the user only enters a name without its corresponding value, or vice versa, then the following prompt 
appears: "Enter Symbol Name or it's substituted value is not entered, Please enter a value." You must 
complete the entry to run the expert.

Set Symbol from Model Browse Expert

Allows you to set a symbol’s value by browsing and selecting a model object instance at run time.
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NOTE: When defining Model Instance names and type variable names, consider that their combined length must 
not exceed 256 characters, otherwise iFIX will not display tags and will return an error.

SCADA Name

Drop-down that contains a list of available SCADAs.

Symbol to Update

The symbol to dynamically replace wherever it is used in your picture expressions.

Update Symbol With

Allows you to select either:

 l Full Object Name (recommended if the model was built with containment): In the above model, 
selecting Motor01 would replace the symbol with the value "Building01>AirConditioner02>Motor01".

 l Object Name (recommended if multiple instances of an object will be viewed on the same screen): 
In the above model, selecting Motor01 would replace the symbol with the value "Motor01".

NOTE: Before the action can be performed in the run time environment, you must first click on the object to select 
it.

Model Browse at Run Time

After selecting an object and switching to run time mode, the Runtime Model Browse dialog will appear. 
This dialog allows you to browse the instances in the model to select the value to use as the symbol replace-
ment (as specified in the Set Symbol from Model Browse Expert above).
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Using the above figure as an example, depending on your selection for the Update Symbol With field in the 
Set Symbol from Model Browse Expert, selecting "Motor01" (under "AirConditioner02") would replace 
the Symbol To Update with:

Update Symbol With: Replacement value for Motor01:

Full Object Name Building01>AirConditioner02>Motor01

Object Name Motor01

Shelve Expert

Lets you configure an object that when clicked will shelve a single alarm in a picture run mode. To make 
an object selectable in configure mode, open the object's property   page and set the IsSelectable prop-
erty to True.

FIX Database Tag

Allows you to enter the data source whose current tag you want to set   to automatically shelve. Click the 
browse button (...) to view all of data sources available   in your system. Click the down button to view the 
last data sources you   used. Click the Modify Database Block button to modify the selected data   source. 
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Use Database Tag(s) for Item(s) Selected In the Run Environment

Allows you to use the tag properties of the selected object, such as datalink, in a picture to shelve 
alarms.   When you select this option, no tag needs to be specified in the iFIX Database field. The 
ShelveAlarm command will shelve only 1 alarm, even if multiple objects with tags are selected or if a 
single object contains multiple tags that are in alarm and are enabled for shelving.   A user may click the 
object additional times to shelve the additional tags.  Note that the ShelveAlarm Expert does not work 
with the AlarmSummary object.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it. 

Shelve Duration

Allows you to auto populate a shelve duration. Enter a time in minutes or hours. This time must be less 
than or equal to the alarm shelving policy defined for this tag.

Toggle Digital Tag Expert

Toggles the specified digital tag between open and closed. This expert   uses the ToggleDigitalPoint sub-
routine. 

Data Source

Allows you to enter the digital tag you want to toggle (for example,   from 0 to 1 and vice versa). Click the 
browse button (...) to view all   of data sources available in your system. Click the down button to view   the 
last data sources you used. Click the Modify Database Block button   to modify the selected data source. 
You can add a database block by entering   a new database block tag name and tabbing off this field. The 
Quick Add   dialog box appears and allows you to enter the appropriate values for   the added block.

Use Database Tags

Allows you to toggle only the selected object's digital blocks. To make   an object selectable, open the 
object's property page and set the property   'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Toggle Scan Expert

Toggles the specified database tag on and off scan. This expert uses   the ToggleScan subroutine. 

Data Source

Allows you to enter the data source whose scan you want toggle on and   off and vice versa. Click the 
browse button (...) to view all of data   sources available in your system. Click the down button to view the 
last   data sources you used. Click the Modify Database Block button to modify   the selected data source. 
You can add a database block by entering a new   database block tag name and tabbing off this field. The 
Quick Add dialog   box appears and allows you to enter the appropriate values for the added   block.

Use Database Tags

Allows you to toggle the scan from on to off and vice versa only on   the selected object's database tags. 
To make an object selectable, open   the object's property page and set the property 'IsSelectable' to 
True.
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NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Toggle Tag Between Auto and Manual Expert

Toggles the specified database tag between auto and manual. This expert   uses the ToggleManual sub-
routine. 

Data Source

Allows you to enter the data source whose current mode you want to toggle   from auto to manual and 
vice versa. Click the browse button (...) to view   all of data sources available in your system. Click the 
down button to   view the last data sources you used. Click the Modify Database Block button   to modify 
the selected data source. You can add a database block by entering   a new database block tag name and 
tabbing off this field. The Quick Add   dialog box appears and allows you to enter the appropriate values 
for   the added block.

Use Database Tags

Allows you to toggle the current mode from auto to manual and vice versa   only on the selected object's 
database tags. To make an object selectable,   open the object's property page and set the property 
'IsSelectable' to   True.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Turn Tag Off Scan Expert

Turns the specified database tag off scan. This expert uses the OffScan   subroutine. 

Data Source

Allows you to enter the data source whose scan you want to turn off.   Click the browse button (...) to 
view all of data sources available in   your system. Click the down button to view the last data sources 
you used.   Click the Modify Database Block button to modify the selected data source.   You can add a 
database block by entering a new database block tag name   and tabbing off this field. The Quick Add dia-
log box appears and allows   you to enter the appropriate values for the added block.

Use Database Tags

Allows you to turn the scan off only the selected object's database   tags. To make an object selectable, 
open the object's property page and   set the property 'IsSelectable' to True.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Turn Tag On Scan Expert

Turns the specified database tag on scan. This expert uses the OnScan   subroutine. 

Data Source

Allows you to enter the data source whose scan you want to turn on.   Click the browse button (...) to view 
all of data sources available in   your system. Click the down button to view the last data sources you 
used.   Click the Modify Database Block button to modify the selected data source.   You can add a data-
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base block by entering a new database block tag name   and tabbing off this field. The Quick Add dialog 
box appears and allows   you to enter the appropriate values for the added block.

Use Database Tags

Allows you to turn the scan on only the selected object's database tags.   To make an object selectable, 
open the object's property page and set   the property 'IsSelectable' to True.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Unshelve Expert

Lets you configure an object that when clicked will unshelve a single alarm in a picture run mode. To 
make an object selectable in configure mode, open the object's property   page and set the IsSelectable 
property to True.

FIX Database Tag

Allows you to enter the data source whose current tag you want to set   to automatically unshelve. Click 
the browse button (...) to view all of data sources available   in your system. Click the down button to view 
the last data sources you   used. Click the Modify Database Block button to modify the selected data   
source. 

Use Database Tag(s) for Item(s) Selected In the Run Environment

Allows you to use the tag properties of the selected object, such as datalink, in a picture to unshelve 
alarms.   When you select this option, no tag needs to be specified in the iFIX Database field. The 
UnShelveAlarm command will unshelve only 1 alarm, even if multiple objects with tags are selected or if 
a single object contains multiple tags that are in alarm and are enabled for shelving.   A user may click the 
object additional times to unshelve the additional tags.  Note that the UnShelveAlarm Expert does not 
work with the AlarmSummary object.

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it. 

Write a Value Expert

Writes a value you select to the specified database tag. This expert   uses the WriteValue subroutine. 

Data Source

Allows you to enter the data source you want to write to. Click the   browse button (...) to view all of the 
data sources available in your   system. Click the down button to view the last data sources you used.   
Click the Modify Database Block button to modify the selected data source.   You can add a database 
block by entering a new database block tag name   and tabbing off this field. The Quick Add dialog box 
appears and allows   you to enter the appropriate values for the added block.

Value

Allows you to specify the value to write to the current value of the   database block. The default is 0.

Use Database Tags

Allows you to write only to the selected object's database tag's value.   To make an object selectable, 
open the object's property page and set   the property 'IsSelectable' to True.
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NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Alpha-Numeric

Enabled when your database tag allows alphanumeric data entry.

Numeric

Enabled when your database tag only allows numeric data entry.

Data Entry Expert

Lets you select a data source and associate a data entry method for   your object.

Data Source

Allows you to enter the data source that the new value will be written   to. Click the browse button (...) to 
view all of data sources available   in your system. Click the down button to view the last data sources 
you   used. Click the modify database block button to modify the configuration   of the selected data 
source. You can add a database block by entering   a new tag name and tabbing off this field. The Quick 
Add dialog box appears   and allows you to enter the appropriate values for the new block.

NOTE: If the   tag requires electronic signatures, the data source will not update until   the action is successfully 
signed for.

Choose Data Entry Method

Item Description

Numeric/Alphanumeric 
Entry 

Allows the operator to set a tag's value by entering   it directly at run 
time. You can configure the following options for the   Numer-
ic/Alphanumeric Entry Method:

 l Numeric   Entry Option – Allows the operator to change a 
tag's value by entering   it in a field in the picture. This allows 
the operator to enter numeric   values only.

 l Alphanumeric   Entry Option – Allows the operator to change 
a tag's value by entering   it in a field in the picture. This allows 
the operator to enter both numeric   and alphanumeric values.

 l Low   Limit – Allows you to enter a value (up to seven decimal 
places   long) that represents the lowest value the operator can 
enter. The valid   range is dependent on the valid range of the 
data source. The default   value is 0.

 l High   Limit – Allows you to enter a value (up to seven decimal 
places   long) that represents the highest value the operator can 
enter. The valid   range is dependent on the valid range of the 
data source. The default   value is 1 for digital blocks, and 100 
for analog blocks.

 l Fetch   Limits Check Box – Fetches the Low and High EGU 
limits from the   data source automatically at runtime. This dis-
ables the high and low limit   text boxes.
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Slider Entry Allows the operator to change a tag's value by moving   a slider control 
or entering an integer value at run time. You can configure   the fol-
lowing options for the Slider Entry Method:

 l Low   Limit –   Allows you to enter a value that represents the 
lowest value the operator   can enter. The valid range is depend-
ent on the valid range of the data   source. The default value is 
0. 

 l High   Limit –   Allows you to enter a value that represents the 
highest value the operator   can enter. The valid range is 
dependent on the valid range of the data   source. The default 
value is 1 for digital blocks, and 100 for analog   blocks. 

NOTE: The   slider allows the operator to enter an integer value or to 
move the slider   to an integer value. If you would like the operator to 
be able to enter   a decimal value, use the Numeric/Alphanumeric 
entry method.

 l Fetch   Limits Check Box –   Fetches the Low and High EGU 
limits from the data source automatically   at runtime. This dis-
ables the high and low limit textboxes.

 l Write   Continuously –   Allows the operator to change the 
value of the tag continuously in real   time. As the operator 
moves the slider control, the value of the tag updates   both in 
the slider control dialog box and at the data source. 

NOTE: If   the tag requires electronic signatures, the data source 
will not update   until the action is successfully signed for, even if 
you select Write   Continuously.

Pushbutton Entry Allows the operator to set a tag's value to 0 or 1.   This is mainly used 
for Digital Output blocks. At run time, the operator   is given two push-
buttons. One button, when clicked, sets the value to   0, the other sets 
the value to 1.

You can configure the following options for the Pushbutton Entry 
Method:

 l Open   Button Title –   Allows you to enter a title (up to 12 char-
acters long) for the pushbutton   that sets the value to 0.

 l Close   Button Title –   Allows you to enter a title (up to 12 char-
acters long) for the pushbutton   that sets the value to 1.

Ramp Entry Allows the operator to ramp a tag's value up or down   by two different 
percentages at run time. You can configure the following   options for 
the Ramp Entry Method:

 l Low   Limit –   Allows you to enter a value (up to seven decimal 
places long) that represents   the lowest value the operator can 
enter. The valid range is dependent   on the valid range of the 
data source. The default value is 0.

386 © 2024 General Electric Company. All rights reserved.



 l High   Limit –   Allows you to enter a value (up to seven decimal 
places long) that represents   the highest value the operator can 
enter. The valid range is dependent   on the valid range of the 
data source. The default value is 1 for digital   blocks and 100 
for analog blocks.

 l Fetch   Limits Check Box –   Fetches the Low and High EGU 
limits from the data source automatically   at runtime. This dis-
ables the high and low limit textboxes.

 l Ramp   Percentage 1 –   Allows you to enter a percentage that 
defines how much to ramp a value.   The operator can ramp the 
tag's value up or down.

 l Ramp   Percentage 2 –   Allows you to enter a percentage that 
defines how much to ramp a value.   The operator can ramp the 
tag's value up or down.

 

Database Experts

The following list summarizes the Database Experts available in iFIX:

 l Add   Database Block

 l Database   Reload

 l Database   Save

 l Modify   Database Block Expert

 l Read   a Value Expert

 

Add Database Block Expert

Lets you add a new database block to your database without having to   open Database Manager.

Data Source 

Allows you to enter the tagname of the block you want to add to your   database. Click the browse button 
(...) to view all of data sources available   in your system. Click the down button to view the last data 
sources you   used. Click the modify database block button to modify the selected data   source. You can 
add a database block by entering a new database block   tag name and tabbing off this field. The Quick 
Add dialog box appears   and allows you to enter the appropriate values for the added block.

Add

Applies and saves any changes you have made and then closes this expert.

 

Database Reload
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Lets you reload the current database without having to open Database   Manager.

NOTE: The database   in memory is replaced. No check is made to see if the database has been   modified.

Database Save

Lets you save your database without having to open Database Manager.

Modify Database Block Expert

Lets you modify a new database block in your database without having   to open Database Manager.

Data Source

Allows you to enter the tagname of the block that you want to modify   in your database. Click the browse 
button (...) to view all of data sources   available in your system. Click the down button to view the last 
data   sources you used. Click the modify database block button to modify the   selected data source. You 
can add a database block by entering a new database   block tag name and tabbing off this field. The 
Quick Add dialog box appears   and allows you to enter the appropriate values for the added block.

Modify

Applies and saves any changes you have made and then closes this expert.

 

Read a Value Expert

Retrieves the value from the specified database tag. This expert uses   the ReadValue subroutine. 

Data Source

Allows you to enter the data source you want to read the value from.   Click the browse button (...) to view 
all of data sources available in   your system. Click the down button to view the last data sources you 
used.   Click the Modify Database Block button to modify the selected data source.   You can add a data-
base block by entering a new database block tag name   and tabbing off this field. The Quick Add dialog 
box appears and allows   you to enter the appropriate values for the added block.

Use Database Tags 

Allows you to read only the selected object's database tag's value.   To make an object selectable, open 
the object's property page and set   the property 'IsSelectable' to True. 

NOTE: Before   the action can be performed in the runtime environment, you must first   click on the object to 
select it.

Picture Experts 

The following list summarizes the Picture Experts available in iFIX:

 l Button   Caption Converter Expert

 l Export   Key Macros Expert

 l Generate   Picture Expert
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 l Refresh   Rate Expert

 l Resolve   Files Expert

 l Save   Files with Thumbnail Preferences Expert

 l Upgrade   File to Enhanced Coordinates Expert

 

Button Caption Converter Expert

The Button Caption Converter allows you to select a button caption (text)   in your active picture and con-
vert that button caption text to scale to   a new screen resolution. You can select one or more buttons to 
convert.

Convert Button Caption

Converts the selected button(s)   in the 'Push buttons found on picture' dialog box..

Find Next

Allows you to confirm the conversion of each button individually.

Convert all

Converts all the selected button text.

Close

Closes the Button Caption Converter dialog box.

Push buttons found on picture 

Lists all the buttons in the active picture that are available for conversion.   It allows you to select a button 
from the list, which you can confirm.    You can   also confirm the button selection by looking at the button in 
the picture.

Export Key Macros Expert

Lets you export all of the key macros in the selected object, picture,   or user global page to a .CSV file. 

Object

The object, picture, or user global page from which you want to export   key macros. You cannot edit this 
field from the expert.

Recursive (Include Children)

Lets you include key macros for all child objects. By default the Recursive   (Include Children) check box 
is selected. 

File Name

The name of the file to which you want to save your key macros. Click   the browse button (...) to view all 
of the existing .CSV files. If you   do not include a path, the .CSV file is saved to your iFIX directory.

Browse (...)

Allows you to view all of the .CSV files in your iFIX picture path.
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Append to File 

If you enter or browse to an existing file name, select the Append to   File check box to add key macros to 
the end of an existing .CSV file.

Export 

Click the Export button to export all of the key macros.

 

Generate Picture Expert

Generates a picture. This expert uses the GeneratePicture   subroutine. 

Window Location

Item Description

Top The preferred top window edge location of the picture   being generated. The loc-
ation Unit, pixel or percent, is determined by   the Pixelscheck box.

Left The preferred left window edge location of the picture   being generated. The loc-
ation Unit, pixel or percent, is determined by   the Pixelscheck box.

Height The preferred window height of the picture being generated.   The dimension Unit, 
pixel or percent, is determined by the Pixelscheck box.

Width The preferred window width of the picture being generated.   The dimension Unit, 
pixel or percent, is determined by the Pixelscheck box.

Pixels Determines whether the window location units are pixel   or percent.

Window Styles

Item Description

Titlebar Defines whether or not the picture window has a title   bar.  

System 
Menu

Defines whether or not the picture window has a system   menu.

Resizable Defines whether or not the picture window is resizable   using the mouse.

Always On 
Top

Defines whether or not the picture window is always   on top of other pic-
ture windows.

Runtime Vis-
ible

Defines whether or not the picture is visible at runtime.

Background Color

Color button for defining the background color of the picture.
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Picture Name

The name of the picture.

 

Refresh Rate Expert

Lets you change the refresh rate for a selected object or an entire   picture. By default, the refresh rate is 
set to 1.

You can modify the refresh rate to fast or slow values. For example,   you might want to give faster 
refresh rates to objects where you enter   data sources.

Selected Objects

Select this option button to apply changes to the refresh rate for the   selected object.

Entire Picture

Select this option button to apply changes to the refresh rate for the   entire picture.

Tolerance

Specifies the current connection's rounding factor. Typically, iFIX   uses this value when comparing a pro-
cess value to a target value. If the   process value is within the specified tolerance, iFIX assumes the two   
values are equal. For example, if the target value is 1.0, the tolerance   is 0.1, and the current value of a 
data source is 0.8, iFIX does not assume   the two values are equal because the data source is not within 
the specified   tolerance. The value must within the range 0.9 to 1.1 to equal the target   value.

Deadband

Specifies the maximum fluctuation you want for the current connection   before iFIX updates it. By enter-
ing a dead band value, you create a +/-   dead zone around the connection's current value. As long as the 
value   is within this range, iFIX does not update the value. However, once the   value exceeds the max-
imum or minimum dead band, the value is updated.

Refresh Rate

Specifies the rate at which iFIX updates the current connection. iFIX   updates the connection no faster 
than the specified speed. 

Resolve Files Expert

Lets you resolve files before you enter into the Runtime environment.   If you do not resolve your files 
before switching to the Runtime environment,   the Workspace queries the database and resolves all the 
tag definitions.   This can be a time consuming process that slows down opening a picture.   By using the 
Resolve Expert to resolve your files, you can improve the   speed of opening pictures.

File Types

Item Description

Pictures Allows you to specify that you want to resolve pictures.   Displayed in the list 
box below will be the names of all the pictures   saved in your iFIX picture 
path.
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Schedules Allows you to specify that you want to resolve schedules.   Displayed in the 
list box below will be the names of all the schedules   saved in your iFIX 
schedule path.

Directories

Item Description

Picture Directory Specifies the directory where the pictures that you want to resolve   
are located.

Update Picture 
Files Button

Refreshes the picture names in the file list if you change the path   in 
the Picture Directory field.

Schedule Directory Specifies the directory where the schedules that you want to 
resolve   are located.

Update Schedule 
Files Button

Refreshes the schedule names in the file list if you change the path   
in the Schedule Directory field.

Resolve Files

Allows you to select the files you want to resolve. Hold down the <CTRL>   button to select multiple files, 
or click the Select All button to select   all of the files. The file names displayed are all of the files saved   in 
your iFIX picture and/or schedule directories.

Select All 

Selects all of the files in the list box.

Deselect All 

Deselects all of the files in the list box.

 

Save Files with Thumbnail Preferences Expert

Allows you to save thumbnail images of existing pictures. If you chose   not to save existing pictures 
(files) with thumbnails, you cannot view   the images from the system tree.

File Types

Item Description
Pictures Populates the Save Files With list box with a list   of all of the pictures (*.grf 

files) saved in your iFIX picture path.
Dynamo Sets Populates the Save Files With list box with a list   of all of the dynamo sets 

(*.fds files) saved in your iFIX picture path.

Directories

Item Description
Pictures Directory Specifies the directory where the pictures that you   want to save with a thumb-
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nail are located.
Refresh Picture List Refreshes the picture names in the file list if you   change the path in the Pic-

tures Directories field.
Dynamo Sets Dir-
ectory

Specifies the directory where the Dynamo sets that   you want to save with a 
thumbnail are located.

Refresh Dynamo 
Set List

Refreshes the names  of   the Dynamo in the file list if you change the path in 
the Dynamo Sets   Directories field.

Save Thumbnails

Allows you to save thumbnails with your files.

NOTE: This setting   overrides the Save thumbnail setting on the Picture  Preferences tab in the User Prefer-
ences dialog box.

Save Files With

Allows you to select the files you want to save with a thumbnail. Hold   down the <CTRL> button to 
select multiple files, or click the Select   All Button to select all of the files. The file names displayed are 
all   of the files saved in your iFIX picture and/or Dynamo sets directories.

Select All

Selects all of the files in the list box.

Deselect All

Deselects all of the files in the list box.

Upgrade File to Enhanced Coordinates Expert

The Upgrade File to Enhanced Coordinates Expert upgrades a Logical Coordinate   System picture or 
dynamo set to the Enhanced Coordinate System.  

File Type 

Allows you to select the file type to display in the Select Files window.    You can   select Pictures or 
Dynamo Sets or both. 

Picture and Dynamo Set Folder Path

Lists the path to the folder that contains the pictures and/or Dynamo   Sets on which you wish to upgrade 
to the Enhanced Coordinate System, or   restore to the Logical Coordinate System.

Browse (....)

Allows you to select a different folder that contains the files you   want to upgrade or restore.  

Refresh File List

Updates the files in the Select Files window to reflect eligible files   in the folder you selected.

Upgrade Files

Upgrades the selected files to screen independent Enhanced Coordinates.    By default,   this button is 
enabled when the dialogue box opens.
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Restore Files from Backup

Restores files from the Backup folder.  When   you select this option, files that are eligible for restoration 
are listed   in the Select Files window.

Select Files 

Lists files that are eligible for upgrading or restoration.  Files   eligible for upgrading include files that are 
not using the Enhanced Coordinate   System and that are not open in the iFIX WorkSpace.  By   default, 
the picture files in your default directory display.  Files   that are eligible for restoration are those files that 
have been upgraded   and for which a backup file exists in the Backup folder.

Buttons

Button Description
Select All Selects all the files listed in the Select Files window.
Deselect   All Clears all the files selected in the Select Files   window.
Upgrade Files Upgrades screen dependent Logical Coordinate System    pictures   and/or 

Dynamo Sets to screen independent Enhanced Coordinate System pic-
tures   and/or Dynamo Sets.

Restore Files Restores the upgraded picture and/or Dynamo Set to   the previously 
saved file in the Backup folder when the file exists. All   changes made to 
the file since the upgrade will be lost. After the restoration   operation is 
completed, the restored  files   are removed from the list in the Select 
Files window and are returned   to the list of files eligible for upgrading.

 

Reports Experts 

The following list summarizes the Reports Experts available in iFIX:

 l Cross   Reference Tool

 l Print   Crystal Report Expert

 l Print   Crystal Report (PrintReport Subroutine)

 

Cross Reference Tool

For more information, refer to "The Cross Reference Tool"   chapter of the Mastering iFIX ebook.

Print Crystal Report Expert

Lets you select a Crystal Report, preview it, and print it.

Select Report 

Allows you to open a Crystal Report for printing. You can only select   reports that were created with Crys-
tal Reports.
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Preview Report 

Allows you to display a preview of the report. From the Preview window,   you can print the report. 

Report Name

Displays the full path of the selected report.

Print Crystal Report Expert (PrintReport Subroutine)

Prints the Crystal Report you specify. This expert uses the PrintReport   subroutine.

Select Report 

Allows you to search the iFIX picture path for the report you want to   print.

Report Name

Displays the name of the selected report.

Print All 

Allows you to print the entire selected report. 

Print Selected Pages 

Allows you to print only the pages of the selected report that you specify.   This option is ignored in Crys-
tal XI.

From Page

Specifies the first page in a range of pages that you want to print   only when you select Print Selected 
Pages. This option is ignored in Crystal   XI.

To Page

Specifies the last page in a range of pages that you want to print only   when you select Print Selected 
Pages. This option is ignored in Crystal   XI.

Prompt User 

Allows you to specify if you want to be prompted when the report is   finished printing. This option is 
ignored in Crystal XI.

Collate 

Prints the report in the proper binding order. This option is ignored   in Crystal XI.

Number of Copies

The number of copies that you want printed. This option is ignored in   Crystal XI.

Create Objects

The following Create Objects are available from the toolbox in the iFIX   WorkSpace:

 l Variable   Object

 l Timer   Object

 l Event   Object
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Variable Object

You can insert a variable object in an iFIX picture. The variable object   can belong to the current picture or 
you can set it as a global object   that is available to your entire system.

Variable Name

Allows you to specify the name of the new variable object. The variable   name must consist of alpha-
numeric values and must begin with a letter.

Variable Type

Allows you to specify the variable object's type. Click the down button   to view the list of types.

Assign Variable

Allows you to connect the variable object's current value to a database   block.

Data Source

Only enabled when the Assign Variable check box is checked, this allows   you to enter the data source 
to connect the variable to. Click the browse   button (...) to view all of data sources available in your sys-
tem. Click   the down button to view the last data sources you used. Click the modify   database block but-
ton to modify the selected data source. You can add   a database block by entering a new database block 
tag name and tabbing   off this field. The Quick Add dialog box appears and allows you to enter   the appro-
priate values for the added block.

Local Variable 

Allows you to define the variable as a local variable.

Global Variable 

Allows you to define the variable as a global variable.

Timer Object

You can insert a timer object in an iFIX picture. The timer object performs   an operation based on an inter-
val of time. You must enter VB code into   the timer object's event for anything to actually occur. If you 
select   the Edit Script button, VBE automatically launches and the cursor is positioned   to the timer's 
OnTimeOut event. You can then enter code for the new timer   object. If you select OK, the timer object is 
created but you will have   to go in at a later date and enter the VB code for the timer.

The timer object event that is invoked is the OnTimeOut event. The timer   has four different types of trig-
gers for the OnTimeOut event:

 l 0 –   One Shot

 l 1 –   Continuous

 l 2 –   Daily

 l 3 –   Monthly

The default trigger type is Continuous. If you want to use a different   trigger type, you will have to set the 
timer's TriggerType property to   the correct number. For Example:
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MyTimer.TriggerType = 0

Sets the timer trigger type to One-Shot.

Timer Name

Allows you to specify the name of the timer object.

Timer Description

Allows you to specify an optional description of the timer.

Start Time

Allows you to specify the start time for the Timer. The format must   be in the following format:

hours: minutes: seconds 

Interval

Allows you to specify the time interval in milliseconds.

Edit Script

Applies and saves changes you have made, launches VBE to the timer object's   OnTimeOut event, and 
closes the expert.

Event Object

You can insert an event object in an iFIX picture. The event object   performs an operation when its event 
type is triggered. You must enter   VB code into the object's event for anything to actually to occur. If   you 
select the Edit Script button, VBE automatically launches and the   cursor appears at the event type that 
you select for the event object.   You can then enter code for that event. If you select OK, the event object   
is created but you will have to go in at a later date and enter the VB   code for the event.

Event Source

Allows you to enter the data source to connect the event object to.   Click the browse button (...) to view 
all of data sources available in   your system. Click the down button to view the last data sources you 
used.   Click the modify database block button to modify the selected data source.   You can add a data-
base block by entering a new database block tag name   and tabbing off this field. The Quick Add dialog 
box appears and allows   you to enter the appropriate values for the added block.

Event Properties Tab

The Event Properties tab contains the following items:

Item Description
Name Allows you to specify the name of the event object.
Description Allows you to specify an optional description of the   event.
Event Type Allows you to specify the type for the event object.   The valid entry 

types are:

 l On Data Change – when the value of data source for   the object 
changes.

 l On True – when   the value of the data source for the object 
changes to True.
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 l On False  – when the value of the data source   for the object 
changes to False.

 l While True –   while the value of the data source for the object is 
True.

 l While False –   while the value of the data source for the object is 
False.

Interval Specifies the time interval in milliseconds. Only   enabled when the 
Event Type is While True or While False.

Historical Properties Tab

The Historical Properties tab allows you to set the parameters for a   query that fetches historical data 
from Proficy Historian. The tab contains   the following items:

NOTE: The following   fields, with the exception of the Update Rate fields, are only available   if you select a His-
torical Mode other than Current Value.

Start Date

Item Description
Fixed Date Specifies whether to enter a specific start date for   the query of the data 

source.
Days Before Now Specifies whether to enter the number of days prior   to today to fetch 

data from Proficy Historian. For example, if you want   to display data col-
lected for the data source two days ago, enter 2.

Start Time

Item Description
Fixed Time Specifies whether to designate a specific time to   start. If selected, 

allows you to enter an explicit start time.
Lock Time Locks the Fixed Time, even if you change the time   zone in the Date and 

Time Properties dialog box in the Control Panel. This   field is available 
only when you designate a specific time to start using   the Fixed Time 
field.

Duration Before 
Now

Specifies whether to enter the duration prior to the   current time to start. 
The minimum duration is 0 seconds; the maximum   is 23 hours, 59 
minutes, and 59 seconds.

Time Zone

Item Description
Time Zone Allows you to select the time zone to associate with   the start time. You 

can select the client time (time zone for your computer),   the server time 
(time zone used by the Historian server), or the tag time   (uses the time 
zone bias of the tag, which is set in Historian). The default   time zone is 
that of the client machine. This field is available only   when Historian is 
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used.
Adjust for Daylight 
Savings Time

Adjusts the time if the zone you selected is experiencing   daylight sav-
ing. This field works only if you selected the Automatically   adjust clock 
for daylight saving changes check box located on the Time   Zone tab of 
the Date/Time Properties dialog box in the Control Panel.   

Historical Mode
Allows you to determine how iFIX   selects and fetches data from a historical data source and, determ-
ines   what each displayed value represents. The options are:

 l Sample – The last   valid value found, up to and including the start of the specified interval.

 l Avg – The average   of all valid data found during the specified interval. 

 l High – The highest   valid data point value found during the specified interval. 

 l Low – The lowest   valid data point value found during the specified interval. 

 l Interpolated – The   data is interpreted by assuming that the line between two values is a   straight 
line. All points along that line are estimated except the starting   point and the ending point. 

 l Current Value – The   current value of the data point.

IMPORTANT:   The Current Value may update at a rate different from the rate set in   the Update Rate 
field. The update rate is not set solely by the rate entered   in the Update Rate field. It also depends on 
the collection rate, the   rate for querying Historian, and the time required to request an update   from the 
Historian server and send it back to the client. As a result,   the time it takes to display the updates may 
be longer than anticipated.   Additionally, please be aware that the timestamp for this mode represents 
the timestamp from the Historian server, not the client.  

 l Std Deviation – The   standard deviation of all valid data found during the specified interval.

 l Total – The total   of all valid data found during the specified interval.

Duration

The duration determines the time range for the historical data source.   The minimum duration for a fetch 
is one second; the maximum is 999 days,   23 hours, 59 minutes, and 59 seconds. 

Item Description
Days Allows you to enter the number of days. This field   can be used in 

conjunction with the other fields in this area.
Hours Allows you to enter the number of hours for the duration   for the 

data fetch query. This field can be used in conjunction with the   
other fields in this area.

Mins Allows you to enter the number of minutes for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.

Secs Allows you to enter the number of seconds for the   duration for the 
data fetch query. This field can be used in conjunction   with the 
other fields in this area.
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Update Rate

Allows you to specify the rate at which the data is updated. The default   rate is five seconds. Zero is per-
mitted for a one-time fetch. The fastest   update rate is five seconds, the slowest, 1:59:59.

Item Description
Hours Allows you to enter the number of hours for the rate   of data 

update. This field can be used in conjunction with the other fields   
in this area.

Mins Allows you to enter the number of minutes for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Secs Allows you to enter the number of seconds for the   rate of data 
update. This field can be used in conjunction with the other   fields 
in this area.

Edit Script

Applies and saves changes you have made, launches VBE to the event type   you selected for the event 
object, and closes the expert.

Using Dynamos

As you develop a system of operator displays, you may want to use an   object you created for one pic-
ture in several other pictures. iFIX offers   a convenient way to save custom-built objects and application 
scripts   into a higher-level reusable object set, called Dynamo   objects. Dynamo objects allow you to cus-
tomize your pictures by   creating a consistent design across your operator displays.

iFIX provides a wide selection of pre-built Dynamos that use the most   common shapes and objects in 
the process automation industry today. You   can also build and save your own Dynamos in the 
WorkSpace using the Build   Dynamo Wizard, and then dragging the new Dynamo into a set for use in   
other pictures. Using existing Dynamo Sets can expedite your picture development,   thereby increasing 
the performance of your entire operation.

For more information on Dynamo objects, refer to Working   with Dynamo Objects chapter.

Using Global Subroutines 

Global subroutines are tools in VBA that allow you to modify a script to perform a global task, such as 
opening a picture. All of iFIX's Experts use global subroutines, which reside in the FactoryGlobals.fxg 
file. For more information on global subroutines, and how to use them to modify scripting functions, refer 
to the Writing Scripts manual.

Performing Functions with Toolbars 
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Toolbars let you quickly perform tasks in your picture by merely clicking a button. There are many types 
of toolbars in iFIX to help you expedite your picture development. For more information on toolbars, refer 
to the Getting Started and Developing Objects in Pictures sections.
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Controlling Object Properties

Properties are perhaps the most significant feature of objects. They   define how your objects perform, 
and therefore dictate how well your pictures   accomplish your process goals. They allow the user to 
define and control   such object attributes as size, shape, edge and background fill, rotation   angle, and 
scaling. This chapter describes how you work with these properties   to maximize the effect of your pic-
tures.

 l How   Properties Work

 l Defining   and Modifying Properties

How Properties Work 

When you create pictures, you can add a variety of objects, such as charts, text, and bitmaps, or geo-
metric shapes, such as rectangles, polygons, and ovals. Each object contains properties – specific 
attributes assigned to the object that make it unique. 

Properties make objects either visible or invisible. Visible objects are those that contain properties you 
can see, such as a color or style fill. These are attributes that you can control in several ways.  Invisible 
objects, also called animation objects, are those that are added to objects during animation, such as rota-
tion, and scaling. When you animate an object, invisible objects are added to your pictures auto-
matically, without your control, and displayed in the system tree. Both visible and invisible properties 
can be modified using either the Properties window or the Animations dialog box.

NOTE: Read-only properties cannot be modified directly. For example, to change the bottom edge of a rect-
angle (a read-only property), you would have to change the rectangle's height property to affect the edge 
property.

Defining and Modifying Properties 

You can modify properties by:

 l Entering   property values manually

 l Animating   the object

 l Writing   a script to change the property's value

These methods are discussed in the following sections.

Entering Property Values Manually 

Property values give you precise control over an object's properties,   and lets you set a property to an 
exact limit.
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Entering Property Values with the Properties Window 

One way you can manually enter a property value for a visible or invisible   object or animation is with the 
Properties window, shown in the following   figure. This window displays the object properties you can 
modify (read-only   properties do not appear). Because the window is modeless, it stays on   your screen 
as you change property values or select other objects to modify.   This allows you to view properties as 
you make other changes to your picture.

To use the Properties window, enter property values in the window's   right-hand column and press Enter. 
Some properties let you select a value   from a list instead of entering it. In these cases, when you select 
the   cell, a drop-down list box appears. To hide the Properties Window, right-click   a cell in the window 
and select Hide from the pop-up menu.
Entering Property Values with the Advanced Animations Dialog Box 

You can also change property values with the Advanced Animations dialog   box. When you access the 
Advanced Animations dialog box, the selected   object's properties are displayed. Only the properties that 
accept data   appear in the dialog box; read-only properties do not appear. To display   read-only properties, 
use the Visual Basic Editor. For more information   on using the Visual Basic Editor, refer to the Writing  
Scripts manual.
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The Advanced Animations dialog box groups similar properties together   into categories. Each category 
is represented by a tab in the dialog box.   Certain tabs appear only if the selected object has the asso-
ciated properties.   For example, the Text tab appears only for text objects; only text objects   have font 
and font style properties.

Each tab displays the following information:

 l The property name.   

 l The property value.   

 l Whether the property   is being used in an animation. 

The following table describes each Animation dialog box tab. 

The tab... Allows you to configure...
General The object's name, description, and behavior at run-time,   as well as a help con-

text ID. 
Visible Whether the object is visible.
Size The height, the width, the percentage to resize the   object by, the direction to 

resize the object in, and whether the object   is uniformly resized.
Misc The object's layer in a picture, as well as numerous   properties specific to cer-

tain object types..
Position The vertical and horizontal position of the object.
Color The foreground color, background color, and edge color   of the object, as well as 

edge and grid properties specific to a chart   object.
Style The fill style, the edge style, and the line width,   as well as properties specific to 

rounded rectangle, pipe, and chart objects.   Not all objects have a fill style. 
Refer to the Coloring   and Styling Objects section for more information.

Rotate The angle of rotation of an object and the unit of   measure for the angles. Ovals, 
rounded rectangles, and charts do not have   rotation properties.

Text The font size, the font style, the font name, and   the text displayed by the 
object. Text properties apply only to text objects.

Behavior The behavior of the object's sizing, scaling, alignment,   and text properties. 
There are also properties specific to chart objects.

Gradient The fade color, fade type, gradient angle and blend   percentage to use for the 
gradient fill. Pipe objects do not have fade   type and gradient angle properties.

Fill The direction to fill the object, and the percentage   to fill the object.
Appearance The background and foreground colors , and the background   style and caption 

of a button object.
Picture The position of the picture.
Variable The variable type, and the initial and current values   of a variable object.

Animation Dialog Box Tabs    

For a complete   list of properties that you can animate, and the objects the properties   apply to, refer to 
Object Properties.

NOTE: When entering   R, G, B values in the Advanced Animations dialog box, the values must   be enclosed in 
parentheses.
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For more detail on the Animations dialog box, refer to the Animating   Object Properties chapter.

Animating Objects to Modify Properties 

Visible objects can be animated, providing an advanced level of control   and customization to your pic-
tures. Although what you see in the iFIX   WorkSpace is an object performing an action, it is the object's 
properties   that are animated, not the object itself. You animate object properties   using the Animations 
dialog box. This dialog box, available for every   object in iFIX, takes client data, finds its source, and then 
delivers   output based on that source. 

For more detailed information on animating objects, refer to the Animating   Object Properties chapter.

Writing Scripts to Modify Properties 

Visual Basic scripts provide developers with maximum flexibility and   control of their objects. Although it 
is not required that you know VBA   to work with properties, it is a powerful technology for those who want   
to use it. Every function on the Animations dialog box is also available   through VBA. 

For more information on using scripts to customize objects, refer to   the Writing Scripts manual. For 
information   on iFIX methods, properties, and events, refer to the iFIX Automation   Interfaces Help file.

 

Animating Object Properties

Whether you have developed one or one hundred pictures using iFIX, you   probably have discovered that 
creating these pictures can involve much   more than just drawing a static oval and linking it to a process 
database.   Thanks in great part to the power of animation, you can make your pictures   perform in ways 
that you have never seen before. iFIX gives you the ability   to acquire and interpret data so that your pic-
tures perform as you expect   them to.

This chapter describes animations, and how they give you the power to   design custom pictures and 
dynamic displays.

 l How   Animations Work

 l Animating   an Object's Properties: Overview

 l Defining   Data Sources

 l Animating   Properties Using Color

 l Animating   Object Properties with Visual Basic

 l Animating   a Grouped Object

 l Modifying   Animations

 l Deleting   Animations

 l Building   Expressions

How Animations Work 
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Animations are objects. When you animate the property of an object,   animation objects are added to the 
object that contains that property.   Although the result you see in the iFIX WorkSpace is an object per-
forming   a visible, functional action, it is the object's properties that are animated,   not the object itself.

 l Understanding   Data Sources

 l Accessing   the Animations Dialog Box and Using Common Animations

 l Understanding   Animation Objects

 l Animating   an Object's Properties

 l Using   Experts to Animate Objects

Understanding Data Sources 

When you animate an object, the values of one or more of its properties   change. Inherent to each prop-
erty is the location where it received data.   This location is called a data   source. Typically, a data source 
identifies a process value or   another object's property. However, a data source can be any of the fol-
lowing:

 l Real-time data from   an I/O address. 

 l An iFIX tag. 

 l The value of a picture   or object property. 

 l A global variable.   

 l A predefined expression.   

 l A VBA event. 

 l OPC servers. 

 l Proficy Historian.

In order to animate an object, you must connect to one of these data   sources. In some cases, you can 
make a direct connection to a data source.   In other instances, such as with Animation Experts, you con-
nect an object   to an animation object, and then connect the animation object to the data   source.

NOTE: Because animations   change object properties, you can only use a property in an animation   if the prop-
erty accepts data. Read-only properties cannot be used. You   can display the available properties by opening 
the Animations dialog   box or the Properties window. 

To specify a data source, you enter the appropriate syntax in the Data   Source field of the Animations dia-
log box. Then, by specifying a conversion   method for the data, you tell iFIX how you want to process the 
data so   that you can achieve the desired effect. For more information on selecting   data sources, and spe-
cifying syntax and conversion types, refer to the Defining   Data Sources section.

Accessing the Animations Dialog Box and Using Common Animations

When you are ready to animate an object, select a way to animate it   from the following table: 

From 
the...

Do this...

406 © 2024 General Electric Company. All rights reserved.



Expert Select the appropriate Expert from the Experts toolbar,   the Task Wizard, or the Toolbox 
(Classic and Ribbon views), or from the   Tools tab, in the Animations Group, or by clicking 
the Animations Dialog   Box Launcher (Ribbon view).

Basic 
Animation 
dialog box

Double-click an object or select Animations from the   right-click menu. 

For some objects, such as OCXs, Alarm Summaries, Data   links, and charts, you must 
right-click the object and select Animations   from the pop-up menu. 

For more information refer to the Using   the Animations Dialog Box section.
Advanced 
Animations 
dialog box

Click the Configure button on the Basic Animations   dialog or, if configured, the Advanced 
Animations dialog appears when   you double-click the object.

For some objects, such as OCXs, Alarm Summaries, Data   links, and charts, you must 
right-click the object and select Animations   from the pop-up menu. 

Click the tab that contains the property you want   to use. You can find a description of the 
dialog box tabs in the Entering   Property Values Manually section. The Animations dialog 
box is available   for every object (and every property of that object) in iFIX. For a descrip-
tion   of what each property does, refer to the Property Description in the Properties   area.

The following table summarizes some of the more commonly-used animations.   

Animating the property... On the 
tab...

Lets you...

HorizontalPosition Position Move an object horizontally across the screen.
VerticalPosition Position Move an object vertically across the screen.
HorizontalFillPercentage Fill Horizontally fill an object based on a percentage.   For example, if 

the value of the property is 50, the object is filled   50%.
VerticalFillPercentage Fill Vertically fill an object based on a percentage. For   example, if 

the value of the property is 50, the object is filled 50%.
HorizontalFillDirection Fill Horizontally fill an object from the left, right,   or center.
VerticalFillDirection Fill Vertically fill an object from the top, bottom, or   center.
RotationAngle Rotate Define the amount to rotate an object. Ovals, rounded   rect-

angles, and charts do not have rotation properties.
UniformScale Size Proportionally scale an object.
Height Size Scale the height of an object. The width remains unchanged.
Width Size Scale the width of an object. The height remains unchanged.
HorizontalScalePercentage Size Horizontally scale an object based on a percentage.   For 

example, if the value of the property is 50, the object is scaled   
50%.

VerticalScalePercentage Size Vertically scale an object based on a percentage.   For example, if 
the value of the property is 50, the object is scaled   50%.

ForegroundColor Color Change the foreground color of an object. Lines, polylines, and 
bitmaps do not have foreground color properties.

Visibility Visible Make an object visible or invisible.

Commonly-Used   Properties for Animations 
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Caption (text objects only) Text Change the text displayed by a text object. 
Fade Color Gradient Change the fade color of an object.
Fade Type Gradient Change the fade type of an object.

Animating a Size Property

You can fill an object based on an analog input value or rotate an object   based on a SIM or SM2 register 
value. You can also dynamically scale objects   by animating the height and/or width of an object. When 
scaling objects   in this manner, be careful of the data source you select. For example,   if you animate a 
rectangle's height based on a variable's current value   (data source is User.Variable1.CurrentValue), the 
object is resized in   the configuration environment to match the variable's value. Since the   WorkSpace is 
in the configuration environment, the value is set to zero   and the rectangle is resized to look like a hori-
zontal line. When you   switch to the run-time environment, the variable receives new values based   on the 
variable's configuration and the size of the rectangle changes.   When you switch back to the con-
figuration environment, the rectangle appears   as a line again because the variable's value is reset to 
zero. 

The same effect results using the Scale Expert and you select the current   value of a variable as the data 
source. 

Understanding Animation Objects 

Animation objects come in three forms:

 l Linear   – Accepts   any input data from a process database, and returns a corresponding output   
value (Example: Animating the foreground color of an oval). Refer to the   Understanding  Signal 
Conditioning section of the Building a SCADA System manual   for more detail on how the Linear 
object works. 

 l Lookup   – Accepts   any input data from a process database and presents that value to each   entry 
in a lookup table to determine whether that value is in a range.   If that value matches the range, 
the Lookup object then returns the corresponding   output value. If the value does not match the 
range, it moves to the next   row in the table and returns that output value (Example: Blinking the   
color of a rectangle based on a toggle rate). 

 l Format   – Accepts   any input data from a database and returns a string as an output value   
(Example: Creating a caption for a text object). 

The most common animation object is the   Lookup object, which is used primarily to apply color. This 
application   is further described in the Animating   Properties Using Color section. For more information on 
animation   object properties, refer to the iFIX Automation Interfaces Help file.

Most of your connections to data sources are through animation objects.   However, you do not need an 
animation   object to animate an object. For example, if another object contains a   property that provides 
the desired animation, you can connect to that   property. This is because every object has the ability to 
perform permanent   connections from one of its properties to another. Essentially, the animation   object 
only transforms data from the property of one object to the property   of another object.

Animating an Object's Properties

The steps that follow provide an overview of how to animate an object's   properties.
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 To animate the   properties of any object in a picture: 

 1. Select an object.   

 2. In Classic view,   click the appropriate Expert on the Experts toolbar, the Task Wizard,   or the 
Basic Animation dialog box. 

-Or-

In Ribbon view, on the Tools tab, in the   Animations group, click Animations and choose the appro-
priate Expert.

 3. In the Data Source   field, enter the data source you want to use to dynamically set property   val-
ues. 

 4. If appropriate, select   the type of data conversion you want to use and complete the related fields.   

 5. If appropriate, on   the Historical Properties tab, select the start date and time, the time   zone, the 
historical mode, duration, and update rate.

For a list of commonly-used properties, refer to the Commonly-Used   Properties for Animations table in 
the Understanding   Data Sources section.

Using Experts to Animate Objects 

An easy way to animate objects is to use Experts. To access an Expert,   click the button on the Experts 
toolbar that corresponds to the task you   want to perform (Classic view), or on the Tool tab, in the Anim-
ations   group, click Animations, and then choose the appropriate Expert (Ribbon   view). Some Experts 
are only available using the Task Wizard. For example,   if you want to animate the edge color of an oval, 
select the Edge Color   Expert from the Animation category of the Task Wizard.

To learn more about the fields on the Expert, click the Help button   on the Expert. For more information on 
iFIX Experts and the Task Wizard,   refer to the Using   Process Assistants to Expedite Pictures chapter.

Additionally, you can access some Experts from the Basic Animation dialog   box. To open the Basic 
Animation dialog box, select Animations from the   object's right-click menu.

Defining Data Sources 

Both the Basic and Advanced Animations dialog boxes group similar properties   together into categories. 
In the Basic Animation dialog box, the Animation   Experts are grouped by Color, Movement, Fill, Vis-
ibility, and Command.   There is also an Additional section that allows you to configure all animations   
using the Advanced Animations dialog box. 

In the Advanced Animations dialog box, each category is represented   by a tab. You can select one or 
more properties from these tabs as needed.   For example, suppose you want to horizontally fill a tank 
and change the   foreground color simultaneously. To do this, you would select the Hori-
zontalFillPercentage   property on the Fill tab and the ForegroundColor property on the Color   tab. 

Regardless of whether you select one property or seventeen, you must   connect to a data source for 
each property so that the necessary data   can be retrieved and processed. The data source for one prop-
erty can be   completely different than that of another property. For more information   about data sources, 
refer to the following topics:
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 l Entering   Data Source Syntax

 l Selecting   Data Sources from a List

 l Filtering   Data Sources

 l Specifying   Data Conversions

 l Classifying   Animations Errors

Entering Data Source Syntax 

To select a data source, enter its name in the Data Source field of   the Animations dialog box, using the 
required syntax that tells iFIX what   type of source contains the data. To assist you with the data source 
and   its syntax, iFIX provides intelligent   defaults, which allows the software to automatically fetch a data   
source based on an incomplete entry. For example, if your data source   is an iFIX tag, and you enter AI1 
in the Data Source field, iFIX connects   to a .F_CV field in the FIX32 database on the local SCADA 
server.

The following table lists the syntax for each data source type. 

When the data 
source   is...

Use the syntax...

An iFIX tag Fix32.node.tag.field

where:

node   is the name of the iFIX SCADA server you are connecting to;

tag   is the database tag; and

field   is the database field.
A Proficy His-
torian tag

Hist.collector.tag

where:

Hist is the   alias of the Proficy Historian Server;

collector   is the name of the Proficy Historian collector you are connecting to;   and

tag is the   database tag.
An I/O address server.io_address

where:

server   is the name of the OPC server; and

io_address   is the I/O address of that server.
An object property 
in a picture

picture.object.property

where:

picture   is the picture that contains the object;

object   is the object in the picture; and

Data Source Syntax  
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property   is the object's property name.
A picture property picture.property

where:

picture   is the picture that contains the property; and

property   is the picture's property name.
A VBA event N/A. When you animate objects with a VBA script, the   script handles all of the anim-

ation by directly changing the appropriate   properties.
A global variable xxx.variable

where:

xxx   is the global object; and

variable   is the name of the variable within the global object.
An expression value operator value

where:

value   is the primary value;

operator   is an operator relating to both values; and

value   is the secondary value.

For more information on creating expressions, refer   to the Building Expressions   sec-
tion.

Some third-party OPC servers require characters in their syntax that   are not parsable by the Expression 
Editor. If the OPC server syntax uses   any characters that do not appear in the list of valid characters 
below,   the server syntax must be enclosed within single quotes (`) as follows:

ServerName.'Device:MyAddress'

In this example, ServerName   is the name used to identify the third-party OPC server, and single quotes   
surround Device:MyAddress,   the part of the syntax that contains the unparsable character(s). If an   
unparsable character is not enclosed in single quotes, an error message   displays.

Valid   Characters: all alphanumeric characters, hyphen (-), underscore   (_), exclamation point (!), less 
than (<), greater than (>), pound   (#), percent (%), dollar sign ($), ampersand (&), forward slash (/),   back-
slash (\), pipe (|), opening bracket ([), closing bracket (]), and   single quote (`).

NOTE: You will have   to remove the added single quotes from any VBA scripts for operation to   succeed.

If a single quote (`) is a literal part of the addressing string syntax,   it must be preceded by a backslash (\) 
in order for the character to be   passed to the server as part of the address.

Refer to the documentation supplied with third-party OPC servers for   information on server-specific syn-
tax. 

Selecting Data Sources from a List 
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In addition to entering a data source directly, you can also select   one from a list using the Expression 
Builder dialog box. This dialog box   lets you select the data source you want to use, or create expres-
sions   by combining two or more data sources together.

You can select data sources from the Expression Builder dialog box by   clicking the tab you want and 
selecting the source from the list. For   example, to select an iFIX tag AI1 in the SCADA server 
SCADA01:

 1. Click the FIX32 Database   tab. 

 2. In the Node Names   list, select SCADA01. 

 3. In the Tag Names   list, select the desired tag. 

If an existing object contains properties, you can also select those   properties from a list. For example, to 
select the Width property of a   picture window:

 1. Click the Pictures   tab. 

 2. Select the picture   you want to modify. 

 3. In the Properties   list, click the WindowWidth property. 

As you make selections from the Expression Builder, the text in the   lower window changes to match 
your selections, enabling you to create   an expression. If applicable, the tolerance, deadband, or refresh 
rate   also appear in this window. The section Building   Expressions describes how to create expressions, 
and describes the   components of the Expression Builder.

Filtering Data Sources 

Using the Expression Builder dialog box, you can filter data sources   to search for specific data at any 
level. This is a helpful tool for eliminating   data that you don't need to access. 

To filter data sources, enter the data source string in the Filter field   and click Filter. (For the FIX32 Data-
base tabbed page, the Filter button   appears as an F.)   To select from the list box, click the down arrow to 
the right of the   field. You can also search for wildcard entries by using an asterisk in   the field. For 
example, to view all of the F_ fields for blocks, enter   F_* in the Filter field.

To find all occurrences starting with a particular string, enter String* in the Filter field, where String   is the 
text that you want to search for. For example, enter AI* to find   all tags starting with AI.

To find all occurrences which contain a particular string, enter *String* in the Filter field, where String   is 
the text that you want to search for. For example, enter *motor* to   find all tags containing the string 
"motor" in the name.

You can also search for a string with a single unknown character by   using the question mark wildcard 
(?). For example, the search string TAN?   locates the string TANK.

Specifying Data Conversions 

After you enter a data source, you need to select the type of data conversion   to apply to the data from 
that source. A data conversion defines how the   incoming data should be processed or formatted so that 
your objects behave   according to the properties you have assigned to them. It also defines   how the out-
going data calculates errors, what those errors mean, and how   they are conveyed to operators. 
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The following table lists the types of data conversions you can specify   in the Data Conversion area of 
the Animations dialog box.

The data con-
version...

Lets you specify...

Range A range of values on which to animate an object. You   can enter the minimum and max-
imum input and output values. When you enter   a range of values, the input values are 
mapped into the output values,   allowing you to apply linear signal conditioning. For inform-
ation on signal   conditioning, refer to the Understanding  Signal Conditioning section in the 
Building a SCADA System manual.

You can also specify if input is allowed to the range.
Table A lookup table. Using a lookup table is like using   a spreadsheet, as the following figure 

shows.

When completing a lookup table, you can define a single   lookup value or a range of 
lookup values for each row in the table. In   addition, you need to enter an output value. 
Depending on the selected   property, this value may be a color, string, fill style, edge 
style, or   numeric value. When the incoming value from the data source matches an   entry 
in the table, it changes the selected property to match the output   value.

The buttons below the lookup table help you modify   the appearance of the table. You can 
insert, modify, or delete rows in   the table by clicking the appropriate buttons. Or, by click-
ing the Advanced   button, you can assign toggle values, a shared lookup table, a toggle   
rate, and a tolerance value for exact match thresholds. For more information   on these 
advanced options, refer to the Animating   Properties Using Color and Classifying   Anim-
ations Errors sections. For more information on using the toggle   rate, refer to the Using 
Blinking   Thresholds section.

Format How to format the data. You can specify:

 l How to justify   the data.

 l How many lines   to display.

 l How many characters   appear on each line.

 l Whether data   entry is allowed and, if so, if it can be entered in-place.

For more information on formatting options, refer   to the Adding Data Links section.
Object No signal conditioning. The data received from the   data source is processed or displayed 

at that exact value.

Data Conversion Types    
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Sample Table Data Conversion 

The following table data conversion has been set up for the FillStyle   property of an oval. 

LowHigh Value
0 25 0-Solid
26 50 2-Horizontal
51 75 3-Vertical
76 100 1-Hollow

Using these definitions, the oval fill style appears as shown in the   following table. 

When the incoming value   is... The oval appears...
Less than 25

Between 26 to 50

Between 51 to 75

Between 76 to 100

Sample Table Data Conversions

Classifying Animations Errors 

iFIX lets you define how any animation behaves if an error occurs. Using   the Output Error Mode field of 
the Advanced Animations dialog box, you   determine how the output data appears to operators. From this 
field you   select the desired error classification based on the specified data conversion   method. The out-
put data appears to the user as the specified error type   when the default value is reached. 

The following table details the error output you can define for a particular   data conversion type. 

The data con-
version...

Lets you define 
errors   using...

Which gives you the   following options...
Error Handling Based on Data   Conversion Types  
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Range  l Current Out-
put

 l Error Table

 l Minimum 
Value

 l Maximum 
Value

 l Minimum and Maximum   Input

 l Minimum and Maximum   Output

 l Use Offset

 l Fetch Input Range   on Open

Table  l Current Out-
put

 l Error Table

 l Exact Match (and   tolerance)

 l Range Comparison

Format  l Current Out-
put

 l Error Table

Display messages in a Data link for any of the following   errors:

 l Communication   Failure

 l Data Uncertain

 l Unknown Failure

 l Device Failure

 l Out of Space

 l Configuration   Error

 l Custom messages   for any of the above as entered in User 
Preferences. 

Object  l Exact Value No output classification. The data received from the   data source is 
processed or displayed at that exact value.

For more information on the output fields, refer to the Animating Properties   Using Color section.

NOTE: Error handling   in iFIX is global, not per-object. You can choose the behavior of a single   object based 
on an error condition; however, because of performance reasons,   the error classification is applied system-
wide.
Specifying OPC Errors 

iFIX provides predefined error defaults that you can customize for your   needs. The Animations Data 
Error Defaults tabbed page of the User Preferences   dialog box contains the default OPC error strings 
and values that display   when an error occurs. The tabbed page is divided into three areas:

 l Linear   Animation Object Defaults –   Contains six numeric, OPC failure strings based on the 
Linear object using   a Range data conversion. 

 l Format   Animation Object Defaults –   Contains six OPC strings based on the Format object 
using a Format data   conversion. The error string is displayed in a Data link. 

 l Lookup   Animation Object Defaults –   Contains six numeric table, string table, and color table 
entries based   on the Lookup object using a Table data conversion. 

The error defaults are global, resulting in better system performance.   You can modify the defaults to 
make error messages more intuitive for   your specific process. For example, when a device error occurs, 
Data links   display by default the text "XXXX". To create a more intuitive   message for device error mes-
sages in the future, enter an alternate string   in the Device field of the Format Animation Object Defaults 
area. For   example:

Device is not working!
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By changing the defaults, you can configure error messages with the   text and color that you want, 
thereby customizing your error handling   scheme. For more information on the fields of the Animations 
Error Defaults   tabbed page, refer to the online help.

Animating Properties Using Color 

Applying color to your objects is a visually effective method of using   animations in your process envir-
onment. One example would be changing   the foreground, edge, and background color of objects to give 
your operators   visual cues about the process values or alarm conditions.

When animating the color of an object, you must define a   color threshold. A color threshold is either a 
color and value   combination or a color and alarm combination. You can define the following   types of 
color thresholds:

 l Color by analog value   

 l Color by digital   value 

 l Color by current   alarm 

 l Color by latched   alarm 

For each type of threshold, specify one or more rows in a lookup table.   When coloring by analog value, 
each row in the lookup table defines a   color and either a single value or a range of values that you want to   
associate with the color. When coloring by alarm, each row defines the   color and the associated alarm. 

NOTE: Any time a data   source changes, iFIX refreshes the color tables. To avoid problems when   modifying a 
color table, be certain that all your changes are correct.

The following sections show you how to define color thresholds using   the methods introduced above. 
Refer to the Specifying   Data Conversions section for information on how to use lookup tables.

 l Color   by analog value

 l Color   by digital value

 l Color   by current alarm

 l Color   by latched alarm

 l Using   Blinking Thresholds

 l Using   Shared Thresholds

Color by Analog Value 

When you color objects by their analog value, you enter a key value   or a range of key values and assign 
them to a color. When the data source   value falls within the threshold, the object changes to that color. 

For example, let's say a factory controls a tank of water for cleaning   and manufacturing purposes. When 
the water in the tank falls below 1000   gallons, the pumps from the main water supply turn on and refill the 
tank.   When the water in the tank rises above 9000 gallons, the pumps shut off.   The thresholds for this 
tank are shown in the following figure.
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When operators see the tank change color, they can also determine whether   the pumps have turned on 
(blue) or off (red). To color an object by analog   value, select the Range Comparison option button on the 
Color Expert and   edit the minimum and maximum values of the lookup table as desired. 

For more detailed information on animating objects, refer to the Animating   Object Properties chapter.

Color by Digital Value 

Color thresholds can be useful with digital values, too. Suppose you   assign the following thresholds to 
an object that monitors the status   of a pump. The data source for this object is a digital I/O point in an   
OPC server.
   

When the value is not in the table, the object is colored black.

Using digital values lets you define thresholds based on an exact match   and a tolerance. When you spe-
cify an exact   match, you declare that you only want to change an object's color   when the data source 
exactly matches the threshold value you have assigned   to that color, plus or minus a specified tolerance   
(the allowable deviation from that value). Tolerances only apply to table   conversions where the con-
figuration is set to exact match.

NOTE: How the output   data is displayed depends on how you classify error handling in the Advanced   Anim-
ations dialog box. For more information, refer to the Classifying   Animations Errors section.
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To color an object by digital value, select the Exact match option button   on the Color Expert and assign 
digital values to the colors you want to   use. If desired, enter a tolerance value in the Exact Match Tol-
erance   field. The default tolerance is 0. If you are using VBA, set the Tolerance   property of the Lookup 
object.

Color by Current Alarm 

Depending on your data source, an animated object can receive a variety   of alarms. You can set up 
thresholds to visually alert an operator that   a data source is in a particular alarm state. By using color by 
current   alarm, the object always displays the color assigned to the current alarm.

When the data source is an iFIX process database, tag alarms can also   provide data on more than just 
control limits. For example, suppose that   the speed at which the tank fills is crucial to the process. To 
effectively   monitor this condition, you could set up another threshold using the Rate   of Change alarm 
state.

For more information on coloring by current alarms, refer to the Implementing Alarms and Messages 
manual.

Color by Latched Alarm 

When a data source is in more than one alarm state that has defined   thresholds, the latched alarm 
strategy displays the color assigned to   the unacknowledged alarm of the highest priority.

For more information on coloring by latched alarms, refer to the Implementing Alarms and Messages 
manual.

Using Blinking Thresholds 

In addition to a color threshold, you can define a blinking threshold   for current and digital values. The 
blinking threshold replaces the object's   foreground, background, or edge color when the assigned value 
is reached   or the assigned alarm occurs. The color of the object blinks between the   threshold color and 
the background color.

To assign a blinking threshold using the Color Expert, double-click   the Blink To cell in the row of a value 
and select the color you want   to assign to the threshold. You can access the Color Expert via the tool-
box   or by selecting the Color Animation button in the Basic Animation dialog   box. Using the Advanced 
Animations dialog box, you can also define blinking   threshold values using the New Level dialog box. 
Click the Toggle option   button in the Output area and enter the output value of the blinking threshold   in 
the field.

Blinking on a New Alarm 

You can also set a selected object to blink every time the data source   registers a new alarm. The object 
stops blinking when the alarm is acknowledged.   This setting overrides the blinking settings defined for 
individual thresholds.   With the Blink on New Alarm check box selected, you can set the color   for the 
blink by clicking the Blink on New Alarm Color check box.

For examples of how to use blinking thresholds in your alarming scheme,   refer to the Implementing 
Alarms and Messages   manual.
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Blinking Rate 

The rate at which objects blink is defined in Advanced Lookup Options   dialog box. This dialog box also 
lets you select the source and value   of the toggle rate that causes the blinking action. The configurable 
blink   speed allows you to set the threshold to blink at a set rate, in seconds.   To set the blink speed, enter 
a value in the Toggle Rate field.

For more information on advanced options with the lookup table, refer   to the Specifying Data Con-
versions   section.

Using Shared Thresholds 

If a lookup object is shared (in either a global data source or in another   picture), you can use its color 
table to define a threshold. 

On the Color Expert, click the Use Shared Table check box and then,   in the Shared Table field, enter the 
data source for the shared color   table. Click the Browse button to make a selection from a Picture or a   
Global data source available in your system.

You can open the Color Expert by clicking on the Color Expert button   in the toolbox, or by selecting a 
specific Color Animation in the Basic   Animation dialog box.

Animating Object Properties with Visual Basic 

You can animate object properties by selecting the properties you want to dynamically change, selecting 
a data source, and defining how the data will be processed (the data conversion). To create custom 
animations, you can write a VBA script. To write a script for an object, right-click the object and select 
Edit Script from the pop-up menu. This starts the Visual Basic Editor.

When you write a script to animate an object, the script must define:

 l The object that you want to animate.   

 l The properties to dynamically change.   

 l The parameters to use when processing data.   

The parameters you specify vary depending on the type of data conversion you want to use. For 
example, if you want to use a Table data conversion, the parameters are cells of the table. Alternately, if 
you want to use a Range data conversion, the parameters are the minimum and maximum input and out-
put values.

After defining these items in your script, you must connect the data source to the object you want to 
animate.

 To connect the data source to the object you want to animate:

 1. Connect the data source to the input of the data conversion.   

 2. Connect the output of the data conversion to the object you want to animate.   

For more information on writing scripts that animate the properties of an object, refer to the Writing 
Scripts manual.

Animating a Grouped Object 
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In addition to animating individual objects, you can also animate grouped   objects. Animating a grouped 
object is similar to animating any other   object, except that the objects inside the group can have inde-
pendent   animations. To animate a grouped object, select the group and animate   the properties you wish 
using the appropriate Expert. The properties of   the group are changed to reflect your entries.

To animate the member objects of a group, drill down to the object in   the group that you want to animate 
and complete the necessary entries   in the appropriate Expert. If the group has an animated property, and   
one of its member objects has the same property animated in a different   way, the most recent animation 
takes precedence. For example, if you animate   the group's ForegroundColor property, and then in turn 
animate a nested   object's ForegroundColor property, you will see the nested object's animation   when 
you run the picture.

You can also use the Basic Animation dialog box to animate a grouped   object or member objects in a 
group. For more information on working with   grouped objects and their members including drilling down, 
refer to the   Creating Complex Objects   section.

Modifying Animations 

There may be times when you must change the animations you create. Modifying   animated objects is 
similar to creating them. The main difference is that   when you open either of the Animation dialog boxes, 
any properties that   have been dynamically changed are indicated by a selected check box (Basic)   or an 
arrow on its corresponding tab (Advanced), as the following figures   show. 

Modifying a Fill Animation   in the Basic Animation dialog box
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To modify an existing Animation in the Basic Animation dialog box, click   the Expert button associated 
with that animation. This opens the Expert   dialog box and allows you to make changes to that animation. 
Clearing   the check box deletes the existing animation.

Modifying a Fill Animation   in the Advanced Animations Dialog Box

To modify an existing animation in the Advanced Animations dialog box,   select the tab containing the 
property you want to change and click Animate.   Perform any required modifications and click OK.

Deleting Animations 
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When you no longer need an animation, you can delete the animation or   the object that contains the 
animation. Deleting animations removes the   animation from the property to which it was assigned.

CAUTION: Deleting   an animation permanently destroys your selections. Do not delete an animation   unless 
you understand the effect it will have on your objects and pictures.

Building Expressions 

As described earlier, there are many data sources you can use to animate   the properties of an object. 
Another valuable option is to use an expression.   An expression is a data value or multiple data values 
connected with one   or more operators. Using the Expression Builder, you can create specific   expres-
sions that access data from unique sources. This gives you more   flexibility when assigning dynamic 
object properties. 

You can use the following data values in an expression:

 l Numeric constants.   

 l Strings enclosed   in quotation marks (" "). 

 l iFIX tags. 

 l Proficy Historian   tags.

 l OPC server I/O addresses.   

 l Picture properties.   

 l Object properties.   

NOTE: Fetching   data limits at runtime for an expression with more than one data source   is not supported and 
may produce unexpected results at runtime. This is   because there could be different tag names in the expres-
sion and it may   not be clear which tag to fetch the limits for.

Using the Expression Builder Dialog Box 

The Expression Builder dialog box is your tool for creating expressions.   This dialog box lets you select 
the data source you want to use or create   expressions by combining two or more data sources together.

The Expression Builder dialog box is divided into multiple tabs, which   are described in the following 
table. 

The 
tab...

Displays...

FIX Data-
base

Any SCADA servers to which your computer is communicating.   Use a data server as a data 
source when you want to animate an object   or an iFIX tag. The tabbed page includes Node 
Names, Tag Names, and Field   Names windows to help you specify your selections.

Pictures The pictures residing on your computer. The Objects   window displays each object in the pic-
ture. Use one of these objects as   a data source when you want to animate an object with a 
picture or object   property value. The Properties window displays the properties for the   selec-
ted object so that you can select a specific property.

Globals Global data sources. The tabbed page includes Objects   and Properties windows to help you 
specify your selections.

Expression Builder Tabs    
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Data 
Servers

Third party OPC servers. Data source connections to   data servers fire at run-time only.

Alarm 
Counters

A filtered list of SCADA servers that your computer   is communicating with. The tabbed 
page includes the Alarm AreaTag Names   window that displays a filtered list of alarm areas 
on the selected SCADA   and alarm counter tags. The Alarm Counter Field Names window 
displays   a filtered list of fields available from the selected area.

Historian Any Proficy Historian Server to which your computer   is communicating. Use a Proficy His-
torian Server data source when you   want to animate an object. The tabbed page includes 
Node Names and Tag   Names windows to help you specify your selections.

Model Allows you to browse your iFIX model directly when building animation expressions in your 
picture. Browsing Types automatically creates a symbol-based string in your expression, 
while browsing Object instances directly inserts the instance variable in your expression.

When you select a data source, it appears in the field at the bottom   of the dialog box. You can add 
strings by typing them into the field.   You can also add operators and numeric constants by typing them 
into the   field, or by clicking the operator buttons on the right side of the dialog   box while the cursor is in 
the field. To display the operator buttons,   click the Mathematical Functions button.

NOTE: If you   have created an object-to-object connection, such as the fill percentage   of one tank to another, 
or created a connection to a data source, the   animated properties display in boldface in the Properties list of 
the   Pictures tab for the selected object.

The Filter fields and buttons allow you to filter data sources. For   more information, refer to the Filtering   
Data Sources section. Additionally, you can specify a tolerance, deadband,   and refresh rate in the appro-
priate fields. These functions are described   later in this section.

For more information on selecting data sources from the Expression Builder   dialog box, including 
examples, refer to the Selecting   Data Sources from a List section.

Customizing the Expression Builder 

You can customize the Expression Builder by showing or hiding specific tabs. To do this, you modify 
properties in VBA. Refer to the following table.     

To show or hide the tab... Set this property to TRUE or FALSE, respectively...
FIX32 Database ShowDatabaseTab
Pictures ShowPicturesTab
Globals ShowGlobalsTab
Data Servers ShowDataServersTab
Proficy Historian ShowProficyHistorianTab

Showing or Hiding Tabs in the Expression Builder    

For more information on modifying VBA scripts, refer to the Writing Scripts manual.

Specifying Tolerance, Deadband, and Refresh Rate 

The Expression Builder also lets you define the tolerance, deadband, and refresh rate of a data source 
connection. These three fields, located at the bottom-right of the dialog box, are defined as follows:
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 l Tolerance – the allowable deviation from a value when evaluating an expression.   

 l Deadband – how much the current data value can deviate from the most recent data value.   

 l Refresh Rate – how often the data source connection updates, in seconds.   

All three of these characteristics apply to a particular connection; they are not global. For example, if you 
connect the object RECT2.PROP1 to source FIX32.NODE.TAG.F_CV, you can specify different 
refresh rates for the rectangles properties, even though the object references the same database tag.

To enter a refresh rate enter a rate, in seconds, in the Refresh Rate field. Refer to the following table to 
determine how fast the connections will update based on the refresh rate you enter.     

If you choose a refresh 
rate of...

Then the data source connection will update no faster 
than...

0.0 Once per 50 milliseconds.
0.1 Five times per second.
1.0 (default) Once per second.
5.0 Once per 5 seconds. 
10.0 Once per 10 seconds.
15.0 Once per 15 seconds.
30.0 Once per 30 seconds.
60.0 Once per 60 seconds.

Refresh Rates    

To enter a tolerance or deadband limit, enter a value in the Tolerance or Deadband fields, respectively.

NOTE: The Tolerance setting in the Expression Builder is for the expression only. To set the tolerance for an 
Exact Match Lookup Table, you must use the Animations Dialog box. For more information, refer to the Clas-
sifying Animations Errors section.

For more information on refresh rate, refer to the Increasing the Refresh Rate section in the Setting up 
the Environment manual.

The Importance of Syntax 

Since the Expression Builder relies on specific data values input by users, the manner in which the data 
is presented is crucial. This is why it is important for you to know the proper syntax of your expressions. 
One of the most common errors in building expressions is that the expression has been entered incor-
rectly. Throughout this chapter, the correct syntax for specific entries is described with specific 
examples.

Syntax: Required Format for Expressions

Expressions require the following syntax:

value
value operator value

where value is a constant or a data source and operator is a mathematical, relational, or boolean symbol.

Operators: Applying the Glue to Your Expressions 
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The operators in expressions are symbols that not only let you connect   data values together but also 
determine how the values work together to   convert the data source. The following types of operators are 
permitted   in your expressions:

 l Mathematical operators   

 l Relational operators   

 l Boolean operators   

To access these operators, click the Mathematical Functions button on   the Expression Builder dialog 
box and select them from the expanded operator   keypad. You can also add numerals to your expres-
sions by clicking the   appropriate numeral in the Numeric area.

In addition to these operators, the Expression Builder allows you to   select a set of functions. These func-
tions are not shown on the expanded   operator keypad and must be entered manually. The following table 
summarizes   the available functions and their syntax. All trigonometric functions   require values entered 
in radians. 

When you select the   function... The Expression Builder   calculates the... Syntax
ABS Absolute value of number. ABS (number)
ACOS Arccosine of number. ACOS (number)
ASIN Arcsine of number. ASIN (number)
ATAN Arctangent of number. ATAN (number)
COS Cosine of number. COS (number)
EXP Anti-log of number. EXP (number)
INT Integer value of number. INT (number)
LOG Natural log of number. LOG (number)
LOG10 Base 10 log of number. LOG10 (number)
SIN Sine of number. SIN (number)
SQRT Square root of the number. SQRT (number)
TAN Tangent of number. TAN (number)

For more information on these functions, refer to the Working  with Functions section in the Creating 
Recipes manual.

The operators and their associated syntax are described in the following   sections with examples of 
each.
Mathematical Operators 

Mathematical operators let you add, subtract, multiply, and divide two   or more values. Using these oper-
ators, you can create a mathematical expression.   You can also change the operator's order of pre-
cedence in the mathematical   expression by using parentheses.

Mathematical expressions are evaluated by determining the data value   on each side of the mathematical 
operator and then performing the mathematical   operation. For example, consider the following expres-
sion:

5+Fix32.SCADA1.AI1.F_CV

When this expression is evaluated, the current value of the iFIX tag   AI1 is determined and then it is 
added to 5. If the value is 50, for example,   the expression evaluates to 55.
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Because of the way the expressions are evaluated, the values on both   sides of an operator must both be 
either a numeric value or a string,   but not one of each. You cannot,   for example, add the descriptive 
string "Pump1 for Main Water Supply"   to the data source Fix32.SCADA1.AI1.F_CV. However, you can   
add that same string to the data source Fix32.SCADA1.AI1.A_DESC. 
Syntax: Mathematical Operators

The syntax for each mathematical operator in provided in the following   table: 

Operator Syntax
+ (addition) value   + value
- (subtraction) value   -value
* (multiplication) value   * value
/ (division) value   / value
( (left parenthesis) (value + value) * value
) (right parenthesis) (value + value) * value

Example: Mathematical Operators

Consider the following expressions: 

Expression Value
5+Fix32.SCADA1.AI1.F_CV The current value of AI1 plus 5. If AI5 is 100, the   

expression evaluates to 105.
"5"+Fix32.SCADA1.AI1.A_CV The current value of AI1 and the string "5"   con-

catenated together. If AI1 is 100, the expression eval-
uates to 1005.

Fix32.SCADA1.AI5.F_CV*OPC1.N35 The product of the iFIX tag AI1 and the I/O address   
N35. If the tag's value is 100, and the I/O point's value 
is 50, the expression   evaluates to 5000.

Alarms.Rect1.Width/Alarms.Rect1.Height The quotient of Rect1's width divided by its height.   If 
both properties are equal, the expression evaluates to 
1.

Alarms.Pump5.HorizontalFillPercentage + 
Fix32.SCADA1.AI1.F_CV

The value of Pump5's HorizontalFillPercentage prop-
erty   plus the current value of the iFIX tag AI1. If the 
HorizontalFillPercentage   property's value is 50 and 
AI1's value is 100, the expression evaluates   to 150.

Alarms.Prompt.Caption+"Enter tagname" The value of Prompt's Caption property and the string   
"Enter tagname" concatenated together. If the Caption 
property   value is null, then the string evaluates to 
"Enter tagname".

Relational Operators 

Relational operators let you compare two values to determine how they   relate to each other.
Syntax: Relational Operators

The syntax for relational operators is shown in the following table.   

Operator Syntax
= (equal to) value   = value
<> (not equal to) value   <> value
> (greater than) value   > value
< (less than) value   < value
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>= (greater than or equal to) value   >= value
<= (less than or equal to) value   <= value

Example: Relational Operators

Relational operators are commonly used in boolean conditions to determine   if part or all of an expression 
is true or false. An example:

Fix32.SCADA1.AI1.F_CV = 50

When this expression is evaluated, the value of the left side of the   operator is compared to the right side. 
If the two values match, the condition   is true. Otherwise, it is false. 

You can compare any data value to any other data value. For example,   consider the following boolean 
conditions: 

Condition Value
3>1 TRUE
5 = "Enter tagname" FALSE
Fix32.SCADA1.AI1.F_CV = 100 TRUE, if the current value of AI1 is 100.
Fix32.SCADA1.AI1.F_CV >= 
OPC1.N35

TRUE, if the current value of AI1 is greater than   
OPC1.N35.

Alarms.Rect1.Width = Alarm-
s.Rect1.Height

TRUE, if Rect1 is a square.

Alarms.Prompt.Caption ="Enter tag-
name"

TRUE, if the value of Prompt's Caption property is   "Enter 
tagname".

Boolean Operators 

Boolean operators let you connect two or more boolean conditions.
Syntax: Boolean Operators

The syntax for each operator is listed in the following table. 

Operator Syntax
AND condition   AND condition
OR condition   OR condition
NOT NOT condition

Example: AND Operator

The AND operator is used when both parts of the expression must be true.   For example, suppose that in 
a factory, several ingredients need to be   mixed together for up to 5 minutes while the mixture is being 
heated to   200 degrees. When both of these conditions (5 minutes and 200 degrees)   are true, you want to 
create an expression to display the following text:

Mixing...

To accomplish these tasks, a rectangle object, MixTime, has been set   up as a progress bar to show the 
time elapsed as a percentage. A text   object, Temperature, has also been animated to show the current 
temperature.

Next, a text object needs to be created for the Mixing message. This   object needs its Visible property 
animated with the following expression:

Mixing.MixTime.VerticalFillPercentage < 100 AND Mixing.Temperature.AnimatedCaption.InputValue < 200
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This expression is true only when the mixing time is less than 5 minutes   and the temperature is less than 
200 degrees. When either condition is   no longer true, the mixer stops and the message is no longer vis-
ible.
Example: OR Operator

Now suppose you want to display instructions to the operator about the   next stage of the process when 
mixing stops. To do this, you can create   another text object and animate its Visible property with the fol-
lowing   expression:

Mixing.MixTime.VerticalFillPercentage >= 100 OR Mixing.Temperature.AnimatedCaption.InputValue >= 200

Example: NOT Operator

Unlike AND or OR, the NOT operator does not   connect two boolean conditions. Instead, it inverts the 
value of a condition.   For example, if the following condition is true:

Alarms.Tank3.HorizontalFillPercentage>80

then the following condition is false:

NOT Alarms.Tank3.HorizontalFillPercentage>80

Changing the Order of Precedence 

When evaluating an expression, iFIX defines an order of precedence for   each operator. The order of pre-
cedence determines which operators (and   the values on each side of the operator) are evaluated first. 
The following   table lists each operator from highest to lowest precedence. 

Operator Precedence
( ), NOT, - (unary minus) 1
*, /, AND 2
+, - (subtraction), OR 3
<, <=, >, >= 4
=, <> 5

You can change the order of precedence by enclosing an expression in   parentheses. Parentheses are 
regarded with the highest priority; thus   all expressions within the parentheses are evaluated first. Oper-
ators   with the same precedence are evaluated in the order they appear from left   to right.
Example: Changing the Order of Precedence

For example, consider the following expressions: 

Expression Value
6+4/2 8
(6+4)/2 5

Bit Operators for Expressions

The GETBIT function allows for bit-level manipulations of data. The   GETBIT function has the following 
syntax:

GETBIT ( nBitNumber nNumberBits uiSourceToken )

You can enter comma to spearate the arguments, but you must have a space between the arguments to 
separate them.

The source token is promoted to the closest unsigned integer data representation   that maintains its 
length. The corresponding zero based range of bits   (bit zero is the most significant bit) is extracted from 
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the source and   an integer is returned which corresponds to the value these bits define   if they existed 
starting in the least significant bit of their own integer.   For example: 

GETBIT ( 8 4 N.T.F )

IMPORTANT:   Be aware that you must have spaces in between the operator and operands   in expressions.  

 

Modifying Expressions 

You can modify an expression by editing the entry in the Data Source   field of either the Expert, or the 
Animations or Expression Builder dialog   boxes. We recommend using the Expression Builder, as you 
can more easily   enter new data sources by selecting or typing them into the field. To   delete an expres-
sion, right-click the expression and select Delete.

Browsing the Model in the Expression Builder

You can browse your iFIX model directly when building an animation expression in your picture using the 
Expression Builder, as shown in the following figure. Browsing Types automatically creates a symbol-
based string in your expression, while browsing Object instances directly inserts the instance variable in 
your expression.

© 2024 General Electric Company. All rights reserved. 429



Accessing the Animation Dialog Boxes

iFIX provides the following options for configuring Animations:

 l Experts   – In the iFIX WorkSpace, select the appropriate Expert from the Experts   toolbar, or the 
Task Wizard (Classic or Ribbon views) or on the Tools   tab, in the Animations group, Animations  
list   (Ribbon view). If the Toolbox is enabled, click the button on the Toolbox.

 l Basic   Animation dialog box – In the iFIX WorkSpace, double-click an object   or select Anim-
ations from the right-click menu. This dialog box contains   many commonly used animations. For 
a listing of all animations available   to an object, use the Advanced Animations dialog box.

 l Advanced   Animations dialog box – Click the Configure button on the Basic   Animation dialog 
box; or, if configured, the Advanced Animations dialog   box appears when you double-click an 
object in the iFIX WorkSpace or select   Animations from the right-click menu. 

NOTE:   To configure the Advanced Animations dialog box to always appear when   you double-click an 
object or select Animations from the right-click menu,   clear the Always Show Basic Animation dialog 
box option on the Picture   Preferences Tab of the User Preferences dialog box. 

 

Selecting a Data Source from a List

 To select a data   source from a list:

 1. In the iFIX WorkSpace,   select an object.

 2. Open either of the   Animation dialog boxes.

 l If you are   using the Advanced Animations dialog box, select the tab containing the   prop-
erty you want to change and select the applicable Animate check box.   The dialog box 
expands to display the applicable animation properties.

 l If you are   using the Basic Animation dialog box, select the appropriate Animation   Expert 
button.

 3. Click the Browse   button to the right of the Data Source field.

 4. Click the tab containing   the data source.

 5. Select the I/O point,   tag, or property you want to use as a data source and click OK. The selected   
data source appears in the Data Source field.

Creating an Animation Using the Basic Animation Dialog Box

 To create an   animation using the Basic Animation dialog box:

 1. In the iFIX WorkSpace,   select the object you want to animate.

 2. Select Animations   from the right-click menu. The Basic Animation dialog box appears.

NOTE: The   Basic Animation dialog box appears the first time you access Animations   in iFIX. To con-
figure the Advanced Animations dialog box to always open   when you double-click an object or select 
Animations from the right-click   menu, clear the Always Show Basic Animation dialog box option in the 
Picture   Preferences Tab of the User Preferences dialog box.

430 © 2024 General Electric Company. All rights reserved.



 3. Select the check   box of the animation property that you want to add to your object. The   asso-
ciated Animation Expert dialog box opens. 

If the Animation that you want to add is   not listed in the Basic Animation dialog box, click the Con-
figure button   to open the Advanced Animations dialog box. The Advanced Animations dialog   box 
contains all available animations for the selected object. For more   information on creating objects 
in the Advanced Animation dialog box,   refer to the Working with Advanced Animations Overview.

 4. Enter the configuration   information for the Animation Expert.

The added Animation property is now selected   in the Basic Animation dialog box. 

 5. Add any additional   animations or click OK to close the dialog box.
 

Modifying an Animation in the Basic Animation Dialog Box

 To modify an   animation using the Basic Animation dialog box:

 1. In the iFIX WorkSpace,   right-click an object and select Animations. The Basic Animation dialog   
box appears.

 2. Click the button   of the animation property that you want to modify. The associated Animation   
Expert dialog box opens.

IMPORTANT:   If you select the check box, you will delete your animation. To   modify an animation, you 
must click the button to access the Expert dialog   box.

 3. Make any required   modifications to the animation and click OK to return to the Basic Animation   
dialog box.

 

Animating Grouped Objects

 To animate a   grouped object:

 1. In the iFIX WorkSpace,   right-click the group you want to animate, and select Animations. The   
Basic Animation dialog box appears.

 2. Click the appropriate   Expert button.

 3. Enter the configuration   information for the Animation Expert.

 

Deleting an Animation in the Basic Animation Dialog Box

 To delete an   animation using the Basic Animation dialog box:

 1. In the iFIX WorkSpace,   select Animations from the object's right-click menu. The Basic Anim-
ation   dialog box appears. If a property contains an animation, the check box   is selected. 

 2. Clear the check box   to delete the animation.

Based on your User Preferences settings,   you may be prompted to acknowledge this action by 
clicking Yes. To configure   whether or not you are prompted upon deleting an animation, modify 
the   Prompt on Delete option in the Picture Preferences tab of the User Preferences   dialog box.
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IMPORTANT:   To delete all animations you configured in the Advanced Animations dialog   box, clear 
the Advanced Animations check box. If you have assigned multiple   animations from the Advanced 
Animations dialog box, be aware that you   will be deleting all of those animations. If you have multiple 
animations   assigned in the Advanced Animations dialog box, it is recommended that   you delete them 
separately within the Advanced Animations dialog box itself.

 

Modifying an Animation in the Advanced Animations Dialog Box

 To modify an   animation using the Advanced Animations dialog box:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

 2. Click the Configure   button. The Advanced Animations dialog box appears.

 3. Select the tab containing   the property you want to change.

 4. If necessary, in   the Data Source field, change the data source you want to use. 

 5. If appropriate, on   the Animation Properties tab, change the type of data conversion you want   and 
complete the related fields.

 6. If appropriate, on   the Historical Properties tab, change the start date, start time, time   zone, his-
torical mode, duration, or update rate.

Deleting Animations in the Advanced Animations Dialog Box

 To delete an   animation using the Advanced Animations dialog box:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

 2. Click the Configure   button. The Advanced Animations dialog box appears.

 3. Select the tab containing   the animation you want to delete. Look for tabs with arrows to help you   
navigate to properties that have been animated.

 4. Clear the Animate   check box for the property that contains the animation you want to delete.

 5. Click OK to save   your changes and close the dialog box.

 

Entering a Property Value in the Advanced Animations Dialog Box

 To enter a property   value in the Advanced Animations dialog box:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

NOTE:   For some objects, you must right-click the object and select Animations   from the pop-up menu.

 2. Click Configure.   The Advanced Animations dialog box appears.

 3. Click the tab containing   the property you want to change.

 4. In the row containing   the property you want to change, click the Animate button. The Dynamic   
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Settings area appears.

 5. In the Dynamic Settings   area, enter the desired value(s) for the property.
 

Changing Properties Using the Property Window

 To change a property   using the Properties window:

 1. In the iFIX WorkSpace,   right-click the object you want to modify and choose Property Window.   
The Properties dialog box appears.

 2. Locate the property   you want to change in the left column of the window and double-click its   row.

 3. If the property lets   you enter a new value, enter that value and press Enter. After you enter   the 
new value, the object changes to reflect your entry.

NOTE:   If the property displays a drop-down list, select the new value from the   list. If the property is a 
Boolean value, double-clicking will automatically   toggle the value. If the property displays an ellipsis 
button, click the   button to open the appropriate dialog box where you can make the required   changes. 

Entering Highlight Timeout Intervals

 To enter a Highlight   Timeout Interval:

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Picture   Preferences tab. 

 3. In the Window Properties   area, select the Click and Stick Enabled check box.

 4. In the Properties   area, enter a value in the Highlight Timeout Interval field to define   the time 
period. The value must be entered in seconds.

 

Filtering Data Sources

 To filter data   sources:

 1. In the iFIX WorkSpace,   double-click an object. The Basic Animation dialog box appears.

 2. Open the Advanced   Animations dialog box, or click the appropriate Expert in the Basic Animation   
dialog box.

If you are using the Advanced Animations   dialog box, select the tab containing the property you 
want to change   and select the applicable Animate check box. The dialog box expands to   display 
the applicable animation properties.

 3. Click the Browse   button to the right of the Data Source field.

 4. Click the appropriate   tab containing the data source you want.
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 5. In the Filter field,   enter a data source name or select one from the drop-down list. If desired,   use 
the asterisk wildcard character to search for data source names.

 6. Click Filter or,   if you are on the FIX Database or Alarm Counters tabbed page, click F.
 

Creating Expressions

 To create an   expression:

 1. In the iFIX WorkSpace,   double-click an object. The Basic Animation dialog box appears.

 2. Click the Configure   button. The Advanced Animations dialog box appears.

 3. Select the tab containing   the property you want to change and select the appropriate Animate 
check   box.

 4. Click the Browse   button to the right of the Data Source field.

 5. Click the appropriate   tab and select the data source you want.

 6. If you want to combine   another data source in the expression, click the Mathematical Functions   
button and enter an operator.

 

Modifying Expressions

 To modify an   expression:

 1. In the iFIX WorkSpace,   double-click an object. The Basic Animation dialog box appears.

 2. Click the Configure   button. The Advanced Animations dialog box appears.

 3. Select the tab containing   the property you want to change and select the appropriate Animate 
check   box.

 4. Click the Browse   button to the right of the Data Source field.

 5. Select the tab for the desired   data source. 

TIP: If you cannot see the tab (say for instance the Historian or Model tab is obscured from view), click 
the drop-down to the far right of the tab view and select the tab you want to view. 

 6. If you want to combine   another data source in the expression, click the Mathematical Functions   
button and enter an operator using the expanded keypad.

 7. Repeat   the necessary steps until you create the desired expression.

 

Deleting Expressions

 To delete an   expression:

 1. In the iFIX WorkSpace,   double-click an object. The Basic Animation dialog box appears.

 2. Click the Configure   button. The Advanced Animations dialog box appears.

 3. Select the tab containing   the animation you want to modify.
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 4. Select the property   that contains the animation that you want to modify.

 5. Select the desired   data source.

 6. Highlight the expression   and press Delete.
 

Data Conversions, Error Defaults, and Threshold Tables

In the iFIX WorkSpace, you can perform the following steps with   data conversions, error defaults and 
threshold tables:

 l Completing   a Range Data Conversion

 l Completing   a Table Data Conversion

 l Completing   a Format Data Conversion

 l Modifying   Animations Error Defaults

 l Assigning   Blinking Thresholds

 l Setting   the Blink Speed

 

Completing a Range Data Conversion

 To complete a   range data conversion:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

 2. Click Configure.   The Advanced Animations dialog box appears.

 3. Click the tab containing   the property you want to change, and select the Animate check box next   
to that property.

 4. From the Data Conversion   list, select Range.

 5. In the Minimum Input   and Minimum Output fields, enter the minimum input and output values,   as 
needed.

 6. In the Maximum Input   and Maximum Output fields, enter the maximum input and output values,   
as needed.

 7. If you want the selected   object to read a value from the data source when the picture opens, 
select   the Fetch Input Range on Open check box.

 8. If you want to perform   an animation on an object in its current position, not in the absolute   position 
specified by the logical unit or postscript point value in the   Minimum Output field, select the Use 
Offset check box.

 

Completing Table Data Conversion
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 To complete a   table data conversion:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

 2. Click Configure.   The Advanced Animations dialog box appears.

 3. Click the tab containing   the property you want to change, and select the Animate check box next   
to that property. 

 4. From the Data Conversion   list, select Table. Make sure you have the correct number of rows in 
the   table. If you do not, click the Insert Row button to add a row. If you   have too many rows, click 
the Delete Row button to remove a row from the   table. 

 5. Select either the   Range Comparison option (to define a range of values for each row in the   lookup 
table) or the Exact Match option (to define a single digital value   for each row in the lookup table).

 6. Do one of the following:

 l Enter the high   and low values for each row in the lookup table.

 l Enter a single   lookup value in the Value column for each row in the lookup table.

 7. Enter or select the   comparison value for each row in the lookup table by doing one of the   fol-
lowing: 

 l If you want to   define a color, double-click the color you want to modify and select a   new 
one from the Color dialog box when it appears.

 l If you want to   enter a string or a numeric value, enter it into the cell.

 l If you want to   select a value from a list, click the down arrow button to display the   list of 
options and select the value you want.

 8. If you want the object   to blink, enter a blink value for each row in the lookup table. 
 

Completing a Format Data Conversion

 To complete a   format data conversion:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

 2. Click Configure.   The Advanced Animations dialog box appears.

 3. Click the tab containing   the property you want to change, and select the Animate check box next   
to that property.

 4. From the Data Conversion   list, select Format.

 5. In the Type field,   specify whether you want to write data to the database. In-Place allows   the user 
to write to the database.

 6. Select the Confirm   check box if you want operators to confirm each entry they make.

 7. From the Justify   list, select how to justify the data on the screen.

 8. From the Type list,   select the type of data.
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 9. If the data type   is alphanumeric, enter the number of lines to display in the Lines field   and the num-
ber of characters per line in the Chars/Line field. If the   data type is numeric, enter a value of 0 to 7 
in the Whole Digits field   and 0 to 5 in the Decimal field.

 10. Select the Raw Format   check box if you want to display data in its raw format.

Modifying Animations Error Defaults

 To modify animations   error defaults:

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select User Preferences.   

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences. 

 2. Click the Animations   Data Error Defaults tab.

 3. Enter the desired   numeric value or text string based on the following guidelines:

 l For range conversions,   enter a numeric string in the appropriate fields of the Linear Anim-
ation   Object Defaults area.

 l For format conversions,   enter a text string in the appropriate fields of the Format Anim-
ation   Object Defaults area.

 l For table conversions,   enter a numeric or string value in the appropriate Numeric Table 
Entries   or String Table Entries fields, respectively. To assign a color to the   new entry, 
click the corresponding field in the Color Table Entries column   and select a color from the 
Select Color dialog box.

Assigning Blinking Thresholds

 To assign a blinking   threshold:

 1. In the iFIX WorkSpace,   select an object.

 2. In Classic view,   click the appropriate Color Expert on the Experts toolbar, or click the   Task Wiz-
ard button and select the appropriate Color Expert from the Task   Wizard dialog box. 

-Or-

In Ribbon view, on the Tools tab, in the   Tasks/Experts group, click the Tasks/Experts dialog box 
launcher and select   the appropriate Color Expert from the Task Wizard dialog box.

 3. In the Data Source   field, enter a data source.

 4. Select the coloring   scheme by selecting the appropriate option in the Color By area. 

 5. Select the threshold   method by selecting the appropriate option in the Color Threshold area.   

 6. In the New Alarm   area, select the Blink on New Alarm check box.

 7. Click the Blink on   New Alarm Color button and select the blink color from the Select Color   dialog 
box.

 

Setting the Blink Speed
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 To set the blink   speed:

 1. In the iFIX WorkSpace,   double-click the object you want to modify. The Basic Animation dialog   
box appears.

 2. Click Configure.   The Advanced Animations dialog box appears.

 3. Click the Color tab.

 4. Select the Animate   check box for the color property you want (ForegroundColor, Back-
groundColor,   EdgeColor, BackDropColor, BackDropBorderColor, BackDropBackgroundColor,   or 
BackDropFadeColor). 

 5. Click the Advanced   button and, in the Other Options area, enter a blinking rate (in seconds)   in the 
Toggle Rate field. 
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Running Your Pictures

Once you have developed your pictures, you are ready to see them go   to work for you. All of the devel-
opment time you put into your design   can now be realized with the click of the mouse. 

Because the iFIX configuration environment is fully integrated with   the iFIX WorkSpace, running your 
pictures is simply a matter of   switching environments. You do not have to start another application or   
leave your picture. Just click the Switch to Run button on the Standard   toolbar (Classic view), or on the 
Home tab in the WorkSpace group, click   Switch to Run (Ribbon view), or press Ctrl+W. This launches 
you into the   run-time environment. The iFIX WorkSpace system tree disables,   and the objects in your 
picture activate. To return to your drawing, select   Switch to Configure from the WorkSpace menu (Clas-
sic view), or on the   Home tab in the WorkSpace group, click Switch to Configure (Ribbon view),   or press 
Ctrl+W again.

When working with your pictures in the run-time environment, you have   many of the same iFIX 
WorkSpace menus available as you did in the configuration   environment. The operations you can per-
form are dependent on two factors:   the type of document that you have open, and the access privileges 
you   are allowed. For example, typically operators will employ some degree   of environmental protection 
to implement a secure run-time environment.   In this case, some of the iFIX WorkSpace menus may not 
be available   because access to specific functions was not granted. For more information   on how to 
implement this type of security, refer to the Configuring Security Features manual.

The following sections provide detail on the operations you can perform   with your pictures while in the 
run-time environment. For more information   on the run-time environment of the iFIX WorkSpace, refer to 
the   Understanding iFIX manual. 

Working with Objects in the Run-time Environment 

Objects in your pictures can be controlled, selected, or modified based   on the properties you have 
enabled for the objects. These properties are   enabled in the configuration environment by selecting the 
appropriate   check box on the Basic Animation dialog box or the General tabbed page   of the Advanced 
Animations dialog box. The following table details the   operations you can perform with objects in the run-
time environment based   on the property you have activated. 

By selecting the 
check   box...

You activate the 
property...

Which lets you...

Enable Tooltips EnableTooltips Enable tooltips for the object at run-time. Text for   the highlight 
comes from the Description property.

Enable Highlight HighlightEnabled Highlight the object at run-time. When the cursor   passes over the 
object, a single-lined box surrounds the object. 

Enable Select IsSelectable Select the object at run-time. When you select the   object, a double-
lined box surrounds the object.

Object   Run-time Attributes 

Each of the properties can also be animated so that you can perform   more specific actions. For more 
information on animating object properties,   refer to the Animating Object   Properties chapter. 

Some objects can be modified at run-time by writing and executing Visual   Basic scripts. For more detail 
on writing scripts to control objects at   run-time, refer to the Writing Scripts   manual.
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Interacting with Alarm Summaries at Run Time 

While in the run-time environment you can view and test an Alarm Summary   object's configuration. For 
example, you can:

 l Acknowledge the currently   selected alarm. 

 l Acknowledge or delete   all alarms that match the current filter. 

 l Change the Alarm   Summary object's filter or sort configuration. 

 l Change and restore   the Alarm Summary object's default settings. 

 l Temporarily disable   the alarm refresh rate and instruct the Alarm Summary object to stop updat-
ing   the spreadsheet. 

For more information on working with Alarm Summary objects in the run-time   environment, refer to the 
Working with  the Alarm Summary Object section of the Implementing Alarms and Messages   manual.

Interacting with Charts in Run Time 

While in the run-time environment, you can control certain chart properties.   Some examples include the 
following:

 l Modifying pen properties   using the Chart Customization dialog box. 

 l Zooming in on an   area of the chart. 

 l Displaying multiple   X and Y axes. 

 l Displaying time cursor   tooltips to determine plot values and time stamps. 

For more information on working with charts in the run-time environment,   refer to the Working  in the Run-
time Environment section of the Trending Historical Data   manual.

Locating Objects 

The Locate Object Expert lets you search for an object in the current document or any open documents 
in the iFIX WorkSpace while in the run-time environment. Simply open the Expert and type the object's 
name in the Object's Name field. You can access this Expert from the Command Category of the Task 
Wizard.

Using the Global Time Control

The Global Time Control, which is available on the Historical tab, in   the Ribbon view during run mode, 
allows you to control the display of   objects configured with historical data sources. If the data source 
configured   in an object is not historical, that is, it uses a real-time data source,   the Global Time Control 
feature has no effect on it. Using the Global   Time Control you can do the following: 

 l Synchronize the time   for all historical data sources to the times displayed in the Start Time   and 
End Time fields (by clicking any of the controls on the Global Time   Control). This synchronization 
applies to all open pictures where GlobalTimeSync   is set to true. The parameters in the Global 
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Time Control do not persist   when you exit run mode.

 l Set the historical   data sources to end at the current time (using the Set to Current Time   button)

NOTE:   If the historical data source in an object is configured for Current Value   mode, the Set to Cur-
rent button has no effect on it. 

 l Scroll through the   historical data, either forward or backward, quickly or slowly (using   the Scroll 
buttons).

 l Playback historical data by a specified speed or frame size.

To use the Global Time Control, the GlobalTimeSync picture property   must be set to true. By default, 
GlobalTimeSynch is set to true on all   pictures. If the GlobalTimeSync is not set to true, than the Global 
Time   Control and its control buttons has no effect on the open pictures. The   GlobalTimeSync property 
can be accessed via the picture's Property Window.

Configuring the Global Time Control

To configure the Global Time Control, click Configuration on the Historical   tab. This opens the Global 
Time Control Configuration dialog box. There,   you can set the start time and end time for the historical 
displays, as   well as the update and scroll rates. You can also enable playback here, optionally.

Clicking OK applies the parameters set in the Global Time Control to   all open pictures.

The Global Time Control is enabled for all pictures, by default. If   you do not want operators to be able to 
configure the Global Time Control,   then disable this option, by setting GlobalTimeSync to false, via the   
Properties window.

Displaying the Global Time Control

To display the Historical tab, which contains the Global Time Control,   you can either:

Click the Historical tab, which will cause it to display until you click   elsewhere.

-Or-

Clear the Minimize the Ribbon option from the Quick Access Toolbar,   which causes the Historical tab to 
display until you leave run mode.

Using the Global Time Control

The Global Time Control has several buttons which control the display.   They are pictured in the following 
image and detailed in the following   table. 

Global Time Control

The Global Time Control includes the following buttons:
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Button Description
Fast Scroll Back. By default, this scroll value is   a percentage of the dur-
ation (either the Duration you entered directly   in the Global Time Control 
Configuration dialog box, or the duration calculated   from the End Time- 
Start Time in the Global Time Control Configuration   dialog box). Other-
wise, this scroll value is the number of days, hours,   minutes, or seconds 
as defined in the Global Time Control Configuration   dialog box.
Slow Scroll Back. By default, this scroll value is   a percentage of the dur-
ation (either the Duration you entered directly   in the Global Time Control 
Configuration dialog box, or the duration calculated   from the End Time- 
Start Time in the Global Time Control Configuration   dialog box). Other-
wise, this scroll value is the number of days, hours,   minutes, or seconds 
as defined in the Global Time Control Configuration   dialog box.
Apply the settings from the Global Time Control Configuration   dialog box 
to all open, or subsequently opened pictures, that have the   Glob-
alTimeSync picture property set to true.

NOTE: If   you have scrolled in your picture, either forward or back, after 
you click   Apply, the time period displayed in the picture is reset to the 
period   specified in the Global Time Control Configuration dialog box; the 
time   to which you scrolled is no longer displayed.
Pause the Historical Update of objects that have a   historical update rate 
configured. Objects that do not have a historical   update rate configured 
are not affected. 

NOTE: Even   though a picture is paused, you can still scroll forward or 
back.
Set the End Time of the Global Time Control to the   Current Time.

Slow Scroll Forward. By default, this scrolls the   time frame as a per-
centage of the duration (either the Duration you entered   directly in the 
Global Time Control Configuration dialog box, or the duration   calculated 
from the End Time- Start Time in the Global Time Control Configuration   
dialog box). Otherwise, this scroll value is the number of days, hours,   
minutes, or seconds as defined in the Global Time Control Configuration   
dialog box.
Fast Scroll Forward. By default, this scrolls the   time frame as a per-
centage of the duration (either the Duration you entered   directly in the 
Global Time Control Configuration dialog box, or the duration   calculated 
from the End Time- Start Time in the Global Time Control Configuration   
dialog box). Otherwise, this scroll value is the number of days, hours,   
minutes, or seconds as defined in the Global Time Control Configuration   
dialog box.

Global Time Control Buttons

NOTE: Changes   made using the Global Time Control apply to historical data sources in   all open pictures 
which have the GlobalTimeSync property set to true.   

The time frame of the data displayed is adjusted to represent the time   of your local time zone.
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Example

Assume the following settings for the Global Time Control: 

 l Duration = 1 hour

 l End Time = 10:00   a.m.

 l Update Rate = 10   minutes

 l Slow Scroll Percentage   = 10%

Clicking Apply applies these settings to all objects containing historical   animations within any open pic-
ture that has the Global Time Control enabled.   

In this example, with the preceding parameters configured in the Global   Time Control, causes the fol-
lowing to occur:

 l Historically animated   objects display historical values between 9:00 a.m. and 10:00 a.m.

 l After 10 minutes,   the picture updates, with historical animations displaying values between   9:10 
a.m. and 10:10 a.m.

 l Clicking Slow Scroll   moves the time window for historical animations forward or backward by   6 
minutes

Limitations

If you apply a short update rate to pictures that contain a large number   of objects with Historical Anim-
ations, you may experience performance   issues –   your objects may not update at the expected rate.

Using Experts to Expedite Pictures at Run Time 

iFIX Experts allow you to perform many different functions at run-time,   and several of the Experts 
provide a check box that let you specify a   function in the run-time environment. The following table 
details the   Experts that you can use in the configuration environment that let you   specify run-time func-
tionality.

NOTE: When using the   Use Database Tag(s) for Item(s) Selected in Run Environment option in   the experts, 
make sure that the object is highlightable, but not selectable.   If the object is selectable when the script is fired, 
the script looks   at that object for a data source and fails when it cannot find one.

To... Select the check box... On the Expert...
Open a picture Select picture to open in Run Environment Open Picture
Close a picture Close Current Picture in Run Environment Close Picture
Replace a picture Replace Current Picture in Run Environment Replace Picture
Open a digital tag Use Database Tag(s) for Item(s) Selected in 

Run Environment
Open Digital Tag

Close a digital tag Use Database Tag(s) for Item(s) Selected in 
Run Environment

Close Digital Tag

Toggle a digital tag Use Database Tag(s) for Item(s) Selected in 
Run Environment

Toggle Digital Tag

Write a value to a tag Use Database Tag(s) for Item(s) Selected in 
Run Environment

Write Value to 
Tag

Ramp a value to a tag Use Database Tag(s) for Item(s) Selected in Ramp Value to 

Performing Operations at Run   Time Using Experts  
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Run Environment Tag
Turn a tag on scan Use Database Tag(s) for Item(s) Selected in 

Run Environment
Turn Tag On Scan

Turn a tag off scan Use Database Tag(s) for Item(s) Selected in 
Run Environment

Turn Tag Off 
Scan

Set a tag to automatic mode Use Database Tag(s) for Item(s) Selected in 
Run Environment

Set Tag Auto

Set a tag to manual mode Use Database Tag(s) for Item(s) Selected in 
Run Environment

Set Tag Manual

Toggle a tag between automatic and 
manual mode

Use Database Tag(s) for Item(s) Selected in 
Run Environment

Toggle Tag 
Auto/Manual

Enable an alarm Use Database Tag(s) for Item(s) Selected in 
Run Environment

Enable Alarm

Disable an alarm Use Database Tag(s) for Item(s) Selected in 
Run Environment

Disable Alarm

Acknowledge an alarm Use Database Tag(s) for Item(s) Selected in 
Run Environment

Acknowledge 
Alarm

Acknowledge all alarms Acknowledge All Alarms for Current Picture in 
Run   Environment

Acknowledge All 
Alarms

For more information on alarm acknowledgment, refer to the Implementing  Alarms and Messages 
manual.

Multiple Picture Instances and Run Mode 

At run-time in the iFIX WorkSpace, you can open multiple instances of   a single picture. This action is 
common for iFIX picture displays in multiple   monitor configurations. After opening the picture, you can 
replace it   even if another instance is already open in the WorkSpace, or choose to   close all open 
instances of the picture.

The following table lists the automation interfaces available for working   with multiple picture instances.

iFIX Auto-
mation Interface

Description

OpenPicture  
Subroutine

Opens the specified picture. Can be configured to   open multiple instances of a spe-
cified picture. 

OpenTGDPicture  
Subroutine

Opens a picture with the specified tag group file.   Can be configured to open multiple 
instances of a picture with different   tag group files. 

ReplacePicture  
Subroutine 

Closes a picture and replaces it with another picture.   If the picture you select is 
already open in the WorkSpace, another instance   of that picture opens. 

ClosePicture  
Subroutine

Closes the specified picture. If there are multiple   instances of a picture open, all 
instances of that picture are closed.   If a different alias is assigned to each instance, 
you can close one instance   using an alias.

Open_QT_Pic_
Ex  Method

Opens a Quick Trend Picture for the selected object(s)   with a set of pens based on 
the first eight (8) valid tags. Can be configured   to open multiple instances of a Quick 
Trend Picture. 

Open_TCP_Pic_
Ex  Method

Opens a Tag Control Panel Picture that displays up   to 20 of the valid tags asso-
ciated with the currently selected object.   Can be configured to open multiple 
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instances of a Tag Control Panel Picture.   
Open_TS_Pic_
Type_Ex  Method

Specifies the type of Tag Status picture to open.   Can be configured to open multiple 
instances of a Tag Status Picture.   

Open_TS_Pic_
Ex  Method

Opens the Tag Status Picture for first found tag for   the selected object(s). Can be 
configured to open multiple instances of   a Tag Status Picture. 

Additionally, the following experts allow you to work with multiple   picture instances:

 l Open  Picture Expert

 l Replace  Picture Expert

 l Close   Picture Expert

Important Information About Run Mode

In run mode, you can modify the VBA scripting in a new instance of a   picture. However, modifications to 
scripts in an individual instance of   a picture will not be saved. Saving changes to scripts in run mode is   
not allowed. To make changes to a script in the main picture, switch to   configure mode and edit the 
script in the main picture (not the instance).   Alternatively, you can edit the VBA script in the main picture 
(not the   instances) in run mode using the steps below.

 To edit a VBA   script of a picture with multiple instances open in run mode:

 1. In Classic view,   in the iFIX WorkSpace, from the WorkSpace menu, select Visual Basic Editor.   

-Or-

In Ribbon view, on the Home tab, in the   WorksSpace group, click the Visual Basic Editor. 

 2. In the Project tree   display, browse to the project you want to edit the script of. Be sure   to select 
the project with the asterisk (*) next to it. For multiple instances,   the asterisk indicates which 
instance is one you can save changes to.   Changes to projects with the same name, but without 
the asterisk, will   not be maintained when you switch back to configure mode.

 3. In the Project tree,   in your selected project, right-click the object you want to edit and   select View 
Code. The code will appear in the main editing window.

 4. On the Run menu,   select Design Mode. 

 5. Make your VBA script   changes.

 6. On the Run menu,   select Exit Design Mode. 

 7. Close the VBA Editor.   

Now, when you go back to configure mode,   you will be able to save your changes.
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Using Tag Status and Quick Trend Pictures

The iFIX WorkSpace run-time environment provides you with three   pre-configured picture types that you 
can access to view tag information   and trends for the currently selected object(s), including alarm sum-
mary   objects. These pictures display real-time information about the tags.   

These pictures include:

 l Tag   Status (*_TS.grf)

 l Quick   Trend (QuickTrend.grf)

 l Tag   Control Panel (TagControlPanel.grf)

You can access these pictures when the WorkSpace is in run mode.

IMPORTANT:   If you create a new iFIX project in the SCU, the TagStatus subdirectory   (located in the PIC dir-
ectory) is not copied to the new project path.   You must copy the TagStatus folder to the new PIC directory. For 
more   information about creating new projects, refer to the topic Create  a Project for Each User Type.

In addition to these pictures, if you select an object (or objects)   with one or more associated tags, the 
title bar of the iFIX picture displays   the tag name of the first tag it finds when the picture opens in run 
mode.   

If you have a single database tag associated with an object, the picture's   title bar displays the name of 
that tag when that object is selected.   The following diagram indicates a single associated database tag. 

Where:

circles.grf   – is the name of the picture the object is a part of.

FIX32.THISNODE   – is the name of the name of the SCADA server (where FIX32 is the data   system 
name, and THISNODE is the alias for the local node name). 

ai1 – is the   tag name.

f_cv – is the   field name whose data is being accessed.

If there are multiple database tags associated with an object, the picture's   title bar displays the name of 
the first tag it finds, as well as a plus   (+) sign to indicate that there are more associated tags. The fol-
lowing   diagram shows a plus sign after the tag name to indicate multiple associated   tags.

Open a Tag Control Panel picture to view a list of the tags associated   with the selected object(s).

NOTES:

 l An object's IsSelectable   property must be set to True so you can select it in the run-time environment,   
and the object must be selected to display the tag information in the   title bar.

 l If you clear the Title   bar check box in the Edit Pictures dialog box for the current picture,   the title bar, 
including the picture and tag name information, will not   be displayed in the run-time environment. This 
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is also true for all new   pictures, when the Title Bar check box is cleared on the Picture Preferences   tab 
on the User Preferences dialog box.

Accessing Tag Status, Quick Trend, and Tag Control   Panel Pictures
Tag Status, Quick Trend, and Tag Control Panel pictures are available   only when the WorkSpace is in 
run mode. If a selected object has one or   more associated tags, you can right-click the object and 
choose the picture   type from the menu. You can also select multiple objects and right-click   to choose 
the picture type, as well.

NOTES:

 l In order to use the Tag   Status features, an object must be selectable in the run-time environment.   For 
information about making an object selectable, refer to Animating   an Object's Properties.

 l You do not have to group   objects in configuration mode to access tag status right-click features   in run 
mode. Simply select multiple objects in run mode prior to accessing   the right-click menu.

The following figure shows the right-click menu that appears if at least   one tag is associated with the 
selected object(s). If only one tag is   associated and you choose Quick Trend, the Quick Trend picture for 
that   tag appears. If there is more than one associated tag, the Quick Trend   picture displays a different 
pen for each valid tag.

Right-click Menu

If only one tag is associated and you choose Tag Status, the Tag Status   picture for that tag appears. If 
an object (or objects) has more than   one associated tag, then initially, the above right-click menu 
appears.   When you choose Tag Status, however, a right-click menu like the following   one appears.

Right-click Menu Expanded

This right-click menu allows you to choose the first tag found (in this   example, Fix32.THISNODE.ar) or 
you can choose Tag Control Panel, which   will open the Tag Control Panel picture for this object (or group 
of objects).   

IMPORTANT:   If the VBA Add-on utility has been installed on your machine, and it is   configured to use the 
RMouseClick Event, the above right-click menus will   not be available and you will   not be able to access tag 
status functionality. Only the VBA utility right-click   menu will be available. It is recommended, however, that 
you use the Tag   Status features because iFIX 4.0 and greater does not support   the VBA Add-on utility.

 

The Tag Status Picture

Tag status pictures are a set of pre-defined pictures that display information   for the selected database 
tag. One database tag status picture exists   for each iFIX database tag type (for instance, AI, AO, DI, 
DO, and so   on).
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The following diagram illustrates what a typical Tag Status picture   looks like for an AI database tag type. 
All database tags types have their   own Tag Status picture and contain similar information.

Tag Status Picture for   an AI Database Tag Type

Some tags (that is, database blocks) are designed to work in chains   while others are designed to operate 
on their own. Tags that can work   in chains display the fields Prev Block   and Next Block in the Tag 
Status   picture. If the tags associated with the selected object are configured   to work in a chain, the next 
and/or previous tag in the chain is displayed   in the appropriate fields. You can click these fields to move 
through   the chain and view the data for the associated tags.

Each Tag Status picture contains a real-time trending chart for the   selected database tag. The trending 
charts are set up to display a 5-minute   duration with a 1-second update rate, to a total of 300 viewable 
points   on the chart. You can enlarge the trending chart by first selecting it   then right-clicking and choos-
ing Quick Trend from the menu. This view   of the Quick Trend chart displays only the pen for the selected 
tag, even   if multiple tags are associated with the object.

Quick Trend Charts in Tag Status Pictures

When a Tag Status picture includes a small Quick Trend chart, you can   select this Quick Trend picture 
and then right-click it and choose Quick   Trend to display an enlarged version for the associated tag. 
However,   not all tags display a Quick Trend picture or a Quick Trend chart within   a Tag Status picture. 
Only those tags with an associated F_CV field can   display a Quick Trend chart. The following table lists 
the tags that do   not have F_CV fields:
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Table Caption Outside Table: Tags That Do not Have Quick Trend Chart Capability

Acronym Description

BB On-Off Control

DC Device Control

EV Event Action

FN Fanout

HS Histogram

PA Pareto

PG Program

SQD SQL Data

TX Text

 

The Quick Trend Picture

The Quick Trend picture provides you with real-time trending information   for up to eight (8) database tags 
associated with the selected object(s).   The following diagram shows a Quick Trend picture with 5 pens 
displaying   the data for the associated tags. All of the tags associated with the   objects are listed and 
update the current value of the tag for the current   time. The current time is the time displayed at the right 
edge of the   x-axis.
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Quick Trend Picture Displaying 5 Pens

In this case, there are two AO tags with the same value. These are displayed   as a single pen. 

For information about Quick Trend charts that appear in Tag Status pictures,   refer to Quick Trend Charts   
in Tag Status Pictures.

The Tag Control Panel Picture

The Tag Control Panel picture is available from the right-click menu   when there are multiple tags asso-
ciated with the selected object(s). This   picture lets you view the tag names and types, tag values, the 
last scan   times, units of measure, and alarm information related to each tag associated   with the selec-
ted object(s).

From the Tag Control Panel picture you can also access the Tag Status   or Quick Trend pictures asso-
ciated with the selected tags. However, if   the tag does not have an F_CV field associated with it, a 
Quick Trend   chart will not be available. For information on tags that can display   a Quick Trend chart, 
refer to the section Quick   Trend Charts in Tag Status Pictures. 
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Tag Control Panel Picture   Displaying 5 Tags

Adding and Deleting Tags

In addition, you can add tags to view their information and the Tag   Status and Quick Trend pictures, or 
you can delete tags from the list.   Adding tags to, or deleting tags from the Tag Control Panel, does not   
affect their existence in regard to the selected object(s). Adding and   deleting tags are temporary oper-
ations; that is, adding a tag in this   picture does not add it to the selected object and deleting a tag, even   if 
it is already associated with the object, does not delete it from the   object. 

For example, if the Tag Control Panel picture is full, but you want   to view the Quick Trend picture for 
another tag, you can delete a tag   and add the tag with the information you want to access. The next time   
you open this Tag Control Picture the proper tags will be listed; that   is, tags you deleted will be visible 
again and tags you added will not   exist.

Saving and Loading Tag Lists

You can save a tag list that you manually created by using the Save   Tag List button. When you have cre-
ated the list of tags you want, click   the Save Tag List button and save the list to the desired location. 
When   you want to view a saved tag list, click the Load Tag List button and   select the tag list you want to 
view. Saving and loading tag lists does   not affect the tags that are displayed for the selected object(s).
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Translating Picture Text

The iFIX WorkSpace provides you with the ability to set and   change the language of a picture as it opens 
in run mode. As the picture   opens, the WorkSpace reads a target language file and substitutes the   pic-
ture's text strings with the translated strings. However, it does not   do the translations for you; you must 
provide the translated text strings   yourself. 

Translating text is limited to replacing text captions, button captions,   object descriptions, the Alarm Sum-
mary object, and certain properties   in charts. You cannot switch the language for overall system text 
such   as dialog box titles, menus, error strings, and so on.

IMPORTANT:

 l If you change   the regional settings in Windows, you must restart iFIX and your   computer after you 
make your changes.

 l If iFIX is   running on a computer under English regional settings (or regional settings   for another west-
ern language such as French or German) , you can only   display translated text strings for western lan-
guages (for example: English,    French, and German) in your pictures.

 l In order to   display translated text for non-western languages (such as Chinese, Japanese,   Russian, or 
Polish), regional settings must be configured for the specified   language that you want to display. To 
change the regional settings, be   sure that you select the correct language (for example, Chinese, 
Japanese,   Russian, or Polish) in all of the applicable drop-down lists from the   Control Panel's 
Regional and Language Options dialog box: in the "Standards   and Formats," "Location," and "Lan-
guages for non-Unicode   programs" fields (the "Languages for non-Unicode programs"   field is located 
on the Advanced tab).  For   double-byte languages such as Japanese or Chinese, you additionally 
need   a Japanese or Chinese operating system; more specific details for working   with double-byte lan-
guages are outlined in some of the bullets below.

 l You cannot   switch translations between multiple non-western languages (such as Chinese,   Japan-
ese, Russian, or Polish) without changing the regional settings.   For example, you cannot switch on-
the-fly between Chinese and Japanese,   or Chinese and Russian.  

 l If you want   to display both Japanese and English (or Japanese and another western   language such 
as French or German), you must set the regional settings   to Japanese. You cannot display other non-
western languages, such as Chinese   or Russian, in your pictures; you can only display Japanese and 
western   languages (for example: English, French, and German).

 l If you want   to display both Chinese and English (or Chinese and another western language   such as 
French or German), you must set the regional settings to Chinese.   You cannot display other non-west-
ern languages, such as Japanese or Russian,   in your pictures; you can only display Chinese and 
western languages (for   example: English, French, and German).

 l If you are   using double-byte languages, (for example, Chinese or Japanese), you must   be running 
iFIX on a computer with a native operating system (for example:   a Chinese or Japanese operating sys-
tem) and have the appropriate regional   settings configured. On the Advanced tab of the Regional and 
Language   Options dialog on Control Panel, do not forget to configure the Languages   for non-Unicode 
programs field with the target language. You must also   make sure that you set the applicable font on 
the Shape Preferences tab   on the User Preferences dialog box.

 l If the translated   text for a single-byte language displays as a series of ????, you must   configure the 
Languages for non-Unicode programs field with the target   language and select the applicable font. 
However, you do not require a   native operating system for single-byte languages.

 l For pictures   created in iFIX 4.0 that include Alarm Summary objects, you need to export   your language 
file again, so that the Alarm Summary information is included.   The Alarm Summary object originally 
was not included in iFIX 4.0 language   translation files.

452 © 2024 General Electric Company. All rights reserved.



 l It is recommended   that you only use either global picture translation or individual picture-level   trans-
lation in your pictures. If you mix both settings, your users could   get undesirable results when opening 
pictures in different languages.   

 l Use caution   when using this feature with iFIX WebSpace. It is recommended that you   set the language 
at the individual picture-level in the iFIX WorkSpace,   instead of using the global configuration. That 
way, you can ensure that   only certain pictures open in a specified language (and not the same lan-
guage   settings for all users and all pictures). For an example of the picture-level   settings and how you 
might want to use them with the iFIX WebSpace, refer   to the second example in the Examples   of How 
to Switch Between Languages section.

 l The iFIX WebSpace   Server should match the regional settings and native operating system   language 
of the iFIX SCADA Server.

This feature is very useful if you develop your picture(s) in one language   (in configure mode), but want to 
provide the text in a different language   for operators viewing the picture (in run mode). Using this feature, 
you   can have the same picture available in multiple languages.

This feature is also useful for changing the language of the text that   appears in a picture in configure 
mode. You can export text strings, translate   them, and import the translated text back into your original 
picture so   that your picture's default text strings now appear in the translated   language in configure 
mode. For instance, use this feature if you want   to translate the text for the Tag Status, Quick Trend, 
and Tag Control   Panel pictures. For more information on these picture types, see Using   Tag Status and 
Quick Trend Pictures.

NOTES:

 l Only the iFIX WorkSpace   supports changing the language of the displayed picture text. 

 l Font colors are not available   for translations.

The Translation Toolbar is available to support these features. This   toolbar allows you to export or import 
all of the text from a picture   into a language specific .CSV file. You can then add translations and   font 
requirements to these .CSV files to use when you open the corresponding   pictures. For more information 
about the Translations Toolbar, refer to   Manipulating Objects   Using Toolbars. For more information on 
how to use the toolbar to   export or import a .CSV file, see Exporting   and Importing Language Files.

IMPORTANT:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to edit 
your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   important that 
you use the proper text editor, so that the list separator,   a comma, gets saved properly using your operating 
system's native regional   settings. If you are unsure of your settings, use Notepad to edit your   .CSV files. 

Global Picture Language Settings
Global picture language settings are used when opening pictures in run   mode. However, you must cre-
ate language files for your pictures and translate   the text strings for this feature to work. For example, 
you develop the   configure mode pictures in your native language of French so that you   can update and 
troubleshoot them. But, the operators want to display all   run mode pictures in German. A German lan-
guage file with translated text   must exist for each picture you want the operators to view in German from   
the WorkSpace run mode. If no language file exists, the default language   (in this case French) appears.

When you change the language in run mode using the global language setting,   all pictures that you open 
from that point on will open in the specified   language, as long as there is a language file for that lan-
guage. If you   change the global language setting, pictures that are opened from that   point forward open 
in the new language, but previously opened pictures   do not change to the new language. You must close 

© 2024 General Electric Company. All rights reserved. 453



and reopen those pictures   for the new language to take effect. The language changes only when opening   
the picture in run mode.

NOTE: If a language   file does not exist, the picture text appears in the picture's default   language; that is, the 
language in which it was created.

User Preference for Global Language Settings

To configure the global picture language settings, select the Translate   Picture on Open check box on the 
Picture Preferences tab of the User Preferences   dialog box. When you select this check box, the Lan-
guage list is enabled   and you can choose the language that you want the text strings to appear   in when 
the picture opens in run mode. You can also use the SetLanguage   global subroutine in VBA.

TIP: While in the User Preferences dialog box, you may also want tp confirm that the applicable font is set on 
the Shape Preferences tab and change it, if necessary.

NOTE: When the Translate   Picture on Open check box is selected, the TranslateOnOpen and Lan-
guageDesired   properties in the Properties window for individual pictures cannot be   changed.

Individual Picture Language Settings
Individual picture language settings are also used when opening pictures   in run mode; however, you can 
change the displayed language for a single   picture rather than all pictures. As with global picture lan-
guage settings,   you must create language files for your pictures and translate the text   strings for this fea-
ture to work. 

For example, you have pictures that only administrators look at and   these pictures are displayed in 
French in run mode. You have another group   of pictures that only operators look at and you want to dis-
play these   pictures in Spanish when in run mode. All of the pictures were developed   in English, in con-
figure mode. In this case, each picture can have specific   language settings. French and Spanish 
language files with translated text   must exist for the appropriate pictures the administrators and oper-
ators   will view in run mode. 

TranslateOnOpen and LanguageDesired Properties in   Individual Pictures

To configure the language settings at the picture level, use the TranslateOnOpen and   LanguageDesired   
properties on the active picture. You can access these properties on the   Properties window in the iFIX 
WorkSpace or from a VBA script while   in configure mode. Be aware that in order to set these properties, 
the   Translate Picture On Open check box on the Picture Preferences tab of   the User Preferences dialog 
box must be cleared. If this check box is   not cleared, the global picture language settings override the 
individual   picture settings. 

You can also use SwitchLanguage   to change the language programmatically in VBA.

NOTE: When   you use the individual picture language settings, opening a picture in   run mode for the first time 
is slower than it would normally take without   caching enabled. If you enable picture caching, after the picture 
has   been opened and cached, the next time you open it in run mode there is   no delay. For more information 
about picture caching, refer to Using   Picture Caching. 

 

Language File Exporter Dialog Box
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The Language File Exporter dialog box allows you to export separate   language files that you want to 
translate for each selected picture. 

Export location

Specifies the folder that the language files are exported to. The language   files are exported to the PIC 
folder of your iFIX installation   location. Language files for Tag Status, Quick Trend, and Tag Control   
Panel pictures are exported to the TagStatus subfolder of the main PIC   folder.

Select Pictures

Lists all of the pictures in the PIC folder or in the TagStatus subfolder    of the main PIC folder. 

Show Tag Status Pictures Check Box

Select this check box to display the Tag Status pictures in the Select   pictures list. The Export location 
folder changes to display the Tag Status   folder location.

Always overwrite existing export files Check Box

Select this check box if you want any previously existing language files   for the selected picture(s) to be 
automatically overwritten. Clear this   check box to be prompted to replace existing language files.

Select Language

Specifies the language you want to use for naming the language file.

Select All 

Click this button to select all of the pictures in the list.

Deselect All

Click this button to clear your selections from the list.

Export

Click this button to perform the language files export.

Exit

Click this button to close the Language File Exporter dialog box without   saving any of your changes.

 

Exporting and Importing Language Files
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Language files are Comma Separated Value (.csv) files that can be edited   in Notepad. If list separator is 
comma in your local regional settings,   you can use Microsoft Excel to edit your .CSV files. Otherwise, it 
is   recommended that you use Notepad to edit your .CSV files. It is important   that you use the proper text 
editor, so that the list separator, a comma,   gets saved properly using your operating system's native 
regional settings.   If you are unsure of your settings, use Notepad to edit your .CSV files.   

These .CSV files reside in the same location that your pictures are   found in, which by default, is the PIC 
folder of your iFIX installation   location, or in the TagStatus subfolder of the main PIC folder. Exported   lan-
guage files are saved in the following format:

PictureName_LangLetter.csv

where:

PictureName   is the name of the picture whose language file you are exporting, and

LangLetter   is the acronym for the language the picture is being translated into.

For example, if the picture name is Circles and you select German for   the language, the exported lan-
guage file name will be Circles_DE.csv.   For more information on the available language letters, see the 
section   Language Letter Acronyms.

iFIX WorkSpace provides a Translation Toolbar that allows you   to:

 l Export a single language   file for each picture.

 l Export language files   for multiple or single pictures.

 l Import a language   file.

After you export a language file, open it in Notepad or Microsoft Excel   and translate the appropriate text 
strings. If the global or picture level   language setting is configured for the same language you translated 
the   text strings into, the iFIX WorkSpace reads the translated .CSV file when   the picture opens in run 
mode and displays the text strings in the translated   language.

If you exported more than one language file for a single picture, the   target language file is the file with the 
language that matches the LanguageDesired   property defined for the individual picture. For example, if 
you exported   language files in Spanish, Italian, and French for the picture Circles.grf   , and the Lan-
guageDesired property is set to Spanish, the picture's text   is displayed in Spanish in run mode. To view 
the translated text in Italian   or French, you must close the picture, change the LanguageDesired property   
to the appropriate language, and then reopen the picture in run mode.

Every time you export a language file, a log file is also created. These   log files are created for each pic-
ture that you export a language file   for, even if you are exporting language files for multiple pictures. For   
example, you have 20 pictures in your PIC folder and you use the Language   File Exporter dialog box to 
export German language files for all 20 pictures.   iFIX creates a separate log file for each language file 
with the format:

PictureName_LangLetterExport.log

The log files will be named Circles1_DEExport.log,   Circles2_DEExport.log, and so on.
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Exporting a Single Language File

You can export a language file for the currently active picture. The   language selected in the Lan-
guageDesired property determines the language   letter acronym used in the language file name. If you 
have a global language   set for all pictures, you cannot change the LanguageDesired property.   In order to 
change the language setting at the picture level, you must   clear the Translate Picture On Open check 
box on the Picture Preferences   tab of the User Preferences dialog box. For more information, see Indi-
vidual   Picture Language Settings.

Exporting Multiple Language Files

You can choose to export language files for multiple pictures. Use the   Language File Exporter dialog box 
to select the pictures and language   you want to create language files for. A separate language file for 
each   of the selected pictures is exported. Each file name uses the same language   letter acronym. For 
more detailed information, see Language   File Exporter Dialog Box.

You can also choose to create a language file for a single picture without   having to change the defined 
language setting, whether it is at the global   or the picture level. For example, the global language setting 
is defined   for French and you have already created French language files for your   20 pictures, Circles1.-
grf through Circles20.grf. You now want your Polish   operators to view Circles10.grf in their native lan-
guage in run mode.   Use the Language File Exporter dialog box to export a Polish language   file for 
Circles1.grf. The operators can then set the LanguageDesired   property for Circles10.grf to Polish before 
opening it in run mode.

NOTE: In order   to set the LanguageDesired property, the Translate Picture On Open check   box on the Picture 
Preferences tab of the User Preferences dialog box   must be cleared. If this check box is not cleared you can-
not define individual   picture language settings.

Importing a Language File

After a CSV language file has been exported and translated, you have   the option to import that CSV file 
back into the corresponding picture   while it is open in configuration mode. This allows you to change the   
text translations in the original, source picture –   so that the translated text is saved along with the picture 
(and not just   temporarily displayed in run mode). The translated text replaces the original   text strings in 
the original picture. 

IMPORTANT:   The language selected in the LanguageDesired property must match the language   letter 
acronym in the language file name in order for the language file   to be imported properly.

NOTE: Be aware   that if you only want to switch languages in run mode, you do no need   to import any trans-
lations. Importing translations is an option   available if you want to update the original pictures with translated   
text, so that the translations replace the original text in configure   mode.

If you have a global language set for all pictures, you cannot change   the LanguageDesired property. In 
order to change the language setting   at the picture level, you must clear the Translate Picture On Open 
check   box on the Picture Preferences tab of the User Preferences dialog box.   

Importing a language file is useful if you want to save the picture   with the translated text strings. For 
example, you have a French version   of iFIX and want to replace the text strings in the Tag Status and 
Quick   Trend pictures with French strings and only view these pictures in French.   After the translation is 
complete and you have imported the language file(s),   save the pictures with the new text strings. In this 
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case, both configure   and run mode pictures will appear in the translated language. There is   no need to 
change language files in run mode.

Language Letter Acronyms

LCID LangLetter Language
1027 CA Catalan
1029 CS Czech
1030 DA Danish
1031 DE German
1032 EL Greek
9 EN English
1034 ES Spanish
1035 FI Finnish
1038 HU Hungarian
1040 IT Italian
1041 JA Japanese
1042 KO Korean
1043 NL Dutch
1044 NO Norwegian
1045 PL Polish
1049 RU Russian
3098 SR Cyrillic
1050 HR Croatian
1051 SK Slovak
1053 SV Swedish
1054 TH Thai
1055 TR Turkish
1057 IN Indonesian
1060 SL Slovenian
1069 EU Basque
1028 ZHTW Chinese - Taiwan
1036 FR French
1046 PTBR Brazilian Portuguese 
2070 PT Portuguese
2052 ZHCN Chinese PRC
3084 FRCA French Canadian

Country Acronyms for Language Files 

 

Examples of How to Switch Between Languages

The following examples show you how to use VBA scripting that allows   you to change the displayed lan-
guage in your pictures when they are opened   in run mode. 
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Example 1 shows you how to set the script at   the global level (with SetLanguage). That is, all pictures 
that have an   exported language file for the set language will display the text in that   language when 
opened in run mode.

Example 2 shows you how to set the script to   open a specific picture in run mode (with Trans-
lateOnOpen,   LanguageDesired,   and SwitchLanguage)   and display the text in the desired language.

Example 3 shows you how to switch the language   for a single open picture, dynamically in run mode 
(with SwitchLanguage).

TIP:   If you want to re-use these examples be sure that you review the important   items listed on the Translating   
Picture Text topic before doing so, to ensure your configuration is   correct.

Example 1: Configure Global Language for all Pictures   to Open in Run Mode

The following example shows you how to create a picture that allows   you to globally switch between lan-
guages while in run mode, in this case   English and Spanish. After you switch the language the first time, 
any   picture you open from that point onward displays in the specified language,   provided a language file 
exists. You must close the picture and click   another language button to switch the language again. With 
this example,   you must manually open and close your pictures in run mode.

NOTE:   This example assumes that English is the default language that the pictures   are created in.
IMPORTANT:   If you are using the iFIX WebSpace, it is recommended that you configure   the language set-
tings at the individual picture-level. If you instead   configure them globally using this example, you will reset 
the language   across all pictures for all users. This may be undesirable for your web   users. For steps on pic-
ture-level configuration, refer to the second example   below.

 1. In the iFIX WorkSpace   configure mode, open the User Preferences and click the Picture Prefer-
ences   tab.

 2. In the Cache area,   clear the Enable Picture Caching check box if is enabled. This check box   
must be disabled if you want to re-open the same   picture in the new language, after changing the 
languages.

 3. In the Picture Translation   area, select the Translate Picture on Open check box, and in the Lan-
guage   drop-down list select Default.

 4. Create a new picture   with two push buttons labeled "Open Pictures in English" and   "Open Pic-
tures in Español", as in the following picture.
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Language Buttons

 5. In configure mode,   right-click the Open Pictures in English push button and choose Edit Script.   
The Visual Basic Editor appears.

 6. Enter the following   script to set the global language:
SetLanguage LANG_English
 

 7. Repeat steps 5 and   6, with the Open Pictures in Español button, but replace the SetLanguage   
LANG_English line with SetLanguage   LANG_Spanish.

 8. Close the Visual   Basic Editor and save the picture with a unique name.

 9. Add some English   text to the picture, and save the picture.

 10. Export Spanish language   files for the pictures that have text you want displayed in Spanish. For   
steps, refer to the Exporting   Multiple Language Files section.

 11. In Notepad, open   the Spanish language CSV file for the picture that you generated in the   previous 
step, and provide translations for the picture text. For steps,   refer to the Editing a Language   File 
section.

 12. Switch to run mode.

 13. Click the Open Pictures   in Español button. Any picture that you open after clicking this button   will 
display the English picture text in Spanish, if the picture has a   Spanish CSV file. 

NOTE:   To display Spanish text for pictures that were opened before clicking   the button, close and re-
open them. For example, if you close the picture   we created in these steps and then re-open it, the text 
displays in Spanish.

 14. To switch back to   English, close any open pictures except the push button picture with the   lan-
guage settings. 

 15. Click the Open Pictures   in English button and then reopen each picture. The text displays in Eng-
lish.   

NOTES:
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 l Only one   instance of a picture can be open at a time; you must close a picture   before opening it to dis-
play the text in a different language.

 l If a picture   does not have a language file for the language you are displaying in,   the text will remain in 
the default language in which it was created.

 l You can create as many   push buttons as you want to switch between multiple languages.

Example 2: Open a Single Picture in a Desired   Language in Run Mode

The following example shows you how to create a picture with push buttons   that allow you to open 
another picture in run mode and display its text   in the desired language; in this case English and Span-
ish. In this example,   only the picture, MyPicture,   will open when either of the buttons is clicked and you 
can easily switch   between English and Spanish. The OpenPicture command will open multiple   
instances of the same picture, so that you can have more than one language   version of a picture open at 
the same time. 

NOTE:   This example assumes that English is the default language that the pictures   are created in.
IMPORTANT:   If you are using the iFIX WebSpace to open a picture, be aware that other   pictures already 
open do not change languages when you open a picture.   The language changes only when you open the pic-
ture.
TIP:   If you want to re-use this example be sure that you review the important   items listed on the Translating   
Picture Text topic before doing so.

 1. Create a picture   with text and name it MyPicture.grf.

 2. Add two push buttons labeled "Open MyPicture in English" and   "Open MyPicture in Español", as 
in the following picture.

Language Buttons

 3. In configure mode,   right-click the Open MyPicture in English push button and choose Edit   Script. 
The Visual Basic Editor appears.

 4. Enter the following   script to set the TranslateOnOpen, LanguageDesired, and SwitchLanguage:
Dim pic As Object
OpenPicture "MyPicture.grf", , , , , , , , True
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Set pic = Application.ActiveDocument.Page
pic.Translateonopen = False
pic.LanguageDesired = 9
pic.SwitchLanguage

 

 5. Repeat steps 3 and   4, with the Open MyPicture in Español button, but replace the pic.Lan-
guageDesired   = 9 line with pic.LanguageDesired   = 1034 (1034 is the enumeration that represents 
Spanish, where   as 9 represents English). 

NOTE:   For a listing of the enumerations for all supported languages (also called   LCIDs) refer to the 
Language   Letter Acronyms table in the Exporting   and Importing Language Files topic.

 6. Close the Visual   Basic Editor and save the picture with a unique name.

 7. Add some English   text to the picture, and save the picture.

 8. Export a Spanish   language file for MyPicture.grf.

 9. Open the language   file in Notepad and translate the picture text to Spanish. For steps,   refer to the 
Editing a Language   File section.

NOTE:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to edit 
your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   import-
ant that you use the proper text editor, so that the list separator,   a comma, gets saved properly using 
your operating system's native regional   settings. If you are unsure of your settings, use Notepad to edit 
your   .CSV files. 

 10. Make sure the Translate   Picture on Open check box on the Picture Preferences tab of the User 
Preferences   dialog box is cleared.

 11. Switch to run mode   and open the picture with the push buttons.

 12. Click the Open MyPicture   in Español button. MyPicture.grf   opens with the text displayed in Span-
ish.

 13. From the Window menu,   choose Tile Vertical to view both pictures.

 14. Click the Open MyPicture   in English button. The text in MyPicture.grf   displays in English.

NOTES:

 l If a picture   does not have a language file for the language you are displaying in,   the text will remain in 
the default language in which it was created.

 l You can create as many   push buttons as you want to switch between multiple languages. Be sure   that 
you review the important items listed on the Translating   Picture Text topic before doing so, however.

Example 3: Switch the Language of Single Picture   to a Desired Language in Run 
Mode

In the following example, two buttons are created to dynamically switch   the language on the currently 
open picture in run mode regardless of the   TranslateOnOpen and LanguageDesired properties. In this 
example, the SwitchLanguage   method is used to perform this task. 

 1. Create a picture   and name it MyPicture.grf.

 2. Add two push buttons   labeled "Switch to English" and "Switch to Español",   as in the following pic-
ture.
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Language Buttons

 3. In configure mode,   right-click the Switch to English push button and choose Edit Script.   The 
Visual Basic Editor appears.

 4. Enter the following   script to set the language:
Me.SwitchLanguage 9
 

 5. Repeat steps 3 and   4, with the Switch to Español button, but replace the Me.SwitchLanguage   
9 line with Me.SwitchLanguage 1034   (1034 is the enumeration that represents Spanish, 
where as 9 represents   English).  

NOTE:   For a listing of the enumerations for all supported languages (also called   LCIDs) refer to the 
Language   Letter Acronyms table in the Exporting   and Importing Language Files topic.

 6. Close the Visual   Basic Editor and save the picture with a unique name.

 7. Add some English   text to the picture, and save the picture.

 8. Export a Spanish   CSV language file for your picture, so you can provide translations for   the text 
you added in the previous step. For steps, refer to the Exporting   a Single Language File section.

 9. Export an English   CSV language file for your picture, so that English text displays when   you 
switch picture languages. 

NOTE:   For each language that you want to use in your picture, prepare a translation   file. For example, 
if your picture has English, Spanish, and French, you   need to create a translation file for English, Span-
ish, and French. To   create a translation .CSV file, refer to the Exporting   a Single Language File sec-
tion.

 10. Open the Spanish   CSV language file in Notepad and translate the picture text to Spanish.   For 
steps, refer to the Editing   a Language File section.

NOTE:   If the list separator is a comma in your local regional settings, you   can use Microsoft Excel to 
edit your .CSV files. Otherwise, it is recommended   that you use Notepad to edit your .CSV files. It is 
important that you   use the proper text editor, so that the list separator, a comma, gets   saved properly 
using your operating system's native regional settings.   If you are unsure of your settings, use Notepad 
to edit your .CSV files.   
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 11. Make sure the Translate   Picture on Open check box on the Picture Preferences tab of the User 
Preferences   dialog box is cleared.

 12. Switch to run mode   and toggle between the two languages:

 l Click the Switch   to Español button. Your picture displays  text in Spanish.

 l Click the Switch   to English button. Your picture displays  text in English.

NOTES:

 l If a picture   does not have a language file for the language you are displaying in,   the text will remain in 
the default language in which it was created.

 l You can create as many   push buttons as you want to switch between multiple languages. Be sure   that 
you review the important items listed on the Translating   Picture Text topic before doing so, however.

How Do I... 

In the iFIX WorkSpace, you can perform steps when working with   picture text languages:

 l Configuring   the Default Language Settings for All Pictures

 l Configuring   Language Settings for an Individual Picture

 l Exporting   a Single Language File

 l Exporting   Multiple Language Files

 l Editing   a Language File

 l Importing   a Language File in Configuration Mode

 

Configuring the Default Language Settings for All Pictures

If you develop your picture(s) in one language (in configure mode),   but want to provide the text in a dif-
ferent language for operators viewing   pictures (in run mode), you can do this in the WorkSpace. Use the 
steps   below if you want all pictures set to the same default language for run   mode viewing. 

If you use the global language setting, it is recommended that you do   not implement language settings at 
the individual picture-level. 

NOTE: You will   also need to export language CSV files for each picture and provide translations   in each of 
these files using Notepad or Microsoft Excel to support this   feature. A link to these steps is provided below.

IMPORTANT: If   you are using the iFIX WebSpace, it is recommended that you configure   your language set-
tings at the individual picture-level. If you instead   configure them globally using the steps below, all   users will 
have the same language settings for all   pictures, after the script is run. This may be undesirable for your web   
users. For steps on picture-level configuration, refer to the Configuring   Language Settings for an Individual 
Picture section.

 To configure   default language for all pictures when opened in run mode:

 1. Open the iFIX WorkSpace   in configuration mode.

 2. In Classic view,   on the WorkSpace menu, click User Preferences. 

-Or-
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In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences.

 3. Click the Picture   Preferences tab and select the   Translate Picture On Open check box. (If it is 
selected, the LanguageDesired   and TranslateOnOpen properties at the picture-level cannot be 
changed   from the Properties window.)

 4. In the Language drop-down,   select the default you want to set for all pictures. 

 5. Click OK.

 6. Create language CSV   files for your pictures that you want to translate the text for on open.   Refer 
to the Exporting Multiple   Language Files section for steps on how to generate your CSV files.

 
 

Configuring Language Settings for an Individual Picture

If you develop a picture in one language (in configure   mode), but want to provide the text in a different lan-
guage for operators   viewing the picture (in run mode), you can do this in the WorkSpace. Use   the steps 
below if you want a single picture to display a different language   in run mode. 

If you use the individual picture-level settings, it is recommended   that you do not implement the global, 
default language settings. 

NOTE: You will   also need to export a language CSV file for the picture and provide translations   for this file in 
Notepad or Microsoft Excel to support this feature. These   steps are included below.

 To configure   the language for a single picture when opened in run mode:

 1. In the iFIX WorkSpace   configuration mode, open the picture with the text strings you want to   
translate.

 2. In Classic view,   on the WorkSpace menu, click User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences.

 3. Click the Picture   Preferences tab and make sure the Translate Picture On Open check box   is 
cleared. (If it is cleared,   the LanguageDesired and TranslateOnOpen properties at the picture-
level   can be changed from the Properties window.)

 4. Click OK.

 5. Right-click anywhere   in the picture and choose Property Window. 

 6. From the LanguageDesired   property, select the language you want to use for the language CSV 
file.   

NOTE:   If you are entering this information programmatically in VBA instead of   using the Property win-
dow, you can find a listing of the enumerations   for all supported languages (also called LCIDs) in the 
Language   Letter Acronyms table in the Exporting   and Importing Language Files topic.

 7. From the TranslateOnOpen   property, select True so that the displayed picture text will be auto-
matically   translated when the picture is opened in run mode.
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 8. Save the picture.

 9. On the Translation   Toolbar, click the Export language file button. The language CSV file   is saved 
to the PIC folder.

 10. Open the language   CSV file in Notepad or Microsoft Excel and translate the text strings.

IMPORTANT:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to 
edit your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   
important that you use the proper text editor, so that the list separator,   a comma, gets saved properly 
using your operating system's native regional   settings. If you are unsure of your settings, use Notepad 
to edit your   .CSV files. 

 11. Open the picture   in run mode. The picture's text strings are displayed in the translated   language.
 

Exporting a Single Language File

 To export a single   language file:

 1. In the WorkSpace   configuration mode, open the picture you want to export a language file   for.

 2. In Classic view,   on the WorkSpace menu, click User Preferences. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click User 
Preferences.

 3. Click the Picture   Preferences tab and make sure the Translate Picture On Open check box   is 
cleared. If it is selected,   the LanguageDesired and TranslateOnOpen properties in the Properties 
window   cannot be changed. 

 4. Click OK to close   the User Preferences dialog box. 

 5. Right-click in the   picture (in an area without any objects) and choose Property Window. 

 6. From the LanguageDesired   list, select the language that you want to generate a CSV for.

 7. From the TranslateOnOpen   list, select Yes.

 8. Display the Translation   toolbar, if it is not already open. To do so: 

 a. In the tree view   area, open the Project Toolbar Files folder and then the Toolbars folder.   

 b. Double-click   TranslationToolbar to open the toolbar.

 9. On the Translation   toolbar, click the Export language file button. A message appears letting   you 
know the language file was successfully exported. 

You can now open the language file in Notepad   or Microsoft Excel and translate the text strings 
for the picture.

IMPORTANT:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to 
edit your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   
important that you use the proper text editor, so that the list separator,   a comma, gets saved properly 
using your operating system's native regional   settings. If you are unsure of your settings, use Notepad 
to edit your   .CSV files. 
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Exporting Multiple Language Files

 To export multiple   language files:

 1. In the iFIX WorkSpace,   display the Translation toolbar, if it is not already open. To do so:   

 a. In the tree view   area, open the Project Toolbar Files folder and then the Toolbars folder.   

 b. Double-click   TranslationToolbar to open the toolbar.

 2. On the Translation   toolbar, click the Export multiple language files button. 

 3. In the Select pictures   list, select the check box for each picture you want to export a language   file 
for.

 4. If applicable, select   the Always overwrite existing export files check box. If you are exporting   a 
language file for a picture that already has a language file for the   selected language, the existing 
language file will be automatically overwritten.   If you clear this check box, you will be prompted to 
replace the existing   language file. Click Yes to replace it and No to keep it.

 5. From the Select language   list, choose the language that you want to provide translations for.

 6. Click Export. A separate   language file is created for each picture you selected.

You can now open each language file in Notepad   or Microsoft Excel, and translate the text strings 
for the pictures.

IMPORTANT:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to 
edit your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   
important that you use the proper text editor, so that the list separator,   a comma, gets saved properly 
using your operating system's native regional   settings. If you are unsure of your settings, use Notepad 
to edit your   .CSV files. 

 

Editing a Language File

 To edit a language   file:

 1. In Windows Explorer,   locate the CSV file for your picture text translations. It is saved in   the same 
folder as your pictures. By default, this folder is C:\Program Files (x86)\Proficy\iFIX\PIC. 

NOTE:   The file name is appended with the language abbreviation. For example,   a Spanish translation 
file would be appended with _ES, such as MyPicture_ES.csv.

 2. In Notepad or Microsoft   Excel, open the CSV file. 

IMPORTANT:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to 
edit your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   
important that you use the proper text editor, so that the list separator,   a comma, gets saved properly 
using your operating system's native regional   settings. If you are unsure of your settings, use Notepad 
to edit your   .CSV files. 

 3. Provide translations   in the Translated Text segments, and make adjustments to fonts and point   
sizes as necessary.

 4. Save the file.
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Importing a Language File in Configuration Mode

 To import a language   file in configuration mode:

 1. If you have not already   done so, in Notepad or Microsoft Excel, open the picture's language file   
and translate the applicable text strings.

IMPORTANT:   If list separator is comma in your local regional settings, you can use   Microsoft Excel to 
edit your .CSV files.  Otherwise,   it is recommended that you use Notepad to edit your .CSV files. It is   
important that you use the proper text editor, so that the list separator,   a comma, gets saved properly 
using your operating system's native regional   settings. If you are unsure of your settings, use Notepad 
to edit your   .CSV files. 

 2. In the iFIX WorkSpace   configuration mode, open the picture whose language file you translated.

 3. If applicable, set   the LanguageDesired property to the same language letter acronym used   in the 
language file name. 

 4. Display the Translation   toolbar, if it is not already open. To do so: 

 a. In the tree view   area, open the Project Toolbar Files folder and then the Toolbars folder.   

 b. Double-click   TranslationToolbar to open the toolbar.

 5. On the Translation   toolbar, click the Import language file button. The picture text is immediately   
displayed in the translated language from the language file.

NOTE:   Importing language files is useful if you want to save your pictures with   the translated text 
strings.
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Using Tag Groups in Pictures

Tag groups allow you to create one picture to show multiple representations   of your process. For 
example, you can use one picture to represent similar   lines on a plant floor. You use the iFIX Tag Group 
Editor (TagGroupEditor.exe)   to create these tag groups in iFIX.

A tag   group is composed of a symbol, a corresponding substitution, and   an optional description field. 
Symbols   are placeholders for data sources or text in a picture. Substitutions   are alphanumeric character 
strings that replace symbols in a picture.   A tag   group file is a binary file that consists of the symbols, sub-
stitutions,   and descriptions for each tag group.

You use symbols in areas of your picture where data points are needed   to represent specific process val-
ues. A substitution can be a tagname   or text, depending on where the corresponding symbol is being 
used in   a picture. For example, if you want to change a button label when a picture   opens, you would 
enter text for the substitution.

You can create several tag group files that associate symbols with specific   substitutions in the run-time 
environment.

Example: Using Tag Groups in Pictures 
Suppose you work in a factory that produces both oatmeal and chocolate   chip cookies, and each type of 
cookie requires a different baking temperature.   Your factory has three ovens that are controlled by dif-
ferent databases   with a similar block structure: Analog Input and Analog Output.

Your real-time control strategy calls for operators to monitor the temperature   in each furnace. This 
strategy calls for you to develop three operator   displays. You realize, however, that the only difference 
between the displays   are the tagnames that reference different databases.

You can use the Tag Group Editor to cut development time and save a   considerable amount of disk 
space by creating one picture and three tag   group files. In the picture, you assign symbols in place of tag-
names and   then, at run time, call a tag group file to replace the symbols with real   tagnames. You call a 
different tag group depending upon which cookie furnace   you want to display.

Using the Tag Group Editor 

The Tag Group Editor (TagGroupEditor.exe) is a simple spreadsheet interface   that allows you to develop 
multiple tag group files and apply them to   one picture. The tags can reside in different databases.

You enter data into the Tag Group Editor spreadsheet to associate symbols   with substitutions. You then 
save the data in a tag group file, with the   extension TGD. When a picture opens, or when a new picture 
replaces the   current picture, iFIX reads the tag group file and replaces the symbols   with the cor-
responding substitutions, as defined in the tag group file.

NOTE: The Recipe   Builder requires the .TGE file format when using tag group files. As such,   the Recipe 
Builder uses the FIX32 Tag Group Editor (TGE.EXE).  The   iFIX Tag Group Editor (TagGroupEditor.exe) is 
used for creating tag groups   in iFIX pictures in .TGD file format. The Recipe Builder cannot use these   newer 
.TGD files.  

Getting Ready to Use the Tag Group Editor 
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Tag groups are most efficiently implemented when your database design is stable and complete. You 
should perform the following tasks before you begin to develop tag group files:

 l Before you develop your database, adopt a standard naming convention.   

 l For example, for the temperature of Oven1, name the Analog Input block TOV01. For the cor-
responding block in Oven2, name it TOV02.   

 l Develop a list of similar tagnames that exist in the same database, or in different nodes or data-
bases. The list should include the data system, node name, tagname, block type, field name, and 
symbol.   

 l This list helps you create multiple tag group files quickly and accurately.   

Starting the Tag Group Editor 

In Classic view, start the Tag Group Editor from the iFIX WorkSpace   by clicking the Tag Group Editor 
button on the Application toolbar shown   below:

Tag Group Editor Button on the Application Toolbar

In Ribbon view, on the Applications tab, in the Utilities group, click   Tag Group Editor.

The Tag Group Editor Window 

The Tag Group Editor window looks similar to the following:

Tag Group Editor Window
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Creating and Opening Tag Group Files 

Once you start the Tag Group Editor, you are ready to work with tag   group files. You can start by cre-
ating a new tag group file or you can   open an existing one.

To open an existing tag group file, click the Open button. To open a   new, empty tag group file, click the 
New button.

You can have only one tag group file open at a time. If you made changes   to a file that is currently open, 
you will be prompted to save it.

To save a tag group file, click the Save button. Tag group files are   automatically saved with the .TGD 
extension in the iFIX\PIC directory.

NOTE: The tag group   file must be located in the iFIX\PIC directory for tag group substitutions   to work correctly.

Column Definitions for the Tag Group Editor 

The following table describes the columns of the Tag Group Editor spreadsheet   and the information that 
you can enter into them.

NOTE: You can access   these columns only when a row is active. Click a row to make it active.

Column Definition Valid Field Values
Symbol The text that is replaced by a substitution string. (Required field) Can contain up to 60 

characters.   The first character must 
be a letter. 

Substitution The tagname or text of the substitution, depending   
upon where the corresponding symbol is being used 
in the picture.

NOTE: Be sure   to enter the text exactly as you 
want it to appear in the picture. If   the substitution 
needs to be in a specific format, make sure the text   
is formatted correctly.

(Required field) Can contain up to 60 
characters.   

NOTE: It is strongly recommended 
that you   use the fully qualified name 
for the tagname.

Get Full 
Name

When you are using tagnames for substitutions, dis-
plays   the fully qualified name for the tag.

–

Description The text that describes the function of the tag 
group.

(Optional field) Can contain up to 60 
alphanumeric   characters, including 
special characters, such as -(*)&+% 
and spaces.

Column   Definitions for the Tag Group Editor 

Using the Tag Group Editor Toolbar 

Many of the commands found on the menu bar have corresponding toolbar buttons. The following table 
describes the functions of the buttons that are specific to the Tag Group Editor.     
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Clic-
k 
this 
but-
to-
n...

To...

Cut the contents of the cell where the insertion point is positioned, and move it to the 
Clipboard.
Copy the contents of the cell where the insertion point is positioned, and place it on the 
Clipboard.
Paste the contents of the Clipboard into the cell where the insertion point is positioned.

Delete the contents of the cell where the insertion point is positioned.

Add a row to the end of the spreadsheet.

Insert a row above the row containing the insertion point.

Delete the row where the insertion point is positioned.

Retrieve all the symbols from your picture and insert them into the Symbol column of the 
spreadsheet.

NOTE: Use this button only if all the substitutions in the tag group file are tagnames and 
none are text.
Retrieve the fully qualified name for all tags entered in the Substitution column.

Change the font displayed in the Tag Group Editor.

Tag Group Editor Toolbar Buttons    

Using the Tag Group Editor Spreadsheet 

You can enter and edit Symbols, Substitutions, and Descriptions in the   Tag Group Editor spreadsheet.

You can also use some special functions to automate data entry or to   manipulate the data in the spread-
sheet. These functions are described   in the sections that follow.

Retrieving Fully Qualified Names for Substitutions in a Spreadsheet   

A fully qualified tagname consists of four parts:

 l Data system 

 l Node 

 l Tag 

 l Field 

Each element is separated by periods, as shown in the following example:

Fix32.THISNODE.AI1.F_CV
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In this example, Fix32 is the name of the data system, THISNODE is the   node name, AI1 is the tag-
name, and F_CV is the field name.

From the Tag Group Editor, you can automatically:

 l Insert a fully qualified   name for an individual tagname. 

 l Retrieve the fully   qualified names for all substitutions in a spreadsheet. (All of substitutions   in the 
spreadsheet must be tagnames; none of them can be text.) 

NOTE: It is strongly   recommended that you use the fully qualified names of tags for substitutions   in a spread-
sheet.
Using the Data Entry Dialog Box to Define Substitutions

Double-clicking the item number in the Tag Group Editor spreadsheet   displays the Data Entry dialog 
box, from which you can:

 l Access the Data Source   Browser expression builder to define the substitution. 

 l Create the data source   for a substitution tagname. 

 l Retrieve the fully   qualified name for a substitution tagname. 
Sorting Data in the Spreadsheet

You can sort the data in any column in the Tag Group Editor spreadsheet.
Searching and Replacing Substitutions

You can make multiple changes to tagname substitutions. This involves:

 l Converting the file   to comma separated value (CSV) format 

 l Making the changes   in a third-party spreadsheet or text editor 

 l Re-opening and re-saving   the file in the Tag Group Editor. 

IMPORTANT: GE   ships two Tag Group Editors: one is for use with pictures and the other   is for use with 
recipes. The Tag Group Editor discussed in this manual   is intended for use with pictures. To use the Tag 
Group Editor with recipes,   double-click the icon for the TGE.EXE program, located in your iFIX root   directory. 
Retrieving Symbols from a Picture 

You may have so many symbols in a picture that entering all of them   into the spreadsheet would be very 
time-consuming. To automatically retrieve   all the symbols from a picture and insert them into the spread-
sheet, you   can use the Get Symbols From Picture button on the Tag Group Editor toolbar.   The Symbols 
column is cleared and all of the symbols from the picture,   including symbols that are used in a picture's 
script, are automatically   inserted into the spreadsheet. You can then alphabetically sort the symbols   by 
clicking the Symbol column heading.

NOTE: If you add new   symbol substitutions on text, pushbutton, or variable objects to a picture,   these symbols 
will NOT be read into the Tag Group Editor until the picture   is resaved. New symbols on the objects in ques-
tion will only be read into   the Tag Group Editor when the picture is saved.

Using Tag Group Symbols in Pictures 

You can enter tag group symbols in a picture for the following object properties:

 l Command button caption   

 l Variable object current value   
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 l Text object caption   

 l Animation data source   

 l Chart pen data source (historical and real-time)   

 l Enhanced chart data source (historical and real-time)   

 l Event data source   

 l Data link data source   

 l Historical data link data source   

You can also use tag group symbols with the following picture methods in a script:

 l TagGroupValue   

 l TagGroupSubstitution   

Implementing a Tag Group Strategy 

There are three major tasks that you must perform to successfully implement   your tag group strategy:

 1. Create a picture   that uses symbols in areas where data points are needed to represent a   specific 
process value. For more information, refer to Creating   and Opening Pictures. 

 2. Create several different   tag group files that associate the symbols in the picture with different   
tags. 

 3. Assign the tag group   file to load when a picture opens, or when a new picture replaces an existing   
one. For more information, refer to Assigning   a Tag Group File to a Picture Event. 

 

Entering a Symbol in a Picture 

When you enter a symbol in a picture, you must type an at sign (@) at the beginning and end of the sym-
bol name. This allows the iFIX software to differentiate tag group symbols from ordinary text.

NOTE: When defining symbols in the Symbol column of the Tag Group Editor, you only need to enter the sym-
bol name, not the @ signs.

Example

You want to enter a data link in a picture that displays the value of a temperature output block. You will 
use this picture three times to show three similar processes. To use a symbol called Temperature in the 
picture, enter the following for the data link:

@Temperature@

When the iFIX software reads text in this format, it identifies the text as a tag group symbol. When a pic-
ture opens, or a new picture replaces the current one, the symbol is replaced with the assigned sub-
stitution.

In the Symbol column of the Tag Group Editor you would enter:
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Temperature

For more information, see Syntax Guidelines for Symbols in Pictures.

Using Partial Substitutions 

You may only want to substitute a specific section of a tag or a string   of text. This is known as a partial 
substitution. The Tag Group Editor   can perform partial substitutions. However, there are some rules you 
must   follow:

 l Make sure there is   an @ sign at the beginning and end of the symbol to denote where the symbol   
name begins and ends. 

 l Keep track of your   @ signs if you are using a symbol in a tagname. 

For example, if you want @Tag1@ to be the symbol in a partial text substitution,   you must enter:

@Tag1@Ready

For more information, see Syntax   Guidelines for Symbols in Pictures.

Partial Substitution Errors in Data Sources 

Be careful when using a partial substitution in a data source. If the   source of a substitution does not cur-
rently exist in the data system,   a connection will be forced. However, you will only know that this has   
occurred when you receive an error message at run time. This can happen   if you made a typographical 
error when you entered a substitution or if   you entered duplicate data.

For example, you enter a partial substitution as the source for a data   link, as follows:

Fix32.@tag1@

However, in the tag group file, you entered the following substitution   for @tag1@:

Fix32.THISNODE.AI1.F_CV

When this substitution occurs, the data source is now Fix32.Fix32.THISNODE.AI1.F_CV.   Since the 
data system thinks that this source can be created, it will   force the connection.

For more information about using symbols for partial substitutions,   see Syntax   Guidelines for Symbols 
in Pictures.

Syntax Guidelines for Symbols in Pictures 

To perform a partial substitution for a tag, follow the syntax guidelines below:     

Enter... Do not enter... Because...
Node.@tag1@.f_cv Node@tag1@f_cv You must separate elements with 

periods. In this example, there must 
be a period between the node and 
the tag, and the tag and the field.

@tag1@.@field@ @tag1@.@field You must start and end every sym-

Symbols in Pictures – Dos and Don'ts    
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bol with an at sign (@). In this 
example, a substitution will not 
occur for field because the symbol 
must end with an at sign (@).

Node.@tag1@.@field@ Node.@tag1@field@ You must separate elements with 
periods. Also, you cannot share at 
signs (@). Text beginning and end-
ing with an at sign (@) denotes a 
symbol to be replaced. In this 
example, a substitution will occur for 
tag1 but not for field.

Node.@unit@@device@.f_
cv 

Node.@unit@device@.f_
cv

You cannot share at signs (@). In 
this example, a substitution will 
occur for unit but not for device.

@tag1@ + @tag2@ @tag1@+@tag2@ You must enter a space before and 
after the mathematical operator (the 
plus sign (+) in this example).

( @tag1@ + @tag2@ ) / 2 (@tag1@ - @tag2@) / 2 You must enter a space before and 
after the tag group when using par-
enthesis. 

Using Symbols for the Current Value of a Variable Object 

When using symbols to represent a data source for the current value of a variable object, you must also 
assign the symbol to the initial value of the variable object. The initial value is written to the current value 
when a picture opens, which means the symbol will be overwritten by the content of the initial value. If 
you assign a symbol to the current value only, you will lose your tag group substitution.

Using Symbols for Complex Expressions 

You cannot substitute a complex expression for a single symbol. For example, you cannot substitute the 
following expression:

Fix32.THISNODE.AI1.F_CV + 10

for the following symbol:

@tag1@

However, you can use partial substitutions to represent each part of the expression. For example, if you 
want to use symbols for the complex expression above, you would use two symbols, as follows:

@tag1@ + @tag2@

where the substitution for @tag1@ would be Fix32.THISNODE.AI1.F_CV, and the substitution for 
@tag2@ would be 10.

Assigning a Tag Group File to a Picture Event 
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Before substitutions can occur in the run-time environment, you must   assign the tag group file to load 
when a picture opens.

You can also assign the tag group file to load when a new picture replaces   an existing one.

Optimizing Picture Loading in the Run-time Environment 

The Tag Group Editor provides a way to get the best possible picture   loading performance in the run-time 
environment. After you have completed   the design process, you can optimize the load performance by 
choosing   the Resolve Tags command from the File menu. When this action occurs,   the picture looks for 
the tag group substitutions, replaces the symbols   with the substitutions, and establishes connections 
between the objects   in the picture and the true data sources. 

The Tag Group Editor saves these connections, along with information   identifying the version number of 
the picture and the tag group file,   and the identifying strings after substitution, in the tag group storage   
file (.TGS). There is only one tag group storage file per node.

Error Log Creation 

The Tag Group Editor creates a text file, TGEERROR.LOG, in the C:\Program Files (x86)\Profi-
cy\iFIX\LOCAL path, which contains a list of errors that occur during the resolution process. Make sure 
that you open this file and verify any errors. If there are no errors, the log will be empty.

OPC Server Address Substitution

The steps below describe how to use an OPC address substitution with   Symbols in the Tag Group 
Editor.

 To use an OPC   address substitution with Symbols in the Tag Group Editor: 

 1. In the iFIX Tag Group   Editor's Substitution field, paste the OPC address name. 

 2. Remove the quotes   from the address name. 

 3. On the Tag Group   Editor's File menu, click Resolve Tags. 

 

Importing and Exporting Tag Group Files 

The Tag Group Editor can import and export tag group information that   is formatted as a comma sep-
arated value (.CSV) file. Comma separated value   files are useful if you want to exchange tag group 
information with a   third-party text editor, spreadsheet, or word processor.

Comma separated value files have several benefits:

 l You can enter tag   group information into an application, such as Microsoft Excel or a text   editor, 
that you are more familiar with and then import this information   into the Tag Group Editor. 
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 l You can generate   a report by printing the comma separated value (.CSV) file as a text file.   The 
report provides a list of all symbols, substitutions, and descriptions   defined in the Tag Group 
Editor spreadsheet. This list can help you verify   your tag groups before   you implement them into 
your SCADA strategy. 

Understanding the CSV File Format 

If you use Microsoft Excel or another spreadsheet application that provides a CSV file format option, the 
application does all the required formatting for you. However, if you prefer to use a text editor, you must 
follow some simple formatting rules to ensure that the text file is successfully imported into the Tag 
Group Editor.

CSV File Formatting Rules

Each line in your text file represents one row when opened in the Tag Group Editor. Use the following 
rules when formatting your text file:

 l Enter the information in the same order as it appears in the Tag Group Editor spreadsheet: sym-
bol, substitution, description.   

 l The symbols, substitutions, and descriptions that you enter into your text file have the same 
length limitations as the corresponding component in the Tag Group Editor spreadsheet.   

 l Use a list separator to separate each component of the tag group. You must use the list separator 
that is defined through Regional Settings, Number tab, in Control Panel. In most cases, this is a 
comma (,).   

 l Do not include comments or blank lines in your CSV file. If you do, a message appears at the 
point that the Tag Group Editor first encounters either a comment or a blank line, and the file will 
stop loading.   

 l The first line of your CSV file must contain only the total number of lines, or tag group entries, in 
the tag group file. For example, if your CSV file contains six tag groups, the first line of the file 
should be the following:   
"6"

If your CSV file does not contain this line, it will not open in the Tag Group Editor.

 l If the name of a symbol, substitution, or description contains a quotation mark (") or the same list 
separator defined through Regional Settings in Control Panel, you must do the following:   

 l Enclose that item in quotation marks.     

 l Type an extra quotation mark before each quotation mark within that item.     

For example, if you are entering a symbol named OVEN"TEMP1 into your text editor, you must 
type "OVEN""TEMP1" as your symbol name.

Example: A Sample CSV File 

Each line in a CSV file represents a row in the Tag Group Editor spreadsheet, except the first line. The 
first line of a CSV file represents the total number of tag groups contained in the tag group file. The fol-
lowing example depicts a CSV file created by the Tag Group Editor.

"3"
"OVENTEMP1", "Fix32.THISNODE.AI1.F_CV", "Oven 1 current temperature"
"OVENTEMP2", "Fix32.THISNODE.AI2.F_CV", "Oven 2 current temperature"
"OVENTEMP3", "Fix32.THISNODE.AI3.F_CV", "Oven 3 current temperature"
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As this example shows, tag group components are separated by a list separator and enclosed in quo-
tation marks. The Tag Group Editor does this as a safeguard even though the only items that require quo-
tation marks are list separators used within an item, and other quotation marks. In fact, you can delete 
the quotation marks around any component that does not contain a defined list separator or quotation 
mark.

Exporting a Tag Group File as a CSV File

You can export a tag group file to a file in comma separated value (CSV)   format. Then you can view the 
information in a text editor or in Microsoft   Excel or another spreadsheet application that provides a CSV 
file format   option.

Converting 6.x Tag Group Files 

You must convert all tag group files created in the 6.x Tag Group Editor   to the current tag group file 
(.TGD) format. You do this by opening the   file in the 6.x Tag Group Editor, and saving it as a CSV file. 
You then   convert the CSV file to a TGD file by choosing the Convert CSV Files to   TGD Files command 
in the File menu.

Tag Group Editor Dialog Boxes

The iFIX Tag Group Editor includes the following dialog boxes (listed   in alphabetical order):

 l Convert   6.x CSV Files Dialog Box

 l Data   Entry Dialog Box

 l Tag   Group Editor Main Window

 

Convert 6.x CSV Files Dialog Box

The Convert 6.x CSV Files dialog box displays the following items:

6.x .CSV File Directory

Enter the path to the directory containing your 6.x CSV files. The path   must end with a backslash (\).

CSV File List

Select the files you want to convert. You can select more than one file   by pressing and holding down the 
<CTRL> key.

Update .CSV File List

Click this button to update the contents of the CSV File List. You must   click this button after you enter a 
file path in the 6.x .CSV File Directory   box.

Select All

Click this button to select all of the files in the CSV File List.
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Deselect All

Click this button to deselect all of the currently selected files in   the CSV File List.

Data Entry Dialog Box

The Data Entry dialog box displays the following items:

Symbol

Enter a symbol that is defined in your picture. Do not enter the starting   and ending delimiters (@). For 
example, if you enter @tag1@   as a symbol in a picture, you only have to enter tag1   in the spreadsheet.

Valid values – Can contain up   to 60 alphanumeric characters. The first character must be a letter. This   
field is mandatory.

Substitution

Enter a substitution for the defined symbol. You can enter a tagname   or text, depending upon where the 
corresponding symbol is being used in   a picture. Click Browse to open the Expression Builder. Click 
Modify Database   Block to modify a database block directly without opening the Database   Manager. 

Valid values – Can contain up   to 1024 alphanumeric characters. The first character must be a letter.   
This field is mandatory.

Browse 

Click Browse to open the Expression Builder. 

Modify Database Block 

Click Modify Database Block to modify a database block directly without   opening the Database Man-
ager. 

Get Full Name 

Click Get Full Name to get the fully qualified name for a tag. For example,   if you enter AI1 in the Sub-
stitution   field and have an AI1 database block defined in your database, the Default Data 
System.Node.AI1.Field   is automatically entered when you click the Get Full Name button. Use   this but-
ton when you want to perform a full tag substitution.

Description

Enter text that describes the function of the tag group.

Valid values – Can contain up   to 256 alphanumeric characters, including special characters, such as   –
(*)&+% and spaces. This field is optional.

Tag Group Editor Main Window

The Tag Group Editor main window displays the following items:
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Symbol

Enter a symbol that is defined in your picture. Do not enter the starting   and ending delimiters (@). For 
example, if you enter @tag1@   as a symbol in a picture, you only have to enter tag1   in the spreadsheet.

Valid values – Can contain up   to 60 alphanumeric characters. The first character must be a letter. This   
field is mandatory.

Substitution

Enter a substitution for the defined symbol. You can enter a tagname   or text, depending upon where the 
corresponding symbol is being used in   a picture. Click Browse to open the Expression Builder. Click 
Modify Database   Block to modify a database block directly without opening the Database   Manager.

IMPORTANT:
 l It   is recommended that you use the fully qualified tagnames or explicitly   use the F_CV field in the sub-

stituted text. 
 l If   the object of your substitution is an element in an OPC server address   that includes double quotes 

surrounding its data items, you should not   include the double quotes in the tag group substitution 
string. Substitution   strings enclosed in double quotes may cause issues with partial data source   sub-
stitutions. 

Valid values – Can contain up   to 255 alphanumeric characters. The first character must be a letter.   This 
field is mandatory. 

Get Full Name 

Click Get Full Name to get the fully qualified name for a tag. For example,   if you enter AI1 in the Sub-
stitution   field and have an AI1 database block defined in your database, the Default Data 
System.Node.AI1.Field   is automatically entered when you click Get Full Name. Use this button   when 
you want to perform a full tag substitution.

Description

Enter text that describes the function of the tag group.

Valid values – Can contain up   to 60 alphanumeric characters, including special characters, such as –
(*)&+%   and spaces. This field is optional.

How Do I...

Click any of the following links for more information about the Tag   Group Editor:

 l Performing   Basic Functions

 l Entering   Data into the Spreadsheet

 l Editing   a Tag Group File

 l Resolving   Tags With a Picture

 l Assigning   a Tag Group File to a Picture Event

 l Importing   and Exporting Tag Group Files

 

Performing Basic Functions
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Click any of the following links for more information about performing   basic functions in the Tag Group 
Editor:

 l Creating   a New Tag Group File

 l Opening   an Existing Tag Group File

 l Changing   the Font

 l Saving   a Tag Group File

 l Closing   a Tag Group File

 l Exiting   the Tag Group Editor

 

Creating a New Tag Group File

 To create a new   tag group file:

 1. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 2. Click the New toolbar   button. 

 3. Enter the symbol,   substitution, and description data for all of the tag groups that you   want to 
define.

 4. When you are done,   click the Save toolbar button. The Save As dialog box appears. By default,   it 
is set to the C:\Program Files (x86)\Proficy\iFIX\PIC path.

 5. Enter a file name,   and click Save. The file is saved with a .TGD extension.

TIPS:

 l You can have only one tag   group file open at a time. If you made changes to a file that is currently   
open, you will be prompted to save it. The iFIX Tag Group Editor replaces   the currently open file with a 
new, empty tag group file.

 l The tag group file must   be located in the C:\Program Files (x86)\Proficy\iFIX\PIC directory   for tag group 
substitutions to work correctly.

 l You can use an existing   tag group file as a template from which to create a new tag group file.   When 
you are ready to save your changes, make sure that you save this   file with a different file name.

Opening an Existing Tag Group File

 To open an existing   tag group file:

 1. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 2. Click the Open toolbar   button. The Open dialog box appears. By default, it is set to the C:\Pro-
gram Files (x86)\Proficy\iFIX\PIC path.

 3. Select the tag group   file that you want to open, and click Open.
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TIPS:

 l You can have only one tag   group file open at a time. If you made changes to a file that is currently   
open, you will be prompted to save it. The iFIX Tag Group Editor replaces   the currently open file with 
the file that you selected.

 l The tag group file must   be located in the C:\Program Files (x86)\Proficy\iFIX\PIC directory   for tag group 
substitutions to work correctly.

Changing the Font

 To change the   font:

 1. In the iFIX Tag Group   Editor, click the Set Font toolbar button.

 2. Select the font,   font style, and size that you want to be displayed in the Tag Group Editor,   and 
click OK.

 

Saving a Tag Group File

 To save a tag   group file:

 1. In the iFIX Tag Group   Editor, click the Save toolbar button. If you haven't previously saved   the 
file, the Save As dialog box appears. By default, it is set to the   C:\Program Files (x86)\Profi-
cy\iFIX\PIC path.

 2. Enter a file name,   and click Save. The file will be saved with a .TGD extension.

TIPS:

 l If information is missing   from the spreadsheet, a message will appear:

 l If you left a symbol cell   blank, you must fill in the missing information before you can save the   tag 
group file. When you have finished, click the Save toolbar button   again.

 l If you left a substitution   cell blank, choose Yes to save the file. Choose No to fill in the missing   sub-
stitution before you save.

 l The tag group file must   be located in the C:\Program Files (x86)\Proficy\iFIX\PIC directory   for tag group 
substitutions to work correctly.

 

Closing a Tag Group File

Once the iFIX Tag Group Editor opens a tag group file, it cannot open   another until the active file is 
closed. 

 To close a tag   group file:

 1. In the iFIX Tag Group   Editor, click the Open toolbar button. The iFIX Tag Group Editor closes   the 
active file and opens the file that you selected.

 2. If you made changes   to the active file, you will be prompted to save it.
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Exiting the iFIX Tag Group Editor

 To exit the iFIX   Tag Group Editor:

 1. In the iFIX Tag Group   Editor, click Exit on the File menu.

 2. If you made changes   to a file that is currently open, you will be prompted to save it before   the iFIX 
Tag Group Editor closes.

 

Entering Data into the Spreadsheet

Click any of the following links for more information about entering   data into the spreadsheet:

 l Entering   Symbols Directly into the Spreadsheet

 l Entering   Substitutions Directly into the Spreadsheet

 l Entering   Descriptions Directly into the Spreadsheet

 l Entering   Data If You Don't Know the Substitution Name

 

Entering Symbols Directly Into the Spreadsheet

 To enter symbols   directly into the spreadsheet:

 1. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 2. Create a new tag   group file.

 3. Make sure the picture   for which you are creating a tag group file is open in the iFIX   WorkSpace. 

 4. Click the Get Symbols   From Picture button on the toolbar. The Symbols column is filled in with   
the symbols defined in the picture.

TIP:   You can also enter a symbol directly into the symbol cell.

 

Entering Substitutions Directly Into the Spreadsheet

 To enter substitutions   directly into the spreadsheet:

 1. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 
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 2. In the iFIX Tag Group   Editor, enter either a tagname or text directly into a substitution cell.

 3. If you are substituting   a tagname for a symbol, click the Get Full Name button. The fully qualified   
name for that tag is inserted into the substitution cell. 

For example, if you enter AI1 in a substitution   cell and click the Get Full Name button next to it, 
FIX32.THISNODE.AI1.F_CV   automatically appears in the substitution cell. If the data source 
does   not exist, a message will appear asking if you want to create it.

TIP:   If you want to retrieve all of the fully qualified names at once, enter   all of the tagnames into the 
spreadsheet, and click the Get Full Name   column heading. The fully qualified names for all of the tag-
names are   automatically inserted into the Substitution column.

Entering Descriptions Directly Into the Spreadsheet

 To enter descriptions   directly into the spreadsheet:

 1. In Classic View,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 2. In the main window,   enter the description directly into the description cell.

Entering Data If You Don't Know the Substitution Name

 To enter data   if you don't know the substitution name:

 1. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 2. Double-click a row   number. The Data Entry dialog box appears.

 3. In the Symbol box,   enter the text you want to use for the symbol.

 4. From the Substitution   list, select a tagname, or do one of the following:

 l Click Browse   to open the Expression Builder dialog box.

 l Click Modify   Database Block to create the data source. You must enter a tagname before   
you can use this button.

 l Click Get Full   Name to retrieve the fully qualified name. You must enter a tagname before   
you can use this button.

 5. In the Description   box, enter text that describes the function of the tag group substitution,   and 
click OK.

 

Editing a Tag Group File

Click any of the following links for more information about editing   a tag group file:
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 l Editing   a Cell

 l Deleting   the Contents of a Cell

 l Inserting   a Row

 l Deleting   a Row

 l Sorting   Data Alphabetically in a Column

 l Searching   and Replacing Substitutions

 l Using   OPC Server Address Substitution in the Tag Group Editor

 

Editing a Cell

 To edit a cell:

 1. In the iFIX Tag Group   Editor, select the cell. The text in the cell is highlighted.

 2. Enter text over the   highlighted text.

 

Deleting the Contents of a Cell

 To delete the   contents of a cell:

 1. In the iFIX Tag Group   Editor, select the cell that contains the data you want to delete.

 2. Click the Delete   Cell Contents toolbar button. The content of the cell is deleted.

 

Inserting a Row

 To insert a row:

 1. In the iFIX Tag Group   Editor, select a cell.

 2. Click the Insert   Row toolbar button. An empty row is inserted above the row that contains   the 
insertion point.

 

Adding a Row

 To add a row: 

In the iFIX Tag Group Editor, click the   Add Row toolbar button. An empty row is added to the end 
of the spreadsheet.

 

Deleting a Row
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 To delete a row:

 1. In the iFIX Tag Group   Editor, select a cell in the row you want to delete.

 2. Click the Delete   Row toolbar button. The row that contains the insertion point is deleted.

 

Sorting Data Alphabetically in a Column

 To sort data   alphabetically in a column:

 1. In the iFIX Tag Group   Editor, click the heading of the column that you want to sort. 

 2. The column is sorted   in ascending order. If you click the column heading again, the column   will be 
sorted in descending order.

 

Searching and Replacing Substitutions

 To search and   replace substitutions:

 1. In the iFIX Tag Group   Editor, export your tag group file as a CSV file.

 2. Open the CSV file   in a third-party spreadsheet or text editor.

 3. Use the text editor's   find and replace functionality (usually found on the Edit menu) to make   mul-
tiple changes to tagname substitutions.

 4. When you have finished   making changes, save the file as a CSV file, and exit the text editor.

 5. Open the CSV file   in the Tag Group Editor.

 6. On the File menu,   click Save As to re-save the CSV file as a tag group (.TGD) file.

 

Using OPC Server Address Substitution in the Tag Group Editor

iFIX requires the following workaround to use the OPC Server address   substitution with the Tag Group 
Editor (TagGroupEditor.exe). The steps   below describe how to use an OPC address substitution with 
Symbols in   the Tag Group Editor.

 To use an OPC   address substitution with Symbols in the Tag Group Editor: 

 1. In the iFIX Tag Group   Editor's Substitution field, paste the OPC address name. 

 2. Remove the quotes   from the address name. 

 3. On the File menu,   click Resolve Tags. 

 

Resolving Tags With a Picture
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 To resolve tags   with a picture:

 1. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 2. On the File menu,   click Resolve Tags. 

 3. Enter a picture file   name, and click Open. 

 4. Enter a tag group   file name, and click Open. The operation is performed.

TIP:   You can select more than one file by pressing and holding the <CTRL>   key while you select files 
from the list.

Assigning a Tag Group File to a Picture Event

Click any of the following links for more information about assigning   a tag group file to a picture event:

 l Assigning   a Tag Group Substitution to Occur When a Picture Opens

 l Assigning   a Tag Group Substitution to Occur When a Picture Replaces Another Picture

 

Assigning a Tag Group Substitution to Occur When a Picture Opens

 To assign a tag   group substitution to occur when a picture opens:

 1. In the iFIX WorkSpace,   open the picture from which you want to open another picture.

 2. Select a button or   shape from which you want to open the picture.

 3. In Classic view,   from the iFIX WorkSpace Toolbox, click the Open Picture Expert button.   

-Or-

In Ribbon view, on the Tools tab, in the   Tasks/Experts group, click Commands, and then click 
Open Picture. 

 4. Enter the file name,   or alias, of the picture that you want to open.

 5. Enter the position   for the picture to open in. The default position is 0,0.

 6. Select the Enable   Tag Group Substitution check box.

 7. Enter the name of   the tag group file that you want to apply to the picture upon opening,   and click 
OK.

 8. Save the changes   you made to the picture, and switch to the runtime environment.

When you click the object, the picture that   you selected to open displays, and the symbols in the 
picture are replaced   with the substitutions that you defined in the tag group file.

TIPS:

 l If you want to choose the   picture to open at runtime, select the Select Picture to Open in Run Mode   
check box. When you switch to the runtime environment and click the object,   the Open dialog box 
appears.
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 l If you want to choose the   tag group file to load at runtime, select the Tag Group File in Run Mode   
check box. When you switch to the runtime environment and click the object,   the picture to which you 
want to assign a tag group file appears, and   then the Please Select a Tag Group Definition (TGD) File 
dialog box appears.

 l You can open the iFIX Tag   Group Editor from the Open Picture Expert dialog box by clicking the Tag   
Group Editor button.

 

Assigning a Tag Group Substitution to Occur When a Picture Replaces   Another Picture

 To assign a tag   group substitution to occur when a picture replaces another picture:

 1. In the iFIX WorkSpace,   open the picture that you want to replace.

 2. Select a button or   shape from which you want to replace the picture.

 3. In Classic view,   from the iFIX WorkSpace Toolbox, click the Replace Picture Expert button.   

-Or-

In Ribbon view, on the Tools tab, in the   Tasks/Experts group, click Commands, and then click 
Replace Picture. 

 4. Enter the file name,   or alias, of the picture that you want to replace.

 5. Enter the file name   of the picture that you want to make the replacement with.

 6. Select the Enable   Tag Group Substitution check box.

 7. Enter the name of   the tag group file that you want to apply to the replacement picture upon   open-
ing, and click OK.

 8. Save the changes   you made to the picture, and switch to the runtime environment.

When you click the object, the picture that   you selected gets replaced by the replacement pic-
ture, and the symbols   in the replacement picture are replaced with the substitutions that you   
defined in the tag group file.

TIPS:

 l If you want to replace   the current picture at runtime, select the Replace Current Picture in   Run Mode 
check box. When you switch to the runtime environment and click   the object, the current picture closes 
and the replacement picture appears.

 l You can open the iFIX Tag   Group Editor from the Open Picture Expert dialog box by clicking the Tag   
Group Editor button.

 

Importing and Exporting Tag Group Files

Click any of the following links for more information about importing   and exporting tag group files:

 l Converting   One or More 6.x Tag Group Files

 l Exporting   a Tag Group File as a CSV File
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Converting One or More 6.x Tag Group Files

The iFIX Tag Group Editor lets you convert multiple tag group files   created in version 6.x of FIX.

 To convert multiple   tag group files:

 1. Start iFIX and open   the iFIX WorkSpace.

 2. In the 6.x Tag Group   Editor, make sure you have saved the tag group files as CSV files. 

 3. In Classic view,   in the iFIX WorkSpace, on the toolbar, click the Tag Group Editor button.   

-Or-

In Ribbon view, on the Application tab,   in the Utilities group, click Tag Group Editor. 

 4. On the File menu,   click Convert CSV Files to TGD Files. The Convert 6.x CSV Files dialog   box 
appears. By default, it is set to the C:\Program Files (x86)\Proficy\iFIX\PIC path.

 5. In the 6.x .CSV File   Directory box, enter the path to the directory where your 6.x CSV files   are loc-
ated, and click the Update .CSV File List button. The path must   end with a backslash (\), similar 
to the following:
C:\Program Files (x86)\Proficy\iFIX\PIC\

 6. Select the files   you want to convert, and click OK. The files will be saved with a .TGD   extension.

 

Exporting a Tag Group File as a CSV File

 To export a tag   group file as a CSV file:

 1. In the iFIX Tag Group   Editor, on the File menu, click Save As. The Save As dialog box appears.   
By default, it is set to the C:\Program Files (x86)\Proficy\iFIX\PIC   path.

 2. From the Save as   type list, select CSV Files (*.CSV).

 3. Enter a file name,   and click Save. The file will be saved with a .CSV extension.

TIP:   The tag group file must be located in the C:\Program Files (x86)\Proficy\iFIX\PIC directory for tag 
group substitutions to work correctly.
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Working with Dynamo Objects

A Dynamo object is an object   or group of objects that you store in a Dynamo Set and can use in all   of 
your pictures, helping to create a consistent design across your operator   displays. All Dynamo objects 
can be manipulated like any iFIX object.   The Dynamo object is closest to the group object in behavior. 
For instance,   you can drill-down into Dynamo objects within pictures to change individual   objects. 

You can create Dynamo objects out of both simple custom objects and   objects with animations. In 
objects with animations, you can assign meaningful   user prompts to Dynamo properties. These user 
prompts appear in the Dynamo   Properties dialog box that opens when you double-click the Dynamo or 
when   you first copy the Dynamo into a new picture. 

Each Dynamo object includes five additional object properties:

 l Dynamo   ID –   You cannot edit this field; it is a system assigned value. This value   is a Globally 
Unique Identifier (GUID). The identifier is the same for   a Master Dynamo in a Dynamo Set and all 
instances of the Dynamo object   throughout all pictures. Use this identifier to identify instances of   
a Dynamo object with the Master Dynamo in a Dynamo Set. 

 l Dynamo   Description –   Provides a short description of the specific usage of the given Dynamo   
Instance. The number of characters that you can enter in this description   are recorded in the 
Max_Dynamo_Desc_Length field. The Dynamo Description   can be different for each Dynamo 
Instance. For the Master Dynamo, the   description is empty and read-only.

 l Master   –   You cannot edit this field; it is a system assigned value. When True,   the selected 
Dynamo is a Master Dynamo (within a Dynamo Set). When False,   this Dynamo is a Dynamo 
Instance (within a picture).

 l Max_Dynamo_Desc_Length – You cannot   edit this field; it is a system assigned value that is 
currently set to   256 characters. This field describes the maximum number of characters that   you 
can enter into the Dynamo Description property, which is currently   set at 256 characters.

 l Revision   – You   cannot edit this field; it is a system assigned number for the revision.   When you 
save a Master Dynamo inside of a Dynamo Set, and the Master Dynamo   contains changes, the 
revision number is incremented. It's only when the   Master Dynamo changes and then you save 
the Dynamo Set that this number   increments on the Master Dynamo. iFIX uses Dynamo revision 
numbers during   an update to determine when a Master Dynamo is newer than the Dynamo 
Instances   created from it. Revision numbers are not updated when a Dynamo Instance   within a 
picture is modified. During an update, when a Dynamo Instance   does not equal the Master 
Dynamo revision number (that is, the revision   number of the Dynamo Instance is lower than the 
Master Dynamo), the revision   number on the Dynamo Instance is updated to match the Master 
Dynamo. 

When you create a Dynamo and save it in a Dynamo Set, you create a Master   Dynamo. You can use 
this Master Dynamo in your system pictures by dragging   the Dynamo object from the Dynamo Set into a 
picture. If you assigned   User Prompts to the Dynamo's Object Properties, the Dynamo's Property   dialog 
box appears. This dialog box allows you to change the data sources   for the Dynamo's properties.

You can create a report of Dynamo objects in your pictures, or pictures   that contain specific Dynamos, 
by using the Cross Reference Tool. A Quick   Report is generated when you run the Quick Dynamo 
Updater or the Dynamo   Updater Wizard, both of which are available from the Dynamo Toolbar (Classic   
View) or on the Tools tab, in the Dynamos group, in the Dynamos list (Ribbon   View).

Master Dynamos and Dynamo Instances
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A Master Dynamo is any Dynamo   object that exists in a Dynamo Set. This term applies only to Dynamo 
objects.   It does not include pre-built Dynamos or Dynamos created in versions of   iFIX earlier than 4.5. A 
Master Dynamo includes an identifier so that   you can identify which Dynamo objects in a picture are 
instances of that   particular Master Dynamo. The Dynamo ID is the same in the Dynamo Instances   that 
are derived from the master. Master Dynamo's exist only within Dynamo   Sets. Once placed into an iFIX 
picture, a Master Dynamo becomes a Dynamo   Instance.

A Dynamo Instance is a Master   Dynamo that has been placed into a picture. A Dynamo Instance can be 
uniquely   identified with one and only one Master Dynamo. Dynamo Instances exist   only within iFIX pic-
tures. When placed into a Dynamo Set, a Dynamo Instance   becomes a Master Dynamo, possibly repla-
cing a pre-existing Master Dynamo   or simply becoming a new Master Dynamo based upon the option 
selected   by the user. Each Dynamo Instance can have its own Dynamo description,   describing how the 
Instance is used in the picture.

When a group containing Dynamo Instances is promoted to a Master Dynamo,   as in the case when it is 
dragged into a Dynamo Set, the contained Dynamo   Instances are converted to standard group objects. 
You are warned about   this occurrence during Master Dynamo creation and the user is allowed   the option 
of cancelling the operation.  

If a Dynamo Instance has been resized since the last Master Dynamo update,   that size is maintained on 
the next update. The overall height and width   of the entire Dynamo Instance remains the same. The rel-
ative size of internal   objects is adjusted accordingly. Be aware that not all dimensions resize,   however. 
For example, for a pipe object, you can resize the height and   width, but not the thickness of the actual 
pipe.  

IMPORTANT:   Be advised that if you delete a Master Dynamo and there are pictures with   Dynamo Instances 
derived from that Master Dynamo, you will no longer be   able to use the Dynamo Updater to update those 
Instances. Use caution   when deleting any Master Dynamo in a Dynamo Set.

 

Pre-Built Dynamos and Dynamos Created Before iFIX 4.5

Dynamos in some pre-built Dynamo Sets and Dynamos created before iFIX   4.5 are not considered 
Dynamo objects. This means you cannot use the Quick   Dynamo Updater, the Dynamo Updater Wizard, 
and the Cross Reference Tool   to update instances of these Dynamos within existing pictures. Only 
Dynamo   objects can be updated with these tools.

Pre-built Dynamos, which are not considered Dynamo objects, include   the following Dynamo Sets:

 l Historical

 l Miscellaneous

 l Motors

 l Pipes

 l PipesAnim

 l Pumps

 l PumpsAnim

 l Tanks

 l TanksAnim1
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 l TanksAnim2

 l Valves

 l ValvesAnim

However, you may convert Dynamos created before iFIX 4.5 to objects   using the Dynamo Converter 
tools. After the Dynamos have been converted,   you may then use the Quick Dynamo Updater, the 
Dynamo Updater Wizard,   and the Cross Reference Tool to update Dynamo instances.

Determining Which Dynamo Sets Contain Dynamo Objects

The following table details which Dynamo Sets contain Dynamo Objects.   Dynamo Sets created before 
iFIX 4.5 are not considered, and do not include,   Dynamo objects; they are considered group objects, or 
legacy Dynamos.   If a Dynamo Set does not contain Dynamo Objects, you cannot use the Quick   
Dynamo Updater, the Dynamo Updater Wizard, and the Cross Reference Tool   to update instances of 
these Dynamos within existing pictures. Only Dynamo   objects can be updated with these tools. To 
update the Dynamos in your   pictures using the Dynamo Updater, you must first convert your legacy   
Dynamo sets, those created before iFIX 4.5 and certain pre-built sets,   using the Dynamo Sets Con-
verter.

Dynamo Set Contains Dynamo Objects?
Yes No

Emergency Stop Button  X
Gauges Horizontal Large X  
Gauges Horizontal Medium X  
Gauges Horizontal Small X  
Gauges Round Large X  
Gauges Round Medium X  
Gauges Round Small X  
Gauges Vertical Large X  
Gauges Vertical Medium X  
Gauges Vertical Small X  
Historical  X
Miscellaneous  X
Motors  X
Panel Buttons Large  X
Panel Buttons Medium  X
Panel Buttons Small  X
Pilot Lights Large X  
Pilot Lights Medium X  
Pilot Lights Small X  
Pipes  X
Pipes Anim  X
Pipes Large X  
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Pipes Small X  
Pumps  X
Pumps Anim  X
Pumps Large X  
Pumps Small X  
Storage Tanks X  
Storage Tanks Anim X  
Switches Large X  
Switches Medium X  
Switches Small X  
Tanks  X
Tanks Anim1  X
Tanks Anim2  X
Up Down Buttons  X
Valves  X
Valves Anim  X
Valves Control Hand X  
Valves ISA Horiz Large X  
Valves ISA Horiz Small X  
Valves ISA Vert Large X  
Valves ISA Vert Small X  

 

 

Converting Dynamos to Dynamo Objects in Pictures

Dynamos created before iFIX 4.5 are not considered   Dynamo objects; they are considered group 
objects, or legacy Dynamos.   This means you cannot use the Quick Dynamo Updater, the Dynamo 
Updater   Wizard, and the Cross Reference Tool on legacy Dynamos. In order to be   able to use the 
Updater tools to quickly update your Dynamos, you must   convert them to Dynamo objects.

You can search for group objects, or legacy Dynamos,   and convert them to Dynamo objects in multiple 
pictures at once using   the Dynamo Converter. The Dynamo Converter is accessed using the Quick   
Dynamo Converter or the Dynamo Converter Wizard, both of which are available   from the Dynamo Tool-
bar (Classic and Ribbon views) or on the Tools tab,   in the Dynamo group, in the Dynamo list (Ribbon 
view). 

When converting Dynamos inside a picture, those Dynamos are replaced   with the Master Dynamo 
objects used in the conversion process. This replacement   is not a merge; if you made changes to the 
Dynamo, they are overwritten   by the Master Dynamo. 
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The Conversion Process

The conversion process for Dynamos created before iFIX 4.5 has four   stages:

Stage Who Does What
1 User Use the Dynamo Sets Converter to convert old Dynamo   Sets.
2 User Link legacy Dynamos to Master Dynamos.

There are two methods for linking legacy Dynamos to   Master 
Dynamos. 

 l The   Quick Dynamo Converter. Allows the user to select 
a Master Dynamo   and Dynamo Instances to link. 
Requires that only one Dynamo Set and one   picture is 
open and active.

 l The   Dynamo Converter Wizard. Allows the user to 
select a Master Dynamo   and Dynamo Instances in mul-
tiple pictures to link. 

3 iFIX Convert Dynamos.

iFIX examines the differences between Dynamos and   their asso-
ciated Master Dynamos, and then converts the Dynamos based 
on   the conversion behavior the user specified. 

4 User/iFIX Create links with several Master Dynamos (if necessary).   

Repeat stages 2 and 3.

Limitations

There are a few limitations when using the Dynamo Converter tools:

 l IMPORTANT:   You must backup all Dynamo Sets and pictures before conversion.

 l IMPORTANT:   All group objects are listed on the Select Dynamo tab of the Dynamo Converter.   The 
groups are nested, and may therefore contain Dynamo objects, in addition   to legacy Dynamos. If you 
select the top-level groups without absolute   certainty that all sub-level groups contain legacy 
Dynamos, the conversion   will produce unexpected results.

 l Pictures   in a shared directory that are currently open by another user are not   available for con-
version. A picture must be able to be opened and saved,   which requires that no one else have the 
file open.

 l Open   Dynamo Sets are not automatically saved after conversion.

 l Resized   Dynamos do convert, however, not all dimensions resize. For example, for   a pipe 
object, you can resize the height and width, but not the thickness   of the actual pipe when you res-
ize it if the pipe's ThicknessType is Fixed;   this is the case for all pictures with pipes created prior 
to iFIX 5.0.   

 l Animations   on any object type will map only to an object of the same type. 

 l Animation   Data Sources from an existing Dynamo are maintained as long as a similar   object still 
exists in the Master Dynamo. 
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 l Dynamo   descriptions are unique and are not overwritten during a conversion. 

 l If   selected, the "Maintain Caption" option presented on the Dynamo   Converter Wizard Progress 
dialog box retains the caption text in Dynamo   Instances only when the object name matches the 
Master Dynamo.

 l Existing   connections made via use of Graphical Connection Nodes are maintained   whenever pos-
sible.

 

Using the Dynamo Toolbar

The following table describes the buttons available on the Dynamo Toolbar.   

NOTE: Although   hidden by default, you can access and use toolbars in Ribbon view. To   access the Dynamo 
toolbar in Ribbon view, on the Home tab, in the WorkSpace   group, click Settings, and then click Toolbars. You 
can also open a toolbar   from the WorkSpace tree, by opening the Project Toolbar Files folder and   double-
clicking the toolbar you want to open.

Click this but-
ton...

Which can also be accessed in 
Ribbon view...

To...

From the Tools tab, in the Dynamos 
group, click Dynamos, and then 
click   Build Dynamo.

Open the Build Dynamo Wizard. 
This wizard allows you to create a 
Dynamo   object from a selected 
object or objects.

From the Tools tab, in the Dynamos 
group, click Dynamos, and then 
click   Quick Dynamo Updater.

Open the Quick Dynamo Updater   
dialog box. This dialog box allows 
you to find and update Dynamo 
Instances   on all open pictures or on 
a single active picture.

From the Tools tab, in the Dynamos 
group, click Dynamos, and then 
click   Dynamo Updater Wizard.

Open the Dynamo Updater   Wizard 
dialog box. This dialog box allows 
you to find and update specific   
Dynamo Instances on selected pic-
tures. You can specify a log file in 
which   to record results.

From the Tools tab, in the Dynamos 
group, click Dynamos, and then 
click   Convert Dynamo Sets.

Open the Convert Dynamo Sets dia-
log box. This dialog box allows you   
to select Dynamo Sets to convert.

From the Tools tab, in the Dynamos 
group, click Dynamos, and then 
click   Quick Dynamo Converter.

Open the Quick Dynamo Converter 
dialog box. This dialog box allows 
you   to find and convert Dynamo 
Instances on a single active pic-
ture.

From the Tools tab, in the Dynamos 
group, click Dynamos, and then 
click   Dynamo Converter Wizard.

Open the Dynamo Converter Wiz-
ard dialog box. This dialog box 
allows   you to find and convert spe-
cific Dynamo Instances on selec-
ted pictures.   You can specify a log 
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file in which to record results.

NOTE: The Dynamo   Wizard toolbar is not accessible when a Dynamo Set is active.  

Creating Dynamo Objects

To create a Dynamo out of the currently selected object(s), click the   Create Dynamo button, shown in 
the following figure, on the Dynamo toolbar   (Classic view) or on the Tools tab, in the Dynamo group, in 
the Dynamo   list, click Create Dynamo (Ribbon view). 

If you are creating a Dynamo from an object with no animations, the   Build Dynamo Wizard dialog box 
appears.  By   default, the Build Dynamo Wizard assigns the object a sequential Dynamo   name. In the 
Build Dynamo Wizard you can rename the Dynamo, as well as   enter text describing the Dynamo and 
the object itself.

When a group containing Dynamo objects is promoted to a Master Dynamo,   as in the case when it is 
dragged and dropped into a Dynamo Set, the contained   Dynamo objects (instances) will be converted to 
standard group objects.   A message prompts you about this occurrence, and allows you to cancel   the 
operation.

 

Creating Dynamo Objects without Animations

To create a Dynamo out of the currently selected object or objects within   a picture, click the Build 
Dynamo button, shown in the following figure,   on the Dynamo toolbar (Classic view) or on the Tools tab, 
in the Dynamo   group, in the Dynamo list, click Build Dynamo (Ribbon view). 

Build   Dynamo Button

If you are creating a Dynamo from an object with no animations, the   Build Dynamo Wizard dialog box 
appears.  By   default, the Build Dynamo Wizard assigns the object a sequential Dynamo   name. In the 
Build Dynamo Wizard you can rename the Dynamo, as well as   enter text describing the Dynamo and 
the object itself.

If you are creating a Dynamo object with animations, the Build Dynamo   with User Prompts dialog box 
appears. For more information on how to use   this dialog box to create your Dynamo object, refer to the 
Creating   Dynamo Objects with Animations section.

Creating Dynamo Objects with Animations

A Dynamo is typically a group of objects that make up a custom object   for use in multiple pictures 
across your system. If some or all of those   objects are animated by a data source, the Build Dynamo 
with User Prompts   dialog box appears, as shown in the following figure, when you apply the   Build 
Dynamo wizard to the group. 
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Build Dynamo with User   Prompts Dialog Box

The object(s) retains the animation properties associated with an object   or group when you create the 
Dynamo object. During Dynamo object configuration,   the Build Dynamo with User Prompts dialog box 
lets you assign meaningful   user prompts to Dynamo properties. 

For example, if you created a tank with several iFIX objects and used   a rectangle as the animated fill por-
tion of the tank, that rectangle is   connected to an animation object whose source may be a database tag. 
Instead   of displaying Rect1.VerticalFillPercentage as the animated property in   the Dynamo's property 
dialog box, the Build Dynamo Wizard lets you name   Rect1.VerticalFillPercentage to something more 
meaningful to Dynamo users,   like Tank Fill. In this example, you would enter Tank Fill in the User   
Prompt field.

These user prompts appear in the Dynamo Properties dialog box when the   Dynamo is double-clicked or 
when the Dynamo is first copied into a new   picture. This allows you to quickly modify the data source 
associated   with the property, if necessary.

The following sections describe the information displayed in the columns   of this dialog box, including:

 l Object   Properties

 l Current   Setting

 l User   Prompts

Object Properties
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The Object Properties column, shown in the Build   Dynamo with User Prompts dialog box, displays the 
objects that comprise   the Dynamo object and their animated properties. The basic format for   an Object 
Property is shown below:

Object Name.Property

Where Object Name is the name of the object that is animated, and Property   is the property of the object 
that is animated.

You may also have some animated object properties that reside within   groups. In this case, the object 
property displays as shown below: 

Group Name.Object Name.Property

The following tables describe the properties of objects that you can   animate. These properties are all 
viewed on the Advanced Animations dialog   box.

Visible Tab

Property Description Objects
Visibility Specifies whether or not a 

shape appears on the screen.
Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Arc, Line, 
Polyline,   Text, Datalink,   
Chart, Bitmap

Size Tab 

Property Description Objects
Height The number of logical units or 

postscript points occupied   by 
the shape in the vertical dir-
ection.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
Datalink,   Chart, Bitmap

Width

 

The number of logical units or 
postscript points occupied   by 
the shape in the horizontal dir-
ection.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
Datalink,   Chart, Bitmap

HorizontalScalePercentage The ratio of the current shape 
width to its original   width.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
Datalink,   Chart, Bitmap

VerticalScalePercentage The ratio of the current shape 
height to its original   height.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
Datalink,   Chart, Bitmap

HorizontalScaleDirection Specifies whether the left or 
right side of the shape   will 
expand or contract when the 
horizontal scale percentage is 

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
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changed. Datalink,   Chart, Bitmap
VerticalScaleDirection Specifies whether the top or 

bottom side of the shape   will 
expand or contract when the 
vertical scale percentage is 
changed.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
Datalink,   Chart, Bitmap

UniformScale Specifies whether or not a 
shape scales horizontally   and 
vertically by the same 
amount.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline,   Text, 
Datalink, Chart, Bitmap

Misc Tab

Property Description Objects
Layer The layer of the shape. Time, Date, Rectangle, 

Rounded Rectangle, 
Oval, Chord,   Polygon, 
Pie, Pipe, Arc, Line, 
Polyline, Text, Com-
mand Button, Datalink,   
Chart

StartX Specifies the X coordinate 
starting point of the line.

Chord, Pie, Arc, Line

StartY Specifies the Y coordinate 
starting point of the line.

Chord, Pie, Arc, Line

EndX The horizontal location (in 
logical units or postscript   
points) of the last point in the 
shape.

Chord, Pie, Arc, Line

EndY The vertical location (in logical 
units or postscript   points) of 
the last point in the shape. 

Chord, Pie, Arc, Line

StartAngle The angle that starts the 
sweep of the pie.

Pie

EndAngle The angle that ends the sweep 
of the pie.

Pie

Radius The current radius of the pie. Pie
Pie Type Specifies whether the pie is 

limited to less than   180 
degrees of arc.

Pie

MousePointer Specifies the mouse pointer to 
display in run mode.

Command Button

Accelerator Specifies the accelerator to 
use in run mode.

Command Button

Name Specifies the name of the 
object.

Command Button, Alarm 
Summary

IsSelectable Controls whether the object 
can be selected in run   mode.

Command Button, Alarm 
Summary

Description A user defined description of Command Button, Alarm 

500 © 2024 General Electric Company. All rights reserved.



this object's function. Summary
ContextID The user-defined context ID for 

the user's context   sensitive 
help file.

Command Button, Alarm 
Summary

Visible Specifies whether or not a 
shape appears on the screen.

Command Button, Alarm 
Summary

Height The number of logical units or 
postscript points occupied   by 
the shape in the vertical dir-
ection.

Command Button, Alarm 
Summary

Width The number of logical units or 
postscript points occupied   by 
the shape in the horizontal dir-
ection.

Command Button, Alarm 
Summary

HorizontalPosition The shape's distance (in 
logical units or postscript   
points) from the left side of the 
picture.

Command Button, Alarm 
Summary

VerticalPosition The shape's distance (in 
logical units or postscript   
points) from the top of the pic-
ture.

Command Button, Alarm 
Summary

HorizontalScalePercentage The ratio of the current shape 
width to its original   width.

Command Button, Alarm 
Summary

VerticalScalePercentage The ratio of the current shape 
height to its original   height.

Command Button, Alarm 
Summary

HorizontalScaleDirection Specifies whether the left or 
right side of the shape   will 
expand or contract when the 
horizontal scale percentage is 
changed.

Command Button, Alarm 
Summary

VerticalScaleDirection Specifies whether the top or 
bottom side of the shape   will 
expand or contract when the 
vertical scale percentage is 
changed.

Command Button, Alarm 
Summary

UniformScale Specifies whether or not a 
shape scales horizontally   and 
vertically by the same amount.

Command Button, Alarm 
Summary

EnableTooltips Specifies whether a shape's 
tooltips are shown.

Command Button, Alarm 
Summary

ControlOrderIndex The order in which this object 
will be selected via   the up and 
down arrow keys.

Command Button, Alarm 
Summary

HighlightEnabled Indicates that the button 
should have a highlight   rect-
angle drawn around it when the 
mouse passes over it in run 
mode.

Command Button, Alarm 
Summary
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Default Specifies whether the button is 
the default button   on the pic-
ture.

Command Button, Alarm 
Summary

Cancel Specifies the ability of the but-
ton to accept the   cancel event 
on the picture.

Command Button, Alarm 
Summary

EnableAlarmAcknowledge Specifies whether or not alarm 
acknowledgement is   enabled.

Alarm Summary

EnableAlarmDeletion Specifies whether or not alarm 
deletion is enabled.

Alarm Summary

EnableColumnQuickSort Specifies whether or not 
column quick sort is enabled.

Alarm Summary

FilterString Specifies the filter string. Alarm Summary
ShowHeaders Specifies whether or not to dis-

play the column headers.
Alarm Summary

ShowRowNumbers Specifies whether or not to dis-
play row numbers.

Alarm Summary

UseUnacknowledgeAlarmColor Specifies whether or not to dis-
play a color for unac-
knowledged   alarms.

Alarm Summary

ShowScrollBars Specifies whether or not to dis-
play scroll bars.

Alarm Summary

SortColumnName Specifies the column name to 
sort by.

Alarm Summary

SortOrderDescending Specifies whether or not the 
descending sort type   is 
enabled.

Alarm Summary

AlarmUserdefField1 Specifies the User Defined 
Field 1 property.

Alarm Summary

AlarmUserdefField2 Specifies the User Defined 
Field 2 property.

Alarm Summary

EnableRightMouseClick Specifies whether or not the 
right mouse menu is enabled.

Alarm Summary

BlinkEnabled Specifies whether or not the 
blink property is enabled.

Alarm Summary

ShowGridLines Specifies whether or not the 
grid lines are displayed.

Alarm Summary

UnacknowledgedAlarmColor Specifies the color to display 
for unacknowledged   alarms.

Alarm Summary

EnableRunTimeConfiguration Specifies whether or not run-
time configuration is   enabled.

Alarm Summary

UpdateOnPropChange Specifies whether or not to 
update when property values   
change.

Alarm Summary

ShowStatusBar Specifies whether or not the 
status bar is displayed.

Alarm Summary

AlarmRefreshInterval Specifies the alarm refresh 
interval in seconds.

Alarm Summary

BlinkRate Specifies the rate, in seconds, Alarm Summary
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at which blinking   occurs.
SelectionTimeout Specifies the length of time, in 

seconds, that a row   remains 
selected.

Alarm Summary

StatusFontSize Specifies the font size of the 
alarm status text.

Alarm Summary

PauseIndicatorBlink Specifies whether or not the 
pause status color blinks.

Alarm Summary

PauseIndicatorColor Specifies the color of the 
pause status.

Alarm Summary

PauseWithNewAlarmIndicatorBlink Specifies whether or not the 
pause alarm status color   
blinks.

Alarm Summary

PauseWithNewAlarmIndicatorColorSpecifies the color of the 
pause alarm status.

Alarm Summary

RunIndicatorBlink Specifies whether or not the 
run status color blinks.

Alarm Summary

RunIndicatorColor Specifies the color of the run 
status.

Alarm Summary

UserDef1ColumnName Specifies the name of the User 
Defined Field 1 property.

Alarm Summary

UserDef2ColumnName Specifies the name of the User 
Defined Field 2 property.

Alarm Summary

BackgroundColor Specifies the background 
alarm color.

Alarm Summary

AlarmHornEnabled Specifies whether or not the 
alarm horn is enabled.

Alarm Summary

VisibleUnacknowledgedAlarms Specifies whether or not unac-
knowledged alarms are   dis-
played.

Alarm Summary

TotalFilteredAlarms Specifies the total number of 
filtered alarms.

Alarm Summary

CheckForNewAlarms Specifies whether or not to 
check for new alarms.

Alarm Summary

TopVisibleRow Specifies the number of top 
rows that are visible.

Alarm Summary

BottomVisibleRow Specifies the number of bot-
tom rows that are visible.

Alarm Summary

CheckForAlarmListChanged Specifies whether or not to 
check if the alarm list   has 
changed.

Alarm Summary

EnableAcknowledgeAll Specifies whether or not the 
Allow Acknowledge All   Alarms 
property is enabled.

Alarm Summary

CurrentImage Specifies the index of the 
image currently displayed.

Bitmap

ApplyProperties Specifies how the properties 
are applied to the list   of 
images.

Bitmap
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ButtonStyle Specifies the button behavior 
of the bitmap.

Bitmap

ButtonState Specifies the state of a multi-
state button.

Bitmap

SecondaryImageDisplayed Specifies whether or not a sec-
ondary image at the   current 
index is being displayed as the 
primary (or mouse-up) image.

Bitmap

DownImageDisplayed Specifies whether or not the 
secondary image is to   be dis-
played on a mouse down.

Bitmap

Transparency Specifies whether or not a bit-
map can effectively   have a 
bleed-through area that can be 
used for animation and visu-
alization.

Bitmap

Position Tab

Property Description Objects
HorizontalPosition The shape's distance (in 

logical units or postscript   
points) from the left side of the 
picture.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Arc, Line, 
Polyline, Text, Datalink, 
Chart, Bitmap

VerticalPosition The shape's distance (in 
logical units or postscript   
points) from the top of the pic-
ture.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Arc, Line, 
Polyline, Text, Datalink, 
Chart, Bitmap

Color Tab

Property Description Objects
ForegroundColor The color used to fill the 

interior of the shape.
Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Text, 
Datalink, Chart

BackgroundColor The color used to fill in the 
interior of the shape.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Text, 
Datalink, Chart, Bitmap

EdgeColor The color used to outline the 
shape.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Arc, Line, 
Polyline, Text, Datalink, 
Chart

ForegroundEdgeColor The foreground edge color of a 
shape.

Chart

BackgroundEdgeColor The background edge color of Chart
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a shape.
HorizontalGridColor The color of the horizontal grid 

lines.
Chart

VerticalGridColor The color of the vertical grid 
lines.

Chart

TransparentColor The transparent color of the bit-
map.

Bitmap

Style Tab

Property Description Objects
FillStyle The pattern used to fill the 

interior of the shape.
Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Text, Datalink, Chart

BackgroundStyle Specifies whether the fill 
style is either a "visible"   or 
"see through" background.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline, Text, 
Datalink, Bitmap

EdgeStyle The pattern used to outline 
the object.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline, Text, 
Datalink, Chart, Bitmap

EdgeWidth The width (in pixels) of the 
object's outline.

Time, Date, Rectangle, 
Rounded Rectangle, Oval, 
Chord,   Polygon, Pie, Pipe, 
Arc, Line, Polyline, Text, 
Datalink, Chart

RoundnessX Specifies the horizontal 
roundness of the rounded   
rectangle.

Rounded Rectangle

RoundnessY Specifies the vertical round-
ness of the rounded rect-
angle.

Rounded Rectangle

Thickness Specifies the thickness (in 
pixels) of the pipe object.

Pipe

StartCap Specifies the style to use for 
the start cap of the   pipe 
object.

Pipe

EndCap Specifies the style to use for 
the end cap of the   pipe 
object.

Pipe

ElbowStyle Specifies the style to use for 
the elbow of the pipe   object.

Pipe

FontSize Specifies the font size used 
to display text.

Chart

FontName Specifies the font family 
used to display text.

Chart
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FontStyle Specifies the style of font 
used to display text.

Chart

Transparent Specifies whether or not the 
chart is transparent.

Chart

MultipleEGU Specifies whether or not the 
chart displays multiple   
EGUs.

Chart

MultipleTimes Specifies whether or not the 
chart displays multiple   times.

Chart

ShowLegend Show/hides the chart legend. Chart
ShowTimeAxis Specifies whether or not to 

display the time axis.
Chart

ShowValueAxis Specifies whether or not to 
display the value axis.

Chart

ShowTimeCursor Specifies whether or not to 
display the time cursor.

Chart

BackgroundEdgeStyle Specifies the background 
edge style of the shape.

Chart

ForegroundEdgeStyle Specifies the foreground 
edge style of the shape.

Chart

ForegroundEdgeWidth Specifies the width of the 
shape's foreground border.

Chart

BackgroundEdgeWidth Specifies the width of the 
shape's background border.

Chart

ShowTimecursorToolTips Specifies whether to show 
the time cursor tool tips.

Chart

TimeCursorColor Specifies the time cursor 
color.

Chart

ShowHorizontalGrid Shows/hides the horizontal 
grid lines.

Chart

ShowVerticalGrid Shows/hides the vertical grid 
lines.

Chart

HorizontalGridStyle Specifies the style of the hori-
zontal grid lines.

Chart

VerticalGridStyle Specifies the style of the ver-
tical grid lines.

Chart

GridWidth Specifies the width of the grid 
lines.

Chart

NumberOfHorizontalGridLines Specifies the number of hori-
zontal grid lines.

Chart

NumberOfVerticalGridLines Specifies the number of ver-
tical grid lines.

Chart

ShowDate Specifies whether or not to 
show the date.

Chart

TimeAxisTitle Specifies the title of the time 
axis.

Chart

ValueAxisTitle Specifies the title of the value 
axis.

Chart
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TimeAxisNumTicks Specifies the number of ticks 
on the time axis.

Chart

TimeAxisNumLabels Specifies the number of 
labels on the time axis.

Chart

ValueAxisNumTicks Specifies the number of ticks 
on the value axis.

Chart

ValueAxisNumLabels Specifies the number of 
labels on the value axis.

Chart

ShowTimeAxisTitle Specifies whether or not to 
show the time axis title.

Chart

ShowValueAxisTitle Specifies whether or not to 
show the value axis title.

Chart

Rotate Tab

Property Description Objects
RotationAngle The angle (in radians or 

degrees) by which the shape   
has been rotated since its cre-
ation.

Rectangle, Chord, Polygon, 
Pie, Pipe, Arc, Line, Polyline

AngleUnits Specifies whether the angles 
are measured in degrees   or 
radians.

Rectangle, Chord, Polygon, 
Pie, Pipe, Arc, Line, Polyline

Text Tab

Property Description Objects
Caption Specifies the displayed text. Time, Date, Text, Datalink
FontName Specifies the font family used 

to display text.
Time, Date, Text, Datalink

FontSize Specifies the font size used to 
display text.

Time, Date, Text, Datalink

FontStyle Specifies the font style used to 
display text.

Time, Date, Text, Datatlink

Behavior Tab

Property Description Objects
AutoSize Controls whether the text 

object automatically picks   a 
new font that will fit into the 
bounding rectangle as the cap-
tion changes.

Time, Date, Text, Command 
Button, Datalink

ScalesWidth Specifies whether the width of 
the text or datalink   object can 
be changed.

Time, Date, Text, Datalink

MaxLines Specifies the maximum num-
ber of text lines allowed.

Time, Date, Text, Datalink

MaxCharactersPerLine Specifies the maximum num-
ber of characters allowed   per 
line.

Time, Date, Text, Datatlink
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Alignment Specifies the alignment of the 
text string within   the text's 
bounding rectangle.

Datalink

StrikeThrough Specifies whether the text has 
a strike through it.

Time, Date, Text, Datalink

Enabled Specifies whether or not the 
command button is enabled.

Command Button

Locked Specifies whether or not the 
command button is locked.

Command Button

WordWrap Specifies whether or not the 
text displayed on the   com-
mand button wraps.

Command Button

RefreshRate Specifies the refresh rate of 
the chart.

Chart

CurrentPen Specifies the current pen. Chart
Timeout Specifies the amount of time 

to pause for.
Chart

ScrollDirection Specifies the direction to 
scroll.

Chart

ResetPercentage Specifies the chart's reset per-
centage.

Chart

ScrollPercentage Specifies the chart's scroll per-
centage.

Chart

ZoomDirection Specifies the direction in 
which to zoom.

Chart

StartDateMode Specifies the start date mode. Chart
DaysBeforeNow Specifies the number of days 

before now that will   be 
included in the chart.

Chart

StartTimeMode Specifies the start time mode. Chart
TimeBeforeNow Specifies the amount of time 

before now to use in   the chart.
Chart

Duration Specifies the time duration. Chart
Interval Specifies the length of time 

between intervals.
Chart

ScrollGrid Specifies the scroll grid mode. Chart
TimeZoneBiasExplicit Specifies the explicit time 

zone bias.
Chart

TimeZoneBiasRelative Specifies the relative time 
zone bias.

Chart

DaylightSavingsTime Specifies whether to use Day-
light Savings Time when   dis-
playing data.

Chart

LockStartTime Specifies whether or not to 
lock the start time.

Chart

IntervalMilliseconds Specifies the millisecond com-
ponent of the interval.

Chart

AutoUpdateRate Specifies the auto-update rate. Chart
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DisplayMilliseconds Specifies whether or not to dis-
play milliseconds.

Chart

Gradient Tab

Property Description Objects
FadeColor Specifies the fade color used 

for the gradient fill.
Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Text, 
Datalink, Chart

FadeType Specifies the fade type used for 
the gradient fill.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Text, Datalink, 
Chart

GradientAngle Specifies the angle of the 
shape's gradient fill.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Text, Datalink, 
Chart

Blend Specifies the blend percentage 
used for the gradient   fill.

Time, Date, Rectangle, Roun-
ded Rectangle, Oval, Chord,   
Polygon, Pie, Pipe, Text, 
Datalink, Chart

Fill Tab

Property Description Objects
HorizontalFillPercentage The percentage of the shape's 

interior that will be   filled hori-
zontally with color and pattern, 
starting at the location identified   
by the HorizontalFillDirection.

Rectangle, Rounded Rect-
angle, Oval, Chord, Poly-
gon,   Pie, Pipe, Bitmap

VerticalFillPercentage The percentage of the shape's 
interior that will be   filled ver-
tically with color and pattern, 
starting at the location identified   
by the VerticalFillDirection.

Rectangle, Rounded Rect-
angle, Oval, Chord, Poly-
gon,   Pie, Pipe, Bitmap

HorizontalFillDirection Specifies the direction of a 
shape's horizontal fill.

Rectangle, Rounded Rect-
angle, Oval, Chord, Poly-
gon,   Pie, Pipe, Bitmap

VerticalFillDirection Specifies the direction of a 
shape's vertical fill.

Rectangle, Rounded Rect-
angle, Oval, Chord, Poly-
gon,   Pie, Pipe, Bitmap

Appearance Tab

Property Description Objects
BackColor Specifies the background color 

of the command button.
Command Button

BackStyle Specifies the background style 
of the command button.

Command Button

Caption Specifies the text to be dis-
played on the command   button.

Command Button
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ForeColor Specifies the foreground color 
of the command button.

Command Button

Picture Tab

Property Description Objects
PicturePosition Specifies the position of the 

picture.
Command Button

Variable Tab

Property Description Objects
VariableType Specifies the variable type. Local Variable
InitialValue Specifies the initial value of the 

variable.
Local Variable

CurrentValue Specifies the current value of 
the variable.

Local Variable

Source Specifies the source string for 
an animation.

Global Variable

GlobalToggle The source of data for triggering 
a "GlobalOutputToggle"   setting 
that will alternate with the actual 
setting from the lookup table.

Global Variable

ToggleSource Specifies the data source or 
expression used to determine   if 
the output of the Lookup object 
should toggle between output1 
and output2.

Global Variable

 

Current Setting

The Current Setting column, shown in the Build   Dynamo with User Prompts Dialog Box, displays the 
source or data source   currently assigned to the associated object property. 

For example, you create a tank that is made up of a group of rectangles   and you assign the Ver-
ticalFillPercentage of the interior rectangle, RectInt,   with the data source FIX32.NODE.TAG.FIELD. 
When you select the tank group   and apply the Build Dynamo Wizard, FIX32.NODE.TAG.FIELD 
appears in the   Current Setting column for the RectInt.VerticalFillPercentage object property.

In addition to representing the data source of an animated property,   the current setting column may also 
display text for a text object.

The Dynamo user can change the current setting when he places the Dynamo   in a picture or double-
clicks it.

User Prompts

The User Prompts column in the Build Dynamo with User Prompts dialog   box, shown in the following fig-
ure, allows you to enter prompts for Dynamo   properties. 
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These user prompts appear in the Dynamo Properties dialog box when the   Dynamo is double-clicked or 
when the Dynamo is first copied into a new   picture. This allows you to quickly modify the data source 
associated   with the property.

For example, if you create the tank described in the Current   Setting section and apply the Build Dynamo 
Wizard, the Build Dynamo   with User Prompts dialog box appears as shown in the following figure.

Build Dynamo with User   Prompts Dialog Box - Entering User Prompts

In this example, enter Tank Fill in the User Prompt field. Tank Fill   describes the property for the 
Dynamo. Tank Fill is more descriptive to   users than RectInt.VerticalFillPercentage. The Dynamo prop-
erties display,   as shown in the following figure, if the user double-clicks the Dynamo.
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Dynamo Properties Dialog   Box

Using Partial Substitution for Dynamo User Prompts

You can configure a Dynamo to allow partial substitution for property   values. For example, you may 
want to allow the user to enter a different   NODE.TAG for a Dynamo property value but keep a static 
field. To do this,   you need to enter the User Prompt surrounded by brackets and use asterisks   for static 
values.

IMPORTANT: When using   tag group symbols as partial substitutions, the Build Dynamo Wizard does   not auto-
matically resolve the tags. 

The following example illustrates how you might use partial substitution   for a Dynamo's property setting.

Example: Using Partial Substitution for Dynamo User Prompts

This example assumes that you have a datalink named Datalink1 in the   group of objects that you are 
converting to a Dynamo. In the Build Dynamo   with User Prompts dialog box, enter the User Prompt as 
shown below: 

Object Property Current Setting User Prompt
Datalink1.Caption FIX32.SCADA01.TL01.F_CV {Measurement Tag}.*

The Dynamo Properties dialog box displays the following: 

DynamoProperty CurrentSetting
Measurement Tag FIX32.SCADA01.TL01

The Dynamo property Measurement Tag always uses the F_CV field for any   tag the user enters.
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Assigning the Same User Prompt for Multiple Object Properties

In some cases, you may want all of the Dynamo object properties to use   the same setting. For example, 
you may want a tank's fill and color properties   to be animated by the same database tag. To do this, 
enter the same User   Prompt for each object property.

If you use the same user prompt for multiple Dynamo properties, when   you view the Dynamo Property 
dialog box, only one property displays. The   value entered for the Dynamo property is used for all the 
object properties   that you assigned that user prompt to.

Example: Assigning the Same User Prompt for Multiple Object Properties

In this example, you create a Dynamo that allows the user to enter one   tag that animates both the ver-
tical fill percentage and the foreground   color of Rect1. In the Build Dynamo with User Prompts dialog 
box, enter   the User Prompt as shown below: 

Object Property Current Setting User Prompt
Rect1.VerticalFillPercentage FIX32.NODE.TAG.FIELD Tank Animation Tagname
Rect1.ForegroundColor FIX32.NODE.TAG.FIELD Tank Animation Tagname

The Dynamo Properties dialog box displays the following: 

Dynamo Property Current Setting
Tank Animation Tagname FIX32.NODE.TAG.FIELD

When you enter a different tag in the Current Setting column, the tag   animates both the fill percentage 
and color.

Displaying No User Prompts for a Dynamo Object with Animations

In some cases, you may not want to display any user prompts for an object   that contains animations. 
For example, you may have a complex Dynamo object   with user prompts provided through scripting, 
rather than manual user   entry. To allow for this, in the Build Dynamo User Prompt dialog box,   do not 
enter a user prompt in any object property. Leave all user prompt   fields empty.

If you do not enter user prompts in any of the object property fields   of the Build Dynamo User Prompt dia-
log box, then no prompts display when   you add the Dynamo Instance to a picture.

Creating Custom Dynamo Objects with Command Scripts

When you create a Dynamo object that contains objects with command scripts,   you can apply user 
prompts to those scripts allowing users of the Dynamo   to change the command script parameter. To do 
this, for each command script,   add a Variable object to the Dynamo group and change the command 
script   parameter as described in the example below. This allows you to change   the command script para-
meter in the Dynamo Properties dialog box. 

Example 1

For example, you may want to create a Dynamo that contains a command   button that when clicked, 
runs the following command script:

ToggleDigitalPoint "FIX32.SCADA01.DO1.F_CV"
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And, you may want to allow the Dynamo users to change the tagname for   the ToggleDigitalPoint com-
mand.
 To allow Dynamo users to change the   tagname for the ToggleDigitalPoint command: 

 1. Add a Variable object   for each command script to the Dynamo group. 

 2. Set the Variable   object's VariableType property to String and its InitialValue property   to the tag-
name. 

 3. Change the command   script parameter in the script to VariableName.InitialValue.   

Example 2

Assume that you have two push buttons in your Dynamo. One has the command   script: WriteValue 
"50", "FIX32.NODE.TAG.F_CV". The   other has the following command script: ToggleDigitalPoint 
"FIX32.NODE.DIGTAG.F_CV".   
 To allow users to be able to set   the tags when they use the Dynamo object: 

 1. In Classic view,   use the Variable toolbar button on the Toolbox to insert a Variable object.   

-Or-

In Ribbon view, on the Insert tab, in the   Objects/Links group, click Objects/Links, and then click 
Variable.

 2. When the Create a   Variable Object dialog box appears: 

 a. Name the Variable   object WriteVal. 

 b. Select Variable   Type String. 

 c. Select Local   Variable. 

 d. Click OK. 

 3. Select the Variable   object that you inserted in the System Tree, and select Property Window   from 
the right-click menu. 

 4. In the Property Window   for the Variable object, set the Initial Value property to 
FIX32.NODE.TAG.F_CV.   

 5. Insert another Variable   object and follow steps 1 through 4 above. Name the Variable object 
ToggleVal   and set the Initial Value property of this Variable object to FIX32.NODE.DIGTAG.F_
CV.   

 6. For the two pushbuttons,   open the Visual Basic Editor and change the command scripts as fol-
lows:   

 l WriteValue "50",   WriteVal.InitialValue 

 l ToggleDigitalPoint   ToggleVal.InitialValue 

 7. Close the editor   and add the two Variable objects to the Dynamo group by selecting them   in the 
System Tree and dragging and dropping them into the group. 

When you select the Create Dynamo toolbar button, the Create Dynamo   with User Prompts displays: 

Object Property Current Settings User Prompt
WriteVal.InitialValue FIX32.NODE.TAG.F_CV  
ToggleVal.InitialValue FIX32.NODE.DIGTAG.F_CV  
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If you set your User Prompts to Write Tag and Toggle Tag, the Dynamo   Properties dialog box displays 
the following: 

Dynamo Property Current Setting
Write Tag FIX32.NODE.TAG.F_CV
Toggle Tag FIX32.NODE.DIGTAG.F_CV

Building Custom Dynamos with VBA 

iFIX Dynamo objects are powerful tools, especially because they let   you customize your display using 
VBA. When a Dynamo fires an Edit event,   you can customize that Dynamo using VBA scripts. Spe-
cifically, you can   modify custom property pages, apply animations in real-time, or hide code   for anim-
ations into an empty user form. You can place user forms into   a global page so that every time you open 
that Dynamo, the format for   a particular property page is shared among several users.

For more information on using VBA to customize Dynamos for your specific   needs, refer to the Writing 
Scripts   manual.

Creating Dynamo Sets 

A Dynamo Set is a collection of Dynamos. Dynamo Sets are saved in iFIX   with a .FDS file extension. 
Each set can include Dynamo objects, pre-built   Dynamos, and Dynamos groups created before iFIX 
4.5. iFIX contains an   extensive library of pre-built Dynamo Sets that you can use, or you can   create your 
own. 

NOTE: Dynamos   in Pre-built Dynamo Sets earlier than iFIX 4.5 and Dynamos created before   iFIX 4.5 are not 
Dynamo objects. This means you cannot use the Quick Dynamo   Updater, the Dynamo Updater Wizard, and 
the Cross Reference Tool to update   instances of pre-built Dynamos or Dynamos created earlier than iFIX 4.5   
within existing pictures. Only Dynamo objects can be updated with these   tools. However, you may convert 
Dynamos created before iFIX 4.5 to objects   using the Dynamo Converter tools. After the Dynamos have been 
converted,   you may then use the Quick Dynamo Updater, the Dynamo Updater Wizard,   and the Cross Refer-
ence Tool to update Dynamo instances.

To open an existing Dynamo Set in the iFIX WorkSpace, open the Dynamo   Sets folder from the system 
tree and double-click the set. 

To create a new Dynamo Set, click the New Dynamo Set button on the Standard   toolbar (Classic view) 
or on the Tools tab, in the Dynamos group, in the   Dynamos set, click New Dynamo Set (Ribbon view). A 
blank document opens   always on top and half the window size, and the Dynamo Set is added to   the 
Dynamo Sets folder in the system tree. When you save a Dynamo Set,   it is given an .FDS extension 
and stored in this folder. 

To accommodate the unique requirements of Dynamo objects, objects behave   slightly different in a 
Dynamo Set than they do in a picture. For example,   when you click an object in a picture and drag that 
object to another   location within the picture, you move the object. However, if you drag   and drop that 
same object into a Dynamo Set, you copy the Dynamo object   to the set, as the following figure shows. 
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An Object Moved within   a Picture

IMPORTANT:   Be advised that if you delete a Master Dynamo and there are pictures with   Dynamo Instances 
derived from that Master Dynamo, the links to those Instances   will be lost when the Master Dynamo is 
deleted. Use caution when deleting   any Master Dynamo in a Dynamo Set.
Dynamo Behavior in Pictures and in Sets

If you create an object, and then copy the object to a Dynamo Set, you   can access the Visual Basic 
Editor by double-clicking the new Dynamo.   If you make changes in the Visual Basic Editor however, and 
then copy   the Dynamo back into a picture, you cannot double-click the object to   display the Animations 
dialog box. This is because an Edit event created   in a Dynamo overrides the double-click behavior in the 
picture.
Right-click Menu for Dynamo Set Objects

Many of the operations you can perform with Dynamos can be accessed   using the Dynamo's right-click 
pop-up menu. When you want to make any   modifications to your Dynamo Sets, you can use this menu. 
To access the   pop-up menu, right-click the object in the Dynamo Set. The following table   describes 
which functions are available and what they help you do. 

Use the oper-
ation...

To...

Undo Undo an operation.
Cut Remove the object from the dynamo and place it into   the clipboard.
Copy Create a duplicate copy of the object and place it   into the clipboard.
Delete Remove the object from the dynamo.

Dynamo Set Pop-up Menu Selections    

516 © 2024 General Electric Company. All rights reserved.



Duplicate Create a duplicate copy of the object and place it   slightly offset from the original.
Edit Script Open the Visual Basic Editor, which allows you to   edit Visual Basic scripts.
Property Window Display the Properties Window, which allows you to   view and change property 

values.

Using a Dynamo Object in Pictures

After you create a Dynamo and save it in a Dynamo Set, you can use it   in your system pictures by drag-
ging the Dynamo from the Dynamo Set into   a picture. A Dynamo is not a Master Dynamo, and therefore 
not linked to   other Dynamos, until it becomes part of a Dynamo Set. Once it's part of   a Dynamo Set, any 
instances created beforehand are not linked to the Master   Dynamo. Only Instances created after the 
Dynamo becomes part of the Dynamo   Set are linked to the Master Dynamo.

If you assigned User Prompts to the Dynamo's Object Properties, the   Dynamo Properties dialog box 
appears after you drop in the Dynamo object.   This dialog box allows you to change the data sources for 
the Dynamo's   properties.

Updating Dynamo Objects in Pictures 

You can search for Dynamo Instances and replace them in multiple pictures   at once with the latest ver-
sions of their associated Master Dynamos using   the Dynamo Updater. The Dynamo Updater is 
accessed using either the Quick   Dynamo Updater or the Dynamo Updater Wizard, both of which are 
available   from the Dynamo Toolbar (Classic view) or on the Tools tab, in the Dynamos   group, in the 
Dynamos list (Ribbon view). The Dynamo Updater can also   be accessed from the Tool menu of the 
Cross Reference Tool.

In general, when updating a Dynamo Instance inside a Picture, that Instance   is replaced with the Master 
Dynamo it is being updated from. This replacement   is not a merge; if you have made changes to the 
Dynamo Instance, it is   overwritten by the Master Dynamo. 

Limitations

There are a few limitations when using the Dynamo Updater tool:

 l The Quick Dynamo   Updater and Dynamo Updater Wizard do not support dynamos with 
Enhanced   Charts.

 l Pictures in a shared   directory that are currently open by another user are not available to   be 
updated. A picture must be able to be opened and saved, which requires   that no one else have 
the file open.

 l If you rotated an   instance of a Master Dynamo object within a picture, you must review the   
Dynamo Instance and modify it after the update.

 l Resized Dynamos do   update, however, not all dimensions resize. For example, for a pipe object,   
you can resize the height and width, but not the thickness of the actual   pipe when you resize it. 

 l Animations on any   object type will map only to an object of the same type. 
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 l Animation Data Sources   from an existing Dynamo Instance are maintained as long as a similar 
object   still exists in the Master Dynamo. 

 l Dynamo descriptions   are unique to the Instance and are not overwritten during an update. 

 l Existing connections   made via use of Graphical Connection Nodes are maintained whenever pos-
sible.    

 l It is possible for   you to have changed a Master Dynamo so significantly that it is impossible   to 
perform an update and maintain all the data. 

For example, if you update a Dynamo to contain   only one data source based animation but a pre-
vious version had three   data source based animations, a best guess match is made about which 
one   of the three data sources to use. A report is then generated based on   your settings. The "best 
guess" approach makes comparisons between   common properties. For example, a Fill Anim-
ation's data source is copied   over only to another Fill Animation. If no Fill Animation exists, the   
data source is likely to be dropped. For multiple Fill Animations, additional   comparisons such as 
the Animation Name are made.

Searching for Mismatched Dynamo Instances

There are three ways to search for Dynamo Instances whose versions do   not match their Master 
Dynamos:

 l The Quick Dynamo   Updater lets you conduct a basic search for Dynamo Instances that are   not 
synchronized with their associated Master Dynamos in the active picture   or all open pictures.

 l The Dynamo Updater   Wizard gives you finer control over which Dynamos and pictures to include   
in the search, lets you specify a log file in which to record search results,   and enables you to spe-
cify the update behavior that the Dynamo Updater   should use during the replacement process.

 l The Cross Reference   Tool's Report Wizard enables you to search for Dynamos in pictures, or   
pictures containing specified Dynamos.

Updating Mismatched Dynamo Instances 

If you have found mismatched Dynamo Instances using the Quick Dynamo   Updater, Dynamo Updater 
Wizard, or Cross Reference Tool Report Wizard,   you can update them with the Dynamo Updater. In the 
Dynamo Updater, you   can configure whether iFIX prompts when or if the updates occur. 

The Dynamo Updater examines the version differences between Dynamo Instances   and their asso-
ciated Master Dynamos, and then updates the Dynamo Instances   based on the update behavior you 
specify. 

Changing the Configuration of a Dynamo

If you need to modify the configuration of an existing Dynamo object   in a picture (a Dynamo Instance), 
right-click the Dynamo object and select   Enter Drill-down. A box appears around the Dynamo object. 
Select the object   you want to make changes to, and update it. Click outside the selected   box when you 
are finished with your changes.
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You can also select the Dynamo object and click the Build Dynamo button   on the Dynamo Toolbar to 
update Dynamo user prompts (Classic view) or   on the Tools tab, in the Dynamos group, in the Dynamos 
list, click Build   Dynamo (Ribbon view). 

Additionally, you can right-click the Dynamo object and select Property   Window to update overall prop-
erties in the Dynamo. 

If you want to modify a Master Dynamo in a Dynamo Set, drag the Dynamo   object from the Dynamo Set 
and into a picture and make your changes. When   you are finished, drag-and-drop the Dynamo object 
from the picture, back   into the Dynamo Set. A message appears asking you if you want to overwrite   the 
Master Dynamo and update it. While you can also edit some Dynamo Properties   from the Dynamo Set 
window, it's better to drag-and-drop the Dynamo into   a picture to make the update and then drag-and-
drop it back into the Dynamo   set. Ensure that you remove the updated Dynamo object from the picture   
and replace it with an instance of the Master Dynamo, and then you can   update other instances of 
Dynamo objects.

 

Modifying Dynamo Object Properties 

The Dynamo Properties dialog box appears when a Dynamo is double-clicked   or when the Dynamo is 
first copied into a new picture, and there are user   prompts available for the Dynamo. This dialog box 
allows you to quickly   modify the data source associated with the property, if necessary. The   Dynamo 
Properties dialog box includes the Dynamo properties listed below:

Property Description
Dynamo 
Name

A read-only field listing the name of the Dynamo object.   You cannot edit this field.

Dynamo 
Description

A description of the specific usage of the given Dynamo   Instance. The maximum number 
of characters that you can enter in this   description are recorded in the Max_Dynamo_
Desc_Length   field. The Dynamo Description can be different for each Dynamo Instance.   
For the Master Dynamo, the description is empty and read-only.

Dynamo 
Property

If the Dynamo contains animated properties, the Dynamo   Properties dialog box displays 
the animated properties and lets you change   their current setting.

Current Set-
ting

Each property contains a Current Setting column. The   Current Setting column contains 
the value or data source assigned to the   Dynamo property. The first time you use the 
Dynamo, it displays the original   values assigned to the properties when the Dynamo was 
created.

If the current setting is a data source, you can select   the Browse (...) button to launch the 
Expression Builder and select a   new data source. You can also select the Quick Modify 
button to modify   the data source value itself.

You may later decide to change the user prompts that appear in the Dynamo   Properties dialog box. You 
can do this by selecting the Dynamo object   (in a picture or Dynamo Set), and clicking the Build Dynamo 
button from   the Dynamo toolbar (Classic view) or by selecting Build Dynamo from the   Dynamo list, in 
the Dynamo group, on the Tools tab (Ribbon view). When   the Dynamo has animated properties, the 
Build Dynamo with User Prompts   dialog box appears. The User Prompts appear in brackets, { }. To 
change   the User Prompt, delete or modify the contents of the User Prompt field   and click OK. 
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Converting Dynamos to Objects

If you want to convert a Dynamo object back to its individual objects,   right-click the Dynamo object and 
select Convert to Objects. Dynamo objects,   just like the pre-existing Dynamo objects, ceases to exist if 
the Dynamo   is ungrouped and converted to individual objects. 

When a Dynamo object in a picture is converted to individual objects,   the link to the Master Dynamo no 
longer exists. You cannot use the Quick   Dynamo Updater, the Dynamo Updater Wizard, and the Cross 
Reference Tool   to update this instance of the Dynamos object. Only Dynamo objects can   be updated 
with these tools.

Dynamo Dialog Boxes

The Dynamo feature includes the following dialog boxes:

 l Add   Objects to Dynamo Set Dialog Box

 l Build   Dynamo Wizard Dialog Box

 l Build   Dynamo with User Prompts Dialog Box

 l Data   Sources Adjustment Option Dialog Box

 l Dynamo   Properties Dialog Box

 l Dynamo   Sets Converter Dialog Box

 l Dynamo   Sets Converter Progress Dialog Box

 l Dynamo   Sets Converter - Conversion Adjustment Option Dialog Box

 l Dynamo   Converter Wizard

 l Dynamo   Converter Wizard Progress Dialog Box

 l Dynamo   Updater Wizard

 l Dynamo   Updater Dialog Box

 l Dynamo   Updater - Update Behavior Dialog Box

 l Overwrite   Master Dynamo Dialog Box

 l Quick   Dynamo Updater Dialog Box

 l Quick   Dynamo Converter Dialog Box

 

Add Objects to Dynamo Set Dialog Box

The Add Objects to Dynamo Set dialog box displays the following items:

Name

A read-only field that displays the object name of the selected Dynamo   for informational purposes. You 
cannot edit this field. 
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Description

A read-only field that displays the object description of the selected   Dynamo for informational purposes. 
You cannot edit this field. 

Create a New Master Dynamo

Select this option to create a new master Dynamo from the selected object.

Add to Dynamo Set As-Is

Select this option to add the selected object to the Dynamo Set without   creating a Master Dynamo 
object.

 

Build Dynamo Wizard Dialog Box

The Build Dynamo Wizard dialog box displays the following items:

Dynamo Name Item

Specify a name for the Dynamo in this field. The name you specify must   satisfy the following conditions:

 l It must begin with   an alphabetic character, and must contain only alphanumeric characters.

 l It cannot be blank,   and cannot contain any spaces.

 l The maximum number   of characters is 64.

 l The name cannot be   changed while a script is running or paused.

 l The name cannot contain   reserved VBA names. See the Microsoft VBA help system for more 
information   on VBA reserved words.  

Dynamo Description

Optionally, specify a description of the Dynamo Instance in this field.   The Dynamo Description can be 
different for each Dynamo Instance. For   the Master Dynamo, the description is empty and read-only.

Object Description

Optionally, specify a description of the object in this field. 

 

Build Dynamo with User Prompts Dialog Box

The Build Dynamo Wizard With User Prompts dialog box displays the following   items:

Dynamo Name Item

Specify a name for the Dynamo in this field. The name you specify must   satisfy the following conditions:

 l It must begin with   an alphabetic character, and must contain only alphanumeric characters.

 l It cannot be blank,   and cannot contain any spaces.
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 l The maximum number   of characters is 64.

 l The name cannot be   changed while a script is running or paused.

 l The name cannot contain   reserved VBA names. See the Microsoft VBA help system for more 
information   on VBA reserved words.  

Dynamo Description

Optionally, specify a description for the Dynamo Instance in this field.   The Dynamo Description can be 
different for each Dynamo Instance. For   the Master Dynamo, the description is empty and read-only.

Object Description

Optionally, specify a description of the object in this field. 

Object Property

Displays each property assigned to the Dynamo.

Current Setting

Displays the value, such as the tagname or command script variable,   that is currently assigned to the 
object property.

User Prompt

The User Prompt fields allow you to enter Dynamo prompts for each object   property so you can re-use 
the Dynamo in multiple displays. A Dynamo prompt   should be meaningful, so that when it is placed in a 
picture, the user   can enter the unique properties for the Dynamo.

Data Sources Adjustment Option Dialog Box

The Data Sources Adjustment Option dialog box displays the following   items:

Update Behavior

The Update Behavior area lets you specify how the Dynamo Updater should   reconcile a data source mis-
match between a Master Dynamo and Dynamo Instance.   Select one of the following options:

 l Update   Dynamo, and use Master Dynamo data sources –   If you want to update mismatched 
Dynamo Instances, but do not want to   apply any new data sources from the Master Dynamo. 
This option uses all   data sources from the Master Dynamo, and no data sources from the 
Dynamo   Instance.

 l Update   Dynamo, and try to match up data sources   – If   you want to update mismatched 
Dynamo Instances using new data sources   from the Master Dynamo. 

For example, if a Master Dynamo object contains   only one data source (user prompt) based on an 
animation, but a previous   version (an instance of that Dynamo) includes three data sources 
based   on animations, a best guess match is made. For the best guess, iFIX decides   which one of 
the three data sources to use in the instance, and a report   is generated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no attempt to 
update the data sources   in the animation for that object.
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 l Do   not Update Dynamo – If you only   want to view a report of mismatched Dynamos and make 
no actual updates.

 l Prompt   for Choice –   If you want a prompt to display with your options each time a mismatched   
Dynamo is found. This option is the default.

 

Dynamo Properties Dialog Box

The Dynamo Properties dialog box appears when a Dynamo is double-clicked   or when the Dynamo is 
first copied into a new picture, and there are user   prompts available for the Dynamo. This allows you to 
quickly modify the   data source associated with the property, if necessary. The Dynamo Properties   dia-
log box displays the following items:

Dynamo Name

A read-only field that displays the Dynamo name for informational purposes.   You cannot edit this field.

Dynamo Description

Optionally, specify a description of the Dynamo Instance in this field.   The Dynamo Description can be 
different for each Dynamo Instance. For   the Master Dynamo, the description is empty and read-only.

Dynamo Property List

The Dynamo Property list box displays each property assigned to the   Dynamo. For each Dynamo Prop-
erty:

 l The Current Setting   field displays a value, such as the tagname or command script variable,   
that is currently assigned to the object property.

 l The User Prompt   field allows you to enter Dynamo prompts for each object property, so   you can 
re-use the Dynamo in multiple displays. A Dynamo prompt should   be meaningful, so that when it 
is placed in a picture, the user can enter   the unique properties for the Dynamo.

 

Dynamo Sets Converter Dialog Box

The Dynamo Sets Converter dialog box displays the following items:

Current Dynamo Set Path

Click the button next to this field to select a path containing the   Dynamo Sets you want to convert.

Dynamo Sets List Box

Displays the Dynamo Sets that exist in the Current Dynamo Set Path.   You can expand Dynamo Sets to 
display the individual legacy Dynamos (top-level   group objects) contained in each Dynamo Set. The 
Dynamo Sets list box   is where you select the legacy Dynamos or Dynamo Sets you want to convert.

Select All/Clear All

Click either the Select All button or the Clear All button to quickly   select or de-select all the Dynamos in 
every listed Dynamo Set.
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Convert

After you have selected at least one legacy Dynamo, the Convert button   becomes available. When you 
click the Convert button, the Dynamo Sets   Converter examines the selected Dynamos and opens the 
Dynamo Sets Converter   dialog box, where you can convert Dynamos. 

NOTE: If the   selected Dynamo Set is open before the conversion process begins, it will   not be saved; close all 
Dynamo Sets before conversion to ensure that changes   are saved.

 

Dynamo Sets Converter (Progress) Dialog Box

After selecting Convert on the Dynamo Sets Converter   dialog box, the Dynamo Sets Converter Pro-
gress dialog box appears. It   displays the following items:

Quick Dynamo Sets Report for Conversion

Item Description
Selected Group 
Objects to Convert 
–   List Box

Displays the Dynamo Instances that were selected for   conversion. 
This list is generated from the Dynamo Sets Converter dialog   box.

Selected Group 
Objects to Convert 
–   Table

Displays the name, object description, dynamo description,   revision, 
file name, and full name of the Dynamo Set selected in the conversion   
list.

Convert Group Objects

Item Description
Conversion Pro-
gress Status

Graphically displays the progress of the Dynamo Conversion   process.

Conversion Pro-
gress Status –   Log 
Display

Displays the date, time, and status of each Dynamo   conversion 
attempted as part of the automated Dynamo Convert process.

Run Conversion

Launches the conversion process, which converts existing Dynamos to   Dynamo objects. 

NOTE: While the   conversion process is running, the Run Conversion button changes to a   Cancel Conversion 
button, allowing you the option of canceling the conversion   while it is in progress.

 

Dynamo Converter –   Conversion Adjustment Option Dialog Box 

The Dynamo Converter –   Conversion Adjustment Option dialog box displays the following items:

Options for the Conversion

The Options for the Conversion area lets you specify how the Dynamo   Converter should reconcile a mis-
match between a Master Dynamo and Dynamo.   Select one of the following options:
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 l Convert   to Dynamo but do not update Dynamo –   If you want to convert the Dynamo to a 
Dynamo object, but do not want   to link it to the Master Dynamo. Use this option if you want to 
use this   Dynamo to create a new Master Dynamo.

 l Convert   to Dynamo, then update Dynamo   – If   you want to convert the Dynamo to a Dynamo 
object, and want to link it   to the Master Dynamo. 

 l Do   not convert to Dynamo – If you only   want to view a report of mismatched Dynamos and 
make no actual conversions   for mismatches. Mismatched Dynamos are not converted.

Apply

Applies the selected adjustment option to a single Dynamo object in   the conversion.

Apply to All

Applies the selected adjustment option to all Dynamo objects in the   conversion.

Dynamo Converter Wizard Dialog Box

The Dynamo Converter Wizard dialog box displays the   following items:

Convert Behavior Tab

The Convert Behavior tab lets you set how Dynamos are handled when the   object structure of a Master 
Dynamo and a Dynamo do not match. You can   select from the following options:

 l Convert   Dynamo, but do not update Dynamo (Don't link to Master Dynamo)   – If   you want 
to convert the Dynamo to a Dynamo object, but do not want to   link it to the Master Dynamo. Use 
this option if you want to use this   Dynamo to create a new Master Dynamo.

 l Convert   Dynamo, then update Dynamo (Link to Master Dynamo). Try to match up data   
sources –   If you want to convert the Dynamo to a Dynamo object, and want to link   it to the 
Master Dynamo.

 l Do   not convert Dynamo –   If you only want to view a report of mismatched Dynamos and make 
no actual   conversions. Dynamos that are not mismatched are converted.

 l Prompt   for choice –   If you want to be prompted each time a mismatch is detected.

Convert Options Tab

Item Description
Save Status Trail 
Check Box

Select this check box to save a text log of the Dynamo Converter's 
activities.   If you do not check this box, the remaining options on the 
Convert Options   Tab are unavailable.

Save Status Trail Edit 
Box

Specify a folder, path, and file name for the Dynamo Converter's log   
file, or click the Browse button to select a file location.

Save Status Trail 
Browse Button

Click this button to select a path and filename for the Dynamo Con-
verter's   log file.

Append/Overwrite 
Options

Choose Append or Overwrite to either append the new results to the 
existing   status trail log, or overwrite the log file with the new results. 
If no   log exists, either option will create a new status trail log file.
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Select Dynamos Tab

Item Description
Current Dynamo Set 
Path

Click the button next to this field to select a path containing the   
Dynamo Sets you want to convert.

Select DynamoSets 
and Master Dynamo

Use this drop-down list to select a Dynamo set.

Master Dynamo List 
Box

Displays the Master Dynamos that exist in the selected Dynamo 
Sets.   The Master Dynamo list box is where you select the Master 
Dynamos within   selected Dynamo Sets you want to convert with the 
Dynamo Converter Wizard.   Only one Master Dynamo can be selected 
for conversion.

Select All/Clear All Not available.
Current Picture Path Click the button next to this field to select a path containing the   pic-

tures you want to convert.
Pictures List Box Displays the pictures that exist in the Current Picture Path. The Pic-

tures   list box is where you select the pictures and group objects you 
want to   convert with the Dynamo Converter Wizard.

Pictures Select 
All/Clear All

Click either the Select All button or the Clear All button to quickly   
select or de-select all the pictures and group objects in the Pictures   
List Box.

View Settings Tab

The View Settings tab displays the options that have been selected from   the Convert Behavior, Convert 
Options, and Select Dynamos tabs.

Back/Next Buttons

Click the Back or Next buttons to navigate back and forth between tabs.   Alternatively, you can click on 
a tab directly.

Run Convert Button

After you have selected one Master Dynamo and at least one group object   in the picture in the Select 
Dynamos Tab, the Run Convert button becomes   available. Click the Run Convert button to begin the 
conversion process.   

Dynamo Converter Dialog Box

The Dynamo Converter Progress dialog box displays the   following items:

Quick Dynamo Report for Conversion

Item Description
Selected Group 
Objects to convert 
–   List Box

Displays the group objects that were found to not   be Dynamos. This 
list is generated from the Quick Dynamo Converter dialog   box or the 
Dynamo Converter Wizard dialog box.

Selected Group 
Objects to convert 

Displays the name, object description, dynamo description,   revision, 
file name, and full name of the Dynamo and Master Dynamo asso-
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–   Table ciated   with the selected Dynamo.

Convert Group Objects

Item Description
Convert Behavior Displays the currently selected behavior that the   Dynamo Converter 

should use when the number of data sources differs between   a Master 
Dynamo and Dynamo.

Modify Click the Modify button to change the conversion behavior.
Maintain Size Select to retain the current size of the Dynamo Instance.
Maintain Captions Select to retain existing captions for all Dynamos.
Conversion Pro-
gress Status

Graphically displays the progress of the Dynamo conversion   process.

Conversion Pro-
gress Status –   Log 
Display

Displays the date, time, and status of each Dynamo   and Master 
Dynamo conversion attempted as part of the automated Dynamo   con-
version process.

Run Conversion

Launches the conversion process, which converts legacy Dynamos into   Dynamo objects. Conversions 
are made based on the Convert Behavior setting.

NOTE: While the   conversion process is running, the Run Conversion button changes to a   Cancel Conversion 
button, allowing you the option of canceling the conversion   while it is in progress.

Dynamo Updater Wizard 

The Dynamo Updater Wizard dialog box displays the following items:

Update Behavior Tab

The Update Behavior tab lets you set how Dynamos are handled when the   number of data sources in a 
Master Dynamo and a Dynamo Instance Object   do not match. You can select from the following 
options:

Item Description
Update Dynamo, 
and use Master 
Dynamo data 
sources

If you want to update mismatched Dynamo Instances, but do not want 
to   apply any of the data sources from the Dynamo Instance. This option 
uses   all data sources from the Master Dynamo, and no data sources 
from the   Dynamo Instance.

Update Dynamo, 
and try to match up 
data sources

If you want to update mismatched Dynamo Instances using data 
sources   from the Dynamo Instance and a best guess matching 
algorithm.

For example, if a Master Dynamo object contains only one data source   
(user prompt) based on an animation, but a previous version (an instance   
of that Dynamo) includes three data sources based on animations, a 
best   guess match is made. For the best guess, iFIX decides which one 
of the   three data sources to use in the instance, and a report is generated 
based   on your settings.
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If the object type differs between the Master Dynamo and the Instance,   
there is no attempt to update the data sources in the animation for that   
object.

Do not update 
Dynamo

If you only want to view a report of mismatched Dynamos and make no   
actual updates.

Prompt for choice If you want a prompt to display with your options each time a mis-
matched   Dynamo is found. This option is the default.

Update Options Tab

Item Description
Save Status Trail 
Check Box

Select this check box to save a text log of the Dynamo Updater's 
activities.   If you do not check this box, the rest of the options on the 
Update Options   Tab is unavailable.

Save Status Trail Edit 
Box

Specify a folder, path, and file name for the Dynamo Updater's log 
file,   or click the Save Status Trail Browse button to select a file loc-
ation.

Save Status Trail 
Browse Button

Click this button to select a path and filename for the Dynamo 
Updater's   log file.

Append/Overwrite 
Options

Choose Append or Overwrite to either append the new results to the 
existing   status trail log, or overwrite the log file with the new results. 
If no   log exists, either option will create a new status trail log file.

Select Dynamos Tab

Item Description
Current Dynamo 
Set Path

Click the button next to this field to select a path containing the   
Dynamo Sets you want to update.

Dynamo Sets List 
Box

The Dynamo Sets List Box displays the Dynamo Sets that exist in the   
Current Dynamo Set Path. You can expand Dynamo Sets to display 
the individual   Dynamos contained in each Dynamo Set. The Dynamo 
Sets List Box is where   you select the Dynamos or Dynamo Sets you 
want to update with the Dynamo   Updater Wizard.

NOTE: The Dynamo   Updater Wizard does not support dynamos with 
Enhanced Charts.

Dynamo Sets 
Select All/Clear All

Click either the Select All button or the Clear All button to quickly   select 
or de-select all the Dynamos in every listed Dynamo Set.

Current Picture 
Path

Click the button next to this field to select a path containing the   pictures 
you want to update.

Pictures List Box The Pictures List Box displays the pictures that exist in the Current   Pic-
ture Path.  The   Pictures List Box is where you select the pictures you 
want to update   with the Dynamo Updater Wizard.

Pictures Select 
All/Clear All

Click either the Select All button or the Clear All button to quickly   select 
or de-select all the pictures in the Pictures List Box.
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View Settings Tab

The View Settings tab displays the options that have been selected from   the Update Behavior, Update 
Options, and Select Dynamos tabs.

Back/Next Buttons

Click the Back or Next buttons to navigate back and forth between tabs.    Alternatively,   you can click on 
a tab directly.

Launch Updater Button

After you have selected at least one Dynamo and one picture in the Select   Dynamos Tab, the Launch 
Updater button becomes available. When you click   the Launch Updater button, the Dynamo Updater 
Wizard examines the selected   Dynamos and pictures and opens the Dynamo Updater dialog box, where 
you   can update mismatched Dynamo Instances and Master Dynamo revisions according   to the options 
you have set.

Dynamo Updater Dialog Box

The Dynamo Updater dialog box displays the following items:

Quick Dynamo Report

Item Description
Dynamo Instances 
Mismatched With 
Revision Of Master   
Dynamo –   List Box

Displays the Dynamo Instances that were found to be   a different revi-
sion from their associated Master Dynamo. This list is   generated from 
the Quick Dynamo Updater dialog box or the Dynamo Updater   Wizard 
dialog box.

Dynamo Instances 
Mismatched With 
Revision Of Master   
Dynamo –   Table

Displays the name, object description, dynamo description,   revision, 
file name, and full name of the Dynamo Instance and Master Dynamo   
associated with the Dynamo selected in the mismatch list.

Update Dynamo Instances

Item Description
Update Behavior Displays the currently selected behavior that the   Dynamo Updater 

should use when the number of data sources does not match   between 
a Master Dynamo and Dynamo Instance.

Modify Click the Modify button to change the Update Behavior.
Maintain Size Select to retain the current size of the Dynamo Instance.   
Maintain Captions Select to retain existing captions for all Dynamo   Instances.
Update Progress 
Status

The Update Progress Status bar graphically displays   the progress of 
the Dynamo Update process.

Update Progress 
Status –   Log Dis-
play

Displays the date, time, and status of each Dynamo   Instance and 
Master Dynamo modification attempted as part of the automated   
Dynamo Update process.
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Run Update

Launches the update process, which reconciles the revision differences   between associated Dynamo 
Instances and Master Dynamos. Updates are made   based on the Update Behavior setting.

NOTES:

 l While the update process   is running, the Run Update button changes to a Cancel Update button, 
allowing   you the option of canceling the update while it is in progress.

 l The Dynamo Updater does   not support dynamos with Enhanced Charts.

 

Dynamo Updater –   Update Behavior Dialog Box

The Dynamo Updater –   Update Behavior dialog box displays the following items:

Data Source Adjustments

The Data Source Adjustments area lets you specify how the Dynamo Updater   should reconcile a data 
source mismatch between a Master Dynamo and Dynamo   Instance. Select one of the following options:

 l Update   the Dynamo, and use Master Dynamo data sources –   If you want to update mis-
matched Dynamo Instances, but do not want to   apply any of the data sources from the Dynamo 
Instance. This option uses   all data sources from the Master Dynamo, and no data sources from 
the   Dynamo Instance.

 l Update   the Dynamo and try to match up the Data Sources   – If   you want to update mis-
matched Dynamo Instances using data sources from   the Dynamo Instance and a best guess 
matching algorithm.

For example, if a Master Dynamo object contains   only one data source (user prompt) based on an 
animation, but a previous   version (an instance of that Dynamo) includes three data sources 
based   on animations, a best guess match is made. For the best guess, iFIX decides   which one of 
the three data sources to use in the instance, and a report   is generated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no attempt to 
update the data sources   in the animation for that object.

 l Do   not update Dynamo – If you only   want to view a report of mismatched Dynamos and make 
no actual updates.

Apply

Applies the selected adjustment option to a single Dynamo object in   the update.

Apply to All

Applies the selected adjustment option to all Dynamo objects in this   update.

Overwrite Master Dynamo Dialog Box

The Overwrite Master Dynamo dialog box displays the following items:
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Name

A read-only field that displays the Dynamo name for informational purposes.   You cannot edit this field. 

Dynamo ID

A read-only field that displays the Dynamo ID for informational purposes.   You cannot edit this field. 

Description

A read-only field that displays the Dynamo Instance description for   informational purposes. You cannot 
edit this field. 

Overwrite the Existing Master Dynamo

Select this option to overwrite the existing Master Dynamo with the   updated one. The Dynamo ID does 
not change when you overwrite the Master   Dynamo and your links to existing Dynamos remain.

Create a New Master Dynamo

Optionally, specify a description of the object in this field. A new   Dynamo ID is generated, and your links 
to existing Dynamos Instances no   longer exist.

 

Quick Dynamo Updater Dialog Box

The Quick Dynamo Updater dialog box displays the following items:

Dynamos on Active Picture

Allows you to search Dynamo objects only in the active picture.

Dynamos on All Open Pictures

Allows you to search Dynamo objects in all open pictures.

 

Quick Dynamo Converter Dialog Box

The Quick Dynamo Converter dialog box displays the   following items:

Select Dynamo Sets

Allows you to select the Dynamo Set to convert.

Select Master Dynamo

Allows you to select the Master Dynamo.

Select Group Object(s)

Allows you to select which group objects to convert to Dynamo objects.   Your choice is selected on the 
active picture.
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Get Selected Group Object(s) on active picture

Propagates the object selected on the picture to the Select Group Object(s)   list.

NOTE: The object(s)   must be selected on picture prior to clicking this button.

Clear All Selection

Clears all items selected in the Select Group Object(s) list.

Run Convert

Launches the conversion process, which converts old Dynamos (group objects)   into Dynamo objects. 
Conversions are made based on the Convert Behavior   settings.

How Do I...

The following sections provide information on how to work with Dynamo   objects:

 l Opening   the Dynamo Toolbar

 l Working   with Dynamo objects

 l Working   with Dynamo properties

 l Working   with Master Dynamos and Instances

 l Working   with Dynamo Sets

 

Opening the Dynamo Toolbar

 To open the Dynamo   toolbar:

 1. In the iFIX WorkSpace   system tree, double-click the Project Toolbar Files item to open the folder.

 2. Double-click the   Toolbars folder to view a list of toolbars.

 3. Double-click the   DynamoToolbar icon to open the Dynamo Toolbar. The six-button Dynamo Tool-
bar   now appears in the WorkSpace. 

 

Working with Dynamo Objects

The following sections describe tasks that you can perform when working   with Dynamo objects:

 l Creating   a Dynamo Object

 l Creating   a Dynamo with User Prompts

 l Displaying   One Dynamo User Prompt for Multiple Dynamo Object Properties

 l Displaying   No User Prompts for a Dynamo Object with Animations

 l Defining   Partial Substitution for a Dynamo's Property Values
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 l Modifying   Dynamo User Prompts

 l Applying   User Prompts for Command Scripts

 l Generating   a Report of Dynamo Usage in the Cross Reference Tool

 

Creating a Dynamo Object in a Picture

 To create a Dynamo   object in a picture:

 1. In the iFIX WorkSpace,   select the custom object or group of objects that you want to convert   to a 
Dynamo.

 2. In Classic view,   on the Dynamo toolbar, click the Build Dynamo  button. 

-Or-

In Ribbon view, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Build 
Dynamo. 

-Or-

Right-click the selected objects and choose   Dynamo.

 l If the custom   object properties are not animated or set to specific values, the Build   
Dynamo Wizard dialog box appears, allowing you to name the Dynamo, and   provide 
descriptions for the Dynamo and object.

 l If the object   properties are animated, the Build Dynamo with User Prompts dialog box   
appears. For more information, refer to the Creating   a Dynamo with User Prompts section.

 3. In the Dynamo Name   field, enter the name you want use for this Dynamo.

 4. Optionally, in the   Dynamo Description field, enter a description for this Dynamo. 

 5. Optionally, in the   Object Description field, enter a description for this object. 

 6. Click OK.

TIP:   When you first create a Dynamo in the WorkSpace, it is not a Master Dynamo.   If you immediately 
want to create a Master Dynamo object(s), instead of   using the Build Dynamo Wizard, drag-and-drop 
the object(s) to a Dynamo   set. The Add Object to Dynamo Sets dialog box appears for each object.   
Select the Create a New Master Dynamo option in each dialog box, and click   OK. These actions cre-
ate the Dynamo object(s) and add them to the set   as a Master Dynamo(s). Or, you can create the 
Dynamo object, and then   drag-and-drop it into the Dynamo Set to create a new Master Dynamo.

 

Creating a Dynamo Object with User Prompts within a Picture

 To create a Dynamo   object with user prompts within a picture:

 1. In the iFIX WorkSpace,   within a picture, select the custom object or group that you want to con-
vert   to a Dynamo.

 2. In Classic view,   on the Dynamo toolbar, click the Build Dynamo  button. 

-Or-
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In Ribbon view, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Build 
Dynamo. 

-Or-

Right-click the selected objects and choose   Dynamo. 

NOTE:   You must have an object with at least one animation for the Build Dynamo   with User Prompts 
dialog box to appear. Otherwise, the generic Build Dynamo   Wizard dialog box appears, requesting 
only a name.

 3. In the Dynamo Name   field, enter the name you want use for this Dynamo.

 4. Optionally, in the   Dynamo Description field, enter a description for this Dynamo.

 5. Optionally, in the   Object Description field, enter a description for this object. 

 6. In the User Prompt   field, for each object property, enter a prompt to display in the Dynamo   User 
Interface that the Build Dynamo Wizard creates.

The prompt can be up to 127 characters long.   Surround the prompt with brackets if you are using 
partial   substitution. Use asterisks (*) for static values. If you do not enter   a User Prompt, the 
Build Dynamo Wizard uses the property name of the animation   for that object property, and no 
prompt appears. If you want to ensure   that the same prompt is used across multiple properties, 
make sure that   all prompts match. For more information, refer to the Displaying   One Dynamo 
User Prompt for Multiple Object Properties section.

 7. Click OK.

 8. To test your Dynamo   User Interface, double-click the Dynamo. The Dynamo Properties dialog   
box with User Prompts appears.

TIP:   When you first create a Dynamo in the WorkSpace, it is not a Master Dynamo.   If you immediately 
want to create a Master Dynamo object(s), instead of   using the Build Dynamo Wizard, drag-and-drop 
the object(s) to a Dynamo   set. The Add Object to Dynamo Sets dialog box appears for each object.   
Select the Create a New Master Dynamo option in each dialog box, and click   OK. These actions cre-
ate the Dynamo object(s) and add them to the set   as a Master Dynamo(s). Or, you can create the 
Dynamo object, and then   drag-and-drop it into the Dynamo Set to create a new Master Dynamo.

 

Displaying One Dynamo User Prompt for Multiple Dynamo Object Properties

 To display one   Dynamo user prompt for multiple Dynamo object properties:

In the Build Dynamo with User Prompts dialog   box, for each Dynamo property, enter the same 
value in the User Prompt   field. 

For example, enter Tagname   for the User Prompt if you want the Tagname to be the same for all 
three   properties, as shown in the following table.

Object Property Current Setting User Prompt
Oval1.VerticalPosition FIX32.MYNODE.MYTAG.F_CV Tagname
Rect1.VerticalFillPercentage FIX32.MYNODE.OTHERTAG.F_CV Tagname
Oval2.HorizontalPosition FIX32.MYNODE.MYTAG.F_CV Tagname

 

Displaying No User Prompts for a Dynamo Object with Animations

534 © 2024 General Electric Company. All rights reserved.



 To display no   user prompts for a Dynamo object with animations:

In the Build Dynamo with User Prompts dialog   box, for each Dynamo property, do not enter a 
value in the User Prompt   field. 

 

Defining Partial Substitution for a Dynamo's Property Values

 To define partial   substitution for a Dynamo's property values:

 1. In the iFIX WorkSpace,   select the custom object or group that you want to convert to a Dynamo.

 2. In Classic view,   on the Dynamo toolbar, click the Build Dynamo  button. 

-Or-

In Ribbon view, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Build 
Dynamo. 

NOTE:   You must have an object that supports animations for the Build Dynamo   with User Prompts dia-
log box to appear. Otherwise, the generic Build Dynamo   Wizard dialog box appears, requesting only a 
name.

 3. Optionally, in the   Dynamo Description field, enter a description for this Dynamo. 

 4. Optionally, in the   Object Description field, enter a description for this object. 

 5. In the User Prompt   field(s), enter the User Prompt surrounded by brackets {} and use asterisks   (*) 
for static values.

 6. Click OK.

Applying User Prompts for Command Scripts

To do this, for each command script, add a Variable object to the Dynamo   group and change the com-
mand script parameter as described in the example   below.

 To apply user   prompts for command scripts:

NOTE:   The following steps assume you have the command script: ToggleDigitalPoint   
“FIX32.NODE.TAG.F_CV” on the click event of an oval.

 1. Create a local variable   object (for example, call it MyVar). Set the Variable Type to String.   Do not 
assign it a data source.

 2. Right-click the object,   and click Property Window on the shortcut menu. Set the InitalValue prop-
erty   to a value such as FIX32.NODE.TAG.F_CV.

 3. In the WorkSpace   system tree, select the variable object and drag it to the Dynamo Set   group.

 4. Right-click the oval,   and click Edit Script on the shortcut menu.

 5. Modify the oval's   click event script from ToggleDigitalPoint “FIX32.NODE.TAG.F_CV” to 
ToggleDigitalPoint   MyVar.InitialValue.

 6. On the Dynamo toolbar,   click the Build Dynamo button. The Build Dynamo with User Prompts 
dialog   box appears.
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 7. Enter a User Prompt   for MyVar.InitialValue. This allows the user to change the parameter for   the 
ToggleDigitalPoint command by changing the value of the variable.

 8. Click OK.

 

Generating a Report of Dynamo Usage in the Cross Reference Tool

 To generate a   report of Dynamo objects:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. Generate a report   with the Quick Report or Report Wizard.

To generate a report with the Quick Report:

 a. From the File   menu, select Quick Report. T 

 b. From the Object   Tree, select a picture or a Dynamo Set. This allows you to search a 
single   picture for Dynamos, or all pictures containing Dynamos within a specified   set. 

 c. Select the Dynamos   Option. Click Search.

- Or -

To generate a report with the Report Wizard:

 a. From the   Tool menu, select Report Wizard. 

 b. Select the   Dynamos in Pictures or Pictures Containing Dynamos option. 

 c. On the Pictures   tab, select the Pictures that you want to search. 

 d. On the Dynamo   Sets tab, select the Dynamo Sets that you want search for. 

 e. Click OK.

If you did not earlier select the prompt   to refrain from a reminder message, a message box 
appears indicating that   you cannot access the iFIX WorkSpace when the Cross Reference Tool 
is   running. 

 3. Click OK to continue.   Wait a few moments for the report to generate in the Cross Reference Tool.

NOTE:   You cannot access the iFIX WorkSpace while the Cross Reference   Tool generates a report. 
After the report completes, you are able to access   the iFIX WorkSpace again.

 4. When the update is   complete, review the report. 

TIP:   You can export the report to a .csv, .htm, .xls, or .tb2 file. On the   File menu, click Save to open the 
Save As dialog box.

Working with Dynamo Properties

The following sections describe tasks that you can perform when working   with Dynamo properties:
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 l Changing   a Dynamo Object's Properties

 l Changing   a Dynamo Object's User Prompt Properties

 l Changing   a Dynamo's Properties from Another Object

 l Converting   a Dynamo to Objects

 

Changing a Dynamo Object's Properties

 To change a Dynamo   object's properties:

 1. In the iFIX WorkSpace,   in a picture or Dynamo Set, right-click the Dynamo object (Instance or   
Master) and select Property Window. The Property window appears in the   WorkSpace.

NOTE:   If you double-click a Dynamo, a dialog box does not display. Instead,   the VBA Editor appears. 
You must right-click the Dynamo object to view   the properties. 

 2. For each Dynamo object,   provide property updates as needed. The Dynamo-specific properties 
include:

 l Dynamo   ID –   You cannot edit this field; it is a system assigned, unique value. This   value 
is a Globally Unique Identifier (GUID). If you have not dragged   the Dynamo Instance to a 
Dynamo Set to create a Master Dynamo, this number   is a series of zeros. 

 l Dynamo   Description –   Enter a new description. The Dynamo Description can be dif-
ferent for each   Dynamo Instance. The maximum number of characters you can enter in 
this   field is displayed in the Max_Dynamo_Desc_Length field.

 l Master   –   You cannot edit this field; it is a system assigned value.

 l Max_Dynamo_Desc_Length   – You   cannot edit this field; it is a system assigned value of 
256 characters.   This limit is used by the Dynamo Description field.

 l Revision   – You   cannot edit this field; it is a system assigned number for the revision.

Other properties can be updated as well,   but be aware you should use caution when updating 
Master Dynamos this   way. Refer to the Updating a Master   Dynamo section for steps on how to 
properly update other properties   for a Master Dynamo and the objects within it.

NOTE:   Alternatively, you can select the Master Dynamo or Dynamo Instance object,   and on the 

Dynamo toolbar, click the Build Dynamo  button   to open the Build Dynamo or Build Dynamo with 
User Prompts dialog box.   This dialog box provides a way to access only the Dynamo properties. 

 

 

Changing a Dynamo Object's User Prompt Properties

 To change a Dynamo   object's user prompt properties:

 1. In the iFIX WorkSpace,   within a picture, double-click the Dynamo object (the Dynamo Instance).   
The Dynamo Properties dialog box appears.

 2. For each Dynamo property,   enter an appropriate data source.
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If necessary, use the scroll bar to page   through the list. If you are entering a tagname, you can 
launch the Expression   Builder by clicking the Browse (...) button to select from a list of tags.

 3. Select OK to accept   the data sources.

TIPS:

 l You can add a new tag   by entering it in the Current Setting field and pressing Tab to move the   
cursor off the field. A dialog box appears allowing you to create the   tag.

 l You can modify a tag   by entering the tagname in the Current Setting field and clicking the   
Quick Modify button to the right of the field.

 

Changing a Dynamo's Properties from Another Object

The following example demonstrates how to configure a Dynamo's properties   from another object's edit 
event in configuration mode or click event   in run mode.

Using a Dynamo named Dynamo2 that has a User Prompt named “Rect Fill,”   the following example dis-
plays the original value of the property in a   message box and on the click of the message box OK button. 
It also changes   the value and displays the new value in a message box.

 To change a Dynamo's   properties from another object:

 1. On the Click event   of a Command button, enter the following code:
Private Sub CommandButton1_Click()
Dim x As String
 
'Creates an instance of the Dynamo Properties form
GetFormEditDynamo
 
'Initialize the data type array with the Dynamo2 Dynamo information, and the User Prompt 'whose Value you are looking to change.
NewEditDynamoForm.Initialize Dynamo2, "Rect Fill"
 
' Get the Dynamo prompts value
x = NewEditDynamoForm.DynamoPromptValue
 
'display a message box with that value
MsgBox x
 
'Set the new Prompt Value then re-initialize the Dynamo.
'If you do not re-initialize the Dynamo
'the old Value will be retrieved.
NewEditDynamoForm.DynamoPromptValue = "FIX32.MYNODE.RAMP.F_CV"
'Re-initialize the array
NewEditDynamoForm.Initialize Dynamo2, "Rect Fill"
 
'Get the Dynamo Prompt Value again
x = NewEditDynamoForm.DynamoPromptValue
 
MsgBox x 'display a message box with the new value

 2. Switch to run mode   and click on the command button. The first message box displays the current   
data source for the Dynamo “Rect Fill” property.

 3. Click OK. The second   message box displays the new data source for the Dynamo “Rect Fill”.

 

Converting a Dynamo to Objects
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 To convert a   Dynamo to objects:

 1. In the picture, select   the Dynamo object.

 2. Right-click the Dynamo   object, and select Convert to Objects. The Dynamo attribute is removed   
and the objects return to their original state. You can now make changes   to individual object prop-
erties.

 3. Remove EasyDynamo   variables.

In the WorkSpace System Tree, if an object   has a + icon next to it, click the icon. The animation 
object displays.   If the animation object has a + icon next to it, click the icon. If the   animation 
object contains an EasyDynamo variable, delete the EasyDynamo   variable.

Working with Master Dynamos and Instances

The following sections describe tasks that you can perform when working   with Master Dynamos and 
Dynamo Instances:

 l Creating   a Master Dynamo

 l Adding   a Dynamo Instance to a Picture

 l Modifying   the User Prompts of a Dynamo Instance

 l Modifying   the User Prompts of a Master Dynamo

 l Converting   Dynamos Using the Quick Dynamo Converter

 l Converting   Dynamos Using the Dynamo Converter Wizard

 l Converting   Dynamo Sets Using the Dynamo Sets Converter

 l Updating   a Master Dynamo

 l Updating   Dynamo Instances Using the Quick Dynamo Updater

 l Updating   Dynamo Instances Using the Dynamo Updater Wizard

 l Updating   Dynamo Instances Using the Cross Reference Tool

 l Changing   Dynamo Instance Update Options

 

Creating a Master Dynamo

 To create a Master   Dynamo:

 1. Create a Dynamo object.   Use the steps in either section:

 l Creating   a Dynamo (without Animations that include User Prompts)

 l Creating   a Dynamo with User Prompts

 2. Open a Dynamo Set.   For details, refer to the Opening   Dynamo Sets section.

 3. Drag-and-drop or   copy and paste the Dynamo object(s) you created into the Dynamo Set. The   
Dynamo object automatically becomes a Master Dynamo.

NOTES:
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 l Alternatively,   if you did not create a Dynamo object yet, you can still drag-and-drop   the object
(s) to the set. The Add Object to Dynamo Sets dialog box appears   for each object you add. 
Select the Create a New Master Dynamo option   and click OK in each dialog box that appears. 
These actions create the   Dynamo object(s) and add them to the set as a Master Dynamo(s). If 
you   want to change the Dynamo description, object description, or name, you   must edit the 
Dynamo properties separately.

 l When a group   containing Dynamo objects is promoted to a Master Dynamo, as in the case   
when it is dragged and dropped into a Dynamo Set, the contained Dynamo   objects (instances) 
are converted to standard group objects. A message   prompts you about this occurrence, and 
allows you to cancel the operation.

 4. Save the Dynamo Set.   

 5. Delete   the original Dynamo object from step1, since this Dynamo object is not   an instance of the 
Master Dynamo. 

The Dynamo object in step 1 is not connected   to the Master Dynamo created in step 4. If you 
look at the Dynamo_ID in   the Property window, you will notice that the number for the original   
Dynamo is all zeros and does not match the Master Dynamo. This means that   it contains no links 
to the master. Only Dynamo Instances that you add   after you create the Master Dynamo   are con-
nected to the Master Dynamo.

TIP:   If you want the original picture to include an instance of the Master   Dynamo, drag-and-drop or 
copy and paste the Master Dynamo object from   the Dynamo set back to the picture that you created 
the original Dynamo   object in. 

 

Adding a Dynamo Instance to a Picture

 To add a Dynamo   Instance to a picture:

 1. Open a Dynamo Set.   For details, refer to the Opening   Dynamo Sets section.

 2. From the Dynamo Set,   drag-and-drop or copy and paste the Master Dynamo object into the pic-
ture.   

Each new Dynamo object that you add to a   picture (not a Dynamo Set) becomes a new Dynamo 
Instance. 

NOTE:   Pre-built Dynamos and Dynamos created in versions of iFIX before 4.5 are   not considered 
Dynamo objects. You cannot update these Dynamos like you   can with Master Dynamo objects.

 

Modifying the User Prompts of a Dynamo Instance

 To modify the   user prompts of a Dynamo Instance:

 1. In the iFIX WorkSpace   picture, select the Dynamo object.

 2. In Classic view,   on the Dynamo toolbar, click the Build Dynamo  button. 

-Or-

In Ribbon view, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Build 
Dynamo. 
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User Prompts appear in brackets, { }. If   the User Prompt has partial substitution, the User Prompt 
appears in brackets,   while static values are represented as asterisks.

 3. In the User Prompt   fields, modify the entries as necessary. You can delete the brackets when   
modifying User Prompts.

 4. Click OK.

 5. To test your changes,   double-click the Master Dynamo object to view the Dynamo Properties dia-
log   box and observe the Dynamo Properties column.

 

Modifying the User Prompts of a Master Dynamo

 To modify the   user prompts of a Master Dynamo:

IMPORTANT: The   only way to modify the user prompts of a Master Dynamo is by manually   editing them 
through the Properties Window, as described below. Do not   try to modify the user prompts by using the Build 
Dynamo wizard. The Build   Dynamo wizard only creates a new Master Dynamo and breaks the connection   
between the selected Master Dynamo and any Instances. 

 1. In the iFIX WorkSpace   system tree, browse to the Dynamo Sets folder. Double-click the folder   
name to view the contents.

 2. In the Dynamo Sets   folder, locate the Dynamo Set and Master Dynamo that you want to update.

 3. Using the plus (+)   symbol, expand the item to locate the Lookup table and view the Easy 
Dynamo   variable.

 4. Right-click the EasyDynamo   variable that contains the user prompts that you want to update and 
select   Property Window. The Properties window appears.

 5. In the CurrentValue   field, enter the current value of the user prompt between the quotation   marks 
and the brackets, { }. For example, here you would edit the text   MyPrompt to change the user 
prompt text:
ForegroundColor.Blink="{MyPrompt}"

 6. Likewise, in the   InitialValue field, enter the initial value for the new user prompt between   the quo-
tation marks and the brackets.

 7. After you finish   your changes, save the Dynamo Set.

 

Converting Dynamos Using the Quick Dynamo Converter 

 To convert a   legacy Dynamo,or a Dynamo created before iFIX 4.5, using the Quick Dynamo   Converter:

 1. Open the following:

 l the picture(s)   you want to convert

 l the Dynamo set   to use for the conversion. 

 2. Make sure that your   picture is active.

 3. In Classic view,   on the Dynamo toolbar, click the Quick Dynamo Converter button. 

-Or-
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In Ribbon View, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Quick 
Dynamo Converter. 

 4. Select the Dynamo   Sets.

 5. Select the Master   Dynamo. The selected Master Dynamo is highlighted in the Dynamo Set.

 6. Select the Group   Object(s).

 7. Click Run Convert.   After a few moments, the Dynamo Converter dialog box displays with an   on 
screen report of the conversion.

 8. Click Run Conversion   to complete the conversion. A Dynamo Caution message box appears if 
you   did not select the prompt to hide it.

 9. Click OK to continue.   The progress of the conversion displays in the Status area. If you selected   
the "Prompt for Choice" option, and any data sources or contained   object structures are mis-
matched between the Master Dynamo and the legacy   Dynamos, the Dynamo Converter - Con-
version Adjustment Option dialog box   appears.

 10. If the Dynamo Converter   - Conversion Adjustment Option dialog box appears, select an option 
and   click Apply:

 l Convert   to Dynamo but do not update Dynamo –   If you want to convert the Dynamo 
to a Dynamo object, but do not want   to link it to the Master Dynamo. Use this option if you 
want to use this   Dynamo to create a new Master Dynamo.

 l Convert   to Dynamo, then update Dynamo   – If   you want to convert the Dynamo to a 
Dynamo object, and want to link it   to the Master Dynamo. 

 l Do   not convert to Dynamo – If you only   want to view a report of mismatched Dynamos 
and make no actual conversions   of mismatched Dynamos. Dynamos that are not mis-
matched are converted.

 11. Repeat step 10 each   time the Dynamo Converter - Conversion Adjustment Option dialog box 
appears.   This allows you to approve each Dynamo object conversion individually.   Otherwise, 
select an option and click Apply to All to use the same option   for all Dynamo object conversions, 
and review the report later.

 12. Review the report,   and click Close to exit.

NOTE: The   Quick Dynamo Converter does not save open pictures after conversion. If   you want to save the 
open pictures, you must do so manually.

Converting Dynamos Using the Dynamo Converter Wizard 

 To convert legacy   Dynamos,or Dynamos created before iFIX 4.5, using the Dynamo Converter   Wizard:

 1. In Classic view,   on the Dynamo toolbar, click the Dynamo Converter Wizard button. 

-Or-

In Ribbon View, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Dynamo 
Converter Wizard.   

 2. On the Convert Behavior   tab, select a conversion adjustment option:

 l Convert   to Dynamo but do not update Dynamo –   If you want to convert the Dynamo 
to a Dynamo object, but do not want   to link it to the Master Dynamo. Select this option if 
you want to use   this Dynamo to create a new Master Dynamo.
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 l Convert   to Dynamo, then update Dynamo   – If   you want to convert the Dynamo to a 
Dynamo object, and want to link it   to the Master Dynamo. 

 l Do   not convert to Dynamo – If you only   want to view a report of mismatched Dynamos 
and make no actual conversions   of mismatched Dynamos. Mismatched Dynamos are not 
converted.

 l Prompt   for Choice –   If you want a prompt to display options, each time a mismatched 
Dynamo   is found. The Prompt for Choice option is the default.

 3. Click Next.

 4. On the Convert Options   tab, if you want to create a log file of the conversion process: 

 a. Select the Save   Status Trail Info check box.

 b. If you want to   change the default path and file name, enter a path in the Path field.   

 c. To add to an   existing log file, select Append. 

-Or- 

To create a new one, select Overwrite.

 5. Click Next.

 6. On the Select Dynamos   tab, in the Dynamo Sets area, select a Master Dynamo that you want to   
use for the conversion process. 

 7. On the Select Dynamos   tab, in the Pictures area, select the pictures you want to search in.   

-Or-

Click Select All to select all pictures   and all contained group objects. 

NOTES:

 l The Dynamo   Converter Wizard allows you to select picture files whether the file is   open or 
closed. During the conversion process, the wizard opens picture   files and saves them on 
close. If a picture is already open, the wizard   does not save the picture file, and the file is kept 
open in the WorkSpace.   For these open pictures, you must manually close and save them.

 l If you are   using Change Management with iFIX, be aware that pictures need   to be checked out 
(even if closed), otherwise the Dynamo Converter Wizard   will not convert these files. If you do 
not check out the files, the picture   files in the Select Dynamos tab appear in red and you are 
unable to select   them.

 8. Click Next and, on   the View Settings tab, review your settings.

 9. Click Run convert.   After a few moments the Dynamo Converter Progress dialog box appears 
with   a report of the Dynamos to convert.

NOTES:

 l If no Master   Dynamo or legacy Dynamos from your selection require conversion, the Run   Con-
version button is unavailable. 

 l You   can click a legacy Dynamo in the Quick Dynamo Report list to view its   name, description, 
revision number, and associated Master Dynamo information.

 10. Click Run Conversion.   A Dynamo Caution message box appears if you did not select the prompt   
to hide it.
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 11. Click OK to continue.   The progress of the conversion displays in the Status area. If there are   mis-
matched between the Master Dynamo and the legacy Dynamo, and you selected   the Prompt for 
Choice option in step 2, the Dynamo Converter - Conversion   Adjustment Option dialog box 
appears.

 12. If the Dynamo Converter   - Conversion Adjustment Option dialog box appears, select an option 
and   click Apply:

 l Convert   to Dynamo but do not update Dynamo –   If you want to convert the Dynamo 
to a Dynamo object, but do not want   to link it to the Master Dynamo. 

 l Convert   to Dynamo, then update Dynamo   – If   you want to convert the Dynamo to a 
Dynamo object, and want to link it   to the Master Dynamo. 

 l Do   not convert to Dynamo – If you only   want to view a report of mismatched Dynamos 
and make no actual conversions.

 13. Repeat step 12 each   time the Dynamo Converter - Conversion Adjustment Option dialog box 
appears.   This allows you to approve each Dynamo object conversion individually.   Otherwise, 
select an option and click Apply to All to use the same option   for all Dynamo object conversions, 
and review the report later.

After a few moments, the Dynamo Converter   dialog box displays with an on screen report of the 
conversion.

 14. Review the report,   and click Close to exit.

Converting Dynamo Sets Using the Dynamo Sets Converter

 To convert legacy   Dynamo Sets, or Dynamo Sets created before iFIX 4.5, using the Dynamo   Sets Converter:

NOTE:   If you are using Change Management with iFIX, be aware that pictures   need to be checked out 
(even if closed), otherwise the Dynamo Converter   Wizard will not convert these files. If you do not 
check out the files,   the picture files in the Select Dynamos tab appear in red and you are   unable to 
select them.

 1. In Classic view,   click the Convert Dynamo Sets button on the Dynamo toolbar. 

-Or-

In Ribbon View, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Convert 
Dynamo Sets. 

 2. Verify that the correct   path appears in the Dynamo Set Path field. If not, either use the browse   
button to locate the correct folder, or enter the path directly in the   Dynamo Set Path field.

 3. From the Dynamo Sets   list box, select the Dynamo Set(s) to convert, or choose Select All to   
select all Dynamo Sets.

 4. Click Convert. The   Dynamo Sets Converter Progress dialog box appears.

 5. Click Run Conversion.   The progress of the conversion displays in the Status area.

 6. Click Close.

 

Updating a Master Dynamo 
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 To update a Master   Dynamo:

 1. Open the Dynamo Set   that contains the Master Dynamo object that you want to update. For 
details,   refer to the Opening Dynamo   Sets section.

 2. In the Dynamo Set,   select the Master Dynamo object.

 3. Drag-and-drop the   Master Dynamo to an open picture.

NOTE:   While you can right-click a Dynamo from within the Dynamo Set and select   Dynamo Properties 
to edit overall Dynamo properties, you have limited   access to what you can edit within the Dynamo 
this way. Instead, we recommend   editing the Master Dynamo from an open picture, instead.

 4. If user prompts are   associated with the Dynamo object, the Dynamo Properties dialog box 
appears.   Enter the required information and click OK,

 5. In the picture, make   the required changes to the Dynamo object you just copied in. 

TIP:   To select a single object within a Dynamo object, with the Dynamo object   selected, on the right-
click menu, select the Enter Drill-down option.   A box appears around the group. Select the object in 
the group you want   to change and make your changes.

 6. When finished, deselect   the object and the group. The box disappears.

 7. Select the Dynamo   again, and drag-and-drop the Dynamo back to the same Dynamo Set. The 
Overwrite   Master Dynamo dialog box appears.

 8. Select Overwrite   the Existing Master Dynamo option.

NOTE:   If you select the Create a New Master Dynamo instead, all instances created   from the old 
Master Dynamo will no longer be linked to the new Master   Dynamo. And, a new Dynamo ID number 
will be generated.

 9. Click OK. The Master   Dynamo is updated in the Dynamo Set. You may need to scroll slightly to   
view the Master Dynamo in the Dynamo Set document. 

 10. If you want to update   the Dynamo Instances in your pictures so that they reflect the new settings   
in the Master Dynamo, use the steps in the following sections:

 l Updating   Dynamo Instances Using the Quick Dynamo Updater

 l Updating   Dynamo Instances Using the Dynamo Updater Wizard

 l Updating   Dynamo Instances Using the Cross Reference Tool

 

Updating Dynamo Instances Using the Quick Dynamo Updater

 To update mismatched   Dynamo Instances using the Quick Dynamo Updater:

 1. Open the picture(s)   you want to update. 

Additionally, you can select the specific   Master Dynamo(s) that you want to use to update the 
Dynamo Instances:

 l If you want to   use a single Dynamo, select the Master Dynamo in the Dynamo set. Only   
one Dynamo per Dynamo Set can be selected. When nothing is selected, all   Master 
Dynamos in the selected Dynamo Set are used for the update.

 l If you want to   use one Dynamo from more than one set, select the Master Dynamo in 
each   set. Only one Dynamo per set can be selected for the update. 
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 2. If you want to update   the Dynamos on a single picture, select the picture in the iFIX WorkSpace   
now. Click anywhere in the picture to ensure the title bar is active.   Otherwise, proceed to step 2 
to update all pictures.

 3. In Classic view,   on the Dynamo toolbar, click the Quick Dynamo Updater  button.   

-Or-

In Ribbon view, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Quick 
Dynamo Updater. 

 4. Select an update   option:

 l If you want to   update the Dynamo objects on a single, selected picture only, select the   
Dynamos on Active Picture option.   If no active pictures are selected in the WorkSpace 
(for instance, a Dynamo   set is selected instead), this option is unavailable. 

 l If you want to   update the Dynamo objects on all pictures, select the Dynamos   on All Open 
Pictures option.

 5. Click OK. After a   few moments, the Dynamo Updater dialog box displays with an on screen   
report of the update.

TIP:   You can click a Dynamo Instance in the Quick Dynamo Report list to view   its name, description, 
revision number, and associated Master Dynamo information.

 5. Click Run Update   to complete the update. A Dynamo Caution message box appears if you did   
not select the prompt to hide it.

 6. Click OK to continue.   The progress of the update displays in the Status area. If any data sources   
are mismatched between the Master Dynamo and the Dynamo Instances, the   Dynamo Updater - 
Update Behavior dialog box appears.

NOTE:   By default, Prompt for Choice is selected as the Update Behavior. You   can change the Update 
Behavior so that you will not be prompted to choose   an update action for each mismatched Dynamo 
Instance. For more information,   refer to the Changing Dynamo   Instance Update Options section.

 7. If the Dynamo Updater   - Update Behavior dialog box appears, select an option and click Apply:

 l Update   the Dynamo, and use Master Dynamo data sources –   If you want to update 
mismatched Dynamo Instances, but do not want to   apply any of the data sources from the 
Dynamo Instance. This option uses   all data sources from the Master Dynamo, and no 
data sources from the   Dynamo Instance.

 l Update   the Dynamo and try to match up the Data Sources   – If   you want to update 
mismatched Dynamo Instances using data sources from   the Dynamo Instance and a best 
guess matching algorithm.

For example, if a Master Dynamo object contains   only one data source (user prompt) 
based on an animation, but a previous   version (an instance of that Dynamo) includes three 
data sources based   on animations, a best guess match is made. For the best guess, iFIX 
decides   which one of the three data sources to use in the instance, and a report   is gen-
erated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no 
attempt to update the data sources   in the animation for that object.

 l Do   not update Dynamo – If you only   want to view a report of mismatched Dynamos and 
make no actual updates.
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 8. Repeat step 7 each   time the Dynamo Updater - Update Behavior dialog box appears. This allows   
you to approve each Dynamo object update individually. Otherwise, select   an option and click 
Apply to All to use the same option for all Dynamo   object updates, and review the report later.

 9. Review the report,   and click Close to exit.

NOTES:

 l The Quick Dynamo Updater   does not save open pictures after update.

 l The Quick Dynamo Updater   does not support dynamos with Enhanced Charts.

 

Updating Dynamo Instances Using the Dynamo Updater Wizard

 To update mismatched   Dynamo Instances using the Dynamo Updater Wizard:

 1. In Classic view,   on the Dynamo toolbar, click the Dynamo Updater Wizard  button.   

-Or-

In Ribbon view, on the Tools tab, in the   Dynamos group, click Dynamos, and then click Dynamo 
Updater Wizard. 

 2. On the Update Behavior   tab, select an update option:

 l Update   the Dynamo, and use Master Dynamo data sources –   If you want to update 
mismatched Dynamo Instances, but do not want to   apply any of the data sources from the 
Dynamo Instance. This option uses   all data sources from the Master Dynamo, and no 
data sources from the   Dynamo Instance.

 l Update   the Dynamo and try to match up the Data Sources   – If   you want to update 
mismatched Dynamo Instances using data sources from   the Dynamo Instance and a best 
guess matching algorithm.

For example, if a Master Dynamo object contains   only one data source (user prompt) 
based on an animation, but a previous   version (an instance of that Dynamo) includes three 
data sources based   on animations, a best guess match is made. For the best guess, iFIX 
decides   which one of the three data sources to use in the instance, and a report   is gen-
erated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no 
attempt to update the data sources   in the animation for that object.

 l Do   not Update Dynamo – If you only   want to view a report of mismatched Dynamos and 
make no actual updates.

 l Prompt   for Choice –   If you want a prompt to display with your options, each time a mis-
matched   Dynamo is found. This option is the default.

 3. Click Next.

 4. On the Update Options   tab, if you want to create a log file of the update process, select the   Save 
Status Trail Info check box, and enter a path in the Path field,   if you want to change the default 
path and file name. Select Append to   add to an existing log file, or Overwrite to create a new one.

 5. Click Next.
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 6. On the Select Dynamos   tab, in the Dynamo Sets area, select the Dynamos that you want to 
search   for. Click Select All to select all Dynamo Sets. 

 7. On the Select Dynamos   tab, in the Pictures area, select the pictures you want to search in.   Click 
Select All to select all pictures. 

The Dynamo Updater Wizard allows you to   select picture files whether the file is open or closed. 
During the update   process, the wizard opens picture files and saves them on close. If a   picture is 
are already open, the wizard does not save the picture file,   and the file is kept open in the 
WorkSpace.

If you are using Change Management   with iFIX, be aware that pictures needs to be checked out 
(even if closed),   otherwise the Dynamo Updater Wizard will not update these files. When   this 
happens, the picture files in the Select Dynamos tab appear in red   and you are unable to select 
them.

 8. Click Next and, on   the View Settings tab, review your settings.

 9. Click Launch Updater.   After a few moments the Dynamo Updater dialog box appears with a 
report   of the Dynamos to update.

NOTES:

 l The Dynamo   Updater Wizard does not support dynamos with Enhanced Charts.

 l If no Dynamo   Instances from your selection require updating, the Launch Updater button   is 
unavailable. 

 l You   can click a Dynamo Instance in the Quick Dynamo Report list to view its   name, descrip-
tion, revision number, and associated Master Dynamo information.

 10. Click Run Update.   A Dynamo Caution message box appears if you did not select the prompt   to 
hide it.

 11. Click OK to continue.   The progress of the update displays in the Status area. If any data sources   
are mismatched between the Master Dynamo and the Dynamo Instances, and   you selected the 
Prompt for Choice option in step 2, the Dynamo Updater   - Update Behavior dialog box appears.

 12. If the Dynamo Updater   - Update Behavior dialog box appears, select an option and click Apply:

 l Update   the Dynamo, and use Master Dynamo data sources –   If you want to update 
mismatched Dynamo Instances, but do not want to   apply any of the data sources from the 
Dynamo Instance. This option uses   all data sources from the Master Dynamo, and no 
data sources from the   Dynamo Instance.

 l Update   the Dynamo and try to match up the Data Sources   – If   you want to update 
mismatched Dynamo Instances using data sources from   the Dynamo Instance and a best 
guess matching algorithm.

For example, if a Master Dynamo object contains   only one data source (user prompt) 
based on an animation, but a previous   version (an instance of that Dynamo) includes three 
data sources based   on animations, a best guess match is made. For the best guess, iFIX 
decides   which one of the three data sources to use in the instance, and a report   is gen-
erated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no 
attempt to update the data sources   in the animation for that object.
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 l Do   not update Dynamo – If you only   want to view a report of mismatched Dynamos and 
make no actual updates.

 13. Repeat step 11 each   time the Dynamo Updater - Update Behavior dialog box appears. This 
allows   you to approve each Dynamo object update individually. Otherwise, select   an option and 
click Apply to All to use the same option for all Dynamo   object updates, and review the report 
later.

After a few moments, the Dynamo Updater   dialog box displays with an on screen report of the 
update.

 14. Review the report,   and click Close to exit.

 

Updating Dynamo Instances Using the Cross Reference Tool

 To update mismatched   Dynamo Instances using the Cross Reference Tool:

 1. In Classic view,   from the WorkSpace toolbar, click the Cross Reference Tool button. 

-Or-

In Ribbon view, on the Applications tab,   in the Utilities group, click Utilities, and then click Cross 
Reference   Tool. 

 2. Generate a report   with the Quick Report or Report Wizard.

To generate a report with the Quick Report:

 a. From the File   menu, select Quick Report. 

 b. From the Object   Tree, select a picture or a Dynamo Set. This allows you to search a 
single   picture for Dynamos, or all pictures containing Dynamos within a specified   set. 

 c. Select the Dynamos   Option. Click Search.

- Or -

To generate a report with the Report Wizard:

 a. From the   Tool menu, select Report Wizard. 

 b. Select the   Dynamos in Pictures or Pictures Containing Dynamos option. 

 c. On the Pictures   tab, select the Pictures that you want to search. 

 d. On the Dynamo   Sets tab, select the Dynamo Sets that you want search for. 

 e. Click OK.

If you did not earlier select the prompt   to refrain from a reminder message, a message box 
appears indicating that   you cannot access the iFIX WorkSpace when the Cross Reference Tool 
is   running. 

 3. Click OK to continue.   Wait a few moments for a report to generate in the Cross Reference Tool.

NOTE:   You cannot access the iFIX WorkSpace while the Cross Reference   Tool generates a report. 
After the report completes, you are able to access   the iFIX WorkSpace again.

 4. On the Tool menu,   select Dynamo Updater. The iFIX WorkSpace appears in the foreground and   
the Dynamo Updater dialog box appears.
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 5. In the Quick Dynamo   Report area, review the Dynamos to be updated and click Run Update. A   
Dynamo Caution message box appears if you did not select the prompt to   hide it.

TIP:   You can click a Dynamo Instance in the Quick Dynamo Report list to view   its name, description, 
revision number, and associated Master Dynamo information.

 6. Click OK to continue.   The progress of the update displays in the Status area. If any data sources   
are mismatched between the Master Dynamo and the Dynamo Instances, the   Dynamo Updater - 
Update Behavior dialog box appears.

NOTE:   By default, Prompt for Choice is selected as the Update Behavior. You   can change the Update 
Behavior so that you are not prompted to choose   an update action for each mismatched Dynamo 
Instance. For more information,   refer to the Changing Dynamo   Instance Update Options section.

 7. If the Dynamo Updater   - Update Behavior dialog box appears, select an option and click Apply:

 l Update   the Dynamo, and use Master Dynamo data sources –   If you want to update 
mismatched Dynamo Instances, but do not want to   apply any of the data sources from the 
Dynamo Instance. This option uses   all data sources from the Master Dynamo, and no 
data sources from the   Dynamo Instance.

 l Update   the Dynamo and try to match up the Data Sources   – If   you want to update 
mismatched Dynamo Instances using data sources from   the Dynamo Instance and a best 
guess matching algorithm.

For example, if a Master Dynamo object contains   only one data source (user prompt) 
based on an animation, but a previous   version (an instance of that Dynamo) includes three 
data sources based   on animations, a best guess match is made. For the best guess, iFIX 
decides   which one of the three data sources to use in the instance, and a report   is gen-
erated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no 
attempt to update the data sources   in the animation for that object.

 l Do   not update Dynamo – If you only   want to view a report of mismatched Dynamos and 
make no actual updates.

 8. Repeat step 7 each   time the Dynamo Updater - Update Behavior dialog box appears. This allows   
you to approve each Dynamo object update individually. Otherwise, select   an option and click 
Apply to All to use the same option for all Dynamo   object updates, and review the report later.

After a few moments, the Dynamo Updater   dialog box displays with an on screen report of the 
update.

 9. Review the report,   and click Close to exit.

 

Changing Dynamo Instance Update Options

 To change the   update options in Dynamo Updater dialog box:

 1. Update Dynamo Instances   using the:

 l Quick   Dynamo Updater

 l Dynamo   Updater Wizard

 l Cross   Reference Tool
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 2. When the Dynamo Updater   dialog box displays with an on screen report of the update, click 
Modify   to change the Dynamo Update options. The Data Sources Adjustment Options   dialog box 
appears.

 3. Select an update   option and click OK:

 l Update Dynamo,   and use Master Dynamo data sources

 l Update Dynamo,   and try to match up data sources

 l Do not update   Dynamo

 l Prompt for choice   (the default)

 4. Click Run Update   to complete the update. A Dynamo Caution message box appears if you did   
not select the prompt to hide it.

 5. Click OK to continue.   The progress of the update displays in the Status area. If any data sources   
are mismatched between the Master Dynamo and the Dynamo Instances, the   Dynamo Updater - 
Update Behavior dialog box appears.

 6. If the Dynamo Updater   - Update Behavior dialog box appears, select an option and click Apply:

 l Update   the Dynamo, and use Master Dynamo data sources –   If you want to update 
mismatched Dynamo Instances, but do not want to   apply any of the data sources from the 
Dynamo Instance. This option uses   all data sources from the Master Dynamo, and no 
data sources from the   Dynamo Instance.

 l Update   the Dynamo and try to match up the Data Sources   – If   you want to update 
mismatched Dynamo Instances using data sources from   the Dynamo Instance and a best 
guess matching algorithm.

For example, if a Master Dynamo object contains   only one data source (user prompt) 
based on an animation, but a previous   version (an instance of that Dynamo) includes three 
data sources based   on animations, a best guess match is made. For the best guess, iFIX 
decides   which one of the three data sources to use in the instance, and a report   is gen-
erated based on your settings.

If the object type differs between the Master   Dynamo and the Instance, there is no 
attempt to update the data sources   in the animation for that object.

 l Do   not update Dynamo – If you only   want to view a report of mismatched Dynamos and 
make no actual updates.

 7. Repeat step 6 each   time the Dynamo Updater - Update Behavior dialog box appears. This allows   
you to approve each Dynamo object update individually. Otherwise, select   an option and click 
Apply to All to use the same option for all Dynamo   object updates, and review the report later.

 8. Review the report,   and click Close to exit.

 

Working with Dynamo Sets

The following sections describe tasks that you can perform when working   with Dynamo Sets:

 l Opening   Dynamo Sets

 l Creating   New Dynamo Sets
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 l Adding   a Dynamo Object to a Set

 

Opening Dynamo Sets

 To open a Dynamo   set:

 1. In the iFIX WorkSpace   system tree, open the Dynamo Sets folder.

 2. Double-click the   set you want to open. A window opens with the Dynamo Set (.fds file) dis-
played.

TIP:   To create a new Dynamo Set to open, in the iFIX WorkSpace, on the Standard   toolbar, click the 
New Dynamo Set button. Add Dynamo objects to the blank   document to build the set. Each new 
Dynamo object that you add to the   set becomes a Master Dynamo. Save the Dynamo Set.

 

Creating New Dynamo Sets

 To create a new   Dynamo Set:

 1. In Classic view,   in the iFIX WorkSpace, on the Standard toolbar, click the New Dynamo Set   but-
ton. 

-Or-

In Ribbon view, click the WorkSpace button,   select New, and click Dynamo Set. 

 2. Add Dynamo objects   to the blank document to build the set. 

 

Adding a Dynamo Object to a Set

 To add a Dynamo   object to a Dynamo Set:

 1. In the iFIX WorkSpace,   open an existing Dynamo Set or create a new one.

 2. Drag-and-drop or   copy and paste the Dynamo object you created with the Build Dynamo Wizard   
into the Dynamo Set. 

If more than one object is selected, the   Add Object to Dynamo Sets dialog box appears.

 3. If the Add Object   to Dynamo Sets dialog box appears, select the Create a New Master Dynamo   
option and click OK. The Dynamo is added to the set as a Master Dynamo.

Each new Dynamo object that you add to the   set becomes a Master Dynamo. 

 4. Save the Dynamo Set.
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Using Key Macros 

You can create key macros in the iFIX Key Macro Editor (KeyMacroEditor.exe).   Key macros allow you 
to assign a key combination on the keyboard to a   specific action in the iFIX WorkSpace that you can 
execute in   operator displays at run time. You can use key macros to automate routine   tasks or to group 
multiple sequential tasks into one function. Some of   the functions that you can use key macros for 
include:

 l Customizing navigation   through pictures 

 l Initiating a backup   

 l Printing a report   

 l Acknowledging an   alarm 

 l Toggling a digital   point 

 l Controlling database   blocks 

 l Starting other applications   

You can associate key macros:

 l With shapes or Dynamo   objects inside an iFIX picture 

 l With iFIX pictures   

 l Across all pictures   

For example, you can use one key macro to acknowledge an alarm in a   display, and then other key mac-
ros to switch views between different pictures   of your plant. The key macro feature lets you add custom 
functionality   to objects within a single operator display, to the display itself, or   to all operator displays.

This chapter describes how to create and manipulate key macros in the   iFIX WorkSpace, using the Key 
Macro Editor. 

Do You Need Key Macros?

If the computers that your operators use are located in areas where   dust or liquids may be a problem, 
you may want to use key macros. If your   mouse risks getting wet or dirty, you probably won't want to 
use it on   the plant floor. With key macros your operators do not need to use a mouse.   Instead, your oper-
ators can use regular computer keyboards or heavy-duty   industrial keyboards, for instance, that are 
dust-protected and surface   waterproof. Industrial keyboards are used in applications at many phar-
maceutical   and medical facilities, clean rooms, factories, mining sites, construction   sites, chemical facil-
ities, and laboratories. 

For example, you might design a series of key macros that open up different   pictures of pumps on your 
plant floor. All that an operator needs to do   to monitor pumps at run time is press a key on his industrial 
keyboard   to switch between iFIX pictures, rather than use a mouse to open up each   picture manually. 
Key macros not only save time, but also allow you to   easily standardize actions based on specific key-
strokes.

Use of key macros, however, is not restricted to users of industrial   keyboards. Any user who wants to 
automate routine tasks, group multiple   sequential tasks into one function, manage alarming and operator 

© 2024 General Electric Company. All rights reserved. 553



messaging,   run applications, control database blocks, or manipulate files by the   use of a key com-
bination can use key macros. The following figure shows   examples of how you might use key macros.

Key Macro Examples

Introduction to the Key Macro Editor 

The Key Macro Editor gives iFIX users an easy way to create and manipulate   key macros in the iFIX 
WorkSpace. This section describes the Key   Macro Editor interface and its basic functionality. Topics 
included are:

 l Getting   Ready to Use Key Macros

 l Starting   the Key Macro Editor

 l Recognizing   the Key Macro Editor Window

 l Understanding   Column Definitions in the Key Macro Editor

 l Using   the Toolbar

 l Navigating   in the Key Macro Editor

 l Defining   User Preferences

 

Getting Ready to Use Key Macros

Before you can begin using key macros you must:
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 l Understand how to   create pictures and use experts in the iFIX WorkSpace 

 l Be familiar with   your process database 

 l Understand how to   work with objects in the run-time environment 

 

Starting the Key Macro Editor 

You must have the iFIX WorkSpace running before you start the   Key Macro Editor. You can start the 
Key Macro Editor from the    iFIX WorkSpace by clicking the Key Macro button on the Application toolbar   
in configure mode (Classic view) or on the Applications tab in the Utilities   group, click Key Macro Editor 
(Ribbon view).

You can also start the Key Macro Editor by selecting Add or Edit from   the Key Macros option in the right-
click menu. You access the right-click    menu after selecting an object, picture, or user global page. You 
can   select an object or picture from the system tree or drawing area. You   can select the user global page 
from the system tree.

The Key Macro Editor Window

The Key Macro Editor window appears as follows:
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Key Macro Editor Main Window

Initially, the Key Macros Apply To field displays the object, picture,   or user global page that was selec-
ted when you opened the Key Macro Editor.

Column Definitions for the Key Macro Editor 

The following table describes the columns of the Key Macro Editor spreadsheet and the information that 
you can enter into them.  

NOTE: You can only access these columns when a row is active. Click a row to make it active.

Use this 
column...

To...

Key Com-
bination

Define the key assignment for the macro. The key combination can include one 
key or a combination of keys. For example: F1, Ctrl+A, or Ctrl+Shift+H are all 
possible key macros.

Action Define the expert that you want to run for the key macro. The expert auto-
matically launches after you select it from the drop-down list.  

An expert consists of a dialog box that requires minimum input to quickly create 
a script to perform a task. For example, the OpenPicture expert requires you to 
enter the picture name that you want to open in the dialog box.  

If you select Custom, the Microsoft Visual Basic Editor opens so you can enter 
a custom script.

Run Expert Re-run the expert defined in the Action cell. You can re-run the expert to modify 
the expert's parameters.  

For example, you can use the Run Expert button to change the name of the pic-
ture that is opened with the OpenPicture expert. You do not need to know Visual 
Basic to run an expert.

VB Editor Access the Microsoft Visual Basic Editor so that you can view or modify the 
VBA script behind the key macro.  

NOTE: It is highly recommended that you do not modify the code that an expert 
created because the format of those comments and code written by the expert 
is used when re-running the expert.

Description Enter text that describe the function of the key macro. Can contain up to 60 
alphanumeric characters, including special characters, such as -(*)&+% and 
spaces.

The Description field is optional.

Column Definitions for the Key Macro Editor 

Using the Toolbar 

Many of the commands found on the menu bar have corresponding toolbar buttons. The following table 
describes the functions of the Key Macro Editor-specific toolbar buttons.     
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Cli-
ck 
this 
but-
to-
n...

To...

Add a row to the spreadsheet.

Edit the fields in a row.

Delete the active row.

Delete all rows.

Cut the active row or rows, and move them to the Clipboard.

Copy the active row or rows, and place them on the Clipboard.

Paste a row or rows into the spreadsheet.

Keep the Key Macro Editor on top of the iFIX WorkSpace. By default, this button is selec-
ted. 

Key Macro Editor Toolbar Buttons    

Navigating in the Key Macro Editor 

After you open the Key Macro Editor, you can apply key macros to the   currently selected item, or nav-
igate to another object, picture, or user   global page. To navigate in the Key Macro Editor:

 l Use the drop-down   list next to the Key Macros Apply To field to view the most recently used   
shape, picture, or the user global page. The Key Macro Editor stores up   to ten items in the most 
recently used list. 

NOTE: If you want   to modify the number of items that appear in the most recently used list,   edit the 
\\HKEY_CURRENT_USER\Software\VB and VBA Program Set-
tings\FDKeyMacros\AddressMRU\MaxEntries   values in the Windows Registry.

 l Use the browse button   to select an object, picture, or user global page. 

 l Use the Global Key   Macros button to switch immediately to the user global page, if you want   to 
define a system wide key macro. 

The Key Macros Apply To field and its related   buttons are described in the following figure.
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Key Macros Apply To Field

Defining User Preferences 

You can define certain features for the Key Macro Editor by the using the Preferences menu:

 l Keep on Top – Keeps the Key Macro Editor on top of the iFIX WorkSpace. By default, Keep on 
Top is enabled.   

 l Always Save User.fxg on Navigate – Every time you make changes to the user global page 
and then navigate to a picture or object, you save the changes without being prompted. The User-
.fxg file contains your system wide key macros. If you do not save the User.fxg file on nav-
igation, global key macros will not be saved to disk until you shut down the WorkSpace. You are 
prompted to save the User.fxg during the shutdown.   

 l Always Save Key Macros on Navigate – Every time you browse to another shape, picture, or 
the user global page, you save the key macros that are configured without being prompted. This 
preference does not save the picture, however. The Always Save Key Macros on Navigate 
option is a good development tool, if you want to safely design key macros and do not want to 
modify your pictures until you close the picture or the WorkSpace.   

You can have any combination of these preferences enabled at the same time. For instance, you can 
select Always Save User.fxg on Navigate and Always Save Key Macros on Navigate if you want to 
enable both in the Key Macro Editor. With both selected, you will not see a prompt asking you to save 
either the User.fxg file or the key macros since both will be saved automatically.  

NOTE: These preferences do not automatically save the picture file. You can save the picture file (.GRF file) 
yourself at any time, or when prompted when you close the picture or the WorkSpace. 

Defining Key Macros 

The actions that you can perform with key macros are defined by VBA   scripts. Each individual VBA 
script contains a series of commands and   instructions that your iFIX software executes on request. You 
can use   experts to define your actions or write your own custom VBA scripts. 

This section describes how to define key macros, including:

 l Understanding   How iFIX Checks for Key Macros in Run Time

 l Adding   Key Macros

 l Defining   a Keystoke Assignment

 l Selecting   an Expert

 l Writing   Custom Key Macros

Understanding How iFIX Checks for Key Macros 

As the following picture details, when a user enters a key or key combination   at run time, iFIX first 
checks to see if a key macro exists at the object   level for the currently selected object. If it does, the 
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action executes.   If the key macro does not exist on the object level, iFIX checks the picture   level. If the 
key macro exists on the picture level, the action executes.   If the key macro does not exist on either the 
object or picture level,   iFIX finally checks at the global level. 

How iFIX Checks for Key   Macros

When you are defining your key macros, keep in mind that object level   key macros can override picture 
and global level key macros. Also, picture   level key macros can override global key macros. For 
example, you can   define a global level key macro that executes no matter what picture is   open (or even 
if no picture is open), unless it is overridden by an object   or picture level key macro. 

For instance, say you define a picture level key macro as F2 to close   a picture, and a global level key 
macro as F2 to replace a picture. When   you are in run-time mode and select F2, the close picture key 
macro will   run. The close picture key macro runs because the picture level key macro   takes precedence 
over the global level key macro. So be careful if you   are using the same key macro at different levels. 

Also, use care if you are assigning key macros to objects within a group.   iFIX does not check for key 
macros at the group level, unless the group   is selected. For example, say you are in run time and you 
select Object   A which is inside Group A, and the group contains a key macro of F5, as   shown in the fol-
lowing figure. However, the picture also contains a key   macro of F5. In this case, if you press F5, the pic-
ture's F5 key macro   would run, and not Group A's. If instead you select Group A and then press   F5, the 
group's key macro would run and not the picture's. As you can   see, if you assign the same key macro to 
different objects within the   same group and to the group itself, the operator could become confused.   
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Example of Key Macros at   Multiple Levels

As another example, say Group A is part of Group C, as shown in the   previous figure. Both Group C and 
the picture have a key macro of F7 assigned   to them. If you are in run time and select Group A and then 
press F7,   the picture's F7 key macro would run and not Group C's. The system does   take into account 
the group hierarchy. 

As another example, say Object B is within Group B, and the group contains   a key macro of F8 but the 
object, picture, or user global does not contain   a key macro of F8. In this case, if you are in run time and 
select Object   B and then press F8, nothing happens. You would need to select the group   before pressing 
F8 for the key macro to execute. You cannot run a group's   key macros by selecting an object within a 
group. If you are creating   Dynamo objects, be sure to keep that in mind. 

Adding Key Macros 

To add a key macro in the Key Macro Editor:

 l Click in the first   empty row of the Key Macro Editor. 

 l Select Add Row from   the Edit menu. 

 l Click the Add Row   button in the toolbar. 

The Key Macro Editor allows you to:

 l Add a key macro to   a shape or a Dynamo object within a picture 

 l Add a key macro to   a picture 

 l Add a key macro to   a user global page 
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If you add a key macro to a shape or Dynamo object within a picture   or to a picture itself, the key macro 
is saved with the picture file.

If you add a key macro to a user global page, the key macro is available   to all displays. Key macros that 
apply "globally" live in the   user global file, User.fxg. 

NOTE: If you add key   macros during run mode, when you switch back to configure mode those key   macros 
are gone.

Defining a Keystoke Assignment 

Each key macro requires a keystroke assignment. This assignment can   be a single key or a key com-
bination. A key combination can consist of   most keyboard keys including the function keys, number 
pad, and punctuation   keys. The following exceptions are: 

 l Backspace 

 l Alt 

 l Caps Lock 

 l Spacebar 

NOTE: Key codes that   cannot be applied in the Key Macro Editor can be added using the interface   methods.

The Shift or Control keys cannot be used alone. Alphanumeric keys are   only valid with Ctrl or Ctrl+Shift.

When you click the Key Combination cell of an active row, you open the   Keyboard dialog box, as shown 
in the following figure. 

Keyboard Dialog Box

The Keyboard dialog box lets you define a keystroke assignment quickly   and easily. Use your mouse to 
select the keys on the Keyboard dialog box,   or enter the key combination in the text box. If you make a 
mistake, click   Clear to start over.

You are not limited to the keys that appear in the Keyboard dialog box.   For example, if the keyboard on 
your computer has an F18 key, when you   hit this key the system recognizes and displays it in the text 
box, even   though the key is not included in the Keypad in the Keyboard dialog box.   There are some keys 
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that are not valid though. If you select an invalid   key, when you close the Keyboard dialog box, you will 
get an error message.   See the following table for guidelines  you can use when defining key macros. 

Key Guideline
Alphanumeric  l Do not use alone,   or just with the Shift key.

 l Use in combination   with the Ctrl or Ctrl+Shift keys.
Ctrl  l Do not use alone.   

 l When used in   a combination, select Ctrl first. 

 l Can use in combination   with function keys.
Delete Use alone or in combination with the Ctrl and/or Shift   key.
Function keys Use alone or in combination with the Ctrl and/or Shift   key.
Insert Use alone or in combination with the Ctrl and/or Shift   key.
Arrow keys Use alone or in combination with the Ctrl and/or Shift   key.
Number pad 
keys

Use alone or in combination with the Ctrl and/or Shift   key.

Punctuation 
keys

 l Do not use alone.

 l Use in combination   with the Ctrl or Ctrl+Shift keys.
Shift  l Do not use alone.

 l When used in   a combination, select Shift first.

 l Use in combination   with function, symbol, punctuation, movement, Insert, or 
Delete key.

 l Do not use in   combination with alphanumeric keys, unless used with the Ctrl 
key.

Symbols Use alone or in combination with the Ctrl and/or Shift   key.

Keystroke Assignment Guidelines    

Selecting an Action 

Select an action for a specified key macro by doing one of the following:

 l Click the Run Wizard   button to use the Multiple Command Script Wizard.

 l Click the VB Editor   button to open the Visual Basic Editor.

The Multiple Command Script Wizard enables you to use Experts to automatically   create a scripted 
action, or series of actions, for the key macro.  Alternatively,   you can use the Visual Basic Editor to cre-
ate a custom scripted action.   

The following Experts are available for use with key macros through   the Multiple Command Script Wiz-
ard:

 l Custom 

 l AcknowledgeAlarm   

 l AcknowledgeAllAlarms   

 l AlarmHorn 

 l CloseDigitalPoint   
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 l ClosePicture 

 l DataEntry 

 l DisableAlarm 

 l EnableAlarm 

 l LocateObject 

 l GenerateReport 

 l OpenDigitalPoint   

 l OpenPicture 

 l RampAValue 

 l ReplacePicture 

 l SetTagAuto 

 l SetTagManual 

 l ToggleDigitalPoint   

 l ToggleScan 

 l ToggleTagAutoManual   

 l TurnTagOffScan 

 l TurnTagOnScan 

 l WriteToADatabasePoint   

For information on particular Experts, refer to the Experts   Summary. 

Writing Custom Key Macros 

You can use your Visual Basic Editor to write a custom script or edit   an existing expert configuration for 
a key macro. Editing expert code   is only recommended for advanced users. If you want to modify the 
expert   parameters, we suggest that you re-run the expert rather than edit the   code. Use the Run Expert 
button to modify these parameters. 

NOTE: If you modify   the expert generated code, you should delete the Expert generated comments   in the 
VBA script.

For information on the VBA scripts and Experts, refer to the following   sections:

 l Writing  Scripts

 l iFIX  Automation Reference

 l Experts   Summary

 

Managing Macros 
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The Key Macro Editor provides the tools necessary to manage and refine   key macros. You can use 
these tools to:

 l Create Global Key   Macros. 

 l Automatically Save   the User.fxg when navigating. 

 l Delete a key macro.   

 l Delete all key macros   for an object, picture, or user global. 

 l Export all key macros   in the selected object, picture, or user global page to a .CSV file. 

NOTE: There is   no import functionality in this release.

In addition, you can also manage key macros in the WorkSpace by:

 l Copying and pasting   key macros from one object to another object. 

 l Copying and pasting   key macros from one picture to another picture. 

 l Copying and pasting   an object containing key macros. 

Determining if an Object, Picture, or User Global Contains a Key Macro

If an object, picture, or user global contains a key macro, it is identified by a key at the top left-hand 
corner of the icon in the system tree. See the following figure for an example.

Example of Key Macros, as Displayed in the System Tree

Overriding WorkSpace Shortcuts in Run Time 

Key macros override shortcut keys that you can normally use in the WorkSpace's   run-time environment. 
For example, you can override the WorkSpace shortcut   of Ctrl+O to open a picture with a key macro that 
does another function   when you select Ctrl+O. You can also disable a shortcut by creating an   empty key 
macro. For example, if you don't want to give operators the   ability to open pictures, you create an empty 
key macro for the Ctrl+O   key combination. This disables the action for the key combination, not   the key 
macro itself. So, when the operator presses Ctrl+O, nothing happens.   
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To create an empty key macro in the Key Macro Editor, you select Custom   in the Action drop-down. 
This functionality is different from the VBA   Key Up/Key Down events that only have access to key com-
binations not used   by the WorkSpace.

NOTE: When you create   a key macro for Ctrl+F4, a user logged in as guest may not be able to   use Ctrl+F4 as 
expected. To overcome this restriction, assign the Enable   Task Switching application feature to that user's 
account.

Tips And Tricks 

Some of the additional functionality provided with key macros include:

 l Right-click on an   object or picture from the system tree or drawing area, or right-click   the user 
global page from the system tree to display a menu with the Key   Macros option. 

NOTE: The Key Macros   option is not available in the right-click menu for variable, timer, or   event 
objects.

 l Determine if an object,   picture, or user global contains a key macro by looking at the System   
Tree. 

 l Search and replace   for a key macro within a picture. 

 l Search and replace   for a key macro within a user global. 

 l Copy all key macros   for an object. 

Notes for Users Familiar with the FIX Product

If you are familiar with the FIX product line and have used key macros before, there are a few things that 
you should be aware of in the latest iFIX release:

 l The User Interface to the Key Macro Editor is re-designed both visually and functionally.   

 l Key macros are now object-based, as well as picture-based and global-based.   

 l The Key Macro Apply To field allows you to select a user global by clicking the Global Key Mac-
ros button. If you add a key macro to a user global page (User.fxg file), the key macro is available 
to all displays.    

 l You can now use the F10 key for key macros.   

NOTE: Unless you enable task switching, the key macro Shift+F10 will not work.

 l Key macros are only functional in the run-time environment.   

 l Key macros are saved with pictures and the user file (User.fxg), and not in a separate .KMX file.   

 l If you copy and paste an object that contains key macros, the key macros are copied and pasted 
along with the object.   

Key Macro Editor Dialog Boxes
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The Key Macro Editor includes the following dialog boxes (listed in   alphabetical order):

 l Key   Macro Editor Main Window

 l Keyboard   Dialog Box

 

Key Macro Editor Main Window

The Key Macro Editor main window displays the following items:

Key Macros Apply To

Enter the object, picture, or user global page to which you want to   apply key macros. You can type the 
name directly into the Key Macros Apply   To field or you can:

 l Click the drop-down   arrow next to the Key Macros Apply To field to select from the most recently   
used list.

 l Click the browse   button to open the browse box to select another object, picture, or the   user 
global page.

 l Click the Global   Key Macros button to apply key macros to the user global page.

Spreadsheet

Click in any cell in the spreadsheet to enter data:

 l Key Combination –   Defines the key assignment for the macro. Can include one or multiple   keys.

 l Action – Defines   the expert that you want to run for the key macro. The expert automatically   
launches after you select it. If you select Custom, the Microsoft Visual   Basic Editor opens so you 
can enter a custom script.

 l Run Expert – Button   that re-runs the expert defined in the Action cell so you can modify the   
expert's parameters.

 l VB Editor: Button   that provides access to the Microsoft Visual Basic Editor so that you   can view 
or modify the VBA script behind the key macro.  

NOTE:   It is highly recommended that you do not modify the code created by an   expert because the 
expert's code is used when re-running the expert.

 l Description – Text   that describes the function of the key macro. Can contain up to 60 alpha-
numeric   characters, including special characters, such as -(*)&+% and spaces.   The Description 
field is optional.

Keyboard Dialog Box

In the Keyboard Dialog Box use the mouse to select keys on the Keyboard   dialog box, or enter the key 
combination in the text box.

A key combination can consist of most keyboard keys except: Backspace,   Alt, Caps Lock, or the 
Spacebar. The Shift or Control keys cannot be used   alone. Alphanumeric keys are only valid with Ctrl or 
Ctrl+Shift.
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How Do I...

The following sections provide steps on how to use iFIX Key Macro Editor:

 l Managing   Key Macros

 l Navigating   in the Key Macro Editor

 l Copy   and Paste Macros

 l Tips   and Tricks

 

Managing Key Macros

The following sections provide steps to help you manage your key macros   when working in the iFIX 
WorkSpace:

 l Adding   a Key Macro

 l Copy   and Paste a Row in the Key Macro Editor

 l Creating   Global Key Macros

 l Defining   a Keystroke Assignment

 l Deleting   a Key Macro

 l Deleting   All Key Macros

 l Exporting   to a .CSV File

 l Selecting   an Action

 

Adding a Key Macro

 To add a key   macro:

 1. In Classic view,   in the iFIX WorkSpace, click the Key Macro Editor button. 

-Or-

In Ribbon view, on the Applications tab   in the Utilities group, click Key Macro Editor. 

 2. Click in the first   empty row of the spreadsheet. 

 3. Click the Key Combination   cell to define the keystrokes for the key macro.

 4. Select an action   from the drop-down list.

 5. Optionally, in the   Description field, enter a description of the key macro.

 6. Click OK.

 

Copy and Paste a Row in the Key Macro Editor
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 To copy and paste   a row in the Key Macro Editor:

 1. In the iFIX Key Macro   Editor main window, click anywhere in the row of the key macro that you   
want to copy. 

NOTE:   If you want to copy multiple rows, hold the Shift key while you click   the rows that you want to 
copy. To select multiple rows that are not located   next to each other, hold the Ctrl key while you click 
each row.

 2. On the Edit menu,   click Copy Row. 

 3. Browse to the object,   picture, or user global page to which you want to paste the key macros.

 4. On the Edit menu,   click Paste Row.

 

Creating Global Key Macros

 To create global   key macros:

 1. From the iFIX Key   Macro Editor main window, click the Global Key Macros button. 

 2. Define your keystroke   assignment, assign an action, and enter a description.

 3. Click OK.

NOTE:   Global key macros are saved in the user global file, User.fxg.

 

Defining a Keystroke Assignment

 To define a keystroke   assignment:

 1. From the iFIX Key   Macro Editor main window, click the Key Combination cell in an active   row. 
The Keyboard dialog box appears.

 2. Use the mouse to   select keys on the Keyboard dialog box, or enter the key combination in   the 
text box. You are not limited to the keys that appear just in the   Keyboard dialog box. 

For example, if the keyboard on your computer   has an F18 key, when you hit this key the system 
recognizes and displays   it in the text box, even though the key is not included in the Keypad   in 
the Keyboard dialog box. 

NOTE:   A key combination can consist of most keyboard keys except: Backspace,   Alt, Caps Lock, or 
the Spacebar. The Shift or Control keys cannot be used   alone. Alphanumeric keys are only valid with 
Ctrl or Ctrl+Shift.

 3. Click OK.

 

Deleting a Key Macro

 To delete a key   macro:

 1. In the iFIX Key Macro   Editor main window, click anywhere in the row of the key macro that you   
want to delete. 

 2. On the Key Macro   menu, click Delete Row. 
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NOTE:   If you want to delete multiple key macros, hold the Shift key while you   click the rows that you 
want to delete. To select multiple rows that are   not located next to each, hold the Ctrl key while you 
click each row.   A confirmation message box appears if more than one row is highlighted   when delet-
ing.

 

 

Deleting All Key Macros

 To delete all   key macros for a given object, picture, or user global page:

 1. In the iFIX Key Macro   Editor main window, on the Key Macro menu, click Delete All Rows. A con-
firmation   message box appears.

 2. Click Yes to continue.

 

Exporting to a .CSV File

 To export to   a .CSV file:

 1. In the iFIX WorkSpace,   from the system tree or drawing area, click the object, picture, or user   
global page from which you want to export key macros.

 2. In Classic view,   on the iFIX WorkSpace toolbar, click the Key Macro Editor button. 

-Or-

In Ribbon View, on the Applications tab   in the Utilities group, click Key Macro Editor. 

 3. On the Key Macros   menu, click Export. 

NOTE: You   cannot import .CSV files. The exported .CSV file is intended to be used   for cross-ref-
erencing key macros in Excel.

By default the Recursive (Include Children)   check box is selected. This allows you to include key 
macros for all pictures   and objects if you select the user global page, or all objects within   a picture 
and the selected picture if you select a picture.

 4. In the File Name   field, enter a path and name for the .CSV file. If you do not include   a path, the 
.CSV file is saved to your iFIX directory.

If you enter or browse to an existing file   name and click the Append to File check box, the key 
macros are added   to the end of the existing .CSV file.

 5. Click Export.

 

Selecting an Action

NOTE: You must   have a key combination defined before you can select an action.

 To select an   action with the Multiple Command Script Wizard:

 1. In the iFIX Key Macro   Editor main window, click the Run Wizard button. The Multiple Command   
Script Wizard appears.
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 2. Choose a command   from the Select Action to Append list. The Expert associated with the   com-
mand you chose appears.

 3. Complete the Expert   with your desired settings and information.

 4. Optionally, repeat   steps 2 and 3 if you want to add additional commands to your scripted   com-
mand sequence.

 5. When you have finished   choosing your command sequence, click OK.

 To select an   action with the Visual Basic Editor:

 1. In the iFIX Key Macro   Editor main window, click the VB Editor button. The Visual Basic Editor   
appears.

 2. Create your custom   script in the VB Editor, then click OK.

For more information on the Multiple Command Script Wizard, see The   Multiple Command Script Wiz-
ard.  For   more information on creating custom scripts, see the iFIX  Automation Interfaces Help. 

Copying and Pasting Macros

In the Key Macro Editor you can do the following:

 l Copy   and Paste Between Objects in a Picture

 l Copy   and Paste Between Pictures

 l Copy   and Paste Whole Objects in a Picture

 

Copy and Paste Between Objects in a Picture

 To copy and paste   key macros between objects:

 1. In the iFIX WorkSpace,   from the system tree or drawing area, right-click the object that contains   
the key macros that you want to copy. A pop-up menu appears.

 2. On the Key Macros   menu, click Copy to copy all key macros for the object.

 3. Right-click the object   to which you want to copy the key macros. A pop-up menu appears.

 4. On the Key Macros   menu, click Paste.

 

Copy and Paste Between Pictures

 To copy and paste   key macros between pictures:

 1. In the iFIX WorkSpace,   in the system tree, right-click the picture that contains the key macros   
that you want to copy. A pop-up menu appears.

 2. On the Key Macros   menu, click Copy. 

 3. Right-click the picture   to which you want to copy the key macros. A pop-up menu appears.

 4. On the Key Macros   menu, click Paste.

570 © 2024 General Electric Company. All rights reserved.

fixvba.chm::/arcover.htm


NOTE:   When you copy and paste key macros between pictures, you copy and paste   those at the pic-
ture level and not at the object level. 

 

Copy and Paste Whole Objects in a Picture

 To copy and paste   objects with key macros:

 1. In the iFIX WorkSpace,   from the system tree or drawing area, select the object.

 2. Hold the Control   key down and drag and drop the object to the desired location. The pasted   the 
object brings the key macros with it.

NOTE:   You can copy and paste objects when the source and destination do not   appear on the screen 
simultaneously, by using the right-click menu.

 

Navigating in the Key Macro Editor

The following sections describe how to navigate within the Key Macro   Editor:

 l Browsing   in the Key Macro Editor

 l Selecting   a Key Macro from the Most Recently Used List

 l Selecting   the User Global Page

 l Saving   Key Macros When Navigating

 l Saving   the User.fxg File When Navigating

 

Browsing in the Key Macro Editor

 To browse to   another object, picture, or user global page in the Key Macro Editor:

 1. In the iFIX Key Macro   Editor main window, click the browse button next to the Key Macros 
Applies   To field.

 2. Select the object,   picture, or user global page to which you want to apply key macros.

 l Click the plus   sign next to a picture to view the objects contained in the picture.

 l Click the minus   sign next to a picture to collapse the expanded view.

 3. Click OK.

 

Selecting a Key Macro from the Most Recently Used List

 To select a key   macro from the most recently used list in the Key Macro Editor:

 1. In the iFIX Key Macro   Editor main window, click the drop-down arrow next to the Key Macros 
Apply   To field. A list box opens with the most recently used items. 

© 2024 General Electric Company. All rights reserved. 571



 2. Select a shape, picture,   or the user global page from the most recently used list. 

NOTE:   Up to ten items are stored in the most recently used list.
 

Selecting the User Global Page

 To select the   user global page in the Key Macro Editor:

 1. In the iFIX Key Macro   Editor main window, click the Global Key Macros button. The word User   
appears in the Key Macros Apply To field.

 2. Enter your key macros   for the user global page.

 

Saving Key Macros When Navigating

 To save key macros   automatically when navigating:

 1. In the iFIX Key Macro   Editor main window, on the Preferences menu, click Always Save Key 
Macros   on Navigate.

 2. Be sure that a check   mark appears next to the Always Save Key Macros on Navigate option in   
the Preferences menu.

 

Saving the User.fxg File When Navigating

 To automatically   save the User.fxg file when navigating:

 1. In the iFIX Key Macro   Editor main window, on the Preferences menu, click Always Save User-
.fxg   on Navigate.

 2. Be sure that a check   mark appears next to the Always Save User.fxg on Navigate option in the   
Preferences menu.

 

Using Tips and Tricks

The following sections provide tips and tricks for working with the   iFIX Key Macro Editor:

 l Adding   a Key Macro Button to the Toolbar

 l Copy   and Paste All Key Macros for an Object

 l Viewing   Key Macros in the System Tree

 l Disabling   a Key or Key Combination

 l Exporting   Key Macros Without Launching the Key Macro Editor

 l Searching   Within a Picture

 l Searching   Within the User Global Page
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Adding an Export Key Macro Button to the Toolbar

 To add an Export   Key Macros button to the toolbar:

 1. In Classic view,   in the iFIX WorkSpace, click Toolbars. 

-Or-

In Ribbon view, on the Home tab, in the   WorkSpace group, click Settings, and then click Tool-
bars. 

 2. Click the Customize   button. 

 3. Click the Buttons   tab.

 4. In the Categories   list, select Picture Tasks.

 5. Drag the Export Key   Macros button from the Customize Toolbars dialog box to the toolbar.

 6. Click the Close button.

 

Copy and Paste All Key Macros for an Object

 To copy and paste   all key macros for an object:

 1. In the iFIX WorkSpace,   from the system tree or drawing area, right-click the object that contains   
the key macros that you want to copy. A pop-up menu appears.

 2. On the Key Macros   menu, click Copy.

 3. Right-click the object,   picture, or user global to which you want to paste the key macros. A pop-
up   menu appears.

 4. On the Key Macros   menu, click Paste.

 

Viewing Key Macros in the System Tree

 To determine where key macros exist from the WorkSpace system tree:

 1. In the WorkSpace   system tree, look for a key in the upper left corner of the object, picture,   or user 
global page icon. 

 2. If you want to view   or add key macros, click the object, picture, or user global page and   open the 
Key Macro Editor.

 

Disabling a Key or Key Combination
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 To disable a   key or key combination:

 1. In the iFIX Key Macro   Editor main window, click the Key Combination cell in an active row. The   
Keyboard dialog box appears.

 2. Use the mouse to   select the key or key combination that you want to deactivate.

 3. Click OK. 

 4. Click Custom from   the Action drop-down list. The Microsoft Visual Basic Editor launches.

 5. If a script was previously   defined for the key or key combination, comment out the contents of the   
script and save the script.

NOTE:   Do not comment out the procedure's declaration if you want the key to   be handled. If you do, 
the key macro will be removed.

By commenting out the contents of the script,   you are disabling the action for the key or key com-
bination, not the key   macro itself. This functionality is different from the VBA Key Up/Key   Down 
events that only have access to key combinations not used by the   WorkSpace.

 6. If no script was   previously defined for the key or key combination, do not enter a new   script.

 7. On the File menu,   click Close and Return to WorkSpace Application. This closes the Visual   
Basic Editor and returns you to the Key Macro Editor main window. 

 8. Optionally, when   you return to the Key Macro Editor main window, you can enter a description   for 
the key macro.

 

Exporting Key Macros Without Launching the Key Macro Editor

 To export key   macros without launching the Key Macro Editor:

 1. In the iFIX WorkSpace,   from the system tree or drawing area, click the object, picture, or user   
global page from which you want to export key macros.

 2. Click the Export   Key Macros button on your toolbar. 

NOTE: The   Export Key Macros button is a custom toolbar option. If it does not display   in your toolbar, 
you will need to add it.

The Export Key Macros dialog box appears.   By default the Recursive (Include Children) check 
box is selected. This   allows you to include key macros for all pictures and objects if you select   
the user global page, or all objects within a picture and the selected   picture if you select a picture.

 3. In the File Name   field, enter a path and name for the .CSV file. If you do not include   a path, the 
.CSV file is saved to your iFIX directory.

If you enter or browse to an existing file   name and click the Append to File check box, the key 
macros are added   to the end of the existing .CSV file.

 4. Click Export.

 

Searching Within a Picture
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 To search for   a key macro within a picture:

 1. From the iFIX WorkSpace   system tree, click the picture in which you want to search for key mac-
ros.

 2. On the Edit menu,   click Find and Replace. The Find and Replace dialog box appears.

 3. In the Find What   field, enter the key or key combination that you want to search for.

 4. Select the Include   Scripts check box. 

You need to select Include Scripts so that   Procedure Declaration and Display String properties 
for key macros appear   in the match list. Both properties are used in key combinations.

 5. Click the Find button.

NOTE:   Do not use the replace feature, unless you are an advanced user. For example,   if you replace 
a key combination with one that exists already, you will   cause a compiler error. 
 

Searching Within the User Global Page

 To search for   a key macro within the user global page:

 1. From the iFIX WorkSpace   system tree, within the Globals folder, click the User item.

 2. On the Edit menu,   click Find and Replace. The Find and Replace dialog box appears.

 3. In the Find What   field, enter the key or key combination that you want to locate.

 4. Select the Include   Scripts check box.

You need to select Include Scripts so that   Procedure Declaration and Display String properties 
for key macros appear   in the match list. Both properties are used in key combinations.

 5. Click the Find button.

NOTE:   Do not use the replace feature, unless you are an advanced user. For example,   if you replace 
a key combination with one that exists already, you will   cause a compiler error. 
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finding and replacing data in  72

grid interval property  70

how to use symbols  474

implementing in your process  49

importing language files  468

locating  59

modifying configuration  85

naming restrictions  3

object-oriented nature  7

opening  3

optimizing load performance  477

performing advanced functions  38

preferences  28

Quick Trend  301

refreshing  25
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resolving tags  487

retrieving symbols from  473, 484

running  439

security areas  76

setting gradient fill  28

setting the background and fade colors  28

sharing files  39

showing  25

sizing  59

Tag Status  300

tiling  39

translating text  465

translations  454
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using Quick Trend  445

using Tag Status  446

viewing at runtime  32

what makes up  50
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window decorations  68

with the Create Picture wizard  78

pies  288

pipe connector tool  148

pipes  142, 296

converting lines and polylines  142

modifying characteristics  143

splitting  133

pixels  7

planning a tag group strategy  469

points  297

polygons  297

adding and deleting points in  124
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polylines  297

adding and deleting points in  124

converting to pipe  142

splitting  133

pop-up menu  26
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functions available on picture  26

using object  15

using the picture  26

Position Expert  356

predefined configuration  78
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Print Crystal Report Expert  394

Print Crystal Report Expert (PrintReport 
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prioritizing alarms  319

properties  334
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defining  402
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modifying  402
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modifying by writing scripts  405

setting gradient fill  28
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Properties window  27, 320

displaying  19

entering property values manually  402

for creating pictures  68

using the picture  27

push buttons  109

adding to pictures  109

Q

Quick Trend pictures  301, 446

R

Ramp a Value Expert  375

range  413, 435

data conversion  412

re-entrance functionality  344

Read a Value Expert  388

rectangles  287

refresh  25

refresh rate  305, 423

Refresh Rate Expert  391

Refresh Rate field  306

renaming  292

Replace Picture Expert  376

Reports Experts Summary  394

reshape handles  11

reshaping  123, 293
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resizing  121

Resolve Files Expert  391
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resolving pictures  46, 89

resolving tags  477, 487

restoring defaults  327

retrieving symbols from pictures  472, 484

right angle line connector tool  148

Rotate Expert  360
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rotating  121, 293

rotation  122, 293

new center of  122

rounded rectangles  287

row numbers  322

rows  486

adding  486
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inserting  486

run-time environment  439

working in  438

S

saving  327, 572

key macros on navigate  572

User.fxg on navigate  572
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saving tag group files  483

saving tag lists  302

SCADA server  319

Scale Expert  363

scripts  513

changing object names  117

command in Dynamos  513

scroll bars  322

searching  574

within a picture  574
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searching and replacing substitutions  487

securing pictures  76

security  76
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protecting pictures  76

selecting  68, 323, 571

experts  569

key macros from drop-down list  571

user global page  572

window properties  68

Selecting a Command  344
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selecting mode  305

selecting styles  323

selection timeout  328
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Set Layer Expert  370
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default font  104
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shapes  297

drawing  101

shared thresholds  419
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shortcut keys  113
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See partial substitutions  475

symbol format  474
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defined  468

described  474
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syntax guidelines for partial 
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using for the current value of a variable 
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system tree  4
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T

table

data conversion  412
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Tag Group Editor  484

creating and opening tag group files  471

described  469
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interface  470
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saving  483
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introduction  468
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loading  302

saving  302
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syntax for  472

Task Wizard
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third-party controls  111
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thumbnail  25, 45

saving  46, 392

time  286

timeout  328
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adding to pictures  112

tips and tricks for key macros  565

title bars  42
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toolbar buttons  471

toolbars  13
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tools  11
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configuration mode  468
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user global page  572
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user preferences for the Key Macro Editor  558
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User Prompts  497

User.fxg (saving)  572
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Variable Object  396

variable objects  288, 476

adding to pictures  110
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using symbols for  476
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in document  51

visibility  154
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Visibility Expert  366

W

window  45

fit to picture  60
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window location  45

window properties  45

window size  44

windows  433

Windows metafiles  88

importing  7

working with  88

Windows Metafiles  46

wizards  83

Wizards  337

Backup and Restore  338

Create Picture  77

Generate  338

running  338

Wizards and Experts  337
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